# Contents

1. **Drawings in Tekla Structures** ................................................................. 15
   1.1 Drawings integrated with models.................................................................17
   1.2 Drawing associativity..................................................................................... 17
   1.3 Drawing mode in Tekla Structures............................................................... 19
   1.4 Drawing layout and views.............................................................................. 20
   1.5 Drawing objects.............................................................................................22
   1.6 How to keep your drawings up to date?.......................................................23
   1.7 Different levels of setting up and modifying drawing properties.............24
      Set automatic drawing properties before creating drawings.....................27
      Modify view-level drawing properties............................................................28
      Modify drawing properties of an existing drawing.......................................29
      Modify drawing object properties..................................................................30
      Load saved drawing object properties..........................................................31
      Detailed object level settings.........................................................................31
      Create detailed object level settings in a general arrangement drawing.........32
      Example: Apply detailed object level settings on drawing level in a GA drawing....33
      Create detailed object level settings in cast unit drawings..........................36
      Example: Apply detailed object level settings on view level in a cast unit drawing....38
   38
   How Tekla Structures applies drawing properties in drawing creation.............40
   Settings affecting the recreation of drawings....................................................41
   Prevent automatic drawing updates and recreation............................................42

2. **Create drawings in Tekla Structures** ............................................... 43
   2.1 Drawing types...............................................................................................45
      General arrangement drawings.......................................................................45
      Example: Foundation plan...............................................................................46
      Example: Slab plan............................................................................................47
      Example: Framing plan......................................................................................48
      Example: Deck plan..........................................................................................49
      Example: Erection elevation drawing..............................................................50
      Example: 3D isometric drawing.......................................................................51
      Example: Anchor bolt plan.............................................................................52
      Single-part drawings.......................................................................................52
      Example: Anchor bolt......................................................................................53
      Example: Embed...............................................................................................54
      Example: Plate..................................................................................................55
      Assembly drawings.........................................................................................58
      Example: Beam.................................................................................................59
      Example: Stairs.................................................................................................60
      Example: Rail....................................................................................................61
      Cast unit drawings...........................................................................................61
2.2 What to do before creating drawings .................................................................65
2.3 Create general arrangement drawings ..............................................................66
2.4 Create single-part, assembly, or cast unit drawings ............................................67
2.5 Create AutoDrawings ........................................................................................69
Create AutoDrawings ............................................................................................69
AutoDrawings wizard files ......................................................................................70
Wizard log ................................................................................................................72
2.6 Create multidrawings ..........................................................................................72
Link or copy drawing views to empty multidrawings .................................................73
Create multidrawings of selected drawings ............................................................73
Create multidrawings of selected parts ....................................................................74
2.7 Create drawings in Master Drawing Catalog ......................................................75
Master drawing types ................................................................................................76
Cloning templates in Master Drawing Catalog .........................................................77
Saved settings in Master Drawing Catalog ...............................................................77
Rule sets in Master Drawing Catalog .......................................................................79
Wizards in Master Drawing Catalog .......................................................................80
Apply detailed object level settings in saved settings ..............................................81
Create general arrangement drawings using saved settings in Master Drawing Catalog ......................................................................................................................82
Create anchor bolt plans using saved settings .......................................................82
Objects included in the anchor bolt plan .................................................................83
Include assemblies in anchor bolt plans .................................................................85
Create single-part, assembly and cast unit drawings using saved settings in Master Drawing Catalog ..........................................................86
Example: Create cast unit drawings one by one .....................................................87
Example: Create assembly drawings from groups of similar parts .........................90
Create drawings using rule sets or wizards in Master Drawing Catalog .................92
Example - Create a new rule set and drawings for all parts .....................................93
Create multiple drawing sheets of the same part ....................................................99
Create multiple drawing sheets with wizards .........................................................99
Create multiple drawing sheets using drawing properties ..................................100
Search for master drawings and save the results in Master Drawing Catalog .........100
Customize Master Drawing Catalog ....................................................................101
Add master drawings in Master Drawing Catalog .................................................101
Remove master drawings from the Master Drawing Catalog ..................................105
Modify master drawing properties .........................................................................106
Modify saved settings' properties ..........................................................................107
Modify rule set properties .......................................................................................108
Modify properties and contents of wizard files ...................................................109
Modifying cloning template properties ..................................................................110
Manage Master Drawing Catalog folders .............................................................111
Example: Add, rename, and move folders ..............................................................112
Copy master drawings to another folder ...............................................................113
Remove master drawings from a folder ..................................................................113
Sample images of drawings ...................................................................................114
Create sample images for Master Drawing Catalog ..............................................114
Add sample and thumbnail images to master drawings .........................................115
2.8 Clone drawings.................. 115
Create drawings using cloning templates in Master Drawing Catalog.................. 116
Clone by using cloning templates located in other models................................. 117
Clone from the Drawing List............................................................................. 118
Example: Clone a general arrangement drawing.............................................. 120
Clone dimensions in selected views only............................................................ 122
Cloned objects..................................................................................................... 123
What to check in cloned drawings................................................................. 123
Refresh drawing associativity after cloning....................................................... 125
Copy a drawing to a new sheet......................................................................... 125
Clone using drawing templates in template library........................................... 126

3 Search for and open drawings.............. 127
3.1 Open Drawing list.................. 128
3.2 What is displayed in the Drawing list......................................................... 128
3.3 Drawing status flags..................................................................................... 131
3.4 How to read the drawing status information.............................................. 131
3.5 Select the drawings to show in Drawing List.............................................. 134
3.6 Search for drawings and save search results............................................ 134
3.7 Select drawings in the Drawing List............................................................ 135
3.8 Check whether parts have drawings.......................................................... 136
3.9 Open drawings............................................................................................. 136
Open a drawing in the model........................................................................... 137
Open a new drawing when a drawing is already open........................................ 137
Cannot load the selected drawing...................................................................... 137
3.10 Create and view drawing snapshots......................................................... 137
Snapshot overlay............................................................................................... 139
Snapshot overlay in model................................................................................ 140
Snapshot overlay in drawings.......................................................................... 141
3.11 Close drawings........................................................................................... 141

4 Edit drawings................................. 143
4.1 Rename drawings...................... 144
4.2 Give titles to drawings................. 145
4.3 Drawing views in open drawings................................................................. 145
Create a section view....................................................................................... 147
Create a curved section view.......................................................................... 149
Create a detail view.......................................................................................... 150
Define a start number or letter for detail view label and mark.......................... 152
Create additional drawing views of parts......................................................... 152
Create a drawing view of an entire model view................................................ 153
Create a drawing view of a selected area in a model view................................. 154
Create a drawing view of a selected area in a drawing view.............................. 155
Add single-part views in assembly drawings..................................................... 156
Create a drawing view for a reinforcement mesh (RebarMeshViewCreator)......... 156
Copy drawing views from other drawings......................................................... 159
Move drawing views to another drawing.......................................................... 160
Link drawing views from other drawings......................................................... 162
Resize the drawing view boundary................................................................. 162
4.4 Dimensions in open drawings ................................................................. 170
Add manual dimensions ............................................................................ 171
Example: Manual dimensions .................................................................... 173
Add manual dimensions to general arrangement drawings ..................... 177
Add manual dimensions using User Coordinate System ......................... 178
Add tags to dimensions ............................................................................. 179
Example: How to filter out dimension tag content .................................... 181
Add dual dimensions manually ................................................................. 183
Recreate dimensions for all parts ............................................................ 184
Add dimensions to reinforcement ............................................................ 185
  Add dimension marks or dimension tags to rebar groups ....................... 185
  Add dimension lines to rebar groups ..................................................... 186
  Predefined reinforcement dimension settings in the Options dialog box .. 188
  Examples of rebar dimensions ............................................................. 190
  Add dimensions to rebar groups (Rebar group dimensioning) ............... 194
Dimension center of gravity (COG) ......................................................... 198
Exaggerate selected dimensions in drawings (ExaggerateSelectedDimensions) 202
Modify dimension properties .................................................................. 203
Add dimension points in anchor bolt plans ............................................. 204
Show plate side marks on dimension leader lines ................................... 204
Change the location of short outside dimension texts ............................ 205
Set a new dimension start point ............................................................. 206
Add closing dimensions ........................................................................ 207
Add or remove dimension points ........................................................... 208
Link perpendicular dimension lines ....................................................... 208
Combine dimension lines ....................................................................... 209
Set the dimension extension line length ................................................ 210
Drag dimension marks .......................................................................... 212
Move the end of the dimension line ....................................................... 214

4.5 Drawing marks, notes, texts and links in open drawings .................... 214
Add part marks manually in drawings ..................................................... 215
Add reinforcement marks manually in drawings .................................... 216
Add level marks in drawings ................................................................. 217
Add section marks in drawings ............................................................. 218
Add detail marks .................................................................................. 218
Add associative notes in drawings .......................................................... 219
Modify associative annotation object (note, mark) properties ................ 220
Adjust mark visibility in an existing drawing ......................................... 221
Update part and weld marks in drawings .............................................. 223
Delete marks for selected parts ............................................................. 224
Change symbols in drawings ................................................................ 226
  Remove change symbols .................................................................... 226
  Hide all change symbols in a drawing (RemoveChangeClouds) .......... 227
Merge marks ......................................................................................... 227
  Merge reinforcement marks manually ............................................... 232
  Drag the mark and associative note leader line base point ................ 232
Add text in drawings ............................................................................ 233
  Add text in superscript ....................................................................... 235
Examples.................................................................................................................. 294

4.16 2D Library in drawings.......................................................................................... 296
Open and view 2D Library.................................................................................. 297
Insert a detail to a drawing from 2D Library................................................................ 299
Create a new detail in 2D Library........................................................................... 300
Create a new folder in 2D Library and copy/move to the folder................................. 303
Modify detail properties in 2D Library.................................................................... 303
Explode a detail....................................................................................................... 304
Update objects in a detail...................................................................................... 304
Explode symbols included in details....................................................................... 305
Insert a .dwg file to a drawing from 2D Library...................................................... 305
Insert an image to a drawing from 2D Library....................................................... 306

4.17 Welds in drawings.............................................................................................. 306
Examples: Model welds in drawings........................................................................ 310
Modify model weld mark visibility and appearance in a drawing............................ 316
Modify model weld representation and appearance............................................... 318
Drag weld marks...................................................................................................... 320
Add manual weld marks in drawings...................................................................... 322
Customize weld type symbols.................................................................................. 323
Example: Weld marks added in drawings................................................................. 324
Merge weld marks................................................................................................... 326

4.18 Custom presentations in drawings...................................................................... 328

4.19 Pours in drawings.............................................................................................. 329
Modify pour objects, pour marks and pour breaks in a drawing............................... 331
Change the pour break symbol................................................................................ 332
Examples of pour drawings and pour reports............................................................ 333

4.20 Grids in drawings.............................................................................................. 334
Modify grid and grid line properties in drawings...................................................... 334
Customize drawing grid labels................................................................................ 335
  Modify grid model properties.................................................................................. 335
  Customize drawing grid labels.............................................................................. 337
  Customize a grid label on a single grid line............................................................ 339
  Modify custom grid labels..................................................................................... 339
  Customize grid labels only at one end of a grid line.............................................. 339
  Add different customized grid labels on horizontal and vertical grid lines......... 341
Use model grid coordinates and prefix as text on grid axis in a drawing.................. 343
Limitations............................................................................................................... 346
Drag grid labels....................................................................................................... 347
Hide grids or grid lines......................................................................................... 347

4.21 Symbols in drawings.......................................................................................... 347
Change a symbol in a symbol file............................................................................. 349
Create a new symbol file......................................................................................... 351
Change the symbol file in use.................................................................................. 351
Add symbols in drawings....................................................................................... 351
Customize leader line arrows.................................................................................. 352
Modify symbol properties....................................................................................... 354
Moment connection symbols in Tekla Structures drawings (Drawing tools).............. 355
  Create moment connection symbols (Drawing tools)......................................... 355
  Update moment connection symbols (Drawing tools)........................................... 357
  Delete moment connection symbols (Drawing tools).......................................... 358
Add surface treatment symbols in drawings (AddSurfaceSymbols)......................... 358
Define a firm folder for images and symbols............................................................ 359

4.22 Colors in drawings............................................................................................ 360
7.6 Print to multiple sheets........................................................................................................410
7.7 Printing settings in Print Drawings dialog box.................................................................411
7.8 Frames and fold marks in drawings....................................................................................413
Add frames and fold marks in printouts..................................................................................414
7.9 Set up printer instances in Printer Catalog........................................................................416
Add a printer instance.............................................................................................................416
Add a print-to-file instance......................................................................................................417
Add an Adobe postscript printer instance...............................................................................418
Define printing paper size and print area h*b.........................................................................419
Line thickness (pen number) in Color Table...........................................................................420
Change the pen numbers (line thickness) for colors.................................................................421
7.10 Printing tips..........................................................................................................................422
8 Define automatic drawing settings......................................................................................424
8.1 Drawing layout....................................................................................................................429
Table layouts................................................................................................................................430
Tables in drawing layout...........................................................................................................432
Create a new drawing layout, add table layouts and tables.....................................................433
Define fixed drawing sizes and connect layouts.....................................................................438
Define calculated sizes and connect layouts...........................................................................439
Replace a table with another one in table layout.....................................................................440
Set the location of tables in a drawing table layout.................................................................441
Key plans......................................................................................................................................443
Create a drawing to be used as a key plan..................................................................................444
Add a key plan in a drawing table layout..................................................................................445
Add a DWG/DXF file in a drawing table layout........................................................................445
Select a new layout for your drawing.......................................................................................446
Edit tables in Template Editor..................................................................................................447
8.2 Drawing size and drawing view scale................................................................................448
Set exact drawing view scale and automatic drawing size......................................................449
Set exact drawing size and automatic drawing view scale......................................................450
Autoscale and autosize drawings.............................................................................................452
8.3 Object protection and placement settings in drawings....................................................453
Protected areas in drawings......................................................................................................454
Protect areas in a drawing........................................................................................................456
Define automatic placement settings for marks.....................................................................458
Define placement settings for dimensions...............................................................................459
Define automatic free or fixed placement for drawing views..................................................461
8.4 Automatic drawing views..................................................................................................461
Define the views to create in single-part, assembly and cast unit drawings............................463
Define automatic view settings for general arrangement drawings.........................................464
Define view labels and view label marks..................................................................................465
Set drawing view projection type...............................................................................................467
Include single-part drawings in assembly drawings...............................................................469
Part orientation in drawing views.............................................................................................471
Change the coordinate system.................................................................................................472
Rotate parts in drawing views....................................................................................................474
Select the steel or timber part face that is shown in front drawing view....................................476
Set viewing direction for parts in assembly drawings...............................................................477
Change plate orientation in drawings......................................................................................478
Show neighbor parts in views....................................................................................................480
Shorten or lengthen parts..........................................................................................................482
8.5 **Automatic dimension settings** ................................................................. 498

- **Automatic view-level dimensions** .......................................................... 500
- **Add automatic view-level dimensions** .................................................... 504
- Define the drawing properties file ................................................................. 504
- Define the drawing views to be created ....................................................... 505
- Define view dimensions ................................................................................ 506
- Connect view properties to views and save drawing properties .................. 509

**Example workflow:** Create automatic overall and hole dimensions on view level... 510

**Dimensioning rule properties** .................................................................... 519

- Create a drawing view filter for view-level dimensioning .............................. 527
- Create a filter for holes and recesses ............................................................ 528
- Create a filter for the main part of an assembly ............................................ 529
- Create an exclude filter for dimension tag .................................................... 530
- Create an exclude filter for stirrups in section views ...................................... 531

**Dimensioning method of shapes, holes and recesses** .................................. 531

**Various scenarios of using different dimensioning types** .......................... 535

- Example: Use both view-level dimensioning and integrated dimensioning... 536
- Example: Use only view-level dimensioning ................................................ 536
- Example: Use only integrated dimensioning ................................................ 537

**Examples:** Dimensions created with view-level dimensioning .................. 539

**Add automatic view-specific dimensions using dimensioning type Integrated** 545

- Group identical objects to the same dimension line ...................................... 547
- Add elevation dimensions ........................................................................... 548
- Check dimensions ....................................................................................... 550
- Example: Part dimensioning ........................................................................ 553
- Example: Bolt dimensioning ....................................................................... 555
- Example: Position dimensioning ................................................................. 556
- Example: Closing dimension ..................................................................... 561
- Example: Combine dimensions ................................................................... 563
- Example: Combine bolt group dimensions ................................................ 565
- Example: Forward offset ............................................................................ 566
- Example: Grid dimensions .......................................................................... 567
- Example: Recognizable distance ............................................................... 567
- Example: Preferred dimension side ............................................................ 568
- Example: Reinforcement dimension ............................................................ 569

**Add automatic dual dimensions** ................................................................. 570

**Add dimensions to unfolded parts** ............................................................ 571

- Add minimum and maximum position dimensions to bolts ....................... 573
- Create dimension line extensions ............................................................... 573
- Change the appearance of absolute dimensions ......................................... 574
- Create exaggerated dimensions .................................................................. 574
- Change the prefix in radial dimensions ....................................................... 576

**Add dimensions to plates** ........................................................................ 577

**Add dimensions to profiles** ....................................................................... 581
8.6 Automatic mark settings ................................................................. 600
  Add automatic marks ........................................................................ 602
  Adjust the visibility of automatic marks ........................................... 604
  Adjust text, frames and leader lines of automatic marks ................. 608
  Adjust part mark leader lines with advanced options ..................... 609
  Place reinforcement mark leader line base point automatically ......... 610
  Mark location .................................................................................... 611
  Set a predefined location for beam, bracing and column marks ........ 612
  How leader line type affects part mark and surface treatment mark location... 613
  How merging affects reinforcing bar group mark location ............... 614
  How leader line type affects reinforcement mark location .............. 615
  Merge marks automatically ............................................................. 615
  Merged part marks ......................................................................... 616
  Merge part marks automatically ..................................................... 618
  Merged reinforcement marks ......................................................... 618
  Merge reinforcement marks automatically ....................................... 619
  Show mark frames and leader lines for hidden parts ....................... 621
  Change unit settings for marks ....................................................... 622
  Add attributes in automatic marks .................................................. 624
  Add level attributes in automatic part marks .................................... 625
  Add templates in marks ................................................................. 628
  Example 1: Create a mark template containing separate value fields and text elements .................................................. 63
  Example 2: Create a mark template containing a formula in the value field.. 632
  Add symbols in automatic marks ..................................................... 634
  Define size in bolt marks using advanced options ......................... 634
  Add pull-out pictures in automatic reinforcement marks ................ 637

8.7 Automatic grid settings in drawings .............................................. 639
  Define automatic grid properties ..................................................... 641

8.8 Automatic part and neighbor part settings in drawings ................ 641
  Define automatic drawing part properties ...................................... 642
  Example: Part representations ....................................................... 643
  Define automatic neighbor part properties .................................... 644
  Indicate part orientation ............................................................... 645
    Use part mark as an orientation mark in general arrangement drawings... 646
    Show compass direction in part marks ......................................... 648
    Show orientation marks (north marks) ........................................ 649
    Show connecting side marks ..................................................... 650

8.9 Automatic bolt settings in drawings .............................................. 652
  Define automatic bolt properties in drawings ................................. 652
  Create customized bolt symbols .................................................... 653
  Example: Bolt representations ....................................................... 654

8.10 Automatic hatches in drawings ..................................................... 655
Add hatches (fills) to parts and sketch objects in drawings................................. 656
Hatch pattern settings (.htc) for automatic drawing hatches.............................. 660
Colors in drawing hatches................................................................................... 662
Example: Insulation hatch patterns....................................................................... 664

8.11 Automatic surface treatment in drawings.................................................... 665
Define automatic surface treatment in drawings............................................ 666

8.12 Automatic weld settings in drawings......................................................... 667
Define automatic model weld properties in drawings........................................ 667

8.13 Automatic pour object settings in drawings................................................ 668
Show pour objects, pour marks and pour breaks in drawings............................ 668

8.14 Automatic reinforcement and mesh settings in drawings............................. 670
Define automatic reinforcement and reinforcement mesh properties................ 670
Example: Hide reinforcing bar lines in drawings.............................................. 672
Example: Reinforcement representations............................................................ 672
Automatic grouping of rebar sets for drawings................................................... 673

8.15 Units and decimals in drawings, reports and templates ................................ 675

8.16 User-defined attributes in drawings............................................................. 677
Modify automatic user-defined drawing attributes............................................ 678
Create a new user-defined drawing attribute..................................................... 679

8.17 Define customized line types in TeklaStructures.lin.................................. 682

9 Drawing settings reference.............................................................................. 684

9.1 General arrangement drawing properties..................................................... 685

9.2 Single-part, assembly and cast unit drawing properties................................. 688

9.3 Layout properties.......................................................................................... 690

9.4 View properties in drawings........................................................................ 692

9.5 Section view properties................................................................................ 698

9.6 Dimension and dimensioning properties...................................................... 699
Dimension properties - General tab................................................................. 700
Dimension properties - Units, precision and format............................................ 704
Dimension properties - Appearance tab............................................................ 705
Dimension properties - Marks and Tags tabs.................................................... 706
Dimensioning properties - General tab (Integrated dimensioning).................. 710
Dimensioning properties - Position dimensions tab (Integrated dimensioning).... 713
Dimensioning properties - Part dimensions tab (Integrated dimensioning)......... 716
Dimensioning properties - Bolt dimensions tab (Integrated dimensioning)........ 718
Dimensioning properties - Dimension grouping tab (Integrated dimensioning).... 720
Dimensioning properties - Sub-assemblies tab (Integrated dimensioning)........ 721
Dimensioning properties - Reinforcement dimensions tab (Integrated dimensioning).............................................................................................................. 722
Dimensioning properties - Grid tab (GA drawings)............................................ 723
Dimensioning properties - Parts tab (GA drawings).......................................... 724

9.7 Mark properties........................................................................................... 726
Mark properties - General, Merging and Content tabs........................................ 726
Leader line types................................................................................................. 730
Positioning properties of view label, section and detail marks........................... 731
Drawing weld mark properties........................................................................... 732
Model weld mark visibility and appearance properties in drawings.................. 734
Level mark properties......................................................................................... 736

9.8 Mark elements.............................................................................................. 737
Common elements in marks........................................................................................................738
Part mark elements..................................................................................................................739
Bolt mark elements...............................................................................................................741
Reinforcement and neighbor reinforcement mark elements.................................................742
Reinforcement and neighbor reinforcement mesh mark elements........................................744
Elements in merged reinforcement marks............................................................................745
Connection mark elements....................................................................................................746
Pour object mark elements ....................................................................................................747
Surface treatment mark elements..........................................................................................747
Section and detail mark elements...........................................................................................748
View, section view and detail view label mark elements.........................................................748

9.9 Part and neighbor part properties in drawings..............................................................749
9.10 Bolt content and appearance properties in drawings..................................................754
9.11 Surface treatment visibility and content properties in drawings.................................755
9.12 Surface treatment hatch pattern properties (surfacing.htc)..........................................756
9.13 Reinforcement/Neighbor reinforcement and mesh properties in drawings..................758
9.14 Reinforcement settings for drawings (rebar_config.inp)..................................................760
9.15 Pour object and pour break properties in drawings.......................................................767
9.16 Placement properties for marks, dimensions, notes, texts and symbols........................770
9.17 Model weld properties in drawings................................................................................771
9.18 Drawing sketch object properties..................................................................................773
9.19 Drawing grid properties..................................................................................................774

10 Disclaimer....................................................................................................................777
Drawings in Tekla Structures

Tekla Structures drawings contain a large variety of features and tools that help you to create and manage your drawings efficiently.

- The model is the single source of information for drawings. The drawing is just another view to the model, usually a 2D view. This ensures that the information in drawings and reports is always up-to-date.
- Creating drawings is fast, efficient and controlled thanks to one centralized location, **Master Drawing Catalog**.
- Automatic workshop single-part and assembly drawings, and cast unit drawings of selected parts with predefined settings for layout, views, dimensions, marks, and building objects. View properties are defined separately for each view before a drawing is created.
- Automatic general arrangement drawings and anchor bolt plans of selected views.
- Drawing objects are associated with model objects, and updated when the model changes.
- Changing some of the properties requires the recreation of the drawings.
- If there are several identical parts, cast units or assemblies in the model, Tekla Structures creates only one drawing.
- You can modify drawing properties on three levels; drawing, view and object level, depending on the drawing type and the desired results.
- The drawings consist of three main types of elements: drawing layout, drawing views, and drawing objects. You can select what to include in the drawing before you create it, and also add necessary objects in an existing drawing.
- You can check previews of the drawings and print your drawings to pdf, printer or plot file.
- You can control drawing revisions, and issue, lock, and freeze drawings.
- You can use interactive editing tools for adding dimensions, various sketch objects, marks, notes, texts, symbols, images and links in the drawings.
<table>
<thead>
<tr>
<th>To</th>
<th>Click the links below to find out more</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check the controls available in drawing mode</td>
<td>Drawing mode in Tekla Structures (page 19)</td>
</tr>
<tr>
<td>Find out how the drawings are integrated to the model and what the integration means</td>
<td>Drawings integrated with models (page 17)</td>
</tr>
<tr>
<td>Find out what drawing associativity means</td>
<td>Drawing associativity (page 17)</td>
</tr>
<tr>
<td>Find out what happens when a drawing needs to be updated</td>
<td>How to keep your drawings up to date? (page 23)</td>
</tr>
<tr>
<td>Learn where you can change the drawing properties and in which order</td>
<td>Different levels of setting up and modifying drawing properties (page 23)</td>
</tr>
<tr>
<td>Find out the cases when a drawing needs to be updated</td>
<td>Settings affecting the recreation of drawings (page 41)</td>
</tr>
<tr>
<td>Find out what the drawing consists of</td>
<td>Drawing layout and views (page 20)</td>
</tr>
<tr>
<td>Find out what kind of objects there are in drawings</td>
<td>Drawing objects (page 21)</td>
</tr>
<tr>
<td>Check the different drawing types available and learn how to create them using different methods</td>
<td>Create drawings in Tekla Structures (page 43)</td>
</tr>
<tr>
<td>Create drawings by cloning, and find out the situations when cloning is the best choice</td>
<td>Clone drawings (page 115)</td>
</tr>
<tr>
<td>Find the drawings that you need using searching and filtering in Drawing List, select drawings, and open drawings</td>
<td>Search for and open drawings (page 127)</td>
</tr>
<tr>
<td>Edit your drawings manually: add objects, modify properties, etc.</td>
<td>Edit drawings (page 143)</td>
</tr>
<tr>
<td>Update drawings when the model changes, lock drawings, freeze drawings, issue drawings, revise drawings, and delete drawings</td>
<td>Manage drawings (page 372)</td>
</tr>
<tr>
<td>Print drawings as PDF files, save them as plot files (.plt) for printing with printer/plotter, or print them on a selected printer</td>
<td>Print drawings (page 382)</td>
</tr>
<tr>
<td>Set up and modify automatic drawing settings</td>
<td>Define automatic drawing settings (page 424)</td>
</tr>
<tr>
<td></td>
<td>Automatic drawing views (page 461)</td>
</tr>
<tr>
<td>Check the available drawing properties and setting</td>
<td>Drawing settings reference (page 684)</td>
</tr>
</tbody>
</table>
1.1 Drawings integrated with models

Tekla Structures integrates the drawings with the model. A drawing is a window to the model presenting 3D structures in 2D. The building objects shown in the drawing are model objects you create in the model. You can change their representation in the drawing but you cannot change the geometry or the location of the building object, or delete building objects; all changes to building objects are made in the model. That is why the drawings are always up-to-date. For example, dimensions and marks in drawings are always correct. You can filter out parts and bolts in drawings using the filtering tools, or make them invisible by hiding them.

You can create drawings at any stage of the project. Creating single-part, assembly and cast unit drawings requires that the model is numbered, so you need to plan and perform the numbering before creating drawings.

If the model changes, Tekla Structures notifies in the Drawing List that you need to update the related drawings. You cannot open a drawing that is not up-to-date.

See also

Numbering the model

Update drawings when the model changes (page 372)

1.2 Drawing associativity

Tekla Structures drawings are associative. The objects in the drawing are linked to model objects, which means that most objects in the drawing are automatically updated when the corresponding model objects change. For example, if a model object is resized, the dimension points move with the corresponding object in the drawing, and the dimensions are recalculated. Still you do not lose any manual changes that you have made in the drawing. This applies to all drawing types.

Tekla Structures updates the following drawing objects to reflect the changes in the model:

- Parts
- Marks
- Dimensions
- Welds
- Views
Tekla Structures retains the following manual changes made to drawings:

- Base points of objects; for example, if you drag an object to a new location
- Object properties; for example, color, font, and line type

Advanced options related to associativity

- XS_ASSOCIATIVE_CHANGE_HIGHLIGHT_SIZE
- XS_ASSOCIATIVE_CHANGE_HIGHLIGHT_SYMBOL
- XS_HIGHLIGHT_ASSOCIATIVE_DIMENSION_CHANGES

See also

Associativity symbol (page 18)

**Associativity symbol**

In drawings, the associativity symbol indicates which drawing objects are associative and automatically updated. Associativity symbols are shown only when you select a drawing object, for example, a dimension.

Objects that do not have valid association get a ghost associativity symbol and a question mark. These symbols are shown constantly, even though the drawing object is not selected. This makes it easier to find objects that need attention.
The associativity symbols are not shown in printed drawings.

**TIP** To hide associativity symbols in drawing views, on the **File** menu, select **Settings --> Associativity symbol (Shift+A)**.

### 1.3 Drawing mode in Tekla Structures

When you open a drawing, Tekla Structures activates the drawing mode. The ribbon and tabs for the modeling mode are replaced by those of the drawing mode. The model views remain on the screen on the background.

The following image identifies the locations of the controls in the a drawings window:
1. The **File** menu only contains buttons available in drawings.
2. The ribbon and the tabs mostly contain commands available in drawings, some buttons are common with modeling mode.
3. **Quick Launch** for searching drawing-related commands.
4. The side pane gives access to macros and other applications that are available in drawings in the **Applications & components** catalog. The **2D Library** for drawings is also located in the side pane.
5. With select switches you can scale down the amount of selectable objects.
6. Snap settings control which points you can snap to and pick.

### 1.4 Drawing layout and views

A Tekla Structures drawing consists of two types of basic elements:

- A **drawing layout** (page 429) defines the drawing size and the included tables, such as revision tables, title blocks, material lists, bills of material, general notes, key plans and DWG files. Tekla Structures has a range of predefined layouts, and you can also create layouts of your own. The tables
included in your drawing are those included in the layout you have chosen to use.

- **Drawing views (page 145)** are views to the whole model, to a part of the model or to individual parts in the model. Views can show building objects from different directions (top, front, back, bottom) and cross sections. Drawing views act as containers for the building objects or areas in the model that you have selected to be included in the drawing.

Below is an example of the drawing layout and views in a workshop drawing.

1. Top view to a part. Here you have selected to include the top view (page 463) in the **View creation** pane.
2. Front view to a part. Here you have selected to include the front view (page 463) in the **View creation** pane.
3. Material list. This is defined in your drawing layout.
4. Drawing title block. This is defined in your drawing layout.

**See also**

*Drawings in Tekla Structures (page 15)*
1.5 Drawing objects

Drawing views may contain several types of objects. Some of them come from the model and represent something that will exist in the real building or will be closely related to it. Others are objects that represent information that is only relevant in the drawing, or add extra information to the information in the model. Drawings may include the following object types:

- **Building objects (page 283):** parts, bolts, welds, chamfers, reinforcing bars, surface treatment, etc.
- **Associative annotation objects (page 214):** dimensions, marks, associative notes.
- **Independent annotation objects (page 214):** objects that are not linked to the model: text, .rtf files, symbols, links, hyperlinks, DWG/DXF files, and reference models. These objects become associative if they have associativity points, i.e. they are associated to building objects.
- **Sketch objects (page 259):** graphical objects you create using the various sketching tools. These objects can be used for highlighting parts of the drawing (clouds, lines, rectangles, etc.), for example. These object are associative if they have associativity points, i.e. they are associated to building objects.

1. Sketch objects: clouds and rectangles
2. Dimensions
3. Marks, associative notes
4. Building objects

1.6 How to keep your drawings up to date?
When a model changes, the related drawings need to be updated. Tekla Structures takes care of updating and notifies you if updating is needed.

WARNING When you start using a newer version of Tekla Structures, updating drawings created with the older version may cause problems. We recommend that you complete any drawings you have started using the older version, or recreate the drawings using your new version of Tekla Structures.

You need to update drawings when:
• The geometry of a model object changes.
• Some other model object properties, for example, material and class change.
• Model objects are added or deleted.
• The number of identical model objects changes.

Tekla Structures automatically updates drawings each time you number the model. If you have not numbered the model, you are prompted to do so when you create a drawing. Furthermore, if you have changed the model and go to the Drawing List to open drawings, Tekla Structures has marked the outdated drawings, and you need to update them before you can open them.

General arrangement drawings are always updated when you open them if the model has changed. You do not need to number the model to update general arrangement drawings.

Click the following links to find out more about drawing update, when recreation is needed, and how the drawings are numbered:

Update drawings when the model changes (page 372)
Settings affecting the recreation of drawings (page 41)
Numbering the model
1.7 Different levels of setting up and modifying drawing properties

In Tekla Structures, you can set up and change drawings and drawing properties on different levels, depending on how permanent and extensive changes are needed. You can change drawings on drawing, view and object level.

**Single-part, assembly and cast unit drawings**

- On the highest level, you can define drawing properties on *drawing level*:
  - Some of the drawing-specific properties that you define in the **Drawing Properties** dialog box apply to the whole drawing: protection settings, user-defined attributes for the drawing, detail view start number/letter, drawing-specific section view settings, some drawing-specific view attributes, drawing titles and drawing layout settings.
  - On the drawing level, you can also select the views that you want to create, and set view, dimensioning, building object and mark settings separately for each view by going further to the **View Properties** dialog box for the selected view. For example, you can define that all marks have blue frame in one view, or that model weld marks are shown in another view. It is very important to save the view-level properties files in the **View Properties** dialog box to be able to connect the desired view properties to the views that you select to create.
  - You can modify the drawing level properties before you create the drawing and also change them in the created drawing.

- You can also change drawing properties in single-part, assembly and cast unit drawings on *view level*:
  - Double-click a view frame in an open drawing, which opens the **View Properties** dialog box.
  - Change an object property. The change takes place only in the views that you have selected in an open drawing.
  - The object properties change in all objects of the particular type in the selected views. For example, if you change the mark line color, the mark line changes in all marks in the selected views.

- Finally, you can change drawing properties on *object level*:
  - Double-click an object in an open drawing, which opens an object-specific property dialog box.
  - Properties change for the selected object only.
  - The properties changed on the object level are no longer affected by any property changes on higher levels.
General arrangement drawings

- On the highest level, you can change general arrangement drawing properties on drawing level Drawing Properties dialog box and its subdialog boxes:
  - This way you can change the properties of all building objects, marks, dimensions, and views in the drawing at the same time. For example, you can define that all marks have blue frame.
  - You can modify the drawing properties before you create the drawing and also change them in the created drawing.
  - The object properties change in all views and objects in that drawing, except for new views that you create after the drawing is created.
- You can also change general arrangement drawing properties on view level:
  - Double-click a view frame in an open drawing, which opens the View Properties dialog box.
  - The changes take place only in the views that you have selected in an open drawing.
  - The object properties change in all objects of the particular type in the selected views. For example, if you change the mark line color, the mark line changes in all marks in the selected views.
- Finally, you can change drawing properties on object level:
  - Double-click an object in an open drawing, which opens an object-specific property dialog box.
  - Properties change for the selected object only.
  - The properties changed on the object level are no longer affected by any property changes on higher levels.

Detailed object level properties

By saving the object property settings and combining them with drawing or view filters and drawing object types into detailed object level settings, you can also apply the object level properties on the drawing and view level. Note that detailed object levels properties on drawing level are available only in general arrangement drawings. Object level settings are a powerful tool: you can use the same property file for creating drawings and quickly change a particular property before you create drawings, for example, reinforcement color or mark frame shape. The object level settings override the property settings in the view and drawing property dialog boxes. Changes in the object level settings applied on the drawing level are inherited to the view level if there are no object level settings defined on the view level. If you apply object level settings on the view level, they override the drawing level settings.

Recommended workflow

The recommended way of working is to work from top to bottom, from drawing level to object level:
1. Set your drawing and automatic drawing view properties as close as possible to what you want by first attempting this on the drawing level.

2. Then modify anything else that needs to be changed on the view level.

3. Finally, if any further cleanup is necessary, you can make changes on the individual object level.

The modifications made on the drawing level remain when the drawing is recreated due to a model change. Once you change properties on the view level you should not go to the drawing level properties and modify drawing properties there. Once you have change something at one level, changing something else on the level above may negate the changes you have just made.

**Example workflow**

The following image illustrates the idea of the three property levels. The frame color and the shape of the mark are used as an example.

1. You change the mark frame color and shape for the whole drawing on the drawing level. The changes propagate to the view level and to the object level.

2. You change the mark frame color and shape in the selected views. The changes take place in the selected views only. The properties do not change in the whole drawing.

   Note that if you change the frame color and shape on the drawing level after changing them on the view level for some of the views, the drawing level changes override the view level changes in all views. In this case, only view settings are not overridden, for example, the view scale stays as you have set it for individual views.

3. You change the mark frame color and shape in the selected marks. The properties do not change anywhere else. If you try to change the mark frame color and shape on the view or drawing level, the properties do not change in the marks that you changed separately.

Click the following links to find out more:

*Set automatic drawing properties before creating drawings (page 27)*
Set automatic drawing properties before creating drawings

Tekla Structures creates drawings using the automatic drawing properties defined separately for each type of drawing.

1. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type.

2. If possible, load drawing properties closest to the ones you need by selecting a properties file from the list at the top.

   In general arrangement drawing properties, you need to click **Load**.

3. Do one the following, depending on the type of the drawing:

   **Single-part, assembly and cast unit drawings:**
   a. Go through the various properties in the options tree and adjust the values as requires.
      The check boxes next to the options are automatically selected when you change something for that particular option.
   b. To save properties, for example, protection properties for future use, give a unique name for the properties in the **Save** box and click **Save**.
      Note that you should not include spaces or special characters in the name.
   c. To adjust view-level settings (views, dimensions, marks and objects), click **View creation**, select the desired view and view properties file, and then click **View properties**.
   d. Adjust the properties for the selected view as required.
   e. To save properties, for example, part properties for future use, give a unique name for the properties in the **Save** box and click **Save**.
      Note that you should not include spaces or special characters in the name.
   f. Click **Save** in **View Properties** to save the properties in the view properties file, when you are done.
g. Click OK in View Properties to return to the drawing properties.

General arrangement drawings:

a. Switch off the all the check boxes by clicking the on/off switch at the bottom and only select the check boxes for the options that you wish to change.

b. Go through the various properties in the drawing properties dialog box, and make the necessary changes.

c. Click OK in each subdialog box where you changed the properties to save the changes and to return to drawing properties.

d. To save properties, for example, part properties, for future use, give a unique name for the properties in the Save as box and click Save as. Note that you should not include spaces or special characters in the name.

4. Click Save to save the properties.

If you want to save the changes in another drawing properties file, enter the new name.

Note that you should not use spaces in the properties file name, this may cause problems. For example, when you use the drawing properties file in a rule set in the Master Drawing Catalog, the drawings are not created if the properties file name contains spaces.

In general arrangement drawing properties, click Save as.

Now you can create a drawing using the drawing properties file that you just set up.

Modify view-level drawing properties

You can modify the view-level drawing properties after you have created the drawing. Most of the properties that a single-part, assembly and cast unit drawing have are specified for each of the drawing views separately already before creating a drawing in the automatic drawing properties. General arrangement drawings do not have automatic view properties, and the view properties can only be modified in an open drawing.

The changes you make in view properties apply only to the view that you have selected to modify.

1. Open the drawing.

2. Double-click a drawing view frame to open the drawing view properties dialog box.
3. The check boxes in the options tree are off by default. When you touch a property, for example, select an option in the panel, Tekla Structures adds a check mark to the check box next to the option in the option tree.

4. Make the necessary changes.

5. Click **Modify** when you are ready with the changes.

The view changes according to the changes that you made in the drawing view properties.

**NOTE** Some of the changes you make require a drawing recreation. For more information, see *Settings affecting the recreation of drawings (page 41)*.

**See also**

*Modify drawing properties of an existing drawing (page 29)*

**Modify drawing properties of an existing drawing**

If you are not satisfied with the drawing properties after creating the drawing and checking it, you can modify the automatic drawing properties in the created drawing.

1. Open the drawing.

2. Double-click the drawing background.

3. Do one of the following, depending on the type of the drawing:

   **Single-part, assembly and cast unit drawings:**
   
   a. Go through the various options in the options tree and adjust the values as required.

   The check boxes next to the options are automatically selected when you change something for that particular option.

   b. To adjust view-level settings (views, dimensions, marks and objects), click **View creation**, select the desired view and view properties file and click **View properties**.

   c. Adjust the view properties as required.

   d. Click **Save** in **View Properties** to save the properties in the view properties file, when you are done.

   e. Click **OK** in **View Properties** to return to the drawing properties.

   **General arrangement drawings:**

   a. Switch all the check boxes off by clicking the on/off switch at the bottom of the dialog box and only select the check boxes for the options that you wish to change.
b. Go through the various options in the drawing properties dialog box, and make the necessary changes.

c. Click OK in each subdialog box where you changed the properties to save the changes and to return to drawing properties.

4. Click **Modify**.

   The drawing is changed according to the changes that you made in the drawing properties.

**NOTE** Some of the changes in you make require a drawing recreation. For more information, see **Settings affecting the recreation of drawings**(page 41).

**TIP** You can also modify the properties of several drawings by selecting them from the Drawing List, right-clicking and selecting **Properties**.

**See also**

*Modify view-level drawing properties*(page 28)

**Modify drawing object properties**

You can change the properties of the objects in the drawings such as parts, marks, bolts, and welds, and save the object properties files for later use.

1. Open a drawing.
2. Double-click the object that you want to modify.
   For example, double-click a part or a bolt, or a reinforcing bar.
3. Change the desired settings in the property dialog box.
   For example, go to the **Appearance** tab and change the color.
4. In the box next to the **Save as** button, enter the name for the properties file and click **Save as**.
   Note that you should not use spaces or special characters in the properties file names.
5. If you want to apply the change in the object, click **Modify**. Otherwise, click **Cancel** to close the object properties dialog box.

Now you have a new object properties file. You can load the properties in this file in other drawing objects, in this case, parts. You can also use the object properties files with filters to apply detailed object level settings.

**See also**

*Load saved drawing object properties*(page 31)
Load saved drawing object properties
You can change the object properties in an existing drawing, for example the part color, by loading saved object properties.

1. Open a drawing.
2. Double-click the drawing object you want to change. For example, double-click a part.
3. Select the desired object properties file from the list next to the **Load** button and click **Load**.

4. Click **Modify**.

Tekla Structures changes the drawing object according to the settings in the loaded object properties file.

See also
 Modify drawing object properties (page 30)

Detailed object level settings
In addition to defining automatic drawing mark and object properties, you can also set up a special representation for marks and building objects in drawings and use these detailed object level settings for specific purposes. For example, you may want to define that all columns in a specific general arrangement drawing are shown in a specific color, and in all other general arrangement drawings in the default part color.

In general arrangement drawings, you can use detailed object level settings on both drawing and view level. In other drawing types, this setting is view specific.

To create detailed objects settings, you need to have:
- A filter that selects the objects that you want to be affected
- Object properties that you want to apply on the objects

See also
 Create detailed object level settings in a general arrangement drawing (page 31)
 Create detailed object level settings in cast unit drawings (page 36)
**Create detailed object level settings in a general arrangement drawing**

Detailed object level settings combine the desired object properties with certain object types. You can use detailed object level settings on drawing or drawing view level.

Before creating the detailed object level settings, create the object properties that you want to use, and save the properties in a properties file. For example, in part properties, set the part color to blue and save the properties.

To create detailed object level settings on drawing level in general arrangement drawings:

1. On the **Drawings & reports** tab, click **Drawing properties --&gt; GA drawing**.
2. Click **Filter** and create a drawing filter that selects the objects that you want to have special representation.
   
   For example, create a filter that selects columns.

3. Save the filter by entering a name for it and click **Save as**.
4. Click **Cancel** to close the dialog box.
5. In the drawing properties dialog box, click **Edit settings**.
6. In the **Object level settings for drawing/for view** dialog box, click **Add row** and select the filters to be used, the drawing object types and the drawing object properties to be used.

   By doing this, you are combining the filter, object type, and object property settings into detailed object level settings.

You can add several rows in detailed object level settings.
7. Give the object level settings a name and save using **Save as**.
   Note that you should not include spaces or special characters in the name.

Now you have new detailed object level settings to be applied on a drawing.

**See also**

*Modify drawing object properties (page 30)*
*Example: Apply detailed object level settings on drawing level in a GA drawing (page 33)*

**Example: Apply detailed object level settings on drawing level in a GA drawing**

In this example, different detailed object level settings will be set up for various types of building objects, such as beams, columns and braces, in a general arrangement drawing.

Before doing this, drawing object properties for beams, columns and braces have been created so that these parts have different colors. For more information about creating drawing object properties, see *Modify drawing object properties (page 30)*.

First you will make a general arrangement drawing filter, then save detailed object level settings in a settings file and finally, apply the new detailed object level settings on drawing level.

In this example, the filter uses part names defined in the model, similarly as in modeling filters.

1. On the **Drawings & reports**, click **Drawing properties --> GA drawing**.
2. Click **Filter** in the drawing properties dialog box.
3. Create filters by **Part - Name** for column, beam, and brace and save the settings using **Save as** with different names, such as *ts_column*, *ts_beam* and *ts_brace*. 
4. Click **Cancel** to close the dialog box.

Now you have created the required filters needed for selecting the desired parts.

5. In the **General Arrangement Drawing Properties** dialog box, click **Edit settings**.

6. In the **Object level settings for drawing** dialog box, select the filters to be used, the drawing object types and the drawing object properties to be used:
   a. Click **Add row** and select **ts_column** as **Model object (Drawing filter)**, **Part** as **Drawing object type** and **column** as **Settings used**.
   b. Click **Add row** and select **ts_beam** as **Model object (Drawing filter)**, **Part** as **Drawing object type** and **beam** as **Settings used**.
   c. Click **Add row** and select **ts_brace** as **Model object (Drawing filter)**, **Part** as **Drawing object type** and **brace** as **Settings used**.

7. Save the detailed object level settings as **gatypel** using **Save as**.
The same detailed object level settings can be used in other general arrangement properties, you do not need to create new ones.

8. Click **Cancel** to exit the dialog box.

9. Create a general arrangement drawing.

10. Open the created general arrangement drawing and double-click the drawing background to open the drawing properties.

11. Click **Edit settings**.

12. Load object level settings you created, in this example `gatypel`, and click **Load**.

13. Click **OK**.

14. Click **Modify** to apply the changes in the drawing.

15. Confirm the detailed object level changes by clicking **Yes** in the on **Object level settings changed!** confirmation message box.
NOTE If a row in the Object level settings dialog box is shown in red, either the object properties file defined in the Settings used box, or the filter file defined in the Model object (Drawing filter) box is missing from the attributes folder in the current model folder. See an example below:

<table>
<thead>
<tr>
<th>Model object (Drawing filter)</th>
<th>Drawing object type</th>
<th>Settings used</th>
</tr>
</thead>
<tbody>
<tr>
<td>test_column_filter</td>
<td>Part</td>
<td>test_properties</td>
</tr>
</tbody>
</table>

See also

Modify drawing object properties (page 30)
Create detailed object level settings in a general arrangement drawing (page 31)

Create detailed object level settings in cast unit drawings
Detailed object level settings combine the desired object properties with certain object types. You can use detailed object level settings on drawing or drawing view level.

Before creating the detailed object level settings, create the object properties that you want to use, and save the properties in a properties file. For example, in reinforcement properties, set color to red and save the properties. You create detailed object level settings in the same way in single-part drawings and assembly drawings.

To create detailed object level settings on view level:
1. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type. For example, select **Cast unit drawing**.

2. Click **View creation**, and click **View properties**.

3. Click **Filter** and create a view filter that selects the objects that you want to have special representation. For example, create a filter that selects reinforcing bars in class 100 and 101.

4. Save the filter by entering a name for in the box at the top and clicking **Save**.

5. Click **View properties** in the options tree and click **Edit settings**.

6. In the **Object level settings for view** dialog box, click **Add row** and select the filters to be used, the drawing object types and the drawing object properties to be used. By doing this, you are combining the filter, object type, and object property settings into detailed object level settings.

   ![Object level settings for view dialog box](image)

   You can add several rows.
7. Give the detailed object level settings a name (here class_100) and save using Save as.

Note that you should not include spaces or special characters in the name.

Now you have new detailed object level settings to be applied on a drawing.

**See also**

Example: Apply detailed object level settings on view level in a cast unit drawing (page 38)

**Example: Apply detailed object level settings on view level in a cast unit drawing**

In this example, detailed object level settings will be set up for lifting anchors in a cast unit drawing.

Before doing this, drawing object properties for lifting anchors have been created so that they use different color. For more information about creating drawing object properties, see [Modify drawing object properties](page 30).

First you will make a cast unit drawing view filter, then save detailed object level settings in a settings file and finally, apply the new detailed object level settings in a view.

1. On the Drawings & reports tab, click Drawing properties --> Cast unit drawing.
2. Click View creation --> View properties.
3. Click Filter in the drawing properties dialog box.
4. Create a filter by Reinforcing bar - Class and enter value 100 101.
5. Save the filter as class100filter and click Save.

Now you have the filter needed for selecting the reinforcing bar.

6. Click View properties in the options tree and click Edit settings.
7. In the **Object level settings for view** dialog box, select the filter to be used, the drawing object type and the drawing object properties to be used:
   
   a. Click **Add row** and select **class100filter** as **Model object (Drawing filter)**, **Reinforcing bar** as **Drawing object type** and **class100** as **Settings used**.

8. Save the detailed object level settings as **class_100** using **Save as**.

   ![Object level settings for view dialog box](image)

   The same detailed object level settings can be used in other cast unit drawing properties, you do not need to create new ones.

9. Click **Cancel** to exit the dialog box.

10. Create a cast unit drawing containing lifting anchors and open the drawing.

11. Double-click the view frame to open the **View properties** dialog box.

12. Click **Edit settings**.

13. Load object level settings you created, in this example **class_100**, and click **Load**.

14. Click **OK**.

15. Ensure that **Use detailed object level settings** is set to **Yes**.

16. Click **Modify** to apply the changes in the view.

17. Confirm the detailed object level changes by clicking **Yes** in the on **Object level settings changed!** confirmation message box.
The lifting anchors now have a different color, they are red.

NOTE: If a row in the Object level settings dialog box is shown in red, either the object properties file defined in the Settings used box, or the filter file defined in the Model object (Drawing filter) box is missing from the \attributes folder in the current model folder. See an example below:

<table>
<thead>
<tr>
<th>Model object (Drawing filter)</th>
<th>Drawing object type</th>
<th>Settings used</th>
</tr>
</thead>
<tbody>
<tr>
<td>test_column_filter</td>
<td>Part</td>
<td>test_properties</td>
</tr>
</tbody>
</table>

See also
Modify drawing object properties (page 30)
Create detailed object level settings in a general arrangement drawing (page 31)

How Tekla Structures applies drawing properties in drawing creation
Tekla Structures generates drawings according to the properties defined for each drawing type. You define the desired properties before you create the drawings. The way Tekla Structures connects the properties to the drawing you create depends on the method you select for creating the drawing.

- If you create the drawings in the Master Drawing Catalog using saved settings, Tekla Structures uses the properties defined in the saved settings file you select. Saved settings file in the Master Drawing Catalog is the same thing as the drawing properties file you save in various drawing properties dialog boxes.
- If you create the drawings in the Master Drawing Catalog using a rule set, Tekla Structures creates the drawing according to the properties defined in the saved settings file or cloning template file used in the rule set.
- If you create the drawings in the Master Drawing Catalog using cloning templates, Tekla Structures creates the drawing using the properties that you have defined for the drawing used as a cloning template together with the manual modifications that you have made in the drawing.
- If you create drawings through Drawings & reports tab using the Create drawings menu button commands, Tekla Structures uses the current drawing properties to create the drawings.
See also
Define automatic drawing settings (page 424)
Create drawings in Master Drawing Catalog (page 75)
Create drawings in Tekla Structures (page 43)
Create general arrangement drawings (page 66)
Create single-part, assembly, or cast unit drawings (page 67)

Settings affecting the recreation of drawings
Changing some of the drawing settings requires the drawing to be recreated. The changes will be applied, and the drawing will be recreated only if and when you click Modify.

In the View creation panel:
• Coordinate system
• Around X
• Around Y
• Around Z
• Undeformed
• Unfolded
• New views added into the Views list.

If at least one of the above mentioned settings is changed, the Recreate the drawing option is automatically set to Yes and the drawing will be recreated when you click Modify. If you manually set Recreate the drawing to Yes, the drawing will also be recreated. When View creation settings have changed and drawings will be recreated, you will get a warning message.

In the Section view panel:
• Section depth
• Distance for combining cuts
• Left section
• Middle section
• Right section

If at least one of the above mentioned settings is changed, Tekla Structures automatically recreates the drawing without giving a warning message when you click Modify.

If you only want to modify the view properties for one of the created views:
• If the changed properties are saved in the same file for all created views, the only way to modify the properties for one view is to set **Recreate the drawing** to **Yes**.

• If the changed properties are saved in a separate file not used for other created views, and that file is selected for the changed view in the **Views** list, then drawing will only be updated on **Modify**, not recreated.

**See also**

- Prevent automatic drawing updates and recreation (page 42)
- Update drawings when the model changes (page 372)

### Prevent automatic drawing updates and recreation

There are some ways you can prevent drawings from being updated and/or recreated.

• Freeze the drawings where you do not want to update all associative objects on top of the drawing views. The building objects (parts, bolts, welds, etc) are always updated in frozen drawings.

• Lock the drawings that you do not want to update.

• If you update a drawing that **has not been modified**, the drawing is recreated. Drawings are automatically recreated unless the drawing has been edited and then saved, or the drawing has been issued using the **Issue** functionality in the **Drawing List**. Use the advanced **XS_RECREATE_UNMODIFIED_DRAWINGS** to control the recreation of unmodified drawings.

• To prevent Tekla Structures from automatically updating drawings if the model changes, set the advanced option **XS_INTELLIGENT_DRAWING_ALLOWED** to FALSE.

**See also**

- Settings affecting the recreation of drawings (page 41)
- Freeze drawings (page 374)
Create drawings in Tekla Structures

Drawing creation is always based on drawing properties, no matter which way you use to create them. Planning and implementing the most suitable drawing settings carefully is very important. You can create drawings one by one, in groups, or you can create all drawings automatically.

Choose the way that meets your needs the best:

• Create drawings using ribbon and pop-up menu commands.
Create drawings using the various master drawing types in the **Master Drawing Catalog**. Using rule sets is a highly automated process of creating several drawings of different type in one go.

Clone drawings on the basis of cloning templates in the current model or in the cloning template models. You can clone drawings in the **Master Drawing Catalog** and in the **Drawing List**.

You can increase the level of automation even more by applying detailed object level settings to all of the above mentioned methods. When the level of automation increases, the need for manual modifications decreases. We recommend that you put extra effort in making the automated settings as effective as possible.

Click the links below to find out more:

- **Drawing types** (page 45)
- **What to do before creating drawings** (page 65)
- **Create general arrangement drawings** (page 66)
- **Create single-part, assembly, or cast unit drawings** (page 67)
- **Create multidrawings** (page 72)
- **Create drawings in Master Drawing Catalog** (page 75)
- **Clone drawings** (page 115)
2.1 Drawing types

You can create many types of drawings in Tekla Structures according to your needs. Click the links below to find out more:

- General arrangement drawings (page 45)
- Single-part drawings (page 52)
- Assembly drawings (page 57)
- Cast unit drawings (page 61)
- Multidrawings (page 64)

General arrangement drawings

General arrangement drawings (GA drawings) show the model from the most suitable direction. For example, in plan drawings, you are looking from the top of a building or floor down towards the ground. In elevation drawings you are looking from one of the sides of the building, like along a grid line. General arrangement drawings often contain enlarged views of complex areas or details, and other additional information that helps in the approval process and during the installation phase.

Create general arrangement drawings when you need

- Several views in one drawing, including the entire model or a part of it
- Plan drawings (foundation, floor, deck layout, and anchor bolt plans)
- Erection elevation drawings
- Information from model views, including 3D views

You can create general arrangement drawings using ribbon or pop-up menu commands in the following ways:

Create general arrangement drawings (page 66)
Create general arrangement drawings using saved settings in Master Drawing Catalog (page 82)

To see examples of general arrangement drawings, click the links below:

Example: Foundation plan (page 46)
Example: Slab plan (page 46)
Example: Framing plan (page 47)
Example: Deck plan (page 48)
Example: Erection elevation drawing (page 49)
Example: 3D isometric drawing (page 50)
Example: Anchor bolt plan (page 51)

See also
Create drawings in Master Drawing Catalog (page 75)

**Example: Foundation plan**

See below for an example of a foundation plan.

See also
General arrangement drawings (page 45)
**Example: Slab plan**

See below for an example of a slab plan.

See also

General arrangement drawings (page 45)
Example: Framing plan

See below for an example of a basement level framing plan.

See also

General arrangement drawings (page 45)
**Example: Deck plan**

See below for an example of a deck plan.

See also

General arrangement drawings (page 45)
Example: Erection elevation drawing

See below for an example of an elevation erection elevation drawing.

See also

General arrangement drawings (page 45)
**Example: 3D isometric drawing**

See below for an example of an isometric drawing.

---

**See also**

General arrangement drawings (page 45)
**Example: Anchor bolt plan**

See below for an example of an anchor bolt plan.

![Anchor bolt plan](image)

**See also**

General arrangement drawings (page 45)

**Single-part drawings**

Single-part drawings are workshop drawings that show the fabrication information for one part (usually without welds). Single-part drawings usually use small sheet sizes, for example, A4 or imperial standard size 8.5" x 11.5".

You can create single-part drawings using ribbon or pop-up menu commands. Click the links below to find out more:

- Create single-part, assembly, or cast unit drawings (page 67)
- Create single-part, assembly and cast unit drawings using saved settings in Master Drawing Catalog (page 86)
- Example - Create a new rule set and drawings for all parts (page 93)

To see examples of single-part drawings, click the links below:

- Example: Anchor bolt (page 53)
- Example: Embed (page 53)
- Example: Plate (page 54)
See also
Create drawings in Master Drawing Catalog (page 75)

*Example: Anchor bolt*

See below for an example of a single-part drawing presenting an anchor bolt.

See also
Single-part drawings (page 52)
Example: Embed

See below for an example of a single-part drawing presenting an embed.

See also

Single-part drawings (page 52)
Example: Plate

See below for examples of single-part drawings presenting plates.
Create drawings in Tekla Structures

Drawing types
### See also

**Single-part drawings (page 52)**
Assembly drawings

Assembly drawings are typically workshop drawings showing fabrication information for one assembly. In most cases, an assembly consists of a main part and secondary parts. The secondary parts are either welded or bolted to a main part. Assembly drawings usually use larger sheet sizes than single-part drawings, for example, A3 or imperial standard size 11" x 17".

You can create assembly drawings using ribbon or pop-up menu commands. Click the links below to find out more:

Create single-part, assembly, or cast unit drawings (page 67)
Create single-part, assembly and cast unit drawings using saved settings in Master Drawing Catalog (page 86)
Create drawings using rule sets or wizards in Master Drawing Catalog (page 92)
Example: Create assembly drawings from groups of similar parts (page 90)
Example - Create a new rule set and drawings for all parts (page 93)

To see examples of assembly drawings, click the links below:

Drawing types (page 45)
Example: Beam (page 58)
Example: Stairs (page 59)
Example: Rail (page 60)
**Example: Beam**

See below for an example of an assembly drawing presenting a beam assembly.

![Beam Assembly Drawing](image)

**See also**

*Assembly drawings (page 57)*
**Example: Stairs**

See below for an assembly drawing presenting stairs.

See also

*Assembly drawings (page 57)*
Example: Rail

See below for an example of a rail assembly drawing.

See also

Assembly drawings (page 57)

Cast unit drawings

Cast unit drawings are dimensional, form work, or reinforcement drawings used in concrete design and construction. They show cast-in embeds, edge chamfers, and hard and soft insulation. Cast unit drawings that show cast-in-place concrete structures usually use large sheet sizes, for example, A1 or imperial standard size 24" x 36". Drawings that show precast structures usually use smaller sheet sizes, for example, A3 or imperial standard size 11" x 17".

You can only create cast unit drawings of concrete parts and cast-in embeds (steel parts or assemblies added to a cast unit). Cast unit drawings also show the bolts and welds in steel parts. The volume and weight information of the cast unit remains accurate even if there are cuts inside the cast unit.

Cast units have the cast unit type part property - they are set either Cast in place or Precast. It is important to use the correct cast unit type, because some features, for example, numbering and continuous concrete are based partly on the cast unit type. In the Rebar detailing configuration, you can create cast unit drawings of cast-in-place cast units only.
You can create cast unit drawings using ribbon or pop-up menu commands. Click the links to find out more:

- Create single-part, assembly, or cast unit drawings (page 67)
- Create single-part, assembly and cast unit drawings using saved settings in Master Drawing Catalog (page 86)
- Create drawings using rule sets or wizards in Master Drawing Catalog (page 92)
- Example: Create cast unit drawings one by one (page 87)

To see examples of cast unit drawings, click the links below:

- Example: Beam (page 62)
- Example: Column (page 62)
- Example: Stairs (page 63)

**Example: Beam**

See below for an example of a combined form and reinforcing bar drawing of an inverted tee beam.

See also

- Cast unit drawings (page 61)
**Example: Column**

See below for an example of a combined form and reinforcing bar drawing of an exterior column with no corbels or plats for beams.

See also

*Cast unit drawings (page 61)*
**Example: Stairs**

See below for an example of a combined form and reinforcing bar drawing of stairs with landings.

See also

Cast unit drawings (page 61)

**Multidrawings**

Multidrawings are workshop drawings that gather several single-part or assembly drawings on one sheet. Multidrawings usually demand large sheet sizes such as A1 or imperial standard size 24" x 36".

Create multidrawings when you want to:

- Have more than one assembly on a sheet
- Collect multiple single-part drawings on a large sheet

Below is an example of a multidrawing with several assemblies included.
See also
Create multidrawings (page 72)

2.2 What to do before creating drawings

The list below contains some things that you may need to do before you create or clone drawings in Tekla Structures:

• The model needs to be numbered. If the model changes, the numbering needs to be updated. This applies to assembly, single-part, cast unit and multidrawings only; model does not need to be numbered before creating general arrangement drawings. Numbering ensures that Tekla Structures connects the right objects to the right drawings. If you try to create drawings without numbering the model, Tekla Structures prompts you to do so. You can also number general arrangement drawings, because then parts and marks will have numbers instead of question marks if you have included part position in part marks.

• Check that the detailing is correct.

• You may want to create test drawings of different types of parts to see how well the predefined drawing properties, layouts, rule sets or cloning templates suit your needs.

• You may want to modify drawing properties, layouts, or rule sets and save the modified settings for future usage.
• If you are going to use a drawing as a cloning template, check that it contains all the necessary elements for this purpose.

See also
Create drawings in Master Drawing Catalog (page 75)
Create general arrangement drawings (page 66)
Create single-part, assembly and cast unit drawings using saved settings in Master Drawing Catalog (page 86)
Define automatic drawing settings (page 424)

2.3 Create general arrangement drawings

When you create general arrangement drawings, remember to load the closest possible predefined properties in the drawing properties first, then modify the properties if needed, and then create the drawing.

Before you create general arrangement drawings, create the model views that you need and ensure that the views are as you want them to be in drawings. The drawing views will have the same orientation and content as the model view you select. A good idea is to fit the work area in the model view using two points to select the area that you want to show in the general arrangement drawing.

**NOTE** General arrangement drawings get overwritten if you recreate them. If you want to create another general arrangement drawing of the same model view, give another name to the drawing in drawing properties.

1. Create the model views you need.
   If you want to switch between 3D view and plane view in the created view, press Ctrl+P.
2. On the **Drawings & reports** tab, click **Drawing properties --> GA drawing**.
3. Select the appropriate predefined drawing properties (saved settings) from the list at the top and click **Load**.
   Always load predefined properties when you are creating a drawing. When you need to modify drawing properties, save the new changes to the properties file when necessary.
4. If needed, modify drawing properties and, if necessary, apply object-level settings.
5. Click **Apply** or **OK**.
6. On the Drawings & reports tab, click Create drawings --> GA drawing. Alternatively, you can select the model views from the model (selected views get a yellow frame), right-click and click Create General Arrangement Drawing.

7. If you have not selected the views yet, select them from the displayed list. You can use the Shift and Ctrl buttons for selecting several views.

8. In the Options list, select if you want to create one drawing for each selected view or add all selected views in one drawing.
   By selecting Empty, you can create an empty drawing and add drawing views in it afterwards.

9. If you want to open the created drawings, select Open drawing.

10. Click Create.

Tekla Structures creates the drawings and adds them in the Drawing List. You can now open the drawing and also change the drawing properties.

See also
Define automatic drawing settings (page 424)
General arrangement drawings (page 45)
Create general arrangement drawings using saved settings in Master Drawing Catalog (page 82)
General arrangement drawing properties (page 685)
Pours in drawings (page 329)

2.4 Create single-part, assembly, or cast unit drawings
When you create single-part, assembly or cast-unit drawings, remember to load the closest possible predefined properties in the drawing properties first, then modify the properties if needed, and then create the drawing.

Ensure that you are using the correct cast unit type, because some functionalities, for example numbering, are based on the cast unit type. Cast units have the cast unit type part property setting in the model - they are set either Cast in place or Precast. In the Cast in Place configuration, you can create cast unit drawings of cast-in-place cast units only.

1. On the Drawings & reports tab, click Drawing properties and select the drawing type.
2. In the drawing properties dialog box, load the appropriate predefined drawing properties (saved settings).
   Always load predefined properties when you are creating a drawing. When you need to modify drawing properties, save the changes to a new properties file when necessary.

   Ensure that for cast unit drawings, you use a property file that contains the desired **Cast unit creation method**:
   - **By cast unit position**: A drawing will be created from each cast unit. If there are identical cast units, one of them will serve as the base cast unit for the drawing. This is the most common method for creating cast unit drawings.
   - **By cast unit ID**: Each part in the model includes a unique GUID. You can create drawings by using cast unit GUIDs. The GUID determines the marking of the drawing. You can create several drawings from identical cast units.

3. Click **View creation**, select the view and the properties that you want to change, and click **View properties**.
   If you do not have any views defined yet, first add the views and then select the view properties for the views.

4. If needed, modify the view properties including view, building object, dimensioning and mark settings and apply detailed object-level settings.

5. Click **Save** to save the view properties.

6. Click **Close** to return to drawing properties.

7. Save the drawing properties you loaded earlier.

8. Click **Apply** or **OK**.

9. Select the objects, or use an appropriate selection filter to select the objects you want to create drawings from and select the entire model.

   Activate only the **Select parts** switch on the **Selecting** toolbar when selecting parts. Otherwise selection could take a long time in large models.

10. Do one of the following:
    - On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type.
    - If you selected individual objects, right-click and select the appropriate drawing creation command.

11. Number the model if you are prompted to do so.
Tekla Structures creates the drawings. The created drawings are listed in the **Drawing List**. If you already have a drawing with the same type and mark, Tekla Structures will not create a new one.

**TIP**  To automatically open any drawing after the drawing has been created, hold down **Ctrl+Shift** while you create the drawing.

See also

- Define automatic drawing settings (page 424)
- Pours in drawings (page 329)
- Show pour objects, pour marks and pour breaks in drawings (page 668)
- Single-part, assembly and cast unit drawing properties (page 688)
- View properties in drawings (page 692)

## 2.5 Create AutoDrawings

The AutoDrawings wizard combines a series of actions so that you can create drawings using a single command. You can use AutoDrawings to create single-part drawings, assembly drawings, cast-unit drawings and multi-drawings.

AutoDrawings wizards contain instructions telling Tekla Structures which drawing type, selection filter, and drawing properties to use. You can edit AutoDrawings wizard files or create your own ones. The AutoDrawings dialog box lists the available wizard files.

### Create AutoDrawings

Before you can create AutoDrawings, the appropriate wizard files must exist and numbering must be up to date.

1. In the model, select the parts from which to create drawings. You can also select the entire model and use filters to fine-tune your selection. You can also use selection filters in the wizard file. If you do, your selection can include parts that will not be included in the drawings.

2. Type **AutoDrawing** in the **Quick Launch** box.

3. In the **AutoDrawings** dialog box, select a wizard file.
4. On the Advanced tab, select whether to create a log file, what information it should include and name the log file.

5. Click Create from selected.

AutoDrawings wizard files

You can create your own AutoDrawings wizard files using any standard text editor. Use the existing wizard files as examples to construct your own.

A typical AutoDrawings wizard file contains several sets of drawing requests containing drawing, attribute and part settings to apply to selected objects, as well as a selection filter. The order of sets is important, as Tekla Structures only creates one drawing for each object.

Place the newly created drawing wizard files in the attributes sub-folder in the model folder.

Example

The AutoDrawings wizard file set in this example creates an assembly drawing for an object that fulfills the selection filter criteria in the set. Tekla Structures will not create another assembly drawing for that object, even if it matches the criteria of the selection filter in later sets in the same wizard file.

The wizard file consist of the lines below. Note the use of parentheses.

```
set_drawing_type(assembly)
set_drawing_attributes(column)
```
set_filter(column_filter)
create_drawings()

<table>
<thead>
<tr>
<th>Line</th>
<th>Description</th>
</tr>
</thead>
</table>
| `set_drawing_type(assembly)` | This line defines the type of drawing the wizard creates. The drawing type appears in parentheses. The options are:  
  * single: workshop drawings  
  * assembly: assembly drawings  
  * multi_single: workshop multi-drawings  
  * multi_single_with_layout: workshop multi-drawings with layout  
  * multi_assembly: assembly multi-drawings  
  * multi_assembly_with_layout: assembly multi-drawings with layout  
  * cast_unit: cast-unit drawings |
| `set_drawing_attributes(column)` | This line tells Tekla Structures which drawing properties to use when creating the drawings. The name of the saved drawing properties file appears in parentheses. |
| `set_filter(column_filter)` | This line tells Tekla Structures which selection filter to use to select the parts from which to create drawings. The filter name appears in parentheses. |
| `create_drawings()` | This line starts the drawing creation. This line should always appear immediately after the lines `set_drawing_type`, `set_drawing_attributes` and `set_filter`. |
Wizard log

Tekla Structures writes a log file when you run an AutoDrawings wizard. The log file contains information about errors, number of drawings created, commands used etc.

You can configure whether or not Tekla Structures creates a log file and how it is displayed using the Advanced tab in the AutoDrawings dialog box.

**Create log** options:
- **No**: Tekla Structures does not create a log file.
- **Create**: Tekla Structures creates a new log file and deletes the old one.
- **Append**: Tekla Structures adds a new entry to the existing log file.

**Display log** options:
- **No**: Tekla Structures does not display the log.
- **With associated viewer**: Tekla Structures displays the log file in an associated viewer (e.g. Notepad) when you run the wizard. You can edit the log file.
- **On dialog**: Tekla Structures displays the log file in a dialog box when you run the wizard. You can not edit the log file.

### 2.6 Create multidrawings

You can create multidrawings of selected parts and of selected drawings. You can also create empty multidrawings and copy or link views in them from other drawings.

If you create multidrawings from existing drawings, you can choose to include their individual drawing layouts. If you want to have separate lists, tables, and call-offs for each part or assembly, you should include the individual drawing layouts. You can also include lists and tables for all parts or assemblies in the multidrawing.

Before creating a multidrawing, check the original assembly or single-part drawing, and clean it up, if necessary. Do not modify the multidrawing object that links to the original drawing.

Before you start, you can set `XS_MULTIDRAWING_REMOVE_VIEW_LABEL_GAP` to `TRUE` in the Drawing Properties category of the Advanced Options dialog box to remove extra space between drawing view labels and drawing views.

**See also**

- Multidrawings (page 64)
- Define automatic drawing settings (page 424)
Link or copy drawing views to empty multidrawings
You can create empty multidrawings in which you can link or copy views from other drawings as such or with the original drawing layout.
1. On the Drawings & reports tab, click Multidrawing --> Empty drawing.
2. On the Drawings & reports tab, click Drawing list.
3. Open the empty multidrawing from the Drawing List.
4. Still on the Drawing List, select the drawings that you want to copy or link to the multidrawing.
5. On the Views tab, click From other drawing and select one of the copying or linking commands:
   • Copy
   • Copy with layout
   • Link
   • Link with layout
   The drawing views are placed in the multidrawing from top to bottom starting from the top-left corner. The views are placed in the same order as they appear on the Drawing list. If you have sorted the list by the name, the drawings are created in the same order.
6. Arrange the views if they are on top of each other.

NOTE When you update multidrawings, the linked drawings are also updated.

Useful links
What does XS_CREATE_CONNECTION_WHEN_COPYING_DRAWING_VIEWS do?

See also
Create multidrawings (page 72)

Create multidrawings of selected drawings
You can create multidrawings of the drawings you select. You can also keep the layout of the selected drawing in the new multidrawing.
1. On the Drawings & reports tab, click Drawing list.
2. Select the drawings you want to add in the multidrawing from the Drawing List.

3. On the Drawings & reports tab, click Multidrawing and select one of the following commands:
   - **Selected drawings**: Create multidrawings of the selected drawings without the drawing layout.
   - **Selected drawings with layout**: Create multidrawings of the selected drawings, keeping the layout of each selected drawing.

   The drawing views are placed in the multidrawing from top to bottom starting from the top-left corner. The views are placed in the same order as they appear on the Drawing list. If you have sorted the list by the name, the drawings are created in the same order.

See also
Create multidrawings (page 72)

**Create multidrawings of selected parts**
Create single-part and assembly drawings of the parts that you select and place the drawings in a multidrawing. You can also keep the layout of the selected single-part or assembly drawings.

1. Select the parts from the model using appropriate selection switches or filters.

2. On the Drawings & reports tab, click Multidrawing and select one of the following commands depending on the desired result:
   - **New single-part drawings of selected parts**: Create single-part drawings of the selected parts and place the drawings in a multidrawing
   - **New single-part drawings of selected parts with layout**: Create single-part drawings of the selected part, keeping the layout of each drawing, and place the drawings in a multidrawing.
   - **New assembly drawings of selected parts**: Create assembly drawings of the selected parts and place the drawings in a multidrawing.
   - **New assembly drawings of selected parts with Layout**: Create assembly drawings of the selected parts, keeping the layout of each drawing, and place the drawings in a multidrawing.

See also
Create multidrawings (page 72)
2.7 Create drawings in Master Drawing Catalog

The Master Drawing Catalog is a fast, efficient and controlled way of creating drawings using master drawings. In the Master Drawing Catalog, all drawing creation commands are available in one centralized location.

A master drawing is a Tekla Structures drawing or a set of drawing properties that is used for creating new drawings that look the same as the master drawing. There are several types of master drawings: cloning templates, saved settings and rule sets. You can also use the existing AutoDrawings wizard files as master drawings.

The example below shows the search view of the Master Drawing Catalog as a thumbnail list.

The Master Drawing Catalog has a toolbar containing commands for creating drawings, selecting the view type and the master drawing list type, displaying master drawing descriptions, selecting the models from which you want to use cloning templates, creating rule sets, displaying the Drawing List, and for keeping the Master Drawing Catalog window always on top.

Tekla Structures populates the catalog by looking for items in the Tekla Structures default folder search order: first from the firm folder, then from the
project folder, and then from the system folder and so on. Cloning templates in the folder defined for the advanced option
XS_CLONING_TEMPLATE_DIRECTORY are shown in the catalog.

See also
Create general arrangement drawings using saved settings in Master Drawing Catalog (page 82)
Create anchor bolt plans using saved settings (page 83)
Create single-part, assembly and cast unit drawings using saved settings in Master Drawing Catalog (page 86)
Master drawing types (page 76)
Search for master drawings and save the results in Master Drawing Catalog (page 100)
Customize Master Drawing Catalog (page 101)

Master drawing types
The master drawing type you should use depends on the type of the drawing that you want to create:

• You can create single-part drawings, assembly drawings or cast unit drawings using saved settings, rule sets, or cloning templates.

• You can create general arrangement drawings using saved settings.
• You can create multidrawings using wizards (old file-based rule sets)

See also
Saved settings in Master Drawing Catalog (page 77)
Rule sets in Master Drawing Catalog (page 79)
Wizards in Master Drawing Catalog (page 80)
Cloning templates in Master Drawing Catalog (page 77)

Cloning templates in Master Drawing Catalog
Cloning templates are Tekla Structures drawings that are used as templates for creating new drawings. You can select a drawing from the Drawing List and add it to the Master Drawing Catalog to be used as a template.

You can also use cloning templates that are located in other models. When you have similar parts in several projects, you can maintain a set of cloning template models and then take the cloning templates in the cloning template models in use when necessary.

See also
Master drawing types (page 76)
Clone drawings (page 115)
Create drawings using cloning templates in Master Drawing Catalog (page 116)
Clone by using cloning templates located in other models (page 117)
Add a cloning template master drawing in Master Drawing Catalog (page 104)

Saved settings in Master Drawing Catalog
The saved settings in Master Drawing Catalog are drawing properties files that have been created and saved in the drawing properties dialog boxes for different drawing types. There are also many predefined drawing property files.

Each drawing type has its own properties file. Default saved settings are located in the environment (.\Tekla Structures\<version>
When you save your own settings, they are saved under the current model directory. Below are some examples how the saved settings are shown in the **Master Drawing Catalog** dialog box.
See also

Master drawing types (page 76)
Create general arrangement drawings using saved settings in Master Drawing Catalog (page 82)
Create single-part, assembly and cast unit drawings using saved settings in Master Drawing Catalog (page 86)

Rule sets in Master Drawing Catalog

Rule sets are sets of rules on how to create drawings for different object types. A rule set is a combination of object groups (model selection filters) and master drawing settings (cloning templates, saved settings) that define which objects to include in the drawing, and which drawing settings to use. You can use the existing AutoDrawings wizard files or create your own rule sets.

The order of sets is important, as Tekla Structures by default creates only one drawing for each object. For example, a rule set creates an assembly drawing for an object that fulfills the selection filter criteria in one set. Tekla Structures
will not create another assembly drawing for that object, even if it matches the criteria of the selection filter in later sets in the same rule set file.

See also
Master drawing types (page 76)
Create drawings using rule sets or wizards in Master Drawing Catalog (page 92)
Add a rule set master drawing in Master Drawing Catalog (page 102)

Wizards in Master Drawing Catalog

A wizard file is a file-based wizard consisting of several sets of drawing requests containing drawing, attribute and part settings to apply to selected objects, as well as a selection filter. The order of sets is important, as Tekla Structures by default creates only one drawing for each object. You can edit the files in the Master Drawing Catalog. However, creating new wizard files is not possible in the Master Drawing Catalog. Instead, you can create a rule set, which is
basically the same thing as a wizard: It applies drawing properties to objects selected by filters, but in a dialog box, not in a text file like a wizard.

**NOTE** In the **Master Drawing Catalog**, the only way to create multidrawings is to use the wizard files.

**See also**
- Master drawing types (page 76)
- Create drawings using rule sets or wizards in Master Drawing Catalog (page 92)
- Wizard file contents (page 109)

### Apply detailed object level settings in saved settings
You can apply drawing object level settings in the drawings that you create in **Master Drawing Catalog** for the saved settings type of master drawings. This way you can use the same saved settings for many drawings and only apply some specific object level settings at the point when you create the drawing, for example, use different kind of marks or change the reinforcement color.

To apply detailed object level settings in saved settings for a general arrangement drawing:

1. In the **Master Drawing Catalog**, double-click the saved setting you want to use for creating drawings.
2. In the **Master Drawing Properties** dialog box, click **Edit drawing properties**.
3. Click the toggle button at the bottom to empty the check boxes.
4. In the **Drawing Properties** dialog box, select only the **Use detailed object level settings** check box and ensure that the **Yes** button next to it is selected.
5. Click **Edit settings**.
6. Select the filter to be used, the drawing object type and the drawing object property file to be used.
7. Click **OK**.
8. Click **Save** on the top of the dialog box to save the changes in the saved settings file (property file).
9. Click **OK** in the **Master Drawing Properties** dialog box.
10. Create the drawings.
NOTE  In single-part, assembly and cast unit drawings, you need to go from the Drawing Properties dialog box further to the view properties of the view where you want apply detailed object level settings.

See also
Modify saved settings' properties (page 107)
Create detailed object level settings in a general arrangement drawing (page 31)
Example: Apply detailed object level settings on drawing level in a GA drawing (page 33)
Create detailed object level settings in cast unit drawings (page 36)
Example: Apply detailed object level settings on view level in a cast unit drawing (page 38)

Create general arrangement drawings using saved settings in Master Drawing Catalog
You can create GA drawings in Master Drawing Catalog on the basis of saved settings.

Before you create general arrangement drawings, create the model views that you need and ensure that the views are as you want them to be. The drawing views will have the same orientation and content as the model view you select. Fit work area using two points to select the area that you want to show in the general arrangement drawing.

1. On the Drawings & reports tab, click Create drawings --> Master drawing catalog.
2. Select the set of saved settings from the list at the top.
3. If needed, modify the drawing properties by double-clicking the saved setting and clicking Edit drawing properties.
   Remember to save the changes in the properties file.
4. Click Create drawings (Alt+C).
5. In the Create General Arrangement Drawing dialog box, select the views that you want to create and the desired option from the Options list.
   If you select Empty, you can create an empty drawing and add drawing views in it afterwards.
6. Click Create to create the drawings.

Tekla Structures creates the drawings and adds them in the Drawing List.
Click in the Master Drawing Catalog toolbar to open the Drawing List.
NOTE  General arrangement drawings get overwritten if you recreate them. If you want to create another general arrangement drawing of the same model view, give another name to the new drawing in drawing properties.

For more information about creating cast in place general arrangement drawings, see Pours in drawings (page 329)

See also
Saved settings in Master Drawing Catalog (page 77)
Create general arrangement drawings (page 66)

Create anchor bolt plans using saved settings
Anchor bolt plans are general arrangement drawings showing the anchor bolt layout. You can create anchor bolt plans in Master Drawing Catalog or using ribbon or pop-up menu commands.

Below you will create an anchor bolt plan using the Master Drawing Catalog.

Before creating the anchor bolt plan, create a model view that is in the xy-plane.

1. On the Drawings & reports tab, click Create drawings --> Master drawing catalog.
2. Double-click a saved settings master drawing that has been created for anchor bolt plans, for example, anchor_bolt_plan.
3. Open the General Arrangement Drawing Properties dialog box by clicking Edit drawing properties.
4. Click View.
5. On the Anchor bolt plan tab, ensure that the option Show as anchor bolt plan is set to Yes.
   Define the drawing as an anchor bolt plan when you are creating the drawing. You cannot convert a general arrangement drawing to an anchor bolt plan afterwards.
6. Modify the enlarged part view scale, if necessary.
7. If needed, set the option Create detail views to Yes to create separate detail views.
   If you select No, Tekla Structures dimensions the anchor bolts in the enlarged view. Tekla Structures groups similar detail views so that similar details are drawn only once.
8. Set the Detail view scale.
9. Click Save to save the changes in the saved settings file.
10. Click **OK** to close the **Master Drawing Catalog Properties** dialog box.

11. Click **Create drawings**.

12. Select one view in the xy-plane.

   If you select some other type of view or several views, Tekla Structures displays a warning message and the anchor bolt plan is not created.

13. Click **Create**.

   Tekla Structures creates the anchor bolt plan.

   Tekla Structures creates bolt dimensions in the anchor bolt plan in the directions of the bolt group coordinate system. If the angle between the bolt group and the view coordinate systems is not orthogonal, Tekla Structures adds angle dimensions to the detail view. Use the advanced option

   `XS_ANCHOR_BOLT_PLAN_USE_VIEW_COORDSYS_FOR_BOLT_DIMENSIONS`

   to create the dimensions in the x and y directions of the main view.

When details are compared, the following aspects are taken into account:

- bolt dimensions
- column profile
- column orientation (coordinate system)
- plate profile

**TIP** In the created drawing, go to the **File** menu, click **Settings** and check that **Ghost outline** is selected and **Drawing color mode** is set to **Color**. In color drawings with white background, hidden objects are shown as ghost outlines, if this setting is selected. In gray scale and black and white drawings, hidden objects are not shown even if **Ghost outline** is selected.

---

**See also**

- Saved settings in Master Drawing Catalog (page 77)
- Objects included in the anchor bolt plan (page 84)
- Define the anchor bolt plan parts using drawing filters (page 85)
- Include assemblies in anchor bolt plans (page 86)
- Example: Dimension anchor bolt plans (page 596)
- General arrangement drawing properties (page 685)
- View properties in drawings (page 692)
**Objects included in the anchor bolt plan**
Tekla Structures selects the objects that are included in the anchor bolt plan based on the following default rules:

- The part is a column or an almost vertical beam.
- The part is the main part of an assembly.
- A base plate is included in the assembly, and it is located lower than the main part. If there is more than one part in the column assembly that fulfills the rules, the lowest part of them is considered to be the base plate.
- Bolts are attached to the base plate.
- The assembly is cut by the view plane.
- The boundary box of the base plate in the xy-direction intersects the boundary box of the column.

**See also**
Create anchor bolt plans using saved settings (page 83)

**Define the anchor bolt plan parts using drawing filters**
You can use general arrangement drawing filters and certain advanced options to include parts in the anchor bolt plan.

1. Create the necessary general arrangement drawing filters in the Filter Properties subdialog box of the general arrangement drawing properties dialog box.

2. On the File menu, click Settings --> Advanced options and go to the Drawing Properties category.

3. Enter the following values for the following advanced options:
   - `XS_ANCHOR_BOLT_PLAN_COLUMN_FILTER`: <the name of the drawing filter for columns>
   - `XS_ANCHOR_BOLT_PLAN_BOLT_FILTER`: <the name of the drawing filter for bolts>
   - `XS_ANCHOR_BOLT_PLAN_BASEPLATE_FILTER`: <the name of the drawing filter for base plates>
   - `XS_ANCHOR_BOLT_PLAN_ADDITIONAL_PARTS_FILTER`: <the name of the drawing filter for additional parts>

If you do not use these advanced options, the default rules are used for determining the columns, base plates, and anchor bolts to be included in the anchor bolt plan.
NOTE Using these advanced options only affects the creation of new anchor bolt plan drawings, and has no affect on the existing anchor bolt plan drawings.

Include assemblies in anchor bolt plans
If you have anchor bolts at varying elevations, you can create a general arrangement drawing at the level of the top-most base plate/anchor bolt.

The anchor bolt plan view extrema looks downwards. If the lowest level anchor bolt is not shown, adjust the advanced option XS_ANCHOR_BOLT_PLAN_DRAWING_TOLERANCE.

To specify the tolerance:
2. Set a value for the advanced option XS_ANCHOR_BOLT_PLAN_DRAWING_TOLERANCE.
   Define the distance in millimeters. The default value is 200 mm.

See also
Create anchor bolt plans using saved settings (page 83)

Create single-part, assembly and cast unit drawings using saved settings in Master Drawing Catalog
You can create single-part, cast unit and assembly drawings in Master Drawing Catalog using saved settings.

NOTE • Cast units have the cast unit type part property setting in the model - they are set either Cast in place or Precast. It is important to use the correct cast unit type, because some features, for example numbering, are based on the cast unit type. In the Cast in Place configuration, you can create cast unit drawings of cast-in-place cast units only.

1. On the Drawings & reports click Create drawings --> Master drawing catalog.
2. Select the desired set of saved settings (drawing properties file) from the list.
For cast unit drawings, select a file that contains the desired **Cast unit creation method**:

- **By cast unit position**: A drawing will be created from each cast unit. If there are identical cast units, one of them will serve as the base cast unit for the drawing. This is the most common method for creating cast unit drawings.

- **By cast unit ID**: Each part in the model has a unique GUID. You can create drawings by using cast unit GUIDs. The GUID determines the marking of the drawing. You can create several drawings from identical cast units.

3. If needed, modify the drawing properties and apply object-level settings. To do this, double-click the saved setting and click **Edit drawing properties**. Remember to save your changes in the property file.

4. If you are creating a drawing only for selected objects, select the objects. You can also use an appropriate selection filter and select the whole model. Activate only the **Select parts** selection switch when you select objects, otherwise the selection may take a long time.

5. Click **Create drawings** (Alt+C) or **Create drawings for all parts** (Alt+A).

6. Number the model if you are asked to do so.

Tekla Structures creates the drawings and adds them in the **Drawing List**.

Click the **Drawing List** button on the **Master Drawing Catalog** toolbar to open the **Drawing List**.

**NOTE** If you already have a drawing with the same type and mark, Tekla Structures will not create a new one.

**See also**

- **Example: Create cast unit drawings one by one** (page 87)
- **Example: Create assembly drawings from groups of similar parts** (page 90)
- **Saved settings in Master Drawing Catalog** (page 77)

**Example: Create cast unit drawings one by one**

In this example, you will create a drawing of a cast unit using saved settings called **Column_with_BOM**.

1. In the model, right-click the concrete column and select **Cast unit --> Set top in form face**, and select the cast unit face that will face upwards in the form.
When you right-click the column and select **Cast unit --> Set top in form face**, the selected face is shown red, see the image below.

The top-in-form face will be displayed in the front view of a drawing.

2. Still in the model, double-click the column and select **Precast** as the **Cast unit type**.

   It is important to use the correct cast unit type, because some features, for example, numbering, are based on the cast unit type.

3. On the **Drawings & reports** tab, click **Drawing properties --> Cast unit drawing**.

4. In the properties dialog box, load the appropriate predefined drawing properties (saved settings). In this example, **Column_with_BOM** is loaded.

5. Ensure that the **Column_with_BOM** settings contain the desired **Cast unit creation method**:

   - **By cast unit position**: A drawing will be created from each cast unit. If there are identical cast units, one of them will serve as the base cast unit for the drawing. This is the most common method for creating cast unit drawings.
• **By cast unit ID:** Each part in the model has a unique GUID. You can create drawings by using cast unit GUIDs. The GUID determines the marking of the drawing. You can create several drawings from identical cast units.

6. If you made any changes in Column_with_BOM, save the changes and close the dialog box.
7. Select the column in the model.
8. On the **Drawings & reports** tab, click **Create drawings --> Master drawing catalog**.
9. Set the type to **Cast-unit drawings** and select the saved settings **Column_with_BOM (C)**.
10. Click **Create drawings**.
    Tekla Structures creates the drawing.

    You can open the **Drawing List** by clicking the **Drawing List** button on the toolbar and open the drawing to view it.
See also
Create single-part, assembly and cast unit drawings using saved settings in Master Drawing Catalog (page 86)

Example: Create assembly drawings from groups of similar parts
Creating drawings one by one may take a lot of time. You can automate the creation process a bit more by selecting groups of items and then create the drawings. For example, you can define the needed properties for the beams and then run all the beam drawings at once by using the Tekla Structures model selection filters.

In this example, you are going to use saved settings named **Beam_with_BOM** and create assembly drawings from all beams.

1. Define a selection filter that selects only one type of items, in this case beams.
   a. Click the selection filter button ☞ on the Selecting toolbar or press **Ctrl+G** to open the Object Group - Selection filter dialog box.
   b. Create a selection filter that selects all parts named BEAM and save it using the name **BEAM**.
2. Activate the *BEAM* filter from the list of selection filters and use area selection to select all beams in the model.

3. Open the **Master Drawing Catalog**: On the **Drawings & reports** tab, click Create drawings --> Master drawing catalog.

4. Under **Assembly drawings**, select the saved settings master drawing. In this example, **Beam_with_BOM (A)** is selected.
5. Click **Create drawings**.

Tekla Structures creates the beam assembly drawings.

**See also**

Create single-part, assembly and cast unit drawings using saved settings in Master Drawing Catalog (page 86)

**Create drawings using rule sets or wizards in Master Drawing Catalog**

In the **Master drawing catalog**, you can create single-part, assembly and cast unit drawings using rule sets, and multidrawings using wizards. You can also create your own rule sets.

**Limitation:** In the **Master Drawing Catalog**, you can create multidrawings only by using file-based wizards and general arrangement drawings using saved settings. You cannot create rule sets for multidrawings or general arrangement drawings.

1. On the **Drawings & reports** tab, click **Create drawings --> Master drawing catalog**.
2. Select a rule set or a wizard file from the list.
3. If needed, modify rule set properties or wizard file contents by double-clicking the rule set or wizard.
4. If needed, edit the drawing properties of the master drawing connected to the rule set. To do this, double-click the rule set, select the master drawing from the list and click **Properties --> Edit drawing properties**. Remember to save your changes.
5. Select the whole model or desired parts.
6. Do one of the following:
   - If you selected parts, click **Create drawings (Alt+C)**.
• If you selected the whole model, click **Create drawings for all parts** (Alt+A).

7. Number the model if you are asked to do so.

Tekla Structures creates the drawings and adds them in the **Drawing List**.

Click the drawing list button 📃 on the **Master Drawing Catalog** toolbar to open the **Drawing List**.

**NOTE** If you already have a drawing with the same type and mark, Tekla Structures will not create a new one.

**See also**

- Rule sets in Master Drawing Catalog (page 79)
- Wizards in Master Drawing Catalog (page 80)
- Add a rule set master drawing in Master Drawing Catalog (page 102)
- Example - Create a new rule set and drawings for all parts (page 93)

**Example - Create a new rule set and drawings for all parts**

The following example will go through creating a basic rule set that will create assembly and single part drawings based on the names of the parts in the model.

The model used here is a very simple model consisting of two columns with a beam in between, base plates and end plates. The parts are named **BEAM**, **COLUMN** and **PLATE**.

Before setting up a rule set in the **Master Drawing Catalog**, you need to have some saved settings (drawing properties) and some selection filters that link the drawing properties to the parts in the model.

**Create selection filters**

You need to have filters that select the beams, columns and plates.

1. Click the selection filter button 🗼 on the **Selecting** toolbar or press **Ctrl +G** to open the **Object Group - Selection filter** dialog box.
2. Click **Add row** and add a selection filter for the beams as shown below, saving it as **DRAWING_BEAM**.

![Selection Filter Dialog](image)

3. In the same way, create selection filters for columns and plates, saving them as **DRAWING_COLUMN** and **DRAWING_PLATE**.

The new filters are displayed in the selection filter list.
4. Close the **Selection Filter** dialog box by clicking **Cancel**.

The new filters will be saved in the model folder. If necessary, copy them to the necessary folders, for example, to the firm or project folders.

**Create saved settings (drawing properties)**

Next you need to modify the drawing properties and save them so that they are displayed as saved settings in the **Master Drawing Catalog**. The saved settings are created separately for single-part drawings and assembly drawings.

1. On the **Drawings & reports** tab, click **Drawing properties --> Assembly drawing** and create properties for a beam and a column drawing.

2. Give a descriptive name for the drawing in the **Name** box, for example, **BEAM** for the beam properties and **COLUMN** for the column properties.

3. Save the properties as **DRAWING_BEAM** and **DRAWING_COLUMN**.
4. On the **Drawings & reports** tab, click **Drawing properties --> Single-part drawing** and create some single-part drawing settings for a beam shaft, column shaft and plates.

5. Give a descriptive name for the drawing in the **Name** box, for example, **BEAM SHAFT** for the beam shaft properties, **COLUMN SHAFT** for the column shaft properties and **PLATE** for the plate properties.

6. Save the settings as **DRAWING_BEAM_SHAFT**, **DRAWING_PLATES** and **DRAWING_COLUMN_SHAFT**.

**Create a rule set**

Now that you have created the necessary selection filters and saved settings, you can create a rule set that automatically creates single-part and assembly drawings for beams, columns and plates.

1. On the **Drawings & reports** tab, click **Create drawings --> Master drawing catalog**.

2. Click the **Define rule set** button on the toolbar.

3. In the **Define Rules for Creating Drawings** dialog box, select the drawing types you want to create with the rule set and click **Next**.

   In this example, select **Single-part drawings** and **Assembly drawings**.

   ![Define Rules for Creating Drawings](image)

4. In the **Define Rules - Single-part Drawings** dialog box, click **Add group** and select the filters and the corresponding single-part drawing saved settings.

5. Under **Object group** select the three new filters, and under **Master drawing**, select the three new saved settings.

   The (S) after the master drawing name indicates that its type is saved setting.
6. Click **Next**.

7. In the **Define Rules - Assembly Drawings** dialog box, click **Add group** and select the filters and the corresponding assembly drawing saved settings.

8. Under **Object group** select the two new filters, and under **Master drawing**, select the two new saved settings.

9. Click **Next**.

10. Give the rule set a name (**Rule Set: Column+Beam+Plate**), description and keywords.

11. Use **Browse** next to **Preview image** and add a sample image for the master drawing.

12. Click **Finish** when you are done.
Create all drawings using the rule set

Now you can create drawings using the new rule set.

1. In the **Master Drawing Catalog Search** view, enter your search criteria in the box next to the **Search** button and click the button.

   In this example, **column beam plate** is entered. Tekla Structures finds the newly created rule set.

2. Right-click the rule set and select **Create drawings for all parts**.

   Tekla Structures starts creating the drawings. When the drawings have been created, the following message is displayed pointing to the **Drawing List** icon on the toolbar: "6 drawings created. Open the Drawing List to see the results". This is a correct amount of drawings.

3. To check which drawings have been created, click the **Drawing List** toolbar icon.
Create multiple drawing sheets of the same part
You can create several drawings from the same part as multiple drawing sheets. The number of sheets is not limited, and each drawing can have its own properties.

This is useful when you need extra sheets for details and section views, and especially when you want to have several drawings of an assembly with different presentation options: one with a large 3D image of the assembly, one with additional section views, and one where only certain parts or sub-assemblies of the assembly are marked and dimensioned.

You can create multiple drawing sheets of the same part in the Master Drawing Catalog using rule sets or wizards (page 99), or using the drawing properties dialog box (page 100).

See also
Copy a drawing to a new sheet (page 125)

Create multiple drawing sheets with wizards
Before you start, ensure that you have created drawing property files (saved settings) for creating multiple sheets for the same part, each file containing the desired settings for a specific purpose and individual sheet numbers.

1. On the Drawings & reports tab, click Create drawings --> Master drawing catalog to open the Create Drawings - Master Drawing Catalog dialog box.
2. Double-click the desired wizard (page 80) file in the list to open the Master Drawing Properties dialog box.
3. Click Edit drawing properties to open the wizard file (page 109).
4. In the file, give the names of the drawing properties files that you want to use to create the multiple drawing sheets.

Give the file names in parenthesis on the set_drawing_attributes row as shown below:

```plaintext
set_drawing_type(cast_unit)
set_drawing_attributes(sheet1, sheet2, sheet3)
set_filter(column_filter)
create_drawings()
```
5. Save the wizard file with a new name.
6. In the model, select the parts you want to create the drawings from.
7. Click the newly created wizard file in the **Master Drawing Catalog** and click **Create Drawings**. Tekla Structures creates the drawings.

**Create multiple drawing sheets using drawing properties**

1. Open the drawing properties dialog box by double-clicking the background of an open drawing.
2. Adjust the drawing properties as needed, and change the drawing name so that it refers to the type of drawing you want to create, for example, **FRAME 3D**.
   
   Do not touch the **Sheet number** box.
3. Click **Apply** to keep the changes and leave the dialog box open.
4. Create a drawing of the object by selecting the appropriate command: On the **Drawings & reports** tab, hold down **Shift** and click **Create drawings** and click the drawing type.
5. In the open drawing properties dialog box, adjust the drawing properties again and change the name to match the type of the new drawing, for example, **FRAME FRONT**.
6. Change the sheet number in the **Sheet number** box to get another drawing of the same assembly with a different sheet number.
7. Click **Apply** and create a new drawing of the same object with different properties.
8. Continue making all the sheets you need in the same way as in steps 5 - 7.

**Example**

An example how the **Drawing List** shows the multiple drawings:

<table>
<thead>
<tr>
<th>Date</th>
<th>Sheet</th>
<th>Number</th>
<th>Description</th>
<th>Sheet number</th>
</tr>
</thead>
<tbody>
<tr>
<td>02.01.2012</td>
<td>02.01.2013</td>
<td>1179* 830</td>
<td>A <strong>[FRAME 1 - 1]</strong></td>
<td>FRAME FRONT</td>
</tr>
<tr>
<td>02.01.2012</td>
<td>02.01.2013</td>
<td>1179* 830</td>
<td>A <strong>[FRAME 1 - 2]</strong></td>
<td>FRAME DETAILS</td>
</tr>
<tr>
<td>02.01.2012</td>
<td>02.01.2013</td>
<td>1179* 830</td>
<td>A <strong>[FRAME.1]</strong></td>
<td>FRAME 3D</td>
</tr>
</tbody>
</table>

**Search for master drawings and save the results in Master Drawing Catalog**

In the **Master Drawing Catalog** search view, you can search for master drawings on the basis of the text that has been entered in the name, description and keyword boxes in the **Master Drawing Properties** dialog box and save your search results. In the folder view, you can copy master drawings.
from a search results folder to another folder to make it easier for you to locate the master drawings you need.

**TIP** Make sure to always add all important information for each master drawing in the **Master Drawing Properties** dialog box. This makes it a lot easier to find the master drawings you are looking for.

To search for master drawings and save the search results:

1. Enter the search criteria in the box next to the **Search** button.
   Tekla Structures remembers search strings. When you start typing a string, it suggests previous strings starting with the same characters.
2. Click **Search**. The results are listed.
3. To save the search results, click **Store**, type a name for the search, and click **OK**.
   The search results are added in the category list in the search view.
   The search results are also displayed as a folder in the folder view. There you can rename the saved search results, and copy the found drawings to the folders of your choice.

**See also**

- *Create drawings in Master Drawing Catalog (page 75)*
- *Modify master drawing properties (page 106)*

**Customize Master Drawing Catalog**

You can customize the **Master Drawing Catalog** according to your needs. Keeping the **Master Drawing Catalog** up to date and well organized is essential if you want to create drawings fast and efficiently. Having good master drawings saves time and effort.

Add only the necessary master drawings, remove obsolete ones, organize the master drawings in folders, add proper preview images, and keep the properties, descriptions and keywords up to date.

<table>
<thead>
<tr>
<th>To</th>
<th>Click the links below to find out more</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add new master drawings (saved settings, rule sets and cloning templates)</td>
<td>Add master drawings in Master Drawing Catalog (page 102)</td>
</tr>
<tr>
<td>Remove an obsolete master drawing from <strong>Master Drawing Catalog</strong></td>
<td>Remove master drawings from the Master Drawing Catalog (page 105)</td>
</tr>
<tr>
<td>Change the name, description, keyword and sample image of a</td>
<td>Modify master drawing properties (page 106)</td>
</tr>
</tbody>
</table>
To | Click the links below to find out more
---|---
master drawing and edit the saved setting properties file, rule set contents, or cloning options |  
Create folders in **Master Drawing Catalog**, copy master drawings between folders, and change the folder location | Manage Master Drawing Catalog folders (page 111)
Take drawing screenshots to be used as sample images and thumbnail images for master drawings in **Master Drawing Catalog** | Sample images of drawings (page 114)
Add sample and thumbnail images to master drawings (page 115)
Create new drawings based on master drawings | Create drawings in Master Drawing Catalog (page 75)

---

**Add master drawings in Master Drawing Catalog**

Depending on your environment, the **Master Drawing Catalog** usually contains some master drawings when you start using it, at least the predefined saved settings (drawing properties files) are there, and maybe some wizards.

You can also add new:

- Saved settings: Add a saved settings master drawing in Master Drawing Catalog (page 104)
- Rule sets: Add a rule set master drawing in Master Drawing Catalog (page 102)
- Cloning templates: Add a cloning template master drawing in Master Drawing Catalog (page 104)

**Add a rule set master drawing in Master Drawing Catalog**

1. On the **Drawings & reports** tab, click **Create drawings --> Master drawing catalog**.
2. Click the **Add rule set** toolbar button 📜.
3. In the **Define Rules for Creating Drawings** dialog box, select the drawing types you want to create with the rule set.
   
   You can select several drawing types with the same rule set. For example, you can use the same rule set to create single-part drawings and assembly drawings.
4. Click **Next**.
5. In the next dialog box, click **Add group** and select the object groups for which you want to create drawings, and a master drawing for each group. Only those master drawing types are listed that can be used for the drawing types that you selected in the previous dialog box. Saved settings are marked with an S and cloning templates with T.

You can use the buttons in the dialog box to do the following:

- Use **Move up** and **Move down** to move a rule upwards and downwards in the list.
  
  If a rule that is higher in the list creates a drawing of an object, another rule lower in the list that would create a drawing of the same object will not do it again.

- Use **Properties** to view or modify the properties of a master drawing that you have selected in the list.

- Use **Preview** to display a sample image of the selected master drawing.

6. Click **Next**.

7. If you have selected several drawing types, repeat steps 4 and 5 for all drawing types that you have selected.

8. Modify master drawing properties of the rule set: give a name to the rule set, add a sample image, and enter a description and keywords.
9. Click **Finish**.
    The rule set is added in the **Master Drawing Catalog**.

**See also**
- Add master drawings in Master Drawing Catalog (page 102)
- Rule sets in Master Drawing Catalog (page 79)
- Create drawings using rule sets or wizards in Master Drawing Catalog (page 92)
- Add sample and thumbnail images to master drawings (page 115)
- Example - Create a new rule set and drawings for all parts (page 93)

**Add a saved settings master drawing in Master Drawing Catalog**
All predefined drawing properties files are shown as saved settings in the **Master Drawing Catalog**. When you save a new drawing properties file, Tekla Structures shows it in the **Master Drawing Catalog** automatically.

1. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type.
2. Modify the drawing properties in the **Single-part Drawing Properties**, **Cast Unit Drawing Properties, Assembly Drawing Properties** or **General Arrangement Drawing Properties** dialog box.
3. Load drawing properties that are as close to the ones you need as possible.
4. Modify the properties.
5. Give a name to the properties file and save the file.
   The new property file is automatically added to the **Master Drawing Catalog**. If it is not displayed in the list, press **F5** to refresh the view.
6. Modify master drawing properties: give the master drawing a name, add a sample image, and enter a description and keywords.

**See also**
- Add master drawings in Master Drawing Catalog (page 102)
- Saved settings in Master Drawing Catalog (page 77)
- Add sample and thumbnail images to master drawings (page 115)
- Create general arrangement drawings using saved settings in Master Drawing Catalog (page 82)
- Create single-part, assembly and cast unit drawings using saved settings in Master Drawing Catalog (page 86)
**Add a cloning template master drawing in Master Drawing Catalog**

You can add drawings as cloning templates in the **Master Drawing Catalog** from the **Drawing List**.

Before you add a cloning template in the **Master Drawing Catalog**, create a drawing with the desired properties and contents and save it.

**Limitations**: You cannot add general arrangement drawings or multidrawings to the **Master Drawing Catalog** from the **Drawing List**. You can clone general arrangement drawings using the **Clone** command in the **Drawing List** dialog box.

1. On the **Drawings & reports** tab, click **Drawing list**.
2. Select the drawing, right-click and select **Add to Master Drawing Catalog** (**Ctrl + M**).
3. Modify the master drawing properties of the cloning template. On the **General** tab, enter a name for the cloning template, and a short description and keywords.
4. Tekla Structures adds a preliminary thumbnail image for the cloning template. If necessary, click **Change Image** and browse for a new image. The same image will then be displayed when you right-click the thumbnail and select **Preview**.
5. Go to the **Drawing creation** tab and specify how dimensions and marks are created, and select the objects to be cloned from the master drawing.
6. Click **OK**.

   The new cloning template is added in the **Master Drawing Catalog**. The icon is displayed in the **Master** column of the **Drawing List** next to the drawing you added.

**See also**

- Add master drawings in Master Drawing Catalog (page 102)
- Add sample and thumbnail images to master drawings (page 115)
- Cloning templates in Master Drawing Catalog (page 77)
- Create drawings using cloning templates in Master Drawing Catalog (page 116)

---

**Remove master drawings from the Master Drawing Catalog**

You can remove obsolete master drawings from the **Master Drawing Catalog**.

**Limitations**: In the folder view, you cannot remove master drawings from the **Master Drawing Catalog** through the folders that you have created yourself.
Use the **Saved searches** folders to display the desired master drawings and then remove the extra ones.

1. On the **Drawings & reports** tab, click **Create drawings --> Master drawing catalog**.
2. In the **Master Drawing Catalog**, select the master drawings you want to remove.
3. Right-click and select **Remove from Catalog**.
4. Confirm the removal.

Tekla Structures removes the master drawings from the catalog. Any created drawings that are based on removed master drawings remain in the **Drawing List**. The catalog properties that you have entered for the master drawing are not deleted. They are still available for the master drawing if you decide to add the master drawing back to the catalog.

**Modify master drawing properties**

Each master drawing in the **Master Drawing Catalog** has its own properties:

- You can search for master drawings based on the master drawing name, description and keywords that you add.
- You can **add a sample image (page 115)** for each master drawing (**Change image** button).
- The sample image is also shown as a thumbnail in the thumbnail view of the **Master Drawing Catalog**.
- You can access drawing properties (**Edit drawing properties** button) and you can, for example, apply object level settings.

**TIP** Make sure to always add all important information for each master drawing in the **Master Drawing Properties** dialog box. This makes it a lot easier to find the master drawings you are looking for.
You can modify the name, description and keywords of saved settings in *Master Drawing Catalog*, and change its sample image.

1. In the *Master Drawing Catalog*, double-click a master drawing of the desired type.
2. Modify the name of the drawing in the **Name** box.
3. Enter or modify the description of the master drawing. You can search master drawings on the basis of data that you enter here.
4. Enter or modify keywords for the master drawing. Use spaces between words. You can search master drawings on the basis of data that you enter here.
5. To add or change the sample image, click **Change image** and select the image. You can use .bmp, .jpg, .jpeg, or .png images. We recommend that you use .png images.
6. If needed, modify the drawing properties of the master drawing by clicking **Edit drawing properties** to display the drawing properties dialog box. This also allows you to apply object level settings.

   Save the modified properties. Ensure that you have the correct drawing property file name at the top.

7. Click **OK**.

**See also**

*Apply detailed object level settings in saved settings (page 81)*

*Saved settings in Master Drawing Catalog (page 77)*

**Modify rule set properties**

You can modify the name, description and keywords of rule sets in **Master Drawing Catalog**, and change its sample image.

1. In the **Master Drawing Catalog**, double-click a master drawing of the desired type.

2. In the **Edit Rules** dialog box, modify the drawing type selections if necessary.

3. Click **Next**.

4. Add or remove object groups and select the appropriate master drawing type.

5. Click **Next** and do the same for all the selected drawing types.

6. Modify the name of the drawing in the **Name** box.

7. Enter or modify the description of the master drawing.

   You can search for master drawings based on the data you enter here.

8. Enter or modify keywords of the master drawing.

   Use spaces between words. You can search master drawings on the basis of data you enter here.

9. To add or change the sample image, click **Change image** and select the image.

   You can use .bmp, .jpg, .jpeg, or .png images. We recommend that you use .png images.

   The same image is used in the thumbnail view of the **Master Drawing Catalog**.

10. Click **Save** to save your changes.

**See also**

*Rule sets in Master Drawing Catalog (page 79)*
Modify properties and contents of wizard files
You can modify wizard files in the Master Drawing Catalog using a text editor. You can change the name, description, and keywords, and add a sample image.

1. In the Master Drawing Catalog, double-click a wizard file.
2. Modify the name of the drawing in the Name box.
3. Enter or modify the description of the master drawing.
   You can search for master drawings based on the data you enter here.
4. Enter of modify keywords of the master drawing.
   Use spaces between words. You can search for master drawings based on the data you enter here.
5. To add or change the sample image, click Change image and select the image.
   You can use .bmp, .jpg, .jpeg, or .png images. We recommend that you use .png images.
   The sample image will also be used as the thumbnail image of the master drawing in the thumbnail view of the Master Drawing Catalog.
6. To edit the contents of the wizard file, click Edit drawing properties.
   The wizard file is opened in a text editor. Modify the contents of the file, and save and close it.
7. Click OK.

See also
Wizards in Master Drawing Catalog (page 80)

Wizard file contents
Wizard files consist of the following entries. Notice the use of parentheses.

set_drawing_type(assembly)
This line defines the type of drawing the wizard creates. The drawing type appears in parentheses. The options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Creates</th>
</tr>
</thead>
<tbody>
<tr>
<td>single</td>
<td>single-part drawings</td>
</tr>
<tr>
<td>assembly</td>
<td>assembly drawings</td>
</tr>
<tr>
<td>multi_single</td>
<td>single-part multidrawings</td>
</tr>
<tr>
<td>multi_single_with_layout</td>
<td>single-part multidrawings with layout</td>
</tr>
</tbody>
</table>

Create drawings in Tekla Structures 109  Create drawings in Master Drawing Catalog
**Option** | **Creates**
---|---
multi_assembly | assembly multidrawings
multi_assembly_with_layout | assembly multidrawings with layout
cast_unit | cast unit drawings

### set_drawing_attributes(column)
This line tells Tekla Structures which drawing properties to use when creating the drawings. The name of the saved drawing properties appears in parentheses.

### set_template_drawing
This line tells Tekla Structures to use the defined drawing as a template when creating a new drawing. This line is used instead of the line `set_drawing_attributes`. The path and the name of the drawing template are given in parenthesis like in the following example:

```plaintext
set_template_drawing("C:\TSModels\AngleModel";"[A.2]")
```

### set_filter(column_filter)
This line tells Tekla Structures which selection filter to use to select the parts from which to create drawings. The filter name appears in parentheses.

### create_drawings()
Tekla Structures starts creating the drawings. This line should always appear immediately after the lines `set_drawing_type`, `set_drawing_attributes` and `set_filter`.

### See also
- [Wizards in Master Drawing Catalog (page 80)]
- [Create drawings using rule sets or wizards in Master Drawing Catalog (page 92)]
- [Modify properties and contents of wizard files (page 109)]

### Modifying cloning template properties
You can modify the name, description and keywords of cloning templates in [Master Drawing Catalog](#), and change its sample image.

1. In the **Master Drawing Catalog**, double-click a master drawing of the desired type.
2. Modify the name of the drawing in the **Name** box.
3. Enter or modify the description of the master drawing.
   You can search for master drawings based on the data you enter here.
4. Enter or modify keywords of the master drawing.
   Use spaces between words. You can search for master drawings based on
   the data you enter here.

5. To add or change the sample image, click **Change image** and select the
   image.
   You can use .bmp, .jpg, .jpeg, or .png images. We recommend that you
   use .png images.
   The sample image will also be used as the thumbnail image of the master
drawing in the thumbnail view of the **Master Drawing Catalog**.

6. Go to the **Drawing creation** tab.
   a. For the **Dimensions**, **Marks**, and **Marks for welds in model**, define
      whether you want to **Clone** them, recreate them automatically when
      you clone a drawing (**Create**) or **Ignore** them in cloning.
   b. Select the objects to be cloned from the master drawing: **Drawing
      and **Hyperlinks**.

7. Click **OK**.

**See also**

- Cloning templates in Master Drawing Catalog (page 77)
- Create drawings using cloning templates in Master Drawing Catalog
  (page 116)

**Manage Master Drawing Catalog folders**

In the folder view of the **Master Drawing Catalog** you can add new folders,
rename folders, and move folders. You can also copy master drawings to
another folder, and delete master drawings.

- Add new, rename, and move folders: Example: Add, rename, and move
  folders (page 112)
- Copy master drawings to another folder: Copy master drawings to another
  folder (page 113)
- Delete master drawings from folders: Remove master drawings from a
  folder (page 113)
NOTE  Deleting master drawings from a folder or copying them to another folder in the folder view does not affect the catalog contents in any way. The folder view is just another way to help you to keep you master drawings well organized.

See also
Create drawings in Master Drawing Catalog (page 75)

Example: Add, rename, and move folders

This is an example of how you can add, rename and move folders in Master Drawing Catalog:

1. In the Master Drawing Catalog, click the folder view button to go to the folder view.
2. **To add a folder:** Right-click the tree area in the upper part of the folder view, select **Create new folder** and enter a name for the new folder. For example, enter `PROJECT_XYZ`.

3. **To add a subfolder:** Right-click folder, in this case `PROJECT_XYZ`, and select **Create new subfolder**.

4. Enter a name for the folder. For example, enter `Site12`.

5. Create another subfolder `Site10` following the steps 3 - 4.

6. **To rename a folder:** Right-click the folder, select **Rename (F2)** and enter a new name. For example, rename `Site10` to `Site11`.

7. **To move a folder upwards:** Right-click the folder and select **Move up**. In this case, move `Site11` one step up.

---

**Copy master drawings to another folder**

1. In the **Master Drawing Catalog**, click the folder view button `📂` to go to the folder view.

2. Open the folder containing the master drawings that you want to copy to another folder, and select the drawings.

3. Right-click and select **Add to** and then select the desired folder.

The master drawings are copied. They are not removed from the original folder.

---

**TIP** Use the following keys and key combinations for selecting drawings:

- Select all displayed drawings: `Ctrl + A`
- Select consecutive drawings: Click the first drawing, hold down `Shift` and select the last drawing.
- Select several drawings: Click the first drawing, hold down `Ctrl` and select the rest of the drawings.

---

**Remove master drawings from a folder**

You may want to remove master drawings from a folder in the folder view, for example, when you have copied master drawings to another folder and no longer need them in the original folder.
1. In the **Master Drawing Catalog**, click the folder view button to go to the folder view.

2. In the upper part of the folder view, click the folder from which you want to remove drawings.
   The master drawings in the folder are shown in the lower part of the view.

3. Select the master drawings to be deleted, right-click and select **Remove from folder**.
   The master drawings are removed from the folder. The master drawings are not removed from the catalog, just from the folder.

**Sample images of drawings**
You can create sample or preview images of the drawings. These screenshots are saved by default in the `\drawings` folder under the model folder as `.png` files. The sample images are used in Master Drawing Catalog.

You can:
- [Create sample images (page 114)](#)
- View the sample image of a master drawing by right-clicking the master drawing and selecting **Preview**.
- [Use sample images as thumbnail images for master drawings (page 115)](#) in the **Master Drawing Catalog** views
- [Add sample images to master drawings (page 115)](#) in the **Master Drawing Catalog**.

**Create sample images for Master Drawing Catalog**
You may want to add a sample image for a master drawing in the **Master Drawing Catalog** to quickly have a look at the drawing template before you create drawings. They are also used as thumbnail images in the **Master Drawing Catalog** thumbnail list.

Before you can create a sample image of a drawing, you must first create the drawing.

1. Open the drawing you want to use.
2. Clean up the drawing from unnecessary objects, for example, associativity symbols.
3. On the **Views** tab, click **Screenshot > Sample image for Master Drawing Catalog**.
   The image is saved in the `\drawings` folder under the model folder in `.png` format with the same name as the drawing. You can see the name of the image on the status bar.
Add sample and thumbnail images to master drawings

You can add sample images for master drawings in Master Drawing Catalog. The same image is used as a thumbnail in the Master Drawing Catalog thumbnail list.

Before you can add a sample image or a preview image to a master drawing, you must have it somewhere ready.

Sample images are just samples, they are not real-time drawings, and they do not update when the drawing changes.

1. On the Drawings & reports tab, click Create drawings --> Master drawing catalog.

2. In the Master Drawing Catalog, locate the desired master drawing and double-click it to open the Master Drawing Properties dialog box.

3. Add the image you created:
   • For the master drawings of the type saved settings, cloning templates, and wizard files, click Change image and browse for the sample image. Click OK to save the image as a sample image.
   • For rule sets, click Next until you get to the page where you can add the sample image. Click Browse and browse for the sample image. Click Save to save the image as a sample image.

Now you can display the sample image by selecting the master drawing on the catalog list, right-clicking and selecting Preview. The thumbnail image in the Master Drawing Catalog thumbnail list is a smaller version of the same sample image.

See also

Create sample images for Master Drawing Catalog (page 114)

2.8 Clone drawings

You should consider cloning drawings when:
   • There are several similar parts, assemblies, or cast units in the model.
   • You want to ease editing work when there are several similar parts that have different position numbers. You may have separate drawings of these similar parts.
   • The drawings need a lot of manual editing

If cloning does not produce a satisfactory result, you need to modify the cloned drawing manually. For example, you can create a drawing for one truss,
modify the drawing, and then clone it for similar trusses. Sometimes you need to modify the cloned drawings where the trusses differ.

The cloned drawing may contain more or less parts than the original drawing. Part properties, marks, associative notes and related text objects are cloned from a similar part in the original drawing.

You can clone drawings using the cloning templates added in the Master Drawing Catalog in the existing model and in other models, using a drawing in the Drawing List of the current model, and using the cloning templates in the template library.

Click the following links to find out more about cloning:

- Create drawings using cloning templates in Master Drawing Catalog (page 116)
- Clone by using cloning templates located in other models (page 117)
- Clone from the Drawing List (page 118)
- Clone dimensions in selected views only (page 122)
- Clone using drawing templates in template library (page 126)
- Cloned objects (page 123)
- What to check in cloned drawings (page 123)
- Refresh drawing associativity after cloning (page 124)

Create drawings using cloning templates in Master Drawing Catalog

In the Master Drawing Catalog, you can create single-part, assembly and cast unit drawings using cloning templates that you have added there from the Drawing List.

Note that only the cloning templates located in the folder that is set for the advanced option XS_CLONING_TEMPLATE_DIRECTORY are displayed in the Master Drawing Catalog.

Limitations:

- You cannot clone general arrangement drawings through the Master Drawing Catalog. You can clone general arrangement drawings only by using the Clone command in the Drawing List dialog box.
- You cannot clone multidrawings.
- The drawing properties of cloning templates cannot be modified through the Master Drawing Catalog.

1. On the Drawings & reports tab, click Create drawings --> Master drawing catalog.
2. Double-click the cloning template that you want to use.

3. Go to the **Drawing creation** tab and specify how dimensions and marks are cloned.
   
   You can select to ignore the dimensions and marks, clone them, or recreate them.
   
   The **Marks** option controls revision marks and all marks for model objects.
   
   Selecting **Create** in the **Dimensions** and **Other marks** box is useful if cloning the dimensions or other marks does not produce satisfactory results. Using this option does not create any new views.

4. On the same tab, select which object types you want to clone.

5. If you want to create a drawing only for certain parts, select the parts from the model.
   
   You can also use an appropriate selection filter and select the whole model. Activate only the **Select parts** selection switch when you select objects, otherwise the selection may take a long time.

6. Click **Create drawings** or **Create drawings for all parts**.

7. Number the model if prompted to do so.
   
   Tekla Structures creates the drawings and adds them in the **Drawing List**. In the **Drawing List**, cloned drawings are marked with the text **Cloned** in the **Changes** column.

8. Check the cloned drawing and modify it (page 123), if necessary.

---

**TIP**  If you have cloning templates that you have created using an older Tekla Structures version and want to utilize the better associativity of a newer Tekla Structures version, refresh the drawing associativity (page 124) by using the **Refresh Associativity** command, which you can type in the **Quick Launch** box.

---

**See also**

- Cloned objects (page 123)
- Cloning templates in Master Drawing Catalog (page 77)
- Add a cloning template master drawing in Master Drawing Catalog (page 104)

---

**Clone by using cloning templates located in other models**

You can take into use in the **Master Drawing Catalog** cloning templates located in other models, and create drawings using them.

**Limitations:** You can only use cloning templates from other models, not other types of master drawings, such as saved settings or rule sets.
1. On the **Drawings & reports** tab, click **Create drawings --&gt; Master drawing catalog**.

2. In the **Master Drawing Catalog**, click 📚 to open the **Models Containing Master Drawings** dialog box.

3. Click **Add model** and browse to the desired model.

4. Click **OK**.  
   Now the cloning templates in the defined folder are displayed in the **Master Drawing Catalog**.

5. Select the cloning template from the **Master Drawing Catalog** and create a drawing using the selected template.

---

**TIP** When you have similar parts in several projects, you can maintain a set of **cloning models** and then take the cloning templates in the cloning models in use when necessary.

---

**See also**

- Create drawings in Master Drawing Catalog (page 75)
- Create drawings using cloning templates in Master Drawing Catalog (page 116)
- Clone from the Drawing List (page 118)
- Clone using drawing templates in template library (page 126)

---

**Clone from the Drawing List**

In addition to cloning drawings using cloning templates in **Master Drawing Catalog**, you can clone single-part, cast unit, assembly and general arrangement drawings from the **Drawing List**.

---

**NOTE**  
- When you clone drawings of assemblies or cast units, they must have the same type of main part as the assembly or cast unit from which the original drawing was created. For example, the upper chords of the original and the cloned truss could be main parts.
- In general arrangement drawings, one main view, and section and detail views are cloned.

---

Before cloning, finalize, save, and close the drawing you want to use as a cloning template.

To clone a drawing from the **Drawing List**:

1. In the model, select what to include in the drawing:
   - If you are cloning a single-part drawings, cast unit drawing or assembly drawing, select parts, assemblies or cast units.
• If you are cloning a general arrangement drawing, select a model view. To do this, click the desired model view so that the view gets a red frame around it.

2. On the **Drawings & reports** tab, click **Drawing list**.

3. In the **Drawing List**, select the drawing that you want to use as a cloning template.

4. Click **Clone**.

5. In the **Clone Drawing** dialog box, select the drawing object types you want to clone into the new drawing, and the actions for each object type.
   - For **Dimensions** and **Other marks** (all marks for model objects), select whether you want to **Clone** them, recreate them automatically when you clone a drawing (**Create**) or **Ignore** them in cloning.

      Selecting **Create** in the **Dimensions** and **Other marks** box is useful if cloning the dimensions or other marks does not produce satisfactory results. Using this option does not create any new views.

      • For other objects, select to **Clone** or **Ignore** them.

6. Click **Clone selected**.

Tekla Structures clones the drawing. In the **Drawing List**, cloned drawings are marked with the text **Cloned** in the **Changes** column.

For an example of cloning a general arrangement drawing, see **Example: Clone a general arrangement drawing (page 120)**
See also
Clone drawings (page 115)
Create drawings using cloning templates in Master Drawing Catalog (page 116)

**Example: Clone a general arrangement drawing**

In this example, we first created a general arrangement drawing of the first floor of a building, then edited the drawing and then cloned the general arrangement drawing of the second floor.

The first floor and second floor have some differences:

![Diagram of first and second floor drawings]

We edited the general arrangement drawing of the first floor slightly.
We selected the model view that represents the second floor and then cloned the drawing using the general arrangement drawing of the first floor as a template.

In the cloned drawing:
• The drawing view plane has been moved to match the model view PLAN 2nd Floor plane.
• If there are parts in matching places, the marks have been cloned to the new location and the content has been updated.
• Dimensions are cloned.
• All model object marks and notes are cloned.

See also
Clone from the Drawing List (page 118)

Clone dimensions in selected views only
The dimension cloning options in the Clone Drawing dialog box affect all views, whereas the option Dimension creation method in this view sets the dimension creation method for the selected view only. You can create automatic dimensions in the front view and clone the dimensions in section and end view, for example.

1. Double-click the drawing view frame to open the View Properties dialog box.
2. On the Attributes 2 tab, set Dimension creation method in this view to Clone.
   Using this option affects the creation of the dimensions during cloning and re-dimensioning of existing drawings.
3. Click Modify.
4. Save and close the drawing.
5. Open the Drawing List, select the drawing and click Clone.
6. In the Clone Drawing dialog box, select the objects to be cloned and the dimension cloning option (Ignore, Clone, Create).
   • If you select Dimension > Ignore, the dimensions will be cloned only for those views that have Dimension creation method in this view set to Clone.
   • If you select Dimension > Clone, the dimensions will be cloned for all views.
   • If you select Dimension > Create, the dimensions will be created for all views except for those that have Dimension creation method in this view set to Do not create.
7. Click Clone selected.

See also
Clone drawings (page 115)
Cloned objects
The following objects can be cloned:
• Dimensions
• Marks for welds added in the drawing
• Marks for welds added in the model
• Level marks
• Revision marks
• Annotation objects
• All user-defined attributes of a drawing
• Texts
• Symbols
• Graphical drawing objects (shapes)
• Text files
• DWG/DXF files
• Hyperlinks
• Manually created section and detail views
• When you clone an assembly drawing that includes single-part drawings, Tekla Structures includes the single-part drawings in the cloned assembly drawing by default.

See also
Clone drawings (page 115)

What to check in cloned drawings
Always check the cloned drawings to make sure that the drawing contents meet your needs, and marks, views and dimensions are correct.

You should go through the cloned drawings and check that everything is correct. Below is a checklist for this purpose.

<table>
<thead>
<tr>
<th>Object</th>
<th>Check and change if necessary</th>
</tr>
</thead>
</table>
| Marks         | • In general, mark contents are correct in cloned drawings, but sometimes you may need to modify the location of the marks.  
<p>|               | • Tekla Structures clones only marks that can be mapped to the original |</p>
<table>
<thead>
<tr>
<th>Object</th>
<th>Check and change if necessary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drawing</td>
<td>To create marks to a cloned drawing also for parts that could not be mapped to the template drawing, set the advanced option XS_CREATE_MISSING_MARKS_IN_INTELLIGENT_CLONING to TRUE through File menu &gt; Settings &gt; Advanced options &gt; Marking: General.</td>
</tr>
<tr>
<td>Views</td>
<td>• Ensure that the view sizes and view orientation are correct, and that the views are placed correctly in the cloned drawing. The size of the views is updated according to the parts included in the views.</td>
</tr>
</tbody>
</table>
| Dimensions | • If the cloned drawing contains less parts than the original drawing, the dimensions to the missing parts are automatically removed.  
• If the cloned drawing contains more parts than the original drawing, Tekla Structures dimensions the additional parts using automatic dimensioning, if you have set the advanced option XS_INTELLIGENT_CLONING_ADD_DIMENSIONS to TRUE. Because Tekla Structures uses automatic dimensioning for creating dimensions for new parts, you may have to check and correct the created dimensions.  
• Add missing dimensions and remove the incorrect ones. |

**See also**
- Clone drawings (page 115)
- Cloned objects (page 123)
Refresh drawing associativity after cloning

Often improvements in cloning and associativity require that the associative rules have to be recreated. This can be done by using the Refresh Associativity command. When you use this command, you do not need to recreate the drawing.

For example, this command is very useful if you have a cloning template you have created using an older Tekla Structures version and want to utilize the better associativity of a newer Tekla Structures version.

1. On the Drawings & reports tab, click Drawing list.
2. Open a cloning template the associativity of which you want to refresh.
3. Go to Quick Launch, enter Refresh associativity, and click the Refresh associativity command on the displayed list.
4. Save the cloning template.

See also
Drawing associativity (page 17)
Clone drawings (page 115)

Copy a drawing to a new sheet

You can copy a drawing to a new sheet. This is useful, for example, if you want to have the same layout and views as in the original drawing, but highlight something else on the new drawing sheet.

1. On the Drawings & reports tab, click Drawing list.
2. Select the drawing that you want to use as the original for copying.
3. Right-click and select Create Drawings --> Copy to new sheet.
   Tekla Structures copies the original drawing to a new sheet and gives the copied drawing a new sheet number.

   ![Drawing example]
   
   • Cloned
   • Cloned

4. Open the new drawing sheet, make the necessary changes and save it.

   **NOTE** If you use the Recreate (Shift+R) command for the copied drawing in the Drawing List, Tekla Structures asks if you want to copy the drawing again from the original drawing. If you answer yes, the previously copied drawing sheet will be replaced by a new copy of the previously selected original drawing.
See also
Create multiple drawing sheets of the same part (page 99)

Clone using drawing templates in template library
This is a more manual way of cloning drawings: you can create drawings using drawing templates located in the template library. The template library is a model folder that contains the drawings you want to use as drawing templates.

1. In a model that you use as a template model, create a drawing you want to use as a drawing template and save the drawing.
2. In another model, select the objects to be included in the new drawing.
3. On the Drawings & reports tab, click Drawing list.
4. In the drawing list, click Clone.
5. Click Other model.
   Use Browse to browse for another model folder containing the drawing templates that you want.
6. Click Select template.
7. In the Drawing Templates dialog box, select a drawing template and leave the list open.
8. In the Clone Drawing dialog box, use the Objects and actions in cloning options to define the drawing objects to be cloned and the actions for each cloned object.
9. Clone the drawing by clicking Clone selected.
Tekla Structures clones the drawing. In the Drawing List, cloned drawings are marked with text Cloned in the Changes column.

TIP You can specify that a certain model folder is always used as a template library using the advanced option XS_DRAWING_TEMPLATES_LIBRARY.

See also
Clone drawings (page 115)
Clone by using cloning templates located in other models (page 117)
3 Search for and open drawings

All drawings in a Tekla Structures model are displayed in the **Drawing List** dialog box. You can search, sort, select, and display drawings according to different criteria, and open the drawings displayed in the list. You can take snapshots of the drawings, and locate the drawing parts in the model, and to find out if a part is included in any of the drawings.

Click the following links to find out more.

- Open Drawing list (page 128)
- What is displayed in the Drawing list (page 128)
- Drawing status flags (page 131)
- Select the drawings to show in Drawing List (page 133)
- Search for drawings and save search results (page 134)
3.1 Open Drawing list

You can open the Drawing list in the model and when a drawing is open.

To open the Drawing list dialog box, do one of the following:
• In the model, on the Drawings & reports tab, click Drawing list (Ctrl + L).
• In an open drawing, on the Drawing tab, click Drawing list (Ctrl + O).

See also
Manage drawings (page 372)
Print drawings (page 382)
Search for and open drawings (page 127)
Open drawings (page 136)

3.2 What is displayed in the Drawing list

Drawing list contains a lot of information about the drawings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>For more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issue, Ready for issuing</td>
<td>These columns contain flags indicating the drawing status.</td>
<td>Manage drawings (page 372)</td>
</tr>
<tr>
<td>Freeze, Master, and Up to date</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Changes</td>
<td>Textual information about the changes in the drawing. For example, if the drawing has been cloned, it says Cloned in this column.</td>
<td></td>
</tr>
<tr>
<td>Created</td>
<td>The creation date of the drawing.</td>
<td></td>
</tr>
<tr>
<td>Modified</td>
<td>The latest modification date of the drawing.</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>For more information</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------------------------------</td>
</tr>
<tr>
<td>Revision</td>
<td>The revision number or revision mark of the drawing.</td>
<td>Revise drawings (page 378)</td>
</tr>
<tr>
<td></td>
<td>By default, Tekla Structures shows revision numbers. To show revision marks</td>
<td></td>
</tr>
<tr>
<td></td>
<td>instead, set the advanced option XS_SHOW_REVISION_MARK_ON_DRAWING_LIST</td>
<td></td>
</tr>
<tr>
<td></td>
<td>to TRUE.</td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>The drawing types are identified by the following letters:</td>
<td>Drawing types (page 45)</td>
</tr>
<tr>
<td></td>
<td>• W for single-part drawings.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• A for assembly drawings.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• C for cast unit drawings.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• G for general arrangement drawings.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• M for multidrawings.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>U (unknown) means that an error has occurred, and you need to delete the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>drawing.</td>
<td></td>
</tr>
<tr>
<td>Size</td>
<td>The paper size the drawing uses.</td>
<td></td>
</tr>
<tr>
<td>Mark</td>
<td>In a single-part drawing mark is the part position, and in an assembly</td>
<td>XS_SHOW_REVISION_MARK_ON_DRAWING_LIST</td>
</tr>
<tr>
<td></td>
<td>drawing the assembly position from which the drawing was created.</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>For more information</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>You cannot change drawing marks. Mark contains the sheet number as well, if it is not zero (0). You can choose to have Tekla Structures base the mark of cast unit drawings on the position number or the ID (GUID) of the cast unit.</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>The name given for the drawing in the drawing properties dialog box.</td>
<td>Rename drawings (page 144)</td>
</tr>
<tr>
<td>Title 1, Title 2, and Title 3</td>
<td>Extra drawing titles added in the drawing properties dialog box.</td>
<td>Give titles to drawings (page 144)</td>
</tr>
<tr>
<td>Ready for issuing by</td>
<td>Indicates who has marked the drawing ready for issuing.</td>
<td>Mark drawings ready for issuing (page 376)</td>
</tr>
<tr>
<td>Locked by</td>
<td>The <strong>Locked by</strong> column shows who locked the drawing. If you have logged in to your Trimble Identity, your account name is shown. Otherwise your user name is shown.</td>
<td>Lock drawings (page 374)</td>
</tr>
<tr>
<td>User-defined attributes</td>
<td>You can show up to 20 user-defined attributes in the <strong>Drawing List</strong>. These user-defined attributes must be added in the <strong>User-defined Attributes</strong> dialog box or panel in drawing properties. To include a user-defined attribute in drawing lists, the user-defined attribute must have the option <code>special_flag</code> set to <code>yes</code> in the <code>objects.inp</code> file.</td>
<td>User-defined attributes in drawings (page 677)</td>
</tr>
</tbody>
</table>

Search for and open drawings 130 What is displayed in the Drawing list
3.3 Drawing status flags

Tekla Structures uses certain symbols called flags, to indicate the status of the drawings. The columns Issue, Ready for issuing, Lock, Freeze, Master and Up to date contain the flags, and the potential additional information is displayed in the Changes column. If a drawing does not have any flag symbol, it is up to date.

See also
Manage drawings (page 372)
How to read the drawing status information (page 131)
Search for and open drawings (page 127)

3.4 How to read the drawing status information

The table below explains the meaning of the status flags and information about the status of a drawing in the Drawing List.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Column where shown</th>
<th>Information in the Changes column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Up to date</td>
<td>Parts modified</td>
<td>The parts in the drawing have changed, for example, parts</td>
</tr>
<tr>
<td>Flag</td>
<td>Column where shown</td>
<td>Information in the Changes column</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>---------------------</td>
<td>------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>have been added or deleted, or part properties have changed.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Quantity increased or Quantity decreased</td>
<td>The actual drawing is up to date, but the number of identical parts has changed.</td>
</tr>
<tr>
<td>✗</td>
<td>Up to date</td>
<td>All parts deleted</td>
<td>All the parts related to the drawing have been deleted.</td>
</tr>
<tr>
<td></td>
<td>Lock</td>
<td></td>
<td>The drawing is locked and you cannot open it for editing.</td>
</tr>
<tr>
<td></td>
<td>Freeze</td>
<td></td>
<td>The drawing is frozen. Changes made to the model objects, which have drawing objects associated with them, are no longer available in the drawing.</td>
</tr>
<tr>
<td></td>
<td>Master</td>
<td></td>
<td>The drawing has been added as a master drawing in the Master Drawing Catalog.</td>
</tr>
<tr>
<td>✓</td>
<td>Ready for issuing</td>
<td>Drawing updated</td>
<td>The drawing is marked ready for issuing. You can check who marked the drawing from the new Ready for issuing by column.</td>
</tr>
<tr>
<td>Flag</td>
<td>Column where shown</td>
<td>Information in the Changes column</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>---------------------</td>
<td>-----------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="flag" /></td>
<td>Up to date</td>
<td>Linked drawing changed</td>
<td>You have a linked drawing in this drawing and the linked drawing has been modified.</td>
</tr>
<tr>
<td><img src="image" alt="flag" /></td>
<td>Up to date</td>
<td>Copied view changed</td>
<td>A copied drawing has been modified.</td>
</tr>
<tr>
<td><img src="image" alt="flag" /></td>
<td>Up to date</td>
<td>Drawing updated</td>
<td>A frozen drawing has been updated.</td>
</tr>
<tr>
<td><img src="image" alt="flag" /></td>
<td>Up to date</td>
<td>Drawing updated</td>
<td>Drawing that has been marked ready for issuing has changed.</td>
</tr>
<tr>
<td><img src="image" alt="flag" /></td>
<td>Up to date</td>
<td>Cloned</td>
<td>The drawing is a cloned drawing. The flag disappears when you save and close the drawing.</td>
</tr>
<tr>
<td><img src="image" alt="flag" /></td>
<td>Issue</td>
<td></td>
<td>The drawing has been issued. For example, you might re-issue drawings that have been sent to site.</td>
</tr>
<tr>
<td><img src="image" alt="flag" /></td>
<td>Issue</td>
<td>Issued drawing changed</td>
<td>The issued drawing has been edited or otherwise changed.</td>
</tr>
</tbody>
</table>

See also

Search for and open drawings (page 127)
3.5 Select the drawings to show in Drawing List

In addition to using search, you can select which drawings you want to see in the list and in which order.

To filter the Drawing List contents, do any of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display a predefined set of drawings</td>
<td>Select a set of drawings from the select drawing set list. Saved search results are also displayed in this list.</td>
</tr>
<tr>
<td>List all drawings</td>
<td>Click Show all.</td>
</tr>
<tr>
<td>Invert the contents of the current list</td>
<td>Click Invert. This feature allows you to list the opposite of the current content. For example, if you had selected to display Locked drawings, clicking Invert shows all drawings except the locked ones.</td>
</tr>
<tr>
<td>List selected drawings only</td>
<td>Select the drawings and click Selected.</td>
</tr>
<tr>
<td>List up-to-date drawings only</td>
<td>Click Up to date.</td>
</tr>
<tr>
<td>List drawings that need to be updated</td>
<td>1. Click Up to date. 2. Click Invert.</td>
</tr>
<tr>
<td>Lists only drawings associated with the objects you have selected in the model.</td>
<td>1. Select objects in the model. 2. Click By parts. This is an easy way to identify the drawings associated with a specific part, assembly or cast unit.</td>
</tr>
<tr>
<td>Sort the list according to Column name</td>
<td>Click the column name.</td>
</tr>
</tbody>
</table>

3.6 Search for drawings and save search results

You can search for drawings in the Drawing List.

To search for drawings and save the results:

1. In the Drawing List, enter the search criteria in Enter search criteria.
2. If needed, you can limit the search so that it addresses only information in a certain column by selecting a column from the Search in list.
3. If needed, you can also limit the search to the currently visible drawings by selecting **Search within the currently visible drawings**.

4. Click **Search**.

5. Click **Store** to save the search results.

6. Enter a name for the search results in the **Store Search Result** dialog box and click **OK**.

   The search results are saved in the **DrawingListSearches** folder, which is created in the model folder.

   You can move the saved search results to your environment, company or project folder. After you have saved the search results, they will be visible in the predefined drawing sets list in the **Drawing List** dialog box.

**Example**

In the following example, you want to find all cast unit drawings that are assigned to Dean Detailer:

1. From the drawing sets, select **Cast unit drawings**. Only cast unit drawings are displayed in the list.

2. In the **Enter search criteria**, type **Dean Detailer**.

3. In the **Search in** list, select **Assigned to**.

4. Click **Search**.

![Drawing List Example](image)

### 3.7 Select drawings in the Drawing List

The **Drawing List** allows you to select one or several drawings at a time. Selecting several drawings is useful, for example, if you want to lock or freeze several drawings at a time, or print several drawings.

To select drawings in the **Drawing List**:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select one drawing</td>
<td>Click the drawing in the list.</td>
</tr>
</tbody>
</table>

Search for and open drawings 135 Select drawings in the Drawing List
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select several consecutive drawings</td>
<td>Click the first drawing, then hold down the Shift key and click the last drawing.</td>
</tr>
<tr>
<td>Select several non-consecutive drawings</td>
<td>Click the first drawing, then hold down the Ctrl key and click the other drawings you want to select.</td>
</tr>
<tr>
<td>Select all drawings in the list</td>
<td>Press Ctrl+A.</td>
</tr>
</tbody>
</table>

See also

Search for and open drawings (page 127)

3.8 Check whether parts have drawings

You can use the **Drawing List** to identify parts in the model that have associated drawings.

Before you start, ensure that you have only the Select parts selection switch active on the Selecting toolbar. Otherwise selecting objects can take a long time in large models.

1. Open a model view where all parts are clearly visible.
2. In the Drawing List, press Ctrl + A to select all drawings.
3. To highlight the parts that have drawings, click the **Select objects** button.
   
   To see the found parts easier, right-click the model and select **Show only selected** to show only the parts that the Select objects command has found and hide all others.
4. After completing the previous step you can highlight the parts that do not have drawings by holding down the Ctrl key and selecting the entire model (hold down the left mouse button and drag all the way from left to right).

3.9 Open drawings

You can open drawings both in the model and in the drawing mode. Only one drawing can be open at a time.

**TIP** To always open the drawings maximized, set the advanced option XS_OPEN_DRAWINGS_MAXIMIZED to TRUE.
Open a drawing in the model

- On the **Drawings & reports** tab, click **Drawing list** (Ctrl + L), and then double-click a drawing to open it.

When you open a drawing, a message box is displayed showing the progress and what is happening, and a snapshot of the drawing is displayed. You can click **Cancel** to cancel the opening.

Open a new drawing when a drawing is already open

You can open another drawing while you already have a drawing open. Do any of the following:

- On the **Drawings** tab, click **Drawing list** (Ctrl + O), and then double-click a drawing to open it.
- To open the next drawing in the **Drawing list**, press Ctrl + Page Down.
- To open the previous drawing in the **Drawing list**, press Ctrl + Page Up.

If you have made some changes in the currently open drawing, Tekla Structures asks you if you want to save the changes before opening another drawing. You also have a chance to take a snapshot (page 137) of the current drawing or mark it ready for issuing (page 376).

When you open a drawing, a message box is displayed showing the progress and what is happening, and a snapshot of the drawing is displayed. You can click **Cancel** to cancel the opening.

Cannot load the selected drawing

Sometimes, you cannot open the drawing because the drawing file cannot be found, or the drawing file is somehow incompatible. Tekla Structures then displays one of the following messages:

- "Cannot load the selected drawing. Could not find the drawing file. Check Tekla User Assistance for more information."
- "Cannot load the selected drawing. Incompatible drawing file. Check Tekla User Assistance for more information."

For more information, see Cannot load selected drawing.

3.10 Create and view drawing snapshots

With snapshots you can take a quick look at any drawings without opening the drawing. Use this tool when you just want to check but not edit a drawing, or
take a look at several drawings while trying to find the one you are looking for, for example, a certain drawing revision. You can take snapshots of all types of drawings.

A snapshot is automatically taken when you open and save a drawing. The snapshot represents the situation when the drawing was last saved, so any newer changes to the model are not reflected in the snapshot.

If you have made changes in the drawing and close it by selecting the Close button in the upper-right corner, a message box is displayed where you can select if you want to save the drawing and also if you want to create a snapshot of the drawing when the drawing is saved.

1. Select a drawing and open it from the Drawing List.
2. Save the drawing by going to the File and clicking Save drawing.
   The snapshot is saved in the ..\<model>\drawings\Snapshots folder.
3. Select the same drawing from the Drawing List.
4. Click the Snapshot button at the bottom of the Drawing List to display the snapshot.
Below is an example of a snapshot.

If you have selected a drawing that does not have a snapshot and click **Snapshots**, an instructional view is displayed asking you to open the drawing and save it to create the snapshot.

**Snapshot overlay**

Drawing snapshots allow you to view the contents of drawings directly in model view without opening the actual drawing. You can also show drawing snapshots against the latest version of a drawing or against another drawing in the drawing mode. All drawing types can be overlaid with drawing snapshots.

You can view a snapshot of a drawing while you are editing a drawing. In the snapshot overlay, you can see the latest changes, and can align the drawing content, for example. You can see the changes in a drawing since the latest update, and switch between the snapshot and the actual drawing.

Finding the correct drawing by going through the snapshots is much faster than opening the actual drawings one by one.

**Limitations**

- Texts are one sided when viewed from the model, and DX graphics do not support text in snapshots.
• Overlay in the model was not designed to work for the 3D drawing views.
• Views that are outside the printing area are displayed in the model overlay.
• Reading large GA drawing snapshots may take a long time.
• Loading the snapshot takes longer for the first snapshot than for the rest.

Before you can see a snapshot overlay of a drawing, you need to create a snapshot (page 137) by opening a drawing, selecting the Create snapshot check box and saving the drawing.

Below you can see the settings in the snapshot view:

![Snapshot overlay in model](image)

**Snapshot overlay in model**

1. Open the Drawing list and select a drawing.
2. Click Snapshot.
3. At the top of the displayed snapshot dialog box, under Overlay in model, select the Overlay check box. You can also select a color for the snapshot.

A cast unit is overlaid with the corresponding cast unit drawing.
**Snapshot overlay in drawings**

1. Click **Drawing** --> **Drawing list**, and open a drawing that has changed after the latest snapshot.

2. Still in the **Drawing list**, select the same drawing and click **Snapshot**.

3. Select one of the options under **Overlay in drawing**:
   - **Overlay**: Show the snapshot on the actual drawing so that both are visible.
   - **Show snapshot only**: Show the snapshot only without the actual drawing.
   - **None**: Quickly switch to the actual drawing.

4. Select a color for the snapshot.

In the example below, the size of the cast unit has changed since the snapshot was taken.

![Snapshot overlay in drawing example](image)

**TIP** If a plan view GA drawing is open, and you want to align content using another GA drawing, you can open a snapshot of the second drawing on the first one, and snap to the snapshot, when placing or moving objects in an open drawing. You can snap to drawing snapshot overlays with the **Snap to geometry lines/points** snap switch.

---

**3.11 Close drawings**

You can only have one drawing open at a time. You always have to close an open drawing before you can open another one.
1. On the **Drawing** tab, click **Close**.
   You can also use the **Close** button in the upper-right corner or the 
drawing window.

2. If you have made changes in the drawing, Tekla Structures asks you to 
confirm if you want to save your changes.
   You can also select to mark the drawing ready for issuing, and create a 
snapshot.

**See also**
- Search for and open drawings (page 127)
- Mark drawings ready for issuing (page 376)
- Create and view drawing snapshots (page 137)
After you have created a drawing, you can modify properties of the drawing and views, building objects, and dimensions and marks already included in the drawing. You can add views, marks, notes, text, shapes and other objects. You can also change drawing colors, and use special custom presentations for some object types.

You can edit the drawing name and titles:
- Rename drawings (page 144)
- Give titles to drawings (page 144)

You can add and edit drawing views and drawing objects:
- Drawing views in open drawings (page 145)
- Dimensions in open drawings (page 170)
- Drawing marks, notes, texts and links in open drawings (page 214)
- Drawing sketching tools and sketch objects (page 259)
- Building objects in drawings (page 283)
- Symbols in drawings (page 347)
- Custom presentations in drawings (page 327)
- Welds in drawings (page 306)
- Edge chamfers in drawings (page 288)
- Pours in drawings (page 329)
- Reference models in drawings (page 364)
- Grids in drawings (page 334)
- Colors in drawings (page 360)
- User coordinate system (UCS) (page 367)

You can move, copy, reposition, and otherwise modify drawing objects. How you can modify an object depends on the object type:
- Hide objects in drawings and drawing views (page 243)
When you save and close the drawings, there are some things you need to keep in mind:

- Save a drawing (page 369)
- Close drawings (page 141)
- Delete unnecessary drawing files in single-user mode (page 370)

### 4.1 Rename drawings

Tekla Structures names the drawings according to the name given in the drawing properties. The drawing name is displayed in the **Drawing List** and in drawing templates. You can change the drawing name when you create the drawing and afterwards.

1. In the **Drawing List**, right-click the drawing and select **Properties**.
2. Enter the new name in the **Name** box.
3. Click **Modify**.
   
   Close the **Drawing List** and open it again to see the change.

**See also**

Define automatic drawing settings (page 424)
4.2 Give titles to drawings

In addition to the drawing name, you can give titles for your drawings. Tekla Structures shows the title in the Drawing List and in drawing and report templates, and also in print output file names. You can define up to three titles to use in drawing templates.

1. In the Drawing List, right-click the drawing and select Properties.
2. Enter the titles.
3. Click Modify.
   Close the Drawing List and open it again to see the change.

TIP If you want to customize your print file names and use title values instead of drawing names in them, you can define that the title entered in this dialog box is used in the print file name. To do this, enter the value %TPL:TITLE1% (or %TPL:TITLE2% or %TPL:TITLE3%) for an advanced option XS_DRAWING_PLOT_FILE_NAME_G (or _W, _A, _M or _C depending on the drawing type) through File menu -> Settings -> Advanced options -> Printing.

See also
Define automatic drawing settings (page 424)
Customize print output file names (page 396)

4.3 Drawing views in open drawings

Drawing views contain Tekla Structures model objects, and the marks, dimensions and other objects that you have added. A drawing view is another way of looking at the model. Drawings may include several views. In addition to the views Tekla Structures creates automatically based on the drawing properties, you can also add new ones in the open drawing, and modify the existing ones.

You can have different types of views in Tekla Structures drawings:
- Main views: front, top, back and bottom views
- Section views
- End views
- Single-part views
- 3D views
- Detail views
- Key plan views
• Views along grid lines
• Elevation views
• Plan views

You can manually add more views in drawings:
Create a section view (page 147)
Create a curved section view (page 149)
Create a detail view (page 150)
Create additional drawing views of parts (page 152)
Create a drawing view of an entire model view (page 153)
Create a drawing view of a selected area in a model view (page 154)
Create a drawing view of a selected area in a drawing view (page 155)
Create a drawing view for a reinforcement mesh (RebarMeshViewCreator) (page 156)

Copying, linking and moving views
You can move, copy and link views from one drawing to another:
Copy drawing views from other drawings (page 159)
Link drawing views from other drawings (page 162)
Move drawing views to another drawing (page 160)

Modifying views and view location
You can modify views and view location manually:
Resize the drawing view boundary (page 162)
Move drawing views by dragging (page 164)
Align drawing views (page 165)
Rotate drawing views (page 166)
Arrange drawing views (page 166)
Modify drawing view properties (page 167)
Modify detail properties in drawings (page 169)
Modify section properties in drawings (page 167)

See also
Automatic drawing views (page 461)
View properties in drawings (page 692)
Section view properties (page 697)
Key plans (page 443)
Create a section view
You can create section views of the parts in a drawing view in an open drawing that contains at least one view.

1. Set the section mark properties first: On the Drawing tab, click Properties --> Section mark.

2. Modify the cutting line, section mark, and section view label properties in the Section symbol properties dialog box, and click OK or Apply.

3. Next, set the section view properties: Hold down Shift and on the Views tab, click Section view.

4. Modify the view properties as required, and click OK or Apply.

5. Pick two points to define the position of the section plane.
   It is easier to pick the points if you activate orthogonal snapping: On the File menu, click Settings and select Ortho or press O.
   For beams, you can also try picking the top line of the beam and then the bottom line of the beam using the snap switch Snap to perpendicular points.

6. Pick two points to define the direction of the cut box and the section view depth.
   When you pick the cut box, exaggerate a little. You can adjust the view depth and the view boundary also later on.
   The direction of the section is the direction where the section mark arrows are pointing.

7. Pick the position for the section view.
   A view symbol follows the mouse pointer allowing you to see where you are about to place the section view.
   The depth to the opposite direction is zero (0).

Tekla Structures creates the section view using the current properties in the View Properties and Section Symbol Properties dialog boxes and adds a section mark in the original view. You can change the properties after creating the view.

TIP • The view boundary of the created section view remains selected, and you can adjust the depth and the height of the view boundary by dragging it.
• If necessary, change the view scale of the section view: Double-click the view frame, clear all other selections using the toggle switch at the bottom, select only the Scale option, and adjust the scale.
• If you want to create another view, start the Section view command again.
1. The first two picked points indicate the position of the section plane.
2. The third picked point indicates the direction of the cut box and the depth of the section view. Here you can exaggerate a little.
3. The fourth pick finalizes the cut box.
4. A view symbol follows the mouse pointer while you are placing the section view. The section view is placed in the selected location. The section view remains selected and the view boundary highlighted right after the view creation.

The section mark is drawn in the original view. The view boundary of the section view is also highlighted in the original view right after the view creation.

See also
Modify section properties in drawings (page 167)
Define view labels and view label marks (page 465)
Section view properties (page 697)
View properties in drawings (page 692)
Modify drawing view properties (page 167)

Create a curved section view
You can create a curved section view of an existing drawing view. This tool is useful when you want to visualize an unfolded face of a building or to manage cladding.

1. Open a drawing.
2. Set the section mark properties first: On the Drawing tab, click Properties --> Section mark.
3. Modify the cutting line, section mark, and section view label properties, and OK or Apply.
4. Set the section view properties: Hold down Shift and on the Views tab, click Curved section view.
5. Modify the view properties as required, and click OK or Apply.
6. Pick three points on the cut plane.
7. Pick two points to indicate the cut box.
8. Pick a point to indicate the location of the curved section view.

A symbol follows the cursor allowing you to see where you are about to place the curved section view.

Tekla Structures creates the curved section view using the current properties in the View Properties and Section Symbol Properties dialog boxes and adds a section mark in the original view. You can change the properties after creating the view.

See also
Modify section properties in drawings (page 167)
Define view labels and view label marks (page 465)
Section view properties (page 697)
View properties in drawings (page 692)
Modify drawing view properties (page 167)

Create a detail view
You can create a detail view from a selected area in an existing drawing view in another view. The scale of the detail view is by default the same as that of the main view, but in some environments the detail view is scaled up. The direction of the detail view is the same as that of the original view.

1. Open a drawing.
2. Set the detail mark properties first: On the Drawing tab, click Properties --&gt; Detail mark.
3. Enter a name for the detail, and modify the detail view label, detail boundary and detail mark properties in the Detail Symbol Properties dialog box.

The shape of the detail boundary you select affects the way you select the area for your detail.
4. Click OK or Apply.
5. Next, set the view properties: Hold down Shift and, on the Views tab, click Detail view.
6. Modify the view properties as required.
7. Click OK or Apply.
8. Depending on the selected detail boundary shape, do one of the following:
   • If the shape is Circle, pick the center point of the circle and then pick a point on the circle.
   • If the shape is Rectangle, pick corner points for the rectangle.
9. Pick a position for the detail mark.
10. Pick a position for the detail view.

Tekla Structures creates the detail view using the current properties in the View Properties dialog box and Detail Symbol Properties dialog box. The detail view takes the view depth from the original view even if you try to change it. You can change the properties after creating the view.

1. Detail boundary is set to Circle
2. Detail mark
3. Detail view
4. Detail view label
You can increase or decrease the detail symbol by dragging the handle on the detail boundary.

See also
Modify detail properties in drawings (page 169)
Modify drawing view properties (page 167)
View properties in drawings (page 692)
Define a start number or letter for detail view label and mark (page 152)

Define a start number or letter for detail view label and mark
Before creating the detail view label and detail mark define a start number or letter in the drawing properties.
1. Double-click an open drawing.
2. Click the check box toggle selection button at the bottom of the dialog box, and select only the check box next to the Detail view button.
3. Click Detail View.
4. Enter the start number or letter.
5. Click Modify.

See also
Create a detail view (page 150)

Create additional drawing views of parts
You can create additional views of a part within a single-part, cast unit or assembly drawing. You can select the part plane (front, top, back, bottom) to use or create a 3D view of the part.
1. Open a drawing.
2. On the Views tab, click View of part and select one of the following:
   • Front
   • Top
   • Back
   • Bottom
• **3D view**

Tekla Structures creates the view using the current properties in the **View Properties** dialog box. If a plane already has a view in the drawing, a new one is not created.

3. Double-click the frame of the new view to open the **View Properties** dialog box and modify the properties as required.

   For example, for 3D views, you may want to modify the view angle.

4. Click **Modify**.

**Example**

In the example below, the drawing originally contained only the front view. A 3D view and a top view were added. The angle of the 3D view was modified in the **View Properties** dialog box.

![Diagram showing front, top, and 3D views of a model]

**See also**

- Modify drawing view properties (page 167)
- View properties in drawings (page 692)

### Create a drawing view of an entire model view

You can create a drawing view of an entire model view and add it in a drawing.

1. Open a drawing.
2. Open the model view list: On the Views tab, click Model views --> Model view list, and leave the list open.

3. Set the drawing view properties: Hold down Shift, and on the Views tab, click Entire model view.

4. Modify the view properties, for example the view scale, and click OK or Apply

5. Open a model view from the model view list.

6. Click the open model view.

Tekla Structures creates the drawing view using the current properties in the View Properties dialog box. It calculates the boundaries of the view to fit the entire model view into the drawing view, and places the view in the drawing.

See also
Modify drawing view properties (page 167)
View properties in drawings (page 692)

Create a drawing view of a selected area in a model view
You can create a drawing view of a selected area in the model, and add it in a drawing.

1. Open a drawing.
2. Open a model view list: On the Views tab, click Model views --> Model view list, and leave the list open.

3. Set the drawing view properties: Hold down Shift and on the Views tab, click Area in model view.

4. Modify the drawing view properties as required, and click OK or Apply.

5. Open a model view from the model view list.

6. Pick two corners in the model to define the X and Y dimensions of the drawing view.
   The X and Y directions use the coordinate system of the model view. The view depth of the drawing view is the same as the depth of the model view.

Tekla Structures creates the drawing view using the current properties in the View Properties dialog box and places the view in the current drawing.

See also
Modify drawing view properties (page 167)
View properties in drawings (page 692)

Create a drawing view of a selected area in a drawing view
You can create a new drawing view of an area in an existing drawing view.

To create a new drawing view of an area in the existing drawing view:
1. Open a drawing.
2. Hold down Shift and on the Views tab, click Area in drawing.
3. You can modify the view label color.
   Other view properties are inherited from the original drawing view.
4. Click OK or Apply.
5. Select an area in the drawing view to be added in the new view.
6. Select a location for the new view.
   A symbol representing the view that you are about to place follows the mouse pointer, so it is easier for you to see where to place the view.

Tekla Structures creates the drawing view using the view properties of the original view.

See also
Drawing views in open drawings (page 145)
Modify drawing view properties (page 167)
Add single-part views in assembly drawings

In addition to automatically including single-part views in assembly drawings through drawing properties, you can also add single-part drawing views in an open assembly drawing.

1. Open the assembly drawing.

2. In the drawing view, select the parts of which you want to create a single-part view.

3. Right-click and select **Create single-part views**.

Tekla Structures adds the single-part views to the assembly drawing using the current properties in the **Assembly Drawing Properties** dialog box ( **Drawing properties** --> **Assembly drawing** --> **Layout** --> **Other** --> **Single-part attributes**).

See also

XS_NO_END_VIEWS_TO_INCLUDED_SINGLE_DRAWINGS
Include single-part drawings in assembly drawings (page 469)

Create a drawing view for a reinforcement mesh (RebarMeshViewCreator)

You can create drawing views each containing one reinforcement mesh using the RebarMeshViewCreator macro. The mesh view contains the overall mesh length and width dimensions, and dimension lines for wire spacing in horizontal and vertical directions. Also the wire sizes are displayed. You can create mesh views in general arrangement and cast unit drawings.

1. Open a drawing containing meshes.

2. Select the meshes.

   If you want to create views for all meshes in the drawing, you do not need to select separately.

3. Click the **Applications & components** button in the side pane to open the **Applications & components** catalog.

4. Click the arrow next to **Applications** to open the applications list.

5. Double-click RebarMeshViewCreator.
6. You have the following options for creating mesh views:
   • If you want to create a mesh view for each separate mesh in the current drawing, select **Create mesh view for all meshes in the drawing**.
   • If you want to create a view for the selected meshes only, select **Create view for selected meshes**. Here you must select the meshes before running the macro.
   • If you have already created the mesh views and just want to add dimension lines and diameters in the views, select **Create annotations for selected meshes**. Here you must select the meshes before running the macro.

7. Select the view, dimension, text, line, and unbent wire line property files that you want to use in the new the mesh view.

8. Select the wire annotation type in **Text content type**.
   The choices are 12 #8 and 12 #8 L=2.50m.

9. Select the wire length unit in **Unit of length in text**.
   When you select **Auto**, with imperial units the text will be using the current units, and otherwise the text will use m.
10. Click **Create**.

Tekla Structures creates or updates the views based on your selections and the property files.

**Example**

Below is an example of a mesh view.

The drawing below contains a 3D view of a wall with two bent meshes, and a separate unbent mesh view of both of the meshes.
Copy drawing views from other drawings
You can copy drawing views from other drawings in the current drawing as such or using the original layout.

1. Open a drawing where you want to add drawing views.
2. Open the **Drawing List** by pressing **Ctrl + O**.
3. Select the drawing containing the view you want to copy.
   You can select several drawings.
4. On the **Views** tab, click **From other drawing** and then click one of the following commands:
   - **Copy**: Copy the views from the selected drawings as such in the open drawing. Tekla Structures does not copy the drawing layout.
   - **Copy with layout**: Copy the views and layout from the selected drawings in the open drawing.
NOTE  Copied drawing views do not update when the original views change.

See also
View properties in drawings (page 692)

Move drawing views to another drawing
You can move section and detail views to another drawing through the drawing list. When you move views to another drawing, the source drawing and the target drawing will contain references to each other.

TIP  General arrangement drawings are often full of information. You may want to create empty general arrangement drawings and move detail or section views from the original general arrangement drawings to the empty drawing.

1. In an open drawing, select the frame of the drawing view you want to move.
2. Right-click and select Move to drawing from the pop-up menu.
3. Select the target drawing from the Drawing List.
   You can select additional drawing views after you have started the Move to drawing command and move multiple drawing views in one go. If you have multiple drawing views selected before starting the Move to drawing command, the command will not be available.
4. Click Move in the Move view to drawing dialog box.
5. Close and save the source drawing.
   Tekla Structures moves the selected view to the target drawing and creates references between the source and target drawings.
6. Open the target drawing from the Drawing List.
   The Drawing List indicates that the drawing has been updated.
7. Arrange the drawing views, if necessary.
8. Save the target drawing.

Example
In this example, we have two drawings on the Drawing List: BEAM1 and BEAM2.

<table>
<thead>
<tr>
<th>Date</th>
<th>Date</th>
<th>Width</th>
<th>Height</th>
<th>Angle</th>
<th>Section</th>
<th>Drawing List</th>
</tr>
</thead>
<tbody>
<tr>
<td>02.10.2009</td>
<td>06.10.2009</td>
<td>564</td>
<td>410</td>
<td>A</td>
<td>[AB.5]</td>
<td>BEAM1</td>
</tr>
</tbody>
</table>
We move section view C-C from drawing BEAM1 to BEAM2. Below is the original section view in the source drawing BEAM1.

We move this view to drawing BEAM2 according to the instructions above. Below is the moved section view in the target drawing BEAM2. The view label name contains the name of the source drawing BEAM1.

In the source drawing BEAM1, the section mark of the moved section view contains a reference to the target drawing BEAM2.
**TIP** You can use the following advanced options to set the reference text for section view labels:

- XS_SECTION_VIEW_REFERENCE
- XS_SECTION_SYMBOL_REFERENCE
- XS_DETAIL_VIEW_REFERENCE
- XS_DETAIL_SYMBOL_REFERENCE

---

**See also**

- Define automatic free or fixed placement for drawing views (page 460)
- Arrange drawing views (page 166)
- Drawing views in open drawings (page 145)

### Link drawing views from other drawings

You can link drawing views from other drawings as such or using the original layout. Linked drawing views update when the original views change.

1. Open a drawing where you want to link drawing views.
2. Open the **Drawing List** by pressing **Ctrl + O**.
3. Select the drawing containing the drawing view you want to link.
   - You can select several drawings.
4. On the **Views** tab, click **From other drawing** and click one of the following commands:
   - **Link**: Display the views of the selected drawings in the open drawing. Tekla Structures does not copy the drawing layout.
   - **Link with layout**: Display the views and the layout of the selected drawings in the open drawing.

**See also**

- View properties in drawings (page 692)

### Resize the drawing view boundary

The view boundary or view restriction box is the dashed frame around the contents of a drawing view, which becomes visible when you click the view frame. You can resize the view boundary, for example, to show just a specific part of the view contents.

When you select a view, the view boundary is highlighted also in other views. When you change the selected view’s boundary in the other views using view...
boundary handles, the change can be seen in the view boundary of the selected view. This way you can easily adjust the section view plane and view depth, and you do not need to go to the view properties dialog box to do this.

1. Click the view frame.
2. Click one of the handles on the view boundary.
3. Drag the handles along the x or y axis of the view.

When the view boundary changes size, the view frame adjusts with the new boundary size.

1. View boundary handle
2. View boundary
3. View frame
Resized view boundary and view

Example
In the example below, the section view in the bottom-left corner has been selected, and the view boundary is highlighted in two other views. You can change the view boundary of the selected view in the other views by dragging the view boundary handles, to change the section view depth, for example.

See also
XS_VISUALIZE_VIEW_IN_ANOTHER_VIEWS
XS_VISUALIZE_VIEW_IN_FATHER_VIEW_ONLY

Move drawing views by dragging
You can move drawing views by dragging.
1. Click the view frame.
2. Hold down the left mouse button and drag the view to a new location. The view follows the cursor while you drag the view, which makes it easier to follow the view movement.

**NOTE**  When you drag a view, its placing setting may change to **fixed** depending on what is set for the advanced option `XS_CHANGE_DRAGGED_VIEWS_TO_FIXED`. This advanced option is by default set to **TRUE**, which means that the placing setting changes to **fixed** when the view is dragged.

**See also**

`XS_CHANGE_DRAGGED_VIEWS_TO_FIXED`

**Align drawing views**

You can align views vertically or horizontally.

1. Select a drawing view in an open drawing, then right-click to display the pop-up menu.
2. Select **Align vertically** from the pop-up menu.
3. Pick a point in the selected view.
4. Pick a point in the view with which you want to align the selected view.
Tekla Structures moves the views so that the picked points line up vertically.

**Rotate drawing views**
You can rotate the views in drawings.
1. Click the frame of the view you want to rotate.
2. On the **Views** tab, click **Rotate view**.
3. Enter the angle in degrees, for example, 90 or \(-90\), in the displayed dialog box and click **Rotate**.

**Arrange drawing views**
You can fit the drawing views so that they include all connected objects, and rearrange the drawing views using the current properties in the **Layout Properties** dialog box.

- On the **Views** tab, click **Arrange views**.

**NOTE** *Arrange views* only affects views where the **Place** is set to **Free** in the view properties. **Fixed** views are not moved.
• If you have set XS_CHANGE_DRAGGED_VIEWS_TO_FIXED to TRUE (default) and drag a view in a drawing, the view becomes fixed, and the Arrange views command does not work
• Arrange views may change the drawing size if you have used automatic scaling of drawing views.

Modify drawing view properties
You can modify view properties in the final drawing view by view or in selected views.
1. Do one of the following:
   • If you want to modify the properties in several views, hold down Ctrl, click the view frames of the views you want to modify, and on the Drawing tab, click Properties --> View.
   • To modify the properties of one view, double-click the view frame.
2. Modify the view properties as required.
   For example, change the view Scale.
3. Click Modify.
4. If there are some object level settings that you want to apply, click the Edit settings button and load the object settings that you want to use. Click Modify.

See also
View properties in drawings (page 692)
Move drawing views by dragging (page 164)
Modify view-level drawing properties (page 28)

Modify section properties in drawings
You can modify section mark, section view label and section view cutting line properties in an open drawing.
1. Double-click the section mark.
2. On the **Cutting line** tab, set the section mark line length and offset (distance between the mark and the section).

3. On the **Section mark** tab, click the ... button next to A1 - A5 to open the **Mark Contents** dialog box and select the elements to be included in the section mark.

4. If needed, select an element from the list, click **Add frame** and select the frame **Type** and **Color**. You can set these individually for each element.

5. If needed, select an element from the list and select the text **Color**, **Font** and **Height**. You can set these individually for each element.

6. On the **Position** tab of the **Mark Contents** dialog box, set the side to show the text, the text position, the horizontal and vertical offset, and the text rotation. Text positioning depends on whether you use a symbol or not.

7. Click **Modify**.

8. In the **Symbol** area, define the section mark symbols. You can select from a list of predefined arrow symbols or use your own custom symbol. The symbol properties can be given separately for both the left and the right section mark symbols. Also set the color, size and position of section mark symbols.

9. On the **View label** tab, click the ... button next to A1 - A5 to open the **Mark Contents** dialog box, and select the elements to be included in the section view label.

10. Modify the element appearance and mark position as described above.

11. Click **Modify**.

12. Select the view label **Symbol** to be used in the label. You can also set the color, size, and the line length of the section view label line and symbol.

13. Set the label position and whether you want to center it according to the view frame or view boundary (view restriction box)

14. Click **Modify**.
Modify detail properties in drawings

You can modify the properties of detail marks, detail view labels and detail mark boundaries in an open drawing.

1. Double-click a detail mark to display the Detail Symbol Properties dialog box.
2. Modify the detail name in the Detail name box.
3. On the View Label tab, click the ... button next to A1 - A5 to open the Mark Contents dialog box, and select the elements to be included in the detail view label.
4. If needed, select an element from the list, click Add frame and select the frame Type and Color. You can set these individually for each element.
5. If needed, select an element from the list and select the text Color, Font and Height. You can set these individually for each element.
6. On the Position tab of the Mark Contents dialog box, set the text position, horizontal and vertical offset, and the text alignment. Text positioning depends on whether you use a symbol or not.
7. Click Modify.
8. Select the view label Symbol to be used in the label. You can also set the color, size, and the line length of the view label line and symbol.
9. Select the Vertical (Above or Below) and Horizontal (Center by view frame or Center by view restriction box) position of the view label.
10. Go to the Detail boundary tab and define the shape of the boundary and the color and type of the bounding line.
    Use the advanced option XS_DETAIL_BOUNDARY_RADIUS for setting a fixed size for the detail boundary.
11. On to the Detail mark tab, click the ... button next to A1 - A5 to open the Mark Contents dialog box and select the elements to be included in the detail mark.
12. Modify the element appearance and mark position as described above.
13. Click Modify.
14. Select the detail mark Symbol to be used in the mark. You can also change the color and size of the symbol.
15. Click modify in the **Detail Symbol Properties** dialog box.

**See also**

View, section view and detail view label mark elements (page 748)

### 4.4 Dimensions in open drawings

In addition to the automatically created dimensions defined in the drawing properties of the created drawings, Tekla Structures contains several tools for modifying dimensions and for adding new dimensions in an open drawing.

**Add manual dimensions**

You can add manual dimensions to drawings:

- Add manual dimensions (page 171)
- Example: Manual dimensions (page 173)
- Add manual dimensions using User Coordinate System (page 177)
- Add dual dimensions manually (page 183)
- Recreate dimensions for all parts (page 184)
- Add manual dimensions to general arrangement drawings (page 177)
- Add dimensions to reinforcement (page 185)
- Dimension center of gravity (COG) (page 198)
- Add closing dimensions (page 207)
- Add or remove dimension points (page 208)

**Modify dimensions**

You can modify dimensions manually:

- Modify dimension properties (page 203)
- Add tags to dimensions (page 179)
- Example: How to filter out dimension tag content (page 181)
- Drag dimension marks (page 212)
- Move the end of the dimension line (page 213)
- Exaggerate selected dimensions in drawings (ExaggerateSelectedDimensions) (page 202)
- Add dimension points in anchor bolt plans (page 204)
- Show plate side marks on dimension leader lines (page 204)
- Change the location of short outside dimension texts (page 205)
- Set a new dimension start point (page 206)
Link perpendicular dimension lines (page 208)
Combine dimension lines (page 209)
Drag dimension marks (page 212)
Move the end of the dimension line (page 213)

See also
Dimension and dimensioning properties (page 699)
Dimension properties - Marks and Tags tabs (page 706)
Automatic dimension settings (page 498)

Add manual dimensions
In addition to automatic dimensions, you can add dimensions manually in an open drawing. Manual dimensions are not recommended to be used in 3D views.

1. Hold down Shift and, on the Dimensioning tab, click one of the dimensioning buttons depending on the type of dimension you want to create:

   **Add horizontal dimension**: Create a dimension in the x direction by picking the points to be dimensioned. X depends on the current UCS.

   **Add vertical dimension**: Create a dimension in the y direction by picking the points to be dimensioned. Y depends on the current UCS.

   **Add perpendicular dimension**: Create a dimension perpendicular to a line you define by picking two points to set the direction of the dimension line, and then picking the points to be dimensioned.

   **Add orthogonal dimension**: Create a dimension in either the x or y direction by picking the points to be dimensioned. Tekla Structures uses the direction of the larger overall distance. X and y depend on the current UCS.

   **Add curved dimension with orthogonal reference lines**: Create curved dimension with orthogonal reference lines by picking three points to define the arc and then picking the points to be dimensioned. The dimension text on the line can be either a distance or an angle value.
Add curved dimension with radial reference lines: Create curved dimension with radial reference lines by picking three points to define the arc and then picking the points to be dimensioned. The dimension text on the line can be either a distance or an angle value.

Add free dimension: Create a dimension parallel to a line between any two points you pick.

Add COG dimensions: Indicate the location of the center of gravity (COG) in single-part, assembly, and cast unit drawings by creating COG dimensions and adding a COG symbol at the center of gravity. You can also create COG dimensions in section views.

Add parallel dimension: Create a dimension parallel to a line you define by first picking two points to define the direction of the dimension line and then picking the points to be dimensioned.

Add radial dimension: Create radial dimension by picking three points to define the arc and pick a position for the dimension.

Add angular dimension: Create angular dimension by picking the vertex point and two points to define the angle. Pick the side to place the dimension.

2. Modify the dimension properties in the properties dialog box.

3. Add the desired elements in dimension marks and modify their properties.

4. Add dimension tags with the desired elements as required, and set the dimension tag rotation.
   You can also include part count to dimension tags and select a filter that removes the desired default content from the tag.
   The available dimension mark and dimension tag mark elements are the same as those for the part, bolt, reinforcement and surface treatment marks.

5. Click OK or Apply.

6. Add the dimensions by following the instructions on the status bar.
   It is very important to use correct snap switches to get the dimensions correct. You can change the switch temporarily by right-clicking and selecting the switch that suits the best for your purpose.
   In dimension types where you click the middle mouse button to place the dimension line, the placement setting affects the result. If you have set
**Placing** to **fixed**, the position you click will be the location of the dimension line. If you have set **Placing** to **free**, the middle mouse button click defines which side of the object the dimension line is located on, and Tekla Structures places the dimension line.

7. Drag the dimensions to the desired locations.

   When you drag the dimensions, the **Placing** setting changes to **fixed** by default.

   You can also drag the dimension mark, and when you drag it, a leader line is automatically created.

**See also**

- Object protection and placement settings in drawings (page 453)
- Modify dimension properties (page 203)
- Dimension and dimensioning properties (page 699)
- Change the prefix in radial dimensions (page 576)
- Add tags to dimensions (page 179)
- Mark elements (page 737)

**Example: Manual dimensions**

Here are some examples of added manual dimensions (page 171).

<table>
<thead>
<tr>
<th>Command</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Add parallel dimension" /></td>
<td><img src="image" alt="Example" /></td>
</tr>
<tr>
<td>1 Shows the edge points picked for defining the direction for the parallel dimension line.</td>
<td></td>
</tr>
<tr>
<td>2 Shows the dimension points picked.</td>
<td></td>
</tr>
<tr>
<td>Command</td>
<td>Example</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Same part as before, now dimensioned with <strong>Add</strong> perpendicular dimension</td>
<td><img src="image1" alt="Diagram of perpendicular dimension" /></td>
</tr>
<tr>
<td>1 Shows the edge points picked for defining the direction for the perpendicular dimension line.</td>
<td><img src="image1" alt="Diagram of perpendicular dimension" /></td>
</tr>
<tr>
<td>2 Shows the dimension points picked.</td>
<td><img src="image1" alt="Diagram of perpendicular dimension" /></td>
</tr>
<tr>
<td><strong>Add curved dimension with orthogonal reference lines</strong></td>
<td><img src="image2" alt="Diagram of curved dimension" /></td>
</tr>
<tr>
<td>The dimension text on the line is a distance value.</td>
<td><img src="image2" alt="Diagram of curved dimension" /></td>
</tr>
<tr>
<td>Command</td>
<td>Example</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td>If the ends of a curved beam or polybeam have been cut or fitted, the points at the ends of the beam do not necessarily lie on the true curve of the beam. This is because curved beams are created with straight segments. The points are indicated with 2. To avoid creating incorrect curved dimensions, pick the three points defining the arc using three of the points indicated with 1. Use end point snap.</td>
<td></td>
</tr>
</tbody>
</table>

**Add curved dimension with radial reference lines**

**Curved** set to **Distance**.
The dimension text on the line is a distance value.

---

**Edit drawings 175 Dimensions in open drawings**
<table>
<thead>
<tr>
<th>Command</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add curved dimension with radial reference lines</td>
<td><img src="image1.png" alt="Diagram" /></td>
</tr>
<tr>
<td><strong>Curved</strong> set to <strong>Angle</strong>. The dimension text on the line is an angle value.</td>
<td><img src="image2.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>

| Add angular dimension                                                  | ![Diagram](image3.png) |
| **Angle** set to **Degrees at angle vertex**                           | ![Diagram](image4.png) |

| Add angular dimension                                                  | ![Diagram](image5.png) |
| **Angle** set to **Degrees on side**                                   | ![Diagram](image6.png) |

<p>| Add angular dimension                                                  | <img src="image7.png" alt="Diagram" /> |
| <strong>Angle</strong> set to <strong>Triangle</strong>. <strong>Triangle base length</strong> set to <strong>100</strong>   | <img src="image8.png" alt="Diagram" /> |</p>
<table>
<thead>
<tr>
<th>Command</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add radial dimension</td>
<td><img src="image1.png" alt="Image" /></td>
</tr>
</tbody>
</table>

**Add manual dimensions to general arrangement drawings**
You can dimension parts to grids along their X, Y, or X and Y axis and along grid lines in general arrangement drawing plan views.

**Limitation:** Parts like beams that are not located along the grids are not dimensioned.

1. Open a general arrangement drawing.
2. To check and change the dimension properties, on the **Drawing** tab, click **Properties --> Dimension**, make the necessary changes and click **Apply** or **OK**.
3. On the **Dimensioning** tab, click **GA dimensions** and the click one of the following commands:
   - To dimension along grid lines, click **Along grid lines** and pick the view in the location where you want to create the dimensions.
   - To dimension along part X or Y axis or both, select the part, and click **Along part X axis**, **Along part Y axis** or **Along part X and Y axis**. The parts are dimensioned to the two nearest grids.

   Tekla Structures creates the dimensions according to the dimension properties you defined in the **Dimension Properties** dialog box.

For instructions on how to dimension reinforcement in GA drawings, see **Add dimensions to reinforcement (page 185)**.

**See also**
- **Modify dimension properties (page 203)**
Add manual dimensions using User Coordinate System
You can pick UCS (user coordinate system) points to define the current coordinate system in the drawing view. If you do this, the dimensioning commands **Horizontal dimension** and **Vertical dimension** and **Orthogonal dimension** follow the defined coordinate system.

1. Open a drawing.
2. On the **Views** tab, click **User coordsys --> Set origin by two points**.
3. Pick the UCS origin and the UCS X direction.

![Diagram of a drawing with UCS points marked]

4. Click **Dimensioning --> Horizontal dimension**.
5. Pick the start and end point for the dimension.

![Diagram with dimension line added]

6. Point to the location where you want to add the dimension line and click the middle mouse button.
NOTE When you use the **Orthogonal dimension** command, it automatically finds out whether the dimension line is in the X or Y direction depending on which one is the closest.

See also
- User coordinate system (UCS) (page 367)
- Add manual dimensions (page 171)

Add tags to dimensions
You can add dimension tags with the desired elements to single and combined dimensions in an open drawing. In addition to elements, you can include part count, or select a filter that removes the desired default content from the tag.

Limitations:
- Rotation is not available for the middle dimension tags.
- The dimension tags are automatically updated according to model changes, when you update the drawing. If you want to disable the automatic update, you can freeze the drawing or set the advanced option `XS_INTELLIGENT_DRAWING_ALLOWED` to `FALSE`. This advanced option affects all drawings.

To add tags to dimensions:
1. Double-click the dimension.
2. Go to the **Tags** tab and select the locations where you want to add dimension tags.
You can add dimension tags above and below the dimension line to the left and right end of the line, to the dimension line ends, and in the middle of the dimension line below the line.

3. Click the ... buttons to go to the Tag Mark Properties dialog box. You can also enter text directly in the A - G boxes.

4. Select the tag rotation. Each tag has an independent rotation setting, so you can rotate some tags and leave others unrotated.
   - Parallel to dimension line does not rotate the tag. This is the default value.
   - Perpendicular to dimension line rotates the tag.

5. Include the elements that you want in the dimension tag.
   The available elements are the same as those of the part, bolt, reinforcement and surface treatment marks.

6. Select the element frame type and color and the text color, font, and height.

7. Click OK.

8. If you want to show the part count in the tag, set Include part count in the tag to Yes.

9. Use Exclude parts according to filter and select a predefined filter to remove some of the automatically created tag content.
   In addition to the user-selectable elements, some of the dimension tag content is automatically created based on the dimension end point locations. If you want to exclude unnecessary tag content for parts that are located in the same location as the dimensioning point, create suitable drawing view filter.

10. If you are adding tags to curved dimensions, you can select the tag type in Curved dimension tag type.

11. Click Modify.

Example
Below is an example of dimension tags:
Below is an example of an unrotated and a rotated dimension tag:

See also

Example: How to filter out dimension tag content (page 181)
Dimension properties - Marks and Tags tabs (page 706)

**Example: How to filter out dimension tag content**

In this example, you will remove from a dimension tag some content that is added in the tag automatically based on the dimension end point locations. First you will create a drawing view filter that you will use for removing the content.

The example below shows a tag that automatically contains the text "CORBEL". You will remove this text.
To create the filter and remove the desired content:
1. Open a drawing.
2. Double-click the view frame to open the View Properties dialog box.
3. Click Filter.
4. Click Add row and create a filter according to the example below so that you select Template as the category, and MATERIAL_TYPE as the property, and enter CONCRETE as the value.
5. Enter concrete as the name of the filter in the box next to the Save as button and click the button to save the filter.
6. In the drawing, double-click the dimension that contains the content that you want to remove.
7. In the Dimension Properties dialog box, go to the Tags page.
8. In **Exclude parts according to filter**, select the **concrete filter**.

9. Click **Modify**.

Tekla Structures removes the text "CORBEL" from the dimension tag. The material type of corbel is concrete, and the **concrete filter** removes all concrete parts from the tag.

---

**Add dual dimensions manually**

In dual dimensions, you can show dimensions in different units and format above and below the dimension line.

You can add **dual dimension automatically** (page 570), or manually in an existing drawing.

To add dual dimensions manually:

1. On the **File menu**, click **Settings --> Options**, go to the **Drawing dimensions** settings.

2. Set the unit, formats and precision, and activate the dual dimensions for the drawing types you want in **Dimensions in tags**.

3. Click **OK**.

4. Double-click a dimension in your drawing.

5. Go to the **Tags** tab, and enter the text **DIMENSION** in the middle dimension tag.
6. Click Modify.
7. If you do not want to show dual dimensions in all dimensions, you can manually delete the text **DIMENSION** from the tag.

**Example**

Below is an example of dual dimensions that use the unit mm and format ###.

See also

- Modify dimension properties (page 203)
- Dimension properties - Marks and Tags tabs (page 706)

**Recreate dimensions for all parts**

You can recreate the dimensions that were originally created for the parts in the drawing.

1. In an open drawing, check that you have set **Dimension creation method in this view** to **Automatically** in the drawing view properties.

   Tekla Structures dimensions parts only in views where this setting is set to **Automatically**.
2. On the **Dimensioning** tab, click **Recreate all dimensions**.  
Tekla Structures re-dimensions all views except linked, 3D and key plan views, and removes all manually created dimensions.

Add manual dimensions (page 171)  
View properties in drawings (page 692)

**See also**  
Add manual dimensions (page 171)  
View properties in drawings (page 692)

**Add dimensions to reinforcement**

You can manually add dimension lines and dimension marks to reinforcing bar groups. When adding dimensions, start by using predefined dimension settings defined for your environment, and modify these settings for individual dimensions, if necessary. There are reinforcement dimension settings affecting the whole model in the **Options** dialog box. You can also add dimensions to reinforcing bar groups using the **Rebar group dimensioning** application.

**Add dimension marks or dimension tags to rebar groups**

Each reinforcing bar group may have a dimension mark or a tagged dimension mark. These dimensions are created based on predefined dimension properties that you have selected in **File --> Settings --> Options --> Drawing dimensions**. The commands are available in GA drawings and cast unit drawings. You may want to add reinforcement dimension marks or tagged dimension marks especially in concrete cast unit drawings, where there is only one reinforced cast unit visible.

To add dimension marks or tagged dimension marks to rebar groups:

1. To select the desired predefined settings, go to **File --> Settings --> Options --> Drawing dimensions**, and load the desired predefined dimension properties files in **Dimension mark settings** and **Tagged dimension mark settings**.

   You can also select the representation for tapered skewed and curved reinforcement group dimensions, and add a dimension line extension to dimension lines that have arrows. For more information, see section "Predefined reinforcement dimension settings in the **Options** dialog box" below.

2. In an open drawing, right-click the reinforcing bar group and select one of the following dimension mark commands and pick a location for the dimension:
Add mark --> Dimension mark

You can change the representation of the current rebar dimension after creating it by double-clicking the rebar dimension in an open drawing, and modifying the dimension content (page 700), appearance (page 705), and marks and tags (page 706) as required. For example, you may want to add more tags, change dimension mark content, or select how to align tags in curved dimensions.

Add mark --> Tagged dimension mark

Add dimension lines to rebar groups

The Create dimension line command shows the distribution of the rebars in the group, and draws dashed lines from the dimension lines to the rebars when you drag the dimension outside the rebar group. This command is available in GA drawings and cast unit drawings, but you may want to use it especially in GA reinforcement drawings, because they may contain a lot of parts with rebar groups, and you often need to show only one rebar from the group and drag the dimension line to a proper place to see everything clearly. This command creates dimensions based on the predefined dimension

Edit drawings 186 Dimensions in open drawings
properties that you have selected in **File --> Settings --> Options --> Drawing dimensions**.

To add dimension lines showing the distribution of the reinforcing bars to rebar groups:

1. To select the desired predefined settings, go to **File --> Settings --> Options --> Drawing dimensions**, and load the desired predefined dimension properties file in **Dimension line settings**.

   You can also select the representation for tapered skewed and curved reinforcement group dimensions, and add a dimension line extension to dimension lines that have arrows. For more information, see section "Predefined reinforcement dimension settings in the Options dialog box" below.

2. Right-click a reinforcing bar group and click **Create dimension line**.

   Tekla Structures creates the dimension line.

3. You can drag the reinforcement dimension line out of the reinforcement bar group.

   When you do this, Tekla Structures draws a dashed line from the reinforcing bar to the dimension line. If the new location is in the reinforcement area, the dimension mark follows the intersection of the reinforcement bar and reinforcement dimension line.

   To change the representation of the current rebar dimension, double-click the rebar dimension in an open drawing, and modify the dimension content (page 700), appearance (page 705), and marks and tags (page 706) as required.

Below is an example of a dimension line created with **Create dimension line**:

![Dimension line example](image)

Below is an example of the dimension line when it has been dragged outside the reinforcing bar group:
Below is an example, where only one rebar of the group is visible, and the dimension line has been dragged outside the group.

**Predefined reinforcement dimension settings in the Options dialog box**

There are predefined settings in the Options dialog box in the Drawing dimensions settings affecting rebar dimensions and dimension marks. Settings are model specific and only affect the current model. Changing the settings does not require Tekla Structures restart.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add mark to reinforcement</td>
<td>dimension_mark</td>
</tr>
<tr>
<td>Dimension Mark settings</td>
<td>tagged_dimension_mark</td>
</tr>
<tr>
<td>Tagged Dimension Mark settings</td>
<td>standard</td>
</tr>
<tr>
<td>Dimension line settings</td>
<td></td>
</tr>
<tr>
<td>Dimension line extension length</td>
<td>0&quot;</td>
</tr>
<tr>
<td>Tapered skewed reinforcement group</td>
<td></td>
</tr>
<tr>
<td>Tapered curved reinforcement group</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Dimension mark settings</td>
<td>Select which predefined dimension settings you always want to apply to dimension marks. These settings are used when you create dimension marks with the <strong>Add mark</strong> command.</td>
</tr>
<tr>
<td>Tagged dimension mark settings</td>
<td>Select which predefined dimension settings you always want to apply to tagged dimension marks. These settings are used when you create dimension marks with the <strong>Add mark</strong> command.</td>
</tr>
<tr>
<td>Dimension line settings</td>
<td>Select which predefined dimension settings you always want to apply to dimension lines that you create with the <strong>Create dimension line</strong> command.</td>
</tr>
<tr>
<td>Dimension line extension length for line arrow</td>
<td>You can create line extensions (page 573) in dimensions that have line arrows. Enter the length of the dimension line extension in the <strong>Dimension line extension length for line arrow</strong> box. This setting will be applied to all dimension that have line arrows.</td>
</tr>
<tr>
<td>Tapered skewed reinforcement group</td>
<td>Select whether skewed dimensions have skewed or horizontal representation in <strong>Tapered skewed reinforcement group</strong>.</td>
</tr>
<tr>
<td>Tapered curved reinforcement group</td>
<td>Select whether curved dimensions have curved or horizontal representation in <strong>Tapered curved reinforcement group</strong>.</td>
</tr>
</tbody>
</table>
**Examples of rebar dimensions**

- Below is a tapered skewed part, and skewed dimension representation is selected from **Tapered skewed reinforcement group**. The dimension line follows the shape of the edge that is closest to where you pick.

- Below is a tapered curved part, and curved dimension representation is selected from **Tapered curved reinforcement group**.
• Below is an example of curved orthogonal dimensions of a tapered curved rebar group with a dimension tag:

• You can also add middle tags in rebar dimensions. Here dual dimensions (page 183) have been applied:
Curved dimension tags can be aligned by selecting one of the options in the **Curved dimension tag type** list in the **Dimension properties** dialog box:

```
123 (123)
123
|123
123 (|123)
-123-
123
```

In the example below, only one rebar is visible, and rebar tags are aligned vertically:

```
123
```

Edit drawings 192 Dimensions in open drawings
In the example below, the dimension tag follows the dimension curve.
• Below is an example of curved orthogonal dimensions of a radial reinforcing bar group.

*Add dimensions to rebar groups (Rebar group dimensioning)*

You can add dimensions to reinforcing bar groups by using the *Rebar group dimensioning* application.

1. Select the reinforcing bar groups.

2. Click the *Applications & components* button in the side pane to open the *Applications & components* catalog.

3. Click the arrow next to *Applications* to open the applications list.

4. Double-click *Rebar group dimensioning*.

5. Select the *Annotation type*. 
The first option is meant for cases where two or more groups are not overlapping. The second and third options are meant for cases where the groups are overlapping. The third option is otherwise similar to the second one, except that the dimension text is in 90 degrees angle in relation to the actual dimension line.

6. In **Prefix for spacing value**, enter the letters or text to be placed before the spacing value.

7. In the **Settings for distribution line**, select the properties file that you want to use for the distribution line.
   
   You can control these properties by opening and modifying the properties file in the **Dimension Properties** dialog box.

8. In **Settings for note text**, select the properties file that you want to use for the annotation text part other than the position text.
   
   You can control these properties by opening and modifying the properties file in the **Text Properties** dialog box.
9. In **Show position in text**, select whether you want to show or hide the position text.

![Position Text Example](image)

10. In **Settings for position text**, select the properties file that you want to use for the position text in the annotation.

![Position Text Example](image)

11. If you set **Close dimension line to part ends** to **Default**, the first annotation type is closed, and the other types are not. You can change this default behavior by selecting **Yes** or **No**.

12. Go to the **Advanced settings** tab to control the relative locations and placing of various elements of the annotation.

13. In **First line spacing**, enter a millimeter value to indicate the space between the dimension line and the first line of dimension text.

![First Line Spacing Example](image)

14. In **Next line spacing**, enter a millimeter value to indicate the space between several lines of dimension text.

![Next Line Spacing Example](image)
15. Select **Free text below text** and enter a millimeter value to indicate the space between the last line of dimension text and the next dimension line.

16. Select **Dimension line spacing** and enter a millimeter value to indicate the space between two or more dimension lines.

17. In **Tolerance for group width**, enter a decimal value to override the default tolerance value of 50 mm.

   The idea is to have a common dimension line and multiple texts whenever the reinforcing bar groups have equal widths, which means that the difference in width is smaller than the tolerance.

18. Click **OK**.
19. Click the location on the reinforcing bar group where you want to place the dimensions.

Example

![Diagram showing reinforcing bar dimensions]

See also
Dimension and dimensioning properties (page 699)
Reinforcement and neighbor reinforcement mark elements (page 742)
Add manual dimensions (page 171)

Dimension center of gravity (COG)
You can indicate the location of the center of gravity (COG) in single-part, assembly, and cast unit drawings by creating COG dimensions and a COG symbol at the center of gravity. You can also create COG dimensions in section views. COG dimensions will be automatically updated if the single part, assembly, or cast unit changes. The COG dimensions can also be cloned.

Limitations:
• If you copy or link a drawing containing COG dimensions to another drawing, such as a multidrawing, the COG dimensions will not be copied.
• You cannot create COG dimensions in general arrangement drawings or multidrawings.

1. On the Dimensioning tab in an open drawing, click Add COG dimensions.

2. Modify the options as required:
• In Create, select **Symbol** to see only the COG symbol, or **Dimensions** to see only COG dimensions. To see both, select **Both**.

• In **Dimensioning**, select to create **Horizontal** or **Vertical** dimensions, or **Both**.

• In **Dimension attributes**, you can load predefined dimension properties.

The appearance settings (size, color, etc.) of the COG dimensions are read from the dimension properties file you load in **Dimension attributes**. To create and save dimension property files, on the **Drawing** tab, click **Properties --> Dimension**. For example, you may
create a special COG dimension properties file to change the color or arrow type, and load the saved properties in Dimension attributes.

- In Symbol options, you can change the Symbol file in use and the symbol you want to use for COG, and load predefined symbol properties.

You can access the symbol options only if you have selected Both or Symbol for Create. The appearance settings (height, color, etc.) of the symbol are read from the symbol properties file you load in Symbol attributes.

To create and save symbol property files, on the Drawing tab, click Properties --> Symbol. For example, you may create a special COG symbol properties file to change the color and height of the symbol, and load the saved properties in Symbol attributes.

3. Click OK.
4. Pick the first point to specify the origin of the dimensions.
The origin is the point from which you want to measure the location of the center of gravity. This point must be located within the view frame.

5. Pick the second point to place the dimensions. This point may fall outside the view frame.

The example below shows the created dimensions.
6. When the dimension is selected, handles are shown at the dimension origin and the dimension location. You can drag these handles to adjust the origin or the location, or move them using the standard editing commands.

Exaggerate selected dimensions in drawings (ExaggerateSelectedDimensions)
You can exaggerate narrow dimensions to make them easier to read. When exaggerated, a dimension that is narrower than the limit defined in the Options dialog box is enlarged using the defined scale. If there are many exaggerated dimensions, Tekla Structures arranges them automatically.

1. Go to On the File menu, click Settings --&gt; Options and go to the Drawing dimensions page.
2. Set the Exaggeration limit and Exaggeration scale.
   Exaggeration scaling defines whether you are using Paper or Model as the exaggeration scaling method. If you select Paper, the exaggeration limit is multiplied by the view scale. If you select Model, and the scale is 1:10, all the dimensions smaller than 10 mm are exaggerated regardless of the drawing scale.
3. Click OK to save the settings and close the Options dialog box.
4. In an open drawing, click the dimension that you want to exaggerate.
5. Click the Applications & components button in the side pane to open the Applications & components catalog.
6. Click the arrow next to Applications to open the applications list.
Modify dimension properties
You can modify the properties of the dimensions in an open drawing.

1. Double-click a dimension.

2. Switch all the check boxes off in the dialog box by clicking the on/off switch at the bottom of the dialog box, and select only the check boxes next to the properties that you want to modify.

3. On the General tab, modify the dimension type, format, and placing settings.
   For example, here you can set the dimension to be free or fixed. Free lets Tekla Structures to decide the location and direction of the dimension. Fixed allows you to place the dimension at any point.

4. On the Appearance tab, modify the text, line and arrow settings.

5. On the Marks tab, modify the dimension mark contents and exaggeration settings.
   Here you can also select whether you want to show plate side marks.

6. On the Marks tab, click the ... button next to Prefix or Posfix to add elements in the dimension mark and modify element appearance.

7. On the Tags tab, add dimension tags as required, and set the dimension tag rotation.
   Here you can also select to include part count to dimension tags and select a filter that removes the desired default content from the tag. You can also select the curved dimension tag type to control how the tags are aligned to the dimension.

8. Click Modify.

See also
Dimension properties - General tab (page 700)
Add dimension points in anchor bolt plans

You can add dimension points to dimensions inside the enlarged views in an open anchor bolt plan.

Limitations: You cannot create new dimension lines that have dimension points inside both the enlarged views and the plan view.

To add dimension points to the dimensions inside the enlarged views:

1. Select the enlarged view frame.
2. Select the dimension to modify.
3. Right-click and select Add dimension point.

See also
Create anchor bolt plans using saved settings (page 83)
Example: Dimension anchor bolt plans (page 596)

Show plate side marks on dimension leader lines

You can show plate side marks on dimension leader lines. The plate side marks indicate whether the dimension point is to the face or center of the part, for example, a plate, web, or flange.

1. Open a drawing.
3. In the Dimension Properties dialog box, go to the Marks tab, set Type under Plate side marks to Specified to manually control the symbol and insert plate side mark symbols in the drawing.

   The option Automatic is available only in intelligent drawings, that is when the advanced option XS_INTELLIGENT_DRAWING_ALLOWED is set to TRUE.

4. Modify the other properties of the plate side marks as required:
   • Select the left and right plate side mark.
   • Set the mark size.
• Adjust the mark color.
• Set an offset for the mark from the dimension line.

5. Click Modify.

See also
XS_DIMENSION_PLATE_SIDE_MARK_SYMBOL_LEFT
XS_DIMENSION_PLATE_SIDE_MARK_SYMBOL_CENTER
XS_DIMENSION_PLATE_SIDE_MARK_SYMBOL_RIGHT
Modify dimension properties (page 203)
XS_INTELLIGENT_DRAWING_ALLOWED
Dimension properties - Marks and Tags tabs (page 706)

Change the location of short outside dimension texts
If you have selected to place texts of short dimensions outside the dimensions by setting Short dimensions to Outside on the General tab of the Dimension Properties, you can select on which side of the extension line the dimension text is placed.

Limitations:
• You can flip only start or end dimensions in a dimension set.
• You can place the dimension text outside the dimensions if there is enough space for the dimension text.

1. On the Dimensioning tab, click Flip outside dimension.
2. Click the dimension whose location you want to change.
Set a new dimension start point
You can select a new start point for running dimensions (dimensions that start from a common start point).

1. Select an existing dimension in a drawing.
2. On the **Dimensioning** tab, click **Set start point**.
3. Select the new start point.
   Tekla Structures automatically updates the dimensions.

**Example**
You can use this command to swap the running dimensions start point to the opposite end of the member.
When you use the US absolute dimension type, Tekla Structures draws a new RD symbol (Running Dimension) at the new zero point and updates the dimensions according to the new start point.

See also
Modify dimension properties (page 203)

Add closing dimensions
In a drawing containing a reinforcing bar group, you can manually add closing dimensions to the edge of the part.
1. Open a cast unit drawing.
2. Select the reinforcing bar group dimension line.
3. On the Dimensioning tab, click Add point.
4. Select the points where you want to add the closing dimensions.

Tekla Structures creates the closing dimensions.
Add or remove dimension points
You can add new dimension points to, or remove existing dimension points from the selected dimension set. You can only add points to one dimension line at a time.

1. Select the dimension line.
2. On the Dimensioning tab, click Add point.
3. Click a position on the part where you want to add the dimension point. You can add several points.
4. To remove a point, on the Dimensioning tab, click Remove point and click the point you want to remove. You can remove several points in a row.

**TIP** A quick way to add and remove dimension points is to first click a positions on the parts where you want to add the dimension points and, if some of them seem unnecessary, remove those by holding down Shift and then clicking the points you want to remove.

See also
Modify dimension properties (page 203)
Add closing dimensions (page 207)

Link perpendicular dimension lines
You can connect two perpendicular dimension lines. Connecting dimension lines makes your drawings clearer and easier to read. For example, you might...
want to link dimension lines of embedded objects in a cast unit, floor beams in a floor plan, or anchor bolts in an anchor bolt plan.

1. In an open drawing, hold down Ctrl and select two perpendicular dimension lines to connect.
2. On the Dimensioning tab, click Link dimensions.
3. If you want to unlink the dimension lines you linked, select the linked dimension line and click Unlink dimensions.

Example
Below is an example of linked dimension lines.

See also
Modify dimension properties (page 203)

Combine dimension lines
You can manually combine a group of two or more parallel dimension lines into one line.
1. Hold down Ctrl and click the dimension lines you want to combine.
2. On the Dimensioning tab, click Combine lines.
   You can also right-click and select Combine Dimension Lines.
Set the dimension extension line length

You can adjust the length of the dimension extension lines in dimension properties in an open drawing. You can also adjust the extension line length using advanced options.

You can load the dimension properties file where you have the correct setting when you add automatic dimensions on view level.

1. Open a drawing and double-click a dimension.
2. Go to the **General** tab of the **Dimensions** dialog box.
3. Select an option from the **Short extension line** list:
<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image1.png" alt="Diagram 1" /></td>
</tr>
<tr>
<td>No</td>
<td>Use this option to create extension lines all of the same length:</td>
</tr>
<tr>
<td></td>
<td><img src="image2.png" alt="Diagram 2" /></td>
</tr>
<tr>
<td>Yes</td>
<td>Use this option to use the short extension line automatically if a dimension line falls on a grid line. Elsewhere the extension line will be as usual.</td>
</tr>
<tr>
<td></td>
<td><img src="image3.png" alt="Diagram 3" /></td>
</tr>
<tr>
<td>On grid lines only</td>
<td></td>
</tr>
</tbody>
</table>

4. Save your setting in a properties file for later use.
5. Click **Modify**.
6. To adjust the extension line lengths, go to **File menu --> Settings --> Advanced options --> Dimensioning: General** and set the following
advanced options. These advanced options adjust the extension line length in relation to the text size:

1. Text height * 1.0 (default). Use `XS_DIMENSION_EXTENSION_LINE_AWAY_FACTOR` to adjust the length of the dimension extension lines that are facing away from the dimension points.
2. Text height * 1.5 (default). Use `XS_DIMENSION_EXTENSION_LINE_TOWARD_FACTOR` to adjust the length of the dimension extension lines that are facing towards the dimension points.

See also
Dimension properties - General tab (page 700)

Drag dimension marks
Dimension marks can be freely dragged to avoid overlapping dimensions and marks.

Note that you can only drag relative dimensions, not absolute dimensions.

Go to File --> Settings and ensure that Smart select is selected.

1. Select the dimension line.
   
   If you do not select the dimension line first, dragging will move the whole dimension, not just the dimension mark.

   When you select the line, the dimension mark handle becomes visible.
2. Point the handle, press down the left mouse button, and drag the dimension mark to the desired location. Tekla Structures automatically adds a leader line to the dimension mark that is dragged from its original position.

Note that if you do not want to draw a leader line when a dimension text is dragged away from the dimension line, set the advanced option XS_LEADER_LINE_TO_DRAGGED_DIMENSION_TEXT to FALSE in the category Dimensioning: General in the Advanced options dialog box. The default value is TRUE.

See also
Drag, reshape and resize drawing objects (page 254)
Modify dimension properties (page 203)
Move the end of the dimension line
You can move the end of the dimension line orthogonal to itself outside the part. The dimension tags are moved together with the end of the line. This is useful when the tags would otherwise cover part geometry or other objects, such as dimensions or marks.

Limitations: You can move the end of the dimension line in all straight dimensions, except elevation dimensions.

1. In an open drawing, click the dimension.
   The dimension line handle becomes visible.
2. Select the handle and drag the end of the line to the desired position.
   It is easier to select the handle when your hold down Alt and then click the handle.

   If the dimension contains dimension tags, the tags are visible while you drag.

4.5 Drawing marks, notes, texts and links in open drawings
You can add many kinds of annotation objects in your drawings, such as marks, associative notes, texts, and links. Some of these are associative and some independent.

Associative objects update according to the changes made in a model object in the model. Dimensions, marks, and notes are associative.

In addition to the automatic marks and dimensions that you already may have in a drawing, you can add the ones listed below and modify their properties:

Add part marks manually in drawings (page 215)
Add manual weld marks in drawings (page 322)
Add level marks in drawings (page 217)
Add associative notes in drawings (page 219)
Add manual dimensions (page 171)
Add manual dimensions to general arrangement drawings (page 177)
Modify associative annotation object (note, mark) properties (page 220)
Update part and weld marks in drawings (page 223)
Change symbols in drawings (page 225)
Merge marks (page 229)
Drag the mark and associative note leader line base point (page 232)
Customize leader line arrows (page 352)
You can also delete marks for parts and reinforcement (page 224).
Independent annotation objects are not linked or connected to the Tekla Structures model in any way. Texts, DWG/DXF files, symbols, revision marks, links and hyperlinks are all independent annotation objects.
Independent objects will also become associative if you snap to a building object when you create them, because then they will get associativity points. For example, in texts, the content does not change when the model changes but the associativity point may change. Another example is a line: if you snap to a part edge when you create a line, the line will get an associativity point and move with the part if the part changes.
You can only add texts, DWG/DXF files, links, hyperlinks, revision marks and symbols in an open drawing, and modify the properties of the added ones:
Add text in drawings (page 233)
Add links to rich text files in drawings (page 235)
Add links to other drawings (page 238)
Add hyperlinks in drawings (page 237)
Add links to DWG and DXF files in drawings (page 241)
Add revision marks in drawings (page 239)
Modify the properties of independent annotation objects (page 243)

See also
Drawing objects (page 21)
Dimensions in open drawings (page 170)
Add symbols in drawings (page 351)
Customize leader line arrows (page 352)

Add part marks manually in drawings
In an open drawing, you can add part marks for all building objects, surface treatment and connections, or for the selected ones only. For each view, Tekla Structures creates the marks according to the mark properties in the view mark properties dialog box.
TIP  Use orthogonal snapping in marks and associative notes with leader lines. For example, you can use it for placing your marks and notes in a more consistent way in exact locations. When you start dragging a mark or note from a leader line end handle, and you have orthogonal snapping on, the leader line end handle locks to the closes orthogonal point in the drawing (0, 45, 90, 135, 180 degrees). To activate orthogonal snapping, press O.

To add part marks, do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add part marks for all parts</td>
<td>On the Drawing tab, click Part mark --&gt; For all parts.</td>
</tr>
<tr>
<td></td>
<td>If you have deleted marks manually from the drawing, this command will not create the marks, and you will have to create them manually part by part.</td>
</tr>
<tr>
<td>Add part marks for selected parts</td>
<td>1. Select the parts.</td>
</tr>
<tr>
<td></td>
<td>2. On the Drawing tab, click Part mark --&gt; For selected parts.</td>
</tr>
<tr>
<td></td>
<td>3. If the part mark does not contain any elements in the drawing view properties, the Part Mark Properties dialog box is displayed, and you can select the elements to be included in the part mark. Add elements and click Modify.</td>
</tr>
</tbody>
</table>

See also
Modify associative annotation object (note, mark) properties (page 220)
Mark elements (page 737)
Mark properties (page 726)
Modify associative annotation object (note, mark) properties (page 220)

Add reinforcement marks manually in drawings
You can add marks manually to reinforcing bars and meshes in drawings.

The reinforcement marks may already be created in the drawing if you have selected to create reinforcement marks in automatic reinforcement mark
properties (page 602) when you created the drawing. If they are not shown, you can add them manually
1. Open a drawing that contains reinforcement.
2. To adjust the reinforcement mark properties, such as color and mark elements included, on the Drawing tab, click Properties --> Reinforcement mark.
3. Click Apply or OK in the properties dialog box.
4. Right-click the reinforcement and select Add mark --> Reinforcement mark.
   The reinforcement mark is created.

See also
Reinforcement and neighbor reinforcement mark elements (page 742)
Reinforcement and neighbor reinforcement mesh mark elements (page 744)

Add level marks in drawings
A level mark represents the elevation of a point. In addition to the automatic elevation dimensions that you can define in the drawing properties before creating the drawing, and the elevation information in the grid labels added in the model, you can also add manual level marks in your drawing to ensure that the dimensions are correct.
1. Open the drawing.
2. Hold down Shift and, on the Drawing tab, click Level mark.
3. In the Level Mark Properties dialog box, modify the content and the appearance of the level mark.
4. Click Apply or OK to save the properties.
5. Pick a start point for the leader line and a position for the mark.

1. Elevation dimension in the grid label
2. Elevation dimension created with Add Level Mark in the drawing

NOTE Shortening value added in the user-defined properties of a part also affects level marks.
See also
Level mark properties (page 736)
Mark properties - General, Merging and Content tabs (page 726)

Add section marks in drawings
You can add section marks in an open drawing.
1. Open a drawing.
2. On the **Drawing** tab, hold down **Shift** and click **Section mark**.
3. In the **Section symbol properties** dialog box, set the cutting line properties and select a color for the line.
4. On the **Section mark** tab, set the contents and the appearance of the section mark.
5. Click **OK** or **Apply**.
6. Pick the first and the second point on the cut plane.
   Create as many section marks as you need.
7. Press **Esc** to interrupt.

See also
Modify section properties in drawings (page 167)

Add detail marks
You can mark details in the drawing with detail marks.
1. In an open drawing, on the **Drawing** tab, hold down **Shift** and click **Detail mark**.
2. In the **Detail symbol properties** dialog box, enter the name for the detail, and modify the detail boundary and detail mark properties, as desired.
   The shape of the detail boundary you select affects the way you select the area for your detail.
3. Click **OK** or **Apply**.
4. Depending on the selected detail boundary shape, do one of the following:
   • If the shape is **Circle**, pick the center point of the circle and then pick a point on the circle.
   • If the shape is **Rectangle**, pick corner points for the rectangle.
5. Pick a position for the label.
6. Press **Esc** to interrupt.

**See also**

Modify detail properties in drawings (page 169)

---

**Add associative notes in drawings**

Associative notes are extra marks that contain additional information about the object they are attached to. Associative notes are updated according to the changes made in the related object in the model. You can add associative notes to building objects, such as parts and reinforcement, surface treatments, edge chamfers, reference objects, pour breaks and pour objects. Associative notes are handy: You can add multiple notes to one object, whereas you only can add one mark to one object.

1. Open the drawing.

2. Hold down **Shift** and, on the **Drawing** tab, click **Note** and click one of the following commands:
   - **With leader line**: Add an associative note with a leader line at the position you specify.
   - **Without leader line**: Create an associative note without a leader line at the position you specify.
   - **Along line**: Add an associative note along a line at the position you specify.

3. Select what kind of an object you want to attach the note to in the **Content** list.

4. Select the elements you want to show in the note, and modify the appearance of the note.
   
   The elements for associative notes are same as those of marks. 
   
   Associative note appearance properties are the same those of parts. Additionally, you can adjust the leader line arrow height and length.
   
   To place the note exactly in the position you pick and keep it there, click the **Place** button and select **fixed** in the **Placing** list.

5. Click **Apply** or **OK** to save the properties.

6. Select the object.

7. Pick a position for the note. If you are using a leader line, first pick the position on the object, and then pick the position for the note.
   
   Continue picking to add the same note in another location.
   
   You can stop adding notes by pressing **Esc**.
See below for some examples of leader lines. The one on the left is **With leader line**, the one in the middle **Without leader line** and the one on the right **Along line**.

![Example of leader lines]

**TIP** For edge chamfers and other hard-to-see items, it is easier to use the pop-up menu command **Add Associative Note** because then you do not have to select the object again after selecting the command from the pop-up.

---

**See also**
- Mark elements (page 737)
- Mark properties - General, Merging and Content tabs (page 726)
- Drawing marks, notes, texts and links in open drawings (page 214)

---

**Modify associative annotation object (note, mark) properties**

You can modify the properties of the associative annotation objects in an open drawing. By associative annotation objects we mean associative notes and all kinds of building object marks, for example, part marks or bolt marks.

1. Double-click a mark or a note.
2. Switch all the check boxes off in the dialog box by clicking the on/off switch at the bottom of the dialog box.
3. Select only the check boxes next to the properties that you want to modify.
4. Add missing elements in the mark on the **Content** tab and change the element properties.
5. Adjust the mark frame and leader line settings.
6. To exactly place the mark in the position you pick and keep it there, click the **Place** button and select **fixed** in the **Placing** list.
7. Leave the dialog box open, select all the marks that you want to change, and click **Modify** to apply the changes in all the selected marks.

**TIP** To modify the properties of the weld marks of welds that you added in the model, you need to modify the weld in the model. When you number the model,
the weld marks are updated in the drawings. In drawings, you can only modify the visibility settings of model welds.

**Adjust mark visibility in an existing drawing**

In addition to defining the mark visibility settings in drawing properties before creating a drawing, you can also modify the mark visibility settings in an open drawing separately for the views that you have in the drawing.

To modify mark visibility in an existing drawing:

1. Open a drawing.
2. Double-click the drawing background to open the drawing properties dialog box.
3. Do one of the following depending on the drawing type. Note that all settings are not available for all mark types.

<table>
<thead>
<tr>
<th>Drawing type</th>
<th>Adjust mark visibility settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single-part, assembly and cast unit drawings:</td>
<td>1. Click <strong>View creation</strong>, select the view and the properties that you want to change, and click <strong>View properties</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. Click a mark type in the options tree. For example, click <strong>Part mark</strong>.</td>
</tr>
<tr>
<td></td>
<td>3. Go to the <strong>General</strong> tab and select whether you want to display marks by selecting one of the <strong>Visibility in view</strong> options. The available options depend on the mark type:</td>
</tr>
<tr>
<td></td>
<td>• <strong>distributed</strong>: Distributes the marks in the view. Tekla Structures only creates marks that are not visible in the other views.</td>
</tr>
<tr>
<td></td>
<td>• <strong>always</strong>: Always creates marks in the view, irrespective the settings in other views.</td>
</tr>
<tr>
<td></td>
<td>• <strong>preferred</strong>: Acts as distributed, but the preferred view has a higher priority.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>preferred</strong> to one view only in a drawing. If you set other views to <strong>distributed</strong>, the marks are located only in the view that has the setting <strong>Visibility in view</strong> set to <strong>preferred</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>none</strong>: Does not create marks.</td>
</tr>
<tr>
<td></td>
<td>Note that if you want to create your own marks manually, always use the <strong>none</strong> option.</td>
</tr>
<tr>
<td></td>
<td>Selecting another option, for example <strong>always</strong>,</td>
</tr>
<tr>
<td>Drawing type</td>
<td>Adjust mark visibility settings</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td></td>
<td>might slow down the drawing update during opening, even if you had deleted the marks manually.</td>
</tr>
<tr>
<td></td>
<td>4. In <strong>Parts out of view plane</strong>, select whether you want to display marks for parts that are out of view plane:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Visible</strong>: Displays marks for parts outside the view in the drawing.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Not visible</strong>: Displays no marks for parts outside the view in the drawing.</td>
</tr>
<tr>
<td></td>
<td>5. For bolt marks, select if you want to show bolt marks in main parts, secondary parts, sub-assembly main parts, or in sub-assembly secondary parts.</td>
</tr>
<tr>
<td></td>
<td>For bolt marks, you can also define the <strong>Bolt size limit</strong>, which filters standard-sized bolt marks out of drawings. Tekla Structures will not display bolt marks of the size you enter here.</td>
</tr>
<tr>
<td></td>
<td>6. Click <strong>Save</strong> to save the changes in view properties, and then click <strong>Close</strong> to return to drawing properties.</td>
</tr>
<tr>
<td></td>
<td>7. Click <strong>Modify</strong>.</td>
</tr>
<tr>
<td><strong>General arrangement drawings:</strong></td>
<td>1. Click a mark type button in the drawing properties dialog box. For example, click <strong>Part mark</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. Go to the <strong>General</strong> tab and select whether you want to display marks by selecting one of the <strong>Visibility in view</strong> options. The available options depend on the mark type:</td>
</tr>
<tr>
<td></td>
<td>• <strong>distributed</strong>: Distributes the marks in the view. Tekla Structures only creates marks that are not visible in the other views.</td>
</tr>
<tr>
<td></td>
<td>• <strong>always</strong>: Always creates marks in the view, irrespective the settings in other views.</td>
</tr>
<tr>
<td></td>
<td>• <strong>preferred</strong>: Acts as distributed, but the preferred view has a higher priority.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>preferred</strong> to one view only in a drawing. If you set other views to <strong>distributed</strong>, the marks are located only in the view that has the setting <strong>Visibility in view</strong> set to <strong>preferred</strong>.</td>
</tr>
<tr>
<td>Drawing type</td>
<td>Adjust mark visibility settings</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td></td>
<td>• <strong>none</strong>: Does not create marks. Note that if you want to create your own marks, always use the <strong>none</strong> option. Selecting another option, for example <strong>always</strong>, might slow down the drawing update during opening, even if you had deleted the marks manually.</td>
</tr>
</tbody>
</table>

3. In **Parts out of view plane**, select whether you want to display marks for parts that are out of view plane:

   • **Visible**: Displays marks for parts outside the view in the drawing.
   • **Not visible**: Displays no marks for parts outside the view in the drawing.

4. For bolt marks, select if you want to show bolt marks in main parts, secondary parts, sub-assembly main parts, or in sub-assembly secondary parts.

   For bolt marks, you can also define the **Bolt size limit**, which filters standard-sized bolt marks out of drawings. Tekla Structures will not display bolt marks of the size you enter here.

5. Click **OK**.
6. Click **Modify**.

---

**Update part and weld marks in drawings**

You can update part marks and weld marks in an open drawing. Normally part marks and weld marks are up to date when you open the drawing. Updating is needed in frozen drawings.

To update marks in an open drawing, do any of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update all part marks</td>
<td>On the <strong>Drawing</strong> tab, click <strong>Update marks --&gt; All part marks</strong>.</td>
</tr>
<tr>
<td>Update selected part marks</td>
<td>1. Select the part marks you want to update.</td>
</tr>
<tr>
<td>To</td>
<td>Do this</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Update all weld marks</td>
<td>On the <strong>Drawing</strong> tab, click <strong>Update marks --&gt; All weld marks</strong>.</td>
</tr>
</tbody>
</table>

Tekla Structures updates the marks according to your selection.

**See also**

- Freeze general arrangement drawings (page 375)
- Freeze single-part, cast unit and assembly drawings (page 375)

**Delete marks for selected parts**

You can delete marks for parts that you select. This is useful when you do not want to see some marks, like neighbor part marks or neighbor reinforcement marks.

With the **Delete part mark** command you can delete all other mark types, except weld marks.

A handy way to use this command is to create a selection filter first, then use area selection to select the parts, and finally delete the marks.

1. In an open drawing, click **Selection filter** and create a selection filter that filters out parts that you do not want to select.
2. Click **Apply**.
3. Only activate the **Select parts in drawings** selection switch.
4. Select the parts using area select.
5. Right-click and select **Delete part mark**.

In the following example, you do not want to delete marks from cast units with a position number B/1. This means that when you use this filter, activate the
Select parts in drawings selection switch, and use area select the parts, all other parts get selected.

The image below shows the selected parts and the part marks that you want to delete.

Now you can delete the marks by using the Delete part mark command on the pop-up menu.
**Change symbols in drawings**

Tekla Structures highlights the marks and dimension marks that have changed due to changes in the model, and dimension points that have been moved.

Tekla Structures also highlights the changed angle dimensions, level marks, and associative notes.

Tekla Structures highlights the changes in the following way:

- A change symbol (by default, a cloud) is drawn around the old point, the new point and the dimension values, or around the changed mark or note.
- An arrow is drawn from the old dimension point to the new one.

There are some advanced options related to change symbols that you may want to use:

- `XS_HIGHLIGHT_ASSOCIATIVE_DIMENSION_CHANGES`
- `XS_HIGHLIGHT_MARK_CONTENT_CHANGES`
- `XS_ASSOCIATIVE_CHANGE_HIGHLIGHT_SYMBOL`
- `XS_ASSOCIATIVE_CHANGE_HIGHLIGHT_SIZE`

See also

*Remove change symbols (page 226)*

*Hide all change symbols in a drawing (RemoveChangeClouds) (page 227)*

**Remove change symbols**

After you have checked all the change symbols that Tekla Structures has created, you can remove all of them or just the selected ones.

To hide change symbols, do one of the following:
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove all dimension change symbols</td>
<td>On the Drawing tab, click Remove --&gt; All dimension change symbols.</td>
</tr>
</tbody>
</table>
| Remove the selected dimension change symbols | 1. Select the dimension change symbols you want to remove.  
2. On the Drawing tab, click Remove --> Selected dimension change symbol.                                                                                                               |
| Remove all mark change symbols         | On the Drawing tab, click Remove --> All mark change symbols.                                                                                                                                       |
| Remove the selected mark change symbols| 1. Select the mark change symbols you want to remove.  
2. On the Drawing tab, click Remove --> Selected mark change symbol.                                                                                                               |
| Remove all associative note change symbols | On the Drawing tab, click Remove --> All associative note change symbols.                                                                                                                        |
| Remove the selected associative note change symbols | 1. Select the associative note change symbols you want to remove.  
2. On the Drawing tab, click Remove --> Selected associative note change symbol.                                                                                                      |

See also

Change symbols in drawings (page 225)

*Hide all change symbols in a drawing (RemoveChangeClouds)*

You can hide all dimension change symbols, mark change symbols and associative note change symbols in one go in an open drawing using the RemoveChangeClouds macro.

1. Open a drawing.

2. Click the Applications & components button in the side pane to open the Applications & components catalog.

3. Click the arrow next to Applications to open the applications list.
4. **Double-click** `RemoveChangeClouds`.

Tekla Structures removes all change symbols.

**Example**

The first image shows an example of a mark change symbol after a material change, and of a dimension change symbol after a change in the size of the part.

The second image shows the dimension text and the mark after running the macro.
Merge marks
You can merge marks to reduce the number of marks in the drawing and to make the drawing clearer. A merged mark has a single leader line. You can merge marks automatically before creating a drawing, in drawing properties of and open drawing, and for some mark types also manually in the final drawing.

In a final drawing, you can merge weld marks (page 326) and reinforcement marks manually (page 232), and part marks, reinforcement marks and surface treatment marks by adjusting their drawing properties.

For more information about merging prerequisites and principles, see Merged part marks (page 616).

To activate merging through drawing properties:
1. Open a drawing.
2. Double-click the drawing background to open the drawing properties dialog box.
3. Do one of the following depending on the drawing type.

<table>
<thead>
<tr>
<th>Drawing type</th>
<th>Adjust mark visibility settings</th>
</tr>
</thead>
</table>
| **Single-part, assembly and cast unit drawings:** | 1. Click **View creation**, select the view and the properties that you want to change, and click **View properties**. The merging needs to be set view by view separately.  
2. Click a mark type in the options tree. For example, click **Part mark**.  
3. Go to the **General** tab.  
4. In **Merge marks**, select **Yes** to merge part marks, or surface treatment marks.  
5. To merge reinforcement marks, click **Reinforcement mark** in the options tree and go to the **Merging** tab.  
   **Identical marks in same cast unit:**  
   • **One leader line per row**: Merges the marks and creates one leader line for a row of reinforcing bars.  
   • **Parallel leader lines**: Merges the marks and creates parallel leader lines.  
   • **Leader lines to one point**: Merges the marks and draws all leader lines to one point.  
   • **No merge**: Marks are not merged, an individual leader line is created for each mark.  
   • If you select **No merge**, you still need to define the mark content for the marks that Tekla Structures automatically merges on the Merging tab.  
   **Preferred direction of merge:**  
   • If there are several possible merge directions, select **Merge horizontal** or **Merge vertical**.  
   **Available elements/Elements in mark:** |

Edit drawings 230 Drawing marks, notes, texts and links in open drawings
**Drawing type** | **Adjust mark visibility settings**
---|---
| • Select the contents to be included in the merged reinforcement marks. To ensure that merged reinforcement marks appear in the drawing, always include **Symbol separating blocks in mark** as the last element in the reinforcement mark. To omit the separating symbol, leave this box blank, but still include the element in the mark.

6. Click **Save** to save the changes in view properties, and then click **Close** to return to drawing properties.

7. Click **Modify**.

**General arrangement drawings:**

1. Click a mark type button in the drawing properties dialog box. For example, click **Part mark**.

2. Go to the **General** tab.

3. In **Merge marks**, select **Yes** to merge part marks, or surface treatment marks.

4. To merge reinforcement marks, click **Reinforcement mark** in the options tree and go to the **Merging** tab.

**Identical marks in same cast unit:**

- **One leader line per row:** Merges the marks and creates one leader line for a row of reinforcing bars.

- **Parallel leader lines:** Merges the marks and creates parallel leader lines.

- **Leader lines to one point:** Merges the marks and draws all leader lines to one point.

- **No merge:** Marks are not merged, an individual leader line is created for each mark.

- If you select **No merge**, you still need to define the mark content for the marks that Tekla Structures automatically merges on the **Merging** tab.

**Preferred direction of merge:**
Drawing type | Adjust mark visibility settings
--- | ---
• If there are several possible merge directions, select **Merge horizontal** or **Merge vertical**.

**Available elements/Elements in mark:**
• Select the contents to be included in the merged reinforcement marks.

To ensure that merged reinforcement marks appear in the drawing, always include **Symbol separating blocks in mark** as the last element in the reinforcement mark. To omit the separating symbol, leave this box blank, but still include the element in the mark.

5. Click **OK**.
6. Click **Modify**.

**See also**

*Merge marks automatically (page 615)*

**Merge reinforcement marks manually**

1. Open a drawing.
2. On the **Drawing** tab, click **Properties --> Merged reinforcement mark**.
3. Modify mark properties as required.
4. Select the marks to merge in the drawing.
5. Right-click and select **Merge marks** from the pop-up menu.
6. If needed, you can split the merged marks by selecting the marks to split, right-clicking and selecting **Split marks**.

**See also**

*Merge reinforcement marks automatically (page 619)*

**Drag the mark and associative note leader line base point**

You can move the leader line base point by dragging it.

Ensure that you have selected **Smart select** in **File menu --> Settings** to drag and drop by handles without selecting them first.

1. Click the leader line.
2. Hold down the left mouse button and drag the base point to a new location.
If the base point is originally on a line, you can drag it along that line. If the base point is originally inside a part, you can drag the base point inside that part.

Add text in drawings
You can add several lines of text in a drawing, and use word wrapping if you like. You can select the desired color, height, font, angle, frame type, and leader line arrow type, and align the text as required.

1. Open a drawing
2. On the Drawing tab, hold down Shift, click Text and select one of the following commands to create a single line or multiple lines of text:
   • Text: Add text without a leader line at the position you pick.
   • Text with leader line: Add text with a leader line at the position you pick.
   • Text along line: Add text along a line at the position you pick.
   • Along line, arrow at end point: Add text along a line at the position you pick. An arrow is inserted at the second position you pick.
   • Along line, arrow at start point: Add text along a line at the position you pick. An arrow is inserted at the first position you pick.
3. Enter the text in the Text box.
You can add a line break by pressing Enter.
4. Modify the text color, height, font, angle and alignment as required.
5. Select a frame type, leader line and color.
6. To wrap the word, set Word wrapping to On. You can define the line length using the Ruler width option.
   When the word wrapping is activated, the text object gets a handle, which you can drag to make the text wider or narrower.
7. Select the leader line arrow type and size.
8. To exactly place the text in the position you pick, and keep it there, click the **Place** button and select **fixed** in the **Placing** list.

9. Click **OK** or **Apply**.

10. Pick the point where you want to place the text. Depending on the command, you have to pick one to three times.

    Text is aligned to left by default. Line spacing is automatically adjusted by the font size you select.

    You can continue picking to add the same line of text in another location. You can also drag the base point of the text leader line freely after adding the text.

See below for examples of the different text options. From left: **Text; With leader line; Along line; Along line, arrow at end point;** and **Along line, arrow at start point**.

![Text examples](image)

The text object gets a handle when word wrapping is activated:
Add text in superscript

You can use superscript in texts in all your text objects, dimension marks, other marks and associative notes.

1. On the File menu, click Settings --> Advanced options and go to the Dimensioning: General category.

2. Ensure that the advanced option XS_SUPERSCRIPT_USED_IN_DRAWING_TEXTS is set to TRUE.

3. Open the properties dialog box of the text object, mark or associative note by holding down Shift and clicking the command.
   For example, on the Drawings tab, click Text --> With leader line.

4. Do one of the following:
   • For text objects, enter the desired text in the Text box.
   • For marks and associative notes, open the Mark Content - text dialog box by double-clicking Text in the Available elements list and enter the desired text in the Text box.

5. Enter circumflexes (^) around the characters that you want to have in superscript.

6. Click OK.

7. Add the text, mark or note.

Example

The following example shows how the superscript is entered in the Text box and what it looks like in the text.

See also
Add text in drawings (page 233)
Drawing marks, notes, texts and links in open drawings (page 214)
Dimensions in open drawings (page 170)

Add links to rich text files in drawings

You can insert text inside a frame in a drawing. First you create a .txt or .rtf file in WordPad, and then add a link to it in a Tekla Structures drawing. Tekla Structures adds the text using some basic formatting settings you can set in
the file itself, and some of the properties in the **Text File Properties** dialog box.

**NOTE** If you change the text in the text file, it will change in all drawings containing a link to the text file.

**Limitation:** The `.rtf` texts need to be created with WordPad.

1. Create the text file.
   
   You can add basic formatting to the file, such as bold, italics, underline, strikethrough, subscript, and superscript, use indent and tabs, and set a specific font. You can also add bulleted lists with hyphens and circular bullets, and numbered lists, and nest the lists. When you add the text link, Tekla Structures preserves the formatting settings.
   
   Note that the text links do not support hyperlinks or images. Tekla Structures colors will always be shown correctly. If you use in the `.rtf` file a color that is not supported in Tekla Structures, then the closest Tekla Structures color will be used.

2. Open the drawing where you want to add the text file.

3. On the **Drawing** tab, click **Rich text**.

4. Set the text height.

   Other text settings are taken from the text file.

5. Set the frame line type and color.

6. Select if you want to scale the text:

   - **Scale to fit**: You only need to pick the upper left corner of the frame when placing the text. Tekla Structures inserts the object in its original size. In this case, when you change the text frame size by dragging from the handles, the text does not wrap, and the font scales automatically.
   
   - **No scaling**: You only need to pick the upper left corner of the frame when placing the text. Tekla Structures adjusts the object size to fit the frame. The text wraps when you change the size of the frame by dragging the handles. The minimum width of the box is defined by the longest word.


8. Click **OK** or **Apply**.

9. Pick a location for the upper left corner of the text frame in the drawing. Tekla Structures adds the link to the text file.

10. You can edit the text and modify the text file properties:

---

**Edit drawings**  236  **Drawing marks, notes, texts and links in open drawings**
• To edit the text file, double-click the text inside the frame. Tekla Structures opens the original text file.

• To modify the text file properties, double-click the frame around the text. For .rtf files, you cannot modify the text color or font here, you need to change these in the .rtf file itself. For plain text files, you can also change the font color.

Examples

In the following example you can see that the text file may contain bulleted lists, numbered lists, colors, italics, and bold, and you can change the font of the desired text parts.

```
• TEXT TEXT TEXT
• TEXT TEXT TEXT TEXT TEXT TEXT TEXT TEXT
• TEXT TEXT TEXT TEXT TEXT TEXT TEXT TEXT
1. TEXT TEXT TEXT TEXT TEXT TEXT TEXT TEXT
2. TEXT TEXT TEXT TEXT TEXT TEXT TEXT TEXT
```

In the following example, the scaling type is **No scaling**. The text wraps when you change the size of the frame by dragging the handles, so that the text always fits the frame. The font size does not change.

```
• TEXT TEXT TEXT
• TEXT TEXT TEXT TEXT TEXT TEXT TEXT TEXT
• TEXT TEXT TEXT TEXT TEXT TEXT TEXT TEXT
1. TEXT TEXT TEXT
2. TEXT TEXT TEXT
```

In the following example, the scaling type is **Scale to fit**. If you change the text frame size by dragging from the handles, the text does not wrap, and the font size changes automatically so that the text fits the frame.

```
• TEXT TEXT TEXT TEXT TEXT TEXT TEXT TEXT
1. TEXT TEXT TEXT
2. TEXT TEXT TEXT
```
Add hyperlinks in drawings

You can add hyperlinks to Internet addresses (URLs) within a frame in a drawing.

1. Open a drawing where you want to add a hyperlink.
2. On the Drawing tab, click Link --> Hyperlink.
3. Modify the text color, height, font and effect.
4. Modify the frame line type and color.
5. Select if you want to scale the link.
   - If you select **No scaling**, you only need pick the upper left corner of the frame when you insert the link. Tekla Structures inserts the link in its original size. If you select **Scale to fit**, you need to pick two points to define the frame. Tekla Structures adjusts the link size to fit the frame.
6. In the **File or URL** text box, enter an Internet address or filename and path.
   - If you need to locate the file, click **Browse**. Tekla Structures inserts an active hyperlink to the location you specify.
7. If you want to display text for the hyperlink instead of the hyperlink, enter the text in the **Text** box.
8. Click **OK** or **Apply**.
9. Pick one or two points in the drawing to indicate the corners of the hyperlink frame.

Double-click the hyperlink text in the drawing to jump to the Internet address.

Example

In the example below, **Scale to fit** has been selected. The Internet address for the hyperlink is shown.

```
http://www.tekla.com/
```
Add links to other drawings
You can insert a link to another drawing in a frame in a drawing. Tekla Structures adds the link to the drawing using the properties in the Drawing Link Properties dialog box.

1. Open the drawing.
2. On the Drawing tab, click Link --> To another drawing.
3. Modify the text color, height, font and effect.
4. Modify the frame line type and color.
5. Select if you want to scale the link. If you select No scaling, Tekla Structures inserts the link in its original size.
   If you select Scale to fit, Tekla Structures adjusts the object size to fit the frame.
6. On the Drawing tab, click Drawing list, and select the drawing to link to.
   The drawings on the list are the drawings in the current model.
7. If you want to display text for the link instead of the drawing name, enter the text in the Text box.
8. Pick two points to define the frame and add the link.
9. Click OK or Apply.

You can open the linked drawing by double-clicking the link.

Example
In the example below, Scale to fit has been selected, and the link contains the name of the drawing.
Add revision marks in drawings
Revision marks are symbols that you can add in the drawing when you want to indicate a change in the Tekla Structures model or drawing, and the objects that have changed. Tekla Structures creates the revision mark using the properties in the Revision Mark Properties dialog box. If you create revisions through the Drawing List using the Revision command, Tekla Structures will not create any marks inside the drawing.

1. Open a drawing.
2. On the Drawing tab, click Revision mark and select one of the following commands:
   • Add revision mark
   • Pointing to left
   • Pointing to right
   • Along line, pointing to left
   • Along line, pointing to right
3. Enter the mark, date, and information on the changes.
   Tekla Structures shows this information in the revision table of the drawing.
4. To place the revision mark exactly in the position you pick and keep it there, click the Place button and select fixed in the Placing list.
5. Go to the Appearance tab and set the text color, height, font and angle, the frame color, leader line and type, and the leader line arrow type and size.
6. Click OK or Apply.
7. Pick a point or points to place the mark.
   Tekla Structures creates the revisions and revision marks. You can also see the new revisions on the Drawing List.
   To delete any unnecessary revision marks, select the marks and press Delete.

See below for examples of revision marks.
Add links to DWG and DXF files in drawings

You can insert a DWG or DXF file inside a frame in a drawing as a link. Tekla Structures adds the DWG or DXF file link using the properties in the **DWG/DXF Properties** dialog box. When you modify the original file, Tekla Structures also modifies all the linked instances in drawings.

Tekla Structures supports AutoCAD version 2010 and earlier in DWG/DXF links. The added dwg/dxf files also support AutoCAD control codes, such as %%u for underscore, or %%c for a circle diameter dimensioning symbol ø.

1. Open the drawing where you want to insert a link to a DWG/DXF file.
2. On the **Drawing** tab, click **DWG / DXF**.
3. Select the scaling options:
   - **Scaling type**:
     - **X**: When you use this setting, you need to pick the left upper corner of the frame to insert the file. You can only set the drawing scale in the X direction.
     - **XY**: When you use this setting, you need to pick the left upper corner of the frame to insert the file. You can set the drawing scale in both the X and Y direction.
     - **Scale to fit**: When you use this setting, you need to pick the left upper and bottom right corners of the frame to size and create the frame. Tekla Structures scales the file to fit the frame.
     - **Best fit**: When you use this setting, you need to pick the left upper and bottom right corners of the frame to size and create the frame.

---

See also

Leader line types (page 730)
Revise drawings (page 378)
Tekla Structures scales the file to fit, maintaining its original aspect ratio.

• **Scale in X:**
  - Scales the file in the X direction. Enter a coefficient to indicate the scale, for example, 1.0 for 100%, 1.5 for 150%, etc. The scaling type must be set to X or XY.

• **Scale in Y:**
  - Scales the file in the Y direction. Enter a coefficient to indicate the scale, for example, 1.0 for 100%, 1.5 for 150%, etc. The scaling type must be set to XY.

4. Select the link frame line type and color.
5. In **Name**, browse for the DWG or DXF file you want to use.
6. Pick one or two points in the drawing to place the frame.
7. Click **OK** or **Apply**.

Tekla Structures adds a link to the DWG or DXF file inside a frame in the drawing.

**Add links to image files in drawings**
You can insert images inside a frame in a drawing. Tekla Structures adds the image link using the properties in the **Image Properties** dialog box. When you modify the original file, Tekla Structures also modifies all the linked instances in drawings.

1. Open the drawing where you want to insert a link to an image.
2. On the **Drawings** tab, click **Image**.
3. Select the scaling options:
   - **Type:**
     - **XY:** When you use this setting, you need to pick the left upper corner of the frame to insert the image. You can set the scale in both the X and Y directions.
     - **Scale to fit:** When you use this setting, you need to pick the left upper and bottom right corners of the frame to size and create the frame. Tekla Structures scales the image to fit the frame.
     - **Best fit:** When you use this setting, you need to pick the left upper and bottom right corners of the frame to size and create the frame. Tekla Structures scales the image to fit, maintaining its original aspect ratio.
• **Scale in X:**
  • Scales the file in the X direction. Enter a coefficient to indicate the scale, for example, 1.0 for 100%, 1.5 for 150%, etc. The scaling type must be set to **XY**.

• **Scale in Y:**
  • Scales the file in the Y direction. Enter a coefficient to indicate the scale, for example, 1.0 for 100%, 1.5 for 150%, etc. The scaling type must be set to **XY**.

4. Select the link frame line type and color.
5. In **Name**, browse for the image file you want to use.
6. Pick the points in the drawing to place the frame.
7. Click **OK** or **Apply**.

Tekla Structures adds a link to the image file inside a frame in the drawing.

---

**Modify the properties of independent annotation objects**

You can modify the properties of texts, symbols, links, hyperlinks, links to DWG and DXF files, and revision marks in an open drawing.

1. Double-click the object in an open drawing.
2. Switch all the check boxes off in the dialog box by clicking the on/off switch at the bottom of the dialog box, and select only the check boxes next to the properties that you want to modify.
3. Modify the properties.
4. Click **Modify**.

---

**4.6 Hide objects in drawings and drawing views**

You can hide selected drawing objects in drawings and drawing views. When you hide a part, Tekla Structures will hide all its related objects. Note that if an object is hidden in drawing views it will not be printed.

1. Open a drawing.
2. Check that the ghost outline option is selected in **File menu --> Settings --> Ghost outline**.
3. Select the **Color** mode by pressing **B**.

Hidden objects are shown as ghost outlines in color drawings. In grayscale and black and white drawings, hidden objects are not shown even if **Ghost outline** is selected.
4. Select the objects you want to hide.

5. On the **Drawing** tab, click **Hide/show** and one of the following commands:
   - **Hide from view**: Tekla Structures hides the selected object in the view where the selected objects are located.
   - **Hide from drawing**: Tekla Structures hides the selected object in all drawing views.

6. When you want to show the hidden objects again, go to the **Drawing** tab and click **Hide/show** --> **Show in view** or **Hide/show** --> **Show in drawing**.

**Example**

Below are some examples of the results with different combinations of selections.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Color mode</strong> is set to <strong>Color</strong> in <strong>File menu</strong> --&gt; <strong>Settings</strong>. No objects are hidden. Part marks are shown.</td>
<td>![Example Image]</td>
</tr>
<tr>
<td>Setting</td>
<td>Example</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td><strong>Color mode</strong> is set to <strong>Color</strong> and <strong>Ghost outline</strong> is not selected in <strong>File menu</strong> --&gt; <strong>Settings</strong>. Parts are hidden and related part marks are not shown.</td>
<td><img src="image1.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>

**Color mode** is set to **Color** and **Ghost outline** is selected in **File menu** --> **Settings**. Hidden parts are shown as ghost outlines and related part marks are not shown. | ![Diagram](image2.png) |
Setting

<table>
<thead>
<tr>
<th>Color mode</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>is set to <strong>Black and white</strong> and <strong>Ghost outline</strong> is selected in <strong>File menu</strong> --&gt; <strong>Settings</strong>. The ghost outline it has no effect on black and white drawings. Parts are hidden and related part marks are not shown.</td>
<td></td>
</tr>
</tbody>
</table>

**List hidden parts in drawings**

You can select whether to list the hidden parts in drawings, for example, in the material list.

**Limitations**: Listing hidden objects does not work in all templates. It works in templates containing PART rows, but not in hierarchical templates. For example, if the template is of type ASSEMBLY - PART, and the Assembly is included in the drawing, all of its parts will also be included.

1. Open a drawing containing hidden parts.
2. Double-click the drawing to open the drawing properties dialog box.
3. Click **Layout**.
4. On the **Drawing size** tab, select whether you want to list the hidden parts in **List hidden objects in templates. No** removes all information about the hidden parts, also from the total weight.
5. Click **Modify**.
In the example below, the hidden reinforcing bars are listed.

**CAST UNIT BILL OF MATERIAL**

<table>
<thead>
<tr>
<th>Cast unit</th>
<th>Quantity</th>
<th>Main part material</th>
<th>Weight (kg)</th>
<th>Volume (m³)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CF/3</td>
<td>8</td>
<td>650.2</td>
<td>6076.6</td>
<td>2.87</td>
</tr>
<tr>
<td>FOOTING</td>
<td>1</td>
<td>650.2</td>
<td>6076.6</td>
<td>2.87</td>
</tr>
</tbody>
</table>

Reinforcement:

<table>
<thead>
<tr>
<th>Type</th>
<th>From</th>
<th>Quantity</th>
<th>Grade</th>
<th>Dam.</th>
<th>a</th>
<th>b</th>
<th>c</th>
<th>d</th>
<th>e</th>
<th>f</th>
<th>g</th>
<th>h</th>
<th>k</th>
<th>l</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>5</td>
<td>12</td>
<td>Undefined</td>
<td>12</td>
<td>3100</td>
<td>400</td>
<td>2950</td>
<td>600</td>
<td>00</td>
<td>20</td>
<td>20</td>
<td>10</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Reinforcement total weight (kg): 34.1

CAST UNIT TOTAL WEIGHT (kg): 6033.4

In the example below, the hidden reinforcing bars are not listed.

**CAST UNIT BILL OF MATERIAL**

<table>
<thead>
<tr>
<th>Cast unit</th>
<th>Quantity</th>
<th>Main part material</th>
<th>Weight (kg)</th>
<th>Volume (m³)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CF/3</td>
<td>8</td>
<td>650.2</td>
<td>6076.6</td>
<td>2.87</td>
</tr>
<tr>
<td>FOOTING</td>
<td>1</td>
<td>650.2</td>
<td>6076.6</td>
<td>2.87</td>
</tr>
</tbody>
</table>

CAST UNIT TOTAL WEIGHT (kg): 6076.6

See also

Hide objects in drawings and drawing views (page 243)

### 4.7 Arrange drawing objects

You can reposition drawing objects on the basis of the protection properties of the drawing and the placing properties of each drawing object type.

1. Open a drawing.
2. On the **Drawing** tab, click **Properties --> Drawing** and go to **Protection**.
3. Check the protection properties, modify them as required and click **Modify**.
4. Double-click objects in your drawing, such as marks and dimensions, and click **Place** to check and change the placing settings as require.
   
   If the object is set to **fixed**, the **Arrange objects** commands have no effect.
5. Click **OK** and **Modify**.
6. In the open drawing, select the drawing objects you want to arrange.
7. On the **Drawing** tab, click one of the following commands:
   
   - **Arrange objects --> Near current locations**.

   Tekla Structures positions the selected drawing objects so that they do not overlap other objects. Objects located in a free location are not
moved, and overlapping objects are moved as close to the current location as possible.

• **Arrange objects** --> **Ignore current locations**.
  Tekla Structures positions the selected drawing objects so that they do not overlap with other objects without checking the current location of the objects.

**See also**

Object protection and placement settings in drawings (page 453)

### 4.8 Align drawing objects

You can align objects (texts, marks, views and graphical objects) to the bottom, to the middle, to the left, to the center, to the right, and to the top. You can also position objects horizontally or vertically at equal distances from each other.

1. Open a drawing.
2. Select the objects that you want to align.
3. Select the aligning command. The following commands are available on the **Drawing** tab:

   - ![Align objects to the bottom](image)
   - **Align objects to the bottom**

   - ![Align objects to the top](image)
   - **Align objects to the top**

   - ![Align objects to the left](image)
   - **Align objects to the left**

   - ![Align objects to the right](image)
   - **Align objects to the right**

   - ![Align objects to the center](image)
   - **Align objects to the center**

   - ![Align objects to the middle](image)
   - **Align objects to the middle**
Position objects to the vertical center at equal distances

Position objects to the horizontal center at equal distances

4. Pick a location for the alignment.
   If you have mixed objects selected, you will be asked to select which objects you want to align.

5. If you selected one of the two commands that position objects to center at equal distances, type the distance in the displayed dialog box.

**TIP** To create a row of objects, align them first to the top and then position them horizontally at equal distances from each other. You do not need to reselect the objects between the two commands.

**Example**
Below is an example where marks have been aligned to left.

![Example Image]

4.9 **Snapping in drawings**
In drawings, you can snap in positions in the same way as in the model. You can also snap to orthogonal angles while placing drawing objects or sketching. Zoom level affects free snapping in the way that the closer you zoom, the more exact you can snap. You can also place a drawing sketch object at a specified distance in the indicated direction.
Drawing snap switches and snap settings

For a list of and for more information about drawing snap switches, see Snap switches and symbols.

For more information on snap settings, see Snap settings.

Snap to orthogonal points in a drawing
Use the Ortho tool to snap to the closest orthogonal point in a drawing. You can specify the orthogonal angle in the Drawing snap settings dialog box. Using ortho snapping is useful if you need to place associative notes in a consistent manner, or sketch a polygon using a certain angle, for example. You can use predefined ortho angles and specify custom angles.

1. To activate orthogonal snapping, on the File menu, click Settings and select the Ortho check box. By default, the keyboard shortcut is $O$.
2. Open a drawing and on the File menu, click Settings --> Snap settings. Note that you have the same snap settings available in the model, but these settings have no effect on drawings.
3. Set the snapping angles using one or both of the following ways:
   • Angle interval: Select the check box next to Angle interval and then select a predefined angle: 10, 15, 30, 45, 90.
   • Custom angles: Select the check box next to Custom angles and define the custom angles you want to snap to, for example, 12.5 or 17.5.
4. You can save different snap settings by entering a unique name in the Save as box and clicking Save as. The settings are saved in the \attributes folder under the model folder.
5. Click OK to save and apply the new settings.
In the example below, you first add a text with a leader line using a 60 degree angle to the part:

Then you will add a new text using the same angle:

Free snapping

Free snapping in drawings is based on the zooming level in drawings: The closer you zoom, the more exact you can sketch. For example, you can more easily create rectangles that are of exact length when you zoom closer. The snapping step changes from 1 to 1000 (1/16" - 5") depending on the zoom level. You can follow the dimensions while you sketch.
**Place a sketch object at a specified distance**

You can snap to a specified distance in the indicated direction and place a sketch object in that position. You can specify the distance coordinate in the **Enter a Numeric Location** dialog box. In the following, you will add a line.

1. On the **Drawing** tab, click **Draw line** to activate the line tool.

2. Hold down **Ctrl** and pick an origin.

3. Point to the direction where you want to place the start point of the line. Here, the bolt group needs to be moved 30 mm to the right and the line will indicate the new position for the group.

4. Start entering the distance, for example **30**.
   
   The **Enter a Numeric Location** dialog box is displayed.
5. When you have entered the distance, click **OK**. Tekla Structures indicates the start point of the line.

6. Pick an end point for the line.

7. To check that the distance is correct, create a dimension.
4.10 Drag, reshape and resize drawing objects

Many drawing objects, dimension lines and leader lines of many drawing objects have handles. You can use these handles to reshape, and resize objects. You can also drag the objects.

Before you start:

• Click a drawing object or an object frame to activate the object and show the handles.

• On the File menu, click Settings and select Smart select to drag by the object handles without selecting the handle first.

Do any of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drag the object</td>
<td>• Point the handle, object or object frame, hold down the left mouse button and drag the object to a new location.</td>
</tr>
<tr>
<td></td>
<td>The object follows the cursor while you drag the object, and you can</td>
</tr>
<tr>
<td>To</td>
<td>Do this</td>
</tr>
<tr>
<td>----</td>
<td>---------</td>
</tr>
<tr>
<td>all the time see what the end result will be. With circles, you can also use the middle handle for dragging.</td>
<td></td>
</tr>
</tbody>
</table>
| **Resize the object** | 1. Click one of the objects or object frame handles.  
2. Drag the handle to resize the object or object frame. To enlarge the rectangle in all directions, drag from a corner handle. |
<p>| <strong>Reshape the object</strong> | 1. Click the middle handle of a line or a handle on the cloud, polyline or polygon. |</p>
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>2. Drag the handle to reshape the object.</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE** If you drag a mark, note, text or dimension, its placing setting may be set to **fixed** depending what its set for the advanced options listed below. The mark, note, text or dimension stays where it is even though you update the drawing.

- XS_CHANGE_DRAGGED_DIMENSIONS_TO_FIXED
- XS_CHANGE_DRAGGED_MARKS_TO_FIXED
- XS_CHANGE_DRAGGED_NOTES_TO_FIXED
- XS_CHANGE_DRAGGED_TEXTS_TO_FIXED

**See also**

*Object protection and placement settings in drawings (page 453)*

### 4.11 Change the shape of leader lines

You can modify the shape of the leader line for objects that have leader lines.

1. Open a drawing and select the leader line you want to modify.
2. Drag from the middle point of the line.
3. Drag further from the created handle points and new middle points.
4.12 Indicate cut lines in Tekla Structures drawings
Cut lines are lines that are indicated with a zigzag or a dash-and-dot lines in different colors to show that the line is partially outside the view border.

To find out more, click the links below:
Create cut lines (page 257)
Update cut lines (page 258)
Delete cut lines (page 258)

**Create cut lines**
You can create cut lines to visualize the lines that are partially outside the view frame. You can create cut lines automatically for all parts in the view, or for selected parts.

**Limitations:**
- Cut lines cannot be created for polybeams.
- View extension for neighbor parts setting is not taken into account.

1. On the **Drawing** tab, click **Create cut lines**.
2. Do any of the following:
   - Select the type (zigzag or dash-and-dot) for the line from the list of types.
• Select the color for the line from the color list.
• Enter a scale for the line in the box next to the list of types.

3. Do one of the following:
• To create cut lines for all parts in the view, select the view.
• To create cut lines for selected parts, select the parts.

4. Click Create.

Example

![Diagram of cut lines]

See also
Indicate cut lines in Tekla Structures drawings (page 257)

Update cut lines

1. Open a drawing that contains cut lines.
2. On the Drawing tab, click Create cut lines.
3. Do one of the following:
   • To update the cut lines of all parts in the view, select the view.
   • To update the cut lines of selected parts, select the parts.
4. Click Create.

Tekla Structures removes all previously created cut lines, and creates new ones that are up-to-date.

See also
Indicate cut lines in Tekla Structures drawings (page 257)

Delete cut lines

1. On the Drawings tab, click Create cut lines.
2. Do one of the following:
• To delete the cut lines of all parts in the view, select the view.
• To delete the cut lines of selected parts, select the parts.

3. Click **Delete**.

**See also**

*Indicate cut lines in Tekla Structures drawings (page 257)*

### 4.13 Explode drawing plug-ins and use them as normal objects

You can explode drawing plug-ins into base objects, and then edit and use them as any other drawing objects. For example, if you want to modify COG dimension in a way that is not available for the plug-in, you can explode the COG dimension and then modify its properties in the **Dimension Properties** dialog box.

1. Click a drawing object that is made using a plug-in.
2. Right-click and select **Explode**.

Tekla Structures explodes the plug-in into base objects that are added to the view. Now you can edit and use the exploded objects as any other drawing objects through the properties dialog box.

### 4.14 Drawing sketching tools and sketch objects

*Sketch objects* are objects that you may add in a drawing to highlight information existing in the Tekla Structures model, or to indicate positions of openings, windows, doors, and such. In open Tekla Structures drawings, you can use the sketching tools to sketch clouds, lines, circles, rectangles, arcs, polylines, and polygons, for example. Use can use these tools to explode and combine sketch objects, cover-up outlines and part faces, and create fillets and chamfers. You can re-order sketch objects, and sketch objects and model objects. Using the sketching tools, you can also trim, extend, split and divide sketch objects, and copy objects using offset.

Sketch objects are associative if they have associativity points, i.e. they are associated to a building object.

Click the following links to find out more about sketching tools and sketch objects:

*Draw sketch objects in drawings (page 260)*

*Combine and explode sketch objects in drawings (page 263)*
Create and add pattern lines in drawings (page 266)
Re-order sketch objects in drawings (page 265)
Trim drawing lines (page 273)
Split sketch objects (page 275)
Divide sketch objects (page 275)
Create fillets in drawings (page 277)
Create chamfers in drawings (page 278)
Copy sketch objects with offset (page 276)
Hide part face areas and outlines with cover-up tools (page 280)

See also
Drawing objects (page 21)
Drawing sketch object properties (page 773)

Draw sketch objects in drawings
You can create lines, single continuous lines, pattern lines, polygons, polylines, rectangles, circles, arcs, clouds and cover-up rectangles, lines, polygons and polylines in an open drawing using sketching tools.

1. Hold down Shift, and on the Drawing tab, click one of the following commands to modify the object properties first:

   • **Line --> Draw line**: Sketch a single line between two points you pick.

   • **Line --> Draw single lines continuously**: Create multiple single lines at one go using the current line properties. Press Esc to interrupt. Tekla Structures creates a continuous line as separate line sections. You can combine (page 263) the sections into one by using the Combine command.

   Note that for the continuous single line tool, you cannot open the properties dialog box before creating the line by holding down Shift and clicking the command on the ribbon. You can change the properties of a continuous line through the properties of a normal single line.
• **Line --> Draw pattern line:** Sketch a line containing a pattern that you select using the current **Pattern line** properties.

   **Tip:** If you need a new pattern, use the **Pattern line editor** to create it (File --> Editors --> Pattern line editor).

• **Draw rectangle:** Sketch a rectangle between points you pick. You can create rectangles with horizontal and vertical sides.
  • You can change the size of the rectangle by dragging the handles.
  • You can **explode (page 263)** rectangles into single lines.
  • To rotate the rectangle, click **Move --> Rotate** on the **Drawing** tab.

• **Draw circle by center and radius:** Sketch a circle by picking the center point first and then a point on the circle that specifies the radius.

• **Draw circle by three points:** Sketch a circle that traverses the three points you pick, either clockwise or counter-clockwise.

• **Draw arc by end points and center:** Sketch an arc by specifying two end points first and then a center point. The center point specifies the center of the circle of which the arc is a part.

• **Draw arc by three points:** Sketch an arc that traverses the three points you pick, either clockwise or counter-clockwise.

• **Draw polyline:** Sketch a line with straight segments using the current polyline properties. Remember to set the **Bulge for all lines** factor if you are creating curved polylines.
  • While sketching a polyline, you can:
    • snap to temporary graphical points and set them as reference points by holding down Ctrl and clicking a point on the temporary line.
    • set multiple reference points using DWG objects and Tekla Structures building objects.
    • delete a reference point by holding down Ctrl and clicking the point.
    • create a polygon by clicking the start point of the polyline.
  • You can delete the selected corner point by right-clicking and selecting **Delete**.

Edit drawings 261 Drawing sketching tools and sketch objects
• You can add handles by dragging a handle point on the polyline. You can change the shape of the polyline by dragging the handles.

• You can explode (page 263) a polyline into separate straight lines, and combine (page 263) polylines into closed polygons.

• **Draw polygon**: Sketch a polygon by picking the corner points using the current polygon properties. To close the polygon, pick the start point again or click the middle mouse button.
  
  • While sketching a polygon, you can:
    
    • snap to temporary graphical points and set them as reference points by holding down Ctrl and clicking a point on the temporary line.
    
    • set multiple reference points using DWG objects and Tekla Structures building objects.
    
    • delete a reference point by holding down Ctrl and clicking the point.
    
  • You can delete the selected corner point by right-clicking and selecting **Delete**.
  
  • You can add handles by dragging a handle point on the polygon. You can change the shape of the polygon by dragging the handles.
  
  • You can explode (page 263) polygons into single lines.

• **Draw cloud**: Sketch a cloud that traverses the points you pick. Close the cloud by clicking the middle mouse button. Remember to set the **Bulge for all lines** factor for the clouds.

• **Draw cover-up rectangle**: Quickly hide model object outlines in drawings. To use, select the command and sketch a non-transparent rectangular area (page 280) over the model object outline that you want to hide. You can change the size of the rectangle by dragging the handles.

• **Draw cover-up line**: Quickly hide model object outlines in drawings. To use, select the command and sketch a non-transparent line (page 280) over the model object outline that you want to hide.

• **Draw cover-up polygon**: Quickly hide model object outlines in drawings. To use, select the command and sketch a non-transparent polygon (page 280) over the model object outline that you want to hide. You can change the shape of the polygon by dragging the handles.
• **Draw cover-up polyline**: Quickly hide model object outlines in drawings. To use, select the command and draw a non-transparent polyline (page 280) over the model object outline that you want to hide. You can change the shape of the polyline by dragging the handles. You can also explode (page 263) a cover-up polyline into separate straight lines, and combine (page 263) cover-up polylines into closed cover-up polygons.

2. Click **OK** or **Apply**.
3. Sketch the object by following the instructions on the status bar.

### While using sketching tools

- Object dimensions are shown while you draw the sketch objects, and also when you select the objects.
- You may want to activate orthogonal snapping by pressing O while sketching to show ortho angles. You can define snapping steps (page 249) and custom angles in **Drawing snap settings** (File -> Settings -> Snap settings).
- The view scale is taken into account when you copy sketch objects from one view to another, which means that the scale of the object and the related numerical information adjusts to the scale of the target view.
- Sketch object dimensions take into account dimension settings in drawings in general. This means, for example, that units can be controlled in the same way as for the other dimensions.

**See also**

- Drawing sketch object properties (page 773)
- Define customized line types in TeklaStructures.lin (page 681)

### Combine and explode sketch objects in drawings

You can explode a polyline, rectangle, or polygon into separate straight lines. You can also combine separate lines, continuous lines and polylines into a single polyline or a closed polygon.

Do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Combine separate lines, continuous lines or polylines into a single polyline or a closed polygon</td>
<td>1. Select the separate lines or polylines.</td>
</tr>
<tr>
<td>To</td>
<td>Do this</td>
</tr>
<tr>
<td>----</td>
<td>---------</td>
</tr>
</tbody>
</table>
| **Explode a polyline, rectangle, or polygon into separate straight lines** | 1. Select polylines, rectangles or polygons.  
2. Go to the **Drawing** tab and click **Explode**.  
The polylines, rectangles and polygons are exploded into single lines: |

Separate lines and polyline are combined into a single polyline or a closed polygon. When you select the combined shape, you can see that Tekla Structures has combined the lines and created more handles in the shape:
Re-order sketch objects in drawings

In drawings, you may want to indicate positions of openings, windows, doors and such by sketch objects. You can change the mutual order of sketch objects (graphical objects), and the mutual order of sketch objects and model objects. You can bring sketch objects forward or in front of other sketch objects, or send them backward or behind other sketch objects. You can also send sketch objects behind model objects or bring them in front of model objects. You can also re-order DWGs and images in the same way.

If you have several sketch objects (objects on several layers), the drawing order affects on which layer the forward and backward commands place the objects.

Newly created sketch objects are placed on their own layer in the drawing order: newer ones on top of the older ones.

1. Right-click a sketch object, DWG or an image and click Re-order.
2. Select one of the following commands:

   - **Send backward**: Moves the selected object one step closer to the back of all other sketch objects.
   - **Send to back**: Places the selected object behind all other sketch objects.
   - **Bring forward**: Moves the selected object one step closer to the front of all other sketch objects.
   - **Bring to front**: Places the selected object in front all other sketch objects.
   - **Send behind model objects**: Places the object behind all model objects. You can also set this option in the sketch object properties dialog box (Behind model objects -- Yes).
   - **Bring in front of model objects**: Places the object in front of all model objects. You can also set this option in the sketch object properties dialog box (Behind model objects --> No).
NOTE Sketch objects that are placed behind model objects, cannot be rearranged together with sketch objects that are placed in front of the model objects.

Create and add pattern lines in drawings
You can easily apply special and complex lines to drawings by using the pattern lines. You can create new pattern lines and modify existing pattern lines in Pattern line editor, and add the created pattern lines in drawings using the Pattern line command. Pattern lines may include symbols, lines and spacings. You can create pattern lines to indicate cut lines, foundations, weld paths, or electrical wiring, for example.

Create a pattern line
1. In the model or when a drawing is open, on the File menu, click Editors -- > Pattern line editor.
   
   If you have not defined a pattern line earlier, all Pattern line editor fields and containers are empty.

2. Click Browse to browse for an image to be used as a sample for the pattern line.

   ![PatternLine](PatternLine.png)

   If you do not select an image, the default image will be used.

   The selected image is also shown later on when you select a pattern line in the Pattern line properties dialog box.
3. Enter a name for the pattern line in Create new. If you want to modify a pattern line, select the desired pattern line from the list first.

4. In the Start element area, click New on the right to create a new start element. The start element starts the pattern line (marked with red in the dialog box example below).

If you select Symbol as the Element type:

• Select the symbol file from the File list.
• In the Index list, enter the number of the symbol. To select a symbol in a separate window, click Select and double-click the desired symbol.
• In Space, enter the space allocated for the element in millimeters.
• In Size, enter the size of the element in millimeters.
• In Spacing type, select the spacing type for the elements on the pattern line:
  Fixed: The unoccupied space will not be distributed.
  Variable: The unoccupied space will be equally distributed to the elements with this spacing type.
  Infinite: The blocks will occupy all the space between the two points. The space will be distributed to fixed elements, and the rest will be equally distributed to the infinite elements.
• In Color, select the element color.
• In **Vertical offset** and **Horizontal offset**, enter offsets for the elements in millimeters.

• In **Rotate**, define a rotation angle for the element.

If you select **Line** as the **Element type**:

![Image of line settings]

• Select a line type from the **Line type** list.

• In **Space**, enter the space allocated for the element in millimeters.

• In **Size**, enter the size of the element in millimeters.

• In **Spacing type**, select the spacing type for the elements:
  - **Fixed**: The unoccupied space will not be distributed.
  - **Variable**: The unoccupied space will be equally distributed to the elements with this spacing type.
  - **Infinite**: The blocks will occupy all the space between the two points. The space will be distributed to fixed elements, and the rest will be equally distributed to the infinite elements.

• In **Color**, select the element color.

• In **Vertical offset** and **Horizontal offset**, enter offsets for the elements in millimeters.

If you select **Spacing** as the **Element type**:

![Image of spacing settings]

• In **Space**, enter the space allocated for the element in millimeters.

• In **Spacing type**, select the spacing type for the elements:
  - **Fixed**: The unoccupied space will not be distributed.
**Variable**: The unoccupied space will be equally distributed to the elements with this spacing type.

**Infinite**: The blocks will occupy all the space between the two points. The space will be distributed to fixed elements, and the rest will be equally distributed to the infinite elements.

5. In the **End element** area, click **New** to create a new end element in the same way as you did for the start element.

   The end element is marked with red in the editor dialog box:

   ![End element](image)

6. On the **Repeating and continuous elements** tab, define the elements that are repeating on the pattern line (marked with red in the editor dialog box):

   ![Repeating elements](image)

7. On the **Repeating and continuous elements** tab, define the elements that are drawn continuously on the pattern line (marked with red in the editor dialog box):

   ![Continuous elements](image)

8. You can check your pattern line definitions and how the line looks by clicking the **Preview** button `🔍`:

   - If you have the **Automatic** preview option active, Tekla Structures automatically opens a drawing preview that shows the created pattern line with different spacing options taken from the **Pattern line** properties dialog box. If you already have a drawing open, Tekla Structures will ask if you want to save and close the drawing before the preview is opened.

     - To update the preview by clicking the **Refresh** button `🔄`, select the **Manual** preview option.

     - You can also see previews of other saved pattern lines by selecting a pattern line from the list at the top.

     - To close the preview, click the **Preview** button `🔍` again.

9. Save your pattern line by clicking the **Save** button `حفظ`. The pattern line is saved in a `.clp` file in the `\attributes` folder under the model folder.
Now you can open a drawing and create a pattern line using the pattern line that you defined.

The symbols in the following example are taken from the PatternLineSymbols symbol file.

- The symbol at the left end is the start element, symbol #49.
- The symbol at the right end is the end element, symbol #48.
- Blue color is defined for the start and end elements.
- Symbol #51 in red is used as a repeating element.
- Two SolidLines are used as continuous elements with vertical offsets 2.0 and -2.0.

Tip: If your pattern lines are jumping like in the example below, try using continuous elements instead of repeating elements.

Add a pattern line in a drawing
You may select among predefined pattern lines, or create your own in Pattern line editor.

Limitations
- Pattern lines are not included in a 2D Library detail unless the pattern line has been exploded.
- You cannot rotate or mirror created pattern lines.
• You cannot clone pattern lines.

1. In an open drawing, hold down Shift and click Drawing --> Line --> Pattern line.

2. In the Pattern line dialog box, select the pattern line that you want to use from the Pattern line list. You can also load other pattern line properties by selecting a properties file from the list at the top and clicking Load.

3. Select whether to show the Start element and/or the End element in the pattern line. The start and end elements are defined in the Pattern line editor.

4. Select how the elements are aligned and spaced in Spacing:
   - **Left** aligns the elements to the left.
   - **Right** aligns the elements to the right.
   - **Centered** centers the elements.
   - **Distributed** uses the same space in between the elements.
   - **Best fit** tries to fit as many elements as possible with minimal distortion. This setting affects both element size and space.

5. Set the Size of the pattern line.

6. Select the desired Scaling option:
   - **View** draws the line and elements scaled down to the view.
   - **Paper** draws the line and elements scaled down to the scale of the paper.

7. Enter the Vertical offset in millimeters if necessary. A positive value moves the whole pattern line upwards and a negative value downwards.

8. Select the Color of the pattern line.

   The color depends on how you set the colors in Pattern line editor and Pattern line properties:
   • If you select Default as the color both in Pattern line editor and in Pattern line properties, all elements will be black.
   • If you select the Default color in Pattern line editor, and you select another color in Pattern line properties, the color selected in Pattern line properties will be used.
• If you select some other color than Default in Pattern line editor, and you select another color in Pattern line properties, the color selected in Pattern line editor properties will be used.

9. If you want to save the pattern line properties in a properties file, enter a name for the file and click Save as.

10. Click OK, pick the points for a polyline, and end the line by clicking the middle-mouse button. Note that you can select the handles in the added pattern line and move the sections of the polyline by dragging.

**Pattern line elements**

A pattern line consists of one or several blocks of elements. These element blocks are arranged between two given points.

The illustration below shows a pattern line consisting of two repeating symbol elements in three blocks.

The symbol elements have the following settings:

- **Space** = 1.5
- **Spacing type** = Fixed
- **Size** = 1
- **Color** = 1st element is blue, and the 2nd element is red

1. Block size

2. Unoccupied space, which is the space that is left when the blocks are arranged between two points. This space is redistributed to the elements which have the spacing type **Variable**.

The following illustration describes the different element settings. The letter E inside a circle is an element:
1. Size of the element
2. Origin
3. Horizontal offset from the origin
4. Vertical offset from the origin
5. Space

**Trim drawing lines**
You can shorten or extend a line relative to the boundary you select in an open drawing. The boundary can be a line, part, arc, or rectangle, for example.

1. On the **Drawing** tab, click **Trim**.
2. Select the object you want to use as a boundary.
3. Click the middle mouse button.
4. Do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extend the line</td>
<td>Click the end of the line to extend it to the boundary line.</td>
</tr>
<tr>
<td><strong>Original lines:</strong></td>
<td></td>
</tr>
<tr>
<td><strong>The extended line:</strong></td>
<td></td>
</tr>
</tbody>
</table>

Edit drawings 273 Drawing sketching tools and sketch objects
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Shorten the line from the left or right end | Click the line at the end from which you want to shorten it. Original line: ![Original line](image1)
Line clicked at the left end: ![Line clicked at the left end](image2)
Line clicked at the right end: ![Line clicked at the right end](image3) |

**See also**

Drawing sketching tools and sketch objects (page 259)
**Split sketch objects**
You can cut a sketch object into two pieces at a point you select in an open drawing. You can split lines, polylines, circles, and arcs.

1. Select the line.

2. On the **Drawing** tab, click **Split**.
3. Pick a point on the line to indicate the location for splitting.

4. Tekla Structures splits the line into two.

   ![Split sketch objects](image)

**See also**
**Drawing sketching tools and sketch objects (page 259)**

**Divide sketch objects**
You can divide a sketch object into a number of segments that you specify in an open drawing. You can divide lines and arcs.

1. Select the line.

2. On the **Drawing** tab, click **Divide**.
3. In the displayed **Segments** dialog box, enter the number of segments, for example 4, and click **OK**.

Tekla Structures divides the line into four lines.

   ![Divide sketch objects](image)

**See also**
**Drawing sketching tools and sketch objects (page 259)**
Copy sketch objects with offset

You can copy lines, circles, polylines, polygons and rectangles in the direction you point using the offset that you specify. You can also create new circles centered in the same location as the original circle and adjust the radius by the offset that you specify.

1. Select the object that you want to copy in a drawing, for example a line or a circle.

2. On the Drawing tab, click Copy with offset.

3. Click the drawing view in the direction where you want to copy the object.

4. Type the offset in the displayed box, and press Enter.

   Tekla Structures copies the selected shape to the specified direction. For example, if you are copying a line, Tekla Structures makes a new copy of the line in the specified location. If you are copying a circle, Tekla Structures creates a new circle that is centered in the same location as the original circle, and adjusts the radius by the offset that you specified.

   When you copy a line that has a bulge, the created line has the same bulge as the original one.

   If the rectangle has no bulges, the copied object will still be a rectangle after you use Copy with offset. Note that if the original rectangle has a bulge, it is not possible to draw a new rectangle using Copy with offset. When you use Copy with offset, the new copied object will become a polygon.

Example

Example of a copied line:

Example of a copied circle:
Create fillets in drawings
You can connect two intersecting lines by extending the two selected lines to their intersection point by creating a fillet. If no intersection point is found or if it is outside the drawing, nothing will be done.

1. Open a drawing.
2. Select two intersecting lines.
3. On the Drawing tab, click Create fillet.

Edit drawings 277 Drawing sketching tools and sketch objects
Create chamfers in drawings
You can create chamfers between two lines using a distance that you specify. You can create both straight and round chamfers.

1. Select two intersecting lines.
2. Do one of the following:
   • To create a straight chamfer, on the Drawing tab, click Create straight chamfer.

   Enter the distance that you want to have between the two lines (the length of the chamfer line) in the displayed dialog box.
To create a round chamfer, on the **Drawing** tab, click **Create round chamfer**.

Enter the desired radius in the displayed dialog box.

**Example**

Example of a straight chamfer:

Example of a round chamfer:
Hide part face areas and outlines with cover-up tools
Use cover-up line, rectangle, polyline or polygon tool for quickly hiding areas of building object faces or outlines in drawings. Cover-up objects are also shown in printouts.

1. Open a drawing.
2. On the Drawing tab, click one of the cover-up tools:
   Draw cover-up rectangle
3. Pick points and draw a non-transparent area or line over the area that you want to hide.

The cover-up object dimensions are shown while you draw it, and also when the object is selected. You can do the following with cover-up objects:

• Drag cover-up objects to another location.
• Resize cover-up objects by dragging the handles.
• Reshape polyline and polygon objects by dragging the handles.
• **Explode (page 263)** a cover-up polyline into separate straight cover-up lines.
• **Combine (page 263)** a cover-up line or polyline into a closed cover-up polygon.
Limitation: The **Re-order** command in the pop-up menu has no effect on the cover-up object. To have a cover-up area hiding sketch objects, such as polygons and polylines, use **Re-order** for the sketch object and send it behind model object.

**See also**
Drawing sketching tools and sketch objects (page 259)
4.15 Building objects in drawings

Building objects are 2D representations of the 3D objects in the model, for example, parts, bolts, surface treatment, and reinforcement. Building objects in drawings get their appearance from the automatic drawing settings when you create a drawing. After creating the drawing, you can change their appearance in an open drawing.

NOTE If you want to change the model weld properties, go back to the model, and make the changes there. In the drawing, you can only change the visibility settings and appearance of the model welds. For manually added drawing weld marks the properties can be changed in the drawings.

You can modify building objects in many ways:

- Modify building object properties (page 283)
- Shorten parts view by view (page 284)
- Hide part face areas and outlines with cover-up tools (page 280)
- Show a single reinforcing bar in a group (page 285)
- Show layer information on reinforcing bars in drawings (RebarLayeringMarker) (page 287)
- Edge chamfers in drawings (page 288)
- Fillet edges in drawings (page 293)

See also

- Part and neighbor part properties in drawings (page 749)
- Bolt content and appearance properties in drawings (page 754)
- Surface treatment visibility and content properties in drawings (page 755)
- Reinforcement/Neighbor reinforcement and mesh properties in drawings (page 758)
- Welds in drawings (page 306)

Modify building object properties

You can modify the drawing properties of the building objects (parts, bolts, reinforcement, surface treatment, welds, pour breaks, pour objects, reinforcement) in an open drawing. For example, you can change the color and how different kinds of lines are shown, or use fills in parts and cross sections.

Limitations: The color of the center lines can be changed only on the drawing and view level, not on the object level. For center lines, you can only adjust the...
color in the properties dialog box, not the type. You can adjust the line type of part center lines with the advanced option XS_CENTER_LINE_TYPE.

To modify the properties of a building object in a drawing:
1. Double-click a building object, for example a part, reinforcement, surface treatment, or bolt.
2. Switch all the check boxes off in the dialog box by clicking the on/off switch at the bottom of the dialog box.
3. Select the check boxes of only those properties that you want to modify.
4. On the Contents tab, select the part representation, whether to show hidden lines, center lines and reference lines, and which additional markings to show.
5. On the Appearance tab, select the color and type of the lines.
   It is easier to adjust the center line color, if you hide the hidden lines on the Contents tab first.
6. On the Fill tab, set the part and section fill options and add hatches.
7. Click Modify.

See also
- Part and neighbor part properties in drawings (page 749)
- Bolt content and appearance properties in drawings (page 754)
- Surface treatment visibility and content properties in drawings (page 755)
- Reinforcement/Neighbor reinforcement and mesh properties in drawings (page 758)
- Pour object and pour break properties in drawings (page 767)
- Model weld properties in drawings (page 771)
- Example: Part representations (page 643)
- Add hatches (fills) to parts and sketch objects in drawings (page 656)

**Shorten parts view by view**
You can shorten parts in the selected view in an open drawing. By default, there is only an empty area shown between the parts, but you can use a shortening symbol instead, and adjust the shortening symbol color and line type.
1. Double-click a drawing view frame in an open drawing.
2. In View properties, go to the Attributes 2 tab.
3. In Cut parts, select Yes, Only in x direction or Only in y direction.
4. In **Cut skew parts**, select **Yes** to cut skewed parts.

5. In **Minimum cut part length**, set the minimum length of the shortened part.
   
   This option defines how long the part must at least be to get shortened. The length of the part must be at least twice the entered value.

6. In **Space between cut parts**, enter the distance between the cut parts on paper.

7. Click **Modify**.

---

**TIP**  
To use a view shortening symbol instead of the empty area, set the advanced options `XS_DRAW_VERTICAL_VIEW_SHORTENING_SYMBOLS_TO_PARTS` and `XS_DRAW_HORIZONTAL_VIEW_SHORTENING_SYMBOLS_TO_PARTS` to **TRUE**.

You can control the appearance of the view shortening symbol with the advanced options `XS_SHORTENING_SYMBOL_COLOR`, `XS_SHORTENING_SYMBOL_LINE_TYPE`, and `XS_SHORTENING_SYMBOL_WITH_ZIGZAG`.

---

**Example**

Below is an example where the zig zag shortening symbol is used.

---

**See also**

- [Shorten parts in drawing views](#)
- [Shorten or lengthen parts](#)
- [View properties in drawings](#)
Show a single reinforcing bar in a group
You can show one reinforcing bar in a group or in a mesh and hide the rest.

1. In an open drawing, select the reinforcing bar group or mesh.
2. Go to Quick Launch, enter Adjust Reinforcing Bars, and click the Adjust Reinforcing Bars command on the displayed list.
3. Click the bar you want to remain visible.
4. If needed, change the number of visible bars again by double-clicking the bar and changing the Visibility of reinforcing bars setting.

NOTE When you use the Adjust Reinforcing Bars command to select the visible reinforcing bar, also the customized setting becomes available for the Visibility of reinforcing bars option in the Drawing Reinforcement Properties dialog box. You can use this setting only after you have used the Adjust Reinforcing Bars command and not, for example, when you create the drawing.

Example

See also
Adjust the location of a single reinforcing bar (page 286)

Adjust the location of a single reinforcing bar
You can show only one bar in a reinforcing bar group and set it to the desired location.

To adjust a location of a single visible bar in a reinforcing bar group:
1. Right-click the reinforcing bar group.
2. Click Adjust location.
   Only one bar is displayed, and the others are hidden.
3. Click the location where you want to place the bar.
Show layer information on reinforcing bars in drawings (RebarLayeringMarker)

You can mark reinforcing bar layers with different marking styles and line types in a drawing using the RebarLayeringMarker macro.

Before you can show layer information in a drawing, you must run the RebarClassificator macro in the model. The RebarClassificator classifies the meshes and reinforcing bars in the selected walls or slabs by their position. All reinforcing bars and meshes get an attribute indicating the layer where they are placed inside the concrete element.

To show reinforcing bar layer information in a drawing:

1. Open the drawing.

2. Click the Applications & components button in the side pane to open the Applications & components catalog.

3. Click the arrow next to Applications to open the applications list.

4. Double-click RebarLayeringMarker to display the Rebar Layering marker dialog box.

5. On the Marking style tab, select the marking style you want to use (symbol style or level prefix style).

6. On the Marking settings tab, select the marker line type.

7. On the Marking settings tab, do one of the following depending on the selected marking style:
   - For symbol style markers, select the symbol you want to use, and the symbol height.
   - For level prefix style markers, select the level prefix.

8. Click All objects to show layering markers on all reinforcing bars, or select the individual reinforcing bars and click Selected objects to show the markers on the selected bars only.
1. Level prefix style layering marker. The number, for example number 1 in T1, indicates the layer number. The letter, for example T in T1, indicates whether the reinforcing bar is on the top, bottom, near side or far side layer.

2. Symbol style layering marker. The number of triangles indicates the layer number from the face. Triangle orientation indicates whether the reinforcing bar is on the top, bottom, near side or far side layer. For example for top bars, the triangle head points downwards, and for bottom bars upwards.

**Edge chamfers in drawings**

You can show edge chamfers in drawings, and control the way they are shown by modifying the part properties and the edge chamfer properties. You can also add chamfer marks as associative notes.

**See also**

- Building objects in drawings (page 283)
- Show edge chamfers in a drawing (page 288)
- Define default line color and type for edge chamfers (page 289)
- Change edge chamfer line color and type manually (page 290)
- Add associative notes to edge chamfers (page 291)
- Example: Edge chamfers (page 291)
Show edge chamfers in a drawing
You can select whether you show edge chamfers in your drawing and the way they are shown.

1. Open a drawing of a part that has edge chamfers, and double-click the drawing background to open the drawing properties.
2. Click View creation, select the view and the properties that you want to change, and click View properties.
3. In the Additional marks area of the part properties dialog box, select the Edge chamfers on/off check box.
4. Select Outline or Exact in Part representation list depending on the desired result.

5. Save the view properties and click Close.
6. Click Modify.
7. If needed, double-click an edge chamfer and modify the line color and type in the drawing.

See also
Part and neighbor part properties in drawings (page 749)
Edge chamfers in drawings (page 288)

Define default line color and type for edge chamfers
You can define a default color and line type for edge chamfers in drawings.
1. On the **File** menu, click **Settings --> Options** and go to the **Drawing objects** settings.

2. Define the default line color.

3. Define the default line type.

4. Click **OK** to save and close the dialog box.

**TIP** You can override the default settings manually in a drawing by changing the edge chamfer line color and type in the Edge Chamfer Properties dialog box (page 290).

---

**Change edge chamfer line color and type manually**

You can change the line type and color of the edge chamfers in an open drawing. This overrides the default color and type defined in the **Options** dialog box.

1. In the drawing, double-click an edge chamfer to display the **Edge Chamfer Properties** dialog box.

2. Select the desired color and line type.

   Background color is often used for edge chamfer lines for the reason that you may not want to print edge chamfers, or see them in small scale drawings, but you want to be able select them, for example, to add chamfer marks.

**Example**

The following examples show how the edge chamfers are displayed with different part representation settings:

**Part representation Exact.**

**Part representation Outline,**

edge chamfer not selected.

**Part representation Outline,**

edge chamfer selected.
TIP You can also set a default line color and type for edge chamfers (page 289).

Add associative notes to edge chamfers
You can add associative notes to edge chamfers.

1. Open a drawing of a part that has edge chamfers.
2. Modify the part properties and edge chamfer properties so that edge chamfers are visible and you can easily select them.
3. On the Drawing tab, hold down Shift and click one of the commands in the Note menu.
4. In the Associative Note Properties dialog box, modify the note properties as required.
5. Select Edge chamfer from the Content list.
6. Add the elements that you want to have in the edge chamfer mark.
7. Click the edge chamfer.
   If you use a leader line, you need to pick a position for the note.

See also
Add associative notes in drawings (page 219)

Example: Edge chamfers
See below for typical examples of the ways showing edge chamfers.
In this example, Part representation is Exact and Edge chamfers are on. Background color is used in edge chamfer lines, because you usually do not want to show edge chamfers in printouts, but may want to see and select them in the drawing, for example, to add associative notes.
In this second example, **Part representation** is **Outline** and **Edge chamfers** are **on**. Background color is used in edge chamfer lines, because you may want to see and select chamfers in the drawing, for example, to add associative notes. This representation is often used when the scale is small and you do not need to see the small chamfers clearly. The edge chamfer presented in the bottom right corner of the image shows what the edge chamfer looks like when it is selected.
Fillet edges in drawings

Fillet edges are lines that define the boundary between straight faces and curved faces in the model. Examples of model objects containing fillet edges are profiles with curved fillets, slabs or contour plates with curved chamfers, and curved polybeams. The fillet edges can be shown in all drawing types for parts and pours. Fillet edges are visible by default for new drawings, and invisible for drawings that are created in a Tekla Structures version earlier than 2016.

Show fillet edges in drawings

To show the fillet edges, you need to set the option Fillet edges to on. For profiles, Exact representation might be required to show the fillet edges,
depending on the profile. You can control the fillet edge visibility in **Part properties** and in **Pour object properties** on drawing, view and object level.

To set the fillet edges visible on drawing level in a general arrangement drawing:

1. Open a general arrangement drawing that contains steel or concrete parts with curved faces, for example, profiles with curved fillets, slabs or contour plates with curved chamfers, or curved polybeams.
2. Double-click the drawing background to display the **General arrangement drawing properties** dialog box.
3. Click **Part** or **Pour object**.
4. If you need to change part representation (page 749) for profiles, select **Exact** from the **Part representation** list.
5. Under **Additional marks**, select the **Fillet edges on/off** check box.
6. If needed, set the hidden lines options:
   - Select the **Hidden lines on/off** check box to show the hidden lines of other parts.
   - Select the **Own hidden lines on/off** check box to show the part’s own hidden lines.
7. Click **Modify**.

**Examples**

Below is an example of fillet edges in the model:
Below is an example of parts in a drawing showing the fillet edges (Fillet edges > on):
Below is an example of parts in a drawing not showing the fillet edges (Fillet edges > off):

4.16 2D Library in drawings

2D Library allows you to quickly select objects in any drawings and save them as 2D drawing details. You can insert details in drawing views and drawings in any model. You can create details out of many kinds of drawing objects, such as parts, texts, notes, drawing sketch objects, or DWG files. In addition to details, you can browse and insert DWG files and images directly to your drawings from the 2D Library. It allows you to browse for details in other folders and use them in your drawing. Your company can create a collection of standard details that can be distributed in the system, project or firm folders and reused in different drawings and projects.

Limitations

• Multi-colored part section hatches cannot be recognized in detail creation, and the part face hatch will be used instead.

• Templates or images cannot be captured in detail creation.
• Manually added weld marks cannot be captured in detail creation. This also applies to certain other manually added marks, such as revision marks and level marks.

• Details inserted in container views (views around linked/copied views) may be placed incorrectly.

• Inserted details do not rotate if the view is rotated.

• Inserted details cannot be cloned with the drawing.

Open and view 2D Library
The 2D Library is located in the Tekla Structures side pane. It is available when a drawing is open.
1. Open a drawing.

2. Open the 2D Library by clicking the Drawing 2D Library button in the side pane.
3. Click the **Folder** button to check the contents of the various folders:

- **Current model** shows the details in the `\Drawing Details` folder under the current model folder. Your details are saved here, and here you can also create new subfolders. This folder may be empty if you have not created any details or used details in other folders.

- **Project** and **Firm** show the details in the subfolder `\Drawing Details` under the project and firm folders if you have defined paths to these folders as values for the advanced options `XS_PROJECT` and `XS_FIRM`, respectively.

- **System** shows the details in the subfolder `\Drawing Details` in any of the folders defined as a value for the advanced option `XS_SYSTEM`.

- **Browse** allows you to browse to any folder for details.
• When you use details in project, firm, system or any other folder than \Drawing Details in the current model folder, the details are copied to the current model folder.

• When you update a detail with new or changed objects, all instances of the detail in any drawings in the current model will be updated as well. If you are fetching the detail that you update from the firm folder, the detail will not change in the firm folder. Global changes can only be done by the administrators of the firm, project and system folders.

• If the administrator updates a detail in the firm, project or system folder, any already inserted detail instances will not get automatically updated in any project. To do this, you would need to manually copy the updated detail file and replace what's in the model folder.

• **New folder** allows you to create a new folder in the current model folder in the subfolder \Drawing Details.

• Any subfolders in any of the folders are shown next to the details in the selected folder in 2D Library view. Double-click the subfolder to see the included details.

4. Search for details by entering a search term in the search box at the top of 2D Library. Tekla Structures shows the matching details in the view. Details are only searched in the currently displayed folder and its subfolders.

**Insert a detail to a drawing from 2D Library**

In 2D Library, you can add details located in system, project, firm or the current model folder to any of your drawings.

1. Open a drawing.

2. Click the **Drawing 2D Library** button ![folder](image) in the side pane to open 2D Library. To browse to another folder for details, click the **Folder** button ![folder](image), and select **Current model**, **System**, **Project** or **Firm**. You can also browse further to other folders by selecting **Browse**.
3. If you always want to insert a detail inside a view when necessary, click the **Options** button and select **Create view if needed**. You may want to create a view if you place details outside drawing views. The new view will use the currently applied view properties and get the same scale as the inserted detail. If the **Create view if needed** option is not selected, the inserted detail does not get a view of its own, and dimensioning will not work properly in the detail.

By default the **standard view properties** file is used. You can also create a new view properties file to be used for detail views. This will let you have a specific view label in detail views, for example. You can select the new properties file, or any of the existing view properties files, in the **Option** menu. The selected view properties file settings will be applied to every 2D detail container view.

4. Click a detail and then click the drawing view or drawing to place the detail. Tekla Structures inserts the detail. The detail is inserted as a plug-in, which means that the detail objects are grouped and stay together when you select or move the detail in a drawing.

**Create a new detail in 2D Library**
You can create new details in the current model folder or its subfolders.
1. In an open drawing, add the objects that will shape your detail.
   In the example below, the detail represents a beam-to-beam connection. The detail contains texts, circles, lines, polylines, and symbols that have been added on top of a drawing and surrounded by a frame.

2. Click the **Drawing 2D Library** button in the side pane to open **2D Library**.

3. Select the objects that you want to include in the detail.

4. Add the detail in **2D Library**:
   a. If you have subfolders in the current model folder, double-click the subfolder in **2D Library** view where you want to save the new detail.
b. Click the **New detail from selected object** button at the top of 2D Library.

   A message at the bottom of 2D Library asks you to pick a reference point.

c. Pick a reference point in the drawing.

   ![Reference Point](image)

   A message at the bottom of 2D Library asks you to capture a sample image by picking two points.

d. Pick two points to capture an image of the detail.

   ![Sample Image](image)

   Tekla Structures creates the detail and adds it to 2D Library in the \Drawing Details folder under the current model folder. This folder is automatically
created when a detail is created in the current model for the first time. Tekla Structures saves the detail and its metadata (name, description) as a .ddf file. The metadata is used when you search for details in 2D Library. The captured image is saved as a .png file.

Create a new folder in 2D Library and copy/move to the folder
You can create details in a new folder or copy or move details to the new folder in the current model folder.

1. In 2D Library, click the Folder button, and select New folder. You can rename the new folder by clicking the folder and entering a name at the bottom of the side pane.
2. Right-click a detail you want to copy or move and click Cut or Copy.
3. Right-click the new folder and select Paste. Tekla Structures copies or moves the selected detail.
4. If you want to add some details in a system folder, create a subfolder in a system folder (defined by XS_SYSTEM) and rename it Drawing Details, then copy details from the model folder to the new \Drawing Details system folder using Windows Explorer. You can copy or move details in the same way to the project and firm folders.

Modify detail properties in 2D Library
You can modify detail properties of the details in the current model folder. You cannot modify the detail objects, for example, the texts, marks, or lines inside a detail, because the details are grouped. You first need to explode the detail, and then update it.

1. In an open drawing, browse for a folder, and click a detail in 2D Library. A new detail looks like the one below in 2D Library when you have not touched its properties yet:

![New detail 1](image)

2. Modify the detail properties at the bottom of the side pane:
a. Edit the detail name and the description of the detail.

b. Select the original scale, enter a scale, or ignore the scale. When you click **Ignore scale**, the detail will have the same visual size regardless of the view scale.

   The scale refers to the scale of the view where the detail was originally created. The **Scale** value is used when inserting the detail for adapting the detail to the scale of the target view, so that dimensioning, for example, will work correctly. Therefore dimensioning will not be correct if you use the **Ignore scale** option.

c. To change the sample image, move the mouse pointer over the image on the left, click the **Capture new** button, and then pick two points in the drawing.

3. To view and modify the detail properties in the drawing, double-click the inserted detail.

**Explode a detail**
You can explode an inserted detail into lines and texts, for example, to update the detail with new objects.

For example, you may have created a detail and something does not look quite right. You can explode the detail, make modifications and update the detail with the changes.

Another example could be that you have a set of company-specific details that you are inserting details from. You can explode a detail and edit it, and make a new detail out of it.

- In a drawing, right-click an inserted detail, and select **Explode**.

The detail is exploded to lines and texts. Now you can edit the detail, and then update the detail.

**Update objects in a detail**
You can modify all instances of a detail by updating the detail with new or modified objects.
1. Insert the detail in a drawing and explode it by right-clicking the detail and selecting **Explode**.

2. Modify the exploded detail objects or add new ones.

3. Select all detail objects, including any new ones.

4. Right-click the detail in **2D Library** view and select **Update detail with selected objects**. You are asked to pick a new reference point. If you are updating the detail in the same view as originally, you do not need to pick a new reference point, otherwise you need to pick a new reference point.

   The detail gets updated. When you update a detail with new objects, the detail will get updated in all drawings where it is used.

### Explode symbols included in details

You can explode symbols included in details, and make them independent of the local symbol files.

**2D Library** saves the drawing symbols as symbols, which means that later, when you insert the detail, you need to have the correct symbols files present. You can avoid this by exploding the symbols.

1. In **2D Library**, click the **Options** button and select **Explode native symbols**.

2. Insert a detail containing drawing symbols in a drawing.

3. Right-click the inserted detail, and select **Explode**. The detail and the included symbols are exploded to lines and texts.

### Insert a .dwg file to a drawing from 2D Library

You can insert .dwg files from the **2D Library** to drawings as reference files.

1. Open a drawing.

2. Click the **Drawing 2D Library** button in the side pane to open the **2D Library**.

3. Browse for the folder containing the .dwg files in the **2D Library**. You can also move your reference files to a \Drawing Details folder under the current model folder.

4. If you always want to insert a detail inside a view when necessary, click the **Options** button and select **Create view if needed**.

5. Click a .dwg file and then click the drawing view or drawing to place the .dwg file. Tekla Structures inserts the .dwg file as a reference object in

---

Edit drawings 305 2D Library in drawings
the drawing, not as a drawing detail. If the file is inserted from outside the model folder, the file will be copied to the model folder first and the insertion path will be relative to that.

You cannot update the .dwg file with new objects, but you can select an inserted .dwg along with any other objects and create a new detail.

**Insert an image to a drawing from 2D Library**
You can insert image files from the 2D Library to drawings.

1. Open a drawing.

2. Click the **Drawing 2D Library** button in the side pane to open the 2D Library.

3. Browse for the folder containing image files in the 2D Library. You can also move your image files to a \Drawing Details folder under the current model folder.

4. If you always want to insert a detail inside a view when necessary, click the **Options** button and select **Create view if needed**.

5. Click an image file and then click the drawing view or drawing to place the image.

   The image is inserted. If the file is inserted from outside the model folder, the file will be copied to the model folder first and the insertion path will be relative to that.

   Note that the image detail thumbnail is created automatically.

**4.17 Welds in drawings**
Tekla Structures shows the welds that you have added in a model as weld seams and weld marks in drawings. You can also add weld marks manually in an open drawing.

**Weld concepts**
*Model welds* are displayed as *weld marks* and *welds* or weld seams in drawings. Welds and weld marks can be controlled separately. For example, you may want to show the welds in one drawing view and the weld marks in another.

3D model welds are representations of welds in the real world. *Weld solids* in drawings are representations of the welds in models. *Weld seam* is the part of the weld path where the weld solid is drawn. *Weld path* may consist of several weld seams.

Weld solids are shown in drawings for the following welds:
• Weld solids are shown in drawings for those weld types that have real solid support. Welds that have no real solid support are shown in the model with a hexagonal placeholder, and in drawings weld solids are not shown.

• Custom cross-section welds are also supported.

Weld solids can be shown as outlines or paths, with or without hidden lines.

In the first example, the welds on the right and in the middle have outlines and own hidden lines. The weld on the left shows the path and hidden lines:

The second example is a cross-section of the structure. The welds left and in the middle have outlines, and the weld on the right shows the path. The welds have manual dimensions.
The weld symbols inside the weld marks indicate the weld properties defined for the model weld in the model or for the drawing weld mark in the drawing. Below is an example of a model weld seam (in red) and a model weld mark (in green) in a drawing.

In addition to the weld symbols, the weld mark contains a reference line and an arrow. The arrow connects the reference line to the arrow side of a connection. The welds on the arrow and other sides of a part can have different weld properties.
Weld placement
When parts are welded together, you can place welds on:

- The arrow sides only
- The other sides only
- Both the arrow and other sides

The following images describe the basic placement principles of welds.

1. Above line
2. Below line
3. Arrow side for weld
4. Other side for weld

By default Tekla Structures places the welds above line according to the ISO standard. You can change this to below line to comply with the AISC standard with the advanced option XS_AISC_WELD_MARK.

Model weld properties
To change model weld properties, you need to modify the weld in the model. When you update the model, the weld objects and weld marks are updated in the drawing according to the model changes. In drawings, you can modify the contents and the appearance of the model weld marks (page 316), and the visibility, representation and appearance of model weld objects (page 318).

Weld solids can be shown in single-part, assembly and general arrangement drawings. In general arrangement drawings, you can only change the representation of welds on view and object level, not on drawing level.

Manual weld marks
To add weld marks (page 322) in an open drawing, use the Weld mark command on the Drawing tab.

Click the links below to find out more:
Examples: Model welds in drawings (page 310)
Drag weld marks (page 320)
Customize weld type symbols (page 323)
Example: Weld marks added in drawings (page 324)
Merge weld marks (page 326)
Model weld mark visibility and appearance properties in drawings (page 734)
Model weld properties in drawings (page 771)
Drawing weld mark properties (page 732)

Examples: Model welds in drawings
Model welds are welds that you have added in the model. In drawings, they are represented by weld seams and weld marks.

Example 1
In this example, the first image below shows an example of the Weld Properties dialog box in the model. You can add welds in the model by selecting one of the welding commands on the Steel tab. Some of the weld properties are numbered in the dialog box, and the second image shows how these properties are shown in a weld mark in a drawing. The same numbers as in the dialog box are used in the weld mark to indicate the position and appearance of the property information in the weld.
Edit drawings 311 Welds in drawings
1. Weld prefix
2. Weld size
3. Weld type
4. Weld angle
5. Weld contour symbol
6. Weld finishing symbol
7. Effective throat
8. Root opening
9. Edge/Around, weld around symbol is used
10. Workshop/Site, site weld symbol is used

Example 2
The example below shows a staggered, intermittent weld. The length is set to 50 and the pitch to 100.
1. Staggered, intermittent weld
2. Length of weld segment
3. Pitch (center-to-center spacing) of weld segments

Example 3
The example below shows a non-staggered, intermittent weld. The length is set to 50 and the pitch to 100. The pitch is shown in the weld mark, if the pitch value is greater than 0.0.
Example 4
Below is an example of a continuous weld.
Example 5
In this example, the staggered, intermittent weld is selected, and the advanced option `XS_AISC_WELD_MARK` is set to `FALSE` to produce an ISO-compliant weld mark.

Example 6
In this example, the staggered, intermittent weld is selected like in the previous example, but the advanced option `XS_AISC_WELD_MARK` is set to `TRUE` to produce an AISC-compliant weld mark.
TIP  For instructions on how to customize weld symbols, see Customize weld type symbols (page 323).

See also
Welds in drawings (page 306)
Model weld mark visibility and appearance properties in drawings (page 734)
Model weld properties in drawings (page 771)

Modify model weld mark visibility and appearance in a drawing
Welding properties are set in the model. You can select the welding properties that you want to show in model weld marks in drawings and adjust the appearance of the model weld marks in the Welding Mark Properties dialog box.

To select which model weld properties to show, and to modify the weld mark properties on drawing view level:

1. In an open drawing, double-click a view frame to open the View Properties dialog box.
2. Click Weld mark to go to weld mark properties.
3. Select whether to show the weld number in Weld number (No/Yes).
4. Under Visibility:
   - In Welds and Welds in assemblies, select what kind of welds to show, or whether to hide all welds (None, Site, Workshop, Both).
   - In Weld size limit, enter a weld size limit to filter welds of that size out of the drawing.

Even though you set the weld size limit, welds are always shown if they have reference texts.
5. Under **Above line**, **Below line** and **Other**, delete the check mark from the **Visibility** check box next to a weld mark property that you want to hide. Remember that if you hide **Size**, also **Prefix** is hidden, and when you hide **Length**, also **Pitch** is hidden.

6. To adjust the placing properties, click **Place**.

7. Click **Modify**.

8. Go to the **Appearance** tab and modify the weld mark text and line appearance.

9. Click **Modify**.

   You can modify the properties of individual model weld marks in an open drawing by double-clicking the mark to open the **Welding Mark Properties** dialog box.

**Example**

The first example shows the original weld mark where a lot of properties are visible.

In the second example, all other welding mark properties are hidden, except **Type** from **Above line** and **Below line**, and **Reference text** from **Other**.
**TIP** You can also omit welds from drawings by weld type using the advanced option XOMMITTED_WELD_TYPE. Then you first need to set a value for the **Weld size limit**.

You can also [customize some weld type symbols](page 323).

---

**See also**

Model weld mark visibility and appearance properties in drawings (page 734)

---

**Modify model weld representation and appearance**

You can modify the model weld object representation and appearance manually on object level.

1. In an open drawing, double-click the model weld seam.
   
   It is easier to select the model weld if you have only the **Select welds in drawings** selection switch active.
2. On the **Content** tab, select the desired **Representation**. The options are **Path** and **Outline**.

3. Select whether you want to show **Hidden lines** and **Own hidden** lines.

4. On the Appearance tab, modify the color and line type of the **Visible lines** and **Hidden lines**.

5. Click **Modify**.

**Examples**

In the first example, the welds on the right and in the middle have outlines and hidden lines. The weld on the left shows the path and hidden lines:

![First example of welds](image1)

The second example is a cross-section of the structure. The welds left and in the middle have outlines, and the weld on the right shows the path. The welds on the right and left go around the part corner. The welds have manual dimensions.

![Second example of welds](image2)
**TIP** You can define automatic weld properties (page 667) before creating a drawing. You can also modify the weld properties on view level in an open drawing by double-clicking frame of the drawing view containing the weld objects and selecting **Welds** from the options tree. On drawing and view level, you can also modify the visibility settings (page 771).

---

**Drag weld marks**

You can drag the model welds by the base point of the weld mark leader line along the weld seam. This way you can position the weld marks more optimally for increased clarity in the drawings.

**TIP** Having **Smart select** (File menu --> Settings --> Smart select) selected makes selecting the leader line base point much easier.

**Limitation:** You cannot drag the weld leader base point to the back-side of a double-sided weld.

1. Click the weld mark near the leader line base point.
2. Hold down the left mouse button and drag the base point to a new location by the leader line base point handle located in the tip of the arrow.
Example

The first image below shows the welds in the model.

The second image shows the model weld marks in a drawing. The area within which the weld mark leader line base point can be dragged is indicated with dark green.
Add manual weld marks in drawings
You can add manual weld marks in an open drawing. Tekla Structures creates manual weld marks using the properties in the Weld Mark Properties dialog box.

1. Hold down **Shift** and, on the Drawing tab, click **Weld mark** to open the Weld Mark Properties dialog box.
2. Enter or modify the content and the appearance of the weld mark.
3. To exactly place the weld mark in the position you pick and keep it there, click the Place button and select **fixed** in the Placing list.
4. Click **Apply** or **OK** to save the properties.
5. Pick a position for the weld mark.
   You can drag the created drawing weld mark freely to a more suitable location by the leader base point handle.

See also
Welds in drawings (page 306)
Drawing weld mark properties (page 732)
Define automatic placement settings for marks (page 458)
Customize weld type symbols (page 323)

Customize weld type symbols
Most of the weld type symbols are hard coded, but you can edit some of them in Symbol Editor.

The bottom seven symbols in the Type list in model Weld Properties and drawing Weld Mark Properties (see image below) are taken from the TS_Welds.sym file. You can edit any of these seven symbols in Symbol Editor to create a custom weld symbol. The rest of the weld symbols are hard coded. Note that the symbol in the Type list in the dialog box does not change when you update the symbol.

1. Open Symbol Editor as administrator.
2. Click File --> Open and browse to the folder were you have the TS_Welds.sym file.
3. Select the file and click **OK**.

4. Modify the desired symbol.
   When doing this, you need to keep the symbol in the same scale as the other symbols. If your symbol is too large to fit in the box, you can let it extend beyond the borders:

5. Save the symbol by selecting **File --> Save**.

For more information about Symbol Editor, click **Symbol Editor User's Guide**.

**Example: Weld marks added in drawings**

In this example, the first image below is the **Weld Mark Properties** dialog box in a drawing. The weld mark properties are numbered in the dialog box. The second image shows how the weld mark properties are displayed in a weld mark in a drawing. The same numbers are used in the weld mark as in the
dialog box to indicate the weld mark property in the weld. Under the images the meaning of different numbers is explained.
1. Weld prefix
2. Weld size
3. Weld type
4. Weld angle
5. Weld contour symbol
6. Weld finishing symbol
7. Effective throat
8. Root opening
9. Edge/Around, here a weld around symbol
10. Workshop/Site, here a site weld symbol

See also
Drawing weld mark properties (page 732)
Add manual weld marks in drawings (page 322)

Merge weld marks
You can force Tekla Structures to use the same mark and symbol for identical welds in a drawing by merging the weld marks.

1. Open a drawing.
2. Hold down Ctrl and select the weld marks to merge.
3. Right-click and select Merge from the pop-up menu.
   Tekla Structures combines the marks.
4. If needed, you can split merged weld marks by right-clicking the mark and selecting **Split** from the pop-up menu.

<table>
<thead>
<tr>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original drawing</td>
<td><img src="image1" alt="Original drawing" /></td>
</tr>
<tr>
<td>Merged weld marks</td>
<td><img src="image2" alt="Merged weld marks" /></td>
</tr>
</tbody>
</table>
4.18 Custom presentations in drawings

You can modify the appearance of many of the objects in drawings using custom presentations. Custom presentations are delivered in Tekla Warehouse as extensions. The presentations can be controlled on the view level and object level.

When you have downloaded a custom presentation for an object type, the Custom presentation tab will become available in the drawing property dialog for that object. The list will only show custom presentations that are available for that specific object type – part, weld, mark, etc.

The following object types support custom presentations:

- welds and weld marks
- parts and part marks
- neighbor parts and part marks
- grid lines
- texts
- associative notes

Examples

In the example below, the Weld solid custom presentation is used for drawing the weld solids.
In the following example, **Corners Only** custom presentation is used for laser layout projection. Drawing all the lines of a part slows down the laser and makes it too dim to see on the layout table.

**Custom presentations in Tekla Warehouse**

**Center of gravity**

**See also**

*Edit drawings (page 143)*

### 4.19 Pours in drawings

Tekla Structures general arrangement drawings are able to present pour object geometry, and pour breaks. Pour drawings can be used for communicating the sequencing of the pours, and the properties of the pours and pour breaks.

**How to enable pours**

Pours can be enabled in a model by setting the `XS_ENABLE_POUR_MANAGEMENT` advanced option to `TRUE`. In the default environment, pours are only enabled in the (Concrete) Contractor role.

**WARNING** If the pours are enabled in the model, do not disable the pours using `XS_ENABLE_POUR_MANAGEMENT`, especially in the middle of the project. This may cause problems if you have drawings containing pours, and if you are sharing your model. The pours and pour breaks in the model and in the drawings may get invalid, and you may lose all pour-related modeling work.

**Pour objects**

The geometry of the pour objects is presented as monolithic concrete. The pour objects can be presented in plan, section and 3D drawings. Tekla Structures shows the pour object geometry in general arrangement drawings exactly like it has been modeled: overlaps and extra outlines vanish if the parts collide, have the same concrete material grade, have **Cast in place** as the **Cast unit type**, and have the same pour phase.

You can select whether you want to show pour objects or not. You can use different colors, line types and fills in different pour objects. You can also modify the pour object properties in an open drawing on object, view and
Pour object marks
Using pour object marks, you can show information related to pour objects, for example, pour number, pour type, material grade, planned pour start date and the name of the pour team. You can add automatic pour marks before creating the pour drawing, and add and modify pour object marks also in an open drawing.

Pour breaks
Pour breaks are shown in general arrangement drawings as they have been modeled. The pour breaks are represented by a symbol. You can change the symbol using the advanced option XS_POUR_BREAK_SYMBOL. The symbol scale and the spacing between the symbols follows the drawing view scale automatically.

You can show pour breaks automatically, and modify the pour break properties and add associative notes to the pour breaks in an open drawing.

Predefined pour drawing properties and templates
In the default environment, the Concrete Contractor role contains some predefined drawing properties, a couple of traditional report templates, and an organizer report template for pours. Your own environment may also contain some predefined drawing properties, and templates for pours. For examples of pour drawings and pour reports, see Examples of pour drawings and pour reports (page 333).

Examples
In the image below, you can see two pour objects colored differently, each having a pour object mark. The pour break can be seen between the pour objects, it is represented by a symbol. The pour break is marked with an associative note.
See also
Show pour objects, pour marks and pour breaks in drawings (page 668)
Change the pour break symbol (page 332)
Add associative notes in drawings (page 219)
Pour object and pour break properties in drawings (page 767)

Modify pour objects, pour marks and pour breaks in a drawing
After you have created a pour drawing, you can open it and modify the pour objects, pour marks and pour breaks.

1. Open a pour drawing and double-click the drawing background to go to the drawing properties.

2. If you want so show the pours in the drawing, click the View button, check that Show pours in drawings is set to Yes, and click OK.

3. Click the Pour object button to modify the properties:
   - Content tab: Select whether you want to see the hidden lines and own hidden lines, and the edge chamfers by clicking on or off.
   - Appearance tab: Set the color and type for visible lines and hidden lines.
• **Fill** tab: Select the fill for the pour object face and/or pour object section face.

4. Click **OK**.

5. Click the **Pour object mark** button, select the contents and appearance of the mark, and click **OK**.

6. Click the **Pour breaks** button and check that **Visibility** is set to **Visible** and click **OK**.

   You can also select whether you want to show pour break hidden lines on the **Visibility** tab. On the **Appearance** tab you can change the color and type of the visible and hidden lines in pour breaks.

7. Modify the other properties as required. For example, click **Reinforcement** and set the **Visibility of all reinforcing bars** to **Visible** to show the reinforcement in the pour drawing.

8. Click **Modify** to apply the changes in your pour drawing.

**See also**

- Pours in drawings (page 329)
- Pour object and pour break properties in drawings (page 767)
- Add hatches (fills) to parts and sketch objects in drawings (page 656)
- Examples of pour drawings and pour reports (page 333)
- Change the pour break symbol (page 332)

**Change the pour break symbol**

If you want to change the pour break symbol, you can do that using the advanced option **XS_POUR_BREAK_SYMBOL**.

1. On the **File menu**, click **Settings** --> **Advanced options** and go to the **Drawing Properties** category.

2. Set a new value for the advanced option **XS_POUR_BREAK_SYMBOL**.

   The default value is PourBreaks@0. The value refers to the PourBreaks.sym file where the symbol is defined. The symbol value starts with the symbol library file name (PourBreaks) and ends with the number of the symbol (0). The default symbol file is located in . . \ProgramData\Tekla Structures\<version>\environments \common\symbols.

   You can also create a new symbol file containing a new symbol, and save it. Then define the new .sym file for **XS_POUR_BREAK_SYMBOL**. If you wish to use a symbol file that is not located under your environment folders,
enter the complete path to the symbol file location, the symbol file name and symbol number as the value for this advanced option.

3. Click **Apply** and **OK**.

**Example**

```
// \ // \ // \ // \ 
```

**See also**

* Pours in drawings (page 329)*

**Examples of pour drawings and pour reports**
The Concrete Contractor role in the default environment contains some predefined templates and settings for pour drawings and reports.

**Examples of drawing properties predefined for pours**
The Concrete Contractor role in the default environment contains predefined general arrangement drawing properties CIP_Pour_3D, CIP_Pour_Plan, and CIP_Pour_Plan_with_Pour_List. These drawing properties use detailed object level settings to color pour objects with different colors based on pour number. In addition, the drawing properties file CIP_Pour_3D does not render hidden lines, and CIP_Pour_Plan_with_Pour_List adds a pour list to the drawing.

![Drawing Properties](image)

The following example drawing is created by using the CIP_Pour_Plan_with_Pour_List drawing properties, and applying CIP_Pour_3D view level properties to 3D views. Click the following link to open the drawing:

*Pour Drawing*
Examples of reports predefined for pours
The Concrete Contractor role in the default environment contains predefined report templates for pour information:

- There are two traditional types or report templates that can be created using the Create reports command: Pour List and Pour Schedule.csv.
- The Pour Organizer report can be exported to excel format.

Click the links below to see example reports created using these report templates:
- Pour list
- Pour schedule
- Pour Organizer report exported to Excel

4.20 Grids in drawings
You can show grids and grid line labels in single-part, cast unit, assembly, and general arrangement drawings. You can set automatic grid properties and also manually modify properties in an open drawing.

<table>
<thead>
<tr>
<th>To</th>
<th>Click below</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify grid properties and the properties of individual grid lines manually</td>
<td>Modify grid and grid line properties in drawings (page 334)</td>
</tr>
<tr>
<td></td>
<td>Drawing grid properties (page 774)</td>
</tr>
<tr>
<td>Hide grids and individual grid lines manually</td>
<td>Hide grids or grid lines (page 347)</td>
</tr>
<tr>
<td>Drag grid labels if the label is covering an important area in a drawing</td>
<td>Drag grid labels (page 346)</td>
</tr>
<tr>
<td>Set automatic grid properties before you create the drawing</td>
<td>Define automatic grid properties (page 640)</td>
</tr>
</tbody>
</table>

Modify grid and grid line properties in drawings
You can modify grid properties on the drawing and view levels, and properties of individual grids or grid lines in an open drawing.

To modify the grid or grid line properties on object level in an open drawing:
1. Ensure that you have the correct selection switch selected.
To modify grids, use the selection switch, and to modify grid lines, use.

2. Double-click the grid or the grid line. Tekla Structures opens the **Grid Properties** or **Grid Line Properties** dialog box.

3. **Visible** shows the grid lines in the drawing. If you want to see the labels only, select **Only grid labels visible**.

4. Modify the label text placing, grid line and text settings as required.

5. Click **Modify**.

**NOTE** You can also set a fixed width to the grid label frames and set a width factor for the grid label frames:

- XS_DRAWING_GRID_LABEL_FRAME_FIXED_WIDTH
- XS_DRAWING_GRID_LABEL_FRAME_LINE_WIDTH_FACTOR

**See also**

*Drawing grid properties (page 774)*

**Customize drawing grid labels**

In GA drawings, you can customize drawing grid labels by including extra text and symbols in the labels. You can define the label text, offsets and offset prefixes in the grid user-defined attributes in the model and show the grid label text in drawings. You can also define the prefixes in an open drawing. You can use a combination of traditional grid labels and custom labels, or only use custom labels.

Before you can customize grid labels, you need to modify the user-defined grid properties in the model, and also other grid properties, depending on your needs. You can also choose to modify the prefix text in the drawing.

**Modify grid model properties**

1. In the model, double-click the grid to open the **Grid** dialog box.

2. Modify the grid properties as required.
In this example, you will create grid labels for elevations, so you need to modify the **Labels** for Z direction.

3. Click **User-defined attributes**.
4. Fill in the necessary information in the grid user-defined attributes dialog box.

Note that you cannot leave the **Offset in Z** box empty even if the offset was 0. If the offset is 0, you still need to enter 0.

In this example, you need to have the **Grid label text**, **Offset in Z** and **Prefix for offset in Z** defined. You can also define the prefixes and the label texts in the **Advanced grid labels** dialog box in the drawing.

5. Click **OK**, select the grid and select **Modify**.

Now you have created the necessary grid label texts and adjusted the needed values. Next, you can customize the drawing grid labels.
**Customize drawing grid labels**

1. Open a general arrangement drawing.

2. On the **Drawing** tab, hold down **Shift** and click **Grid labels**.

3. Define the properties for the custom grid labels:

<table>
<thead>
<tr>
<th>Grid label placing</th>
<th>Select which grid labels are displayed by selecting the desired check boxes.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use settings from</td>
<td>Define where the grid label properties are taken from:</td>
</tr>
<tr>
<td></td>
<td>• <strong>grid</strong> inherits the properties from the grid.</td>
</tr>
<tr>
<td></td>
<td>Note that if you have defined settings for text color, height and font in the standard drawing <strong>Grid properties</strong> dialog box, the corresponding settings in the <strong>Advanced grid label properties</strong> dialog box will changed accordingly, when you click <strong>Modify</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>dialog box</strong> uses the settings defined in the <strong>Advanced grid labels</strong> dialog box.</td>
</tr>
<tr>
<td>Frame type</td>
<td>Select the type of the frame:</td>
</tr>
<tr>
<td></td>
<td>Any symbol, grid label text inside, at the bottom</td>
</tr>
<tr>
<td></td>
<td>Any symbol, grid label text inside at the top</td>
</tr>
<tr>
<td></td>
<td>Any symbol with a leader line, grid label text under the leader line outside the symbol</td>
</tr>
<tr>
<td></td>
<td>Any symbol with a leader line, grid label text above the leader line outside the symbol</td>
</tr>
<tr>
<td></td>
<td>Note that you can define a fixed size for the grid label frame by setting the advanced option <strong>XS_DRAWING_GRID_LABEL_FRAME_FIXED_WIDTH</strong> to a defined value. If you want to calculate the grid label frame size automatically, leave the value out.</td>
</tr>
<tr>
<td>File</td>
<td>Select a symbol file from the list.</td>
</tr>
<tr>
<td>Number</td>
<td>Click the ... button and double-click the symbol. For example, the elevation symbol is by default symbol number 35 in the <strong>xsteel.sym</strong> file.</td>
</tr>
<tr>
<td><strong>Color</strong></td>
<td>Select the color and the line type of the grid label frame symbol.</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Height</strong></td>
<td>Set the height of the grid label frame symbol:</td>
</tr>
<tr>
<td></td>
<td><strong>Enter height:</strong> Enter the height in the <strong>Height</strong> box.</td>
</tr>
<tr>
<td></td>
<td><strong>Autosize:</strong> Adjust the symbol height automatically.</td>
</tr>
<tr>
<td></td>
<td><strong>Enter Autosize minimum height:</strong> Set the minimum height for the symbol.</td>
</tr>
<tr>
<td><strong>Grid: Number</strong></td>
<td>Define the <strong>Prefix</strong>, <strong>Color</strong>, <strong>Height</strong> and <strong>Font</strong> of the grid numbers. If you define the prefix in the user-defined attributes of the grid, you no longer need to do it here.</td>
</tr>
<tr>
<td><strong>Grid: Text</strong></td>
<td>Define the <strong>Prefix</strong>, <strong>Color</strong>, <strong>Height</strong> and <strong>Font</strong> of the grid label texts. If you define the prefix in the user-defined attributes of the grid, you no longer need to do it here.</td>
</tr>
<tr>
<td><strong>Create axis text</strong></td>
<td>Select <strong>Yes</strong> or <strong>No</strong>. Yes enables the options below. <strong>No</strong> is the default value. If you have defined prefixes and grid axis texts in the user-defined attributes of the grid, you no longer need to define them here.</td>
</tr>
<tr>
<td><strong>Prefix for axis X</strong></td>
<td>Define the prefix for the X axis.</td>
</tr>
<tr>
<td><strong>Prefix for axis Y</strong></td>
<td>Define the prefix for the Y axis.</td>
</tr>
<tr>
<td><strong>Prefix for axis Z</strong></td>
<td>Define the prefix for the Z axis.</td>
</tr>
<tr>
<td><strong>Color</strong></td>
<td>Define the color of the grid axis text.</td>
</tr>
<tr>
<td><strong>Height</strong></td>
<td>Define the height of the grid axis text.</td>
</tr>
<tr>
<td><strong>Font</strong></td>
<td>Define the font used in the grid axis text.</td>
</tr>
</tbody>
</table>

4. Save the properties for future use by entering a unique name in the **Save as** box and clicking **Save as**.

5. Click **OK** and pick a grid.

Tekla Structures customizes the grid labels and label texts according to the modifications that you made in the grid UDAs in the model, and in the **Advanced grid label** properties in the drawing.

Note that if you get duplicate grid labels (traditional and custom), double-click the drawing grid and clear the check boxes of double grid labels in grid properties.

In the example below, the following properties were defined in the grid properties and grid user-defined attributes in the model:

- **Labels: Z** = Floor1  Floor2  Floor3
- **Grid label text** = Text
- **Prefix for offset in Z** = Prefix Z
Offset in Z = 1000.00

In the Advanced grid labels dialog box, was selected as the Frame type.

**Customize a grid label on a single grid line**
1. Ensure that you have the Select grid lines in drawings selection switch active.
2. In an open drawing, on the Drawing tab, hold down Shift and click Grid labels.
3. Define the properties for the grid labels (see instructions above).
4. Click OK, and pick a grid line. You can also select several grid lines using area selection.

Tekla Structures customizes the grid labels and label texts on the selected grid line according to the modifications you made.

**Modify custom grid labels**
You can modify the custom grid labels by selecting the grid labels.
1. Ensure that you have the Select grids in drawings selection switch active.
2. In an open drawing, on the Drawing tab, hold down Shift and click Grid labels.
3. Only select the check box of the grid label that you want to customize.
4. Define the properties for the custom grid label.
5. Click Modify and select the grid label.

**Customize grid labels only at one end of a grid line**
You can have regular and customized labels at different ends of a grid line.
1. Ensure that you have the Select grids in drawings selection switch active.
2. In an open general arrangement drawing, on the **Drawing** tab, hold down **Shift** and click **Grid labels**.

3. Only select the check box of the grid label you want to customize.

4. Define the properties for the custom grid label.

5. Click **OK** and select the grid.

6. Select the **Select grid lines in drawings** selection switch.

7. Select the desired grid lines, right-click and select **Properties**, and only select the check box at the opposite end of the grid line. Area select is handy in grid line selection.

8. Click **Modify**. The custom grid label is displayed at the one end of the grid line, and the traditional grid label at the other end.
**Add different customized grid labels on horizontal and vertical grid lines**

You can use different customized labels in horizontal and vertical grid line labels.

1. Ensure that you have the **Select grids in drawings** selection switch active.
2. In an open drawing, on the **Drawing** tab, hold down **Shift** and click **Grid labels**.
3. In the **Advanced grid labels** dialog box, only select the check box for the right horizontal grid labels.

4. Define the properties for the horizontal grid labels. For example, for elevation grid label, set up an elevation symbol.

5. Click **OK** and select the grid.

   Custom grid labels are added on the horizontal grid lines. There are no grid labels on the vertical grid lines.

6. Hold down **Shift** and click **Grid label**.

7. In the **Advanced grid labels** dialog box, only select the check box for the upper vertical grid labels.

8. Define the properties for the vertical grid labels. For example, select the desired frame label type.

9. Click **OK** and select the grid line.

   Custom grid labels are added on the vertical grid lines of the selected grid. The horizontal grid lines have the labels that you added earlier.
Use model grid coordinates and prefix as text on grid axis in a drawing

1. On the **Drawing** tab, hold down **Shift** and click **Grid labels**.

2. Do any of the following:
   - Define the following settings to show grid coordinates automatically along grid lines:
     - You can also do this in another way and use different prefixes:
       a. First in the model grid user-defined attributes, add in **Prefix offset in X** and in **Prefix offset in Y** values W: and N: in the following way:

   ![Diagram showing grid coordinates and prefixes](image)
b. Then in the drawing in the **Advanced grid label properties** dialog box, set **Grid axis text** to **Yes**: 
If you want to write prefixes to these values, in Advanced grid label properties dialog box, add the Prefix for axis X and Prefix for axis Y information.

c. To get model grid coordinates shown in the drawing grid labels automatically, in the model, go to user-defined grid attributes, and change the offset values to 0.
When you do this, go to drawing Advanced grid label properties, and set Create axis text to No.

**Limitations**

- The grid lines are not refreshed automatically.
  - If you have hidden grid lines or otherwise modified them, you need to click **Modify** in the Advanced grid labels dialog box to refresh the grid labels.
  - If you drag grid line handles, the custom grid labels are not moved together with the handle, until you click **Modify** in the Advanced grid labels dialog box.
- Advanced grid labels are not supported in multidrawings, key plans or in cloning, or when moving views to another drawing.
- Not all frame types are allowed for all axises.
Drag grid labels
You can move single grid labels in drawings by dragging them. This is useful, if the grid label is covering an important area in a drawing.

Ensure, that you have selected Smart select in File menu --> Settings to drag and drop by handles without selecting them first.

1. Ensure that you have the grid line selection switch selected.
2. Click a grid.
3. Hold down the left mouse button and drag the label by the handle to a new location.

Hide grids or grid lines
You can hide grids and grid lines if you do not want to have them visible in a drawing.

1. Ensure that you have the correct selection switch selected:

   To hide grids, use the selection switch, and to hide grid lines, use

2. Click a grid or a grid line.
3. Right-click the grid or the grid line and click Hide/Show --> Hide from drawing view.

TIP If you want to show the grids or grid lines, press B until the color mode is Color, right-click the grid or the grid line, and select Hide/Show --> Show in drawing view. You can see and select the hidden grids and grid lines only in Color mode.

4.21 Symbols in drawings
You can use symbols in drawings, for example, as separate objects, and in marks, object representations, and line arrows. Symbols can be created and edited in Symbol Editor.

Symbol Editor
You can open Symbol Editor by clicking File menu --> Editors --> Symbol Editor. In Symbol Editor, you can create new symbol files, and create and modify symbols.

The Symbol Files dialog box in drawing mode allows you to change the symbol file in use. It also provides access to Symbol Editor.
We recommend that you have a look at the Symbol Editor User's Guide, so that you get familiar with creating new symbols and modifying the existing ones.

We strongly recommend that you do not modify the original symbol files delivered with your Tekla Structures application. If you need to modify any symbols, copy the original symbol file and work on the copy, keeping the original symbol file intact.

If your symbols are located in a protected folder, the symbols are read-only, because you cannot save a modified symbol in a protected folder if you are not an administrator. In this case, run Tekla Structures as administrator.

**Symbol file search order**

When displaying the symbols in drawings, Tekla Structures searches the symbol files from folders listed in DXK_SYMBOLPATH (defined in the environment initialization file <your_environment>.ini and in the Tekla Structures initialization file teklastructures.ini). Alternatively, you can add your own DXK_SYMBOLPATH in options.ini under the model folder and define your own symbol folder paths there. Note, that also the path settings in the <your_environment>.ini file need to be added there. The last read .ini file settings are used. At startup of Tekla Structures, the reading order of the .ini files containing DXK_SYMBOLPATH is:

- teklastructures.ini
- <your_environment>.ini
- options.ini

All symbol files that are found are available to be used in Tekla Structures. If there are symbol files with the same name, the one that is read last is used.

<table>
<thead>
<tr>
<th>To</th>
<th>Click below for more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change a symbol in a symbol file using Symbol Editor</td>
<td>Change a symbol in a symbol file (page 349)</td>
</tr>
<tr>
<td>Create new symbol files to be used in drawings</td>
<td>Create a new symbol file (page 350)</td>
</tr>
<tr>
<td>Change the currently used symbol file</td>
<td>Change the symbol file in use (page 351)</td>
</tr>
<tr>
<td>Add symbols in your drawings manual</td>
<td>Add symbols in drawings (page 351)</td>
</tr>
<tr>
<td>Customize the symbols that are used as leader line arrows</td>
<td>Customize leader line arrows (page 352)</td>
</tr>
<tr>
<td>Modify the appearance of a symbol in an open drawing</td>
<td>Modify symbol properties (page 354)</td>
</tr>
<tr>
<td>Add symbols in marks, for example, part marks</td>
<td>Add symbols in automatic marks (page 633)</td>
</tr>
<tr>
<td>Define a firm folder where Tekla Structures always searches for the</td>
<td>Define a firm folder for images and symbols (page 359)</td>
</tr>
<tr>
<td>To</td>
<td>Click below for more information</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>images and symbols. When you store the images and symbols in this folder, you do not have to move them from folder to folder when you install a new version of Tekla Structures. Installing a new version does not replace the files in the firm folder.</td>
<td>Add surface treatment symbols in cast unit drawings using the AddSurfaceSymbols macro (AddSurfaceSymbols) (page 358)</td>
</tr>
<tr>
<td></td>
<td>Create, update and delete moment connection symbols, which indicate the beams that are connected to columns with rigid connections</td>
</tr>
<tr>
<td></td>
<td>Moment connection symbols in Tekla Structures drawings (Drawing tools) (page 355)</td>
</tr>
</tbody>
</table>

**See also**

- Customize weld type symbols (page 323)
- Define a firm folder for images and symbols (page 359)

**Change a symbol in a symbol file**

You can make changes in a symbol in a symbol file. If you do this, we recommend that you save the file with another name and save it in another folder, for example, in model, firm or project folder.

1. Depending on where you are in Tekla Structures, you can open a symbol file in Symbol Editor in several ways:
   - On the **File** menu, click **Editors --> Symbol Editor**. Open a symbol file using **File --> Open**.
   - Open the **Mark content - symbol** dialog box by double-clicking a mark in an open drawing, and selecting **Symbol** from the available mark elements list in the mark properties dialog box. Then click **Select**, select a file from the **Symbol Files** browser and click **Edit**.
   - Open the **Symbol properties** dialog box by double-clicking a symbol that you have added in a drawing. Then click **Select**, select a file from the **Symbol Files** browser and click **Edit**.

2. Modify the file in the Symbol Editor:
   a. Click symbol in slot and sketch your new symbol with drawing tools.
      You can also import AutoCAD or MicroStation files through **File --> Import**.
b. When you are happy with the symbol, point the symbol slot to check the number of the new symbol at the bottom of the window.

In many places, when adding a symbol, you need to know the number of the symbol to be able to use it.

3. Click **File --> Save As** and give a new name.
   
   You can also save the file with a new name in a new location, for example, in model, firm or project folder. We strongly recommend that you do not the original symbol files delivered with your Tekla Structures software. If you need to modify any symbols, copy the original symbol file and work on the copy, keeping the original symbol file intact.

   Tekla Structures reads the symbol files in certain search order.

4. Click **OK**.

**TIP** In Symbol Editor, you can copy symbols between symbol files (*.sym). Press Ctrl + C and select the symbol you would like to copy, then open the symbol file you want to copy to (or a new symbol file), select the location for the symbol and press Ctrl + V.

**See also**

*Define a firm folder for images and symbols (page 359)*
Create a new symbol file
In addition to the default symbol files that are delivered with Tekla Structures, you can create symbol files of your own, and save them in model, firm, or project folder, for example.

If you decide to use your own files, you can add DXK_SYMBOLPATH in the options.ini file under the model folder and define your own symbol file folder paths there. The symbol files are read in a certain search order.

1. On the File menu, click Editors --> Symbol Editor.
2. Click File --> New.
   You can also open an existing symbol file, edit it and save with a new name.
3. Create the symbol in the Symbol Editor.
4. Click File --> Save and save the symbol file in the folder that you use for keeping your symbol files.
   If you opened an existing symbol file, use File --> Save as and give the symbol file another name.

Change the symbol file in use
You can change the currently used symbol file if the current symbol file does not contain the symbols that you need.

1. Do one of the following, depending on what you are doing:
   • Open the Mark content - symbol dialog box by double-clicking a mark in an open drawing, and selecting Symbol from the available mark elements list in the mark properties dialog box.
   • Open the Symbol properties dialog box by double-clicking a symbol that you have added in a drawing.
2. Click Select next to the File box.
3. Select a new file from the Symbol Files list and click OK or double-click the file.

Add symbols in drawings
You can add symbols in your drawings. They can be represented in three different ways: without leader line, with leader line, and along line. Tekla Structures adds symbols using the properties defined in the Symbol Properties dialog box.

1. In the drawing, hold down Shift and, on the Drawing tab, click Symbol and one of the following symbol commands:
• **Symbol**: Add a symbol in the current drawing without a leader line.

• **Symbol along line**: Create a symbol along the line you define by picking two points. Then pick an insertion point for the symbol.

• **Symbol with leader line**: Add a symbol with a leader line pointing to the point you pick first.

2. Modify the symbol properties:

• **File**: Change the symbol file in use.

• **Number**: Change the symbol.

• **Symbol**: Change the color, height and angle of the symbol.

• **Frame**: Change the frame type, leader line and color.

3. Click **OK**.

4. Pick one to three points in the drawing to place the symbol. The symbol command you selected affects the number of points to pick.

**See also**

*Symbols in drawings (page 347)*

*Leader line types (page 730)*

### Customize leader line arrows

If you do not find a suitable leader line arrow in the **Arrow** list in the **Mark Properties** dialog box, you can add an arrow of your own.

First you will create the arrow symbol in the Symbol Editor, and save the created symbol in the **arrow.sym** file. Then you need to add the position of the new symbol in the **arrow.sym** file to the configuration file **arrow.txt**, which tells which arrows are available for use in your environment.

1. On the **File** menu, click **Editors --> Symbol Editor** to open the Symbol Editor.

2. Open the **arrow.sym** file located in common environment or in your environment under symbols folder.

3. Click an empty symbol slot and sketch your symbol with drawing tools. You can also import AutoCAD or MicroStation files through **File --> Import**.

4. When the symbol is completed, point the symbol slot to check the number of the new symbol at the bottom of the window.
5. Save the arrow.sym file by clicking File --> Save.

6. Click File --> Exit to close the Symbol Editor.

7. Open the arrow.txt file located in the same symbols folder as the arrow.sym file.
   The file contains a list of symbol numbers.

8. Add the number of your symbol preceded by zero (0) in the correct position and separate it with a comma:
   016,017,018,019,020,021,022,023,024,032,048,049,101,102,110,200

9. Click File --> Save to save your change.

10. Add a bitmap of the created arrow in the ..\ProgramData\Tekla Structures\<version>\Bitmaps folder on your computer.
    Use the following format in the file name:
    dr_dialog_arrow_type_022.bmp.

11. Double-click a mark in a drawing to open the Mark Properties dialog box.

12. Open the Arrow list, and you should see that the new arrow symbol is now available for use.
NOTE  We recommend you define a firm folder (page 359) for symbols, because the default folders are overwritten when you upgrade to a newer version of Tekla Structures. Add the firm folder to the advanced option DXK_SYMBOLPATH.

Modify symbol properties

You can modify the properties of symbols in an open drawing.

To modify the symbol properties:

1. Double-click a symbol.
2. Switch all the check boxes off in the dialog box by clicking the on/off switch at the bottom of the dialog box, and select only the check boxes next to the properties that you want to modify.
3. If necessary, change the symbol file in use and select the symbol to use.
4. To modify symbol placement settings, click Place.
   Here you can set the placing to free or fixed, specify the search margin, minimal distance and select the desired quarter to place the symbol.
5. Go to the Appearance tab and set the symbol color, height and angle, and the frame type, leader line and color.
6. Click Modify.
See also
- Placement properties for marks, dimensions, notes, texts and symbols (page 769)
- Leader line types (page 730)

**Moment connection symbols in Tekla Structures drawings (Drawing tools)**

Moment connections show the beams that are connected to columns with rigid connections.

To display the moment connection symbols for a part in drawings, you need to set the **Moment connection** to **Yes** on the **End Condition** tab in the user-defined attributes of the part in the model.

You can create, update and delete moment connection symbols using drawing tools:

- Create moment connection symbols (Drawing tools) (page 355)
- Update moment connection symbols (Drawing tools) (page 357)
- Delete moment connection symbols (Drawing tools) (page 358)

**Create moment connection symbols (Drawing tools)**

In general arrangement drawings, you can create moment connection symbols to show the beams that are connected to columns with rigid connections. The symbols are created according to part end releases. You can create moment connection symbols automatically for all parts in a drawing view, or for selected parts.

**Limitations:** Moment connection symbols are created to reference lines. This means that offsets are not taken into use.

1. Open the drawing.

2. Click the **Applications & components** button in the side pane to open the **Applications & components** catalog.

3. Click the arrow next to **Applications** to open the applications list.

4. Double-click **Drawing tools** to display the **Drawing tools** toolbar.

5. Click **Create moment connection symbols**.

6. In the **Create moment connection symbols** dialog box, select the color for the symbols from the color list.

7. Enter a scale for the symbols in the box next to the color list.
8. Do one of the following:
   - To create moment connection symbols for all parts in a drawing view, select the view.
   - To create moment connection symbols for selected parts, select the parts.
9. Click **Create**.

The moment connection symbols are created according to analysis part and connection release properties:

- If a connection exists, start and end release information is read from the **Start releases** and **End releases** tabs in the analysis part properties dialog box.
- If a connection does not exist, release information is read from the **End conditions** tab in the user-defined attributes dialog box of the part.

**Example**

![Diagram of moment connection symbols]

**TIP** The moment connection symbol that is used depends on if it points to right, left, down, or up. The symbols are retrieved by default from the `xsteel.sym` symbol file. If you want to use another symbol, you can modify the symbols in Symbol Editor by opening the `xsteel.sym` symbol file and modifying the symbols.
(right symbol), 86 (left symbol), 85 (down symbol), or 84 (symbol up) and saving the changes.

See also
Moment connection symbols in Tekla Structures drawings (Drawing tools) (page 355)

**Update moment connection symbols (Drawing tools)**
If you want to remove all previously created moment connection symbols and create new ones that are up to date, you can update the moment connection symbols.

1. Click the Applications & components button in the side pane to open the Applications & components catalog.
2. Click the arrow next to Applications to open the applications list.
3. Double-click Drawing tools to display the Drawing tools toolbar.
4. Click Create moment connection symbols in the Drawing tools toolbar.
5. Do one of the following:
   • To update the moment connection symbols of all parts in the view, select the view.
   • To update the moment connection symbols of selected parts, select the parts.
6. Click Create.

When you do this, Tekla Structures removes all previously created symbols, and creates new ones that are up-to-date.

See also
Moment connection symbols in Tekla Structures drawings (Drawing tools) (page 355)
Delete moment connection symbols (Drawing tools)
You can delete moment connection symbols of all parts in a view or of selected parts.

1. Click the Applications & components button in the side pane to open the Applications & components catalog.
2. Click the arrow next to Applications to open the applications list.
3. Double-click Drawing tools to display the Drawing tools toolbar.
4. Click Create moment connection symbols.
5. Do one of the following:
   • To delete the moment connection symbols of all parts in the view, select the view.
   • To delete the moment connection symbols of selected parts, select the parts.
6. Click Delete.

See also
Moment connection symbols in Tekla Structures drawings (Drawing tools) (page 355)

Add surface treatment symbols in drawings (AddSurfaceSymbols)
You can add surface treatment symbols in cast unit drawings using the AddSurfaceSymbols macro.

Before you start, ensure that you have an object that has surface treatment in the model, and that you have created a cast unit drawing of that object. Also check in the surface treatment drawing properties that the surface treatment is set to Visible.

1. Open a drawing that has a part containing surface treatment.
2. Click the Applications & components button in the side pane to open the Applications & components catalog.
3. Click the arrow next to Applications to open the applications list.
5. In the **Create surface symbols** dialog box, select the texts that you want to include in the surface treatment symbol from the **Available Elements** list and add the texts to the **Elements in mark** by clicking **Add**.

6. Select **All views** to include the symbols in all drawing views, or **Selected views** to include the symbols only in the views you select.

7. Change the font settings, if necessary.

8. If you selected **Selected views**, select the views where you wish to have surface treatment symbols.

9. Click **Create**.

Tekla Structures creates the surface treatment symbols according to the defined settings. You can change the symbol properties and the text afterwards in the **Text properties** dialog box, which is opened when you double-click the symbol.

---

**Define a firm folder for images and symbols**

You can define a firm folder where Tekla Structures always searches for the images and symbols. When you store the images and symbols in this folder, you do not have to move them from folder to folder when you install a new version of Tekla Structures. Installing a new version does not replace the files in the firm folder.

Define the firm folder in the **options.ini** file under the model folder or **user.ini** using the advanced option **XS_FIRM**.

To define the firm folder for images and symbols in the **options.ini** file:
1. Modify the options.ini file to include the advanced option DXK_SYMBOLPATH that points to the firm folder.

   The advanced option DXK_SYMBOLPATH may contain multiple paths separated by semicolons.

   Since Tekla Structures version 19.0, the folder path definitions like %DATADIR% or %XS_FIRM% in DXK_SYMBOLPATH have not converted the paths correctly when used in options.ini located in the firm folder. However, these definitions work correctly if used in user.ini. Currently you need to write the absolute paths for DXK_SYMBOLPATH in options.ini in the firm folder, like in the example below:

   DXK_SYMBOLPATH=C:\ProgramData\Tekla Structures \2017\Environments\common\symbols;C:\firm\Symbols;

2. In Template Editor, click Options --> Preferences --> File Locations and enter the path to the firm folder also for Symbols, pictures.

See also
Symbols in drawings (page 347)

4.22 Colors in drawings

   You have three basic color modes for line colors in drawings: Black and white, Gray scale, and Color. By default, drawings are black and white.

   In addition to the three basic color modes, you can have a black background and colored lines in drawings (advanced option XS_BLACK_DRAWING_BACKGROUND).

   In addition to the actual colors, you can specify a special color (page 363) that is not converted to black in printouts.

   When you are printing, you can also change the line thicknesses of different colors. This setting affects printouts but also the line thicknesses in color drawings on the screen, if you have selected Printer line widths in File menu --> Settings.

Colors and gray shades

   The table below shows the basic colors available in Tekla Structures drawings, and how the different colors are shown in black and white drawings and in grayscale drawings. The corresponding pen numbers referring to the line thicknesses used in the printed drawings are listed in the Pen column.

<table>
<thead>
<tr>
<th>Name</th>
<th>Pen</th>
<th>Tekla Structures color</th>
<th>Black and white</th>
<th>Gray scale</th>
<th>Lightness</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invisible</td>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td>Invisible</td>
</tr>
</tbody>
</table>

Edit drawings 360 Colors in drawings
<table>
<thead>
<tr>
<th>Name</th>
<th>Pen</th>
<th>Tekla Structures color</th>
<th>Black and white</th>
<th>Gray scale</th>
<th>Lightness</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td>0%</td>
</tr>
<tr>
<td>Red</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td>0%</td>
</tr>
<tr>
<td>Green</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td>0%</td>
</tr>
<tr>
<td>Blue</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td>0%</td>
</tr>
<tr>
<td>Cyan</td>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td>0%</td>
</tr>
<tr>
<td>Yellow</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td>0%</td>
</tr>
<tr>
<td>Magenta</td>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td>0%</td>
</tr>
<tr>
<td>Brown</td>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td>30%</td>
</tr>
<tr>
<td>Dark green</td>
<td>110</td>
<td></td>
<td></td>
<td></td>
<td>50%</td>
</tr>
<tr>
<td>Dark blue</td>
<td>141</td>
<td></td>
<td></td>
<td></td>
<td>70%</td>
</tr>
<tr>
<td>Blue-green</td>
<td>111</td>
<td></td>
<td></td>
<td></td>
<td>90%</td>
</tr>
<tr>
<td>Orange</td>
<td>31</td>
<td></td>
<td></td>
<td></td>
<td>100% white</td>
</tr>
<tr>
<td>Gray</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>60%</td>
</tr>
<tr>
<td>Special</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
<td>-</td>
</tr>
</tbody>
</table>

**Colors in drawing hatches**

In drawing hatches/fills, there are more gray colors available. These additional gray colors are true grays (page 662), which means that they are also printed as such.

**See also**

Change drawing color (page 361)
Print to a file, plot file (.plt) or printer (page 383)

**Change drawing color**

You can change the color of the drawings.

1. Open a drawing.

2. On the File menu, click Settings and select Black and white, Gray scale or Color.

   You can toggle between the color modes by pressing B on the keyboard.

**Example**

Below is an example of a color drawing.
In grayscale mode, the colors from 1 to 7 (black, red, green, blue, cyan, yellow, magenta) are shown in black, and the colors from 8 to 14 (brown, dark green, dark blue, blue-green, orange, gray) are shown in different shades of gray. Below is an example of a gray scale drawing.

Below is an example of a black-and-white drawing.
Specify a special color in drawings

You can define a special color that is not converted to black when printed. This color will be printed as color or grayscale, depending on the selected printer settings. The special color is defined using RGB (Red Green Blue) values in a scale of 0 to 255. The special color is applied on parts as a hatch.

You can specify a special color for a building object (part, bolt) before creating a drawing, and use it in the final drawing for a drawing shape or a building object.

1. On the File menu, click Settings --> Advanced options and go to the Hatching category.
2. Define the color using the following advanced options:
   - XS_HATCH_SPECIAL_COLOR_R
   - XS_HATCH_SPECIAL_COLOR_G
   - XS_HATCH_SPECIAL_COLOR_B
   The default value for all of the above advanced options is 230.
   The smaller the values are, the darker the shade.
3. Click OK or Apply.
4. Open a drawing.
5. Double-click a drawing object to open the properties dialog box. For example, click a building object or a rectangle.
6. Select a fill type.
7. Select the **Special** fill color.
8. Click **Modify**.
The object that you selected now uses the color that you specified.

### 4.23 Reference models in drawings

Reference models can be shown in general arrangement, assembly and cast unit drawings. For example, you may want to use 3D plant models or architectural drawings as reference models.

Click the links below to find out more:

- **Show reference models in drawings** (page 364)
- Reference models

#### Show reference models in drawings

You can select whether to show a reference model, and change the reference model appearance in the drawing view properties in an open drawing. You can select whether to show the reference model as outlines or as wireframe, set the hidden lines and own hidden lines options, and define the line color and type. Reinforcement in reference models is also shown.

The appearance options can also be modified in drawing properties before you create the drawing, but the visibility options only when a drawing is open.

1. In an open drawing, double-click the drawing view frame to open the drawing view properties.
   
   In GA drawings, you can also adjust the visibility settings on drawing level by double-clicking the drawing background.

2. Click **Reference objects** in the options tree.
   
   The **Content** tab lists all the reference models included in the model.

3. To show a reference model in the drawing, click the row of the reference model, and in the **Visibility** column, select **Visible**.

4. Go to the **Appearance** tab and select the representation for the reference model:
**Wireframe:** Shows the reference model as a wireframe. To open drawings quickly, use the wireframe.

**Outline:** The reference model is drawn in the same way as Tekla Structures native parts. It shows the reference model outline. With this option, you have the **Hidden lines** and **Own hidden lines** options available.

**Hidden lines:** Shows hidden lines in of the reference model that are hidden by other reference models or parts.

**Own hidden lines:** Shows the hidden lines in the reference model that are hidden by the reference model itself.

5. Modify the color and the type of **Visible lines** and **Hidden lines**.
6. Click **Modify** to modify the reference model in the selected view with the new settings.

You can also change the visibility and appearance settings in an open drawing by double-clicking the reference model and changing the settings in the **Reference object** properties.

Note that if you modify the reference model appearance on the object level, you can no longer modify the appearance on the view level.

**Reference model representation examples**

Below is an example of the **Wireframe** representation:

![Wireframe example](image)

Below is an example of the **Outline** representation. **Hidden lines** and **Own hidden lines** are set off:
Below is an example of the Outline representation. Hidden lines is set on, and shown in red.

Below is an example of the Outline representation. Hidden lines and Own hidden lines are both set on, and shown in red.

Below is an example of how the parts are shown with reference models. Reference model visible lines are shown in green, and hidden lines in red. The part visible lines are shown in blue, and the hidden lines in cyan.
See also

Reference models in drawings (page 364)

4.24 **User coordinate system (UCS)**

UCS is a local user coordinate system you can use in a drawing view. It is easier to position drawing objects in view, when you can place objects relative to a user-defined point of origin, or a base point, in the drawing view.

Tekla Structures shows the UCS symbol in the current drawing view, when you create, copy, move, or modify objects.

You can define a different point of origin for the UCS for each drawing view, and change the UCS point of origin as often as you like.

The following example shows several views, each with their own UCS.
NOTE To position an object using the global coordinate system, you need to calculate the coordinates of the object from the point of origin of the drawing, not a drawing view.

Click the following links to find out more:
Add manual dimensions using User Coordinate System (page 177)
Set a new UCS (page 368)
Toggle between two user coordinate systems (page 369)
Reset UCS (page 369)
Keyboard shortcuts

**Set a new UCS**
You can set a new UCS (user coordinate system) using one point or two points.
1. Open a drawing.
2. On the **Views** tab, click **User coordsys** and click one of the following commands:
   - Select **Set origin** to set the new UCS using one point.
   - Select **Set origin by two points** to set the new UCS using two points.
Tekla Structures displays the UCS symbol with a crosshair marking the center point.
3. Click the view where you want to place the origin.
4. If you are using two points, pick a point to define the direction of the x axis.

See also
User coordinate system (UCS) (page 367)
Add manual dimensions using User Coordinate System (page 177)

**Toggle between two user coordinate systems**

You can toggle between two user coordinate systems that have the same point of origin: the UCS following the axes of the drawing view and the oriented UCS you have created.

- To toggle between the coordinate systems, open a drawing, go to the **Views** tab and click **User coordsys --> Toggle orientation** (Ctrl + T).

See also
User coordinate system (UCS) (page 367)

**Reset UCS**

You can reset the UCS to its original position in the current drawing view or in all drawing views.

Do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset the UCS in the current drawing view</td>
<td>In an open drawing, go to the <strong>Views</strong> tab, and click <strong>User coordsys --&gt; Reset current</strong> (Ctrl + 1).</td>
</tr>
<tr>
<td>Reset the UCS in all drawing views</td>
<td>In an open drawing, go to the <strong>Views</strong> tab, and click <strong>User coordsys --&gt; Reset all</strong> (Ctrl + 0).</td>
</tr>
</tbody>
</table>

See also
User coordinate system (UCS) (page 367)
4.25 Save a drawing
Tekla Structures automatically saves drawings at set intervals. You can also save your drawing when ever you want to.

- In the open drawing, go to the File menu and click Save drawing.
  Both the drawing *.dg and the model *.db1 and *.db2 are saved. The drawings are saved in the \drawings folder under the model folder.

For more information about autosave, see Autosave drawings.

See also
Close drawings (page 141)

4.26 Delete unnecessary drawing files in single-user mode
By default all unnecessary drawing files are deleted automatically after seven days. You can delete all your unnecessary drawing files in the single-user mode using the command Remove unnecessary drawing files without waiting for Tekla Structures to automatically remove them.

To delete the files, you need to have full privileges. You can find the Remove unnecessary drawing files through Quick Launch.

**NOTE** If you have worked with the drawings (edited, deleted) after you saved the last time, remember to save before you use the command Remove unnecessary drawing files.

1. Search for the command Remove unnecessary drawing files in Quick Launch.
2. When Tekla Structures finds the command, select it and press Enter.
  Tekla Structures deletes all drawings that do not have a corresponding drawing in the database.

**TIP** By default, the privileges are full. If you want to restrict the command usage, add the following line in the privileges.inp file:

```plaintext
action:RemoveUnnecessaryDrawingFiles [who] [access]
[who] is everyone or <Windows_logon_name>, or <domain_name>
[access] can be none/view/full.
```

In the following example, only the administrator can use the Remove unnecessary drawing files command:
action:RemoveUnnecessaryDrawingFiles everyone none
action:RemoveUnnecessaryDrawingFiles ORGANIZATION\admin full

Edit drawings 371 Delete unnecessary drawing files in single-user mode
Depending on the workflow phase, you have several tools available for managing your drawings. You can update drawings when the model changes, lock drawings, freeze drawings, issue drawings, revise drawings, and delete drawings.

<table>
<thead>
<tr>
<th>To</th>
<th>Click the link below:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update saved drawings because of model changes</td>
<td>Update drawings when the model changes (page 372)</td>
</tr>
<tr>
<td>Indicate that a drawing is not available for editing by locking it</td>
<td>Lock drawings (page 374)</td>
</tr>
<tr>
<td>Select whether to allow Tekla Structures to update all associative objects on top of the drawing views</td>
<td>Freeze drawings (page 374)</td>
</tr>
<tr>
<td>Mark drawings ready for issuing</td>
<td>Mark drawings ready for issuing (page 376)</td>
</tr>
<tr>
<td>Mark a drawing issued when it has been released for fabrication</td>
<td>Issue drawings (page 377)</td>
</tr>
<tr>
<td>Delete a drawing that you do not need anymore</td>
<td>Delete drawings (page 381)</td>
</tr>
<tr>
<td>Revise drawings, and attach information about the changes you have made</td>
<td>Revise drawings (page 378)</td>
</tr>
</tbody>
</table>

See also
Print drawings (page 382)

5.1 Update drawings when the model changes
Saved drawings need updating because of model changes. Cast-unit, assembly, single part and multidrawings use position numbers as identifiers.
Many changes affect numbering, so many times renumbering is needed. Before updating drawings you need to ensure that the numbering is correct.

The drawings needing updates are indicated by flags in the **Drawing List**. Renumbering model objects after creating drawings may also generate flags.

**NOTE** • General arrangement drawings do not require model numbering to be updated. If you use part position numbers in part marks, you must number the model to get updated marks, because old and not up-to-date part marks have question marks in them. If you do not use numbering, you can modify general arrangement drawings without numbering. Then, for example, profile changes are highlighted with change symbols.

• When you update multidrawings, also the linked drawings are updated.

Do the following after changing the model:

1. Check the numbering settings by going to the **Drawings & reports** tab and clicking **Numbering settings** --> **Numbering settings**.
2. Select **Compare to old** for both the new and modified parts.
3. Number all model objects that have same numbering series settings on the **Drawings & reports** tab by clicking **Perform numbering** --> **Number series of selected objects**, or number only new or modified model objects by clicking **Perform numbering** --> **Number modified objects**.
4. Check the **Drawing List** for status flags.
5. To find the parts that have been affected, select each drawing marked with the **!** flag in the **Drawing List** and click the **Select objects** button. Tekla Structures highlights the affected parts in the model.

Do the following:

a. Check the numbering history log for renumbered parts by going to the **File** menu and clicking **Logs** --> **Numbering history log**.

Part or Assembly at the beginning of a line in the numbering history log indicates that Tekla Structures has renumbered parts or assemblies, as in the following example:

```
Part guid: ID66CC370F-0000-029E-3134-3536333052233 series:MC/1 MC/0 -> MC/1
Part guid: ID66CC370F-0000-029E-3134-3536333052233 series:MC/1 MC/0 -> MC/2
Part guid: ID66CC370F-0000-029E-3134-3536333052233 series:MC/1 MC/0 -> MC/3
Part guid: ID66CC370F-0000-029E-3134-3536333052233 series:MC/1 MC/0 -> MC/2
Assembly guid: ID66CC370F-0000-029E-3134-3536333052233 series:C/1 C/0 -> C/1
Assembly guid: ID66CC370F-0000-029E-3134-3536333052233 series:C/1 C/0 -> C/2
Assembly guid: ID66CC370F-0000-029E-3134-3536333052233 series:C/1 C/0 -> C/3
Assembly guid: ID66CC370F-0000-029E-3134-3536333052233 series:C/1 C/0 -> C/2
Assembly guid: ID66CC370F-0000-029E-3134-3536333052233 series:C/1 C/0 -> C/3
Assembly guid: ID66C42A49-0000-0022-3134-3536333052233 series:C/1 C/0 -> C/4
```

Manage drawings 373 Update drawings when the model changes
b. To find the renumbered parts in the model, select the relevant entries from the numbering history log. Tekla Structures highlights the corresponding parts in the model.

6. Select the affected drawings from the Drawing List and click Update.
7. If you have new parts in the model, create drawings for them.

See also
Manage drawings (page 372)
Settings affecting the recreation of drawings (page 41)

5.2 Lock drawings

You can indicate that a drawing is not available for editing by locking it. When a drawing is locked, it cannot be accidentally modified. The geometry of the locked drawing still changes when the model changes.

Tekla Structures flags locked drawings for update if the model changes.
1. In the Drawing List, select the drawings you want to lock.
2. Click Lock -- On.
   The Locked by column in the Drawing List shows who has locked the drawing. If you have logged in to your Trimble Identity, your account name is shown. Otherwise your user name is shown.
3. To unlock the drawings, select the drawings and click Lock -- Off.

See also
Select drawings in the Drawing List (page 135)

5.3 Freeze drawings

You can select whether to allow Tekla Structures to update all associative objects on top of the drawing views. The geometry of the model is always updated, but freezing is used to stop the drawing intelligence (associativity) of drawing objects on top of the model views, and prevent them from being updated. For example, parts are updated, but dimensions, marks, views, and drawing shapes are not. Use freezing only to avoid changes in drawings while updates are made in the model, not just for noting that the drawing has been edited.
<table>
<thead>
<tr>
<th>To</th>
<th>Click the link below</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freeze and unfreeze general arrangement drawings</td>
<td>Freeze general arrangement drawings (page 375)</td>
</tr>
<tr>
<td>Freeze and unfreeze single-part, cast unit and assembly drawings</td>
<td>Freeze single-part, cast unit and assembly drawings (page 375)</td>
</tr>
<tr>
<td>Find out what happens to the drawings when they are frozen</td>
<td>How freezing affects drawings (page 376)</td>
</tr>
</tbody>
</table>

**See also**

Select drawings in the Drawing List (page 135)

Update part and weld marks in drawings (page 223)

**Freeze general arrangement drawings**

1. If you have the GA drawing open, close it without saving it.
2. In the Drawing List, select the drawing you want to freeze.
3. Click Freeze --> On.
4. When freezing is no longer necessary, select the frozen drawings and click Freeze --> Off.

**See also**

Freeze drawings (page 374)

**Freeze single-part, cast unit and assembly drawings**

1. Save the model.
2. Open a drawing.
3. If the drawing does not look the way you want, close it without saving it.
4. Reopen the model. Do not save it.
5. In the Drawing List, select the drawing you want to freeze.
6. Click Freeze --> On.
7. Open the drawing.
8. When freezing is no longer necessary, select the frozen drawings and click Freeze --> Off.

**See also**

Freeze drawings (page 374)
How freezing affects drawings

Freezing affects drawings in the following way:

- The associativity does not disappear from a frozen drawing. When you unfreeze the drawing, the associativity works again.
- Freezing does not have any effect on the cloning result. If you edit the drawing, it does not matter whether you freeze the drawing before or after editing it.
- If a drawing is frozen, the associative drawing objects are not updated when the drawing is updated. This means that the dimensions and views are not updated, and the marks do not follow the parts if the parts have been moved.
- If a drawing is frozen, and the part changes in the model, the geometry of the part is updated in the frozen drawing when the drawing is updated.
- Unfreezing the drawing before cloning does not have any effect on the cloning result. This means, for example, that it does not matter whether you keep the drawing frozen all the time or temporarily unfreeze it before cloning.
- If you unfreeze a drawing before update, the drawing is updated normally.

See also

Freeze drawings (page 374)

5.4 Mark drawings ready for issuing

When a drawing is ready to be released for fabrication, you can mark it ready for issuing by using the option Ready for issuing in the Drawing list. When there are changes in the model, the geometry of the drawings marked ready for issuing is updated. You can also edit the marked drawings just like any other drawings.

1. In the Drawing list, select the drawings to be marked ready for issuing.
2. Select Ready for issuing > On.

You can also select this command from the pop-up menu.

The drawings are marked ready for issuing, and flagged with a green check mark.
in the **Ready for issuing** column in the **Drawing list**. You can check who marked the drawing from the **Ready for issuing by** column.

**TIP** You can also mark a drawing ready for issuing by selecting the **Mark drawing ready for issuing** check box in the save confirmation message box, which appears when you close an unsaved drawing.

You can add in your reports the information whether the drawing is marked ready for issuing, and who has marked it using the template attributes **IS_READY_FOR_ISSUE** and **READY_FOR_ISSUE_BY**

### 5.5 Issue drawings

When a drawing has been released for fabrication, it should be marked as issued in the **Drawing List**. The geometry of the issued drawings is updated when the model changes. Issuing only prevents the recreation of the drawing during update.

The issuing information can be used to filter what is shown in **Drawing List** and in templates.

1. In the **Drawing List**, select the drawings to be issued.
2. Select **Issue --> On**.

   Tekla Structures marks the issued drawings with a flag 🚧

   When an issued drawing has been edited or otherwise changed, the color of the flag changes 🚧 and the text **Issued drawing changed** is displayed.

**TIP** To show the issue date in a report, add the template field **DATE_ISSUE** in the appropriate report template.

**See also**

- Manage drawings (page 372)
- Select drawings in the Drawing List (page 135)
5.6 Revise drawings

When revising drawings, you can attach information about the revision changes. Tekla Structures displays this information alongside the revision number or mark. The revision date appears in the revision table. The revision number or mark is shown in the **Drawing List**, and the revision information can be included in reports. You can also add manual revision marks in an open drawing.

**TIP** One example of the report using revision information is `drawing_issue_rev.xsr`, which shows the most recent revision dates of drawings.

<table>
<thead>
<tr>
<th>To</th>
<th>Click the link below</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create revisions to follow the changes in the drawing, and show the revision information in the <strong>Drawing List</strong> and reports</td>
<td>Create drawing revisions (page 378)</td>
</tr>
<tr>
<td>Change revision information afterwards</td>
<td>Change drawing revisions (page 379)</td>
</tr>
<tr>
<td>Delete unnecessary revisions</td>
<td>Delete drawing revisions (page 379)</td>
</tr>
<tr>
<td>Add revision marks manually in an open drawing</td>
<td>Add revision marks in drawings (page 239)</td>
</tr>
</tbody>
</table>

**Create drawing revisions**

You can create revisions to follow the changes in the drawing using the Revision command in the **Drawing List**.

1. In the **Drawing List**, select the drawings to revise.
2. Click **Revision**.
   
   The **Revision Handling** dialog box is displayed.
3. Enter a mark in the **Mark** box.
   
   Marks can be numerical or alphabetical such as 1, 2, 3... or A, B, C...
4. Fill in the **Created by** information and select the creation date from the calendar that is displayed when you click the down-arrow next to the **Date** option.
5. If you need to give information about who checked and approved the drawing, enter the information in the corresponding boxes and select the appropriate dates.
6. Enter a revision description in the **Description** box.
7. Enter delivery information in the Delivery box.
8. Enter any additional information in the Info 1 and Info 2 boxes.
9. Click Create.

The revision number or mark is now displayed in the Drawing List. When you open the drawing, you can see the revision information in the revision table if there is one in the drawing.

**TIP** Each drawing has its own unique revision number, but several drawings can share the same revision mark, date, and other information. To attach the same revision information to several drawings simultaneously, select multiple drawings from the drawing list and then click the Revision button.

To show the revision mark instead of the revision number in the Drawing List, set the advanced option XS_SHOW_REVISION_MARK_ON_DRAWING_LIST to TRUE.

**See also**
Revise drawings (page 378)
Attributes used in drawing revisioning (page 380)

---

**Change drawing revisions**
You can change revision information in an existing revision.

1. Open the Drawing List and select a revised drawing.
2. Click Revision.
3. In the Revision Handling dialog box, select the number of the revision that you want to change from the Rev. No. list.
4. Change the revision information as required.
5. Click Modify.
6. Close the Revision Handling dialog box.

**See also**
Manage drawings (page 372)
Attributes used in drawing revisioning (page 380)

---

**Delete drawing revisions**
You can delete unnecessary drawing revisions.

1. Open the Drawing List, and select a revised drawing.
2. Click Revision.
3. In the **Revision Handling** dialog box, select the revision number from the list next to the **Mark** box.

4. Click **Delete**.

When you delete a revision, Tekla Structures automatically adjusts the remaining revision numbers for that drawing. The revision marks remain the change.

**See also**

*Manage drawings (page 372)*

**Attributes used in drawing revisioning**

Drawing revisioning attributes can be included in drawing templates and report templates.

All revisioning attributes and the corresponding options in the **Revision Handling** dialog box are listed below.

<table>
<thead>
<tr>
<th>Revision handling attribute</th>
<th>Option in the Revision Handling dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>MARK</td>
<td>The revision mark in the <strong>Mark</strong> box.</td>
</tr>
<tr>
<td>NUMBER</td>
<td>The revision number in <strong>Rev. No.</strong></td>
</tr>
<tr>
<td>CREATED_BY</td>
<td>The <strong>Created by</strong> information of the revision.</td>
</tr>
<tr>
<td>DATE_CREATE</td>
<td><strong>Date</strong> next to <strong>Created by</strong>.</td>
</tr>
<tr>
<td>CHECKED_BY</td>
<td>The <strong>Checked by</strong> information of the revision.</td>
</tr>
<tr>
<td>DATE_CHECKED</td>
<td><strong>Date</strong> next to <strong>Checked by</strong>.</td>
</tr>
<tr>
<td>APPROVED_BY</td>
<td>The <strong>Approved by</strong> information of the revision.</td>
</tr>
<tr>
<td>DELIVERY</td>
<td>The <strong>Delivery</strong> information of the revision.</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>The revision <strong>Description</strong>.</td>
</tr>
<tr>
<td>DATE_APPROVED</td>
<td><strong>Date</strong> next to <strong>Approved by</strong>.</td>
</tr>
<tr>
<td>INFO1</td>
<td>The <strong>Info 1</strong> text of the revision.</td>
</tr>
<tr>
<td>INFO2</td>
<td>The <strong>Info 2</strong> text of the revision.</td>
</tr>
<tr>
<td>LAST</td>
<td>The revision number of the latest revision in <strong>Rev. No.</strong>.</td>
</tr>
<tr>
<td>LAST_CREATED_BY</td>
<td>The <strong>Created by</strong> information of the latest revision.</td>
</tr>
<tr>
<td>LAST_CHECKED_BY</td>
<td>The <strong>Checked by</strong> information of the latest revision.</td>
</tr>
<tr>
<td>Revision handling attribute</td>
<td>Option in the Revision Handling dialog box</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------------------------------</td>
</tr>
<tr>
<td>LAST_DATE_CHECKED</td>
<td>The Checked by Date of the latest revision.</td>
</tr>
<tr>
<td>LAST_DATE_APPROVED</td>
<td>The approval Date of the latest revision.</td>
</tr>
<tr>
<td>LAST_DELIVERY</td>
<td>The Delivery information of the latest revision</td>
</tr>
<tr>
<td>LAST_MARK</td>
<td>The revision mark of the latest revision in the Mark box.</td>
</tr>
<tr>
<td>LAST_DESCRIPTION</td>
<td>The Description of the latest revision.</td>
</tr>
<tr>
<td>LAST_DATE_CREATE</td>
<td>The Created by date of the latest revision</td>
</tr>
<tr>
<td>LAST_APPROVED_BY</td>
<td>The Approved by information of the latest delivery.</td>
</tr>
<tr>
<td>LAST_INFO1</td>
<td>The Info 1 text of the latest revision.</td>
</tr>
<tr>
<td>LAST_INFO2</td>
<td>The Info 2 text of the latest revision.</td>
</tr>
</tbody>
</table>

See also
Create drawing revisions (page 378)

5.7 Delete drawings
If some drawings become unnecessary, you can delete them from the Drawing List. This also deletes the .dg files from the \drawings folder.

**NOTE** In some configurations, deleting drawings from the Drawing List is not allowed.

1. In the Drawing List, select the drawings you want to delete.
2. Click Delete.
3. When Tekla Structures asks you to confirm the deletion, select Yes.

**TIP** If you press down Shift while you click Delete, Tekla Structures will not ask you to confirm the deletion.

See also
Manage drawings (page 372)
Select drawings in the Drawing List (page 135)
6 Print drawings

You can print drawings as PDF files, save them as plot files (.plt) for printing with printer/plotter, or print them on a selected printer. You can also change the line thickness of different colors. Tekla Structures provides a real-time preview of drawings in the Print Drawings dialog box.

**Limitations in printing**

- You cannot print to several paper sizes at the same time using the Print Drawings dialog box. To print to several paper sizes, you need to modify the drawingsizes.dat (page 393) file.
- Drawings in previews are in color even if you select Grayscale or Black and white through File menu --> Settings).
• In an open drawing, you can only preview and print that drawing. Having a drawing open, and you open another drawing (for example, by double-clicking another drawing in the **Drawing List**), the preview may not be updated. Select the drawing again (single-click) in the **Drawing List** and the preview is then updated to match the selection.

**NOTE** You can also use the so called "old" printing functionality where you use the **Printer Catalog** dialog box and Tekla Structures printer instances. To do this, see [Print drawings using Printer Catalog printer instances (old printing)](page 399).

---

**See also**

- [Print to a .pdf file, plot file (.plt) or printer](page 383)
- [Add frames and fold marks in printouts](page 394)
- [Configuration files used in printing](page 393)
- [Customize print output file names](page 396)
- [Print drawings using Printer Catalog printer instances (old printing)](page 399)

---

### 6.1 Print to a .pdf file, plot file (.plt) or printer

You can print drawings and selected drawing areas to `.pdf` files, plot files (.plt) to be sent to a plotter/printer or to a printer. You can also change the line thickness (pen number) of the printed drawings.

1. On the **File** menu, click **Printing --> Print drawings**.
2. Load the desired printing settings from the settings list in the upper-left corner.
   You can also give the settings a new name. In this case, you need to give the new name before you modify any settings, otherwise your changes will be lost. For more information about the printing settings, see [Printing settings and search order](page 392).
3. On the displayed **Drawing list**, select the drawings that you want to print.
   Any out-of-date drawings are detected and you are asked whether to include them in the output or not. You can also print locked drawings that are up to date. If a locked drawing is not up to date, it is not possible to open or print it, and failed printout will be reported. You can print any unlocked drawing unless the status of the drawing is **Original part deleted**.
4. To show a preview of a drawing, select it from the list of drawings at the top of the **Print Drawings** dialog box.
The drawings are shown one by one in a preview. The preview shows the drawings always up to date. Use **Next** and **Previous** to scroll through the set of selected drawings.

5. Select the printing option:
   - **PDF file**: Converts drawings to PDF format.
   - **Printer**: Sends the drawings to the selected printer.
   - **Plot file**: Converts drawings to print files in a format suitable for the selected printer and saves them in a specified location.

6. Define the printing settings on the **Options** tab. The available settings depend on the printing option that you have selected:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File location</td>
<td>Enter the location for the .pdf or plot file, or use <strong>Browse</strong> to browse for the folder. The \Plotfiles folder under the model folder is the default value.</td>
</tr>
<tr>
<td>Open folder when finished</td>
<td>Open the .pdf or plot file folder in Windows Explorer after the printout has been created.</td>
</tr>
<tr>
<td>Open file when finished</td>
<td>Open the .pdf file after it has been created.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Output to single file</td>
<td>Print the selected drawings to a single .pdf file. If you do not select this option, each drawing will be printed in a .pdf file of its own.</td>
</tr>
<tr>
<td>File extension</td>
<td>Specify a file name extension for the plot file. The default is .plt.</td>
</tr>
<tr>
<td>File prefix</td>
<td>Enter a specific prefix in the file name.</td>
</tr>
</tbody>
</table>
| File suffix               | Enter a specific suffix in the file name. When you enter a prefix or suffix, the print file name preview displayed under the File prefix and File suffix boxes will reflect the change immediately.  
The print file name can be controlled by a couple of advanced option switches for customizing print file names (page 396). These switches do not work for single combined multiple drawings .pdf file. |
| Fit to paper              | Fit the drawing to a specific paper size.                                                                                                    |
| Scale                     | Define the scale to force the printout to a specific scale.  
The Scale value will turn red if the drawing cannot fit on the specified sheet.                                                              |
| Center drawing on paper   | Center the drawing on the sheet (or sheets).                                                                                                 |
| Print on multiple sheets  | Print on multiple sheets and specify the direction of printing the sheets. Select either **Left to right**, **top to bottom** or **Bottom to top, right to left**.  
When you use Print on multiple sheets, select a particular paper size.                                                                 |
| Paper size                | Define the paper size or use automatic size. With the **Auto** setting Tekla Structures selects the paper size that has the least wasted area when the scaled print is fitted to the printable area on the sheet.  
Printers are often unable to print on the full area of a sheet, and leave borders. The printable area is determined for the selected printer when the option **Printer** or **Plot file** is selected. In the case of creating a .pdf file, the printer is not known so the output is sized to the full sheet. However, when printing a .pdf, the same problem exists and the drawing content is fitted to the printable area of whatever printer is being used. The printable area is show with white background and the non-
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td><strong>printable border</strong></td>
<td>printable border is shaded gray in the image below.</td>
</tr>
<tr>
<td><strong>Orientation</strong></td>
<td>Define the orientation or use automatic orientation.</td>
</tr>
<tr>
<td></td>
<td>The Auto setting means that the orientation that wastes least space is selected automatically.</td>
</tr>
<tr>
<td><strong>Color</strong></td>
<td>Select if the output is to be Color, Black and white or Grayscale.</td>
</tr>
<tr>
<td><strong>Number of copies</strong></td>
<td>Define the number of plot file or paper copies to be printed.</td>
</tr>
<tr>
<td><strong>Collate</strong></td>
<td>Collate the printout when you are printing multiple copies.</td>
</tr>
<tr>
<td><strong>Embed fonts</strong></td>
<td>Embed the fonts in the .pdf file.</td>
</tr>
<tr>
<td></td>
<td>This ensures that fonts may be reproduced on a system that does not have the same fonts installed, but also increases the file size. In certain cases, fonts may be embedded automatically. When using non-Latin fonts, it is recommended that embedding is selected, otherwise the .pdf may not be displayed correctly.</td>
</tr>
<tr>
<td><strong>Select area</strong></td>
<td>Select a rectangular area from the drawing preview and only print that area. This option only works when you have a drawing open.</td>
</tr>
<tr>
<td></td>
<td>All settings in the dialog box also work when this option is selected, and you can change the orientation, line thicknesses, and paper size, for example.</td>
</tr>
<tr>
<td><strong>Show entire drawing</strong></td>
<td>When you have selected an area with Select area, the Show entire drawing button is displayed, and you can use it to show the entire drawing preview again.</td>
</tr>
</tbody>
</table>
7. Go to the **Line thickness** tab to map drawing colors to line thicknesses (pen numbers) and set the printout colors:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Line thickness** | Enter the line thickness for each color row in the boxes.  
Line thicknesses are expressed as a multiple of the advanced option `XS_BASE_LINE_WIDTH` value. The default value for this advanced option is 0.01 mm.  
For example, pen number 25 will give a line weight of 0.25 mm.  
In color drawings, the lines are shown with different thicknesses if the **Printer line widths** setting is selected in **File menu --> Settings**.  
You can define **Invisible** color for parts and shapes in drawings in the part or shape properties. The **Invisible** color is not shown in printouts, neither on paper nor on .pdf.  
For instructions on how to show correct line thicknesses in the drawing in the **Black and white** mode, see **Line thickness in drawings (page 389)**. |
| **Color on output** | • Set the printout color for a row by clicking a box under **Color on output** and selecting a new color.  
Different output color is often used when you just need one or two lines in color and the rest in black.  
Output colors are used when printing to printer, and when generating plot and .pdf files. The output colors are saved to and loaded from the printing settings files.  
The **Color on output** only applies when the **Color** option is set to **Color** on the **Options** tab.  
You can reset the printout colors:  
• To reset an individual printout color, click the color box under **Color on screen** on the desired row, and the **Color on output** box will change to have the same color.  
• To reset all printout colors to be the same as the colors on the screen, click the **Reset colors** button.  
For instructions on how to show correct line thicknesses in the **Black and white** mode, see **Line thickness in drawings (page 389)**. |
8. If you need to change Windows printing settings for a printer or for a plot file, click the **Properties** button and change the necessary settings.

9. Save your printing settings by using the **Save** button in the upper-left corner.

   For more information about the printing settings and the search order, see *Printing settings and search order* (page 392).

10. Click **Print** to print the drawings in .pdf format or as plot files, or to send them to a printer according to the settings you defined in the dialog box.

    Each drawing is sent to the printer as a separate print job.

**Example**

Below is an example of printing to multiple sheets. The option **Bottom to top, right to left** is selected. The numbers indicate the printing order of sheets.

![](image)

In the next example, the option **Left to right, top to bottom** is selected.
See also
Print drawings (page 382)
Customize print output file names (page 396)
Configuration files used in printing (page 393)
Printing settings and search order (page 392)
Line thickness in drawings (page 389)

Line thickness in drawings
You can set the printer line thickness (pen number) in the Print drawings dialog box, but you may have some challenges in showing the lines correctly in the drawing on screen. You can solve this issue by adjusting the printer line widths or by using some predefined printer settings in printer definition file plotdev.bin.

Change line thickness (pen width/pen number/line width) for printed drawings
You can change the line width for printing. To do this, open the Print drawings dialog box and go to the Line properties tab:
The base line width is 0.01, and this can be changed using the advanced option `XS_BASE_LINE_WIDTH`. For example, to get the line thickness of 0.25 mm, enter the number 25.

**Set the line thickness shown on the screen**

The line thickness that you see in the drawing is not the real line thickness that you get in the printed drawing. There is a way to affect how the lines are shown in the drawing.

To be able to set the pen width for the drawings in a Tekla Structures model:
1. Take old printing into use by setting the advanced option `XS_USE_OLD_PLOT_DIALOG` to `TRUE`.

2. Define the line settings for the first printer in the list.

3. Take new printing into use by setting the advanced option `XS_USE_OLD_PLOT_DIALOG` to `FALSE`.

4. Go to the **File** menu and check if the switch **Printer line widths** is active or not. This switch takes the settings from the old printer dialog settings. If the switch is not active, the line widths are only shown in black and white mode, if active, the line widths are shown for all color modes.
   
   You can toggle between color modes by pressing **B**.

   The file `plotdev.bin` in `..\ProgramData\Tekla Structures\<version>\environments\default\system` contains some predefined line thicknesses for the first printer instance. These are not the same that you use for printing, unless you use defaults in the **Print drawings** dialog box.

   You can save printer definitions file `plotdev.bin` in the current model folder or in the project and firm folders, and in a folder indicated by the advanced option `XS_DRIVE`. Tekla Structures searches first for `plotdev.bin` in the model, project and firm folders, then in the folder indicated by the advanced option.

<table>
<thead>
<tr>
<th>Without line thickness (pen number) set up in <code>plotdev.bin</code></th>
<th>With settings for line weight for the first printer in <code>plotdev.bin</code></th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>---</td>
</tr>
<tr>
<td>Grayscale</td>
<td></td>
</tr>
<tr>
<td>Black and white</td>
<td></td>
</tr>
</tbody>
</table>

See also
Change the pen numbers (line thickness) for colors (page 421)

### 6.2 Printing settings and search order

Tekla Structures printing settings in the **Print Drawings** dialog box are stored in two files: `<user>_PdfPrintOptions.xml` and `PdfPrintOptions.xml`. When you open a new model, the `PdfPrintOptions.xml` file is loaded. The changes that you make in printing settings are automatically saved in `<user>_PdfPrintOptions.xml`, and settings in this file are loaded when you re-open the model.

You can create printing settings files for different printing purposes and load them later on. You can also create and share common settings throughout an organization.

You can load existing printing settings or save the current printing settings to either an existing printing settings file or a new file. The first settings file name in the control list will be standard and any other settings file names will be listed alphabetically after this. The latest settings used are automatically saved to `<model>\attributes\<user>_PdfPrintOptions.xml` (where `<user>` is the current Windows user when the dialog box is closed. The printing settings that you save using the **Save** button are saved to the `<model>\attributes\` folder with the following names:

- The **standard file** is saved as `PdfPrintOptions.xml`.  

---

Print drawings 392 Printing settings and search order
• All other printing settings names have the filename <SettingsName>.PdfPrintOptions.xml. For example, if you use the name MyPrintingSettings, the settings will be saved as MyPrintingSettings.PdfPrintOptions.xml.

• If a file already exists it will be overwritten.

• You can move the saved printing settings files to the following locations so that other models and/or other users can access the settings:
  • XS_PROJECT
  • XS_FIRM
  • XS_DRIVER
  • XS_SYSTEM
  • XS_USER_SETTINGS_DIRECTORY

• When you open the dialog box, Tekla Structures searches the above locations in the listed order for any available settings files and adds them to the setting list.

• It will load the settings from the first of the following settings files it finds:
  • <model>\attributes\<user>_PdfPrintOptions.xml
  • <model>\attributes\PdfPrintOptions.xml
  • PdfPrintOptions.xml from the standard search locations listed above.

See also
Print drawings (page 382)

6.3 Configuration files used in printing
In printing, two configuration files are needed. They affect paper sizes and drawing sizes: PaperSizesForDrawings.dat and DrawingSizes.dat.

• PaperSizesForDrawings.dat defines a list of paper size names allowed to be used, and their dimensions. The PaperSizesForDrawings.dat file is by default located in the ..\ProgramData\Tekla Structures <version>\environments\common\system folder.

• DrawingSizes.dat provides a list of properties that should be set up to match the drawing sizes configured in the Tekla Structures drawing layout definitions. It is used to link those drawings to the paper size name that each drawing was set up for, and provides information about the drawing sizes and the margins around them. The DrawingSizes.dat file is located in the \system folder in the common, UK, Germany, US imperial and US metric environments.
Default values are provided in the files installed with the printing functionality. These values are appropriate in most cases. The optimum values depend on the details of the existing drawing layout definitions. If the printed area of the drawing needs to be moved, or if inappropriate paper sizes are selected, see instructions for adjusting values in these two files.

Make copies of the original configuration files if you want to modify the settings, and place the copies in appropriate folders. You may have several copies of the configuration files on your computer. When needed, these files are searched for and the first one found is used in the following search order:

- model folder
- project folder as defined by the XS_PROJECT advanced option
- firm folder as defined by the XS_FIRM advanced option
- system folder as defined by the XS_SYSTEM advanced option

If no files are found default values will be used.

**TIP** When making copies of the configuration files, keep them first in a test model folder. Validate the results before using them through the project, firm or environment folders. Also, keep backup copies of the configuration files in a safe location as re-installing later versions of Tekla Structures may overwrite your own settings.

### See also

- Print drawings (page 382)
- Print to a .pdf file, plot file (.plt) or printer (page 383)

## 6.4 Add frames and fold marks in printouts

You can add frames and fold marks in printed drawings. Fold marks indicate the locations where the printouts should be folded. You can select a color for the frames and fold marks.

Drawing frames and fold marks are controlled in the standard.fms file under the \system folder. There is no saving option in the **Drawing Frame Properties** dialog box, which is why the default values are located in a standard file.

1. Enter **Drawing frames and foldmarks** in the **Quick Launch** box in the upper-right corner of the Tekla Structures main window.
2. In the **Drawing Frame Properties** dialog box, select the check boxes of the frames you want to print.
3. In **Margins**, enter in millimeters the distance between each frame and the left, right, bottom, and top edge of the paper.
4. Select a color for each frame.
5. To print the fold marks, select the **Foldmarks** check box.
6. Enter in millimeters the horizontal and vertical distances of the first fold marks from the lower right corner of the outer frame, and between the other fold mark.
7. Select a color for the fold marks.
8. Click **OK**.

Below is an example of the properties dialog box contents and the standard file.

```plaintext
dia_drframe.drframe1_en 1
dia_drframe.drframe2_en 0
dia_drframe.fold_en 0
dia_drframe.x1 5.000000
dia_drframe.y1 5.000000
dia_drframe.x2 5.000000
dia_drframe.y2 5.000000
dia_drframe.pen 4
dia_drframe.x1_2 0.000000
dia_drframe.y1_2 0.000000
dia_drframe.x2_2 0.000000
dia_drframe.y2_2 0.000000
dia_drframe.pen_2 4
dia_drframe.fold_width 0.000000
dia_drframe.fold_height 0.000000
dia_drframe.fold_pen 0
```

**NOTE** There is a fixed distance value of 5 mm in drawing frame margins. Thus, if you want to use a drawing frame margin with a drawing title that sticks to the...
frame corner, you need to change not only the drawing frame margin in the Drawing Frame properties dialog box, but also the Vector between corners in the Tables dialog box ( Drawings & reports tab --> Drawing properties --> Drawing layout --> Table layouts --> Tables ).

See also
Print to a .pdf file, plot file (.plt) or printer (page 383)

6.5 Customize print output file names

You can affect the way Tekla Structures automatically names the .pdf files and plot files by using certain drawing-type-specific advanced options.

1. On the File menu, click Settings --> Advanced options and go to the Printing category.

2. Enter values for any or all of the advanced options
   XS_DRAWING_PLOT_FILE_NAME_A, XS_DRAWING_PLOT_FILE_NAME_W, XS_DRAWING_PLOT_FILE_NAME_G, XS_DRAWING_PLOT_FILE_NAME_M, or XS_DRAWING_PLOT_FILE_NAME_C.
   The letter at the end indicates the drawing type. You can also combine several values. The values are not case sensitive.

3. Click OK.

Example
Use single % around the values. The example below results in the following assembly drawing .pdf name: E_P1_PLATE_Revision=2.pdf:
XS_DRAWING_PLOT_FILE_NAME_A=E_%NAME.%_%TITLE%REV?_Revision=% %REV%.pdf

Possible values

<table>
<thead>
<tr>
<th>Value</th>
<th>Example of the result</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%NAME%</td>
<td>P_1</td>
<td>Part, assembly, or cast unit position, using the file name format prefix_number.</td>
</tr>
<tr>
<td>%DRAWING_NAME%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>%NAME.-%</td>
<td>P-1</td>
<td>Part, assembly, or cast unit position, using the file name format prefix-number.</td>
</tr>
<tr>
<td>%DRAWING_NAME.-%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>%NAME.%</td>
<td>P1</td>
<td>Part, assembly, or cast unit position, using the file name format prefixnumber.</td>
</tr>
<tr>
<td>%DRAWING_NAME.%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td>Example of the result</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>%REV%</td>
<td>2</td>
<td>Drawing revision number.</td>
</tr>
<tr>
<td>%REVISION%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>%DRAWING_REVISION%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>%REV_MARK%</td>
<td>B</td>
<td>Drawing revision mark.</td>
</tr>
<tr>
<td>%REVISION_MARK%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>%DRAWING_REVISION_MARK%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>%TITLE%</td>
<td>PLATE</td>
<td>Drawing name from the drawing properties dialog box.</td>
</tr>
<tr>
<td>%DRAWING_TITLE%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>%UDA:&lt;drawing user-defined attribute&gt;%</td>
<td>Painted</td>
<td>Value of a user-defined drawing attribute. The user-defined drawing attributes are defined in objects.inp. The actual values for the user-defined attributes are entered in the drawing-specific user-defined attributes dialog box.</td>
</tr>
<tr>
<td>%REV? - &lt;text&gt;%</td>
<td>2 - Rev</td>
<td>Adds conditional prefixes. In this example, if REV exists, Tekla Structures adds the text between ? and % to the filename.</td>
</tr>
<tr>
<td>%TPL:&lt;template attribute&gt;%</td>
<td>Base plate</td>
<td>You can use template attributes that can be found in Template Editor. The actual values for these attributes are entered in the drawing properties dialog box. Examples:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• %TPL:TITLE1%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• %TPL:TITLE2%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• %TPL:TITLE3%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• %TPL:DR_DEFAULT_HOLE_SIZE %</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• %TPL:DATE%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• %TPL:TIME%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• %TPL:DR_DEFAULT_WELD_SIZE %</td>
</tr>
</tbody>
</table>

**NOTE** The print output file name switches %DRAWING_NAME% and %NAME% that should produce an underscore in the print file name (P_1) do not work if XS_ASSEMBLY_POSITION_NUMBER_FORMAT_STRING does not use a
separator between the values (for example, %ASSEMBLY_PREFIX% %ASSEMBLY_POS%), or if XS_USE_ASSEMBLY_NUMBER_FOR is set.

To make the switches work, do the following:

- If you want to use XS_ASSEMBLY_POSITION_NUMBER_FORMAT_STRING, use a dot (.) slash (/) or hyphen (-) between the values, for example, %ASSEMBLY_PREFIX% . %ASSEMBLY_POS%, or similar.
- Leave XS_USE_ASSEMBLY_NUMBER_FOR empty.

See also

Print to a .pdf file, plot file (.plt) or printer (page 383)
Print drawings using Printer Catalog printer instances (old printing)

You can also use Tekla Structures own **Printer Catalog** printer instances for printing drawings. To do this, you need to set the advanced option `XS_USE_OLD_PLOT_DIALOG` to `TRUE`. 
Setting XS_USE_OLD_PLOT_DIALOG to TRUE takes the **Printer Catalog** dialog box in use, and printer instances need to be set.

Print drawings using Printer Catalog printer instances (old printing) 400 Customize print output file names
Setting up printers in the Microsoft Windows environment is not covered in this documentation. It is assumed that printers are set up and tested in your environment. For further information about on setting up printers, contact your system administrator.

If you prefer to print using the "new" printing functionality, see Print to a .pdf file, plot file (.plt) or printer (page 383).

Click the links below to find out more:
- Print single drawings (page 401)
- Print multiple drawings with different sizes in one go (page 404)
- Create .pdf files (page 405)
- Print to file (page 406)
- Print to multiple sheets (page 410)
- Frames and fold marks in drawings (page 413)
- Set up printer instances in Printer Catalog (page 416)
- Printing settings in Print Drawings dialog box (page 411)
- Printing tips (page 422)

## 7.1 Print single drawings

The instructions below apply when you are printing using Printer Catalog printer instances, which means that you have set the advanced option `XS_USE_OLD_PLOT_DIALOG` to `TRUE` in `File menu --> Settings --> Advanced options --> Printing`.

Before you print the drawing, check that the printer instance settings are correct and the layout contains the correct drawing size settings.

1. Open a drawing.
2. On the `File` menu, click `Print drawing`.
3. In the `Print Drawings` dialog box, select the printer instance you want to use.
4. If needed, modify the printing settings and add frames and fold marks in the printout.
5. Click `Print`.

**TIP**  Shortcut for opening the `Print Drawings` dialog box: `Shift+P`.

### Examples

To see some examples of printing single drawings, click the links below:
Example: Print on A4 in landscape (page 402)
Example: Print on A3 in portrait (page 403)
Example: Print A3 drawing on A4 paper (page 404)

See also
Frames and fold marks in drawings (page 413)
Print drawings using Printer Catalog printer instances (old printing) (page 399)
Printing settings in Print Drawings dialog box (page 411)
Set up printer instances in Printer Catalog (page 416)

Example: Print on A4 in landscape

The instructions below apply when you are printing using Printer Catalog printer instances, which means that you have set the advanced option XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings --> Advanced options --> Printing.

This example describes how you can print on A4 paper in landscape style in black and white.

NOTE In this example, it is assumed that the print area h*b is defined h being along the longer side of the paper and b being along the shorter side of the paper. When using some other printer driver you might have to change h*b values if you find out that the printer driver uses h along the short side of the paper.

1. Open a drawing and double-click the drawing background.
2. In drawing properties dialog box, click Layout.
3. Define the following settings:
   • Set Size definition mode to Specified size.
   • Set Drawing size to 287 * 200.
   • You can also use Autosize. Then you need to make sure that you have defined appropriate Fixed sizes or Calculated sizes.
4. Click Modify and OK.
5. On the File menu, click Print drawing.
6. In the Print Drawings dialog box, click the printer instance you want to use.
7. Click Add/Edit and check that the printer settings are correct:
   • Paper size: A4 210 x 297 mm
   • Print area h*b: 287 x 200
• Color: Black/white
8. Click Update.
9. Click OK.
10. Set Scaling to Scale and enter 1.
    In this case, also Scaling setting Auto would produce a similar printout because drawing size and h*b are the same.
11. Set Orientation to Landscape (or Auto).
12. Set Print area to Entire Drawing.
13. Click Print.

Example: Print on A3 in portrait

The instructions below apply when you are printing using Printer Catalog printer instances, which means that you have set the advanced option XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings --> Advanced options --> Printing.

This example describes how you can print on A3 paper in portrait style in black and white.
1. Open a drawing and double-click the background.
2. In drawing properties dialog box, click Layout.
3. Define the following settings:
   • Set Size definition mode to Specified size.
   • Set Drawing size to 287 * 410.
   • You can also use Autosize. Then you need to make sure that you have defined appropriate Fixed sizes or Calculated sizes.
4. Click Modify and OK.
5. On the File menu, click Print drawing.
6. In the Print Drawings dialog box, click the printer instance you want to use.
7. Click Add/Edit and check that the printer settings are correct:
   • Paper size: A3 297 x 420 mm.
   • Print area h*b: 410 x 287
   • Color: Black/white
8. Click Update.
9. Click OK.
10. Set Scaling to Scale and enter 1.
11. Set Orientation to Portrait (or Auto).
12. Set Print area to Entire Drawing.
13. Click Print.

Example: Print A3 drawing on A4 paper

The instructions below apply when you are printing using Printer Catalog printer instances, which means that you have set the advanced option XS_USE_OLD_PLOT_DIALOG to TRUE in File menu -- Settings --> Advanced options --> Printing.

This example describes how you can print an A3 drawing on A4 paper. This is useful, for example, when you need draft drawings that do not have to show the correct scale.

1. Open the A3 drawing.
2. On the File menu, click Print drawing.
3. In the Print Drawings dialog box, click the printer instance that you want to use.
4. Click Add/Edit, click the printer instance that you are going to use and ensure that:
   • It prints to A4 paper.
   • The Print area h*b value takes into account the printer hard margins. In this case, the Print area h*b could be 287*200.
5. If you changed any settings, click Update and OK.
   If you did not change any settings in the Printer Catalog, click OK to return to the Print Drawings dialog box.
6. Set Scaling to Auto.
   When you use Auto, and the drawing is bigger than the paper, the drawing is scaled down to fit the paper.
7. Click Print.
7.2 Print multiple drawings with different sizes in one go

You can print multiple drawings from the Drawing List, and print drawings of different sizes at the same time.

The instructions below apply when you are printing using Printer Catalog printer instances, which means that you have set the advanced option XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings --> Advanced options --> Printing.

1. In the Drawing List, select the drawings you want to print.
2. Right-click the selected drawings and select Print drawings.
3. In the Print Drawings dialog box, indicate the printer instances you want to use.
   To select several printer instances, hold down Ctrl and select the printers.
   When you select drawings of several sizes and several printer instances, Tekla Structures sends each drawing to the printer instance that is using the smallest paper size on which the drawing will fit. For example, if you have two printer instances selected, one A4 and one A3, Tekla Structures will send A4 drawings to the A4 printer instance and A3 to the A3 printer instance.
4. Set Scale to 1.
   This makes it possible for Tekla Structures to select and use the printer instance that is using the correct paper size.
5. If necessary, modify other printing settings and add frames and fold marks in the printout.
6. Click Print.

See also
Set up printer instances in Printer Catalog (page 416)
Frames and fold marks in drawings (page 413)
Print drawings using Printer Catalog printer instances (old printing) (page 399)
Print single drawings (page 401)

7.3 Create .pdf files

You can use any standard pdf printer to create .pdf files, such as pdfFactory, Win2PDF, or Adobe Acrobat. You can print several drawings at a time, and use several printer instances.

The instructions below apply when you are printing using Printer Catalog printer instances, which means that you have set the advanced option
XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings --> Advanced options --> Printing.

Before you start creating .pdf files using Adobe Acrobat, ensure that you have Adobe Acrobat and Adobe Distiller installed and configured with the Adobe Postscript Printer Driver set up to print to file. Consult your Adobe documentation for more information.

Also ensure that you have an Adobe postscript printer instance in the Tekla Structures printer catalog.

1. In the Drawing List, select the drawings of which you want to create .pdf files.
2. On the File menu, click Print drawings.
3. In the Print Drawings dialog box, select the pdf printer instances you want to use.
   If you select several printer instances, Tekla Structures sends each drawing to the printer instance that is using the smallest paper size on which the drawing will fit. For example, if you have two printer instances selected, one A4 and one A3, Tekla Structures will send A4 drawings to the A4 printer instance and A3 to the A3 printer instance.
4. If needed, modify the printing settings and add frames and fold marks in the PDF.
5. Click Print.
   Tekla Structures creates the .pdf files and saves them in the folder that you specified when you defined the printer instance. The file will have the name shown in the Drawing List with the extension ps.

Limitations
Do not use the Print to file option when you create .pdf files.

See also
Printing settings in Print Drawings dialog box (page 411)
Add an Adobe postscript printer instance (page 418)
Frames and fold marks in drawings (page 413)
Print drawings using Printer Catalog printer instances (old printing) (page 399)

7.4 Print to file
You can print to a file using a print-to-file printer instance. The file is by default printed to the \Plotfiles folder under model folder, but you can change the folder.
The instructions below apply when you are printing using **Printer Catalog** printer instances, which means that you have set the advanced option `XS_USE_OLD_PLOT_DIALOG` to `TRUE` in File menu --> Settings --> Advanced options --> Printing.

Before you start, make sure you have a printer instance set up to print to file.

1. In the **Drawing List**, select all the drawings that you want to print.
2. On the **File** menu, click **Print drawings**.
3. Click a printer instance that is set up to print to file.
4. Select the **Print to file** check box.
   
   Specify the folder. You can use the folder specified during printer instance setup or click **Browse** to locate the destination folder in the **Browse For Folder** dialog box.
   
   If you do not enter a folder, Tekla Structures creates the files in the current model folder or in the folder defined by the advanced option `XS_DRAWING_PLOT_FILE_DIRECTORY`.
5. If needed, modify other printing settings and add frames and fold marks in the printout.
6. Click **Print**.

Tekla Structures prints the selected drawings to files in the specified folder using the drawing names.

See also

- Printing settings in Print Drawings dialog box (page 411)
- Add a print-to-file instance (page 417)
- Frames and fold marks in drawings (page 413)
- Print drawings using Printer Catalog printer instances (old printing) (page 399)

### 7.5 Customize print file names

By default, Tekla Structures uses the drawing names as print file names. You can customize these file names using an advanced option indicating the drawing type, and entering switches defining the format of the print file name as a value.

To customize the filenames:

1. On the **File menu**, click **Settings --> Advanced options** and go to the **Printing** category.
2. Enter switches for the advanced options `XS_DRAWING_PLOT_FILE_NAME_A`, `XS_DRAWING_PLOT_FILE_NAME_W`,
You can also combine several switches. The switches are not case sensitive.

3. Click OK.

Example
The example below results in the filename \E\_P1\_PLATE\_Revision=2\..\x\f:\

XS_DRAWING_PLOT_FILE_NAME_A=E_%NAME.%_%TITLE%\REV%\Revision=%REV%.\x\f

See also
Switches for customizing print file names (page 408)

Switches for customizing print file names
Use the following switches when you want to customize the print file name format. If you are defining these in an .ini file, use double %%. Use single % in the Advanced Options dialog box.

<table>
<thead>
<tr>
<th>Switch</th>
<th>Example of the result</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%NAME% %DRAWING_NAME%</td>
<td>P_1</td>
<td>Part, assembly, or cast unit position, using the filename format prefix_number.</td>
</tr>
<tr>
<td>%NAME.-% %DRAWING_NAME.-%</td>
<td>P-1</td>
<td>Part, assembly, or cast unit position, using the filename format prefix-number.</td>
</tr>
<tr>
<td>%NAME.% %DRAWING_NAME.%</td>
<td>P1</td>
<td>Part, assembly, or cast unit position, using the filename format prefixnumber.</td>
</tr>
<tr>
<td>%REV% %REVISION% %DRAWING_REVISION%</td>
<td>2</td>
<td>Drawing revision number, if Include revision mark to filename is checked in the Print Drawings dialog box.</td>
</tr>
<tr>
<td>%REV_MARK% %REVISION_MARK% %DRAWING_REVISION_MARK%</td>
<td>B</td>
<td>Drawing revision mark, if Include revision mark to filename is checked in the Print Drawings dialog box.</td>
</tr>
<tr>
<td>%TITLE% %DRAWING_TITLE%</td>
<td>PLATE</td>
<td>Drawing name from the drawing properties dialog box.</td>
</tr>
<tr>
<td>Switch</td>
<td>Example of the result</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>%UDA:&lt;drawing user-defined attribute&gt;%</td>
<td>Painted</td>
<td>Value of a drawing user-defined attribute. The drawing user-defined attributes are defined in objects.inp. The actual values for the user-defined attributes are entered in the drawing-specific user-defined attributes dialog box.</td>
</tr>
<tr>
<td>%REV? - &lt;text&gt;%</td>
<td>2 - Rev</td>
<td>Adds conditional prefixes. In this example, if REV exists, Tekla Structures adds the text between ? and % to the filename.</td>
</tr>
<tr>
<td>%TPL:&lt;template attribute&gt;%</td>
<td>Base plate</td>
<td>You can use here template attributes that can be found in Template Editor. The actual values for these attributes are entered in the drawing properties dialog box. Examples:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• %TPL:TITLE1%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• %TPL:TITLE2%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• %TPL:TITLE3%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• %TPL:DR_DEFAULT_HOLE_SIZE%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• %TPL:DATE%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• %TPL:TIME%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• %TPL:DR_DEFAULT_WELD_SIZE%</td>
</tr>
</tbody>
</table>

**NOTE** The print output file name switches %DRAWING_NAME% and %NAME% that should produce an underscore in the print file name (P_1) do not work if XS_ASSEMBLY_POSITION_NUMBER_FORMAT_STRING does not use a separator between the values (for example, %ASSEMBLY_PREFIX %ASSEMBLY_POS%), or if XS_USE_ASSEMBLY_NUMBER_FOR is set.

To make the switches work, do the following:

- If you want to use XS_ASSEMBLY_POSITION_NUMBER_FORMAT_STRING, use a dot (.) slash (/) or hyphen (-) between the values, for example, %ASSEMBLY_PREFIX%.%ASSEMBLY_POS%, or similar.
- Leave XS_USE_ASSEMBLY_NUMBER_FOR empty.

**See also**

- Customize print file names (page 407)
- Objects.inp properties
7.6 Print to multiple sheets

If your drawing is very large, you can print it on multiple sheets. With correct scaling settings, Tekla Structures automatically calculates the required amount of sheets.

The instructions below apply when you are printing using Printer Catalog printer instances, which means that you have set the advanced option XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings --> Advanced options --> Printing.

Before printing to multiple sheets, make sure that the layout of the drawing supports printing on several smaller sheets. Remember that Tekla Structures automatically adds a 5 mm margin to the printouts.

Also ensure that you have set up the printer instance correctly for printing to multiple sheets.

1. Open a drawing.
2. On the File menu, click Print drawing.
3. In the Print Drawings dialog box, select the printer instance you want to use.
4. Select the Print on multiple sheets option.
5. In Scaling, set Scale = 1. This preserves the scale. The number of sheets is rounded up.

Do not use Auto when you print to multiple sheets.

Tekla Structures calculates the required amount of sheets needed to print the drawing.

6. If needed, modify other printing settings and add frames and fold marks in the printout.

If you set Orientation to Auto, Tekla Structures selects an orientation that results in the smallest number of printed sheets.
Tekla Structures prints the drawing to multiple sheets so that it prints the lower right corner the first, and the upper left corner the last (see the numbered sheets in the example below).

If you want to have drawing frames and/or the title blocks for each smaller size sheet, you need to use proper table layout as shown in the example below.

**TIP** Use the advanced option `XS_PRINT_MULTISHEET_BORDER` to set borders that are left out from the smaller sheets.

See also

- Printing settings in Print Drawings dialog box (page 411)
- Print drawings using Printer Catalog printer instances (old printing) (page 399)

### 7.7 Printing settings in Print Drawings dialog box

The Print Drawings dialog box contains options for setting up printing. This dialog box is only displayed if you have set `XS_USE_OLD_PLOT_DIALOG` to `TRUE` in **File menu --> Settings --> Advanced options --> Printing.**
### Setting | Description
--- | ---
Print to file | Prints the drawing to a file.
Include revision mark to file name | Adds the latest revision of the printed drawing to the filename. Revision number is used by default. However, if you set the advanced option XS_SHOW_REVISION_MARK_ON_DRAWING_LIST to TRUE, the revision mark is used.
Scaling | **Auto** fits the drawing to the **Print area h*b** size, i.e. fits it to the paper. This is useful, for example, when you are printing draft drawings on A4. With this option you can include everything in the printout, but the scale of the drawing may be affected as drawing size is fitted to the **Print area h*b**. With **Auto**, if the drawing size is smaller than the paper, the drawing is scaled up to fill the defined **Print area h*b**, keeping the aspect ratio.
### Setting | Description
--- | ---
Entering an exact scale in the **Scale** box scales the drawing manually to the defined scale. Examples on **Scale**: 1.0 = 100%, 0.9 = 90%
**Print on multiple sheets** | Prints the drawing on multiple small sheets.
**Number of copies** | Defines the number of copies.
**Orientation** | **Auto** orientates the drawing to suit the paper. **Landscape** prints the drawing horizontally - as it is displayed on the screen. **Portrait** prints the drawing vertically.
**Print area** | **Entire drawing** prints the entire drawing. **Visible area** prints the area visible in the current drawing window.
**Add/Edit** | Add (page 416) or delete printer instances, or modify their settings.
**Frames** | Opens a dialog box where you can select to print frames and fold marks (page 413).
**Printer setup** | Opens the Windows print setup dialog box where you can change the printing settings for the current Tekla Structures session only. The changes that you make are not saved for the printer permanently.

### 7.8 Frames and fold marks in drawings
You can have a frame around drawing contents, or two drawing frames inside each other. You can add default Tekla Structures frames around the drawing contents, or use DWG/DXF files in the table layouts as drawing frames.

You can add frames and fold marks only when the advanced option **XS_USE_OLD_PLOT_DIALOG** is set to **TRUE** (old printing).

You can create fold marks as guides for folding printed drawings. They are small lines between and perpendicular to the drawing frames.
1. Frame
2. Fold mark

See also
Add frames and fold marks in printouts (page 414)
Add a DWG/DXF file in a drawing table layout (page 445)

Add frames and fold marks in printouts
You can add frames around printed drawings, and fold marks to indicate folds. You can select a color for the frames and fold marks.

The instructions below apply when you are printing using Printer Catalog printer instances, which means that you have set the advanced option XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings --> Advanced options --> Printing. If this advanced option is set to FALSE, you are using the newer printing functionality, where you cannot set the frames and fold marks through the Print Drawings dialog box.

Drawing frames to be printed are controlled in the standard.fms file under the system folder. There is no saving option in the Drawing Frame Properties dialog box, which is why the default values are located in a standard file.

1. On the File menu, click Printing --> Print drawings.
2. In the Print Drawings dialog box, click Frames.
3. In the Drawing Frame Properties dialog box, select the check boxes of the frames you want to print.
4. In Margins, enter in millimeters the distance between each frame and the left, right, bottom, and top edge of the paper.
5. Select a color for each frame.
6. To print the foldmarks, select the Foldmarks check box.
7. Enter in millimeters the horizontal and vertical distances of the first foldmarks from the lower right corner of the outer frame, and between the other fold mark.

8. Select a color for the fold marks.

9. Click OK.

Below is an example of the properties dialog box contents and the standard file.

```plaintext
dia_drframe.drframe1_en 1
dia_drframe.drframe2_on 0

dia_drframe.fold_en 0
dia_drframe.x1 5.000000
dia_drframe.y1 5.000000
dia_drframe.x2 5.000000
dia_drframe.y2 5.000000
dia_drframe.pen 4
dia_drframe.x1_2 0.000000
dia_drframe.y1_2 0.000000
dia_drframe.x2_2 0.000000
dia_drframe.y2_2 0.000000
dia_drframe.pen_2 4
dia_drframe.fold_width 0.000000
dia_drframe.fold_height 0.000000
dia_drframe.fold_pen 0
```

**NOTE** There is a fixed distance value of 5 mm in drawing frame margins. Thus, if you want to use a drawing frame margin with a drawing title that sticks to the frame corner, you need to change not only the drawing frame margin in the **Drawing Frame properties** dialog box, but also the **Vector between corners**
in the Tables dialog box (Drawings & reports tab --> Drawing properties --> Drawing layout --> Table layouts --> Tables).

See also

Table layouts (page 430)

7.9 Set up printer instances in Printer Catalog

You need to set up printer instances in Printer Catalog for different purposes: for printing to .pdf, to print file, or to different printers, and to print in different sizes.

You can only set up Tekla Structures printer instances in Printer Catalog if you have set the advanced option XS_USE_OLD_PLOT_DIALOG to TRUE in File menu > Settings > Advanced options > Printing. If this advanced option is set to FALSE, you are using the newer printing functionality, and the Printer Catalog is not available.

Tekla Structures uses Microsoft Windows printer drivers to write the printed data directly to a printer, print file or .pdf.

There are two steps in setting up printer instances in Tekla Structures:

• First, you need to add a printer instance (page 416) in the Printer Catalog. By default, several printer instances are already defined.
• Next, you need connect the printer instances to printer drivers and adjust the printer instance settings such as paper size and print area (page 419). You can also connect one printer driver to several printer instances, for example, to print in different sizes on the same printer.

See also

Add a print-to-file instance (page 417)
Add an Adobe postscript printer instance (page 418)
Line thickness (pen number) in Color Table (page 420)

Add a printer instance

You need to add printer instances in Printer Catalog to be able to print. This applies to printing when the advanced option XS_USE_OLD_PLOT_DIALOG is set to TRUE.

The instructions below apply when you are printing using Printer Catalog printer instances, which means that you have set the advanced option XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings --> Advanced options --> Printing.
1. On the File menu, click Printing --> Printer catalog.
2. In Printer Catalog, click an existing printer instance that has similar settings to the one you want to add.
3. Enter a new name for the new printer instance in the box under the Printer instances list.
4. Click Add.
5. Click Browse to access the Select Printer dialog box, which shows a list of Microsoft Windows printer drivers currently configured in your system.
6. Click a printer driver and then OK.
7. Select the paper size (page 419).
8. Enter the print area (page 419) in Print area h*b (height and width).
9. If necessary, use Offset for print origin to move the drawing print origin.
10. Select Black/white, Gray Scale or Color.
   If you select Color, Tekla Structures prints lines with the colors defined in the drawing properties.
11. Click Color table to map pen size to the on-screen line color. The background color is not printed.
12. Click Update.
13. Click OK.
14. Confirm that you want to save changes to the model folder.

See also
Print drawings using Printer Catalog printer instances (old printing) (page 399)
Define printing paper size and print area h*b (page 419)
Line thickness (pen number) in Color Table (page 420)

Add a print-to-file instance
To print to a file, you need to add a print-to-file printer instance in Printer Catalog. This applies to printing when the advanced option XS_USE_OLD_PLOT_DIALOG is set to TRUE.

1. On the File menu, click Printing --> Printer catalog.
2. In Printer Catalog, click Add.
3. Enter a printer instance name for the printer driver, followed immediately (no spaces) by @path\folder\. The folder must already exist. For example, 11X17@d:\small\
You can also leave the folder out. If you do this, Tekla Structures prints the file in the current model folder or in the folder specified for the advanced option `XS_DRAWING_PLOT_FILE_DIRECTORY`.

**WARNING** `XS_DRAWING_PLOT_FILE_DIRECTORY` overrides the folder defined in the **Printer Catalog**.

4. Click **Add**.
5. Click **Browse** to access the **Select Printer** dialog box and click a printer driver that is configured to print to file and then click **OK**.
6. In **Paper size**, select **By print area**.
7. Enter the print area (page 419) in **Print area h*b** (height and width).
8. Enter a file name extension, for example, `.plt` for a print file.
9. Select **Color**, **Gray Scale** or **Black/white** as the color.
10. Click **Color table** to change the pen sizes of different colors, if needed.
11. Click **Update**.
12. Click **OK**.
13. Confirm that you want to save changes to the model folder.

**TIP** One way to send different drawing sizes to different folders is to set up a Microsoft Windows printer to print to file for each paper size you will use. Enter a different destination folder for each paper size in the **Printer instances** in Tekla Structures.

**See also**

- Print drawings using Printer Catalog printer instances (old printing) (page 399)
- Define printing paper size and print area h*b (page 419)
- Line thickness (pen number) in Color Table (page 420)
- Print to file (page 406)

**Add an Adobe postscript printer instance**

To print to a `.pdf` file, you need to add a Adobe postscript printer instance in **Printer Catalog**. This applies to printing when the advanced option `XS_USE_OLD_PLOT_DIALOG` is set to **TRUE**.

The instructions below apply when you are printing using **Printer Catalog** printer instances, which means that you have set the advanced option...
XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings --> Advanced options --> Printing.

1. On the File menu, click Printing --> Printer catalog.
2. In Printer Catalog, click Add.
3. Enter a new printer instance name followed immediately (no spaces) by @ and the folder where Adobe Distiller should look for files. For example, A4_PDF@c:\plots\pdf\in\.
4. Click Add.
5. Click Browse to access the Select Printer dialog box. Click the Adobe postscript printer driver and then OK.
6. Set Paper size to By print area.
7. Enter the print area (page 419) in Print area h*b (height and width).
8. Enter the file name extension ps.
9. Select Black/white, Gray Scale or Color as the color.
10. Click Color table to change the pen sizes of different colors, if needed.
11. Click Update.
12. Click OK.
13. Confirm that you want to save the changes to the model folder.

See also
Print drawings using Printer Catalog printer instances (old printing) (page 399)
Define printing paper size and print area h*b (page 419)
Line thickness (pen number) in Color Table (page 420)
Create .pdf files (page 405)

Define printing paper size and print area h*b
You need to define paper size and print area h*b for each printer instance you add in Printer Catalog. This applies to printing when the advanced option XS_USE_OLD_PLOT_DIALOG is set to TRUE.

The instructions below apply when you are printing using Printer Catalog printer instances, which means that you have set the advanced option XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings --> Advanced options --> Printing.

1. On the File menu, click Printing --> Printer catalog.
2. In the Printer Catalog, select the printer instance.
3. Use the Paper size setting to select the paper size used in printing:
• **Named paper size:** Tekla Structures lists a named paper sizes for most sizes A3 and smaller. Selecting one of the listed sizes is recommended for A3 printers and smaller.

• **By print area:** The printer selects the paper size based on the print area. This option is recommended for A2 printers and larger. If you use a named paper size with a larger printer than A3, drawings larger than the print area are cropped to the size of the print area.

• **None:** Sends no size information to the printer. This option provides legacy support for Xsteel 5.0 and is not recommended for use in other circumstances.

4. **Enter the Print area h*b:**

   • Tekla Structures uses the print area values to position the printout on the paper. Ensure that the values for h and b relate to the paper size required.

   Usually the value is the paper size less the hard clip margins of the printer. For example, if the paper size is 297*420, the print area could be 407 * 284. See your printer documentation for the hard clip margins of your printer.

   • Usually for roll feed printers, h defines the roll width direction and b defines the roll feed direction. Usually for tray feed printers, h defines the tray feed direction, and b defines the tray width direction. Enter the values, and test how the printing works. If you can see, that the direction is wrong, switch the h and b values.

   • When you are printing from Tekla Structures, it uses the values set for the printer in the Tekla Structures printer instance settings in the **Printer Catalog**, and overrides for these settings the Windows printer settings.

5. **Click OK and confirm the change.**

**TIP** To print to different paper sizes, you can define several printer instances, each using a different paper size, but all connected to the same physical printer. For more information about setting up print devices in Microsoft Windows, see your operating system documentation.

**See also**

Add a printer instance (page 416)

Printing tips (page 422)

**Line thickness (pen number) in Color Table**

You can only set Tekla Structures pen numbers in the **Color Table** of **Printer Catalog** if you have set the advanced option **XS_USE_OLD_PLOT_DIALOG** to...
TRUE in File menu > Settings > Advanced options > Printing. If this advanced option is set to FALSE, then you are using the newer printing functionality, and the Printer Catalog is not available.

Pen numbers in the Color Table dialog box refer to the line weights used in the printed drawing. By default, pen number 0 corresponds to a line weight of 0.01 mm. The final line weight in a printed drawing is the default pen thickness multiplied by the pen number. For example, pen number 25 will give a line weight of 0.25 mm.

- The line thicknesses displayed on the screen are taken from the first printer instance on the Printer instances list in the Printer Catalog. When you print a drawing, the line thickness is taken from the printer instance you use for printing.
- In color drawings, the lines are shown with different thicknesses if the Printer line widths check box is selected in File menu --> Settings.
- In black and white drawings, Tekla Structures shows the black lines on the screen using pen number thickness defined for the color in the Color Table.
- You can change the default line thickness using the advanced option XS_BASE_LINE_WIDTH.

See also
Change the pen numbers (line thickness) for colors (page 421)

Change the pen numbers (line thickness) for colors
You can change the pen numbers for colors in Printer Catalog to show and print lines with different thicknesses. This applies to printing when the advanced option XS_USE_OLD_PLOT_DIALOG is set to TRUE.

The instructions below apply when you are printing using Printer Catalog printer instances, which means that you have set the advanced option XS_USE_OLD_PLOT_DIALOG to TRUE in File menu --> Settings --> Advanced options --> Printing.

1. Open a drawing.
2. On the File menu, click Printing --> Printer catalog, and select a printer instance.
3. Click Color table
4. Enter or change a pen number.
   For example, to get line weight of 0.25 mm, enter 25.
   You can change the default line thickness 0.01 using the advanced option XS_BASE_LINE_WIDTH.
5. Click OK.
6. In a color drawing, on the **File** menu, click **Settings** and select **Printer line widths**, otherwise you cannot see the changes on the screen.

**See also**
- Change drawing color (page 361)
- Colors in drawings (page 360)
- Line thickness (pen number) in Color Table (page 420)

### 7.10 Printing tips

Here are some tips that help you print drawings the way you want.

- If you are printing a drawing to a smaller paper, the line weights are scaled accordingly. This means that no lines are drawn too thickly and the drawings are more readable.

- You can force a drawing to use a different size paper: Open the drawing and go to **Drawing Properties --> Layout**. In **Size definition mode**, select **Specified size**. Insert the required sheet size into **Drawing size**.

- If a drawing does not fit to the paper or is printed to a wrong location, use the **Offset for print origin** option in the **Printer Catalog** to move the drawing print origin for the selected printer instance.

  The advanced options **XS_PLOT_ORIGIN_MOVE_X** and **XS_PLOT_ORIGIN_MOVE_Y** move the print origin in the x or y direction for all printer instances. If you set values for the advanced options, they are used instead of the **Offset for print origin** value.

- You can disable the print date information to prevent the loss of information when working with multi-user models. This is useful in cases where a user modifies drawings while another user prints the same drawings. Use the **XS_DISABLE_DRAWING_PLOT_DATE** to disable the print date.

- You can add several Windows printer drivers for the same physical printer, and define an exact paper size for each printer driver in Windows printer driver printing preferences or printing defaults. Then in Tekla Structures, you can set printer instances so that you select the printer driver that matches the desired paper size. See the table at the end.

- If you only have one Windows printer driver for one physical printer, define the largest paper size you are going to use for that printer driver in Windows printer driver printing preferences or printing defaults, for example, A0. Then in Tekla Structures, you can use that one printer driver, and set several printer instances for it, each using the necessary paper size. See the table below.
<table>
<thead>
<tr>
<th>Physical printer</th>
<th>Windows printer drivers</th>
<th>Tekla Structures printer instances</th>
</tr>
</thead>
<tbody>
<tr>
<td>One printer.</td>
<td>Separate Windows printer drivers for each needed size.</td>
<td>Separate Tekla Structures printer instances are defined for each needed size, each printer instance is using the printer driver with a matching paper size.</td>
</tr>
</tbody>
</table>
| ![Printer Icon] | - A0  
- A1  
- A2  
- A3  
- A4 | ![Printer Icon] |
| ![Printer Icon] | One Windows printer driver. The printer driver is set to the biggest needed paper size. | Separate Tekla Structures printer instances are defined for each needed size, the same printer driver is used for each printer instance. |
| ![Printer Icon] | - A0 | ![Printer Icon] |

See also
- Print drawings using Printer Catalog printer instances (old printing) (page 399)
- Set up printer instances in Printer Catalog (page 416)
Define automatic drawing settings

Drawing settings tell Tekla Structures what the drawing should look like and what it should include. Automatic drawing settings are defined before drawings are created.

**Automatic drawing settings**

Automatic drawing settings are settings that are defined through:

- Drawing, view and object properties in various drawing types. The properties are stored in properties files. Properties can be defined separately for each drawing that you create, but it is advisable to save the most commonly used settings in properties files for future use, for example, in **Master Drawing Catalog**. When creating a new drawing, always start by loading automatic drawing properties that you think contain the best settings for the drawing you are creating, and then adjust the settings as required before creating the drawing. Properties can be adjusted also after you have created the drawing.

  You can open the drawing properties dialog boxes for setting the automatic drawing properties by going to the **Drawings & reports** tab, **Drawing properties** and then selecting the drawing type.

- Drawing settings that are defined through various options and advanced options in **Options** and **Advanced Options** dialog boxes.

- Additional settings files, such as `rebar_config.inp` (page 760) for setting reinforcement, and `hatch_types1.pat` (page 655) for setting hatch patterns.

**Single-part, assembly and cast unit drawing properties**

These drawings contain two types of automatic properties: drawing-specific and view-specific. **Drawing-specific properties** apply to the whole drawing: coordinate system, coordinate system rotation, drawing titles, drawing layout, user-defined properties, protection settings, and some detail and section view properties.
View-specific properties are defined separately for each view that you select to create. For example, you might want to show marks in one view, dimensions in another, and surface treatment in the third one. You can create as many views as you need.

To specify the drawing views to create and the properties to use, follow the path shown in the image below. First select the views to create and select view properties to be used for the views. If you need to adjust view properties or create new ones, click View properties and adjust the view properties, including dimensions, filters, marks and objects. Always use Save to save the view properties, otherwise your changes are not saved.
Drawing-level and view-level properties in single-part, assembly and cast unit drawings can be modified in an open drawing by double-clicking the drawing background or the view frame, respectively. The available properties are the same as in the dialog boxes shown above.

**General arrangement drawing properties**

Automatic drawing properties for general arrangement drawings can be defined on drawing level before creating the drawing. You can modify the drawing level properties in an open drawing by double-clicking the drawing background.
You select the views that you want to create after activating the creation of a general arrangement drawing. You can adjust the view-level properties in an open drawing by double-clicking a view frame.
Individual dimension, mark and object properties

You can modify the dimension, mark and object properties manually in an open drawing and save the changed properties in properties files to be use later on for different purposes.

Define automatic drawing settings 428  Printing tips
8.1 Drawing layout

A drawing layout defines which drawing tables to include in the drawing, and the set of rules for increasing the drawing size when necessary. The layout connects a set of drawing table layouts to drawing sizes. Tekla Structures selects the smallest defined drawing size that will fit the drawing views and the connected table layout. This tells Tekla Structures which elements to include in the drawing automatically.

Each drawing layout has its own:

- Table layouts
- Fixed drawing sizes
- Calculated drawing sizes

Tekla Structures has several predefined drawing layouts. Each drawing type; assembly, single-part, cast unit, general arrangement, and multidrawing, has its own layouts. You can also create customized layouts.

Using different layouts you can, for example, set assembly drawings to use A1 and A2 size drawing sheets, and single-part drawings to use A3 and A4 sheets.
Another example is that you may want to include a material list in assembly drawings, but not in general arrangement drawings.

Tekla Structures saves the new layouts you create in separate files with the file name extension .lay. The layout files are located in the \attributes folder in the model folder. You can copy them to project or firm folders defined by advanced options XS_FIRM and XS_PROJECT.

<table>
<thead>
<tr>
<th>To</th>
<th>Click the link to find out more</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find out what a table layout is and what it may contain</td>
<td>Table layouts (page 430)</td>
</tr>
<tr>
<td>Find out what tables in the table layout are and what kind of things you can include in the tables</td>
<td>Tables in drawing layout (page 432)</td>
</tr>
<tr>
<td>Define a new drawing layout consisting of the table layout, including tables</td>
<td>Create a new drawing layout, add table layouts and tables (page 433)</td>
</tr>
<tr>
<td>Find out the things to consider when you replace a table with another one in a table layout</td>
<td>Replace a table with another one in table layout (page 440)</td>
</tr>
<tr>
<td>Define where the tables are located in the table layout</td>
<td>Set the location of tables in a drawing table layout (page 441)</td>
</tr>
<tr>
<td>Add key plans in a table layout</td>
<td>Key plans (page 443)</td>
</tr>
<tr>
<td>Add DWG/DXF files in a table layout</td>
<td>Add a DWG/DXF file in a drawing table layout (page 445)</td>
</tr>
<tr>
<td>Modify tables in Template Editor</td>
<td>Edit tables in Template Editor (page 446)</td>
</tr>
<tr>
<td>Change the drawing layout</td>
<td>Select a new layout for your drawing (page 446)</td>
</tr>
<tr>
<td>Check the drawing layout properties</td>
<td>Layout properties (page 690)</td>
</tr>
<tr>
<td>Add frames and fold marks in a drawing</td>
<td>Add frames and fold marks in printouts (page 414)</td>
</tr>
<tr>
<td>Add a Tekla Structures label in the drawing layout</td>
<td>XS_PRODUCT_IDENTIFIER</td>
</tr>
</tbody>
</table>

**Table layouts**

A table layout is a group of tables or templates included in a drawing of a certain type and size.

The layout defines:

- Which tables are included in the drawing
- Where the tables are located in the drawing
How much space Tekla Structures leaves between the drawing frame and views and between the drawing views

Table layouts define the background of the drawing, not the number or location of the drawing views to include.

You can use the same table layout with different drawing sizes, or give each drawing size its own table layout. For example, if the number of views changes in a drawing and Tekla Structures chooses a new drawing size, Tekla Structures may also choose another table layout automatically.

The examples below illustrate the relationship between the table layout and drawing views. The drawing views are blue, and the elements of the table layout are green.

Below is an example of a GA drawing layout.

1. General arrangement drawing view
2. Part list on assembly or cast unit level
3. Revision table and title block

Below is an example of an assembly drawing layout.
1. Margins between the drawing frame and the outermost views
2. Spaces between the views
3. Top view
4. Front view
5. Section views A-A and B-B
6. Drawing frame
7. Key plan
8. Revision table
9. Material list
10. Drawing title block
11. Table layout consists of several elements
12. Fold marks

See also
Create a new drawing layout, add table layouts and tables (page 433)
Replace a table with another one in table layout (page 440)
Set the location of tables in a drawing table layout (page 441)

Tables in drawing layout
Tables are Template Editor templates included in Tekla Structures drawings. Tables contain information on model objects.
The term table refers to various elements of the drawing layout, such as:

- Tables (such as revision tables)
- Title blocks
- Lists (such as part and bolt lists)
- General notes
- Key plans
- DWG/DXF files

If you change the model, Tekla Structures updates the contents of the affected drawings and tables. The contents of the tables are filled in by Tekla Structures at run time. You can create tables in Template Editor, where the tables are referred to as templates.

The available graphical templates are read from the following folders in the following order, and shown in the Available tables list in the Tables dialog box:

- Template directory (XS_TEMPLATE_DIRECTORY)
- Current model folder
- Project folder (XS_PROJECT)
- Firm folder (XS_FIRM)
- Environment-specific system templates folder (XS_TEMPLATE_DIRECTORY_SYSTEM)
- System folder (XS_SYSTEM)

See also

- Edit tables in Template Editor (page 446)
- Set the location of tables in a drawing table layout (page 441)
- Create a new drawing layout, add table layouts and tables (page 433)

Create a new drawing layout, add table layouts and tables

If none of the predefined drawing layouts meets your needs, you can create a new one from scratch or on the basis of an existing drawing layout. After creating the drawing layout, you can add table layouts in it, and then add the necessary tables in the table layouts.

The following workflow with take you through the steps of:

- Creating a new drawing layout.
- Adding table layouts in the new drawing layout. Here you also specify the margins between the outermost views and the drawing frame, and the
spaces between two drawing views. In addition, you need to define fixed drawing sizes and calculated drawings sizes for the table layouts.

- Adding tables in table layouts.

**Create a new drawing layout**

1. On the **Drawings & reports** tab, click **Drawing properties --> Drawing layout**.

2. Do one of the following in the **Layout** dialog box:
   - Create a new layout from scratch:
     a. Enter the name of the new layout in the box under the list of layouts.
     b. Click **Add**.
     The new layout is empty.
   - Create a new layout on the basis of an existing layout:
     a. Select a layout from the list.
     b. Enter a new name for the new layout in the box under the list of layouts.
     c. Click **Add**.
     The content of the new layout is the same as that of the layout you selected from the list.

Below, a new drawing layout is created on the basis of an existing layout.

3. Click **Apply** when done.
Add new table layouts

Now that you have created a new drawing layout, you can add table layouts in the drawing layout.

1. In the Layout dialog box, select the desired drawing layout from the list.
2. Click Table Layout to open the Table Layouts dialog box.
3. Create a new layout by entering the name of the table layout and clicking Add.

   One drawing layout may have several table layouts. You can, for example, create one table layout for each paper size.

4. Enter the margins between the drawing frame and the outermost views in the Width and Height boxes.
5. Adjust the space between two drawing views in the Horizontal and Vertical boxes.
6. Repeat steps 3 - 5 for each table layout.
7. Click Update and OK.
8. In the Layout dialog box, select the drawing layout, click Fixed sizes, define fixed drawing sizes, and connect the fixed drawing sizes to table layouts.

   Fixed sizes use specific drawing sizes.
9. Click **Update** and **OK** when done.

10. In the **Layout** dialog box, select the drawing layout, click **Calculated sizes** and define the necessary drawing size calculations, and connect the drawing sizes to table layouts.

    Calculated sizes are rules that Tekla Structures follows when it automatically adjusts the drawing size.

11. Click **OK** when done.

**Add tables to table layouts**

When you have created the necessary table layouts, you can add tables in the created table layouts.

1. In the **Layout** dialog box, select the desired drawing layout from the **Layouts** list and click **Table layout**.
2. Select a table layout from the list.
3. Click **Tables** to open the **Tables** dialog box.
4. Select the tables that you want to include in the table layout from the **Available tables** list and add them to the **Chosen tables** list using the right arrow.
5. Select a table from the **Chosen tables** list and define its location in the table layout by selecting one of the table corners as its reference point in the **Table** area, and by selecting the reference point of the reference object in the **Reference** area.
6. Set the scale of the selected table.
   You can scale tables created with the Template Editor and DWG/DXF files to different sizes. Each table and DWG/DXF file in a table layout can have its own scale. The values you enter determine the size of the scaled object relative to the original.
7. Set the transparency of the selected table.
   A transparent table can overlap with another table, view, or drawing object. For example, if you use DWG/DXF drawing frames, you should make them transparent. Otherwise you will not be able to locate any other objects inside the frames.
8. Define the horizontal and vertical distance of the selected table from the reference object.
9. Click **Update**.
10. Repeat the steps 5 - 9 for each table you add in the table layout.
11. Click **OK**.
12. Click **Update** and **OK** in the **Table Layouts** dialog box.
13. Click **OK** in the **Layout** dialog box.

You have now created a new drawing layout to be used for creating drawings.

Now you can use the new layout in your drawings.

**See also**

- Drawing layout (page 429)
- Define fixed drawing sizes and connect layouts (page 438)
- Define calculated sizes and connect layouts (page 439)

**Define fixed drawing sizes and connect layouts**

When a drawing layout uses fixed drawing sizes, it has a specific size (width and height), and a specific table layout. You can use fixed drawing sizes in autosizing the drawings.

Use fixed sizes when you print drawings to small (A4 and A3) printing devices. Single-part and assembly drawings typically use fixed drawing sizes.
1. On the **Drawings & reports** tab, click **Drawing properties --&gt; Drawing layout**.
2. Select a layout and click **Fixed sizes**.
3. Select a fixed size from the list.
   To create a new size, enter its name and click **Add**.
4. Enter the width and height of the fixed drawing size.
5. Connect the fixed drawing size to a table layout by selecting the table layout the list.
6. Click **Update**.
7. Repeat steps 3–6 for each fixed size.
8. Click **Apply** or **OK**.

**See also**

Create a new drawing layout, add table layouts and tables (page 433)
Drawing size and drawing view scale (page 448)

**Define calculated sizes and connect layouts**

You can use calculated drawing sizes to define the rules Tekla Structures follows when it automatically adjusts drawing size. You can also connect layouts to drawing sizes that meet certain criteria.

1. On the **Drawings & reports** tab, click **Drawing properties --&gt; Drawing layout**.
2. Select a drawing layout and click **Calculated sizes**.
3. Use boxes under **Increasing step** to define the interval by which Tekla Structures increases the drawing size when it needs to.
   You can set this individually for drawing width and height.
4. Use the boxes under **Maximum size** to define the maximum size of the drawing.
   If the drawing size exceeds the width or height limit you set here, Tekla Structures uses an oversize sheet with no table layout.
5. You can connect a layout to drawings that meet one of the following size criteria:
   • **Size A4** for drawings exactly this size
   • **Size A3** for drawings exactly this size
   • **Height = A3** for drawings having the same height as an A3 sheet (=297 mm)
• **Height > A3** for drawings with a larger height than A3.

For each size, Tekla Structures makes the table layouts available depending on the layout you selected.

6. Click **OK** or **Apply**.

**See also**

Create a new drawing layout, add table layouts and tables (page 433)

Drawing size and drawing view scale (page 448)

### Replace a table with another one in table layout

Be careful when you delete tables from table layouts because other tables may use the table as a reference object. Also, when you replace tables with new ones, the new ones do not automatically inherit the location and the properties of the deleted tables.

1. On the **Drawings & reports** tab, click **Drawing properties** --&gt; **Drawing layout** .

2. In the **Layout** dialog box, select a drawing layout and click **Table Layouts**.

3. Select a table layout and click **Tables**.

4. Check if the table you are going to delete is used as a reference the table for another table in the layout. If it does, and you delete the table, you cannot see any tables at all in the layout.

5. In the **Available tables** list, select the new table, and in the **Chosen tables** list, select the table you want to replace, and click the right arrow.

   This moves the new table to the **Chosen tables** list, and the new table inherits the location and other properties of the selected, old table.

6. Select the new table, and check that the binding point of the new table and its location relative to the reference object are correct, and check also the transparency, scale and the distance from the reference object settings.

7. Delete the old table by selecting it from the **Chosen tables** list and click the left arrow.

8. Click **Update** and **OK**.

9. Click **Update** and **OK** in the **Table Layouts** dialog box.

10. Click **OK** in the **Layout** dialog box.

**See also**

Create a new drawing layout, add table layouts and tables (page 433)
Set the location of tables in a drawing table layout

You define the location of each individual table in a table layout by binding it to a reference object such as the drawing frame, or to another table. You can also define the horizontal and vertical distances of the table from the reference object.

2. In the Layouts dialog box, select a drawing layout and click Table Layout.
3. Select a table layout and click Tables.
4. Select a table from the Chosen tables list.
   The name of the table is displayed in the Table box.
5. In the Table area, select one of the table corners as its reference point by selecting the check box in that corner.
6. In the Reference area, select the reference object from the list.
   The reference object can be another table included in the table layout, or the drawing frame.
7. Select the reference point of the reference object by selecting the check box in the appropriate corner.
   You can also position a table to the midpoint of the drawing frame or table boundary by selecting two reference points, for example, the lower-left and lower-right corners. If you do not use the right combination of reference points for tables and binding objects, Tekla Structures may position drawing tables outside the drawing.
8. In the Vector between corners boxes, define the horizontal (x) and vertical (y) distance of the table from the reference object if you need some space between them.
   By default, Tekla Structures places tables side by side.
   There is a fixed distance value 5 mm used as a drawing frame margin. Thus, if you want to use a drawing frame margin with a drawing title that sticks to the frame corner, you need to change the Vector between corners values.
9. In Scale, set the size of the table relative to its original size.
   Each table can have its own scale.
10. If you want the table to be transparent, select the Transparent check box.
    A transparent table can overlap with another table, view or drawing object.
11. Click Update.
12. Repeat steps 2–11 for all the tables on the Chosen tables list.
13. Click **OK** or **Apply** to save the table layout.

**Examples**

In the images below, the lower-right corner of the drawing title block (**Table**) is bound to the lower right corner of the drawing frame (**Reference**), and the **Vector between corners** is set to 0.0

In the example below, the value for \(x\) is -5.00 and the value for \(y\) is 5.00. The lower-right corner of the title block is still bound to the lower right corner of the drawing frame.

**See also**

Create a new drawing layout, add table layouts and tables (page 433)
**Key plans**

A key plan or a key plan view is a small map in a drawing that indicates the location of an assembly, a cast unit, or a part in the model. The key plan contains the model grid and the assembly, cast unit, or part shown in the included drawing view.

Tekla Structures automatically includes the correct object in the key plan. You can use drawings that contain only one view of the correct scale as a key plan. Tekla Structures only uses the view from the original drawing. The view position, drawing size, and templates of the original drawing are not relevant to the key plan.

Below is an example of a key plan.

You can add key plans in table layouts: Add a key plan in a drawing table layout (page 445)

Some things are important to consider, when setting up key plan views: Create a drawing to be used as a key plan (page 443)
**Create a drawing to be used as a key plan**

To create a key plan drawing, you first need to create a suitable view in the model, then create a general arrangement drawing of the view, and finally modify the created drawing so that it can be used as a key plan. The key plan drawing may only contain one view.

1. In the model, create a new XY view on the 0.0 plane, or on the level of the grid.
2. Select the view, right-click and select **Fit work area**.
3. Double-click the model view and set the **Up** and **Down** depth of the view to include the desired part of the model in the View Properties dialog box.
4. Click **Modify**.
5. On the Drawings & reports tab, click Drawing properties --> GA drawing.
6. Define desired properties for the general arrangement drawing, and set the size to perhaps 100*75 in Layout properties.
7. Give a name to the key plan GA drawing, for example, **KEY_PLAN_1**.
8. Click **OK**.
9. Create a GA drawing of the view.
10. Double-click the view boundary to open the View Properties dialog box.
11. Set the desired view scale in the **Scale** box to 1:200, for example.

   Tekla Structures uses the scale of the key plan view in every drawing that uses the key plan view. You cannot change the key plan view scale in the drawing layout properties.
12. Ensure that all parts are visible by doing one of the following:
   • Modify the **x min**, **x max**, **y min**, and **y max** values in the View Properties dialog box.
   • Select the view and drag the view boundary from the handles on the X and Y axes of the view.
13. Modify other view properties in the View Properties dialog box.

   All the changes you make in the properties affect the key plan. For example, if you set part and bolt marks to be visible, they will also be visible in the key plan, so you may want to hide them.
14. Click **Modify**.
15. On the File menu, click **Save drawing**.

Now you can add this GA drawing as a key plan view in your drawing layout.
See also
Add a key plan in a drawing table layout (page 445)

Add a key plan in a drawing table layout
You can add key plans in a drawing layout. The key plans show the location of an assembly, a cast unit, or a part in the model.

Before you start, create a drawing that you want to use as a key plan and set the view properties (page 443) so that they meet the needs of a key plan view.

1. On the Drawings & reports tab, click Drawing properties --&gt; Drawing layout.
2. Select the drawing layout you want to modify and click Table layout.
3. Select the table layout you want to modify and click Tables.
4. From the Available tables list, double-click Key plan.
5. From the Drawing List, select the drawing that you want to use as a key plan drawing and click OK.
6. From the Chosen tables list, select Key plan and set the key plan properties.
7. Click Update.
8. Click OK.

Now you can create a drawing using the layout containing the key plan. Check the drawing properties before creating a drawing to ensure that you are using the correct layout.

See also
Set the location of tables in a drawing table layout (page 441)

Add a DWG/DXF file in a drawing table layout
You can add DWG and DXF files in table layouts. For example, you might have some details in a DWG or DXF file that you want to show in certain types of drawings and therefore add the file in the layout. You can also use a DWG/DXF file as a print boundary in your drawing.

1. On the Drawings & reports tab, click Drawing properties --&gt; Drawing layout.
2. Select the layout you want to modify and click Table layout.
3. Select the table layout you want to modify and click Tables.
4. From the Available tables list, double-click DWG/DXF.
5. Select the DWG/DXF file that you want to add.
6. Click OK.
7. From the Chosen tables list, click the selected DWG/DXF file and set the properties as required.
   For example, set the required scale and define the location for the DWG/DXF file in the drawing. Test the layout before using it to ensure, that the settings are as you wish.
8. Click Update.
9. Click OK.

Now you can create a drawing using the layout containing the DWG/DXF file. Check the drawing properties before creating a drawing to ensure that you are using the correct layout.

See also
Set the location of tables in a drawing table layout (page 441)

Select a new layout for your drawing
You can select which layout to use in a drawing in drawing properties. The layout information is stored in the drawing property files. We recommend that you create as many property files as you need different layouts for the different drawing types.

To select a new layout and save the layout information in a drawing properties file:
1. On the Drawings & reports tab, click Drawing properties and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. Click Layout.
4. Select a new layout from the Layout list.
5. Click Save to save the changed drawing properties and OK to close the drawing properties dialog box.

Now you can create a drawing using the drawing property file that contains the changed layout information.

See also
Drawing layout (page 429)
Layout properties (page 690)
**Edit tables in Template Editor**

If you need to edit a table in a drawing layout, you can open it in Template Editor (TplEd). In Template Editor, drawing layout tables are called templates.

You can only open tables with templates created or saved in Template Editor version 3.2. or later.

If your templates are located in a protected folder, the templates are read-only, because you cannot save a modified template in a protected folder if you are not an administrator. In this case, run Tekla Structures as administrator.

1. In a drawing, double-click the table you want to modify.

2. Tekla Structures shows the following message:

   You are about to edit this template.
   
   To apply the changes in this drawing, save the template after editing and reopen the drawing.
   
   Please note that this change will be applied in all drawings that have this template in the drawing layout definition.
   
   Do you want to edit this template in Template Editor?

3. Click **Yes**. Tekla Structures starts the Template Editor, and the selected template is displayed.

4. Modify the template and save the changes by selecting **File --> Save**, or **Save as** to use another folder, for example model folder.

For more information about the Template Editor, see *Template Editor User's Guide*.

The example below illustrates how a table looks in a drawing and in Template Editor. In this example, there is a revision table and a title block. The revision table is located above the title block and bound to the title block in the layout.
8.2 Drawing size and drawing view scale

Tekla Structures offers you several combinations of settings that you can use for defining the drawing size and the drawing view scale. You can use exact drawing view scale and automatic drawing size, automatic view scale and exact size, or both automatic scale and size.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Click the link below to find out more</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autosizing: If you always want to use a certain scale, then you would set the exact scale to be used and let Tekla Structures automatically select the drawing size that suits the selected scale. You can define different scales for main views and section views. All main views in a drawing automatically</td>
<td>Set exact drawing size and automatic drawing view scale (page 450)</td>
</tr>
<tr>
<td><strong>Settings</strong></td>
<td><strong>Click the link below to find out more</strong></td>
</tr>
<tr>
<td>------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>use the same scale unless you fine-tune individual views manually.</td>
<td></td>
</tr>
<tr>
<td>Autoscaling: if you always need to use a certain drawing size, for example,</td>
<td>Set exact drawing view scale and automatic drawing size (page 449)</td>
</tr>
<tr>
<td>A3, A4 or A1, then you would set the size and let Tekla Structures</td>
<td></td>
</tr>
<tr>
<td>automatically select the drawing view scale that suits the selected size.</td>
<td></td>
</tr>
<tr>
<td>Tekla Structures first tries to use the preferred scale for the drawing</td>
<td>Autoscale and autosize drawings (page 451)</td>
</tr>
<tr>
<td>views, then the alternative scales, and selects the largest possible scale.</td>
<td></td>
</tr>
<tr>
<td>If you are not bound to any specific drawing sizes or drawing view scales,</td>
<td></td>
</tr>
<tr>
<td>you might want to let Tekla Structures take care of both.</td>
<td></td>
</tr>
</tbody>
</table>

**See also**

Define calculated sizes and connect layouts (page 439)
Define fixed drawing sizes and connect layouts (page 438)
Layout properties (page 690)

**Set exact drawing view scale and automatic drawing size**

You can let Tekla Structures find appropriate sizes and table layouts for drawings. Tekla Structures automatically updates drawings to adapt to these changes by using different drawing sizes and table layouts.

Using exact drawing view scale and automatic drawing size is very useful, for example, when the number, size, or location of drawing views may change.

1. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. Click **Layout**.
4. Set **Size definition mode** to **Autosize**.
5. Select the set of drawing sizes for Tekla Structures to use. You have the following options:
   - **Calculated sizes**: Use this when you want to define the rules that Tekla Structures follows when it tries to adjust the drawing size.
• **Fixed sizes**: Use this when you want to use fixed drawing sizes A2, A3, A4, etc.

• **Calculated/fixed sizes**: Use this when you want Tekla Structures to select the smallest of the suitable sizes.

6. Go to the **Scale** tab and set **Autoscale** to **No**.
   This way Tekla Structures uses the exact scale that you have set for the main views and section views.

7. Click **View creation**, select the view and the properties that you want to change, and click **View properties**.

8. On the **Attributes 1** tab, set the desired **Scale**.

9. Save the view properties and click **Close**.

10. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

When you create the drawing, Tekla Structures creates the views using the selected scale and selects the smallest drawing size where the views fit in the drawing. Tekla Structures may also need to change the table layout to adapt to the new drawing size. It will then use another appropriate table layout within the same layout specified in drawing properties.

**See also**

- Drawing size and drawing view scale (page 448)
- View properties in drawings (page 692)
- Section view properties (page 697)
- Define calculated sizes and connect layouts (page 439)
- Define fixed drawing sizes and connect layouts (page 438)
- Layout properties (page 690)

**Set exact drawing size and automatic drawing view scale**

If you need to use a specific size in your drawings, for example, A3, A2, or A1, you can specify the exact size, and let Tekla Structures automatically select the suitable drawing view scale. The drawing size should always be smaller than the actual paper size to accommodate printer margins.

1. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type.

2. Load drawing properties that are as close to the ones you need as possible.

3. Click **Layout**.
4. On the **Drawing size** tab, set **Size definition mode** to **Specified size** and enter the drawing size.
   The size should be smaller than the actual paper size to accommodate printer margins.

5. Select the table layout from the **Table layout** list.

6. On the **Scale** tab, set **Autoscale** to **Yes**.

7. Set the **Main view scales** and **Section view scales**.
   Enter the denominators of scales and separate them with spaces. For example, enter "5 10 15 20" for the scales 1/5, 1/10, 1/15, and 1/20.

8. Select the **Scale change mode**, which defines the relationship between the scales of main and section views within a drawing.
   The options are:
   - **main = section**: The scales of the main and section view are equal.
   - **main < section**: Main view scales are smaller than section view scales.
   - **main <= section**: Main view scales are smaller than or equal to section view scales.

9. Click **View creation**, select the view and the properties that you want to change, and click **View properties**.

10. Enter the preferred scale.
    Do the same for each view that you create.

11. Save the view properties and click **Close**.

12. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

Tekla Structures creates the drawing using the specified size. Tekla Structures first tries to use the preferred scale for the drawing views, then the alternative scales, and selects the largest possible scale.

**See also**
- Drawing size and drawing view scale (page 448)
- View properties in drawings (page 692)
- Section view properties (page 697)
- Define calculated sizes and connect layouts (page 439)
- Define fixed drawing sizes and connect layouts (page 438)
- Layout properties (page 690)
**Autoscale and autosize drawings**

If you are not bound to any specific drawing sizes or drawing view scales, you can let Tekla Structures take care of both.

1. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. Click **View creation**, select the view and the properties that you want to change, and click **View properties**.
4. On the **Attributes 1** tab, set the preferred drawing view scale in the **Scale** box.
   
   Do the same for all of the views you plan to create.
5. Click **Save** to save the view properties. Do this for all of the views you have modified.
6. Click **OK** to return to drawing properties.
7. Click **Layout**, go to the **Scale** tab and set **Autoscale** to **Yes**.
8. Set the alternative **Main view scales** and **Section view scales**.
9. Select the **Scale change mode**, which defines the relationship between the scales of main and section views within a drawing.
   
   The options are:
   - **main = section**: The scales of the main and section view are equal.
   - **main < section**: Main view scales are smaller than section view scales.
   - **main <= section**: Main view scales are smaller than or equal to section view scales.
10. Enter the **Preferred size**.
11. On the **Drawing size** tab, set **Size definition mode** to **Autosize**.
12. Select the set of drawing sizes (**Calculated sizes**, **Fixed sizes** or **Calculated/Fixed sizes**).
13. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

When you use both autoscaling and autosizing at the same time, Tekla Structures follows the steps below:

- First Tekla Structures tries to find a drawing size where the drawing contents fit by first trying to use the exact scale defined in **View properties --&gt; Attributes 1** and the smallest drawing size defined in the current layout ( **Drawings & reports --&gt; Drawing settings --&gt; Layout --&gt; Calculated/Fixed sizes** ).
• Then Tekla Structures increases the drawing size until it reaches the
  Preferred size defined in Layout -> Scale .
• If the drawing fits with the original scale, Tekla Structures tries to increase
  the scale using the alternative main and section view scales you defined in
  Layout > Scale.
• If the drawing does not fit to any of the defined scales, Tekla Structures
  starts to increase the drawing size until the contents fit, using the fixed or
  calculated sizes or both. When necessary, Tekla Structures changes to
  another appropriate table layout within the current layout.
• When the views fit, Tekla Structures begin to increase the scale again so
  that the final drawing uses the largest possible scale.

See also
  Drawing size and drawing view scale (page 448)
  View properties in drawings (page 692)
  Section view properties (page 697)
  Define calculated sizes and connect layouts (page 439)
  Define fixed drawing sizes and connect layouts (page 438)
  Layout properties (page 690)

8.3 Object protection and placement settings in drawings

When you create a drawing, Tekla Structures uses predefined rules for
positioning marks and dimensions. Marks and dimensions are automatically
placed in the first suitable position.

The following settings are considered when placing the objects:
• The protected areas defined in drawing properties. How the protection
  settings are applied depends on the drawing order of the objects in the
  drawing: the parts are drawn first, then the marks and then the
  dimensions.
• The placing and leader line type settings (page 613) of the annotation
  objects defined in the annotation object properties. Marks are usually
drawn before dimensions, but if the marks have leader lines, they are
drawn after the dimensions.
• The predefined mark location and part orientation settings for some
  marks. For more information, see Set a predefined location for beam,
  bracing and column marks (page 612).
• The modeling direction of parts.

When you create a drawing, Tekla Structures places the annotation objects
according the automatic placement settings and protection settings. You can
modify the placement settings in drawing view properties and on object level for individual objects. The protection settings for the whole drawing are also considered when you add annotation objects manually.

When you create a drawing, Tekla Structures places the views in the drawing according to the settings in the drawing layout and view properties. In final drawings, you can select whether to use fixed or free view placement of views, drag drawing views to new locations, or align them.

<table>
<thead>
<tr>
<th>To</th>
<th>Click a link below to find out more</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify protected areas in your drawings</td>
<td>Protected areas in drawings (page 454)</td>
</tr>
<tr>
<td></td>
<td>Protect areas in a drawing (page 456)</td>
</tr>
<tr>
<td>Specify how the marks or dimensions are placed</td>
<td>Define automatic placement settings for marks (page 458)</td>
</tr>
<tr>
<td></td>
<td>Define placement settings for dimensions (page 459)</td>
</tr>
<tr>
<td>Specify whether the view placement is fixed or free</td>
<td>Define automatic free or fixed placement for drawing views (page 460)</td>
</tr>
</tbody>
</table>

See also

Placement properties for marks, dimensions, notes, texts and symbols (page 769)

Protected areas in drawings

You can define protected areas in drawings to prevent text, marks or dimensions from being placed in that area. When Tekla Structures places text, marks, dimensions or other annotation objects in a drawing, it first checks the protection settings.

The drawing properties files contain predefined protection properties, which you may change. When you load the drawing properties, the protection settings in the loaded file are applied in your drawing.

For details about adjusting the protection settings, see Protect areas in a drawing (page 456)

Below is an example of the protection properties dialog with explanations of the selections.
1. With a selection like this, text and marks may overlap with part corners and edges, but not with part content.

2. With a selection like this, dimension values may not overlap with other dimension arrowheads, lines or values.

The objects on the top define the areas to be protected, see descriptions below:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Part corners image]</td>
<td>Part corners</td>
</tr>
<tr>
<td>![Part edges image]</td>
<td>Part edges</td>
</tr>
<tr>
<td>![Part content image]</td>
<td>Part content</td>
</tr>
<tr>
<td>![Text, mark or weld mark image]</td>
<td>Text, mark or weld mark</td>
</tr>
<tr>
<td>![Dimension arrowhead image]</td>
<td>Dimension arrowhead</td>
</tr>
<tr>
<td>![Dimension line image]</td>
<td>Dimension line</td>
</tr>
<tr>
<td>![Dimension value image]</td>
<td>Dimension value</td>
</tr>
</tbody>
</table>
The objects on the left define which objects, or object elements, Tekla Structures cannot place in the protected areas. See the descriptions below:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>Cutting line</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image" /></td>
<td>Section mark</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td>Weld arrow</td>
</tr>
<tr>
<td><img src="image4.png" alt="Image" /></td>
<td>Weld mark content</td>
</tr>
</tbody>
</table>

You can check which areas are protected by using the **Show protection** command. You can start this command in the Quick Launch box. This command shows the protected areas with colors.

You can define protected areas in drawings to prevent text, marks or dimensions from being placed in that area.
1. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type.

2. Load drawing properties that are as close to the ones you need as possible.

3. Click **Protection**.

   The settings are the same for all drawing types.

4. Select check boxes to indicate the areas that you want to protect from text, marks, weld marks, associative notes, dimension arrowheads, dimension lines or dimension values.

   - For example, to prevent text, marks, dimensions or other annotation objects from being placed over the inside area of parts, select the third check box on the first row. The first row defines the placement of annotation objects, and the icon above the third check box indicates the inside area of parts. With this setting, Tekla Structures may place annotation objects on the corners and edges of parts.

   ![Diagram showing protection settings](image)

   - If you clear the first two columns of check boxes, Tekla Structures does not protect part corners and edges. This increases drawing speed and decreases the memory requirements. You can still protect these areas by using the third column of check boxes for part protection.

   ![Diagram showing protection settings](image)

5. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**See also**

- Object protection and placement settings in drawings (page 453)
- Protected areas in drawings (page 454)
Define automatic placement settings for marks
You can define automatic placement settings for the marks before creating a drawing. You can modify the settings in an open drawing.

1. On the Drawings & reports tab, click Drawing properties and select the drawing type.

2. Load drawing properties that are as close to the ones you need as possible.

3. Single-part, assembly and cast unit drawings: Click View creation, select the view and the properties that you want to change, and click View properties.

4. Click an object that you want to adjust, for example Part Mark.

5. On the appropriate tab, click the Place button to open the Placing dialog box.

6. Adjust the placement settings. The options available in the dialog box vary depending on the annotation object type.
   - In Minimum distance, enter the closest distance Tekla Structures should use to place the drawing object.
   - In Maximum distance, enter the farthest distance Tekla Structures should use to place the drawing object, for example, a mark. If no place for mark is found within the specified distance, Tekla Structures will force the mark to that distance. If you set this option to 0, the maximum distance behaves like infinity.
   - In Search margin, enter the minimum distance within which Tekla Structures searches for a space to place the object.
   - To move marks away from each other, use Search margin, not Minimum distance. Keep the minimum distance setting as small as possible to reduce the possibility of marks overlapping.
   - Select the Quarter to define the areas Tekla Structures searches for a space to place the object.

7. Click OK.

8. Single-part, assembly and cast unit drawings: Click Save to save the changes in view properties and Close to return to drawing properties.

9. General arrangement drawings: Click OK.

10. Click Save to save the drawing properties, then click OK and create the drawing.

**TIP** If you are not happy with the mark placement settings in a drawing, you can change the settings in the object level mark placing dialog box, which
has more options available. In an open drawing, you can also change the placement settings for manually added marks, notes, texts, and symbols.

To open an object level dialog box, double-click the mark, text, note, or symbol in the drawing and click **Place**. If you set **Placing** to **free**, you are letting Tekla Structures to decide the location of the mark. If you set **Placing** to **fixed**, you can place the mark in any location. When you use the setting **fixed**, the mark stays where you place it even though you update the drawing, whereas with **free**, Tekla Structures tries to find the optimal place for the mark. You can select several or all marks in a view and change the placing settings this way.

See also

Object protection and placement settings in drawings (page 453)
Protected areas in drawings (page 454)

**Define placement settings for dimensions**

You can set dimension placement to free or fixed, and control the space between parallel dimension lines and the location of the dimension in relation to the object it is dimensioning. You can also select whether to place short dimension text inside or outside the dimension.

In single-part, assembly and cast unit drawings, the dimension placement settings can be defined in an open drawing, saved into a dimension properties file and loaded in another drawing, or taken into use in **Dimensioning Rule Properties** dialog box. In general arrangement drawings, most of the settings can be defined on drawing and view level, but placement settings only on object level.

Remember that in addition to dimension placement settings, the placement is also affected by **Protection** properties. Tekla Structures uses the protection properties to prevent marks and dimensions from being placed in protected areas.

To adjust dimension placement settings in an open drawing and save the settings for later use:

1. On the **Drawing** tab, click **Properties --> Dimension**.
2. Go to the **General** tab of the **Dimensions** dialog box.
3. In **Dimension lines spacing**, enter the desired space between two parallel dimension lines.
4. Select whether to place short dimension text inside or outside of the dimensions from the **Short dimension** list.
5. Click **Place**, and define the desired placing settings:
• Set Placing to free to let Tekla Structures decide the location and direction of the dimension based on the Direction settings.

• If you set Placing to fixed, you can place the dimension in any location. When you use the setting fixed, the dimension stays where you place it even though you update the drawing, whereas with free, Tekla Structures tries to find the optimal place for the dimension.

• The option Direction defines where Tekla Structures places dimensions relative to the dimensioned object. You can select either positive or negative, or both. Positive places the dimension further away and negative closer to the dimensioned object. This setting affects the Placing: free setting.

6. In Minimum distance, enter the closest distance Tekla Structures should use to place the dimension.

7. In Search margin, enter the furthest distance within which Tekla Structures searches for an empty space to place the dimension. If Tekla Structures cannot place the dimension at the minimum distance, it moves the dimension by the value you enter in the Search margin box. Tekla Structures tries to place the dimension using the Search margin value until it finds a place for the dimension.

8. Click OK to close the dimension placing dialog box.

9. Save the dimension properties using Save, or save them in another file using Save as.

10. Click Modify to modify the dimension properties in the open drawing.

The dimensions are placed according the changes you made. Now you have a dimension properties file that you can load whenever you need to adjust the dimension placement settings in the same way. For example, you can load these properties in the Dimension properties box in the Dimensioning Rule Properties dialog box, or in an open general arrangement drawing in the Dimension properties dialog box.

See also

Object protection and placement settings in drawings (page 453)
Dimension properties - General tab (page 700)
Dimension properties - Appearance tab (page 705)
Dimension properties - Units, precision and format (page 703)
Placement properties for marks, dimensions, notes, texts and symbols (page 769)
Define automatic free or fixed placement for drawing views
You can keep the views in the same location (fixed) or let Tekla Structures find a suitable place for the view (free) during drawing updates.

In general arrangement drawings, this setting can only be defined on view level in an open drawing. In single-part, assembly and cast unit drawings, you can set the view placement before creating drawings.

To define automatic free or fixed placement of in single-part, assembly and cast unit drawings:
1. On the Drawings & reports tab, click Drawing properties and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. Click View creation, select the view and the properties that you want to change, and click View properties.
4. On the Attributes 1 tab, select one of the following options:
   • Set Place to Fixed to always keep the view in the same location when you update the drawing.
   • Set Place to Free to let Tekla Structures find a suitable place for the view when you update the drawing.
5. Click Save to save the view properties.
6. Click Close to return to drawing properties.
7. Click Save to save the drawing properties, then click OK and create the drawing.

NOTE The Arrange views (page 166) command only affects views where the Place is set to Free. Fixed views are not moved.

See also
Object protection and placement settings in drawings (page 453)

8.4 Automatic drawing views
Automatic drawing views are views that you select to create before creating a single-part, assembly or cast unit drawing. You can define the desired drawing view properties separately for each view before you create the drawings.

When you create general arrangement drawings, you cannot select the views to be created in the general arrangement properties dialog box, but you select them at GA drawing creation. However, you can define automatic settings that apply to all the views you create in a general arrangement drawing.
<table>
<thead>
<tr>
<th>To</th>
<th>Click the links below to find out more:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the views that you want to create in single-part, assembly or cast unit drawings</td>
<td>Define the views to create in single-part, assembly and cast unit drawings (page 463)</td>
</tr>
<tr>
<td>Define automatic view properties for general arrangement drawings</td>
<td>Define automatic view settings for general arrangement drawings (page 464)</td>
</tr>
<tr>
<td>Define automatic view properties for section views</td>
<td>Define automatic section view properties (page 491)</td>
</tr>
<tr>
<td>Define the contents of the main view and section view labels before you create the drawing</td>
<td>Define view labels and view label marks (page 465)</td>
</tr>
<tr>
<td>Define how Tekla Structures places the projections of a part in cast unit, single-part, and assembly drawings</td>
<td>Set drawing view projection type (page 467)</td>
</tr>
<tr>
<td>Include single-part drawings of the individual parts that make the assembly in assembly drawings</td>
<td>Include single-part drawings in assembly drawings (page 469)</td>
</tr>
<tr>
<td>Adjust the orientation of parts by changing the coordinate system, rotating parts in drawing views, setting viewing direction of columns, beams or bracings, or changing the project north</td>
<td>Part orientation in drawing views (page 471)</td>
</tr>
<tr>
<td>Show neighbor parts in drawing views</td>
<td>Show neighbor parts in views (page 479)</td>
</tr>
<tr>
<td>Shorten or lengthen parts in model or drawing views</td>
<td>Shorten or lengthen parts (page 482)</td>
</tr>
<tr>
<td>Unfold polybeams and bent plates in single-part drawings according to unfolding parameters</td>
<td>Unfold polybeams in drawings (page 486)</td>
</tr>
<tr>
<td>Undeform warped or cambered parts and show the developed shape of deformed parts in drawings</td>
<td>Undeform deformed parts in drawings (page 487)</td>
</tr>
<tr>
<td>Show symbols for part openings and recesses (blind holes) in drawing views</td>
<td>Show part openings and recesses in drawings (page 489)</td>
</tr>
</tbody>
</table>

**See also**

- View properties in drawings (page 692)
- Section view properties (page 697)
Define the views to create in single-part, assembly and cast unit drawings

Before you create single-part, assembly or cast unit drawings, you need to select the views that you want to include automatically. At the same time, you can set the necessary view properties.

To select the drawing views to be created and set the view properties:

1. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type.
2. Load the drawing properties file that you want to modify from the list at the top.
3. Click **View creation**.
4. Go to the **Attributes** tab and change the settings as required.
   These settings apply to all views in the drawing. Here you can select the coordinate system, set the coordinate system rotation, and undeform warped or cambered parts.
5. Select the views you want to create. You can create as many views as you like.
   - If you select **off**, Tekla Structures does not create the view, but dimensions the parts in the available views. If you set all four main views off, Tekla Structures will still create one front view.
   - If you select **on**, Tekla Structures always creates the view, even if it was not necessary in order to show the dimensions. For section views, Tekla Structures creates one additional section view showing the middle of the main part. For end views, Tekla Structures creates an end view from one end of the main part.
   - If you select **auto**, Tekla Structures creates the view if it is necessary in order to show the dimensions. For section views, Tekla Structures creates the necessary number of views to show all the dimensions. For end views, Tekla Structures also creates another end view from the other end of the main part, if there are dimensions at that end.
6. For each of the views that you create, select the view properties that you want to use in the **View properties** column.
   The lists contain predefined view properties for different types of drawings, also the view properties that you save in **View Properties**.
7. Check the view properties for each view by selecting the view from the list and clicking **View properties**, and modify the properties as required.
8. Check the settings on the **Attributes 1** tab.
   Here you can set the view scale and size, view extension distance, view place, and rotation of 3D views, show a reflected view and apply detailed object level settings for the selected view.

9. Check the settings on the **Attributes 2** tab.
   Here you can undeform warped or cambered parts, shorten parts, show openings and recesses, set the datum point for elevations and select the dimension creation method in the selected view.

10. Check the settings on the **Label** tab.
    Here you can define the label text and position, add a symbol in the label and show the view direction marks in the selected view.

11. Select options from the options tree, and modify dimensioning, mark and object settings as required.

12. Save the view properties by clicking **Save**.

13. Click **Close**.

14. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**See also**

- View properties in drawings (page 692)
- Section view properties (page 697)
- Automatic drawing views (page 461)
- Set automatic drawing properties before creating drawings (page 27)

### Define automatic view settings for general arrangement drawings

Before you create general arrangement drawings, define the automatic view properties.

1. Click **Drawings & reports** --> **Drawing properties** --> **GA drawing**.
2. Load the drawing properties file that you want to modify from the list at the top.
3. Click **View** and load the view properties you want to modify.
4. On the **Attributes** tab, change the settings as required.
   Here you can set the view scale, view extension distance, show a reflected view, show openings and recesses, set the datum point for elevations and show pours.
5. Go to the **Shortening** tab and define the part shortening settings.
   Here you can select whether you want to cut parts, set the minimum part length, and set the space between cut parts.

6. Go to the **Label** tab and define the view label text, symbol and position.

7. If you want to create an anchor bolt plan drawing, go to the **Anchor bolt plan** tab and set **Show as anchor bolt plan** to **Yes**.
   You can also select, whether you want to create detail views in anchor bolt plans and set the enlarged part view scale.

8. Save the view properties.

9. Click **OK** to return to drawing properties.

10. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**See also**
- View properties in drawings (page 692)
- Automatic drawing views (page 461)
- Create anchor bolt plans using saved settings (page 83)
- Set automatic drawing properties before creating drawings (page 27)

**Define view labels and view label marks**
All drawing views can have view labels, which may contain text and symbols. You can set the contents of the main view labels and section view labels before you create the drawing. You can also adjust them after you have created the drawing.

1. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type.

2. Load drawing properties that are as close to the ones you need as possible.

3. Do one of the following depending on the drawing type:
   - **Single-part, assembly and cast unit drawings:**
     a. Click **View creation**, select the view and the properties that you want to change, and click **View properties**.
     b. Click **Attributes** and go to the **Label** tab.
   - **General arrangement drawings:**
     a. Click **View**.
     b. Go to the **Label** tab.

4. Click the ... button next to **A1 - A5** to open the **Mark Contents** dialog box.
The illustration in the view properties dialog box is only one way to position the label text. When you modify the positioning, the illustration in the dialog box does not change.

5. On the **Content** tab, select the elements that you want to include in the view label mark.

6. If needed, select an element from the list and click **Add frame** and select the frame **Type** and **Color**.

7. If needed, select an element from the list and select the text **Color**, **Font** and **Height**.

8. Go to the **Position** tab and set the text position, horizontal and vertical offset, and the text alignment.
   
   Text positioning depends on whether you use a symbol or not.

9. Click **OK**.

10. Select the view label **Symbol** you want to use in the label.
    
    You can simply use only a label or add a symbol in it. You can also set the color, size, line length and the position of the view label.

11. Select the position for the view label: **Vertical** (Above or Below) and **Horizontal** (Center by view frame or Center by view restriction box).

12. To save the changes, click **Save**.

13. **Single-part, assembly and cast unit drawings**: Click **Close**.
    
    **General arrangement drawings**: Click **OK**.

14. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

See below for examples of view labels:

**FRONT**

1:20

**3 Typical Gymnasium Joist Elevation**

521 Scale 1:20

Drag the view label to the desired page in an open drawing.

The view frame is resized automatically, if necessary.
For more information on the elements available in view label marks, see View, section view and detail view label mark elements (page 748).

For more information about the positioning of the view label marks, see Positioning properties of view label, section and detail marks (page 731)

Define section view properties for all views in a drawing

If you want to use the same section view properties, such as start number or letter, cutting line, contents, and text position, in all your section views, you can do this in on the drawing level. For more information, see Define automatic section view properties (page 491).

See also

View properties in drawings (page 692)
Section view properties (page 697)
Automatic drawing views (page 461)

Set drawing view projection type

Projection type defines how Tekla Structures places the projections of a part in cast unit, single-part, and assembly drawings. Projection type affects the order of the views in the drawing.

1. On the Drawings & reports tab, click Drawing properties and select the drawing type.
2. Load the properties you want to change.
3. Click Layout and go to the Other tab.
4. Select one of the following:
   - First angle (also referred to as European projection).
   - Third angle (also referred to as American projection).
5. To save the properties in the properties file, click **Save**.

6. Click **OK** and create the drawing.

First-angle projection:

![First-angle projection](image1)

Third-angle projection:

![Third-angle projection](image2)
Include single-part drawings in assembly drawings
You can include in assembly drawings single-part drawing views of the individual parts that make the assembly. You can use existing single-part drawings on the Drawing List or create new single-part drawing views.

1. On the Drawings & reports tab, click Drawing properties --> Assembly drawing.
2. Load the desired assembly drawing properties.
3. Click Layout and go to the Other tab.
4. Set Include single parts to Yes.
   This activates the Single-part attributes list.
5. In the Single-part attributes list, select the desired drawing properties to be used in the single-part view. The properties file standard is the default.
6. Click Save to save the drawing properties in the properties file.
7. Click **OK** and create the drawing.

The value of the advanced option

\texttt{XS\_USE\_EXISTING\_SINGLE\_PART\_DRAWINGS\_IN\_ASSEMBLY\_DRAWINGS}

affects how Tekla Structures creates the single-part views. If the option is set to

\texttt{TRUE}, Tekla Structures will use single-part drawings in the **Drawing List**. If it is

set to \texttt{FALSE}, or if there is no existing single-part drawing for a given part, a

new view will be created according to the **Include single parts** setting. The

default value is \texttt{FALSE}.

Tekla Structures also maintains the original scale in a single part drawing in an

assembly drawing when you set the layout to include single part drawings, and

set the option

\texttt{XS\_USE\_EXISTING\_SINGLE\_PART\_DRAWINGS\_IN\_ASSEMBLY\_DRAWINGS} is

set to \texttt{TRUE}. If you do not want to maintain the scale of the existing single part
drawing, set the advanced option

\texttt{XS\_USE\_EXISTING\_SINGLE\_PART\_DRAWINGS\_SCALE} can be set to \texttt{FALSE}. If

you do this, the scale of the included single part drawing will follow the scale
of the assembly drawing, or advanced option \texttt{XS\_SINGLE\_SCALE} if it is set.

The following advanced options all affect how the single-part drawing views

behave:

- \texttt{XS\_SINGLE\_CENTERED\_SCREW}
- \texttt{XS\_SINGLE\_CLOSE\_DIMENSIONS}
- \texttt{XS\_SINGLE\_CLOSE\_SHORT\_DIMENSIONS}
- \texttt{XS\_SINGLE\_COMBINE\_DISTANCE}
- \texttt{XS\_SINGLE\_COMBINE\_MIN\_DISTANCE}
- \texttt{XS\_SINGLE\_COMBINE\_WAY}
- \texttt{XS\_SINGLE\_DIMENSION\_TYPE}
- \texttt{XS\_SINGLE\_DRAW\_PART\_AS}
- \texttt{XS\_SINGLE\_EXCLUDE}
- \texttt{XS\_SINGLE\_FORWARD\_OFFSET}
- \texttt{XS\_SINGLE\_NO\_SHORTEN}
- \texttt{XS\_SINGLE\_ORIENTATION\_MARK}
- \texttt{XS\_SINGLE\_PART\_EXTREMA}
- \texttt{XS\_SINGLE\_PART\_SHAPE}
- \texttt{XS\_SINGLE\_SCALE}
- \texttt{XS\_SINGLE\_SCREW\_INTERNAL}
- \texttt{XS\_SINGLE\_SCREW\_POSITIONS}
- \texttt{XS\_SINGLE\_USE\_WORKING\_POINTS}
- \texttt{XS\_SINGLE\_X\_DIMENSION\_TYPE}
Part orientation in drawing views

In single-part, assembly, and cast unit drawings, you can adjust the orientation of the parts in the drawing views by selecting an appropriate coordinate system and by rotating the parts. You can also separately set the viewing direction of columns, beams and bracings in assembly drawings. The project north setting also affects part orientation.

<table>
<thead>
<tr>
<th>To</th>
<th>Click the links below to find out more</th>
</tr>
</thead>
<tbody>
<tr>
<td>To change the angle from which the part, assembly, or cast unit is</td>
<td>Change the coordinate system (page 471)</td>
</tr>
<tr>
<td>viewed, how the part, assembly, or cast unit is rotated, and how</td>
<td></td>
</tr>
<tr>
<td>the dimensions in the drawing view are oriented</td>
<td></td>
</tr>
<tr>
<td>Rotate a part, assembly, or cast unit in a drawing view around its</td>
<td>Rotate parts in drawing views (page 474)</td>
</tr>
<tr>
<td>local axes</td>
<td></td>
</tr>
<tr>
<td>Select which side of a steel or timber part is always shown in the</td>
<td>Select the steel or timber part face that is shown in</td>
</tr>
<tr>
<td>drawing main view</td>
<td>front drawing view (page 476)</td>
</tr>
<tr>
<td>Change the plate orientation in drawing views</td>
<td>Change plate orientation in drawings (page 478)</td>
</tr>
<tr>
<td></td>
<td>XS_POLYGON_SQUARE_CORNER_PREFERENCE_FACTOR</td>
</tr>
<tr>
<td></td>
<td>XS_POLYGON_PERPENDICULAR_EDGE_PREFERENCE_FACTOR</td>
</tr>
<tr>
<td>Define the front view direction separately for columns</td>
<td>Set viewing direction for parts in assembly drawings</td>
</tr>
<tr>
<td></td>
<td>(page 477)</td>
</tr>
<tr>
<td>Define the front view direction separately for beams and bracings</td>
<td>Set viewing direction for parts in assembly drawings</td>
</tr>
<tr>
<td></td>
<td>(page 477)</td>
</tr>
</tbody>
</table>
**Change the coordinate system**
You change the angle from which the part, assembly, or cast unit is viewed, how the part, assembly, or cast unit is rotated, and how the dimensions in the drawing view are oriented.

The coordinate system defines:

- The angle from which the part, assembly, or cast unit is viewed.
- How the part, assembly, or cast unit is rotated.
- The orientation of the dimensions in the drawing view.

To change the coordinate system:

1. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type.
2. Load the drawing properties that you want to change.
3. Click **View creation** and go to the **Attributes** tab.
   
   The settings affect all views in a drawing.
4. In **Coordinate system**, select one of the available coordinate systems:
   
   - **local**
     
     Tekla Structures uses the local coordinate system of the main part. The x axis of the part is parallel to the x axis of the drawing, and the start point (the end point created first) of the part is on the left. The start point is marked with yellow, and the end point created second is marked with pink.

   ![Diagram showing local coordinate system]

   - **model**
     
     Tekla Structures uses the global coordinate system. The part has the same position in the drawing as it has in the model. This is one option when you want to show columns vertically. You can also use this option to display sloping parts in position. Tekla Structures cannot display horizontally skewed parts.

   ![Diagram showing model coordinate system]
• **oriented**

Tekla Structures uses the local coordinate system of the main part, but the coordinate system is oriented so that the x axis of the part points to the right even if the part was created from right to left.

![Diagram](image1.png)

• **horizontal brace**

Tekla Structures automatically rotates the drawing views so that the front view is from the top of the model. This is used for skewed braces. It automatically rotates the front view around the x axis.

• **vertical brace**

Tekla Structures automatically rotates the drawing views so that the front view is in the same plane as the brace in the model. This is used for skewed braces. It automatically rotates the front view around the x axis.

![Diagram](image2.png)

• For concrete parts, the option **Fixed** rotates the front view so that it shows the casting direction (the face that is top in form) of the concrete part, if it is defined in the model. For more information about the casting direction, see Casting direction.

5. To save the changes, click **Save**.
6. Click OK and create the drawing.

**Rotate parts in drawing views**
You can rotate a part, assembly, or cast unit in a drawing view around its local axes.

1. On the Drawings & reports tab, click Drawing properties and select the drawing type.
2. Load the drawing properties that you want to change.
3. Click View creation and go to the Attributes tab.
   The settings affect all views in a drawing.
4. In Rotate coordinate system, specify the angle:
   • With the X axis, you can rotate in steps of 90 degrees (0, 90, 180, 270).
   • With the Y axis, you can rotate in steps of 180 degrees (0, 180).
   • With the Z axis, you can specify any angle.
5. To save the changes, click Save.
6. Click OK and create the drawing.

**Examples**
Below there are some examples of rotating an object around the x axis:
1. 0 degrees
2. 90 degrees
3. 180 degrees
4. 270 degrees

Below is an example of rotating the same part 180 degrees around the y axis:

Below is an example of rotating the same part 30 degrees around the z axis:
Select the steel or timber part face that is shown in front drawing view

You can select which face of a steel or timber part is shown in the drawing main (front) view by using the user-defined attribute **Fixed drawing main view**.

The user-defined attribute **Fixed drawing main view** controls the drawing coordinate system for steel and timber parts. This UDA is only taken into account when you use the coordinate system **Fixed** in drawing properties. When the fixed coordinate system is used, the part is rotated so that the front view shows the part face that has been selected with the **Fixed drawing main view** UDA.

1. In the model, double-click a part to open the part properties dialog box, and click the **User-defined attributes** button.
2. On the **Parameters** tab, click **Fixed drawing main view**, and select one of the options:
   - Top
   - Back
   - Bottom
   - Start
   - End
   - Front
3. Click **OK**.
4. Click **Drawings & reports --> Drawing properties**, and select assembly or single part drawing properties.
5. Click View creation in the options tree, go to the **Attributes** tab, and set **Coordinate system** to **Fixed**.
6. Click OK to activate the settings, and create the drawing using the current settings.

**NOTE** The FixedMainView UDA does not affect the numbering of steel and timber parts, but does affect the numbering of concrete parts, regardless of how it has been defined in . This behavior is hard coded.

---

**Set viewing direction for parts in assembly drawings**

In assembly drawings, you can define the front view viewing direction separately for columns, beams and bracings.

**NOTE** Do not change the viewing direction settings in the middle of the project. If you change the settings, some drawings may disappear.

---

**Set viewing direction for columns in assembly drawings**

1. On the File menu, click Settings --> Options and go to the Orientation marks settings.

2. Under Viewing direction, use the Columns in assembly drawing option to set the front view direction of columns:
   - The values are As beam and bracing, North, East, South and West. Select As beam and bracing to use the same viewing direction as you use for beams and bracings. This is the default value.
   - If you have set the coordinate system to local in View creation properties, Tekla Structures uses the coordinate system of the column when setting the viewing direction of the front view.
   - If you have set the coordinate system to oriented, the column is in a horizontal position, and the viewing direction of the front view is the option you select (North, East, South or West).
   - If you have set the coordinate system to model, the column is in a vertical position, and the viewing direction of the front view is the option you select (North, East, South or West).

3. Click OK.

---

**Set viewing direction for beams and bracings in assembly drawings**

1. On the File menu, click Settings --> Options and go to the Orientation marks settings.

2. Under Viewing direction, use the Beams and bracings in assembly drawing option to set the front view direction:
   - The values are North or east, North or west, South or east, and South or west. The default value is North or east.
• If the beam or bracing is parallel to the X axis of the model, it is also parallel to the X axis in the drawing.
• If you have set the coordinate system to model, and the beam or bracing is sloped, it is also sloped in the drawing.

3. Click OK.

Change plate orientation in drawings
Plates created with the Contour plate command are automatically oriented in drawings. The longest side of the plate always faces downwards in the drawing. You can affect this orientation.

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Contour plate in the model view.](image) | Contour plate in the model view.  
1. First creation point  
2. Second creation point |
| ![Single-part drawing of the contour plate.](image) | Single-part drawing of the contour plate. |

Instead of using automatic plate orientation, you can set the plate main axis to follow the line created by the first and second points you pick, regardless of the plate dimensions. This enables you to define the plate orientation in drawings or reports.

To define the contour plate orientation with first and second picked points:
1. Create the contour plate.
   
The first and second points you pick also define the plate’s main axis.
2. Double-click the plate to open the Contour plate properties dialog box.
3. Click User-defined attributes, and click the Orientation tab.
4. Select **From 1st to 2nd creation point** in the **Main axis direction** list.
5. Click **Modify**, and close the dialog box.
6. Click **Drawings & reports** --> **Numbering** --> **Number modified objects** to update numbering.
7. To view the orientation of the plate, create a single-part drawing of the plate.

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Contour plate in the model view.](image1) | Contour plate in the model view.  
1. First creation point  
2. Second creation point |

| ![Single-part drawing of the plate.](image2) | Single-part drawing of the plate.  
The user-defined attribute **Main axis direction** is set to **From 1st to 2nd creation point**. |

**NOTE**  You can also affect the orientation of the plates using the advanced options  
XS_POLYGON_SQUARE_CORNER_PREFERENCE_FACTOR and  
XS_POLYGON_PERPENDICULAR_EDGE_PREFERENCE_FACTOR.
Show neighbor parts in views
You can select which neighbor parts to show in views and also automatically extend the view boundary if necessary.

Neighbor parts refer to (optionally shown) parts that are close to the part that is depicted in a drawing. Depending on settings, the neighbor parts may be parts somehow connected to the part in question, or just parts that happen to be close by.

1. On the Drawings & reports tab, click Drawing properties and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. Single-part, assembly and cast unit drawings: Click View creation, select the view and the properties that you want to change, and click View properties.
4. Click Neighbor part.
5. On the Visibility tab, select the parts and that you want to show using the following options:
   • None does not show neighbor parts.
   • Connected parts shows all parts connected to the model object.
   • Connecting parts shows only the parts the model object is connected to.
   • All components combines the Connected parts and the Connecting parts options.
   • By extreme show all parts within the boundaries of the main and secondary part. This setting is affected by the value entered for View extension for neighbor parts on the Attributes (1) tab.
   • Main/Secondary parts: Main parts shows only neighbor parts that make the main part of an assembly or a cast unit.
   • Main/Secondary parts: Secondary parts shows only neighbor parts that are secondary parts of an assembly or a cast unit.
   • Main/Secondary parts: Both shows both main and secondary parts.
   • Skew parts: Yes shows skew parts as neighbor parts in the drawing, No does not show skew parts as neighbor parts.
   • Bolts: Yes shows the bolts in the neighbor parts, whereas No does not show the neighbor part bolts.
6. On the Contents tab, set the representation of the neighbor part and neighbor part bolts, and which lines and marks are shown.
7. On the Appearance tab, set the colors and line types you want to use in neighbor parts.
8. Depending on the drawing type, do one of the following:

**Single-part, assembly and cast unit drawings**

a. Click **Attributes** in the options tree and enter a value by which to extend the view in the **View extension for neighbor parts** box. Try different values and check which one suits your needs. Often too big values do not work very well. If you set the value to 0, neighbor part extension is not shown.

b. To save the changes, click **Save**.

c. Click **Close** to return to drawing properties.

**General arrangement drawings**

a. Click **OK** to return to drawing properties.

b. Click **View**, and on the **Attributes** tab, enter a value by which to extend the view in the **View extension for neighbor parts** box.

c. Click **OK** to return to drawing properties.

9. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

---

**TIP** If you do not want to see neighbor part extensions in drawing views, set the advanced option `XS_VISUALIZE_VIEW_NEIGHBOR_PART_EXTENSION` to `FALSE`.

---

**Example**

In the following example, **View extension for neighbor parts** is set to **100**. No neighbor parts are located in this area.

---

**See also**

- Part and neighbor part properties in drawings (page 749)
- View properties in drawings (page 692)
- Automatic drawing views (page 461)
Shorten or lengthen parts
You can use the shortening functionality in the model to make the part longer or shorter in the drawing than in the model. You can shorten and lengthen parts also in drawing views.

Lengthening can be useful for adding length to concrete precast parts in the cast condition while the model stays in the erected state. The most common use for this is to account for pre-stressing elastic shortening, where the part actually shrinks a fraction of an inch after casting and after the strands are cut.

<table>
<thead>
<tr>
<th>To</th>
<th>Click the links below to find out more</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shorten parts in the model, and in drawings, decrease the true length of the part</td>
<td>Shorten a part in the model (page 482)</td>
</tr>
<tr>
<td>Lengthen parts in the model, and in drawings, increase the true length of the part</td>
<td>Lengthen a part in the model (page 483)</td>
</tr>
<tr>
<td>Shorten parts in drawing views at locations where there is nothing important in the part</td>
<td>Shorten parts in drawing views (page 483)</td>
</tr>
<tr>
<td>Stretch shortened drawing views to fill up empty areas of the drawing</td>
<td>Lengthen shortened parts in drawing views (page 486)</td>
</tr>
<tr>
<td>Shorten parts in the selected view in an open drawing</td>
<td>Shorten parts view by view (page 284)</td>
</tr>
</tbody>
</table>

Shorten a part in the model
You can shorten parts in the model. When you do that the true length of the part is decreased in the drawing.

1. Double-click a part to open the part properties dialog box.
2. Go to the Deforming tab.
3. In the Shortening box, define the degree of shortening.
4. Click Modify.

When drawings are created, Tekla Structures decreases the true length of the part by the value defined in the Shortening box. Shortening is applied linearly along the length in drawings.

TIP  To show the dimensions of the shortened part correctly in the drawings, set Undeformed to Yes on the Attributes tab in the View creation panel in drawing properties
**See also**
Shorten or lengthen parts (page 482)
Undeform deformed parts in drawings (page 487)

**Lengthen a part in the model**
You can lengthen parts in the model. When you do this, the true length of the part is increased in the drawing.

To have a concrete part lengthened in cast unit drawings, you must enter a negative value for shortening in the part properties dialog box.

1. Double-click a part to open the part properties dialog box.
2. Go to the **Deforming** tab.
3. In the **Shortening** box, enter a negative value.
   For example, \(-20\) would result in a part that is cast 20 units longer in the drawing than the part in the model.
4. Click **Modify**.

**See also**
Shorten or lengthen parts (page 482)

**Shorten parts in drawing views**
If parts are large and do not include any important details, you can shorten them in drawing views by cutting them.

Parts are only cut in empty areas. If there is something important, for example, a stiffener in the part, the part is not cut in that area, because that area is not considered empty.

1. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. Click **View creation**, select the view and the properties that you want to change, and click **View properties**.
4. Go to the **Attributes 2** tab.
5. In **Cut parts**, select one of the following:
   - **Yes** to cut in both X and Y direction.
   - **Only in X direction**
   - **Only in Y direction**
6. In **Minimum cut part length** and **Space between cut parts**, select how to cut the middle regions of the parts in drawing views.

   The **Minimum cut part length** defines how long the part must at least be to get shortened. The length of the part must be at least twice the entered value.

   The **Space between cut parts** defines the distance between cut parts on paper. For example, try 3.0 mm.

7. Set **Cut skew parts** to **Yes** to also cut skew parts in views.

8. To save the changes, click **Save**.

9. Click **Close**.

10. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**Related advanced options**

- You can show view shortening symbols in drawings by setting the advanced options `XS_DRAW_VERTICAL_VIEW_SHORTENING_SYMBOLS_TO_PARTS` and `XS_DRAW_HORIZONTAL_VIEW_SHORTENING_SYMBOLS_TO_PARTS` to **TRUE** through **File menu --> Settings --> Advanced options --> Drawing Properties**.

- You can also control the appearance of the view shortening symbol with the advanced options `XS_SHORTENING_SYMBOL_COLOR`, `XS_SHORTENING_SYMBOL_LINE_TYPE`, and `XS_SHORTENING_SYMBOL_WITH_ZIGZAG`.

**Examples**

Below is an example of a part before and after cutting. Note that the width is the same in the non-cut and cut part. **Minimum cut part length** is 1' 4" and cut length is 3/8".
The following example describes the meaning of **Minimum cut part length**, **Space between cut parts**, and an area that is not considered to be empty in the part, and therefore the part is not cut. **Minimum cut part length** is set to 650, which means that the part is shortened in the view at 650.

1. **Space between cut parts** is set to 1. This means the distance between cut parts on paper (not in model).
2. There is not enough empty area between the stiffeners, and that is why the part is not shortened at **Minimum cut part length**.

Below is an example of using the advanced options: 
**XS_DRAW_VERTICAL_VIEW_SHORTENING_SYMBOLS_TO_PARTS** and **XS_SHORTENING_SYMBOL_WITH_ZIGZAG**.
Lengthen shortened parts in drawing views

You can stretch shortened drawing views to fill up empty areas of the drawing.

After Tekla Structures has scaled drawing views and selected the drawing size, it may stretch shortened views to fill up empty areas of the drawing.

1. On the Drawings & reports tab, click Drawing properties and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. Click Layout and go to the Other tab.
4. Set Expand shortened parts to fit to Yes.
5. To save the changes, click Save.
6. Click OK and create the drawing.

See also
Shorten or lengthen parts (page 482)
Unfold polybeams in drawings

When you create a drawing, you can automatically unfold polybeams and bent plates in single-part drawings. Tekla Structures unfolds the polybeams according to unfolding parameters, which define the location of the neutral axis when a profile is unfolded.

Limitations:
- You can unfold only beams that have been created with the Polybeam command. You cannot unfold beams created with the Curved beam command.
- You can unfold a polybeam only on one plane.

2. Load drawing properties that are as close to the ones you need as possible.
3. Click View creation in the options tree and go to the Attributes tab.
4. Set Unfolded to Yes.
5. To save the changes, click Save.
6. Click OK and create the drawing.

Tekla Structures unfolds the polybeam in the single-part drawing.

NOTE The Unfolded setting in the View Properties properties dialog box on the Attributes 2 tab is ignored in drawing creation when you set this option on the Attributes tab of the Single-part drawing properties dialog box.

See also

View properties in drawings (page 692)
Undeform deformed parts in drawings
You can undeform warped or cambered parts and show the developed (undeformed) shape of deformed parts in drawings.

Deformed parts are parts that have been warped or cambered in the model. You may want to undeform these parts if you want a concrete part to have two states: as erected (in the model view) and as cast (in the drawing view), for example.

**NOTE** Part shortenings are hidden if you set Undeformed to No.

1. On the Drawings & reports tab, click Drawing properties and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. Click View creation and go to the Attributes tab.
4. To hide deforming angles and cambering, set Undeformed to Yes.
5. To save the changes, click Save.
6. Click Close.
7. Click Save to save the drawing properties, then click OK and create the drawing.

The created drawing shows the developed shape and dimensions of the part. See below for an example of a undeformed part in a drawing.

See below for an example of a warped part in a drawing.
The Undeformed option value in the View Properties properties dialog box on the Attributes 2 tab is ignored in drawing creation when the Undeformed option is set to a value on the View creation --> Attributes tab.

See also

View properties in drawings (page 692)

Show part openings and recesses in drawings
You can select whether you want to show symbols for part openings and recesses (blind holes) in drawing views.

1. On the Drawings & reports tab, click Drawing properties and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. Depending on the drawing type, do one of the following:
   Single-part, assembly and cast unit drawings:
   a. Click View creation, select the view and the properties that you want to change, and click View properties.
   b. Go to the Attributes 2 tab.
   c. Set Show openings/recess symbol to Yes.
   d. Save the view properties and click Close.
   General arrangement drawings:
   a. Click View.
   b. On the Attributes tab, set Show openings/recess symbol to Yes.
   c. Click OK.
4. Click Save to save the drawing properties, then click OK and create the drawing.

By default, Tekla Structures displays openings and recesses in the following way:

<table>
<thead>
<tr>
<th>Type of opening</th>
<th>Shown as</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hole through a part</td>
<td>Hole symbol</td>
<td><img src="image" alt="Example" /></td>
</tr>
<tr>
<td>Type of opening</td>
<td>Shown as</td>
<td>Examples</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Recess in the front face of a part</td>
<td>Recess symbol and bounding lines shown as unbroken lines</td>
<td><img src="image1" alt="Example" /></td>
</tr>
<tr>
<td>Recess in the back face of a part</td>
<td>Recess symbol and bounding lines shown as dashed lines</td>
<td><img src="image2" alt="Example" /></td>
</tr>
<tr>
<td></td>
<td>Remember to switch hidden lines on for parts.</td>
<td></td>
</tr>
</tbody>
</table>

### Add symbols in openings and recesses

Tekla Structures has some advanced options that you can use for adding symbols in openings and recesses in your drawings.

1. **On the File menu, click Settings --> Advanced options and go to Drawing Properties.**
2. **Set the advanced option `XS_USE_CROSS_FOR_OPENING_SYMBOL` to `FALSE`** to show the openings and recesses as follows:
   - ![Symbol 1](image3)
   - ![Symbol 2](image4)
   - ![Symbol 3](image5)
   - ![Symbol 4](image6)
3. **Set `XS_USE_OPENING_SYMBOL_IN_BORDER_HOLES` to `TRUE`** to show opening/recess symbols in openings located at part borders. This advanced option is by default set to `FALSE`. The symbol used depends on the setting of the advanced option `XS_USE_CROSS_FOR_OPENING_SYMBOL`.
   - ![Symbol 5](image7)

---

Define automatic drawing settings 490 Automatic drawing views
4. Set `XS_USE_OPENING_SYMBOL_IN_CORNER_HOLES` to `TRUE` to show opening/recess symbols in openings located in part corners. This advanced option is by default set to `FALSE`. The symbol used depends on the setting of the advanced option `XS_USE_CROSS_FOR_OPENING_SYMBOL`.

See also

View properties in drawings (page 692)
Automatic drawing views (page 461)

Define automatic section view properties
You can set some automatic properties for section views before you create a drawing. Properties for automatic section views need to be set in two places in drawing properties: in the Section view pane, and in View creation --> View properties. The settings on the Section view pane apply to all section views in the drawing.
1. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type.

2. Load drawing properties that are as close to the ones you need as possible.

3. Click **Section view**.

4. On the **Attributes** tab, set values for options **Section depth** and **Distance for combining cuts**:
   - **Section depth** defines the positive and negative depth of the section view when sections are not combined. In an open drawing, you can adjust the section view depth also by dragging the view boundary.
   - **Distance for combining cuts** defines the distance range for combining cut views.
   - You can additionally control which section views get combined using the advanced option `XS_DRAWING_CUT_VIEW_COMPARISON_CRITERIA`.

5. Still on the **Attributes** tab, set the direction of the **Left section**, **Middle section** and **Right section** to **left** or **right**.

6. Go to the **Cutting line** tab and set the section mark line length and offset (distance between the section mark and the section).

7. Go to the **Section mark** tab and modify the section mark settings:
   a. Click the ... button next to **A1 - A5** to open the **Mark Contents** dialog box.
   b. Select the elements that you want to include in the mark.
   c. If needed, select an element from the list and click **Add frame** and select the frame **Type** and **Color**.
   d. If needed, select an element from the list and select the text **Color**, **Font** and **Height**.
   e. Go to the **Position** tab and select the side to show the text, the text position, the horizontal and vertical offset, and the text rotation options.
   f. In **Start number or letter of section view and symbol label**, select whether you want to start the section view and section symbol labels with a number or a letter:
      - You can enter any number starting from 1, or any letter A - Z or a - z (also shown in uppercase in the label).
      - If you use a letter, and the entered string is longer than one letter, only the first letter is shown. If you use numbers, all entered numbers are shown.
      - The start number in the label changes only when you change it in the drawing properties before creating a drawing, and when you...
change it in an existing drawing and recreate the drawing, in which case the labels for all automatically included section views and all new section views will change.

g. Click OK to return to drawing properties.

8. Click **View creation** and add the section and end views you want to create.

9. Still in the **View creation** panel, select the view and the properties that you want to change and click **View Properties**.

10. Adjust the view properties as required.

11. Click **Save** to save the view properties.

12. Click **Close**.

13. Repeat steps 9 - 12 for all the section and end views you create.

14. To save the changes, click **Save**.

Now you can create drawings with automatic section or end view properties that you just modified and saved.

**See also**

View properties in drawings (page 692)
Section view properties (page 697)
Examples of section view and mark settings (page 493)

**Examples of section view and mark settings**

**Combining section views**

1. Distance for combining cuts = 1' - 4"
2. Section depth = 4"
3. Combined sections
**Section view direction**
The arrow in the section view symbol indicates the direction of the section view, as shown below:

1. Left section, right direction
2. Middle section, right direction
3. Right section, left direction

**Section marks**
See below for examples of section marks:

See also
*Define automatic section view properties (page 491)*
*View properties in drawings (page 692)*
*Section view properties (page 697)*

**Show section and end view direction marks in drawings**
You can display view direction marks in section views and end views in drawings.
1. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type.

2. Load drawing properties that are as close to the ones you need as possible.

3. Click **View creation**, select the view and the properties that you want to change, and click **View properties**.
   
   In this case, select a section view or an end view.

4. Go to the **Label** tab in **View Properties**.

5. Select one of the options in **View direction marks: Show marks**:
   - **Symbol only**
   - **Label only**
   - **Symbol and label**
   - **None** does not show any marks.

6. Define the height of the symbol and text label in **Height**.

7. To save the changes, click **Save**.

8. Click **Close**.

9. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

The view direction mark is shown with a small symbol (optionally with a text label) around the end or section view.

- The view direction mark is shown with a small symbol (optionally with a text label) around the end or section view.

The view orientation mark position follows the label position setting. In the image below, **Center by view restriction box** has been selected for the label.
Tips

• You can drag view direction marks to a better place in a drawing view: click the view frame to activate the handles, point the handle, press and hold down the left mouse button and drag. The view frame is resized automatically, if necessary.

• You can define the view direction mark symbol in File menu -- Settings -- > Advanced options --> Drawing Properties by using the following advanced options:
  • XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_BACK
  • XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_BOTTOM
  • XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_FRONT
  • XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_TOP

  The default symbol is xsteel@66.

See also

Section view properties (page 697)
Define the location for end views and section views
You can always place section views and end views next to the main view or in any empty location in a single-part, assembly, and cast unit drawing.

1. On the Drawings & reports tab, click Drawing properties and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. Click Layout and go to the Other tab.
4. Set Align end views with main view to Yes to place the views next to the main view.
5. Set Align section views with main view to Yes to place the views next to the main view.
6. To save the changes in a drawing properties file, click Save at the top.
7. Click OK and create the drawing.

If you select No, Tekla Structures places the section and end views in any available location.

Example
End and section views in any location (No selected).

End and section views beside the main view (Yes selected).
Dimensions are associative annotation objects that represent building object measurements. Dimensions are more than lines or vectors; they are interactive callouts of geometry. In automatic dimensioning Tekla Structures creates dimensions in the whole drawing or in drawing views based on dimensioning settings you define before creating the drawing.

In single-part, assembly and cast unit drawings automatic dimensions are set view by view.

In general arrangement drawings, automatic dimensions are set for the whole drawing.

You can define automatic dimensions settings before you create a drawing and you can also modify the settings after you have created the drawing.
<table>
<thead>
<tr>
<th>To</th>
<th>Click the links below to find out more</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create automatic dimensions in single-part, assembly or cast unit</td>
<td><strong>Automatic view-level dimensions</strong> (page 500)</td>
</tr>
<tr>
<td>views</td>
<td><strong>Add automatic view-level dimensions</strong> (page 504)</td>
</tr>
<tr>
<td></td>
<td><strong>Example workflow: Create automatic overall and hole dimensions on view level</strong> (page 510)</td>
</tr>
<tr>
<td>Check the settings affecting dimension creation</td>
<td><strong>Dimensioning rule properties</strong> (page 518)</td>
</tr>
<tr>
<td></td>
<td><strong>Create a drawing view filter for view-level dimensioning</strong> (page 527)</td>
</tr>
<tr>
<td></td>
<td><strong>Create a filter that is needed in view-level dimensioning for selecting the objects that you want to</strong></td>
</tr>
<tr>
<td></td>
<td><strong>dimension</strong></td>
</tr>
<tr>
<td></td>
<td><strong>See examples of different combinations of dimensioning types and settings</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Various scenarios of using different dimensioning types</strong> (page 535)</td>
</tr>
<tr>
<td></td>
<td><strong>Example: Use both view-level dimensioning and integrated dimensioning</strong> (page 535)</td>
</tr>
<tr>
<td></td>
<td><strong>Example: Use only integrated dimensioning</strong> (page 537)</td>
</tr>
<tr>
<td></td>
<td><strong>Example: Use only view-level dimensioning</strong> (page 536)</td>
</tr>
<tr>
<td></td>
<td><strong>Examples: Dimensions created with view-level dimensioning</strong> (page 539)</td>
</tr>
<tr>
<td></td>
<td><strong>Use the traditional way of dimensioning in the Dimensioning dialog box by using the dimensioning</strong></td>
</tr>
<tr>
<td></td>
<td><strong>type Integrated</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Add automatic view-specific dimensions using dimensioning type Integrated</strong> (page 545)</td>
</tr>
<tr>
<td></td>
<td><strong>Create dual dimension tags automatically in all types of drawings</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Add automatic dual dimensions</strong> (page 570)</td>
</tr>
<tr>
<td></td>
<td><strong>Control the dimensions that Tekla Structures adds for unfolded parts</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Add dimensions to unfolded parts</strong> (page 571)</td>
</tr>
<tr>
<td></td>
<td><strong>Create minimum and maximum position dimensions for bolts</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Add minimum and maximum position dimensions to bolts</strong> (page 572)</td>
</tr>
<tr>
<td></td>
<td><strong>Add extensions to dimension lines</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Create dimension line extensions</strong> (page 573)</td>
</tr>
<tr>
<td></td>
<td><strong>Adjust extension line settings</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Set the dimension extension line length</strong> (page 210)</td>
</tr>
<tr>
<td></td>
<td><strong>Adjust absolute dimensions</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Change the appearance of absolute dimensions</strong> (page 574)</td>
</tr>
<tr>
<td>To</td>
<td>Click the links below to find out more</td>
</tr>
<tr>
<td>-------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Exaggerate narrow dimensions to make them easier to read</td>
<td>Create exaggerated dimensions (page 574)</td>
</tr>
<tr>
<td>Use another prefix in radial dimensions</td>
<td>Change the prefix in radial dimensions (page 576)</td>
</tr>
<tr>
<td>Dimension plates using advanced options</td>
<td>Add dimensions to plates (page 577)</td>
</tr>
<tr>
<td>Adjust profile dimensioning using dimension planes table</td>
<td>Add dimensions to profiles (page 580)</td>
</tr>
<tr>
<td>See examples of sloped dimension texts</td>
<td>Sloped dimension texts (page 583)</td>
</tr>
<tr>
<td>Add automatic dimensions in general arrangement drawings</td>
<td>Add automatic dimensions to general arrangement drawings (page 584)</td>
</tr>
</tbody>
</table>

**Automatic view-level dimensions**

Automatic view-level dimensioning gives you full control on the dimensions in each drawing view you create, with a lot of dimensioning options. Automatic view-level dimensioning can be used in single-part, assembly and cast unit drawings.

In view-level dimensioning, the dimensions are created based on the rules you define. You can define what you want to dimension, where the dimensions are placed, in which order they are created, and which settings you want to use for each dimension. You can dimension shapes and holes, for example.

Below you can find short description on how to proceed in dimensioning.

1. When you click the **View creation** option in the options tree in drawing properties, you are able to select the views to be created and the view properties to be used.
2. Click **View properties**.

3. Click **Dimensioning** in the options tree.

   In the **Dimensioning** panel, you can add rules by clicking **Add rule**. Then select which dimensioning rules you want to use in the **Dimensioning type** column and the desired dimensioning rule properties file.

4. You can modify the selected rule by clicking **Edit Rule**.

   In the **Dimensioning Rule Properties** dialog box, you can select what to dimension, how to dimension, which objects to measure from, where to place the dimensions, and select the dimension properties. The **Dimension properties** list contains properties files that you have saved in the object level **Dimension Properties** dialog box in an open drawing. For example, you may want to use some special font or color in the dimensions. To do this, double-click a dimension in a drawing, make the necessary changes and save the properties file. Then you can load the properties here.
If you select **Integrated dimensions**, the **Dimensioning Properties** dialog box is displayed. Make your changes to the settings on the tabs and save the properties file with a unique name using **Save as**. You can also load dimension properties here as well.
5. When you have set the rule properties, give a name to the rules file and click **Save as**.

6. Click **Close** to return to the **Dimensioning** panel.

7. Ensure that you have selected correct dimensioning properties files for the dimensioning rules.
8. Enter a unique name for the view properties in the box at the top of the View Properties dialog box and click Save. Now you can select the saved view properties for a view in the View creation panel. These view properties contain the saved dimensioning properties.

See also
Dimensioning rule properties (page 518)
Add automatic view-level dimensions (page 504)
Add automatic view-specific dimensions using dimensioning type Integrated (page 545)

Add automatic view-level dimensions
The next examples will go through the basic workflow of creating automatic dimensions on view level. The goal is to create drawing properties that you can use later on to create similar drawings, including all necessary views, having the dimensions that you want, just by loading the appropriate drawing properties file and then creating the drawing. The workflow consists of four tasks:

1. Define the drawing properties file (page 504)
2. Define the drawing views to be created (page 505)
3. Define view dimensions (page 506)
4. Connect view properties to views and save drawing properties (page 509)

Define the drawing properties file
Create a drawing properties file that will pull together all the settings that you define in the Drawing Properties dialog box, including view-level dimension settings. This is phase 1 in the workflow Add automatic view-level dimensions (page 504).

1. On the Drawings & reports tab, click Drawing properties and select the drawing type.
2. In the drawing properties dialog box, load the drawing properties that you want to use as a basis for the new properties by selecting from the list at the top.

If you do not have any suitable drawing properties available, give the drawing properties file a unique name and save the properties by clicking Save.

Now you have created a drawing properties file where you can save the new dimensioning settings.

**Define the drawing views to be created**

Select the views you want to create. This is phase 2 in the workflow Add automatic view-level dimensions (page 504).

To create the desired views and define the view properties to use:

1. On the Drawings & reports tab, click Drawing properties and select the drawing type.
2. Load the drawing properties that you created and saved in the phase 1 of this workflow.
3. Click View creation in the options tree.
4. In the next panel, click Add row to add new views in your drawing.

5. For those views that you want to create, set the on/off control to On.
   If you select Auto, the view is created if relevant dimensions are created with the used dimensioning settings. If relevant dimensions are not
created, neither is the view. Tekla Structures can automatically decide whether dimensions are relevant or not.

Now you have defined the views that you want to have in the drawing you will create. You can save the list of views using **Save**, and then load it if you need the same set of views in another drawing.

**Define view dimensions**

Define the dimensioning rule properties to be used in the drawing views that you just created. This is phase 3 in the workflow **Add automatic view-level dimensions (page 504)**.

If you are planning to use filters to select the parts that you want to dimension, you need to create the drawing view filters first, for example, for selecting embeds, inner panels or outer panels.

You need to create separate dimensioning rules for each dimensioning type. For example, the rules made with **Overall dimensions** are valid for **Overall dimensions** only, not for **Shape dimensions**, for example.

To define dimensions for a view:

1. Select a view in the **View creation** panel and click **View properties**.
2. In the **View Properties** dialog box, click **Dimensioning** in the options tree to define the dimensions to be created for the selected view.
3. Click **Add row** to add a rule.

   Here we add two rows.

   The order of the rules in the list defines the order of the dimension lines in the drawing: the dimension created by the first rule is placed closest to the dimensioned object

   At the moment, the filter can only be set for the **Integrated** dimensions in this panel. You are able to select the filter in the **Dimensioning Rule Properties** dialog box, and you can leave the selection **Current assembly** in the **Filter** column for all rules.

   Leave **Current assembly** in the **Filter** column.

4. Select the **Dimensioning type** for the selected rules.
Here we select overall dimensions and hole dimensions:

5. Click one of the rules and click **Edit Rule**.

6. In the **Dimensioning Rule Properties** dialog box, define what to dimension, and where and how to place the dimensions. From the **Dimension properties** list, select a suitable set of saved dimension properties to change the dimension appearance, dimension text font size or color, for example.
7. Give the dimensioning rule a unique name and click **Save as**.
8. Click **Close**.
9. Define other dimensioning rules needed for the view following the steps 5 - 8.
10. Select correct properties for the rules.
Even though the dimension lines are created and placed by default in the order that you define them in the View creation panel, Tekla Structures searches for the first suitable location for the dimension lines according to the placement and protection settings. So the dimension placement may not always follow the creation order. Check the result and adjust the location of the dimension lines if necessary.

11. In the top-left corner, give a unique name to the view properties and click Save to save your changes to the view properties file.

Now you have created new view properties containing two types of dimensions. You can connect this properties file with a drawing view and use the defined dimensions in that view.

**Connect view properties to views and save drawing properties**

Connect then new view properties to drawing views and save drawing properties. This is phase 4 in the workflow Add automatic view-level dimensions (page 504).

1. In the View creation panel, select correct view properties for the views that you are creating.
In the example below, one front view and one section view are created, and the views have been connected to view properties cu_FRONT and cu_SECTION.

2. Remember that you created or loaded the drawing properties file in phase 1 of this workflow. Click Save to save the drawing properties, then click OK and create the drawing.

Tekla Structures creates the drawing according to the definitions in various properties files.

**Example workflow: Create automatic overall and hole dimensions on view level**

In this example workflow, you will create a cast unit wall panel drawing that contains

- one front view with automatic overall and hole dimensions
- one section view with overall dimensions

In overall and hole dimension rules you will apply the dimension properties that you have earlier created and saved manually in a cast unit drawing. You will save the created dimensioning rule properties in view properties. Finally, you will save the created view properties in drawing properties and create a cast unit drawing.

Before starting, create manually in the object-level **Dimension Properties** dialog box in an open cast unit drawing a dimension properties file **dim_font_5**, where the dimension text font size is 5.00, and a dimension properties file **dim_red**, where the dimension color is red.

In this example, you are going to dimension the following cast unit wall panel in the model:
Define the views to be created

1. On the Drawings & reports tab, click Drawing properties --&gt; Cast unit drawing.
2. Load drawing properties that are as close to the ones you need as possible.
3. Click View creation in the options tree.
4. In the View creation panel, click Add row to add new views in your drawing.

   In this example, you want to add two views, one front view and one section view.

Define automatic drawing settings 511 Automatic dimension settings
5. Set the **on/off** setting to **On** for the views that you want to create. If the list contains extra views, set them to **Off** or use the **Delete row** button to delete them.

Now you have defined the views that you want to create. Next, you need to define the dimensions that you want to have in the front view and section view.

**Define front view dimensions**

1. Select a view in the **View creation** list.
   In this example, select one **Front** view.

2. Click **View properties** and then click **Dimensioning** in the option tree to define the dimensions to be created in the front view.

3. In the **Dimensioning** panel, use **Add row** to add two new dimension rules in the dimensioning rules list.

4. Select **Overall dimensions** as the first rule and **Hole dimensions** as the second.

   The order of the rules in the list defines the order of the dimension lines in the drawing: the dimensions created by the first rule is placed closest to the dimensioned part.

   Leave **Current assembly** in the **Filter** column for both rules.

5. To define overall dimension rules, click the **Overall dimensions** row, and click **Edit Rule**.
6. In the **Dimensioning Rule Properties** dialog box, define what to dimension, where and how to place the dimensions, and which dimension properties to use.
   - Select the check boxes above and on left side of the object, and also the check box in the upper-left corner to link the dimensions together.
   - Use default values in the **Start point** lists. The default values are left for the **Horizontal** and bottom for the **Vertical** dimension.
   - From the **Dimension properties** list, select a suitable set of saved dimension properties. In this example, select the dimension properties file `dim_font_5`, which contains a definition for a larger font.
   - Give the dimensioning rule a unique name and click **Save as**. In this example, the name **overall** is used.

![Dimensioning Rule Properties dialog box](image)

7. Click **Close**.

8. Next, define the hole dimensions. In the **Dimensioning** panel, select **Hole dimensions** from the dimensioning rules list and click **Edit Rule**.
9. Create dimensioning rules for hole dimensions:
   • Select the check boxes above and on left side of the object, and also the check box in the upper-left corner to link the dimensions together.
   • Use the default values in the Start point lists.
   • In Close lines, select the setting that extends the dimension lines to the other end of the cast unit.
   • In Dimension to, select the setting that dimensions to both ends.
   • From the Dimension properties list, select a suitable set of saved dimension properties. In this example, select the dimension properties file dim_red containing a definition for red dimensions.
   • Give the hole dimensioning rule a unique name and click Save as. In this example, the name hole is used.

10. Click Close.
11. For the **Overall dimensions** rule, select **overall** properties, and for the **Hole dimensions** rule, select **hole** properties from the **Properties** column.

<table>
<thead>
<tr>
<th>Dimensioning rules:</th>
<th>Dimensioning type</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current assembly</td>
<td>Overall dimensions</td>
<td>overall</td>
</tr>
<tr>
<td>Current assembly</td>
<td>Hole dimensions</td>
<td>hole</td>
</tr>
</tbody>
</table>

12. In the **View Properties** dialog box, give the front view properties a unique name and click **Save as**.

In this example, the front view properties are saved with the name **CU_Front**.

Now you have saved the view properties for the front view containing overall and hole dimensions. Leave the **View Properties** dialog box open for further modifications.

**Define section view dimensions**

A section view is also needed in the cast unit drawing, because you want to show the wall thickness. Next, you will create overall dimensions for the section view.

1. In the **View creation** panel, select the **Section views** row and click **View properties**.

2. Load the view properties file **CU_Front**.

   You can start creating new view properties on the basis of already existing view properties.

3. Click **Dimensioning** in the options tree.

4. In the **Dimensioning** panel, delete the unnecessary hole dimension rule by clicking the **Hole dimensions** row and **Delete row**.

   You will only need the overall dimensions in the section view.

5. Click the **Overall dimensions** row and click **Edit Rule**.

6. Create a dimensioning rule for the overall dimensions in the section view:
   - Select the check box below the object only, because you only want to show the thickness.
   - Select the same dimension properties as for the overall dimensions in the front view, because you want to show the dimension text with a little bit larger font: **dim_font_5**.
• Give the rule a unique name and click **Save as**.
In this example, the name **thickness** is used.

In the **Dimensioning** panel, select **thickness** in the **Properties** column as the property file for the overall dimensioning rule.

9. Give a unique name for the section view properties and click **Save as**.
In this example, the name **CU_Section** is used.

10. Click **OK**.
Now you have saved the view properties for the section view containing overall dimensions.

**Connect view properties to views and save drawing properties**

1. In the **View creation** panel, select **CU_Front** for the front view and **CU_Section** for the section view.
2. In the **Drawing Properties** dialog box, give the drawing properties a unique name and click **Save**.

   In this example, the name `cu_wall_panel` is used.

![Cast Unit Drawing Properties](image)

3. Click **OK** and create the cast unit drawing.

   Tekla Structures creates the cast unit drawing according your definitions in different properties files. The cast unit drawing contains a front view and a section view. The overall dimensions in both views have a little bit larger font, and the front view has red hole dimensions. Only the wall thickness is dimensioned in the section view.

   You can use the drawing properties file `cu_wall_panel` later on when you need drawings with similar settings.
**TIP** You can still change the dimensioning settings in the views after creating the cast unit drawing:

1. Double click the drawing view frame to open the view properties dialog box.
2. Click **Dimensioning** in the options tree to open the **Dimensioning** panel where you can select and then edit the dimensioning rules.
## Dimensioning rule properties

The following table describes the options and their settings in the **Dimensioning Rule Properties** dialog box. This dialog box can be opened by selecting **View creation** in a **Drawing Properties** dialog box, selecting a view row and then clicking **View Properties --> Dimensioning --> Edit Rule**.

If you have selected Integrated (page 545) as the dimension type, the **Dimensioning properties** (page 709) dialog box will be displayed instead.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>What is dimensioned</strong></td>
<td>Sets the dimensioning type:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Overall dimensions</strong> creates dimensions for the bounding box of the objects you select in the <strong>Measure from</strong> list.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Edge shape</strong> creates dimensions for the edge of the object selected in the <strong>Measure from</strong> list.</td>
</tr>
<tr>
<td></td>
<td>For sandwich walls, the default setting <strong>Cast unit / Assembly</strong> may not give the desired result with <strong>Edge shape</strong>. Then you can dimension the internal and external layers separately according to the part name.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Secondary parts</strong> creates dimensions for the secondary parts of a cast unit or an assembly.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Holes</strong> creates dimensions for the holes of the objects selected in the <strong>Measure from</strong> list. The hole dimensions are combined according to the <strong>Combine on one line</strong> setting.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> The <strong>Holes</strong> dimensioning type does not dimension bolts, you need to use the <strong>Integrated dimensions</strong> to get the bolt dimensions.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Recesses</strong> creates dimensions for the recesses of the objects selected in the <strong>Measure from</strong> list. The hole dimensions are combined according to the <strong>Combine on one line</strong> setting.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Distance to grid</strong> creates dimensions from the grid line to the bounding box of the object selected in the <strong>Measure from</strong> list. This setting works only when the grid lines are visible.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Filter</strong> can be used to dimension anything that can be filtered. It is often used when dimensioning embeds. For example, you can</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Dimension line location and linking</td>
<td>Controls on which sides of the cast unit the dimensions will be created.</td>
</tr>
</tbody>
</table>

- Dimension line locations are rotated together with the drawing view if the view is manually rotated.
- When selecting both sides, top and bottom or left and right, the objects will be dimensioned on the side that is closest to the object.
- When only a part of the cast unit is selected for the rule, one of the check boxes will be dimmed and you cannot select it.
- When you have selected one vertical and one horizontal dimension line, the linking check boxes in the corners are activated, and you can link the perpendicular dimension lines. The check boxes are dimmed by default.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td></td>
</tr>
<tr>
<td>• You can select objects for dimensioning from the whole cast unit or only from one half of the cast unit. If you do this, objects in the other half will be ignored in dimension creation. The default value is the whole cast unit.</td>
<td></td>
</tr>
</tbody>
</table>

**Orientation**

Orients the dimensions along the sloped edge of a part. Another possibility is to create horizontal or vertical dimensions.

- This option is visible only when the dimensioning type **Filter** or **Edge shape** is selected.
- When **Filter** is selected, there are two settings available for orientation.

The first setting places the dimensions along the sloped edge:

The second setting places the dimensions horizontally and vertically:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum length for skew section</td>
<td>Defines the minimum length of skewed sections when dimensions are still created for skew sections. The default value is 300 mm. For example, when you use the value 500 mm and the skew section is shorter than 500 mm, the</td>
</tr>
</tbody>
</table>

- When **Edge shape** is selected, there are three settings available for orientation. First two settings work in the same way as the first two **Filter** settings. The first setting is the default value. The third one creates both dimensions:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Dimensions are not created along the skew section, but horizontally and vertically instead.</td>
</tr>
<tr>
<td><strong>Start point</strong></td>
<td>Defines where the origin points for the dimensions are:</td>
</tr>
<tr>
<td></td>
<td>• The default values are left for the <strong>Horizontal</strong> and bottom for the <strong>Vertical</strong> dimension.</td>
</tr>
<tr>
<td></td>
<td>• The setting marked with symbol shows chooses the nearest edge as the dimension origin, for every dimension separately. In the example below, the object is closer to the right edge, and so the horizontal dimension starts from there.</td>
</tr>
<tr>
<td><strong>Vertical = Horizontal</strong></td>
<td>Often the settings are similar for both directions, and when this option is used, only vertical settings need to be set.</td>
</tr>
<tr>
<td><strong>Close lines</strong></td>
<td>Defines whether the dimension lines extend to the other end of the cast unit or assembly or not</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Dimension lines</td>
<td>The dimension lines extend to the other end by default.</td>
</tr>
</tbody>
</table>
| Dimension to      | Defines which points of the selected objects are dimensioned:  
• **Both ends** is the default.  
• If you select the center point setting and the object is a custom part (=embed), Tekla Structures will use the component insertion point, which is not always in the center. For other objects, the actual center point will be used. |
| Round holes       | Defines whether the round holes will be dimensioned by center point or diameter:  
• This option is visible only when **Holes** or **Recesses** is selected.  
• The diameter is the default value.  
• Currently, round holes are identified only by cut part profile (prefix D). If you create the round hole using round chamfers, for example, the hole will not be dimensioned. |
| Dimension properties | **Attribute file** takes into use the dimensions properties defined in the dimension properties file that has been saved earlier on the object level **Dimension Properties** dialog box in a drawing. The default value is **standard**. |
| Measure from      | Defines the objects that will be used as the origin point for the dimensions. The available settings are:  
• **Cast unit/Assembly**: This is the default value. If you select this setting, you have three more settings available:  
• **Only concrete/steel parts**: For a cast unit, only concrete parts are used, and for steel only steel parts. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All parts</td>
<td></td>
</tr>
<tr>
<td>All parts and rebars</td>
<td></td>
</tr>
<tr>
<td><strong>Main part</strong>: This setting uses cast unit or assembly main part.</td>
<td></td>
</tr>
<tr>
<td><strong>Part name</strong>: If you select <strong>Part name</strong>, you can define the part name.</td>
<td></td>
</tr>
<tr>
<td><strong>Filter</strong>: If you select <strong>Filter</strong>, you can use a predefined filter for selecting the objects that you want to use as dimension origin points.</td>
<td></td>
</tr>
<tr>
<td><strong>Current part</strong>: Select <strong>Current part</strong> when you are dimensioning a single part.</td>
<td></td>
</tr>
<tr>
<td><strong>Bounding box</strong>: Uses the bounding box of an object as the origin point for the dimensions. This option is only available in filter, hole, recess and secondary part dimensioning.</td>
<td></td>
</tr>
<tr>
<td><strong>Nearest edge</strong>: Uses the nearest edge an object as the origin point for the dimensions. This option is only available in filter, hole, recess and secondary part dimensioning.</td>
<td></td>
</tr>
<tr>
<td><strong>Combine on one line</strong></td>
<td>Creates a rule based on a filter, for example, for embeds (EB_*), and then groups the embeds according to the main part name, so that embeds with different names will get their own dimension lines. The filtered object can be a part, a reinforcing bar or an assembly. The available settings are:</td>
</tr>
<tr>
<td>All objects</td>
<td>(default)</td>
</tr>
<tr>
<td>By name</td>
<td></td>
</tr>
<tr>
<td>By position number</td>
<td></td>
</tr>
<tr>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

When **Holes** or **Recesses** is selected, the **Combine on one line** option changes to display suitable settings for holes or recesses. The available settings are:

<p>| All holes              | (default)                                                                                                                                                                                                    |
| Any holes of the same size |                                                                                                                                                                                                                   |
| By cut part name       |                                                                                                                                                                                                             |
| No                     |                                                                                                                                                                                                             |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Combine only objects that have the same</td>
<td>Combines only the dimensions of objects that are on the same horizontal or vertical line, or dimensions of objects that have the same Z coordinate. By default, these options are not selected.</td>
</tr>
<tr>
<td>X or Y coordinate</td>
<td></td>
</tr>
<tr>
<td>Z coordinate</td>
<td></td>
</tr>
<tr>
<td>Tolerance</td>
<td>The tolerance is the maximum distance between objects when Tekla Structures still considers the objects to be on the same line. 50 mm is the default value.</td>
</tr>
<tr>
<td>Preferred combining direction</td>
<td>Sets the preferred direction for combining dimensions if an object can be combined both in horizontal and in vertical direction. X is the default value.</td>
</tr>
<tr>
<td>Do not create dimensions shorter than</td>
<td>Defines the minimum length of the dimensions for Tekla Structures to create them. 0 is the default value, which means that all dimensions are created.</td>
</tr>
<tr>
<td>Do not dimension holes smaller than</td>
<td>Defines the minimum diameter for the holes for Tekla Structures to create the dimensions. With this option you can prevent the creation of dimensions for small holes. The distance is the shortest dimension of a hole. If any dimension of the hole is larger than the given value, the hole will be dimensioned in all directions. For example, with value 40, a rectangular hole of 80*30 will get both dimensions 80 and 30. Default value is 0, which means that all dimensions are created.</td>
</tr>
<tr>
<td>Component objects</td>
<td>Defines how component objects are dimensioned:</td>
</tr>
<tr>
<td></td>
<td>• <strong>By reference points</strong> (default) places the dimensioning point to the first insertion point of the component. Only one dimension will be created for each component regardless of the number of parts inside the components.</td>
</tr>
<tr>
<td></td>
<td>• <strong>As secondary objects</strong> creates separate dimensions for each part inside the component.</td>
</tr>
</tbody>
</table>

See also

- Add automatic view-level dimensions (page 504)
- Create a drawing view filter for view-level dimensioning (page 527)
- Dimension and dimensioning properties (page 699)
Create a drawing view filter for view-level dimensioning

You need to create a drawing view filter to use the Filter option in view-level dimension creation in single-part, assembly and cast unit drawings. The filter needs to be created on view level, because you createt the dimensions view by view.

1. In an open drawing, double-click the drawing view frame to open the View Properties dialog box.
2. Click Filter.
3. Click Add row and define the filter properties.
   • Add a row first to define the Object type object category. This needs to be defined for all drawing view filters that are going to be used in dimensioning definitions. Set the Value to Part or Reinforcing bar
   • Then add a filter row that selects all parts in a specific class, for example.

4. Use Save to save the filter with a unique name.
5. Click Cancel to close the dialog box.

Now you can select the drawing view filter from the filter list in the Dimensioning Rule Properties dialog box and use it for dimensioning. If the

Define automatic drawing settings 527 Automatic dimension settings
filter is not displayed immediately after creation, refresh the list by closing and opening the dialog box.

Examples

Have a look at some filtering examples:

Create a filter for holes and recesses (page 528)
Create a filter for the main part of an assembly (page 529)
Create an exclude filter for dimension tag (page 530)
Create an exclude filter for stirrups in section views (page 530)

See also

Dimensioning rule properties (page 518)

Create a filter for holes and recesses

You can create a filter for cut parts. The filter can be a drawing view filter or a model selection filter.

To create a model selection filter for holes and recesses:

1. Click the Selection filter button on the Selecting toolbar.
2. In the Object Group - Selection Filter dialog box, add the first row:
   • Select Object as category, Object type as property and Equals as condition.
   • To fill 11 in the value, use Select from model, and select a cut part.
3. Add the second row:
   • Select Template as category, enter NAME in uppercase as property and select Equals as condition.
   • Enter the name of the template as the value.
4. Select check boxes **Selection filter** and **All drawing types**.

   Too see all available filter types, click **>>**

5. Save the filter with a unique name using **Save as**.

   ![Object Group - Selection Filter](image)

See also

*Create a drawing view filter for view-level dimensioning (page 527)*

**Create a filter for the main part of an assembly**

When your subassembly consists of many objects, but you only want to select the main part for dimensioning, you can create a filter for that.
Create an exclude filter for dimension tag

Often several objects need to be excluded from dimension tag content. You can exclude everything else from the tag content, except the parts that you want to include.

With the example filter shown below it is possible to exclude everything else from the tag content, except cut parts that have the name ‘HVAC’.
Create an exclude filter for stirrups in section views
The view-level dimensioning currently dimensions reinforcing bar polygon points along the center line of the reinforcing bar. You can filter, where stirrups (shape 14) are excluded but all other reinforcing bars are dimensioned.

Below is an example of a stirrup in section view. In some cases, the resulting dimensions are created similarly regardless of the hook type.

To avoid this kind of results, you can use suitable filtering criteria. See below for an example of a filter, where stirrups (shape 14) are excluded but all other reinforcing bars are dimensioned.

Dimensioning method of shapes, holes and recesses
The logic and functionality of shape dimensions, hole dimensions and recess dimensions in view-level dimensioning is clear and predictable. The definition, which geometry is shape, hole or recess is done only once for the object to be dimensioned, and that definition is used in all drawing views.
The definition of shape and hole is done by looking at the shadow of an object in three directions X, Y and Z in the following way:

- Points along the outer edge of the shadow are dimensioned as a shape.
- Inner loops in the shadow will be dimensioned as holes.
- All other geometry points that are not visible in the shadow, will be dimensioned as recesses.

In the image below there are some examples of each geometry type:

1. Holes
2. Recesses
3. Shapes

**Examples**

Below is an example of a shape in a model object and the dimensions in a drawing:
Below is an example of a hole in a model object and the dimensions in a drawing:
Below is an example of a recess in a model object and the dimensions in a drawing:
See also
Automatic view-level dimensions (page 500)
Dimensioning rule properties (page 518)

Various scenarios of using different dimensioning types
Depending on what you want to dimension and how, you can create different sets of dimensioning rules to get what you need. Have a look at the examples scenarios below:
1. Example: Use only view-level dimensioning (page 536)
2. Example: Use both view-level dimensioning and integrated dimensioning (page 535)
3. Example: Use only integrated dimensioning (page 537)
**Example: Use both view-level dimensioning and integrated dimensioning**

Both view-level and integrated dimensioning methods are used. This is example 2 in the list of scenarios *Various scenarios of using different dimensioning types* (page 535).

In this example, integrated, overall and shape dimensions are created for both top and front view.

<table>
<thead>
<tr>
<th>Dimensioning rules:</th>
<th>Filter</th>
<th>Dimensioning type</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current assembly</td>
<td>Shape dimensions</td>
<td>shape</td>
<td></td>
</tr>
<tr>
<td>Current assembly</td>
<td>Overall dimensions</td>
<td>overall</td>
<td></td>
</tr>
<tr>
<td>Current assembly</td>
<td>Integrated dimensioning</td>
<td>reinforcement</td>
<td></td>
</tr>
</tbody>
</table>

**Example: Use only view-level dimensioning**

Only dimension types suitable for precast objects are used. This is example 1 in the list of scenarios *Various scenarios of using different dimensioning types* (page 535).

Each rule creates one dimension line on selected sides of the cast unit or assembly. In the image below, four rules have been defined and four dimension lines are created. Only the first rule (shape dimensions) is
configured to create dimensions on all sides. Other rules are configured to create dimensions only on two sides. Rules are executed in the order they appear in the list; the topmost rule first, then the second, and so on. The first rule is closest to the part being dimensioned.

**Example: Use only integrated dimensioning**

Only integrated dimensioning is used for creating the reinforcing bar dimensions. This is example 3 in the list of example scenarios Various scenarios of using different dimensioning types (page 535).

When you select **Integrated dimensions** as the Dimensioning type and click **Edit Rule** in the **View Dimensioning Rules** dialog box, the **Dimensioning Properties** dialog box is displayed. Go to the **Reinforcement dimensions** tab and define the desired properties. On the **General** tab there are some options...
for controlling dimension properties, and you can load object level dimension properties for various dimension types. Save the changes with **Save** or **Save as** to save the properties file for later use.

When you return to the **View Dimensioning Rules** dialog box by clicking **Close**, you can attached the new integrated dimensioning properties to the **Integrated dimensioning** rule.
Examples: Dimensions created with view-level dimensioning

See below for examples of dimensions created with different settings in the Dimensioning Rule Properties dialog box.

Overall dimensions

Edge shape
Secondary parts

Holes

Recesses

Define automatic drawing settings 540 Automatic dimension settings
Distance to grid

Filter: Embeds
Filter: Surface treatment

Filter: Bolts

To get the location of every bolt in the bolt group dimensioned, set **Dimension to midpoint**.
Filter: Reinforcing bars and strands

Use the midpoint option to dimension each bar in a group:

Start point and end point option will dimension the first and the last reinforcing bar in a group:
If you want to have separate dimension lines for reinforcing bars that are not of the same size, set the **Combine on one line** to **By position number**:

To make the rule creation easier, the midpoint setting of the **Dimension to** option works so that it will create dimensions to start point and end point of the reinforcing bars that are parallel to the view plane:

If you want to get different size of reinforcing bars on separate dimension lines, set **Combine on one line** to **By position number**:

Define automatic drawing settings 544 Automatic dimension settings
Add automatic view-specific dimensions using dimensioning type Integrated
In the Dimensioning dialog box, you can control what gets dimensioned and how in a drawing. You can experiment with different combinations of options to achieve different kinds of dimensioning effects.

1. On the Drawings & reports tab, click Drawing properties and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. Click View creation, select the view and the properties that you want to change, and click View properties.
4. Click Dimensioning.
5. Select Integrated dimensions as the dimensioning type, select dimensioning rule properties and click Edit Rule.
6. Select the dimensions to create and adjust the related settings.
   The available tabs and settings depend on the drawing type:
   • On the Part dimensions tab, select the part dimensions to create and adjust the related settings (Dimensioning properties - Part dimensions tab (Integrated dimensioning) (page 716)).
- On the **General** tab, adjust settings related to minimizing the number of views, dimension type, combining dimensions, closing dimensions, limit for dimensioning asymmetry in secondary parts, forward offset, grid dimensions, dimension position, and part marks on dimension line ([Dimensioning properties - General tab (Integrated dimensioning) (page 709)]).

- On the **Position dimensions** tab select the position dimensions to create. They indicate the position of parts in relation to the main part or to work points ([Dimensioning properties - Position dimensions tab (Integrated dimensioning) (page 713)]).

- On the **Bolt dimensions** tab, select the bolt dimensions to create, combine bolt dimensions and select the side for the dimension ([Dimensioning properties - Bolt dimensions tab (Integrated dimensioning) (page 718)]).

- On the **Dimension grouping** tab, group dimensions and adjust the related settings ([Dimensioning properties - Dimension grouping tab (Integrated dimensioning) (page 720)]).

- On the **Sub-assembly** tab, create dimensions for parts in sub-assemblies and adjust the related settings ([Dimensioning properties - Sub-assemblies tab (Integrated dimensioning) (page 721)]).

- On the **Reinforcement dimensions** tab, create dimensions for reinforcing bar groups in cast unit drawings, add dimension marks and adjust the related settings ([Dimensioning properties - Reinforcement dimensions tab (Integrated dimensioning) (page 722)]).

7. Save the dimensioning settings by clicking **Save** and close the dialog box by clicking **Close**.

8. Save the view properties by clicking **Save** and return to the drawing properties dialog box by clicking **Close**.

9. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**See also**

- Add minimum and maximum position dimensions to bolts (page 572)
- Group identical objects to the same dimension line (page 547)
- Add dimensions to unfolded parts (page 571)
- Add elevation dimensions (page 548)
- Add dimensions to plates (page 577)
- Add dimensions to profiles (page 580)
- Create check dimensions (page 550)
- Example: Part dimensioning (page 552)
- Example: Position dimensioning (page 556)
Group identical objects to the same dimension line
You can group identical parts, bolts, components and cuts or shapes to the same dimension line in integrated dimensioning. You also have the option to include automatic dimension tags to grouped dimensions.

1. In the **Dimensioning Properties** dialog box, go to the **Dimension Grouping** tab.
2. In **Activate dimension grouping**, select the objects that you want to group.
3. Highlight a row (**Parts**, **Bolts**, **Components** or **Cuts/Shapes** in the **Activate dimension grouping** list and select the elements by which you define the identical conditions in **grouping properties**.
4. In **Automatic tagging**, select the appropriate options to include automatic dimension tags.
5. If you want Tekla Structures to update dimension grouping automatically, set the option **Update grouping when model changes** to **Yes**.
6. Click **OK**.
**TIP** You can change the dimension tag contents in the final drawing and include some other elements in the tag.

**See also**

Dimensioning properties - Dimension grouping tab (Integrated dimensioning) (page 720)
Add automatic view-specific dimensions using dimensioning type Integrated (page 545)

**Add elevation dimensions**

You can add elevation dimensions (level marks) in your drawings for the start and end points of parts in integrated dimensioning. Tekla Structures dimensions elevations relative to a reference point, which you can change.

For example, if the elevation is 5000 mm, and you set the reference point to 200, the elevation changes to 4800 mm. You can also change the elevation dimension prefix, which in the English version is **EL** by default.

To change the reference point and create elevation dimensions using another prefix:

1. Go to the **Position dimensions** tab, and set **Elevation dimensions** to **On**.
2. Click **OK**.
3. In the drawing properties dialog box, click **View --> Attributes 2**.
4. Do one of the following:
   - To use a specific value, select **Specified** from the **Datum point for elevations** list and enter a value in the **Datum level** box.
• To measure reference points relative to the view plane, select View plane from the Datum point for elevations list.

5. Save the drawing properties and create the drawing.

6. To change the prefix, open the dim_operation.ail file in a text editor that supports UTF-8 coding. Recommended editors are Visual Studio and Notepad++.

This file is located in the Tekla Structures/<version>/messages/ folder. Replace EL with a new prefix on the following line in the file:

```java
string dim_operation_dim_elevation_prefix{entry = ("enu", "EL");};
```

**NOTE** Shortening value added in the user-defined properties of a part affects also elevation dimensions.

---

**Example**

```
+ + +
+ + +
+ + +
```

---

**Limitations**

Tekla Structures creates elevation dimensions for skew parts only if the parts are in the same position in the drawing as they are in the model. This means that the coordinate system must be set to model.

If you are using local, oriented, or brace coordinate systems, Tekla Structures does not draw the elevation dimensions for skewed parts by default. If you want to create elevation dimensions, set the advanced option XS_DRAW_SKEWED_ELEVATIONS to TRUE in File menu --> Settings --> Advanced options --> Dimensioning: Parts. See below for an example of an elevation dimension for a skew part.
Check dimensions
Check dimensions are additional dimensions in integrated dimensioning that you can use for checking, usually in thinner text than other dimensions. They are not required for fabrication or erection, and they are mainly used for checking detailing, not for assembling parts.

Tekla Structures uses work points to create check dimensions. Work points can be either the points between which the part was originally created, or the intersection point of the reference lines of the parts. The reference line location depends on the part position depth set in the part properties dialog box. If it is middle, the reference line is the center line, if it is front, the line is located in the part front edge, etc.

Knock-off dimension is a special type of check dimension that dimensions the distance from work points to the end of the part.

See also
Create check dimensions (page 550)

Create check dimensions
In integrated dimensioning, you can create additional dimensions to check the accuracy of dimensions.

To create check dimensions, do any of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
<th>Number in the image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create check dimensions between outermost work points.</td>
<td>In the Dimensioning dialog box, click Part dimensions and set Main part work points to Yes.</td>
<td>1</td>
</tr>
<tr>
<td>To</td>
<td>Do this</td>
<td>Number in the image</td>
</tr>
<tr>
<td>-------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Create check dimensions between outermost bolts.</td>
<td>In the <strong>Dimensioning</strong> dialog box, click <strong>Bolt dimensions</strong> and set Extreme bolts to <strong>Assembly</strong> or <strong>Main part</strong>.</td>
<td>2</td>
</tr>
<tr>
<td>Create check dimensions from outermost work point to first bolt.</td>
<td>In the <strong>Dimensioning</strong> dialog box, click <strong>Bolt dimensions</strong> and set Extreme bolts to <strong>Assembly</strong> or <strong>Main part</strong> and Extreme bolts to work points to <strong>Yes</strong>.</td>
<td>3</td>
</tr>
<tr>
<td>Create horizontal and vertical check dimensions between the work points in a skewed brace.</td>
<td>In the <strong>Dimensioning</strong> dialog box, click <strong>Position dimensions</strong> and set Main part skew position to <strong>Yes</strong>.</td>
<td>4</td>
</tr>
<tr>
<td>Create check dimensions between the work points, such as the intersections of main and neighbor part reference lines.</td>
<td>In the <strong>Dimensioning</strong> dialog box, click <strong>Position dimensions</strong> and set Position bolts to or Position parts to Working points or Both.</td>
<td></td>
</tr>
<tr>
<td>Create check dimensions to the bolt hole locations in the main part.</td>
<td>In the <strong>Dimensioning</strong> dialog box, click <strong>Position dimensions</strong> and set Main part bolt position to <strong>On</strong>.</td>
<td></td>
</tr>
<tr>
<td>Create knock-off dimensions.</td>
<td>In the <strong>Dimensioning</strong> dialog box, click <strong>Part dimensions</strong> and set Knock-off dimensions to <strong>On</strong>.</td>
<td>5</td>
</tr>
</tbody>
</table>
See also

Check dimensions (page 550)
Dimensioning properties - Part dimensions tab (Integrated dimensioning) (page 716)
Dimensioning properties - Position dimensions tab (Integrated dimensioning) (page 713)
Dimensioning properties - Bolt dimensions tab (Integrated dimensioning) (page 718)
**Example: Part dimensioning**

Here are some examples of what the part dimensions look like in integrated dimensioning with different settings selected on the Part dimensions tab.

<table>
<thead>
<tr>
<th>Dimensioning setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal dimensions set to</td>
<td>![Diagram of internal dimensions set to None]</td>
</tr>
<tr>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Internal dimensions set to</td>
<td>![Diagram of internal dimensions set to All]</td>
</tr>
<tr>
<td>All</td>
<td></td>
</tr>
<tr>
<td>Overall dimensions</td>
<td>![Diagram of overall dimensions]</td>
</tr>
<tr>
<td>Dimensioning setting</td>
<td>Example</td>
</tr>
<tr>
<td>------------------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Main part shape (Shape dimensions) set to On.</td>
<td><img src="image1" alt="Diagram" /></td>
</tr>
<tr>
<td>Bevel dimensions set to On.</td>
<td><img src="image2" alt="Diagram" /></td>
</tr>
<tr>
<td>Bevel angle set to Angle of cut.</td>
<td><img src="image3" alt="Diagram" /></td>
</tr>
</tbody>
</table>

Define automatic drawing settings 554 Automatic dimension settings
### Dimensioning setting | Example
---|---
Bevel angle set to Angle of beam. | ![Example Image]

See also
Dimensioning properties - Part dimensions tab (Integrated dimensioning) (page 716)
Add automatic view-specific dimensions using dimensioning type Integrated (page 545)

**Example: Bolt dimensioning**
Here are a couple of examples of what the bolt dimensions look like in integrated dimensioning with different settings.

<table>
<thead>
<tr>
<th>Dimensioning setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main part bolt internal dimensions is set to All on the Bolt dimensions tab of the Dimensioning Properties dialog box.</td>
<td>![Example Image]</td>
</tr>
</tbody>
</table>
Dimensioning setting | Example
---|---
All bolt and hole dimensions are shown in the front view of the main assembly. The elements **Gage of outstanding leg** (GOL) and **Center-to-center distance** (C/C or Gage) have been added in a bolt and hole mark in **Bolt mark...** > **Content.**

<table>
<thead>
<tr>
<th>Dimensioning setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Position parts to</strong> is set to <strong>None.</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Example: Position dimensioning**

Here are some examples of what the position dimensions look like in integrated dimensioning with different settings selected on the **Position dimensions** tab.
<table>
<thead>
<tr>
<th>Dimensioning setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Position parts to</strong> is set to Main part.</td>
<td><img src="image1" alt="Diagram" /></td>
</tr>
<tr>
<td><strong>Position bolts to</strong> is set to Working points.</td>
<td><img src="image2" alt="Diagram" /></td>
</tr>
<tr>
<td>Dimensioning setting</td>
<td>Example</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------</td>
</tr>
<tr>
<td><strong>Secondary part is dimensioned By bolts.</strong></td>
<td>![Diagram 1]</td>
</tr>
<tr>
<td><strong>Secondary part is dimensioned By parts.</strong></td>
<td>![Diagram 2]</td>
</tr>
<tr>
<td><strong>Secondary part is dimensioned By both.</strong></td>
<td>![Diagram 3]</td>
</tr>
<tr>
<td><strong>Secondary part is dimensioned By bolts.</strong>&lt;br&gt;<strong>Secondary part dimension direction is Neighbor part.</strong>&lt;br&gt;<strong>Position from</strong> is set to <strong>Work points.</strong></td>
<td>![Diagram 4]</td>
</tr>
</tbody>
</table>

1. Running dimensions start from the intersection of the main and secondary part (=work point)
2. Dimensions are aligned with the neighboring part
<table>
<thead>
<tr>
<th>Dimensioning setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Main part bolt position</strong> is set to <strong>Off</strong>.</td>
<td><img src="image1" alt="Dimensioning setting example" /></td>
</tr>
<tr>
<td><em>(Main part bolt internal dimensions is set to Internal on the Bolt dimensions tab.)</em></td>
<td><img src="image2" alt="Dimensioning setting example" /></td>
</tr>
<tr>
<td><strong>Main part bolt position</strong> is set to <strong>On</strong>.</td>
<td><img src="image3" alt="Dimensioning setting example" /></td>
</tr>
<tr>
<td><em>(Main part bolt internal dimensions is set to Internal on the Bolt dimensions tab.)</em></td>
<td><img src="image4" alt="Dimensioning setting example" /></td>
</tr>
<tr>
<td><strong>By default, create minimum and maximum position dimensions are not created for bolts. For information on how to create these dimensions, see Add minimum and maximum position dimensions to bolts (page 572).</strong></td>
<td><img src="image5" alt="Dimensioning setting example" /></td>
</tr>
<tr>
<td><strong>Main part skew position</strong> is set to <strong>Yes</strong>.</td>
<td><img src="image6" alt="Dimensioning setting example" /></td>
</tr>
<tr>
<td><strong>Skew position</strong> is set to <strong>Angle</strong>.</td>
<td><img src="image7" alt="Dimensioning setting example" /></td>
</tr>
<tr>
<td>Dimensioning setting</td>
<td>Example</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Centered part is set to Internal.</td>
<td><img src="image1" alt="Example" /></td>
</tr>
<tr>
<td>Centered part is set to Position.</td>
<td><img src="image2" alt="Example" /></td>
</tr>
<tr>
<td>Center bolt is set to Internal.</td>
<td><img src="image3" alt="Example" /></td>
</tr>
<tr>
<td>Center bolt is set to Position.</td>
<td><img src="image4" alt="Example" /></td>
</tr>
</tbody>
</table>

See also
Dimensioning properties - Position dimensions tab (Integrated dimensioning) (page 713)
Add automatic view-specific dimensions using dimensioning type Integrated (page 545)

**Example: Closing dimension**

Here are some examples of how Tekla Structures creates dimensions in integrated dimensioning with different options selected in the **Close dimensions** area on the **General** tab.

<table>
<thead>
<tr>
<th>Closing option</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close dimensions is set to <strong>No</strong>.</td>
<td><img src="image" alt="Example Diagram" /></td>
</tr>
</tbody>
</table>

Define automatic drawing settings 561 Automatic dimension settings
<table>
<thead>
<tr>
<th>Closing option</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Close dimensions</strong> is set to <strong>All.</strong></td>
<td><img src="image" alt="Example of All dimensions" /></td>
</tr>
<tr>
<td><strong>Short dimensions</strong> is set to <strong>No.</strong></td>
<td><img src="image" alt="Example of No short dimensions" /></td>
</tr>
</tbody>
</table>

See also

- Dimensioning properties - General tab (Integrated dimensioning) (page 709)
- Add automatic view-specific dimensions using dimensioning type Integrated (page 545)
**Example: Combine dimensions**

Here are some examples of how Tekla Structures combines dimensions in integrated dimensioning with different options selected on the **General** tab.

<table>
<thead>
<tr>
<th>Combining option</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option <strong>No</strong> prevents dimensions from being combined.</td>
<td><img src="image1" alt="No Combining Example" /></td>
</tr>
<tr>
<td>Option <strong>1</strong> combines part position dimensions with part internal dimensions, and bolt group internal dimensions with bolt edge distances. Bolt position dimensions are not combined with bolt internal dimensions.</td>
<td><img src="image2" alt="Option 1 Example" /></td>
</tr>
<tr>
<td>Option <strong>2</strong> combines the part position dimension with part internal dimensions and bolt group internal dimensions. Bolt internal dimensions are combined with bolt position dimensions. Edge distances are shown separately.</td>
<td><img src="image3" alt="Option 2 Example" /></td>
</tr>
<tr>
<td>Combining option</td>
<td>Example</td>
</tr>
<tr>
<td>------------------</td>
<td>---------</td>
</tr>
<tr>
<td><strong>Option 3</strong> combines bolt internal dimensions and position dimensions in the same dimension line.</td>
<td><img src="image1" alt="Diagram" /></td>
</tr>
<tr>
<td><strong>Option 4</strong> combines bolt group position dimensions with part position dimensions. Part and bolt internal dimensions are not combined with this option, but bolt internal dimensions are combined with bolt edge distances.</td>
<td><img src="image2" alt="Diagram" /></td>
</tr>
<tr>
<td><strong>Option 5</strong> combines internal dimensions and the position dimension of bolt groups where there are several bolt groups.</td>
<td><img src="image3" alt="Diagram" /></td>
</tr>
<tr>
<td><strong>Option 4.5</strong> uses a combination of option 5 for the main part and a combination of option 4 for the secondary parts.</td>
<td><img src="image4" alt="Diagram" /></td>
</tr>
</tbody>
</table>

**Distance 5'-0**

---

Define automatic drawing settings 564  Automatic dimension settings
### Combining option

<table>
<thead>
<tr>
<th>Combining option</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Distance 1'-0</strong></td>
<td><img src="image1.png" alt="Example Image" /></td>
</tr>
<tr>
<td><strong>Min distance 5'-0</strong></td>
<td><img src="image2.png" alt="Example Image" /></td>
</tr>
<tr>
<td><strong>Min distance 5&quot;</strong></td>
<td><img src="image3.png" alt="Example Image" /></td>
</tr>
</tbody>
</table>

**See also**
Dimensioning properties - General tab (Integrated dimensioning) (page 709)
Add automatic view-specific dimensions using dimensioning type Integrated (page 545)

**Example: Combine bolt group dimensions**

For dimensioning and marking purposes, Tekla Structures treats bolt groups located close together in integrated dimensioning as one group on the basis of
the minimum number of dimensions to combine and format selected on the **Bolt dimensions** tab. See an example below:

1. Bolt group 1
2. Bolt group 2

**See also**

- Dimensioning properties - Bolt dimensions tab (Integrated dimensioning) (page 718)
- Add automatic view-specific dimensions using dimensioning type Integrated (page 545)

**Example: Forward offset**

Here are some examples of how Tekla Structures places dimensions in integrated dimensioning with different forward offset values set on the **General** tab.

<table>
<thead>
<tr>
<th>Forward offset setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Forward offset</strong> greater than the 1’-8 dimension to the hole group.</td>
<td>![Example Diagram]</td>
</tr>
</tbody>
</table>
**Forward offset setting** set to a smaller value.

<table>
<thead>
<tr>
<th>Forward offset</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image" alt="Example Diagram" /></td>
</tr>
</tbody>
</table>

**See also**

Dimensioning properties - General tab (Integrated dimensioning) (page 709)
Add automatic view-specific dimensions using dimensioning type Integrated (page 545)

**Example: Grid dimensions**

Here is an example of how Tekla Structures creates dimensions in integrated dimensioning with different options selected in the **Grid dimensions** area on the **General** tab.

(1) Option **Overall** selected
(2) Option **Individual spans** selected

**Example: Recognizable distance**

Here is an example of how Tekla Structures uses the **Recognizable distance** setting in integrated dimensioning. If you set value for **Recognizable distance**
on the General tab, and the asymmetry of the parts is smaller than the distance you entered, Tekla Structures represents it using a dimension.

This setting is used, when the Internal dimension is set to Necessary. Recognizable distance dimension is not necessarily needed, if the part can be assembled correctly without it.

A typical example is a rectangle that is almost as long as it is wide.

See also
Dimensioning properties - General tab (Integrated dimensioning) (page 709)
Add automatic view-specific dimensions using dimensioning type Integrated (page 545)

**Example: Preferred dimension side**

You can set the preferred dimension side for parts and bolts on the Part dimensions tab and Bolt dimensions tab in integrated dimensioning. The examples below show how the different settings for Preferred dim side look like for part dimensions.
Add automatic view-specific dimensions using dimensioning type Integrated (page 545)

**Example: Reinforcement dimension**

Here are some examples of how Tekla Structures creates dimensions for reinforcing bar groups in integrated dimensioning with different options selected on the **Reinforcement dimensions** tab.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dimensions for reinforcing bar groups</strong> is set to <strong>On</strong>, no dimension tags selected in <strong>Mark location</strong>.</td>
<td><img src="image1.png" alt="Example 1" /></td>
</tr>
<tr>
<td><strong>Dimensions for reinforcing bar groups</strong> is set to <strong>On</strong>, dimension tags selected in <strong>Mark location</strong>.</td>
<td><img src="image2.png" alt="Example 2" /></td>
</tr>
</tbody>
</table>
Settings | Example
--- | ---
Dimensions for reinforcing bar groups is set to On, dimension tags selected in Mark location, Close dimensions to binding geometry is set to Yes.

See also
Dimensioning properties - Reinforcement dimensions tab (Integrated dimensioning) (page 722)
Add automatic view-specific dimensions using dimensioning type Integrated (page 545)

Add automatic dual dimensions
You can create dual dimension tags automatically in all types of drawings.

Limitations:
Dual dimensions can only be shown in relative and US absolute dimensions, but not in absolute dimensions.
1. Click On the File menu, click Settings --> Options and go to Drawing dimensions settings.
2. Set the units, format and precision.
3. Select the drawing types where you want to have the dual dimensions.
4. Click OK.

When Tekla Structures creates the drawing, it adds in the lower dimension tag in the selected unit and format, and adds the text DIMENSION in the middle dimension tag in the Dimension Properties dialog box.

Example
Below is an example of dual dimensions using the units mm and format ###.
Add dimensions to unfolded parts

In single-part and assembly drawings, you can control the dimensions Tekla Structures adds for unfolded parts that have been created using View --> Attributes 2 --> Unfolded =Yes .

Use the advanced options in File menu --> Settings --> Advanced options --> Dimensioning: Unfolding.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create bending line dimensions for unfolded parts.</td>
<td>Set the advanced option XS_DRAW_BENDING_LINE_DIMENSIONS_IN_UNFOLDING=TRUE.</td>
</tr>
<tr>
<td>Create angle and radius dimensions for unfolded parts.</td>
<td>Set the advanced option XS_DRAW_ANGLE_AND_RADIUS_INFO_IN_UNFOLDING=TRUE.</td>
</tr>
<tr>
<td>Set a prefix text for an angle dimension.</td>
<td>Set the advanced option XS_ANGLE_TEXT_IN_UNFOLDING_BENDING_LINE_DIMENSIONING=A=.</td>
</tr>
<tr>
<td>Set a prefix text for a radius dimension.</td>
<td>Set the advanced option XS_RADIUS_TEXT_IN_UNFOLDING_BENDING_LINE_DIMENSIONING=R=.</td>
</tr>
<tr>
<td>To</td>
<td>Do this</td>
</tr>
<tr>
<td>----</td>
<td>---------</td>
</tr>
<tr>
<td>For angle text dimensions, show the interior angle instead of the exterior angle.</td>
<td>Set the advanced option <code>XS_DRAW_INSIDE_ANGLE_IN_UNFOLDING=TRUE</code>.</td>
</tr>
<tr>
<td>Set the format for angle text.</td>
<td>Set the advanced option <code>XS_UNFOLDING_ANGLE_DIM_FORMAT=1</code>.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| | ###= 0  
| | ###[.#]= 1  
| | ###.##= 2  
| | ###[.##]= 3  
| | ###.##= 4  
| | ###[.###]= 5  
| | ###.###= 6  
| | ### /##= 7  
| | ####/###= 8  |
| Set the accuracy of the angle text. | Set the advanced option `XS_UNFOLDING_ANGLE_DIM_PRECISION=10`. |
| | 0.00= 1  
| | 0.50= 2  
| | 0.33= 3  
| | 0.25= 4  
| | 1/8= 5  
| | 1/16= 6  
| | 1/32= 7  
| | 1/10= 8  
| | 1/100= 9  
| | 1/1000= 10  |

**See also**

*Dimension properties - Units, precision and format (page 703)*
Add minimum and maximum position dimensions to bolts
By default, Tekla Structures does not create minimum and maximum position dimensions for bolts. You can use an advanced option to create the dimensions.

To create minimum and maximum position dimensions for bolts:
1. On the File menu, click Settings --> Advanced options and go to the Dimensioning: Bolts category.
2. Set XS_BOLT_POSITION_TO_MIN_AND_MAX_POINT to TRUE.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before setting the advanced option.</td>
<td>![Diagram before setting option]</td>
</tr>
<tr>
<td>After setting the advanced option to TRUE.</td>
<td>![Diagram after setting option]</td>
</tr>
</tbody>
</table>

Create dimension line extensions
You can create line extensions for dimensions that have line arrows.

Limitations
Line extensions cannot be applied to dimensions that have different arrows from line arrows, or to knock-off dimensions of the following type:

1. On the File menu, click Settings --> Options and go to the Drawing dimensions settings.
2. Enter the length of the dimension line extension in the Dimension line extension length for line arrow box.
Example

---

Line extensions added
No line extensions

Change the appearance of absolute dimensions
You can select whether to show zero at the zero point of the absolute dimensions, and also change the orientation of the absolute dimensions.

1. On the **File** menu, click **Settings --> Options**, and go to the **Drawing dimensions** settings.
2. Set **Show zero in absolute dimensions** to **No** if you do not want to show zero at the zero points in absolute dimensions.
   
   **Yes** is the default value.
3. Set **Draw absolute dimension values parallel to dimension line** to **Yes** to show dimensions parallel to dimension lines in absolute dimensions.

   **No** is the default value.
4. Click **OK**.

Example

In the following example, dimensions are parallel to the dimension line and zero is shown at the zero point.

---

See also

- Dimension properties - Appearance tab (page 705)
- Automatic view-level dimensions (page 500)

Create exaggerated dimensions
You can exaggerate narrow dimensions to make them easier to read.
When you enable the exaggeration of the dimensions, a dimension that is narrower than the defined limit is enlarged. If there are many exaggerated dimensions, Tekla Structures arranges them automatically. Setting exaggeration consists of selecting the exaggeration limit and the exaggeration scale, enabling the exaggeration and setting the direction, origin, width, position and height for the exaggerated dimensions.

For single-part, assembly and cast unit drawings, save the dimension exaggeration properties on object level in an open drawing into a dimension properties file, which you can take into use when you modify dimensioning rules.

**Limitation:** Exaggeration works only if the dimension extension lines are long. Set **Short extension line** to **No** on the **General** tab of the **Dimension Properties** dialog box.

1. On the **File** menu, click **Settings --> Options** and go to the **Drawing dimensions** settings.
2. Enter the exaggeration limit in the **Exaggeration limit** box.
3. Select **Paper** or **Model** as the exaggeration scaling method.
   - If you select **Paper**, the exaggeration limit is multiplied by the view scale. For example, if the scale is 1:10 and the limit is 10 mm, then all the dimensions smaller than 100 mm are exaggerated.
   - If you select **Model**, and the scale is 1:10, all the dimensions smaller than 10 mm are exaggerated regardless of the drawing scale.
4. Click **OK**.
5. Open a drawing and double-click a dimension.
6. Go to the **Marks** tab of the **Dimensions** dialog box.
7. Enable the exaggeration by setting **Exaggeration** to **Specified**.
8. Set the values for **Direction**, **Origin**, **Width**, **Position** and **Height**.
9. Enter a name for the dimension properties file at the top and click **Save**.
10. If you want to modify the current dimension, click **Modify**. Otherwise, close the dialog box.
    
    Now you have a dimension properties file that contains the exaggeration settings, which you can load later on or use in dimensioning rules.

**Example**

See below for an example of exaggerated dimensions:
You can change the dimension prefix in radial dimensions.

By default, the prefix of radial dimensions is R, for example, R 200.

1. Close Tekla Structures
2. Open the file `dim_operation.ail` located in `..\Tekla Structures <version>\messages\`.

3. Change the prefix R to Radius:

   ```
   string dim_operation_dim_radius_prefix{ ... entry =
   ("enu", "R ");};
   string dim_operation_dim_radius_prefix{ ... entry =
   ("enu", "Radius ");};
   ```

4. Save the changes and reopen Tekla Structures.

**See also**

Add manual dimensions (page 171)

## Add dimensions to plates

You can dimension plates using some advanced options in **File menu -- Settings -- Advanced options -- Dimensioning: Parts**.

**NOTE** If you have added a path to the `dim_planes_table.txt` file as a value to the advanced option `XS_PART_DIMENSION_PLANES_TABLE`, the settings in `dim_planes_table.txt` are always used, not the values that you set to the advanced options described below.

To dimension plates using the advanced options:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimension the plates to the edge that is nearest to the neighbor part</td>
<td>Set the advanced option <code>XS_PART_POSITION_TO_EDGE_NEAREST_TO_NEIGHBOUR</code> to TRUE.</td>
</tr>
</tbody>
</table>
| Dimension the plates to the leading edge of the beams | 1. Set the advanced option `XS_USE_PLATE_SIDE_POSITIONING` to FALSE.  
   2. Set the advanced option `XS_PART_POSITION_TO_EDGE_NEAREST_TO_NEIGHBOUR` to FALSE.  
   3. Set the advanced option `XS_PART_POSITION_TO_LEADING_EDGE` to TRUE. |
| Dimension the plates to the leading edge of the columns | 1. Set the advanced option `XS_USE_PLATE_SIDE_POSITIONING` to FALSE. |
To

<table>
<thead>
<tr>
<th>To Dimension the plates to the trailing edge</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Set the advanced option XS_USE_PLATE_SIDE_POSITIONING to FALSE.</td>
<td></td>
</tr>
<tr>
<td>2. Set the advanced option XS_PART_POSITION_TO_EDGE_NEAREST_TO_NEIGHBOUR to FALSE.</td>
<td></td>
</tr>
<tr>
<td>3. Set the advanced option XS_PART_POSITION_TO_LEADING_EDGE to FALSE.</td>
<td></td>
</tr>
<tr>
<td>4. Set the advanced option XS_PART_POSITION_TO_LEADING_EDGE_IN_COLUMNS_ALSO to FALSE.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To Dimension the plates using their original reference points in the model</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Set the advanced option XS_PART_POSITION_TO_EDGE_NEAREST_TO_NEIGHBOUR to FALSE.</td>
<td></td>
</tr>
<tr>
<td>2. Set the advance option XS_USE_PLATE_SIDE_POSITIONING to TRUE.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** If you have created one plate from left to right and another from right to left, Tekla Structures dimensions them differently.

Below is an example of dimensioning plates to the leading edge.

![Leading Edge Dimension](image1.png)

Below is an example of dimensioning plates to the trailing edge.

![Trailing Edge Dimension](image2.png)
In the following two examples, neighbor parts are blue, and the plate creation points are shown.

In the example below, the following values are used:

- \( \text{XS\_PART\_DIMENSION\_PLANES\_TABLE} = \text{(no value given)} \)
- \( \text{XS\_PART\_POSITION\_TO\_EDGE\_NEAREST\_TO\_NEIGHBOR} = \text{TRUE} \)
- \( \text{XS\_PART\_POSITION\_TO\_LEADING\_EDGE} = \text{FALSE} \)
- \( \text{XS\_PART\_POSITION\_TO\_LEADING\_EDGE\_IN\_COLUMNS\_ALSO} = \text{FALSE} \)
- \( \text{XS\_USE\_PLATE\_SIDE\_POSITIONING} = \text{FALSE} \)
In the example below, the following values are used:

- `XS_PART_DIMENSION_PLANES_TABLE = (no value given)`
- `XS_PART_POSITION_TO_EDGE_NEAREST_TO_NEIGHBOR = FALSE`
- `XS_PART_POSITION_TO_LEADING_EDGE = FALSE`
- `XS_PART_POSITION_TO_LEADING_EDGE_IN_COLUMNS_ALSO = FALSE`
- `XS_USE_PLATE_SIDE_POSITIONING = TRUE`

See also

*Add automatic view-specific dimensions using dimensioning type Integrated (page 545)*
Add dimensions to profiles
You can affect the way Tekla Structures dimensions different profiles in drawings. For example, you can have Tekla Structures always dimension round bars to the middle of the profile and large I profiles to the top.

To define dimension settings for profiles, you need to edit the dimension planes table `dim_planes_table.txt`.

1. On the **File** menu, click **Settings --> Advanced options** and go to the **Dimensioning: Parts** category.
2. Set the advanced option `XS_PART_DIMENSION_PLANES_TABLE` as follows:
   ```
   XS_PART_DIMENSION_PLANES_TABLE=%XS_PROFDB%\dim_planes_table.txt
   ```
   This advanced option defines the path to the part dimension planes table.
3. Open the `dim_planes_table.txt` file in any text editor, for example, Microsoft Notepad. The file is located in `..\Tekla Structures\<version>\environments\<environment>\profile`.
4. Edit the file contents and save the file.
5. To use the new settings in drawings, restart Tekla Structures and recreate the drawings. Changing the file does not automatically update existing drawings.

**Example 1**
In this example, the hole dimension is set from the middle of the flange instead of the flange edge for "I" Profile.

Open the file and edit the middle of the column to **TRUE* in the ProfType 1 row line, save and restart Tekla Structures. However, when you generate the new drawing, it will create the hole dimension from the middle of the flange.

```
#dim_planes_table.txt
/**** DIMENSION PLANES TABLE for different profile types and sizes
****/
//Values: -1.0 in max size means no size limit!
/**** FLANGE WEB
ProfType, MaxSize, middle, left, right, middle, bottom, top
=================================================================
***/
//I-profile - horizontal by reference line,vertical from top flange
1, **TRUE***, FALSE, FALSE, FALSE, TRUE, TRUE*
```
(1) Required dimension (middle of flange)
(2) Default dimension (edge of flange)

Example 2

Here is another example of a dimension planes table:

<table>
<thead>
<tr>
<th>dim_planes_table.txt</th>
</tr>
</thead>
<tbody>
<tr>
<td>FLANGE WEB</td>
</tr>
<tr>
<td>ProfType, MaxSize, middle, right, left, middle, right, left</td>
</tr>
<tr>
<td>1, 300.0, TRUE*, FALSE, FALSE, FALSE, TRUE*, TRUE</td>
</tr>
<tr>
<td>7, -1.0, TRUE*, FALSE, FALSE, TRUE*, FALSE, FALSE</td>
</tr>
</tbody>
</table>

The line beginning with 1 means that Tekla Structures always dimensions I profiles \( \text{(ProfType} = 1) \) smaller than 300 mm \( \text{(MaxSize} = 300) \) to the middle of the flange and to the right edge of the web, no matter how the part was created.

The line beginning with 7 means that Tekla Structures always dimensions round tubes \( \text{(ProfType} = 7) \) to the middle of the profile.

The \text{ProfType} numbers run in the same order as the profiles in the \text{Profile} catalog:

- 1 = I profile
- 2 = L profile
- 3 = Z profile
- 4 = U profile
- 5 = plate
- 6 = round bar
- 7 = round tube
- 8 = square pipe
- 9 = C profile
- 10 = T profile
• 15 = ZZ profile
• 16 = CC profile
• 17 = CW profile
• 51 = polygon_plate etc.
The value -1.0 in the **MaxSize** indicates that there is no size limit for the profile.
The asterisk after **TRUE** indicates that it is the default value.

**Sloped dimension texts**

Tekla Structures aligns slightly sloped dimension text. If the dimension text is sloped more than a certain degree, Tekla Structures flips the text.

Below is an example of a dimension text that is slightly sloped.

Below is an example of a flipped dimension text.

The default limit for aligning dimension text is 0.1 (5.74 degrees). When this limit is exceeded, the dimension text gets flipped. To adjust this limit, use the advanced option **XS_TEXT_ORIENTATION_EPSILON**.
Add automatic dimensions to general arrangement drawings

In the general arrangement drawing General - Dimensioning Properties dialog box, you can create part, grid and overall dimensions, and control the way they are created. You can experiment with different combinations of options to achieve different kinds of dimensioning effects.

1. On the Drawings & reports tab, click Drawing properties --> GA drawing.
2. Load drawing properties that are as close to the ones you need as possible.
3. Click Dimensioning.
4. Select the dimensions to create and modify the related settings.
5. On the Grids tab, adjust the grid dimension and overall dimension creation settings and the positioning of the dimensions.
6. On the Parts tab, adjust part dimension creation settings and the positioning of the dimensions.
7. Click OK and create the drawing.

See also
Object groups in dimensioning general arrangement drawings (page 584)
Dimension object groups on different dimension lines (page 585)
Example: Grid and overall dimensions (page 586)
Example: Maximum leader line length options (page 588)
Example: Dimension parts partly outside the view (page 589)
Example: Limit the number of outside dimensions (page 590)
Example: Position part dimensions (page 591)
Example: Dimension anchor bolt plans (page 596)
Dimensioning properties - Grid tab (GA drawings) (page 723)
Dimensioning properties - Parts tab (GA drawings) (page 723)

Object groups in dimensioning general arrangement drawings

You can use the object groups (selection filters) that you have created in the model, or create the necessary groups through the Parts tab in the General -

Define automatic drawing settings 584 Automatic dimension settings
Dimensioning Properties dialog box using the Object groups button. For example, you might want to create an object group for beams of a certain size.

See also
Dimension object groups on different dimension lines (page 585)

Dimension object groups on different dimension lines
You can use object groups to specify different objects to be dimensioned on different dimension lines.

1. On the Drawings & reports tab, click Drawing properties --> GA drawing.
2. Click Dimensioning, and go to the Parts tab
3. Add the desired object groups to dimensioning rules by clicking Add rule and selecting the rule from the list in the Object group column.
4. If needed, you can create new object groups by clicking Object group. For example, add object group rules for beams of different size.
5. For each object group, select the Positioning option, the Horizontal position option, and the Vertical position option, depending on the type of the objects in the group.
   For example, for beam groups, set Horizontal position to Left side to position the beam dimensions to the left side of the grid.
6. If needed, in the Tag column, enter the text tags that you want to display for the different object groups in the drawing. For example, enter the size of the beam.

Example
In this example, several beam groups were created, one for each beam size to be dimensioned, then the position for the dimensions in different groups was selected, and tags were added displayed for each group:
See also

Object groups in dimensioning general arrangement drawings (page 584)
Example: Position part dimensions (page 591)
Example: Dimension parts partly outside the view (page 589)
Example: Limit the number of outside dimensions (page 590)
Example: Maximum leader line length options (page 588)
Dimensioning properties - Parts tab (GA drawings) (page 723)
Example: Grid and overall dimensions

Here are some examples of what the grid and overall dimensions look like in general arrangement drawings with different settings selected on the Grid tab.

<table>
<thead>
<tr>
<th>Dimensioning setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid line dimensions = On&lt;br&gt;Overall dimension = On&lt;br&gt;Horizontal = Left&lt;br&gt;Vertical = above</td>
<td><img src="image1.png" alt="Example 1" /></td>
</tr>
<tr>
<td>Grid line dimensions = On&lt;br&gt;Overall dimension = Off&lt;br&gt;Horizontal = Left&lt;br&gt;Vertical = above</td>
<td><img src="image2.png" alt="Example 2" /></td>
</tr>
</tbody>
</table>
See also
Dimensioning properties - Grid tab (GA drawings) (page 723)

**Example: Maximum leader line length options**

Here are some examples of how the dimensions are positioned when you have set values for the Maximum leader line length options Outside dimensions and Inside dimensions on the Parts tab.

<table>
<thead>
<tr>
<th>Dimensioning setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>A value has been set for Outside dimensions.</td>
<td>![Example Diagram]</td>
</tr>
</tbody>
</table>

![780*380]
### Dimensioning setting

<table>
<thead>
<tr>
<th>Dimensioning setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inside dimensions</td>
<td></td>
</tr>
</tbody>
</table>

A value has been set for **Inside dimensions**.

```plaintext
780°380
1500
1500
```

See also
- Dimensioning properties - Parts tab (GA drawings) (page 723)
- Add automatic dimensions to general arrangement drawings (page 584)
**Example: Dimension parts partly outside the view**

Here is an example of how the parts are dimensioned if you set the option **Include parts not entirely in the view** to **On** on the **Parts** tab of the **General - Dimensioning properties** dialog box.

![Diagram of dimensioned parts]

See also

Dimensioning properties - Parts tab (GA drawings) (page 723)

**Example: Limit the number of outside dimensions**

Here is an example of what the part dimensions look like when you set 3 as the value for the option **Maximum number of outside dimensions** on the **Parts** tab in general arrangement drawing dimensioning properties. Tekla
Structures creates three dimensions outside the grid and the fourth inside the grid.

See also
Dimensioning properties - Parts tab (GA drawings) (page 723)

**Example: Position part dimensions**

Here are some examples of how the part dimensions are positioned in general arrangement drawings with different positioning settings selected on the Parts tab.

In the example below, **Positioning** is set to **Inside grid**, which places all dimensions next to or near the grid.
In the example below, **Positioning** is set to *Outside grid*, which places all dimensions outside the grid.

In the example below, **Horizontal position** is set to *Left side*, which places all dimensions to horizontal parts to the left of the grid.
In the example below, **Horizontal position** is set to **Right side**, which places all dimensions to horizontal parts to the right of the grid.
In the example below, **Horizontal position** is set to **Distributed to both sides**, which places all dimensions to horizontal parts to the side of the grid nearest the part they are dimensioning.

In the example below, **Vertical position** is set to **Above**, which places all dimensions to vertical parts above the grid.
In the example below, **Vertical position** is set to **Below**, which places all dimensions to vertical parts under the grid.
In the example below, **Vertical position** is set to **Distributed to both sides**, which places all dimensions to vertical parts to the side of the grid nearest the part they are dimensioning.

See also

*Dimensioning properties - Parts tab (GA drawings) (page 723)*

**Example: Dimension anchor bolt plans**

Here are some examples of what the dimensions in anchor bolt plans look like in different situations.

First an example of a typical situation, where all columns are located in grid line intersections:
If the column reference point is not located on the grid line, Tekla Structures dimensions the reference point automatically relative to the grid lines. See the example below.
If the column is rotated relative to the drawing, the rotation is also automatically dimensioned. See the example below.
If you set the advanced option
X$S\_ANCHOR\_BOLT\_PLAN\_USE\_VIEW\_COORDSYS\_FOR\_BOLT\_DIMENSIONS$ to
FALSE and create the drawing, all dimensions are in the drawing coordinate
system.
8.6 Automatic mark settings

Marks are associative annotation objects that are used for identifying individual building objects in a drawing. A mark displays a set of user-selectable properties called mark elements. Automatic marks are marks that Tekla Structures creates in a drawing based on the mark properties defined in drawing properties.

You can modify the mark properties after creating the drawing, and add marks manually in an open drawing.

The mark properties define what Tekla Structures shows in marks and how the marks are shown. In addition, Tekla Structures uses the contentattributes_global.lst attributes file for setting the default unit settings for some mark elements. You can use contentattributes_userdefined.lst when you want to configure settings of your own.

Tekla Structures is able to create the following automatic marks:
- Part marks
- Bolt marks
- Neighbor part marks
- Surface treatment marks
- Connection marks
- Model weld marks
- Reinforcement marks
- Pour object marks
- Dimension marks
- View and section view label marks, and section marks

<table>
<thead>
<tr>
<th>To</th>
<th>Click the links below to find out more</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set up and add automatic marks for building objects</td>
<td>Add automatic marks (page 602)</td>
</tr>
<tr>
<td>Indicate whether to show and merge marks</td>
<td>Adjust the visibility of automatic marks (page 604)</td>
</tr>
<tr>
<td>Add frames around single mark elements or around the mark itself,</td>
<td>Adjust text, frames and leader lines of automatic marks (page 608)</td>
</tr>
<tr>
<td>adjust the appearance of the mark text and leader line, and change</td>
<td></td>
</tr>
<tr>
<td>the unit and format of an element</td>
<td></td>
</tr>
<tr>
<td>Check how the location of the mark is affected by mark placement</td>
<td>Mark location (page 611)</td>
</tr>
<tr>
<td>settings, the type of the leader line, predefined mark location</td>
<td></td>
</tr>
<tr>
<td>and part orientation settings, modeling direction of parts, and</td>
<td></td>
</tr>
<tr>
<td>drawing protection settings</td>
<td></td>
</tr>
<tr>
<td>Automatically merge part marks, surface treatment marks or</td>
<td>Merge marks automatically (page 615)</td>
</tr>
<tr>
<td>reinforcement marks</td>
<td></td>
</tr>
<tr>
<td>Show the mark frame and leader line of the hidden part with a</td>
<td>Show mark frames and leader lines for hidden parts (page 621)</td>
</tr>
<tr>
<td>dashed or a solid line</td>
<td></td>
</tr>
<tr>
<td>Set or change the unit and the number of decimals in measurement</td>
<td>Change unit settings for marks (page 622)</td>
</tr>
<tr>
<td>values for various mark elements</td>
<td></td>
</tr>
<tr>
<td>Use advanced options to define the contents of the bolt mark Size</td>
<td>Define size in bolt marks using advanced options (page 634)</td>
</tr>
<tr>
<td>element</td>
<td></td>
</tr>
</tbody>
</table>
To | Click the links below to find out more
---|---
Add level attributes in part marks and associative notes as user-defined attributes | Add level attributes in automatic part marks (page 625)
Add user-defined attributes and template attributes in marks | Add attributes in automatic marks (page 624)
Add custom graphical templates as elements in marks, for example, add a template that changes the unit and the number of decimals in measurement values in a mark | Add templates in marks (page 628)
Add symbols in mark from a specific symbol file | Add symbols in automatic marks (page 633)
Add a pull-out picture of a reinforcing bar in a reinforcement mark | Add pull-out pictures in automatic reinforcement marks (page 637)

See also
Mark properties (page 726)
Mark elements (page 737)
Object protection and placement settings in drawings (page 453)
Drawing marks, notes, texts and links in open drawings (page 214)
Show pour objects, pour marks and pour breaks in drawings (page 668)
Pours in drawings (page 329)
Units and decimals in drawings, reports and templates (page 675)

Add automatic marks
You can set up automatic marks for building objects (parts, neighbor parts, bolts, surface treatment, connections, reinforcement, and neighbor reinforcement) and save the mark properties in a property file for later use.

You can do this the view properties dialog box of single-part, assembly, and cast unit drawings. For general arrangement drawings, automatic marks can be defined on drawing level.

1. On the Drawings & reports tab, click Drawing properties and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. Single-part, assembly and cast unit drawings: Click **View creation**, select the view and the properties that you want to change, and click **View properties**.

4. Click the mark type you want to modify, for example, **Part mark**.

5. For some marks, you need to select from a list the object that you are defining the marks for.
   
   For example, for part marks, you can define part mark settings independently for main and secondary parts, and for sub-assembly main and secondary parts.

6. Add elements in the mark by double-clicking the elements in the **Available elements** list.

7. Modify the element appearance (frame and font).
   
   For length, height, spacing and diameter elements, you can adjust also the unit and format.

8. Use the **Move up** and **Move down** buttons to place the elements in the order you want.

9. Modify the appearance, placement and visibility settings on the **Content** and **General** tabs.

10. Depending on the drawing type, do one of the following:

   **Single-part, assembly and cast unit drawings:**
   
   a. Save the view properties by entering a properties file name in the box at the top and click **Save**.
   
   b. Click **Close** to return to the drawing properties.

   **General arrangement drawings:**
   
   • Click **OK** in the subdialog to save the changes, close the subdialog and return to the drawing properties.

11. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**Example**

This is an example of a part mark.
1. Assembly position
2. Size
3. Mark frame
4. Profile
5. Mark element frame
6. Length

See also
Mark location (page 611)
Define automatic placement settings for marks (page 458)
Mark properties (page 726)
Mark elements (page 737)
Add symbols in automatic marks (page 633)
Add templates in marks (page 628)
Add pull-out pictures in automatic reinforcement marks (page 637)
Add attributes in automatic marks (page 624)
Define size in bolt marks using advanced options (page 634)

Adjust the visibility of automatic marks
Using the visibility options in the mark properties you can indicate whether the marks are displayed in a drawing. You can modify these settings before creating a drawing, and also in an open drawing after creating a drawing.

To adjust the visibility of marks before creating a drawing:
1. On the Drawings & reports tab, click Drawing properties and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. Do one of the following depending on the drawing type. Note that all settings are not available for all mark types.
### Single-part, assembly and cast unit drawings:

<table>
<thead>
<tr>
<th>Drawing type</th>
<th>Adjust mark visibility settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Adjust mark visibility settings</strong></td>
<td></td>
</tr>
<tr>
<td>a. Click <strong>View creation</strong>, select the view and the properties that you want to change, and click <strong>View properties</strong>. You need to adjust the setting for all the views in the drawing separately.</td>
<td></td>
</tr>
<tr>
<td>b. Click a mark type in the options tree. For example, click <strong>Part mark</strong>.</td>
<td></td>
</tr>
<tr>
<td>c. Go to the <strong>General</strong> tab and select whether you want to display marks by selecting one of the <strong>Visibility in view</strong> options. The available options depend on the mark type:</td>
<td></td>
</tr>
<tr>
<td>• <strong>distributed</strong>: Distributes the marks in the view. Tekla Structures only creates marks that are not visible in the other views.</td>
<td></td>
</tr>
<tr>
<td>• <strong>always</strong>: Always creates marks in the view, irrespective the settings in other views.</td>
<td></td>
</tr>
<tr>
<td>• <strong>preferred</strong>: Acts as distributed, but the preferred view has a higher priority. Select <strong>preferred</strong> to one view only in a drawing. If you set other views to <strong>distributed</strong>, the marks are located only in the view that has the setting <strong>Visibility in view</strong> set to <strong>preferred</strong>.</td>
<td></td>
</tr>
<tr>
<td>• <strong>none</strong>: Does not create marks. Note that if you want to create your own marks, always use the <strong>none</strong> option. Selecting another option, for example <strong>always</strong>, might slow down the drawing update during opening, even if you had deleted the marks manually.</td>
<td></td>
</tr>
</tbody>
</table>

---

**Define automatic drawing settings** 605  **Automatic mark settings**
<table>
<thead>
<tr>
<th>Drawing type</th>
<th>Adjust mark visibility settings</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>d. In <strong>Parts out of view plane</strong>, select whether you want to display marks for parts that are out of view plane:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Visible</strong>: Displays marks for parts outside the view in the drawing.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Not visible</strong>: Displays no marks for parts outside the view in the drawing.</td>
</tr>
<tr>
<td></td>
<td>e. For bolt marks, select if you want to show bolt marks in main parts, secondary parts, sub-assembly main parts, or in sub-assembly secondary parts.</td>
</tr>
<tr>
<td></td>
<td>For bolt marks, you can also define the <strong>Bolt size limit</strong>, which filters standard-sized bolt marks out of drawings. Tekla Structures will not display bolt marks of the size you enter here.</td>
</tr>
<tr>
<td></td>
<td>f. Click <strong>Save</strong> to save the changes in view properties, and then click <strong>Close</strong> to return to drawing properties.</td>
</tr>
<tr>
<td></td>
<td>g. Click <strong>Save</strong> to save the drawing properties, then click <strong>OK</strong> and create the drawing.</td>
</tr>
<tr>
<td><strong>General arrangement drawings:</strong></td>
<td>a. Click a mark type button in the drawing properties dialog box. For example, click <strong>Part mark</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. Go to the <strong>General</strong> tab and select whether you want to display marks by selecting one of the <strong>Visibility in view</strong> options. The available options depend on the mark type:</td>
</tr>
<tr>
<td></td>
<td>• <strong>distributed</strong>: Distributes the marks in the view. Tekla Structures only creates marks that are not visible in the other views.</td>
</tr>
</tbody>
</table>
### Adjust mark visibility settings

<table>
<thead>
<tr>
<th>Drawing type</th>
<th>Adjust mark visibility settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <em>always</em>: Always creates marks in the view, irrespective the settings in other views.</td>
<td></td>
</tr>
<tr>
<td>• <em>preferred</em>: Acts as distributed, but the preferred view has a higher priority. Select <em>preferred</em> to one view only in a drawing. If you set other views to <em>distributed</em>, the marks are located only in the view that has the setting <em>Visibility in view</em> set to <em>preferred</em>.</td>
<td></td>
</tr>
<tr>
<td>• <em>none</em>: Does not create marks. Note that if you want to create your own marks, always use the <em>none</em> option. Selecting another option, for example <em>always</em>, might slow down the drawing update during opening, even if you had deleted the marks manually.</td>
<td></td>
</tr>
</tbody>
</table>

c. In *Parts out of view plane*, select whether you want to display marks for parts that are out of view plane:

| • *Visible*: Displays marks for parts outside the view in the drawing. |
| • *Not visible*: Displays no marks for parts outside the view in the drawing. |

d. For bolt marks, select if you want to show bolt marks in main parts, secondary parts, sub-assembly main parts, or in sub-assembly secondary parts.

For bolt marks, you can also define the **Bolt size limit**, which filters standard-sized bolt marks out of drawings. Tekla Structures will not display bolt marks of the size you enter here.
Adjust mark visibility settings

<table>
<thead>
<tr>
<th>Drawing type</th>
<th>Adjust mark visibility settings</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>e. Click OK.</td>
</tr>
<tr>
<td></td>
<td>f. Click <strong>Save</strong> to save the drawing properties, then click <strong>OK</strong> and create the drawing.</td>
</tr>
</tbody>
</table>

See also

Adjust mark visibility in an existing drawing (page 221)

Merge marks automatically (page 615)

Merge reinforcement marks automatically (page 619)

Mark properties - General, Merging and Content tabs (page 726)

Mark properties (page 726)

**Adjust text, frames and leader lines of automatic marks**

You can add frames around single mark elements and around the mark itself. You can also adjust the appearance of the mark text and leader line. For some elements, you can change the unit and format.

1. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type.

2. Load drawing properties that are as close to the ones you need as possible.

3. Do one of the following depending on the drawing type:

   **Single-part, assembly and cast unit drawings:**
   a. Click **View creation**, select the view and the properties that you want to change, and click **View properties**.
   b. Click a mark type in the drawing properties dialog box. For example, click **Part mark**.

   **General arrangement drawings:**
   • Click a mark type in the drawing properties dialog box. For example, click **Part mark**.

4. On the **Content** tab of the in mark properties, select one or several elements from the **Elements in mark** list and adjust the element settings:

   • To apply your changes in all of them, hold down **Shift** and click the last element in the list to select all elements.
   • To add a frame around the selected elements, click **Add frame**.
• Select a **Type** and **Color** for the frame.
  
  You can select a different frame type and color for each element you add.
  
• Select the element text **Color**, **Font** and **Height**.
  
  You can select a different color, font and font height for each element you add.
  
• If necessary, change the unit and the format of a length, height, spacing or diameter element.
  
  Before you can do this, you must first select the element from the **Elements in mark** list.

5. Go to the **General** (or the **Appearance**) tab adjust the mark frame and leader line settings:
  
• Select the mark frame **Type** and **Color**.
  
• Select the **Type** for the leader line and the **Arrow** to use.
    
    All marks do not have leader lines, in which case the leader line type selection is not available.
  
• If you want to hide leader lines of hidden parts, set **Use hidden lines for hidden parts** to **Yes**.

  This option is not available for all marks.

6. **Single-part, assembly and cast unit drawings**: Click **Save** to save the view properties, and then click **Close** to return to drawing properties.

   **General arrangement drawings**: Click **OK**.

7. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**See also**

- Adjust part mark leader lines with advanced options (page 609)
- Place reinforcement mark leader line base point automatically (page 610)
- Mark properties - General, Merging and Content tabs (page 726)
- Mark properties (page 726)

**Adjust part mark leader lines with advanced options**

You can modify part mark leader line settings using advanced options. On the **File menu**, click **Settings --> Advanced options** and go to **Marking: Parts**.
To modify part mark leader line settings using advanced options:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define whether a leader line is drawn when the leader line is shorter than defined with the advanced option <code>XS_DRAW_SHORT_LEADER_LINES_OF_PART_MARKS_MINIMUM_LENGTH</code>.</td>
<td>Set <code>XS_DRAW_SHORT_LEADER_LINES_OF_PART_MARKS_MINIMUM_LENGTH</code> to <code>TRUE</code> (default) to always draw leader lines in part marks. When you set this option to <code>FALSE</code>, the leader line is not drawn if it would be shorter than the minimum you set for the advanced option <code>XS_DRAW_SHORT_LEADER_LINES_OF_PART_MARKS_MINIMUM_LENGTH</code>.</td>
</tr>
<tr>
<td>Give a minimum length for the leader line. If the length is less than this value, the leader line is not drawn.</td>
<td>Set a value in millimeters for the advanced option <code>XS_DRAW_SHORT_LEADER_LINES_OF_PART_MARKS_MINIMUM_LENGTH</code>.</td>
</tr>
<tr>
<td>Define the leader line start position for a leader line with a rectangular frame.</td>
<td>Set a value for the advanced option <code>XS_MARK_LEADER_LINE_POSITION_TYPE_FOR_RECTANGULAR_FRAME</code>.</td>
</tr>
<tr>
<td>Define the leader line start position for a leader line of a mark without a frame and for a leader line of a mark with a mark element frame.</td>
<td>Set a value for the advanced option <code>XS_MARK_LEADER_LINE_POSITION_TYPE_FOR_NO_FRAME</code>.</td>
</tr>
<tr>
<td>Define the length of the leader line extension.</td>
<td>Set a value for the advanced option <code>XS_MARK_LEADER_LINE_EXTENSION_LENGTH</code>.</td>
</tr>
</tbody>
</table>

See also

*Adjust text, frames and leader lines of automatic marks (page 608)*

**Place reinforcement mark leader line base point automatically**

Tekla Structures places the base point of reinforcement mark leader lines so that it points to only one reinforcing bar. You can adjust how Tekla Structures searches for the place for the base point.

- On the **File menu**, click **Settings --> Advanced options** and go to the **Concrete Detailing** category.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select an optimal place for the base point.</td>
<td>Set <code>XS_ENABLE_REBAR_MARK_LEADER_LINE_BASE_POINT</code> to <code>TRUE</code> (default) to enable the automatic placement of the base point.</td>
</tr>
</tbody>
</table>

Define automatic drawing settings 610 Automatic mark settings
To define how far the other reinforcing bars must be from the base point in order for Tekla Structures to place the base point, set a millimeter value for `XS_REBAR_MARK_LEADER_LINE_BASE_POINT_SEARCH_TOLERANCE`.

To define the search step length while searching for an optimal place for the base point along the reinforcing bar, set a millimeter value for `XS_REBAR_MARK_LEADER_LINE_BASE_POINT_SEARCH_STEP_LENGTH`.

**Example**

An example showing optimized base points.

**See also**

*Adjust text, frames and leader lines of automatic marks (page 608)*

**Mark location**

The location of the marks in drawings is affected by several settings, not only the properties of the mark itself.
<table>
<thead>
<tr>
<th><strong>Setting</strong></th>
<th><strong>Click the links below to find out more</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>The placement settings in the mark properties</td>
<td>Define automatic placement settings for marks (page 458)</td>
</tr>
</tbody>
</table>
| The type of the selected leader line | How leader line type affects part mark and surface treatment mark location (page 613)  
How leader line type affects reinforcement mark location (page 615)  
How merging affects reinforcing bar group mark location (page 613) |
| The predefined mark location and part orientation settings | Set a predefined location for beam, bracing and column marks (page 612)  
Settings in the Options dialog box: Orientation settings  
Use part mark as an orientation mark in general arrangement drawings (page 646) |
| Protection settings | Protected areas in drawings (page 454) |
| The modeling direction of parts | Creating horizontal parts |

**See also**

Mark properties (page 726)

Mark properties - General, Merging and Content tabs (page 726)

**Set a predefined location for beam, bracing and column marks**

By default, part marks are placed at the end point of the part. You can change this by adjusting the predefined location settings for beam, bracing and column marks.

1. On the **File** menu, click **Settings --> Options** and go to the **Orientation marks** settings.
2. In **Mark location: Preferred location for beams and bracings**, select **Left** or **Right** to place the mark to the left or right end of the part.
3. In **Mark location: Mark always to center of column in GA drawings**, select **Yes** to place part marks in the center of columns in plan views, or **No** to place part marks on the same flange in GA drawings and assembly drawings.
4. Click **OK**.

**See also**
Mark location (page 611)
Mark properties (page 726)
Mark properties - General, Merging and Content tabs (page 726)
Use part mark as an orientation mark in general arrangement drawings (page 646)

**How leader line type affects part mark and surface treatment mark location**

Part marks and surface treatment marks have several types of leader lines you can select. The type of the leader line affects the location of the mark.

<table>
<thead>
<tr>
<th>Leader line type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Leader line" /></td>
<td>Always uses a leader line.</td>
</tr>
<tr>
<td><img src="image" alt="Leader line" /></td>
<td>Tries to find a space along the part for the mark. If impossible, Tekla Structures uses a leader line.</td>
</tr>
<tr>
<td><img src="image" alt="Leader line" /></td>
<td>The mark is always along the part. Lack of space might cause the mark to overlap other elements.</td>
</tr>
<tr>
<td><img src="image" alt="Leader line" /></td>
<td>The mark is always inside the part.</td>
</tr>
<tr>
<td><img src="image" alt="Leader line" /></td>
<td>The mark is always inside the part and parallel to the part axis.</td>
</tr>
<tr>
<td><img src="image" alt="Leader line" /></td>
<td>Tries to find a space for the mark inside the part. If impossible, Tekla Structures places the mark along the part with a leader line.</td>
</tr>
<tr>
<td><img src="image" alt="Leader line" /></td>
<td>Tries to find a space inside the part for the mark and align it parallel to the part axis. If impossible, Tekla Structures places the mark along the part with a leader line.</td>
</tr>
<tr>
<td><img src="image" alt="Leader line" /></td>
<td>Places the part mark along and in the middle of a part face.</td>
</tr>
</tbody>
</table>

**See also**
Mark location (page 611)
Mark properties - General, Merging and Content tabs (page 726)
Mark properties (page 726)
**How merging affects reinforcing bar group mark location**

In reinforcing bar groups Tekla Structures first tries to place the mark on the middle bar if it is visible. If that is not possible, Tekla Structures tries the next visible bar.

Below is a list of leader line options available for identical reinforcement marks and reinforcing bar group marks:

<table>
<thead>
<tr>
<th>Option</th>
<th>Image</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>One leader line to group</td>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="example1.png" alt="Example" /></td>
</tr>
<tr>
<td>One leader line per row</td>
<td><img src="image2.png" alt="Image" /></td>
<td><img src="example2.png" alt="Example" /></td>
</tr>
<tr>
<td>Parallel leader lines</td>
<td><img src="image3.png" alt="Image" /></td>
<td><img src="example3.png" alt="Example" /></td>
</tr>
<tr>
<td>Leader lines to one point</td>
<td><img src="image4.png" alt="Image" /></td>
<td><img src="example4.png" alt="Example" /></td>
</tr>
</tbody>
</table>

**See also**

Mark location (page 611)
How leader line type affects reinforcement mark location

Reinforcement marks have several types of leader lines you can select. The type of the leader line affects the location of the mark. Tekla Structures tries to place the mark close to the midpoint on straight bars, or to the midpoint of the longest bar segment.

<table>
<thead>
<tr>
<th>Reinforcement leader line type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Leader Line 1" /></td>
<td>Always creates a leader line.</td>
</tr>
<tr>
<td><img src="image" alt="Leader Line 2" /></td>
<td>Tries to find a space along the reinforcing bar for the mark. If impossible, creates a leader line.</td>
</tr>
<tr>
<td><img src="image" alt="Leader Line 3" /></td>
<td>The mark is always along the reinforcing bar. The mark may overlap other elements if there is not enough space.</td>
</tr>
<tr>
<td><img src="image" alt="Leader Line 4" /></td>
<td>The mark is parallel to the reinforcing bar.</td>
</tr>
<tr>
<td><img src="image" alt="Leader Line 5" /></td>
<td>The mark is parallel to the reinforcing bar on line. If there is not enough space for the mark, a leader line is created.</td>
</tr>
</tbody>
</table>

See also

- Mark location (page 611)
- Mark properties - General, Merging and Content tabs (page 726)
- Merge reinforcement marks automatically (page 619)
- Mark properties (page 726)

Merge marks automatically

You can let Tekla Structures automatically merge marks.

You can automatically merge:

- Part marks and surface treatment marks: Merge part marks automatically (page 618)
- Reinforcement marks: Merge reinforcement marks automatically (page 619)

See also

- Merge marks (page 229)
Merged reinforcement marks (page 618)

**Merged part marks**
A merged part mark means that you have only one part mark for similar parts in a drawing, instead of a separate mark for each of the parts. Merged part marks indicate the number of included parts, and contain the defined part mark contents, and the near side and far side information. The marks are merged only in X direction of the main part.

Tekla Structures merges marks for visible parts in drawings if:

- The secondary parts are welded or bolted to the same main part.
- The parts are on the same line.
- Distances between the parts are equal.
- The parts have the same part position.
- Distance between parts is not more than what is set for the advanced option `XS_PART_MERGE_MAX_DISTANCE`.
- There are at least as many parts in the array as it has been set for the advanced option `XS_MIN_MERGE_PART_COUNT`.

**Limitations**

- Part marks can be merged only on view and drawing level. It is not possible to merge or split part marks manually.
- You cannot merge part marks (assembly marks) that are not part of the same assembly.
- Tekla Structures does not merge neighbor part marks.

**Advanced options in merging marks**

In merging part marks, you may find the following advanced options useful:

- `XS_MULTIPLIER_SEPARATOR_FOR_MERGED_PART_MARK`
- `XS_NSFS_POSTFIX_FOR_MERGED_PART_MARK`
- `XS_NS_POSTFIX_FOR_MERGED_PART_MARK`
- `XS_FS_POSTFIX_FOR_MERGED_PART_MARK`
- `XS_PART_MERGE_MAX_DISTANCE`
- `XS_MIN_MERGE_PART_COUNT`

**Example**

In the example below, the part marks are merged in X direction of the HEA300 beam (main part).
In the example below, the leftmost part marks are not merged, because they are too far from each other.

In the example below, the marks in the Y direction are not merged, because the marks are merged only in X direction (which in this example is horizontal).
See also
Merge part marks automatically (page 618)
Mark properties - General, Merging and Content tabs (page 726)

**Merge part marks automatically**
You can merge part marks and surfaced treatment marks automatically to reduce the number of marks in the drawing.

1. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. **Single-part, assembly and cast unit drawings:** Click **View creation**, select the view and the properties that you want to change, and click **View properties**.
4. Click **Part mark**.
   If you want to merge surface treatment, click **Surface treatment mark** instead.
5. On the **General** tab in the part mark properties, set **Merge marks** to **On**.
6. **Single-part, assembly and cast unit drawings:** Click **Save** to save the changes in view properties and **Close** to return to drawing properties.
   **General arrangement drawings:** Click **OK**.
7. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

   Tekla Structures merges marks for identical secondary parts on both faces of main parts.

See also
Merged part marks (page 616)
Mark properties - General, Merging and Content tabs (page 726)

**Merged reinforcement marks**
Tekla Structures can automatically merge similar reinforcement marks of bars. Merged reinforcement marks may include several blocks, and additional information. Blocks combine similar single marks.

**NOTE**
To have Tekla Structures automatically merge reinforcement marks in drawings, the reinforcement must be attached to a concrete part or cast unit in the model.
Tekla Structures automatically merges marks for visible reinforcing bars in drawings if:

- The bars belong to the same concrete part or cast unit.
- The direction of the bars is the same.
- The bar marks are identical.
- The bars are close to each other.
- A straight line can be drawn through all the bars.

You can also define the distance within which to automatically merge marks for visible reinforcing bars using the following advanced options:

- `XS_MAX_MERGE_DISTANCE_IN_HORIZONTAL`
- `XS_MAX_MERGE_DISTANCE_IN_VERTICAL`

See also

- Merge reinforcement marks manually (page 232)
- Merge reinforcement marks automatically (page 619)

**Merge reinforcement marks automatically**

You can merge reinforcement marks automatically to reduce the number of marks in the drawing.

1. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type. You can merge reinforcement marks in cast unit drawings and general arrangement drawings.
2. Load drawing properties that are as close to the ones you need as possible.
3. **Cast unit drawings:** Click **View creation**, select the view and the properties that you want to change, and click **View properties**.
4. Click **Reinforcement mark**.
5. Go to the **Merging** tab of the reinforcement marks dialog box.
6. Select an option from the **Identical marks in same cast unit** list to merge marks and create leader lines:
   - **One leader line per row:** Merges the marks and creates one leader line for a row of reinforcing bars.
   - **Parallel leader lines:** Merges the marks and creates parallel leader lines.
   - **Leader lines to one point:** Merges the marks and draws all leader lines to one point.
No merge: Marks are not merged, an individual leader line is created for each mark.

If you select No merge, you still need to define the mark content for the marks that Tekla Structures automatically merges on the Merging tab.

7. If there are several possible merge directions, select the horizontal or vertical from Preferred direction of merge.

8. Select the contents to be included in the merged reinforcement marks from the Available elements list.

To ensure that merged reinforcement marks appear in the drawing, always include Symbol separating blocks in mark as the last element in the reinforcement mark. To omit the separating symbol, leave this box blank, but still include the element in the mark.

9. If needed, add a frame around the single elements in the mark. You can define the frame individually for each element.

10. Adjust the font, font height and the color of the mark text. You can adjust these settings individually for each element.

11. Cast unit drawings: Click Save to save the changes in view properties and Close to return to drawing properties.

   General arrangement drawings: Click OK.

12. Click Save to save the drawing properties, then click OK and create the drawing.

Example
In this example, three A φ12 L2000 marks are merged to a block, and six V φ8 L650 marks to another block, and then these blocks are merged in the following way:

1. Single mark content
2. Symbol separating the blocks
3. Block prefix
4. Distance between groups
5. Block 1
6. Block 2

See also
Mark properties - General, Merging and Content tabs (page 726)
Merged reinforcement marks (page 618)

Show mark frames and leader lines for hidden parts
If a part is behind another part in the drawing so that it is hidden, you can select whether to show the mark frame and leader line of the hidden part with a dashed or a solid line.

1. On the Drawings & reports tab, click Drawing properties and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. Single-part, assembly and cast unit drawings: Click View creation, select the view and the properties that you want to change, and click View properties.
4. Click Part mark.
5. In part mark properties, go to the General tab.
6. Use one of the following options:

   Use hidden lines for hidden parts: Yes
   Part mark frame and leader line are shown with a dashed line.

   ![Dashed line example]

   Use hidden lines for hidden parts: No
   Part mark frame and leader line are shown with a solid line.

   ![Solid line example]

7. Single-part, assembly and cast unit drawings: Click Save to save the changes in view properties and Close to return to drawing properties.
   General arrangement drawings: Click OK.
8. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**TIP** With the advanced option `XS_OMIT_MARKS_OF_HIDDEN_PARTS_IN_GA_DRAWINGS` you can omit the marks of hidden objects in general arrangement drawings.

**See also**

- Mark properties - General, Merging and Content tabs (page 726)
- Mark properties (page 726)

### Change unit settings for marks

Tekla Structures uses the `contentattributes_global.lst` attributes file for setting the default unit settings for various mark elements. This file defines, for example, the unit used, and the number of decimals. You can change the unit and format for the length, height, diameter, and spacing elements in the mark, associative note and dimension mark properties dialog box. One additional way to change the unit is to add individual settings at the end of the `contentattributes.lst` file.

The `contentattributes_global.lst` file also defines default values for attributes in templates created in Template Editor.

If you change the unit and format, save the changes for future usage in a property file if necessary.

**WARNING** Do not edit `contentattributes_global.lst`.

For user-defined attributes in mark elements, the default unit settings are taken from the `contentattributes_userdefined.lst` file. You can use `contentattributes_userdefined.lst` also when you want to configure settings of your own. By default, this file is located in `..\Program Files\Tekla Structures\<version>\nt\TplEd\settings`, but often the location depends on your environment. The files are read from different locations in a certain search order.

The container file `contentattributes.lst` lists all the files that contain the actual attribute definitions. The order of the files included in `contentattributes.lst` defines the reading order of the files.

**TIP** You can add in the mark a template that changes the unit and number of decimals. This affects all drawings that have marks containing the changed template.
Example 1
This first example shows how you can change the unit and format of a length element in the part mark, save your changes in a property file and apply the changes in a part mark.

1. Double-click the background of an open drawing to open the Drawing Properties dialog box.
2. Click Part mark.
3. Add a Length element in the part mark.
4. Select Length from the Elements in mark list and adjust the unit and format as required. For example, select mm and ###.##.
   The unit and format settings only become available when you select the Length element in the Elements in mark list.
5. Give a name to the property file next to the Save as button and click Save as.
   Now you can load this file later on when you need to use the same unit and format again.
6. Click Modify.
   All the part marks in your drawing now have the new unit and format setting for the length element.

Example 2
This second example shows a situation when you want a certain project to have certain individual settings. In this case, you can add contentattributes.lst under the model folder, and add this individual setting at the end of the contentattributes.lst. See the example below showing the included global attributes and user attributes files, and the added DIAMETER setting.
Add attributes in automatic marks

All types of building object marks allow you to add user-defined attributes and template attributes. For example, you might want to add control numbers or specify the number of characters in part numbers in assembly or part marks.

You can add user-defined attributes and template attributes in automatic and manual marks.

1. On the Drawings & reports tab, click Drawing properties and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. **Single-part, assembly and cast unit drawings:** Click View creation, select the view and the properties that you want to change, and click View properties.
4. Click Part mark.
5. In the mark properties dialog box, double-click the User-defined attribute element in the Available elements list to add it in the mark.
6. Enter the user-defined attribute name in the Mark content - user defined attribute dialog box exactly as it appears in the objects.inp file.
   If you need a template attribute in your mark, enter that instead.
7. **Single-part, assembly and cast unit drawings:** Click Save to save the changes in view properties and Close to return to drawing properties.

**General arrangement drawings:** Click OK.
8. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**Example**

In the following example, the user-defined attribute `OBJECT_LOCKED` has been added in the part mark after a text element `Locked:

---

**Locked: Yes**

**See also**

- Add level attributes in automatic part marks (page 625)
- Mark elements (page 737)
- Common elements in marks (page 738)

**Add level attributes in automatic part marks**

You can add level attributes, such as `TOP_LEVEL`, `BOTTOM_LEVEL`, `ASSEMBLY_TOP_LEVEL`, `ASSEMBLY_BOTTOM_LEVEL`, and `ASSEMBLY.MAIN_PART.TOP_LEVEL`, in part marks as user-defined attributes.

The level attributes take the dimension format from the `MarkDimensionFormat.dim` file. If you want, you can also change the dimension format in the Dimension properties dialog box in an open drawing and load the changed dimension properties in the dimensioning rule that you use for creating dimensions in a view.

You can add level attributes in automatic and manual marks.

To change the dimension format and add level attributes:

1. In an open drawing, on the **Drawing** tab, click **Properties -- Dimension**.
2. Select `MarkDimensionFormat` from the properties file list at the top, and click **Load**.
3. Change the unit, precision and format as desired.
4. Click **Save** to save the changes in the **MarkDimensionFormat** file, and then click **Cancel** to close the dialog box.

5. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type.

6. Load drawing properties that are as close to the ones you need as possible.

7. Click **View creation**, select the view and the properties that you want to change, and click **View properties**.

8. Click **Part mark**.

9. In part mark properties, double-click the **User-defined attribute** element to add it to the mark.

10. Enter a user-defined attribute name in the **Mark content - user defined attribute** dialog box.

You can enter the following values:

- **TOP_LEVEL**
- **TOP_LEVEL_UNFORMATTED**
- **TOP_LEVEL_GLOBAL**
- **TOP_LEVEL_GLOBAL_UNFORMATTED**
- **BOTTOM_LEVEL**
- **BOTTOM_LEVEL_UNFORMATTED**
- **BOTTOM_LEVEL_GLOBAL**
- **BOTTOM_LEVEL_GLOBAL_UNFORMATTED**
- **ASSEMBLY_TOP_LEVEL**
- **ASSEMBLY_TOP_LEVEL_UNFORMATTED**
- **ASSEMBLY_TOP_LEVEL_GLOBAL**
- **ASSEMBLY_TOP_LEVEL_GLOBAL_UNFORMATTED**
- **ASSEMBLY_BOTTOM_LEVEL**
- **ASSEMBLY_BOTTOM_LEVEL_UNFORMATTED**
11. Click **Dimensioning** in the options tree.
12. Select a dimension rule from the list and click **Edit Rule**.
13. Select **MarkDimensionFormat** from the **Dimension properties** list.
14. Save the dimensioning rule by clicking **Save** and click **Close**.
15. Save the view properties clicking **Save**.
16. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**Example**

In the following example, **TOP_LEVEL** and **ASSEMBLY_TOP_LEVEL** have been added in the mark.
See also
Add attributes in automatic marks (page 624)
Units and decimals in drawings, reports and templates (page 675)

Add templates in marks
You can create custom graphical templates (.tpl) with Template Editor and add them as elements in all types of marks, dimension marks and associative notes in all drawing types.

In mark templates, you can include detailed information of an embed or assembly, such as the sub-material used. Or you can use a template that changes the unit and the number of decimals in measurement values in a mark. You can also add graphical objects using the Template Editor tools.

To add templates in dimension marks or tags, you need to modify the Dimension Properties in an open drawing. You can save the dimension properties, and then take the saved properties into use when you create automatic dimensions (page 504).

The size of the templates in part marks is calculated according to the actual size of template contents. Only lines and texts in the template are considered when calculating the exact size. This means, for example, that circles or bitmaps in the template do not have any effect.
Limitations: Mark templates do not support image files like the other graphical drawing templates.

Before you add a template in a mark, ensure that the template you use does not contain any margins.

1. On the Drawings & reports tab, click Drawing properties and select the drawing type.

2. Load drawing properties that are as close to the ones you need as possible.

3. Single-part, assembly and cast unit drawings: Click View creation, select the view and the properties that you want to change, and click View properties.

4. Click the mark type that you want to change.

For example, click Part mark.

5. In the mark properties dialog box, double-click the Template element in the Available elements list to add it in the mark.

This will remove all other elements from the mark.

6. Select a template from the list in the Mark content - template dialog box. If you have not created a template yet, or want to edit the template, you can do that from here by selecting Create new or Edit.

Remember that if you edit the template here, the change affects all drawings that have marks containing the changed template.

7. Click OK to return to mark properties.

8. Save the mark properties for later using a unique name.

9. Single-part, assembly and cast unit drawings: Click Save to save the changes in view properties and Close to return to drawing properties.

General arrangement drawings: Click OK.

10. Click Save to save the drawing properties, then click OK and create the drawing.

11. When necessary, copy the saved mark properties files from the <model>\attributes folder into your firm or project folder.

TIP The mark templates are by default searched from the following folders in the following order:

- %XS_TEMPLATE_DIRECTORY%\mark
- ModelDir\mark
- %XS_PROJECT%\mark
- %XS_FIRM%\mark
- %XS_TEMPLATE_DIRECTORY_SYSTEM%\mark

Define automatic drawing settings 629 Automatic mark settings
The mark folder name can be changed using the advanced option 
\texttt{XS\_TEMPLATE\_MARK\_SUB\_DIRECTORY}

**Example**

For more information about templates in marks, see the following examples:

**Example 1:** Create a mark template containing separate value fields and text elements (page 630)

**Example 2:** Create a mark template containing a formula in the value field (page 632)

**Example 1: Create a mark template containing separate value fields and text elements**

You can use decimals instead of fractions in your part marks in the US Imperial environment by using a mark template. The template contains separate value fields and text elements that change the fractions to decimals, and change the number of decimals.

1. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. **Single-part, assembly and cast unit drawings:** Click **View creation**, select the view and the properties that you want to change, and click **View properties**.
4. Click **Part mark**.
5. Double-click **Template** in the **Available elements** list.

---

%XS_SYSTEM\mark

Define automatic drawing settings 630 Automatic mark settings
6. In the **Mark content - template** dialog box, click **Create new**.
   This starts the Template Editor.

7. Click **File --> New** and create a new graphical template.

8. Click **Insert --> Component --> Row**.

9. Select **PART** as the content type.

10. Click **Insert --> Text**, enter L and place it inside the row you just added.

11. Click **Insert --> Value field** and place the value field on the right side of the L text.

12. In the displayed **Select Attribute [Part]** dialog box, scroll down to **PROFILE - Profile**, open the profile tree, select the **HEIGHT - height** property and click **OK**.

13. Double-click the value field. In the **Value Field Properties** dialog box, change the settings as follows:
   - **Unit**: inch
   - **Decimals**: 1
   - **Length**: 8

14. Click **OK**.

15. Click **Insert --> Text**, enter X as text and place it on the right side of the value field.

16. In the similar way, add another value field for the width information (**WIDTH - Width** profile property).

17. Click **Insert --> Text** and add the second X between the value fields.

18. Add the third value field for the profile flange thickness by selecting **FLANGE_THICKNESS_1 - Flange thickness 1** profile property and modify the settings as follows:
   - **Unit**: inch
   - **Decimals**: 2
   - **Length**: 4

19. Click **Edit --> Properties** and minimize the height and the width of the row.

20. Click **File --> Save** to save the template.
   The template is by default saved as a .tpl file in the \mark folder under the model folder. You can copy this template to other models as required.

21. In Tekla Structures, click **Refresh list** in the **Mark content - template** dialog box to see the template you created.

22. Select the template and click **OK**.
23. Save the mark properties for late use with a unique name.

24. **Single-part, assembly and cast unit drawings:** Click **Save** to save the changes in view properties and **Close** to return to drawing properties.

   **General arrangement drawings:** Click **OK**.

25. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**Example**

The first example below uses fractions and the second one decimals.

![Example Mark](image)

**Example 2: **Create a mark template containing a formula in the value field**

You use decimals instead of fractions in your part marks in the US Imperial environment by adding a formula in the mark template value field.

1. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. **Single-part, assembly and cast unit drawings:** Click **View creation**, select the view and the properties that you want to change, and click **View properties**.
4. Click **Part mark**.
5. In the mark properties dialog box, double-click the **User-defined attribute** element in the **Available elements** list to add it in the mark.
6. In the **Mark content - template** dialog box, click **Create new**. This starts the Template Editor.
7. Click **File** --> **New** and create a new graphical template.
8. Click **Insert** --> **Component** --> **Row**.
9. Select **PART** as the content type.
10. Click **Insert** --> **Value field**, and place the field.
11. In the displayed **Select Attribute [Part]** dialog box, click the **Formula** button.
12. Add the following formula in the **Formula** box and click **OK**:

   \[ L \text{ inch} \times W \text{ inch} \times \text{Thickness} \text{ inch} \]

   where:
   - \( L \) is the length of the part
   - \( W \) is the width of the part
   - \( \text{Thickness} \) is the thickness of the part

13. Double-click the value field to open the **Value Field Properties** dialog box.
14. Set the **Data type** to text, enter a name for the field, for example, **PART_MARK**, and ensure that the length value you give in the **Length** field is high enough to fit all the characters and numbers included, for example, 20.
15. Click **OK**.
16. Click **Edit** --> **Properties** and minimize the height and the width of the row.
17. Click **File** --> **Save** to save the template.

   The template is by default saved as a .tpl file in the \mark folder under the model folder. You can copy this template to other models as required.
18. In Tekla Structures, click **Refresh list** in the **Mark content - template** dialog box to see the template you created.
19. Select the template and click **OK**.
20. Save the mark properties for later use with a unique name.
21. **Single-part, assembly and cast unit drawings**: Click **Save** to save the changes in view properties and **Close** to return to drawing properties.

   **General arrangement drawings**: Click **OK**.
22. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

See also

Example 1: Create a mark template containing separate value fields and text elements (page 630)
Add symbols in automatic marks
All types of marks allow you to add symbols in them. You can select the symbol file to be used and the symbol to be added in the mark.

1. On the Drawings & reports tab, click Drawing properties and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. **Single-part, assembly and cast unit drawings:** Click View creation, select the view and the properties that you want to change, and click View properties.
4. Click Part mark.
5. In mark properties, double-click Symbol in the Available elements list.
6. In the Mark content - Symbol dialog box, click Select next to the File box to select the symbol file you want to use.
7. When you have selected the file, click Select next to the Number box to select the number of the symbol you want to use.
8. Click OK.
   Tekla Structures adds the name of the symbol file and the number of the symbol in the elements list.
9. Save the mark properties for later use with a unique name.
10. **Single-part, assembly and cast unit drawings:** Click Save to save the changes in view properties and Close to return to drawing properties.
    **General arrangement drawings:** Click OK.
11. Click Save to save the drawing properties, then click OK and create the drawing.

See also
Symbols in drawings (page 347)

Define size in bolt marks using advanced options
You can use certain advanced options to define the contents of the bolt mark Size element in different types of drawings.

To change the bolt mark Size element content, go to File menu --> Settings --> Advanced options --> Marking: Bolts .

**NOTE** • General arrangement drawings have separate advanced options.
Any changes made to the advanced options listed in the table below will take place only in the new drawings you create, and if you modify the affected bolt marks.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define the contents of the size element in slotted hole marks or</td>
<td>Set a value for the advanced option XS_LONGHOLE_MARK_STRING_FOR_SIZE.</td>
</tr>
<tr>
<td>longhole marks (general arrangement drawings).</td>
<td>For GA-drawings, set a value for the advanced option</td>
</tr>
<tr>
<td></td>
<td>XS_LONGHOLE_MARK_STRING_FOR_SIZE_IN_GA.</td>
</tr>
<tr>
<td>Define the contents of the size element in slotted hole marks or</td>
<td>Set a value for the advanced option XS_SITE_LONGHOLE_MARK_STRING_FOR_SIZE.</td>
</tr>
<tr>
<td>longhole marks (general arrangement drawings) for site bolts.</td>
<td>For GA-drawings, set a value for the advanced option</td>
</tr>
<tr>
<td></td>
<td>XS_SITE_LONGHOLE_MARK_STRING_FOR_SIZE_IN_GA.</td>
</tr>
<tr>
<td>Define the contents of the size element in slotted hole marks or</td>
<td>Set a value for the advanced option XS_SHOP_LONGHOLE_MARK_STRING_FOR_SIZE.</td>
</tr>
<tr>
<td>longhole marks (general arrangement drawings) for workshop bolts.</td>
<td>For GA-drawings, set a value for the advanced option</td>
</tr>
<tr>
<td></td>
<td>XS_SHOP_LONGHOLE_MARK_STRING_FOR_SIZE_IN_GA.</td>
</tr>
<tr>
<td>Define the contents of the size element in hole marks.</td>
<td>Set a value for the advanced option XS_HOLE_MARK_STRING_FOR_SIZE.</td>
</tr>
<tr>
<td></td>
<td>For GA-drawings, set a value for the advanced option</td>
</tr>
<tr>
<td></td>
<td>XS_HOLE_MARK_STRING_FOR_SIZE_IN_GA.</td>
</tr>
<tr>
<td>Define the contents of the size element in hole marks for site</td>
<td>Set a value for the advanced option XS_SITE_HOLE_MARK_STRING_FOR_SIZE.</td>
</tr>
<tr>
<td>bolts.</td>
<td>For GA-drawings, set a value for the advanced option</td>
</tr>
<tr>
<td></td>
<td>XS_SITE_HOLE_MARK_STRING_FOR_SIZE_IN_GA.</td>
</tr>
<tr>
<td>To</td>
<td>Do this</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>
| Define the contents of the size element in hole marks for workshop bolts. | Set a value for the advanced option XS_SHOP_HOLE_MARK_STRING_FOR_SIZE  
For GA-drawings, set a value for the advanced option XS_SHOP_HOLE_MARK_STRING_FOR_SIZE_IN_GA |
| Define the contents of the size element in bolt marks. | Set a value for the advanced option XS_BOLT_MARK_STRING_FOR_SIZE  
For GA-drawings, set a value for the advanced option XS_BOLT_MARK_STRING_FOR_SIZE_IN_GA |
| Define the contents of the size element in bolt marks for site bolts. | Set a value for the advanced option XS_SITE_BOLT_MARK_STRING_FOR_SIZE  
For GA-drawings, set a value for the advanced option XS_SITE_BOLT_MARK_STRING_FOR_SIZE_IN_GA |
| Define the contents of the size element in bolt marks for workshop bolts. | Set a value for the advanced option XS_SHOP_BOLT_MARK_STRING_FOR_SIZE  
For GA-drawings, set a value for the advanced option XS_SHOP_BOLT_MARK_STRING_FOR_SIZE_IN_GA |

You can use any combination of text and the following options as the value for the above advanced options. Enclose each option in % characters. To use special characters enter a backslash (\) followed by an ASCII number. You can use the options in any order, and make calculations.

- BOLT_NUMBER
- DIAMETER
- LENGTH
- HOLE_DIAMETER
- LONG_HOLE_X
- LONG_HOLE_Y
- LONGHOLE_MIN (the shorter of the slotted hole dimensions)
- LONGHOLE_MAX (the longer of the slotted hole dimensions)
Example

Example of using the advanced options:

\[ XS_{-}LONGHOLE\_MARK\_STRING\_FOR\_SIZE=D%HOLE.DIAMETER\% \\
   (\%HOLE.DIAMETER+LONG\_HOLE_X\%x\%HOLE.DIAMETER+LONG\_HOLE_Y\%) \]

\[ XS_{-}SITE\_HOLE\_MARK\_STRING\_FOR\_SIZE=D%HOLE.DIAMETER\% \]

Please note that for calculations the operator (+, -, *, /) must not be outside the "%" marks:

Correct: %OPTION1*OPTION2%

Incorrect: %OPTION1%*%OPTION2%

For example, if OPTION1 = 5.0 and OPTION2 = 3.0, the results would be "15" and "5*3"

Add pull-out pictures in automatic reinforcement marks

You can add a pull-out picture of the reinforcing bar in the reinforcement mark to illustrate the shape and dimensions of the bar in the drawing.

Pull-out pictures can be added in automatic and manually created reinforcement marks.

1. On the Drawings & reports tab, click Drawing properties and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. Cast unit drawings: Click View creation, select the view and the properties that you want to change, and click View properties.
4. Click Reinforcement mark.
5. Double-click the Pullout picture element in the Available elements list to add it in the reinforcement mark.
6. In the Pullout picture dialog box, select the scaling option in Scale by:
   - Auto auto-scales the pull-out.
• **One factor** and **Two factors** scale the pull-out according to the values that you enter.

The scale of the pull-out is relative to the scale of the drawing view. For example, if the drawing view scale is 1/10 and the pull-out scaling is 2, the actual scale of the pull-out in the drawing view is 1/5.

7. In **Rotation**, select the rotation of the pull-out: **Automatic**, **Plane** or **3D**. If the pull-out is 3D, and you select **Automatic**, Tekla Structures automatically shows the pull-out in 3D.

8. In **End marks**, define the shape of bar ends in the pull-out.

9. Select **Dimensions** to show bar dimensions in the pull-out.

10. Select **Exaggeration** to show reinforcing bar hooks more clearly in the pull-out.

11. Select **Bending radius** to show the bending radius in form of diameter of the bending roll.

12. Select **Bending angle** to show bar bending angles in the pull-out.

13. Click **OK**.

14. Save the mark properties for late use with a unique name.

15. **Cast unit drawings**: Click **Save** to save the changes in view properties and **Close** to return to drawing properties.

    **General arrangement drawings**: Click **OK**.

16. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**Example**

![Example diagram](image)

A 3D pull-out showing the bending radius:
TIP  To change the leader line length, color, line type, or representation of a pull-out, open the (page 760) file in \..\Tekla Structures\<version>\environments\<environment>\system and edit the following lines: PullOutLeaderLineMinLength, PulloutColor, PulloutVisibleLinetype and PulloutRepresentation.

See also
Reinforcement and neighbor reinforcement mark elements (page 742)

8.7 Automatic grid settings in drawings
You can show grids in all types of drawings. You can change the appearance and visibility of the labels, label frames, and grid lines.
See also
Grids in drawings (page 334)
Define automatic grid properties (page 640)
Drawing grid properties (page 774)
Define automatic grid properties
You can modify drawing grid properties of single-part, assembly and cast unit drawings individually for each view. In general arrangement drawings, you can modify the grid properties on both view and drawing level. You can also modify individual grid properties of in an open drawing.

1. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. Single-part, assembly and cast unit drawings: Click **View creation**, select the view and the properties that you want to change, and click **View properties**.
4. Click **Grid**.
5. Modify the grid properties as required.
6. Single-part, assembly and cast unit drawings: Click **Save** to save the view properties and click **Close**.
   - General arrangement drawings: Click **OK**.
7. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**TIP** The advanced options `XS_DRAWING_GRID_LABEL_FRAME_FIXED_WIDTH` and `XS_DRAWING_GRID_LABEL_FRAME_LINE_WIDTH_FACTOR` allow you to adjust the grid labels further.

See also
- **Drawing grid properties** (page 774)

### 8.8 Automatic part and neighbor part settings in drawings
Parts and neighbor parts in drawings are building objects that will exist in the real structure or which will be closely related to the structure.

Parts and neighbor parts have drawing properties that affect the way that the part is shown in the drawing.

<table>
<thead>
<tr>
<th>To</th>
<th>Click the links below to find out more</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define what is shown in a part and how the part is shown</td>
<td>Define automatic drawing part properties (page 642)</td>
</tr>
<tr>
<td>To</td>
<td>Click the links below to find out more</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Check examples of modifying the part settings</td>
<td>Define automatic neighbor part properties (page 644)</td>
</tr>
<tr>
<td>Define what is shown of neighbor parts and how the neighbor parts are shown. You can also control the visibility of the neighbor part bolts.</td>
<td>Example: Part representations (page 643)</td>
</tr>
<tr>
<td>Indicate the part orientation by using part marks, by including compass direction in marks, and showing orientation marks and connecting side marks</td>
<td>Indicate part orientation (page 645)</td>
</tr>
<tr>
<td>Check and change part and neighbor part properties</td>
<td>Part and neighbor part properties in drawings (page 749)</td>
</tr>
</tbody>
</table>

**Define automatic drawing part properties**

You can define what is shown in a part and how the part is shown.

1. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. Single-part, assembly and cast unit drawings: Click **View creation**, select the view and the properties that you want to change, and click **View properties**.
4. Click **Part**.
5. On the **Contents** tab, select the part representation, whether to show hidden lines, center lines and reference lines, and which additional markings to show.
   - A reference line is a line between the points from which a part is created.
6. On the **Appearance** tab, select the color and type of the lines.
   - The color of the center lines can be changed only on the drawing and view level, not on the object level. For center lines, you can only adjust the color in the properties dialog box, not the type. You can adjust the line type of part center lines with the advanced option `XS_CENTER_LINE_TYPE`.
7. On the **Fill** tab, set the part and section fill options.
8. Single-part, assembly and cast unit drawings: Click **Save** to save the view properties. Then return to drawing properties by clicking **Close**.
9. General arrangement drawings: Click **OK** to return to drawing properties.
10. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**See also**
- Part and neighbor part properties in drawings (page 749)
- Example: Part representations (page 643)

**Example: Part representations**

Here are some examples of what parts look like with different settings defined in the **Part Properties** dialog box.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Part representation</strong> is set to <strong>Outline</strong>.</td>
<td><img src="example.png" alt="Outline Example" /></td>
</tr>
<tr>
<td><strong>Part representation</strong> is set to <strong>Exact</strong>. The <strong>Edge chamfers</strong> check box is selected in <strong>Additional marks</strong>.</td>
<td><img src="example.png" alt="Exact Example" /></td>
</tr>
<tr>
<td><strong>Part representation</strong> is set to <strong>Symbol</strong>.</td>
<td><img src="example.png" alt="Symbol Example" /></td>
</tr>
</tbody>
</table>
### Setting | Example
--- | ---
Part representation is set to Symbol with partial profile. | ![Symbol with partial profile](image)
Part representation is set to Bounding box. | ![Bounding box](image)
Part representation is set to Base box. | ![Base box](image)

The Hidden lines check box is not selected. | ![Hidden lines not selected](image)

The Hidden lines check box is selected. The Own hidden lines check box is selected.
1. Hidden lines for other parts are shown.
2. Own hidden lines for the main part are shown. | ![Hidden lines selected](image)

**See also**
- Part and neighbor part properties in drawings (page 749)
- Define automatic drawing part properties (page 642)

**Define automatic neighbor part properties**
You can define what is shown of neighbor parts and how the neighbor parts are shown. You can also control the visibility of the neighbor part bolts.

1. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. Single-part, assembly and cast unit drawings: Click **View creation**, select the view and the properties that you want to change, and click **View properties**.
4. Click **Neighbor part**.
5. Select the desired visibility options on the **Visibility** tab.
   - For more information, see Show neighbor parts in views (page 479)

6. On the **Contents** tab, select the neighbor bolt representation, whether to show hidden lines, center lines and reference lines, and which additional markings to show.
   
   A **reference line** is a line between the points from which a part is created.

7. On the **Appearance** tab, select the color and type of the lines.
   
   The color of the center lines can be changed only on the drawing and view level, not on the object level. For center lines, you can only adjust the color in the properties dialog box, not the type.
   
   You can adjust the line type of part center lines with the advanced option `XS_CENTER_LINE_TYPE`.

8. Single-part, assembly and cast unit drawings: Click **Save** to save the view properties. Then return to drawing properties by clicking **Close**.

9. General arrangement drawings: Click **OK** to return to drawing properties.

10. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**See also**

Automatic part and neighbor part settings in drawings (page 641)

Part and neighbor part properties in drawings (page 749)

Example: Part representations (page 643)

**Indicate part orientation**

Part orientation marks indicate the erection direction of assemblies and cast units. There are many ways available for indicating part orientation: by using part marks, by including compass direction in marks, and showing orientation marks and connecting side marks.

<table>
<thead>
<tr>
<th>To</th>
<th>Click the following links to find out more</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check how the location of the mark is affected by mark placement settings, the type of the leader line, predefined mark location and part orientation settings, modeling direction of parts, and drawing protection settings</td>
<td>Mark location (page 611)</td>
</tr>
<tr>
<td>Use part marks to indicate part orientation</td>
<td>Use part mark as an orientation mark in general arrangement drawings (page 646)</td>
</tr>
</tbody>
</table>
To | Click the following links to find out more
---|---
Include face direction information in part marks | Show compass direction in part marks (page 648)
Use a symbol in assembly drawings to indicate the side of a part to which a connecting part is attached | Show connecting side marks (page 650)
Use orientation marks to indicate the erection direction of assemblies | Show orientation marks (north marks) (page 649)

See also
Part and neighbor part properties in drawings (page 749)

**Use part mark as an orientation mark in general arrangement drawings**
In general arrangement drawings, part marks appear at the same end as in assembly drawings. Parts with the same assembly position are always marked at the same end.

1. Select **Drawings & reports --> Drawings properties --> Assembly drawing**.
2. Load drawing properties that are as close to the ones you need as possible.
3. In assembly drawing properties, click **View creation --> Attributes** and set the **Coordinate system** to **oriented** or **model**.
   You must use **oriented** or **model** if you want the **Viewing direction** settings in **File menu --> Settings --> Options --> Orientation marks** to have effect.
4. Click **Save** to save the properties and **Close** to close the dialog box.
5. In the model, click **Drawings & reports --> Numbering settings --> Numbering settings** and clear the **Beam orientation** and **Column orientation** check boxes.
   When you do this, similar assemblies get the same number regardless of the part orientation.
6. Go to **File menu --> Settings --> Options --> Orientation marks** and set the following options:
   • Set the desired **Viewing direction** for beams, bracings and columns.
   • Set **Mark always to center of column in GA drawings** to **No**.
   • Set **Preferred location for beams and bracings** to **Left** or **Right**.
   The preferred location determines the end where the mark is placed.
7. Click OK.
8. Check the leader line type through Drawings & reports --> Drawings properties --> GA drawing --> Part marks --> General.
   Place the mark near the part end, not in the middle of the part using one of the following settings:
   ![Mark Symbol]

9. Click Save to save the drawing properties and OK to close the dialog box.
10. Create assembly (and single-part) drawings using the settings you modified.
11. Create general arrangement drawings using the settings you modified.

**NOTE** In general arrangement drawings, the cast unit part marks behave in the same way as the assembly part marks, except when **Top in form face** is set to Front or Back on the Parameters tab of the part's User-defined attributes dialog box. These settings tell the end where the part mark is placed.
   When you update an assembly drawing so that the mark is placed at the other end of the part, remember to update the marks in the corresponding general arrangement drawing. Tekla Structures does not do this automatically.

**Example**
The part mark is positioned at the stiffener side:

![Diagram]

The marks are positioned at the same side irrespective of the orientation of the beams:
See also
Mark location (page 611)
Indicate part orientation (page 645)
Automatic mark settings (page 600)

Show compass direction in part marks
You can include face direction information in part marks. No matter where you add or move the mark, the face direction stays the same. The face direction indicates the compass direction (North, East, South, West) of the face where the mark appears.

Limitation: Tekla Structures indicates the face direction only if it is the same for all assemblies or cast units with the same assembly or cast unit position number.

1. Check in which direction north is in the model by clicking File menu --> Settings --> Options --> Orientation marks and checking Project north.
2. In the model, click Drawings & reports --> Numbering settings --> Numbering settings and select the Column orientation check box.
   
   This forces Tekla Structures to show the face direction in the part mark for two similar columns with different orientation.
3. In the desired assembly or cast unit drawing view properties, click Part mark and insert the Face direction element in the part mark.
Now the assembly or cast unit drawings show the face direction in the part marks.

See also
Indicate part orientation (page 645)

Show orientation marks (north marks)
You can use orientation marks or north marks to indicate the erection direction of assemblies. The default orientation mark is a triangle inside a circle.

1. On the Drawings & reports tab, click Drawing properties --> Assembly drawing.
2. Click View creation, select the view and the properties that you want to change, and click View properties.
3. Click Part --> Content and select the Orientation marks check box.
4. Save the view properties and click Close.
5. Save the assembly drawing properties and click OK.
6. If needed, define which parts Tekla Structures considers to be columns, braces or beams by setting the skew limits through File menu --> Settings --> Options --> Orientation marks --> Skew limit.
7. Use the following advanced options to adjust orientation marks:
   • XS_ORIENTATION_MARK_DIRECTION
   • XS_ORIENTATION_MARK_MOVE_DIST_FOR_BEAMS
   • XS_ORIENTATION_MARK_MOVE_DIST_FOR_COLUMNS
   • XS_NORTH_MARK_SYMBOL
   • XS_HIDDEN_NORTH_MARK_SYMBOL
   • XS_NORTH_MARK_SCALE
8. Create the assembly drawing.

For different parts, Tekla Structures draws orientation marks in the following way:

- To the top flange of beams, at the end which points closest to the north or to the direction defined in `XS_ORIENTATION_MARK_DIRECTION` (see part 1 and 2 in the illustration below)
- To the lower end of columns, on the flange which points closest to the north or to the direction defined in `XS_ORIENTATION_MARK_DIRECTION` (see part 4 in the illustration below)
- To the flange of bracing, at the end which points closest to the north or to the direction defined in `XS_ORIENTATION_MARK_DIRECTION` (see 3 A and B in the illustration below)

**Tip** You can display orientation marks for single-part views included in assembly drawings by setting the advanced option `XS_SINGLE_ORIENTATION_MARK` to `TRUE`.

**See also**

- Indicate part orientation (page 645)
- Part and neighbor part properties in drawings (page 749)

**Show connecting side marks**

You can use a symbol in assembly drawings to indicate the side of a part to which a connecting part is attached.

1. Select **Drawings & reports** --> **Drawings properties** --> **Assembly drawing**.

Define automatic drawing settings 650 Automatic part and neighbor part settings in drawings
2. Load drawing properties that are as close to the ones you need as possible.

3. Click **View creation**, select the view and the properties that you want to change, and click **View properties**.

4. Click **Part**.

5. On the **Content** tab, select the **Connecting side marks** check box.

6. Click **Save** to save the view properties.

7. Click **Close**.

8. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**TIP** If needed, you can change the connecting side mark symbol with the advanced option `XS_CONNECTING_SIDE MARK_SYMBOL`, and use `XS_MIN DISTANCE FOR CONNECTING SIDE MARK` to control whether the connecting side mark is drawn or not.

**See also**

Part and neighbor part properties in drawings (page 749)
8.9 Automatic bolt settings in drawings

Bolts are connecting objects that fasten parts or assemblies or attach to them. You can change how the bolts are shown in drawings.

<table>
<thead>
<tr>
<th>Change how the bolts are shown in drawings</th>
<th>Define automatic bolt properties in drawings (page 652)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create you own bolt symbols</td>
<td>Create customized bolt symbols (page 653)</td>
</tr>
<tr>
<td>Check examples of different bolt settings</td>
<td>Example: Bolt representations (page 653)</td>
</tr>
<tr>
<td>Check bolt properties</td>
<td>Bolt content and appearance properties in drawings (page 754)</td>
</tr>
</tbody>
</table>

Define automatic bolt properties in drawings

You can define what is shown in bolts and how the bolts are shown.

1. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. Single-part, assembly and cast unit drawings: Click **View creation**, select the view and the properties that you want to change, and click **View properties**.
4. Click **Bolts**.
5. On the **Content** tab, select the bolt representation, bolt symbol content, and the visibility of bolts in main parts.
   - For assembly and cast unit drawings, you can also set the visibility of bolts in secondary parts and sub-assemblies.
6. On the **Appearance** tab, select the color of the bolts.
7. Single-part, assembly and cast unit drawings: Click **Save** to save the view properties. Then click **Close** to return to drawing properties.
8. General arrangement drawings: Click **OK**.
9. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**See also**

Automatic bolt settings in drawings (page 651)
Create customized bolt symbols

You can create your own bolt symbols in Symbol Editor and use them in drawings. You only need to create bolt symbols if you need different bolt symbols than the ones that you can find in Tekla Structures.

1. Save the symbol file `ud_bolts.sym` in the symbol folder (usually the folder `..\Tekla Structures\<version>\environments\common\symbols\`).

2. Open Microsoft Notepad, or any text editor.

3. Create a text file consisting of lines in three columns:
   - The first column contains the bolt assembly standard.
   - The second contains the bolt diameter.
   - The third column contains the name of the symbol file and the symbol number, separated with the @ character.

   Example of file contents:
   
   7990 24 ud_bolts@1
   7990 25 ud_bolts@2

   Tekla Structures uses the user-defined symbol for bolts in drawings that have the standard and diameter you define in this text file.

4. Save the file with the name `bolt_symbol_table.txt`.

5. Set the name of the file as a value for the advanced option `XS_USER_DEFINED_BOLT_SYMBOL_TABLE` in File menu --> Settings --> Advanced options --> Marking: Bolts as follows:

   `XS_USER_DEFINED_BOLT_SYMBOL_TABLE=bolt_symbol_table.txt`

   You can also enter a full path to the bolt definition file. Without the path Tekla Structures searches for the file in the model, firm, project, and system directories.

6. To use your own bolt symbol, click Bolt --> Content --> Solid/Symbol --> User-defined symbol in the drawing view properties dialog box.

See also

Automatic bolt settings in drawings (page 651)
Example: Bolt representations
There are several representation options available for displaying bolts in drawings.

You can select the options from the **Solid/symbol** list. Here are some examples of different selections.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solid</td>
<td><img src="image1" alt="Solid Example" /></td>
</tr>
<tr>
<td>Exact Solid</td>
<td><img src="image2" alt="Exact Solid Example" /></td>
</tr>
<tr>
<td>Symbol</td>
<td><img src="image3" alt="Symbol Example" /></td>
</tr>
<tr>
<td>Symbol 2</td>
<td><img src="image4" alt="Symbol 2 Example" /></td>
</tr>
</tbody>
</table>
8.10 Automatic hatches in drawings

Use hatching on part faces, part sections or drawing shapes, such as circles and polygons, to show different materials.

The hatches are located in the `hatch_types1.pat` file in the `…\Tekla\Structures\<version>\environments\<environment>\inp` folder. You can also use hatching patterns on surface treatment.

You can also add custom hatches in the `hatch_types1.pat` file, see Adding custom fill patterns.
Add hatches (fills) to parts and sketch objects in drawings (page 656)
Colors in drawing hatches (page 662)
Define automatic surface treatment in drawings (page 665)
Example: Insulation hatch patterns (page 664)
Hatch pattern settings (.htc) for automatic drawing hatches (page 660)
Surface treatment hatch pattern properties (surfacing.htc) (page 756)

Add hatches (fills) to parts and sketch objects in drawings
You can use hatches as fills in parts, neighbor parts, cross sections and sketch objects in a drawing. You can use automatic hatches or manual hatches.
Automatic hatches are defined in drawing-specific hatch schema files (page 660) (*.htc). You can also use custom hatches.

Limitations
There are some limitations in the hatch background color usage:
• Background color does not work in conjunction with hardware hatches.
• The background color does not have any effect if there is an automatic hatch available. The background color can only be changed if the automatic hatch is not defined for the material type.

To add a fill to a part:
1. On the Drawings & reports tab, click Drawing properties and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. Single-part, assembly and cast unit drawings: Click View creation, select the view and the properties that you want to change, and click View properties.
4. Click Part and go to the Fill tab.
5. Select the hatch from the Type list.
   To preview the hatches, click the ... button next to the Type list.
   You can also select the hatch by double-clicking it in the Hatch window.
   If you select Automatic, Tekla Structures uses the hatches defined in the hatch schema file (.htc). Each drawing type has its own schema file.
   The names of the schema files (page 660) Tekla Structures are defined in the Hatching category of the Advanced options dialog box:
   XS_DRAWING_GA_HATCH_SCHEMA
   XS_DRAWING_CAST_UNIT_HATCH_SCHEMA
   XS_DRAWING_SINGLE_PART_HATCH_SCHEMA
   XS_DRAWING_ASSEMBLY_HATCH_SCHEMA
6. Define a color for the hatch (page 662) in the Color box.
7. Define a background color for the hatch in the Background box.
   You can define the background color only after selecting a hatch first.
8. In Scale, select whether to use automatic or custom scaling and rotation for hatches.
If you select automatic scaling and rotation, Tekla Structures automatically scales the hatch to suit the profile size, and you do not need to edit each drawing manually. If you select **Custom** scaling and rotation:

- Enter the scales in **Scaling in direction x** and **Scaling in direction y**, and select whether to **Keep the x and y ratio**.
- Enter the angle of rotation in the **Angle** box. Angle 0.0 is for horizontal and 90.0 for vertical.

9. Single-part, assembly and cast unit drawings: Click **Save** to save the view properties. Then return to drawing properties by clicking **Close**.

10. General arrangement drawings: Click **OK** to return to drawing properties.

11. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**Example**

In the example below, the following hatch options have been selected for cross sections:

Scale: **Custom**

- **Scaling in x direction**: 0.25
- **Scaling in y direction**: 0.50
- **Keep ratio of x and y** is selected.
- **Angle**: 10.00
Cast-in-place and precast hatches use different automatic hatch depending on the cast unit type. You need to select the appropriate cast unit type in the concrete part properties.

Some advanced options related to hatches

- `XS_HATCH_SCALE_LIMIT`
- `XS_HATCH_SPECIAL_COLOR_R`
- `XS_HATCH_SEGMENT_BUFFER_SIZE`
- `XS_HATCH_SPECIAL_COLOR_ACI`

Define automatic drawing settings

Automatic hatches in drawings
Hatch pattern settings (.htc) for automatic drawing hatches

The hatch patterns for material types and names in drawings are defined in a hatch schema file .htc. Different drawing types (general arrangement, assembly, single-part, and cast unit drawings) have their own schema files.

The hatch patterns defined in schema files are used when you set Type to Automatic on the Fill page in the part or shape properties.

Hatch schema file name and location

The name of the schema file Tekla Structures uses for each drawing type is defined in the Hatching category of the Advanced options dialog box:

- XS_DRAWING_GA_HATCH_SCHEMA=general.htc
- XS_DRAWING_ASSEMBLY_HATCH_SCHEMA=assembly.htc
- XS_DRAWING_SINGLE_PART_HATCH_SCHEMA=single.htc
- XS_DRAWING_CAST_UNIT_HATCH_SCHEMA=cast_unit.htc

The default schema files are located in the ..\Tekla Structures \<version>\environments\common\system folder. The environment-specific schema files are located under the environments, for example:

- ..Tekla Structures\<version>\Environments\<environment>\system\steel\general.htc (also assembly.htc, single.htc)
- ..Tekla Structures\<version>\Environments\<environment>\system\concrete\precast\cast_unit.htc

Schema file syntax

Material type, Cast unit type, Material name, Hatch name, Scale, Color, Automatic scaling and rotation

Examples:

CONCRETE,,hardware_SOLID,,120 (gray shade)
CONCRETE,Precast,C25/30,CONC,0.3,1 ("traditional" concrete Precast)
CONCRETE,CIP,C25/30,CONCRE,0.3,1 ("traditional" concrete CIP)
CONCRETE,,CROSS,2,1 (small crosses)
MISCELLANEOUS,Insulation,HARD_INS1,1,,1 (straight lines)
MISCELLANEOUS,Insulation,SOFT_INS,1,,1 (rounded lines)
To see an example of the `cast_unit.htc` file, click the following link: [cast_unit.htc](#)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material type</td>
<td>STEEL, CONCRETE, TIMBER, MISCELLANEOUS <em>(case sensitive)</em></td>
</tr>
<tr>
<td>Cast unit type</td>
<td>Precast or CIP. You also need to define the cast unit type for concrete parts in the part properties dialog box.</td>
</tr>
<tr>
<td>Material name</td>
<td>The material name defined for the part in part properties in the model.</td>
</tr>
<tr>
<td>Hatch name</td>
<td>To check the hatch pattern names and related hatch patterns go to the Fill tab in Part properties, select a hatch pattern from the Type list and click the ... button next to the list. Then click a pattern to see its name in the Type list. The selected hatch pattern is marked with a red frame. Hatch names are case sensitive. If you do not want to use any hatch pattern for a material, leave the hatch name field blank in the schema file.</td>
</tr>
</tbody>
</table>
| Color             | BLACK: 0 (default)                                                                                      WHITE: 1                          RED: 2                                   GREEN: 3                  BLUE: 4                          CYAN: 5                                  YELLOW: 6                          MAGENTA: 7                            Special: 120 *(use this color for gray shade)* GRAYSCALE 1: 130 GRAYSCALE 2: 131 GRAYSCALE 3: 132 GRAYSCALE 4: 133
### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The hatch color defines the line width for the printer. If you do not define a color for a hatch in the schema file, Tekla Structures uses the default color black (0). To use the special color that is printed as color or grayscale, depending on the selected printer settings, set the color number in the .htc file to 120. To adjust the gray shade for Special color 120, use the following advanced options:</td>
<td></td>
</tr>
<tr>
<td>XS_HATCH_SPECIAL_COLOR_R</td>
<td></td>
</tr>
<tr>
<td>XS_HATCH_SPECIAL_COLOR_G</td>
<td></td>
</tr>
<tr>
<td>XS_HATCH_SPECIAL_COLOR_B</td>
<td></td>
</tr>
<tr>
<td>Scale</td>
<td>Scale is a numeric value that Tekla Structures uses to scale hatches.</td>
</tr>
<tr>
<td>Automatic scaling and rotation</td>
<td>Automatic scaling and rotation defines whether you want to use automatic scaling and rotation.</td>
</tr>
<tr>
<td>TRUE: 1</td>
<td></td>
</tr>
<tr>
<td>FALSE: 0 (default)</td>
<td>Automatic scaling and rotation requires additional processing, so use it only when necessary.</td>
</tr>
</tbody>
</table>

### See also

- Add hatches (fills) to parts and sketch objects in drawings (page 656)
- Part and neighbor part properties in drawings (page 749)

### Colors in drawing hatches

You can define different colors for drawing hatches and fills. There is a large variety of shades of gray available.

You can select the color for a hatch in part and shape properties on the Fill tab after you have selected a fill type from the Type list.

Some of the different gray shades are true colors in the way that they will keep their color regardless of the drawing color mode, all the way to printing.
The true gray shades are marked with red in the image below.
The gray scale colors (130 - 133) are available also for automatic hatches.

See also
Colors in drawings (page 360)
Add hatches (fills) to parts and sketch objects in drawings (page 656)

Example: Insulation hatch patterns
You can use the following fill types to represent insulation:
These hatch types can be scaled and rotated.

<table>
<thead>
<tr>
<th>Hatch name</th>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>HARD_INS1</td>
<td></td>
</tr>
<tr>
<td>SOFT_INS</td>
<td></td>
</tr>
<tr>
<td>SOFT_INS2</td>
<td></td>
</tr>
</tbody>
</table>
**Previewing patterns**
To preview the scaled and rotated patterns, click the ... button next to the *Type* box.

**See also**
Automatic hatches in drawings (page 655)

### 8.11 Automatic surface treatment in drawings
You can add various types of surface treatment to steel and concrete parts in the Tekla Structures model and show them in drawings.

The properties of the hatch patterns to use for each surface treatment type are defined in the *surfacing.htc* file. Also the *product_finishes.dat* code file is needed listing all surface treatment codes that are used in drawings and reports, for example, TS1 for Tile Surface 1.

**See also**
Define automatic surface treatment in drawings (page 665)
Surface treatment visibility and content properties in drawings (page 755)
Surface treatment hatch pattern properties (surfacing.htc) (page 756)
Define automatic surface treatment in drawings

You can define what is shown in a surface treatment and how the surface treatment is shown in drawings.

The hatch pattern Tekla Structures adds on the surface treatment depends on the type of the surface treatment that you selected in the Surface Treatment Properties dialog box in the model and the hatch properties defined in the surface treatment hatch pattern properties file surfacing.htc.

1. On the Drawings & reports tab, click Drawing properties and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. Single-part, assembly and cast unit drawings: Click View creation, select the view and the properties that you want to change, and click View properties.
5. On the Contents tab, select the surface treatment representation, and whether to show the surface treatment pattern, hidden lines, and own hidden lines.
6. On the Appearance tab, select the color and type of visible and hidden lines.
7. General arrangement drawings: Click OK.
8. Click Surface treatment mark, add the elements that you want to include in the mark and adjust the appearance of the mark as required.
9. Single-part, assembly and cast unit drawings: Click Save to save the view properties. Then click Close to return to drawing properties.
10. General arrangement drawings: Click OK.
11. Click Save to save the drawing properties, then click OK and create the drawing.

See also

Define automatic surface treatment in drawings (page 665)
Surface treatment visibility and content properties in drawings (page 755)
Surface treatment hatch pattern properties (surfacing.htc) (page 756)
Surface treatment hatch pattern properties (surfacing.htc) (page 756)
Automatic hatches in drawings (page 655)
8.12 Automatic weld settings in drawings

You can define automatic weld settings to be used in a drawing before you create a drawing. You can modify the settings in an open drawing after you have created the drawing.

Before creating a single-part drawing or an assembly drawing, you can define the representation, visibility and appearance properties (page 771) for the model welds. For general arrangement drawings, representation settings can only be defined on view and object level, not on drawing level.

See also

Define automatic model weld properties in drawings (page 667)
Welds in drawings (page 306)
Examples: Model welds in drawings (page 310)

Define automatic model weld properties in drawings

You can define what the model welds look like in your drawings before you create the drawing.

1. On the Drawings & reports tab, click Drawing properties and select the drawing type.

2. Load drawing properties that are as close to the ones you need as possible.

3. Single-part and assembly drawings: Click View creation, select the view and the properties that you want to change, and click View properties.

4. Click Weld.

5. On the Content page, define the visibility settings:
   • In Welds and Welds in sub-assemblies, select Not visible, Site weld visible, Workshop weld visible, or Both visible.
   • In Weld size limit, enter a weld size to filter out welds of that size and bigger.
     This is useful when you only want to show non-typical welds in a drawing.

     To set whether the weld size is an exact or minimum value, use the advanced option XS_WELD_FILTER_TYPE.

     To filter out a standard weld type, use the advanced option XS_OMITTED_WELD_TYPE.

   • In Representation, select Outline or Path, and enable Hidden lines and Own hidden lines, if required.

6. On the Appearance tab, modify the color and line as required.
7. Single-part, assembly and cast unit drawings: Click **Save** to save the view properties. Then click **Close** to return to drawing properties.
8. General arrangement drawings: Click **OK**.
9. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**See also**
- Model weld properties in drawings (page 771)
- Model weld mark visibility and appearance properties in drawings (page 734)

### 8.13 Automatic pour object settings in drawings

You can define automatic pour object settings to be used in a drawing before you create a drawing. You can modify the pour settings in an open drawing after you have created the drawing.

You can select whether to show pours and pour breaks in drawings, define the desired pour object and pour break content and appearance. For pour objects, you can also define the desired fill. Additionally, you can add automatic pour object marks in your drawings.

You can change these settings also in an open drawing.

For more information, see **Show pour objects, pour marks and pour breaks in drawings (page 668)**.

**See also**
- Pours in drawings (page 329)
- Pour object and pour break properties in drawings (page 767)
- Add hatches (fills) to parts and sketch objects in drawings (page 656)
- Examples of pour drawings and pour reports (page 333)

### Show pour objects, pour marks and pour breaks in drawings

You can show pour objects and pour breaks in general arrangement drawings. You can also add automatic pour object marks.

Ensure that you have enabled pour management (set the advanced option `XS_ENABLE_POUR_MANAGEMENT` to `TRUE`).

To show pour objects and pour breaks automatically, modify their appearance and add pour object marks:
1. On the Drawings & reports tab, click Drawing properties --> GA drawing.
2. Load drawing properties that are as close to the ones you need as possible.
3. In the properties dialog box, click the View button and set Show pours in drawings to Yes, and click OK.
4. Click the Pour object button to modify the properties:
   - Content tab: Select whether you want to see the hidden lines and own hidden lines, and the edge chamfers by clicking on or off.
   - Appearance tab: Set the color and type for visible lines and hidden lines.
   - Fill tab: Select the fill for the pour object face and/or pour object section face.
5. Click OK.
6. Click the Pour object mark button, select the contents and appearance of the mark, and click OK.
7. Click the Pour breaks button and set the Visibility to Visible and click OK.
   You can also select whether you want to show pour break hidden lines on the Visibility tab. On the Appearance tab you can change the color and type of the visible and hidden lines in pour breaks.
8. Modify the other properties as required. For example, click Reinforcement and set the Visibility of all reinforcing bars to Visible to show the reinforcement in the pour drawing.
9. Save the changed properties and click OK.
   Now you can create the general arrangement drawing using the modified properties. The pour objects, pour object marks and pour breaks are shown accordingly.
   You can also open the pour drawing and modify the properties further on drawing, view and object level.

See also
Pours in drawings (page 329)
Pour object and pour break properties in drawings (page 767)
Add hatches (fills) to parts and sketch objects in drawings (page 656)
Examples of pour drawings and pour reports (page 333)
8.14 Automatic reinforcement and mesh settings in drawings

There are numerous ways of showing reinforcing bars and meshes in drawings. You can define automatic reinforcement and mesh settings before you create the drawing, and adjust the settings in an open drawing. In addition to modifying the properties available in the properties dialog box, you can also modify the bending schedules, rounding of bar dimensions, symbols in use, and reinforcement appearance in the rebar_config.inp settings file.

Click the links below to find out more:

Define automatic reinforcement and reinforcement mesh properties (page 670)
Example: Hide reinforcing bar lines in drawings (page 671)
Example: Reinforcement representations (page 672)

See also

Reinforcement/Neighbor reinforcement and mesh properties in drawings (page 758)
Reinforcement settings for drawings (rebar_config.inp) (page 760)
Part and neighbor part properties in drawings (page 749)

Define automatic reinforcement and reinforcement mesh properties

You can define what is shown in reinforcing bars and meshes and how they are shown in cast unit and general arrangement drawings. You can also do this for neighbor reinforcement.

1. On the Drawings & reports tab, click Drawing properties and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. Single-part, assembly and cast unit drawings: Click View creation, select the view and the properties that you want to change, and click View properties.
4. Click Reinforcement (or Neighbor reinforcement).
5. On the Bar content tab, set the bar representation, bar end symbols, and the visibility of bars and lines.
6. On the Bar appearance tab, select the color and type of the visible lines and hidden lines.
7. On the Mesh content tab, set the mesh representation, mesh symbols, and the visibility of meshes, wires, bars and lines.
8. On the **Mesh appearance** tab, select the color and type of the visible lines and hidden lines.

9. General arrangement drawings: Click **OK**.

10. Click **Reinforcement mark** (or **Neighbor reinforcement mark**), add the elements that you want to have in the mark and adjust the mark appearance.

11. Single-part, assembly and cast unit drawings: Click **Save** to save the view properties. Then click **Close** to return to drawing properties.

12. General arrangement drawings: Click **OK**.

13. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

---

**TIP** The representation of reinforcing bars that point away from the drawing can be changed. You can customize reinforcing bar bent symbols (cross, circle, filled circle) by editing the symbol file `bent.sym`, which in the default environment is located in the folder \ProgramData\Tekla Structures\<version>\environments\common\symbols. Or, you can create a new symbol file in the same folder, for example, `my_new_symbols.sym`, and take it into use in the `rebar_config.inp` (page 760) by entering the following string in the file: `BentSymbolFile=my_new_symbols.sym`

---

**See also**

- Reinforcement/Neighbor reinforcement and mesh properties in drawings (page 758)
- Reinforcement settings for drawings (rebar_config.inp) (page 760)
- Part and neighbor part properties in drawings (page 749)
- Automatic reinforcement and mesh settings in drawings (page 669)
Example: Hide reinforcing bar lines in drawings
You can hide reinforcement bar lines behind other reinforcing bars and behind parts in cast unit drawings.

Here are some examples of what reinforcing bars look like with different settings selected on the **Bar content** tab in **Reinforcement** or **Neighbor Reinforcement** properties.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide lines behind parts</td>
<td>The reinforcing bar lines are hidden behind other parts.</td>
</tr>
<tr>
<td>hide lines behind other rebars</td>
<td>The reinforcing bar lines are hidden behind other reinforcing bar lines.</td>
</tr>
</tbody>
</table>

See also

- Define automatic reinforcement and reinforcement mesh properties (page 670)
- Automatic reinforcement and mesh settings in drawings (page 669)

Example: Reinforcement representations

Here are examples of how the reinforcement will look with the different representation options selected on the **Bar content** tab in **Reinforcement** or **Neighbor Reinforcement** properties.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>single line</td>
<td><img src="image" alt="Example" /></td>
</tr>
</tbody>
</table>
### Setting | Example
--- | ---
**double line** | ![Example](image1.png)
**double lines with filled ends** | ![Example](image2.png)
**filled line** | ![Example](image3.png)
**stick** | ![Example](image4.png)
**outline** | ![Example](image5.png)

**See also**
- Automatic reinforcement and mesh settings in drawings (page 669)
- Reinforcement/Neighbor reinforcement and mesh properties in drawings (page 758)

---

**Automatic grouping of rebar sets for drawings**

The rebars created by using the rebar set commands are automatically grouped for drawing marking and dimensioning purposes. The automatic grouping works both for simple, non-tapered groups as well as for tapered groups.

**Preconditions for rebar group creation**

Non-tapered rebars are grouped when:

- Rebars are created by the same rebar set
- Rebars are side by side
• Rebars have identical properties, except length
• Rebars have the same position number

Tapered rebars are grouped when:
• Rebars are created by the same rebar set
• Rebars are side by side
• Rebars have identical properties, except length
• Length of bars increases linearly
• There are minimum of 3 bars in a group

**Work with rebar set groups in drawings**

Automatically created groups behave in the drawing similarly as the old rebar groups:

• There is only one mark for the rebar group, and the **reinforcement mark content** (page 742) comes from the content setting **Group** in **Reinforcement mark** properties.

  Note that tapered bar groups within rebar sets do not have position numbers, so position information is not included in reinforcement marks.

• You can **adjust the rebar visibility** (page 758) in **Reinforcement properties**. For example, you can select to show **bar in the middle of group**.

• You can use the following rebar-group-specific **interactive dimensioning and marking commands** (page 185) found in the pop-up menu for rebar groups:

  • **Create dimension line**
  • **Add mark --> Dimension mark**
  • **Add mark --> Tagged dimension mark**

• **Associative notes** (page 219) can be created.

Below is an example of an automatically created rebar group in a drawing. The drawing uses rebar group visibility option **bar in the middle of group**, and reinforcement mark option **One leader line to group**, and the dimensions have been created with the command **Create dimension line**.
For more information about creating rebar sets, see Create a rebar set.

8.15 Units and decimals in drawings, reports and templates

Unit settings used in drawing objects, and reports and templates created in Template Editor are taken from different places. These settings include, for example, the used unit and the number of decimals.

In drawings, reports and templates, the units and decimals are defined in the following way:

- **Unit settings for marks**: Tekla Structures uses the `contentattributes_global.lst` attributes file for setting the default unit and decimal settings for various mark elements. You can use `contentattributes_userdefined.lst` when you want to configure settings of your own.

```
// Name   Datatype Justify  Cacheable Length Decimals Unit type Unit   Precision
// Xxxxx   FLOAT    RIGHT   TRUE    6     2     Length  ft-inch  1/8
// ------- ---------- ------- -------- ------- -------- ---------- ----------
DIAMETER  FLOAT    RIGHT   TRUE    5      0     Length   mm
```

For more information about unit settings in marks, see Change unit settings for marks (page 622).

For more information about the `contentattributes_global.lst` and `contentattributes_userdefined.lst` files, see Template attribute files.
• **Unit settings for drawing objects**: Default unit settings for drawing objects (other than marks) either come from the standard drawing properties files (standard.*) or are hardcoded in Tekla Structures.

• **Unit settings for dimensions in dimension tags**: Default unit settings for dimensions and dimension tags are defined in the **Options** dialog box on the **Drawing dimensions** page.

• **Level attributes in marks**, such as **TOP_LEVEL**, and **BOTTOM_LEVEL** take the dimension format from the **MarkDimensionFormat.dim** file. For more information about level attributes in part marks, see **Add level attributes in automatic part marks** (page 625).

• **Unit settings for reports/templates created with Template Editor**: Unit settings for reports and templates created in Template Editor can be defined in the **Value Field Properties** dialog box **Format** area or in format functions. The default unit and decimal settings are taken from the **contentattributes_global.lst** attributes file.

**Format** area:

Formula containing a format function:

```java
if GetValue("ADVANCED_OPTION.XS_IMPERIAL")=='TRUE' then
  "format(double(GetValue("TOP_LEVEL")*1000),"Length","ft-inch", 1/16)
else
  "+GetValue("TOP_LEVEL")"
endif
```

For tips for using format functions, see **Tips for using format function in formulas**. For more information about formats and value fields, see **Template Editor User's Guide**.
8.16 User-defined attributes in drawings

Many Tekla Structures dialog boxes contain user-defined attributes for various objects. When you define a new user-defined attribute, make the definition of the user-defined attribute unique. This is because a user-defined attribute cannot have different definitions for different object types. In drawings, the user-defined attributes can be used in templates, Drawing List, and marks, for example.

The user-defined attributes in the drawing are displayed when you click User-defined attributes in the drawing properties dialog box. You can show up to 20 user-defined attributes in the Drawing List. To check the ones that you have, click User-defined attributes in a drawing properties dialog box.

When you define new user-defined attributes

When you define new user-defined (page 679) attributes, create your own file in the company, project or firm folder. After adding your own user-defined attributes, you need to use the Diagnose & Change Attribute Definitions tool to update the definitions in the model. The object.inp files are merged so that if there are user-defined attributes in any of the files, they are displayed in the user interface. Tekla Structures merges the files in a way that eliminates duplicate attributes. If Tekla Structures encounters the same attribute name in different objects.inp files, the attribute from the first read objects.inp file will be used.

Tekla Structures reads the objects.inp files from the following folders in the following order:

1. model folder
2. company folder
3. project folder
4. firm folder
5. system folder
6. inp folder

Show user-defined attributes in Template Editor

In order to show the new user-defined attribute in Template Editor, you need to add the user-defined attribute in a customized contentattributes_userdefined.lst file and include the name of the customized file in the contentattributes.lst file.

Make a copy of these modified files as the Tekla Structures installation always overwrites these files.

See also

Add attributes in automatic marks (page 624)
Modify automatic user-defined drawing attributes

You can modify the user-defined attributes before you create a drawing.

1. On the Drawings & reports tab, click Drawing properties and select the drawing type.
2. Load drawing properties that are as close to the ones you need as possible.
3. Single-part, assembly, and cast unit drawings: Click View creation, select the view and the properties that you want to change, and click View properties.
4. Click User-defined attributes.
5. On the Workflow tab, enter project-specific information to be displayed in drawings and in the Drawing List.
6. On the Parameters tab, enter a user-defined Comment for drawings, projects, assemblies, parts, and so on.
7. Use the User field 1 to User field 8 on the Parameters tab to enter drawing-specific information.
8. On the Title tab, select if you want to use project-specific or drawing-specific information in the title block of the drawing.
   When you click Use project settings, you cannot enter any information in the title block fields.
9. If you selected Use drawing settings, the title block fields become available, and you can enter the necessary data in the fields.
10. Single-part, assembly and cast unit drawings: Click Save to save the view properties. Then click Close to return to drawing properties.
11. General arrangement drawings: Click OK.
12. Click Save to save the drawing properties, then click OK and create the drawing.

TIP • You can control whether the modifications in user-defined attributes affect all selected drawings in the Drawing List at the same time, even if the drawings are of different types by using the advanced option XS_DRAWING_UDAS_MODIFY_ALL_DRAWING_TYPES.
See also
Create a new user-defined drawing attribute (page 679)

Create a new user-defined drawing attribute
If you want to add a new line in the user-defined drawing attributes dialog box and a new column in the Drawing List, you need to create your own objects.inp and add a new user-defined attribute there. You also need to do this if you want the user-defined attribute to be available in the Template Editor.

Before you start, close Tekla Structures.

1. Open the objects.inp file located by default in ..\ProgramData\Tekla Structures\<version>\environments\common\inp.
2. Save the objects.inp file in your model, project or firm folder.
3. Delete all user-defined attribute definitions from the objects.inp file, except the property definitions in the beginning of the file that describe the properties, and the sections that define the new tab to different drawing types. Also leave one property definition in section User-defined attributes for objects that you can use as a template for the new property.
4. Enter the name of the tab page where you want the new user-defined attributes to be located and the attribute properties.
   Do not enter the names of the tab pages that come with the installation, use a new one instead.
5. To show the user-defined attribute in the Drawing List and in the user-defined attributes dialog box, set status_flag to yes.

```plaintext
/* User defined attributes for objects */
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~

/* Common drawing attributes*/
~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~

beam(2,"Beam")
{
   tab_page("My tab")
   {
      attribute("DESIGNED_BY", "Designed By", string, "/%s", yes, none, "0.0", "0.0")
      {
         value("", 0)
      }
   }
   modify(1)
}
```

Define automatic drawing settings 679 User-defined attributes in drawings
6. Define the drawing types where you want to use the new tab containing
the new user-defined attribute.

```c
/* Drawing attributes - single part */
/*_single_part_drawing) */
// (my tab","My tab",200)
// _Single_part_drawing
```  

```c
/* Drawing attributes - GA */
/*_GA_drawing) */
// (My tab","My tab",200)
// _GA_drawing
```  

7. Save and close the file.

8. Update the definitions of the user-defined attributes:
   a. On the File menu, click Diagnose & repair --> Diagnose & change
      attribute definitions.
      
      The Diagnose & Change Attribute Definitions dialog box is
      displayed.

      ![Diagnose & Change Attribute Definitions dialog box]

      b. If there are conflicts between your objects.inp and the default
         objects.inp, select the definition in the area on the right and click
         Change current settings to selected objects.inp settings.
      
      The definition of the user-defined attribute is updated in the model.

9. On the Drawings & reports tab, click Drawing properties and select the
drawing type.
   In this example, select GA drawing.

10. Click User-defined attributes.
The user-defined drawing attributes dialog box of the general arrangement drawing shows the tab you created.

11. Use **Save as** to save the properties for future use.
12. Click **OK** and create a general arrangement drawing.
13. Right-click the created drawing in the **Drawing List** and select **User-defined attributes**.
14. Go to the new tab (**My tab**) and enter the name needed information (the designer name in the **Designed By** box).
15. Click **Modify** and close the dialog box.

The **Drawing List** contains a column for the new user-defined attribute, and the name of the designer is displayed.

<table>
<thead>
<tr>
<th>Created</th>
<th>Modified</th>
<th>Size</th>
<th>Type</th>
<th>Mark</th>
<th>Name</th>
<th>Designed By</th>
</tr>
</thead>
<tbody>
<tr>
<td>18.04.2013</td>
<td>00.00.0000</td>
<td>830*584</td>
<td>G</td>
<td>[2]</td>
<td>Designer</td>
<td></td>
</tr>
</tbody>
</table>

**See also**

User-defined attributes in drawings (page 677)
Define customized line types in TeklaStructures.lin

You can define your own line types, and use them wherever line type settings are available. The customized line types are handled the same way as other line types. The customized line types are defined in the TeklaStructures.lin file in ..\ProgramData\Tekla Structures\<version>\environments\common\inp. By default, the most widely used line types are available in the file.

2. Start every line with the letter A to indicate the beginning of the line type pattern.
   You can use three different objects: dashes, dots and spaces to form a line.
3. Define the length of a dash (-) using positive numbers.
4. Define the length of a space ( ) using negative numbers.
5. Define dots (.) using the number zero (0).
   The patterns must begin with a dash. They typically end with a space, although the space in the end is not required.
6. After you have defined the line type pattern, press Enter.

The TeklaStructures.lin.id file contains the names of the line types visible in the user interface and the unique IDs assigned for each line type. The value of the ID must be greater than 10, for example:

CENTER, 1000
BORDER, 1002
DASHDOT, 1003

You can use TeklaStructures.lin also in mapping the exported line types.

NOTE If you add new customized line types, you need to add corresponding bitmaps to the ..\ProgramData\Tekla Structures\<version>\bitmaps folder, and name them dr_line_type_*.bmp, for example dr_line_type_CENTER.bmp.

Example 1

Line type definition for DASHDOT is A, 12.7, -6.35, 0, -6.35
means that the pattern starts with a dash with the length of 12.7 units, followed by a space with the length of 6.35 units, then a dot, and then again a space with the length of 6.35 units. Then the first dash is drawn again.
Example 2

Below is an example containing definitions for dotted lines:

<table>
<thead>
<tr>
<th>Definition</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOT, Dot</td>
<td>A, 0, -1.5875</td>
</tr>
<tr>
<td>DOT2, Dot (.5x)</td>
<td>A, 0, -0.79375</td>
</tr>
<tr>
<td>DOTX2, Dot (2x)</td>
<td>A, 0, -3.175</td>
</tr>
</tbody>
</table>

See also

Drawing sketch object properties (page 773)
There are a lot of settings in Tekla Structures that you mainly control in the properties dialog boxes. There are also some additional settings files that you need to modify in a text editor.

Click the links below to find out more:
- General arrangement drawing properties (page 685)
- Single-part, assembly and cast unit drawing properties (page 688)
- Layout properties (page 690)
- View properties in drawings (page 692)
- Section view properties (page 697)
- Dimension and dimensioning properties (page 699)
- Mark properties (page 726)
- Mark elements (page 737)
- Pour object and pour break properties in drawings (page 767)
- Part and neighbor part properties in drawings (page 749)
- Bolt content and appearance properties in drawings (page 754)
- Surface treatment visibility and content properties in drawings (page 755)
- Surface treatment hatch pattern properties (surfacing.htc) (page 756)
- Reinforcement/Neighbor reinforcement and mesh properties in drawings (page 758)
- Reinforcement settings for drawings (rebar_config.inp) (page 760)
- Placement properties for marks, dimensions, notes, texts and symbols (page 769)
- Model weld properties in drawings (page 771)
- Drawing sketch object properties (page 773)
- Drawing grid properties (page 774)
- Settings in the Options dialog box: Orientation settings
### 9.1 General arrangement drawing properties

On the **Drawings & reports** tab, click **Drawing properties --> GA drawing**. You can modify the properties after creating the drawing by double-clicking the drawing background.

The options in the general arrangement drawing properties dialog box are described below.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>For more information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>The name of the drawing. This name is shown in the <strong>Drawing List</strong>, and can be included in drawing and report templates.</td>
<td></td>
</tr>
<tr>
<td><strong>Title 1, Title 2, Title 3</strong></td>
<td>Titles are shown in the <strong>Drawing List</strong> and in drawing and report templates.</td>
<td>Give titles to drawings (page 144)</td>
</tr>
<tr>
<td><strong>Use detailed object level settings</strong></td>
<td>Set to <strong>Yes</strong> to use the detailed object level settings created in the <strong>Object level settings for general arrangement drawings</strong> dialog box.</td>
<td>Detailed object level settings (page 31)</td>
</tr>
<tr>
<td><strong>Layout</strong></td>
<td>Select the drawing layout and define drawing sizes. You can also select whether you want to list hidden objects in templates.</td>
<td>Drawing layout (page 429)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Drawing size and drawing view scale (page 448)</td>
</tr>
<tr>
<td><strong>View</strong></td>
<td>Define view properties: scale, neighbor part view extension, reflected view, opening and recess symbol, datum point elevation, part shortening, view label, and anchor bolt plan settings.</td>
<td>View properties in drawings (page 692)</td>
</tr>
<tr>
<td><strong>Detail view</strong></td>
<td>Define detail view properties: view label, detail boundary and detail mark settings.</td>
<td>Modify detail properties in drawings (page 169)</td>
</tr>
<tr>
<td><strong>Dimension</strong></td>
<td>Define dimension properties: dimension type, units, precision, format, placing, and appearance.</td>
<td>Dimension and dimensioning properties (page 699)</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>For more information</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Dimensioning</strong></td>
<td>Define dimensioning properties: grid dimension and part dimension settings.</td>
<td>Dimension and dimensioning properties (page 699)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Dimensioning properties - Parts tab (GA drawings) (page 723)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Dimensioning properties - Grid tab (GA drawings) (page 723)</td>
</tr>
<tr>
<td><strong>Part mark</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Bolt mark</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Neighbor part mark</strong></td>
<td>Define mark properties: included elements and element settings, and mark visibility, mark frame, mark leader line and placing settings.</td>
<td>Mark properties (page 726)</td>
</tr>
<tr>
<td><strong>Surface treatment mark</strong></td>
<td></td>
<td>Part and neighbor part properties in drawings (page 749)</td>
</tr>
<tr>
<td><strong>Weld mark</strong></td>
<td></td>
<td>Drawing weld mark properties (page 732)</td>
</tr>
<tr>
<td><strong>Reinforcement marks</strong></td>
<td></td>
<td>Mark properties - General, Merging and Content tabs (page 726)</td>
</tr>
<tr>
<td><strong>Neighbor reinforcement marks</strong></td>
<td></td>
<td>Model weld mark visibility and appearance properties in drawings (page 734)</td>
</tr>
<tr>
<td><strong>Connection mark</strong></td>
<td></td>
<td>Mark elements (page 737)</td>
</tr>
<tr>
<td><strong>Pour object mark</strong></td>
<td></td>
<td>Pours in drawings (page 329)</td>
</tr>
<tr>
<td><strong>Part</strong></td>
<td>Define part properties: part representation, hidden line, center line and reference line visibility, additional mark visibility, part appearance, and fill settings.</td>
<td>Part and neighbor part properties in drawings (page 749)</td>
</tr>
<tr>
<td><strong>Bolt</strong></td>
<td>Define bolt properties: bolt representation, bolt symbol content, bolt visibility, and bolt appearance settings.</td>
<td>Bolt content and appearance properties in drawings (page 754)</td>
</tr>
<tr>
<td><strong>Neighbor part</strong></td>
<td>Define neighbor part properties: visibility, part representation, hidden line, center line and reference line visibility, additional mark visibility, and part appearance settings. You can also define</td>
<td>Part and neighbor part properties in drawings (page 749)</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>For more information</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------</td>
</tr>
<tr>
<td>Surface treatment</td>
<td>Define surface treatment properties: surface treatment visibility, pattern visibility, hidden lines visibility and surface treatment representation settings.</td>
<td>Surface treatment visibility and content properties in drawings (page 755)</td>
</tr>
<tr>
<td>Weld</td>
<td>Define welding properties: weld visibility, weld size limit and weld appearance settings.</td>
<td>Model weld properties in drawings (page 771)</td>
</tr>
<tr>
<td>Reinforcement</td>
<td>Define reinforcement and mesh properties: bar and mesh representation and visibility, bar and mesh symbol, and bar and mesh appearance settings.</td>
<td>Reinforcement/Neighbor reinforcement and mesh properties in drawings (page 758)</td>
</tr>
<tr>
<td>Neighbor reinforcement</td>
<td>Define neighbor reinforcement and mesh properties: bar and mesh representation and visibility, bar and mesh symbol, and bar and mesh appearance settings.</td>
<td>Reinforcement/Neighbor reinforcement and mesh properties in drawings (page 758)</td>
</tr>
<tr>
<td>Reference objects</td>
<td>Define reference object visibility and appearance settings.</td>
<td>Show reference models in drawings (page 364)</td>
</tr>
<tr>
<td>Grid</td>
<td>Define grid visibility and appearance settings.</td>
<td>Drawing grid properties (page 774)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Customize drawing grid labels (page 335)</td>
</tr>
<tr>
<td>Protection</td>
<td>Define protected areas to prevent text, marks or dimensions from being placed there.</td>
<td>Protect areas in a drawing (page 456)</td>
</tr>
<tr>
<td>Filter and Neighbor part filter</td>
<td>Create and modify part filters/neighbor part filters on drawing level.</td>
<td>Create new filters</td>
</tr>
<tr>
<td>User-defined attributes</td>
<td>Add customized information to a drawing, such as information related to workflow, and comments.</td>
<td>User-defined attributes in drawings (page 677)</td>
</tr>
</tbody>
</table>
### 9.2 Single-part, assembly and cast unit drawing properties

On the Drawings & reports tab, click Drawing properties and select the drawing type. You can modify the properties after creating the drawing by double-clicking the drawing background.

The options in single-part, assembly and cast unit drawing properties dialog box are described below.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>For more information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Define the name of the drawing that is shown in the Drawing List, and can be included in drawing and report templates.</td>
<td></td>
</tr>
<tr>
<td><strong>Cast unit definition method</strong></td>
<td>By cast unit position: A drawing will be created from each cast unit. If there are identical cast units, one of them will serve as the base cast unit for the drawing. This is the most common method</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>For more information</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td><strong>Description</strong></td>
<td><strong>For more information</strong></td>
</tr>
<tr>
<td></td>
<td>for creating cast unit drawings.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>By cast unit ID</strong>: Each part in the model has a unique GUID. You can create drawings by using the cast unit GUIDs. The GUID determines the marking of the drawing. You can create several drawings from identical cast units.</td>
<td></td>
</tr>
<tr>
<td><strong>Title 1, Title 2, Title 3</strong></td>
<td>Define titles that are shown in the <strong>Drawing List</strong> and can be included in drawing and report templates.</td>
<td>Give titles to drawings (page 144)</td>
</tr>
<tr>
<td><strong>Sheet number</strong></td>
<td>Used for creating several drawings of the same part as multiple drawing sheets. The number of sheets is not limited.</td>
<td>Create multiple drawing sheets using drawing properties (page 100)</td>
</tr>
<tr>
<td><strong>Layout</strong></td>
<td>Select the drawing layout, and define drawing sizes, autoscale, projection type, view alignment and part expansion settings. You can also select whether you want to list hidden objects in templates.</td>
<td>Drawing layout (page 429)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Drawing size and drawing view scale (page 448)</td>
</tr>
<tr>
<td><strong>View creation</strong></td>
<td>Define the drawing views to be created. From here you can move on to modifying the view properties for each view.</td>
<td>View properties in drawings (page 692)</td>
</tr>
<tr>
<td><strong>Section view</strong></td>
<td>Define section view properties.</td>
<td>Section view properties (page 697)</td>
</tr>
<tr>
<td><strong>Detail view</strong></td>
<td>Define the start number or letter of the detail view and detail symbol label.</td>
<td>Modify detail properties in drawings (page 169)</td>
</tr>
<tr>
<td><strong>Protection</strong></td>
<td>Define protected areas to prevent text, marks or dimensions from being placed there.</td>
<td>Protect areas in a drawing (page 456)</td>
</tr>
<tr>
<td><strong>User-defined attributes</strong></td>
<td>Add customized information to a drawing, such as information related to workflow, and comments. This information can be</td>
<td>User-defined attributes in drawings (page 677)</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>For more information</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td>----------------------</td>
</tr>
<tr>
<td></td>
<td>displayed in the <strong>Drawing List</strong>, and you can use it in report and drawing templates, marks, and as switches when customizing print file names. The user-defined attributes and tabs shown in this dialog box are defined in the <code>objects.inp</code> file. The drawing user-defined attributes dialog box in the default environment contains three tabs: <strong>Workflow</strong>, <strong>Parameters</strong>, and <strong>Title</strong>. On the <strong>Title</strong> tab you can select if you want to use project-specific or drawing-specific information in the title block of the drawing. When you select <strong>Use project settings</strong>, you cannot enter any information in the title block fields.</td>
<td></td>
</tr>
</tbody>
</table>

9.3 **Layout properties**

On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type. Then click **Layout**. You can modify the properties after creating the drawing by double-clicking the drawing background.

All options in all layout property panels and dialog boxes are described below. All the described options are not available for all drawing types.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Drawing size</strong> tab</td>
<td></td>
</tr>
<tr>
<td><strong>Layout</strong></td>
<td>Define the layout that you want to use.</td>
</tr>
<tr>
<td><strong>List hidden objects in templates</strong></td>
<td>Select <strong>Yes</strong> to list hidden objects in templates. <strong>No</strong> removes all information about the hidden parts, also from the total weight.</td>
</tr>
<tr>
<td><strong>Size definition mode</strong></td>
<td>Select <strong>Autosize</strong> if you want to let Tekla Structures find appropriate sizes and table layouts for drawings. Select <strong>Specified size</strong> to specify the exact size for the drawing. The drawing size should</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>always be smaller than the actual paper size to accommodate printer margins.</td>
<td></td>
</tr>
</tbody>
</table>
| Autosize: Use          | The fixed sizes and calculated sizes are both defined in the **Drawing layout properties**:  
  **Fixed sizes**: Use this when you want Tekla Structures to use fixed drawing sizes A2, A3, A4, etc.  
  **Calculated sizes**: Use this when you want to define the rules that Tekla Structures follows when it tries to adjust the drawing size.  
  **Calculated/fixed sizes**: Use this when you want Tekla Structures to select the smallest of the suitable sizes. |
| Drawing size           | If you selected **Specified size**, define the drawing size here.                                                                                                                                              |
| Table layout           | If you selected **Specified size**, define the table layout to be used.                                                                                                                                       |
| Scale tab              |                                                                                                                                                                                                             |
| Autoscale              | Set **Autoscale** to **Yes** to let Tekla Structures automatically select the suitable scale for the drawing view.                                                                                               |
| Main view scales       | When you use autoscaling, enter the denominators of main view and section view scales and separate them with spaces.                                                                                           |
| Section view scales    | For example, enter "5 10 15 20" for the scales 1/5, 1/10, 1/15, and 1/20                                                                                                                                       |
| Scale change mode      | When you use autoscaling, set the scale change mode which defines the relationship between the scales of main and section views within a drawing:  
  **main = section**: The scales of the main and section view are equal.  
  **main < section**: Main view scales are smaller than section view scales.  
  **main <= section**: Main view scales are smaller than or equal to section view scales |
<p>| Preferred size         | Enter the preferred size of the drawing, if you use both autosizing and autoscaling. Tekla Structures tries to find a drawing size where the drawing contents fit by first trying to use the exact scale and the smallest drawing size. If the contents do not fit, Tekla Structures increases the drawing size until it reaches the preferred size. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other tab</td>
<td></td>
</tr>
<tr>
<td><strong>Projection type</strong></td>
<td>Define how Tekla Structures places the projections of a part in cast unit, single-part, and assembly drawings. Projection type affects the order of the views in the drawing. The options are: First angle, also referred to as the European projection. Third angle, also referred to as the American projection.</td>
</tr>
<tr>
<td><strong>Align section views with main view</strong></td>
<td>Set to Yes to place the views next to the main view. If you select No, Tekla Structures places the section and end views in any available location.</td>
</tr>
<tr>
<td><strong>Align end views with main view.</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Expand shortened parts to fit</strong></td>
<td>Set to Yes to stretch shortened views to fill up empty areas of the drawing.</td>
</tr>
<tr>
<td><strong>Include single parts</strong></td>
<td>Set to Yes to include in assembly drawings the single-part drawings of the individual parts that make the assembly. Setting this to Yes, activates the Single-part attributes option.</td>
</tr>
<tr>
<td><strong>Single-part attributes</strong></td>
<td>Define the desired single-part drawing properties to be used in the single-part view. To do this, set include single parts to Yes.</td>
</tr>
</tbody>
</table>

See also
- Drawing size and drawing view scale (page 448)
- Drawing layout (page 429)
- Set drawing view projection type (page 467)
- Define the location for end views and section views (page 496)
- Lengthen shortened parts in drawing views (page 486)
- Include single-part drawings in assembly drawings (page 469)

### 9.4 View properties in drawings

Use the View Properties dialog box to view and modify the drawing view properties.
The table below describes all view level properties for all drawing types.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Drawing Properties --> View creation** panel: Views tab | **View type on/off**  
Defines the main views, section views and 3D views that you want to create.  
- If you select **off**, Tekla Structures does not create the view, but dimensions the parts in the available views. If you set all four main views off, Tekla Structures will still create a front view.  
- If you select **on**, Tekla Structures always creates the view, even if it was not necessary in order to show the dimensions. For section views, Tekla Structures creates one additional section view showing the middle of the main part. For end views, Tekla Structures creates end view from one end of the main part.  
- If you select **auto**, Tekla Structures creates the view if it is necessary in order to show the dimensions. For section views, Tekla Structures creates the necessary number of views to show all the dimensions. For end views, Tekla Structures also creates another end view from the other end of the main part, if there are dimensions at that end. |
| **View label**                      | Shows the view label set in view properties. If the label is defined in view properties, you can change it here. You can always change the label of the main views.                                                                                                                                  |
| **View properties**                 | Shows the current view properties for the view. You can select another view properties file from the list and modify the view properties by clicking View properties.                                                                                                                                                  |

**Drawing Properties --> View creation: Attributes** tab  
These settings are drawing-specific.

Drawing settings reference 693 View properties in drawings
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Coordinate system</strong></td>
<td>Sets the coordinate system of the drawing views. The options are: local, model, oriented, horizontal brace, vertical brace, and fixed.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Change the coordinate system (page 471).</td>
</tr>
<tr>
<td><strong>Rotate coordinate system Around X, Around Y and Around Z</strong></td>
<td>Rotates the view around the x, y, or z axis of the parts using the entered values.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Rotate parts in drawing views (page 474).</td>
</tr>
<tr>
<td><strong>Unfolded</strong></td>
<td><strong>Yes</strong> shows and dimensions the bend lines in the drawing.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Unfold polybeams in drawings (page 486).</td>
</tr>
<tr>
<td><strong>Undeformed</strong></td>
<td><strong>Yes</strong> undeforms deformed parts and shows the developed (undeformed) shape of the deformed parts in drawings.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Undeform deformed parts in drawings (page 487).</td>
</tr>
<tr>
<td><strong>Recreate the drawing</strong></td>
<td><strong>Yes</strong> recreates the drawing.</td>
</tr>
<tr>
<td><strong>View properties</strong> dialog box: Attributes 1 and Attributes 2 tabs** (Attributes and Shortening tabs in general arrangement drawings)</td>
<td></td>
</tr>
<tr>
<td><strong>Scale</strong></td>
<td>Sets the view scale.</td>
</tr>
<tr>
<td><strong>Reflected view</strong></td>
<td>Displays load bearing structures, such as columns and beams on a lower floor.</td>
</tr>
<tr>
<td></td>
<td><strong>Yes</strong> displays structures with a continuous line, and <strong>No</strong> displays them with a dashed line.</td>
</tr>
<tr>
<td><strong>Rotation around (in 3D views)</strong></td>
<td>Modify the view angle of 3D views. Enter the values for the angles in y and x directions. Rotation in a drawing view is around the local axis.</td>
</tr>
<tr>
<td></td>
<td>Value 0.0 for both equals the front view.</td>
</tr>
<tr>
<td><strong>Size</strong></td>
<td><strong>Fit by parts</strong>: Tekla Structures fits the view contents in the drawing view.</td>
</tr>
</tbody>
</table>

View properties reference  694  View properties in drawings
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>frame without leaving any unnecessary space.</td>
</tr>
<tr>
<td></td>
<td><strong>Define as distances</strong>: The x and y boxes define the view size along the x and y axes of the view. The depth boxes define the depth of the view relative to, and perpendicular to the view plane.</td>
</tr>
<tr>
<td>View extension for neighbor parts</td>
<td>Sets the distance from the drawing view to display neighboring parts. For more information, see Show neighbor parts in views (page 479).</td>
</tr>
<tr>
<td>Use detailed object level settings</td>
<td>Allows you to create and apply object level settings. For more information, see Detailed object level settings (page 31)</td>
</tr>
</tbody>
</table>
| Place                                       | Set the placing for the drawing view to be fixed or free:  
  • **Fixed**: Maintain the views in the same location during updates.  
  • **Free**: Let Tekla Structures find a suitable place for the view during updates. For more information, see Define automatic free or fixed placement for drawing views (page 460). |
| Undeformed                                  | Yes undeforms deformed parts and shows the developed (undeformed) shape of the deformed parts in drawing views. For more information, see Undeform deformed parts in drawings (page 487). |
| Shortening                                  | If parts are very long and do not include any details, you can shorten them:  
  • **Cut parts Yes** activates shortening. You can also select to cut **Only in x direction** or **Only in y direction**. |

*Drawing settings reference  695  View properties in drawings*
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>Minimum cut part length</strong> defines</td>
<td>the minimum length of the shortened part to show.</td>
</tr>
<tr>
<td>• <strong>Space between cut parts</strong> defines</td>
<td>the distance between cut parts.</td>
</tr>
<tr>
<td>• <strong>Cut skew parts: Yes</strong> cuts skew parts.</td>
<td></td>
</tr>
<tr>
<td>For more information, see Shorten parts in</td>
<td>drawing views (page 483).</td>
</tr>
<tr>
<td><strong>Show openings/recess symbol</strong></td>
<td><strong>Yes</strong> shows symbols in openings and recesses.</td>
</tr>
<tr>
<td>For more information, see Show part</td>
<td>openings and recesses in drawings (page 489).</td>
</tr>
<tr>
<td><strong>Datum point for elevations</strong></td>
<td><strong>Specified</strong> uses the entered value. <strong>View plane</strong> measures reference points relative to the view plane.</td>
</tr>
<tr>
<td>For more information, see Add elevation</td>
<td>dimensions (page 548).</td>
</tr>
<tr>
<td><strong>Show pours in drawings</strong></td>
<td><strong>Yes</strong> shows pours in drawings. For more information, see Show pour objects, pour marks and pour breaks in drawings (page 668).</td>
</tr>
<tr>
<td><strong>Dimension creation method in this view</strong></td>
<td>Clones the dimensions separately for the selected view only. Using this option affects the creation of the dimensions during cloning and re-dimensioning of existing drawings.</td>
</tr>
<tr>
<td>For more information, see Clone dimensions</td>
<td>in selected views only (page 122).</td>
</tr>
<tr>
<td><strong>Labels tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Text</strong></td>
<td>Defines the view label text. Enter text in fields <strong>A1 - A5</strong>, or click the ... buttons and select the label mark contents and appearance.</td>
</tr>
<tr>
<td>For more information about view labels, see</td>
<td>Define view labels and view label marks (page 465)</td>
</tr>
<tr>
<td><strong>Symbol</strong></td>
<td>Defines a symbol to be used in the view label, and the color, size, and line length of the symbol.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Label position</strong></td>
<td>Defines the vertical and horizontal position of the view label:</td>
</tr>
<tr>
<td>• <strong>Vertical:</strong> Select <strong>Above</strong> or <strong>Below</strong>.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Horizontal:</strong> Select <strong>Center by view frame</strong> or <strong>Center by restriction box</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>View direction marks</strong></td>
<td>Shows or hides the view direction marks and defines the mark height.</td>
</tr>
<tr>
<td><strong>Anchor bolt plan</strong> (general arrangement drawings only)</td>
<td></td>
</tr>
<tr>
<td><strong>Show as anchor bolt plan</strong></td>
<td><strong>Yes</strong> shows the general arrangement drawing as an anchor bolt plan. For more information, see Create anchor bolt plans using saved settings (page 83)</td>
</tr>
<tr>
<td><strong>Enlarged part view scale</strong></td>
<td>Defines the scale used in the enlarged part views.</td>
</tr>
<tr>
<td><strong>Create detail views</strong></td>
<td><strong>Yes</strong> creates separate detail views. If you select <strong>No</strong>, Tekla Structures dimensions the anchor bolts in the enlarged view. Tekla Structures groups similar detail views so that similar details are drawn only once.</td>
</tr>
<tr>
<td><strong>Detail view scale</strong></td>
<td>Defines the scale used in the anchor bolt plan detail views.</td>
</tr>
</tbody>
</table>

**See also**

- Automatic drawing views (page 461)
- Drawing size and drawing view scale (page 448)
- Define the views to create in single-part, assembly and cast unit drawings (page 463)
- Define automatic view settings for general arrangement drawings (page 464)
### 9.5 Section view properties

When you create automatic section views, Tekla Structures creates section views and section marks using the current view and mark properties. You can modify the section view properties in an open drawing.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Attributes tab</strong></td>
<td></td>
</tr>
<tr>
<td>Section depth</td>
<td>Defines the positive and negative distances of the section view when views are not combined.</td>
</tr>
<tr>
<td>Distance for combining cuts</td>
<td>Defines the distance range for combining cut views.</td>
</tr>
<tr>
<td>Direction</td>
<td>Define the view direction of the section. The options are:</td>
</tr>
<tr>
<td></td>
<td>• Right section</td>
</tr>
<tr>
<td></td>
<td>• Middle section</td>
</tr>
<tr>
<td></td>
<td>• Left section</td>
</tr>
<tr>
<td></td>
<td>The available values are <strong>left</strong> or <strong>right</strong>.</td>
</tr>
<tr>
<td><strong>Cutting line tab</strong></td>
<td></td>
</tr>
<tr>
<td>Line</td>
<td>Length and offset of the cutting line.</td>
</tr>
<tr>
<td>Properties</td>
<td>Color of the cutting line.</td>
</tr>
<tr>
<td><strong>Section mark tab</strong></td>
<td></td>
</tr>
<tr>
<td>Text</td>
<td>Defines the text on the section mark. Click the ... buttons next to the text boxes to open the <strong>Mark Contents</strong> dialog box.</td>
</tr>
<tr>
<td>Symbol: Color</td>
<td>Color of the section mark symbol.</td>
</tr>
<tr>
<td>Left symbol, Right symbol</td>
<td>Left and right section mark symbol.</td>
</tr>
<tr>
<td>Size</td>
<td>Size of the section mark left and right symbol.</td>
</tr>
<tr>
<td>x/y</td>
<td>Offset of the section mark left and right symbol.</td>
</tr>
<tr>
<td><strong>Start number or letter of section view and symbol label</strong></td>
<td>Defines the letter or number used in the section view label or in the section symbol label.</td>
</tr>
<tr>
<td></td>
<td>You can enter any number starting from 1 or any letter A - Z or a - z (also shown in uppercase in the label). If you use letter, and the entered string is longer than one letter, only the first letter is shown in the view label and</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>section symbol label. If</td>
<td>section symbol label. If you use numbers, all entered numbers are shown. The start number changes only if you change it in the drawing properties</td>
</tr>
<tr>
<td>you use numbers, all</td>
<td>before creating a drawing, and if you change the option in an existing drawing and recreate the drawing, in which case section view and symbol</td>
</tr>
<tr>
<td>entered numbers are</td>
<td>labels for all automatically included section views and all new section views will change.</td>
</tr>
<tr>
<td>shown. The start number</td>
<td>change only if you change it in the drawing properties before creating a drawing, and if you change the option in an existing drawing and recreate</td>
</tr>
<tr>
<td>changes only if you</td>
<td>the drawing, in which case section view and symbol labels for all automatically included section views and all new section views will change.</td>
</tr>
<tr>
<td>change it in the drawing</td>
<td></td>
</tr>
<tr>
<td>properties before</td>
<td></td>
</tr>
<tr>
<td>creating a drawing, and</td>
<td></td>
</tr>
<tr>
<td>if you change the option</td>
<td></td>
</tr>
<tr>
<td>in an existing drawing</td>
<td></td>
</tr>
<tr>
<td>and recreate the</td>
<td></td>
</tr>
<tr>
<td>drawing, in which case</td>
<td></td>
</tr>
<tr>
<td>section view and symbol</td>
<td></td>
</tr>
<tr>
<td>labels for all</td>
<td></td>
</tr>
<tr>
<td>automatically included</td>
<td></td>
</tr>
<tr>
<td>section views and all</td>
<td></td>
</tr>
<tr>
<td>new section views will</td>
<td></td>
</tr>
<tr>
<td>change.</td>
<td></td>
</tr>
</tbody>
</table>

See also

View properties in drawings (page 692)
Object protection and placement settings in drawings (page 453)
Automatic drawing views (page 461)
Define the views to create in single-part, assembly and cast unit drawings (page 463)
Create a section view (page 147)

9.6 Dimension and dimensioning properties

Dimension properties define what the dimensions look like and which formats, units etc. are used. Dimensioning properties define what is being dimensioned and how.

Click the following links to find out more about dimension properties:

- Dimension properties - General tab (page 700)
- Dimension properties - Units, precision and format (page 703)
- Dimension properties - Appearance tab (page 705)
- Dimension properties - Marks and Tags tabs (page 706)

Click the following links to find out more about dimensioning properties in view-level dimensioning:

- Dimensioning rule properties (page 518)
- Dimensioning properties - General tab (Integrated dimensioning) (page 709)
- Dimensioning properties - Part dimensions tab (Integrated dimensioning) (page 716)
• Dimensioning properties - Position dimensions tab (Integrated dimensioning) (page 713)
• Dimensioning properties - Bolt dimensions tab (Integrated dimensioning) (page 718)
• Dimensioning properties - Dimension grouping tab (Integrated dimensioning) (page 720)
• Dimensioning properties - Sub-assemblies tab (Integrated dimensioning) (page 721)
• Dimensioning properties - Reinforcement dimensions tab (Integrated dimensioning) (page 722)

Click the following links to find out more about dimensioning properties in GA drawings:
• Dimensioning properties - Grid tab (GA drawings) (page 723)
• Dimensioning properties - Parts tab (GA drawings) (page 723)

**Dimension properties - General tab**
Use the **General** tab in the **Dimension Properties** dialog box to view and modify the format, type, unit, precision, extension line, grouping and placing settings of the dimensions.

The drawing level **Dimension Properties** dialog box and object level **Dimension Properties** dialog box contents differ. All options in both dialog boxes are described below.

• To open the drawing level **Dimension properties** dialog box, open the drawing, go to the **Drawing** tab and click **Properties --> Dimension**.

• To open the object level **Dimension properties**, double-click a dimension in an open drawing.

• To open **Dimension properties** dialog box for general arrangement drawings before creating a drawing: On the **Drawings & reports** tab, click **Drawing properties --> GA drawing**, and then click **Dimension**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dimension type</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Straight</strong></td>
<td>Sets the dimension type for straight dimensions.</td>
</tr>
<tr>
<td><img src="image" alt="Straight" /></td>
<td><strong>Relative</strong>: Point to point dimensions.</td>
</tr>
<tr>
<td><img src="image" alt="Straight" /></td>
<td><strong>Absolute</strong>: Dimensions from a common start point.</td>
</tr>
</tbody>
</table>

Drawing settings reference 700 Dimension and dimensioning properties
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /> <img src="image2.png" alt="Image" /></td>
<td><strong>Relative and absolute</strong>: Combination of point to point and common start point.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /> <img src="image4.png" alt="Image" /></td>
<td><strong>US absolute</strong>: Dimensions from a common start point, which include a running dimension mark (RD).</td>
</tr>
<tr>
<td><img src="image5.png" alt="Image" /> <img src="image6.png" alt="Image" /></td>
<td><strong>US absolute 2</strong>: Similar to <strong>US absolute</strong>, but it changes short dimensions to relative.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Image" /> <img src="image8.png" alt="Image" /></td>
<td><strong>Absolute plus short relatives</strong>: Similar to <strong>Absolute</strong>, but it changes short dimensions to relative. Also called internal absolute. This option may show both dimensions, but it does not show relative dimensions when dimensions are long. This option shows the absolute dimensions inside the dimension lines.</td>
</tr>
<tr>
<td><img src="image9.png" alt="Image" /> <img src="image10.png" alt="Image" /></td>
<td><strong>Absolute plus all relatives above the absolutes</strong>: Similar to <strong>Relative and absolute</strong>, but it places the relative dimensions above the absolute.</td>
</tr>
<tr>
<td><img src="image11.png" alt="Image" /></td>
<td><strong>Elevation</strong>: Creates an elevation dimension at a picked point. This type is only available in the dimension properties of manual dimensions in drawing mode.</td>
</tr>
<tr>
<td><img src="image12.png" alt="Image" /></td>
<td><strong>In x direction</strong>: As above, but overrides the straight setting for horizontal dimensions. If you use the blank option, Tekla Structures uses the <strong>Straight</strong> option settings. The x direction usually means dimensions parallel to the drawing x axis.</td>
</tr>
<tr>
<td><img src="image13.png" alt="Image" /></td>
<td><strong>Angle</strong>: Defines the appearance of angle dimensions.</td>
</tr>
<tr>
<td><img src="image14.png" alt="Image" /></td>
<td>Shows the angle dimensions in degrees on side.</td>
</tr>
<tr>
<td><img src="image15.png" alt="Image" /></td>
<td>Shows the angle dimensions in degrees at angle vertex.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="image" alt="Angle Dimensions" /></td>
<td>Shows the angle dimensions using a triangle. You can also set the <strong>Triangle base length</strong> to control the base dimension shown for bevel dimensions.</td>
</tr>
<tr>
<td><img src="image" alt="Degree Triangle" /></td>
<td>Shows the angle dimensions using a triangle with degrees.</td>
</tr>
<tr>
<td><strong>Triangle base length</strong></td>
<td>The base length of a triangle.</td>
</tr>
<tr>
<td><strong>Curved</strong></td>
<td>Defines whether to use angle units or distance units for curved dimensions.</td>
</tr>
<tr>
<td><strong>Short extension line</strong></td>
<td>Defines whether Tekla Structures should create extension lines all of the same length or use the short extension line automatically if the dimension line falls on a grid line. If you want to exaggerate dimensions, you need to set this option to No.</td>
</tr>
<tr>
<td><strong>Dimension format</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Units</strong></td>
<td>Defines the units (page 703) used in dimensioning.</td>
</tr>
<tr>
<td><strong>Precision</strong></td>
<td>Defines dimension precision (page 703): rounding, imperial units.</td>
</tr>
<tr>
<td><strong>Format</strong></td>
<td>Defines the dimension format (page 703): the number of decimals and their appearance.</td>
</tr>
<tr>
<td><strong>Use grouping</strong></td>
<td>Defines whether long dimension values are grouped.</td>
</tr>
<tr>
<td><strong>Combine equal dimensions</strong></td>
<td>Combines equal dimensions. The choices are Off, 3<em>60 or 3</em>60=180. The accuracy of combining equal dimensions is 0.1.</td>
</tr>
<tr>
<td><strong>Minimum number to combine</strong></td>
<td>Defines the minimum number of dimensions to combine.</td>
</tr>
<tr>
<td><strong>Dimension grouping</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Update grouping when model changes</strong></td>
<td>Yes updates dimension grouping automatically when the model changes.</td>
</tr>
<tr>
<td><strong>Placing</strong></td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Dimension line spacing</td>
<td>Defines the space between parallel dimension lines. In manually created dimensions, this setting works only if dimension <strong>Placing</strong> is set to <strong>Free</strong>, see below.</td>
</tr>
<tr>
<td>Short dimensions</td>
<td>Defines the text location of short dimensions: between or outside the dimension lines.</td>
</tr>
<tr>
<td>Place</td>
<td>Opens the <strong>Dimension Placing</strong> dialog box. <strong>Placing</strong> is the method used for placing dimensions. The choices are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Free</strong> lets Tekla Structures to decide the location and direction of the dimension based on the <strong>Direction</strong> settings.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Fixed</strong> allows you to place the dimension at any point.</td>
</tr>
<tr>
<td></td>
<td><strong>Search margin</strong> is the farthest distance Tekla Structures uses when searching for an empty space for the dimension.</td>
</tr>
<tr>
<td></td>
<td><strong>Minimal distance</strong> is the closest distance Tekla Structures uses to search for an empty space for a dimension.</td>
</tr>
<tr>
<td></td>
<td><strong>Direction</strong> defines the side of the dimensioned object on which Tekla Structures places the dimensions.</td>
</tr>
</tbody>
</table>

**See also**

*Dimension properties - Units, precision and format (page 703)*
Dimension properties - Units, precision and format

Use the General tab of the Dimension properties dialog box to view and modify options related to dimension format, unit and precision.

The integer values are provided for situations when you need to use the value as a value for an advanced option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Integer value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td></td>
<td></td>
</tr>
<tr>
<td>###</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>###[.#]</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>###.#</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>###[.##]</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>###.##</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>###[.###]</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>###.###</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>### #/#</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>## #/## #</td>
<td>8</td>
<td>This option is available only for straight dimensions.</td>
</tr>
<tr>
<td>Precision</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.00</td>
<td>1</td>
<td>For defining precision with rounding. For example, with precision 0.33 the actual dimension 50.40 is shown as 50.33.</td>
</tr>
<tr>
<td>0.50</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>0.33</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>0.25</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>1/8</td>
<td>5</td>
<td>For imperial units</td>
</tr>
<tr>
<td>1/16</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>1/32</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>1/10</td>
<td>8</td>
<td>For defining precision without rounding</td>
</tr>
<tr>
<td>1/100</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>1/1000</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Units</td>
<td></td>
<td></td>
</tr>
<tr>
<td>automatic</td>
<td></td>
<td>Uses the units defined in the model</td>
</tr>
<tr>
<td>mm</td>
<td></td>
<td>millimeters</td>
</tr>
<tr>
<td>cm</td>
<td></td>
<td>centimeters</td>
</tr>
<tr>
<td>m</td>
<td></td>
<td>meters</td>
</tr>
</tbody>
</table>
### Option | Integer value | Notes
---|---|---
**foot - inch** |  | feet and inches
Inches are converted into integer feet, and the remaining inches are shown in inches.

**cm / m** |  | centimeters and meters
Dimensions under 100 cm are shown in centimeters, and dimensions above 100 cm are shown in meters. Millimeters are shown as superscript.

**inch** | inches |  
**feet** | feet |  

**See also**
Dimensioning rule properties (page 518)
Dimension properties - General tab (page 700)

### Dimension properties - Appearance tab
Use the **Appearance** tab in the **Dimension properties** dialog box to view and modify the settings affecting the dimension appearance.

- To open the drawing level **Dimension properties** dialog box, open the drawing, go to the **Drawing** tab and click **Properties --> Dimension**.
- To open the object level **Dimension properties** dialog box, double-click a dimension in an open drawing.
- To open **Dimension properties** dialog box for general arrangement drawings before creating a drawing: On the **Drawings & reports** tab, click **Drawing properties --> GA drawing**, and then click **Dimension**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Text</strong></td>
<td></td>
</tr>
</tbody>
</table>
**Color** | The color of the dimension mark text. This controls the line weight in printed drawings.  
**Height** | Controls the height of the text used in the dimension marks in the drawing. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Font</strong></td>
<td>Controls which font is used in the dimension mark.</td>
</tr>
<tr>
<td><strong>Frame</strong></td>
<td>Defines a frame for the dimension mark.</td>
</tr>
<tr>
<td><strong>Place</strong></td>
<td>Defines how the dimension mark is placed relative to the dimension line.</td>
</tr>
<tr>
<td><strong>Line, Arrow</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Color</strong></td>
<td>Controls the color of the dimension line. The color controls the line weight in printed drawings.</td>
</tr>
<tr>
<td><strong>Arrow shape</strong></td>
<td>Controls the type of mark used with the dimension line.</td>
</tr>
<tr>
<td></td>
<td>Sets the height and the length of the arrowhead.</td>
</tr>
<tr>
<td><strong>US Absolute dimensions</strong></td>
<td>Controls the type of mark used with the dimension line in US Absolute dimensions.</td>
</tr>
<tr>
<td><strong>Level dimensions</strong></td>
<td>Controls the type of mark used with the dimension line in level dimensions.</td>
</tr>
</tbody>
</table>

**See also**

Dimension properties - General tab (page 700)

**Dimension properties - Marks and Tags tabs**

Use the **Marks** and **Tags** tabs in the **Dimension Properties** dialog box to view and modify the contents of dimension marks and tags in an open drawing.

- To open the drawing level **Dimension properties** dialog box, open the drawing, go to the **Drawing** tab and click **Properties --> Dimension**.
- To open the object level **Dimension properties**, double-click a dimension in an open drawing.
- To open **Dimension properties** dialog box for general arrangement drawings before creating a drawing: On the **Drawings & reports** tab, click **Drawing properties --> GA drawing**, and then click **Dimension**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Marks</strong> tab</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Prefix</td>
<td>Displays the defined value before the numeric value of the dimension. The prefix value cannot be plain numbers, and the prefix value cannot end with a number.</td>
</tr>
<tr>
<td>Visibility of numeric value</td>
<td>Defines whether the numeric value of the dimension is visible or hidden. If you hide the numeric value of the dimension, the prefix and postfix text will still be shown.</td>
</tr>
<tr>
<td>Postfix</td>
<td>Displays the selected text after the numeric value of the dimension. The postfix value cannot be plain numbers, and the postfix value cannot start with a number when the numeric value of the dimension is visible.</td>
</tr>
<tr>
<td>... buttons</td>
<td>Define dimension mark contents by adding elements. You can also modify the mark appearance.</td>
</tr>
<tr>
<td></td>
<td><strong>Frame around elements:</strong> <strong>Type</strong> and <strong>Color</strong> define the element frame type and color individually for each element.</td>
</tr>
<tr>
<td></td>
<td><strong>Add frame</strong> allows you to add frames around elements. <strong>Font:</strong> <strong>Color</strong>, <strong>Height</strong> and <strong>Font</strong> define the font type, color, and height used in element texts individually for each element. Clicking <strong>Select</strong> gives more font choices.</td>
</tr>
<tr>
<td></td>
<td><strong>Units:</strong> <strong>Unit</strong> and <strong>Format</strong> allow you to set the unit and format for length elements. Unit settings can be modified only when a length element is selected.</td>
</tr>
</tbody>
</table>
|                               | You can also use template attributes in the **User-defined attribute** element. In marks, you cannot use template attributes such as **MODEL_TOTAL** that refer to the whole model. Marks only check the information from the object in the
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate side marks</td>
<td><strong>Specified</strong> creates plate side marks to plate dimension (page 204) using the specified color, size and offset. Offset means the distance of the mark from the dimension line.</td>
</tr>
<tr>
<td></td>
<td>The option <strong>Automatic</strong> is available only in intelligent drawings, that is when the advanced option <code>XS_INTELLIGENT_DRAWING_ALLOWED</code> is set to <code>TRUE</code>.</td>
</tr>
<tr>
<td>Exaggeration</td>
<td><strong>Specified</strong> exaggerates narrow dimensions.</td>
</tr>
<tr>
<td></td>
<td>Select the <strong>Direction</strong>: <strong>Left/ Down, Right/Up</strong> or <strong>Both</strong>.</td>
</tr>
<tr>
<td></td>
<td>Set the <strong>Origin, Width, Position</strong> and <strong>Height</strong>.</td>
</tr>
<tr>
<td>Tags tab</td>
<td></td>
</tr>
<tr>
<td>Tags area</td>
<td><strong>Add tags to dimension lines</strong> (page 179). You can enter text in the tag box or add elements by clicking the <strong>...</strong>.</td>
</tr>
<tr>
<td></td>
<td>When you click the <strong>...</strong> button next to a tag box, a dialog box for the particular tag is displayed and you can define dimension tag contents by adding elements. You can also modify the tag element appearance.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Rotation</strong> --&gt; <strong>Perpendicular to dimension line</strong> rotates the tag.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Rotation</strong> --&gt; <strong>Parallel to dimension line</strong> does not rotate the tag. This is the default value.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Frame around elements</strong>: <strong>Type</strong> and <strong>Color</strong> define the element frame type and color individually for each element.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Add frame</strong> allows you to add frames around elements. <strong>Font</strong>: <strong>Color, Height</strong> and <strong>Font</strong> define the font type, color, and height used in element texts individually for each element.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Option 1: Units</td>
<td><strong>Units</strong>: <strong>Unit</strong> and <strong>Format</strong> allow you to set the unit and format for length elements. Unit settings can be modified only when a length element is selected.</td>
</tr>
<tr>
<td>Option 2: User-defined attribute</td>
<td>You can also use template attributes in the <strong>User-defined attribute</strong> element. In tags, you cannot use template attributes such as <code>MODEL_TOTAL</code> that refer to the whole model. Tags only check the information from the object in the drawing, and not from the whole model.</td>
</tr>
<tr>
<td>Include part count in the tag</td>
<td>Yes includes part count in the tag.</td>
</tr>
<tr>
<td>Exclude parts according to filter</td>
<td>Select a drawing view filter that removes desired content from the tag (page 181).</td>
</tr>
<tr>
<td>Curved dimension tag type</td>
<td>Select a <strong>tag type</strong> for a curved reinforcing bar (page 185) dimension line. The tag type controls how the tags are aligned to the dimension.</td>
</tr>
</tbody>
</table>

**See also**

- Add manual dimensions (page 171)
- Add manual dimensions to general arrangement drawings (page 177)
- Add dimensions to reinforcement (page 185)
**Dimensioning properties - General tab (Integrated dimensioning)**

Use the **General** tab in the **Dimensioning Properties** dialog box to view and modify the general settings of the dimensions. This dialog box is displayed if you use **Integrated** dimensioning type in dimensioning.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Dimensioning type** | **Standard** is used for almost all dimensioning.  
**Truss** meets the specific requirements needed to dimension truss drawings. It dimensions the position and length of the diagonals. The dimensioning is done only if the diagonals are secondary parts that are welded to upper and lower chords, which are main parts and not welded to any parts. If the truss welding is done some other way, standard dimensioning is used. |
| **Number of views: Minimize** | **Yes** minimizes the number of views that Tekla Structures creates.  
Also check the settings in the drawing **View properties** dialog box.                                                                                   |
| **Combine dimensions** | **Combines (page 562)** several single dimensions into one dimension line.  
In **Options**, select the combination level. The larger the number, the more Tekla Structures combines dimensions.  
Option **4.5** uses a combination of option **5** for main part and option **4** for secondary parts.  
The **Distance** means the distance within which Tekla Structures combines internal dimensions.  
If the distance between two details is less than the defined **Minimum distance**, Tekla Structures combines the dimensions. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Close dimensions                           | **Close dimensions** *(page 561)* completes dimension lines to include the entire part.  
**No** does not close dimensions  
**In X** only closes dimensions in the x direction and leaves others open  
**All** closes all dimensions  
This setting is not relevant to profile shape dimensions.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                           |
| Close dimensions: Short dimensions         | **Yes** closes short dimensions.  
With **No**, the open dimension is the middle one rather than the short end dimension.  
When you leave short dimensions open, Tekla Structures leaves out the longer dimension line in dimension lines that contain two dimensions. If dimension lines contain three dimensions, Tekla Structures leaves out the middle one. This option does not affect dimension lines with more than three dimensions.                                                                                                                                                                                                                                                                                                                                 |
| Placing: Forward offset                    | **Forward offset** *(page 566)* defines the distance Tekla Structures uses to search for the base point of a dimension. If Tekla Structures does not find a base point (corner) within the **Forward offset** search distance, it uses an edge point.  
The **Centered bolt** setting affects on how the dimension is displayed.                                                                                                                                                                                                                                                                                                                                                                                                                                                      |
| Necessary internal dimensioning:          | **Recognizable distance** *(page 567)* defines the limit for dimensioning asymmetry in secondary parts. In some cases, it is important to look at the asymmetrical relationship of parts, so that an asymmetric secondary part is correctly connected to a main part. You can use **Recognizable distance** to have asymmetry reflected in dimensioning. If the asymmetry is smaller than the distance you enter here, Tekla  
<pre><code>                                                                                                                                                                                                                                                                                                                                                                                                                                                             |
</code></pre>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part mark on dimension line</td>
<td><strong>None</strong> creates no part mark on the dimension line.</td>
</tr>
<tr>
<td></td>
<td><strong>Assembly overall dimensions</strong> creates a part mark on the assembly overall dimension line.</td>
</tr>
<tr>
<td></td>
<td><strong>Extreme bolts</strong> creates a part mark on the dimension line between the outermost bolts.</td>
</tr>
<tr>
<td>Main dimension position</td>
<td>Defines the side on which Tekla Structures places the <strong>Assembly overall</strong>, <strong>Main part work point</strong>, and <strong>Knock-off</strong> dimensions.</td>
</tr>
<tr>
<td></td>
<td><strong>Auto</strong> treats the main dimensions in the same way as other dimensions.</td>
</tr>
<tr>
<td></td>
<td><strong>Above</strong> places the main dimensions above the part (or to the left for vertical parts).</td>
</tr>
<tr>
<td></td>
<td><strong>Below</strong> places the main dimensions below the part.</td>
</tr>
<tr>
<td></td>
<td><strong>Above</strong> places the skew position dimensions of the main part below the part and <strong>Below</strong> places them above.</td>
</tr>
<tr>
<td>Grid dimensions</td>
<td>Creates [grid dimensions](page 567). The values are: <strong>None</strong>, <strong>Individual spans</strong>, <strong>Overall</strong> or <strong>Individual spans and overall</strong>.</td>
</tr>
<tr>
<td>Grid dimension position</td>
<td>Sets the grid dimension position. The values are: <strong>Main view - above</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Main view - below</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Top view - above</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Top view - bottom</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Bottom view - above</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Bottom view - below</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Back view - above</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Back view - below</strong></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>All views - above</td>
<td></td>
</tr>
<tr>
<td>All views - below</td>
<td></td>
</tr>
<tr>
<td>Dimension properties</td>
<td></td>
</tr>
<tr>
<td>Straight dimensions</td>
<td>Sets the dimension type for straight dimensions using the settings in the properties file you select.</td>
</tr>
<tr>
<td>In X direction</td>
<td>Otherwise same settings as in straight dimensions but overrides the straight setting for horizontal dimensions. If you use the blank option, Tekla Structures uses the <strong>Straight dimensions</strong> option settings. The x direction usually means dimensions parallel to the drawing x axis.</td>
</tr>
<tr>
<td>Arrow shape: US Absolute dimensions</td>
<td>Controls the type of mark used with the dimension line in US Absolute dimensions.</td>
</tr>
<tr>
<td>Arrow shape: Level dimensions</td>
<td>Controls the type of mark used with the dimension line in level dimensions.</td>
</tr>
<tr>
<td>Angle dimensions</td>
<td>Sets the dimension type for angle dimensions using the settings in the properties file you select.</td>
</tr>
<tr>
<td>Check dimensions</td>
<td>Sets the dimension type for check dimensions using the settings in the properties file you select.</td>
</tr>
</tbody>
</table>

See also

Add automatic view-specific dimensions using dimensioning type Integrated (page 545)

**Dimensioning properties - Position dimensions tab (Integrated dimensioning)**

Use the **Position dimensions** tab in the Dimensioning Properties dialog box to view and modify the settings for the position dimensions in single-part, assembly and cast unit drawings.

Note that the contents of the dialog box vary depending on the drawing type, and all the options listed below are not available for all drawing types. This dialog box is displayed if you use **Integrated** dimensioning type in dimensioning.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Position bolts/parts to</strong></td>
<td>Controls from where Tekla Structures creates the part/bolt position dimensions.</td>
</tr>
<tr>
<td><strong>None</strong></td>
<td>creates no position dimensions.</td>
</tr>
<tr>
<td><strong>Main part</strong></td>
<td>creates the dimensions from the main part reference line.</td>
</tr>
<tr>
<td><strong>Working points</strong></td>
<td>creates the dimensions between the work points, such as the intersections of main and neighbor part reference lines.</td>
</tr>
<tr>
<td><strong>Embedded objects</strong></td>
<td>Creates position dimensions for locating embedded objects in cast unit drawings. The embedded objects are custom components attached to the cast unit.</td>
</tr>
<tr>
<td><strong>As secondary objects</strong></td>
<td>dimensions embedded objects in cast unit drawings the same way as secondary parts.</td>
</tr>
<tr>
<td><strong>By reference points</strong></td>
<td>dimensions embedded objects to their reference point, which is the origin of the custom component.</td>
</tr>
<tr>
<td><strong>Secondary part</strong></td>
<td>Creates dimensions to bolt holes or edges of the secondary part.</td>
</tr>
<tr>
<td><strong>None</strong></td>
<td>creates no position dimensions for secondary parts.</td>
</tr>
<tr>
<td><strong>By bolts</strong></td>
<td>dimensions bolt hole locations in the secondary parts.</td>
</tr>
<tr>
<td><strong>By parts</strong></td>
<td>dimensions edges of secondary parts.</td>
</tr>
<tr>
<td><strong>By both</strong></td>
<td>dimensions bolt hole locations and edges of the secondary part.</td>
</tr>
<tr>
<td><strong>Secondary part dimension direction</strong></td>
<td>Aligns dimensions with the main or neighboring part. Only for skewed clip angles or shear plates.</td>
</tr>
<tr>
<td><strong>Position from</strong></td>
<td>Sets the start point for running dimensions. Only for skewed clip angles or shear plates bolted to a neighboring part.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reversed direction for running dimensions</td>
<td><strong>Yes</strong> changes the direction of running dimensions. With this option, you can set the zero point to the end of a member rather than to the start.</td>
</tr>
<tr>
<td>Main part bolt position</td>
<td><strong>On</strong> creates dimensions to the bolt hole locations in the main part.</td>
</tr>
<tr>
<td>Main part skew position</td>
<td><strong>Yes</strong> creates horizontal and vertical check dimensions representing the skew position of a brace. Created between the work points of the main part. Skew check dimensions are located in the front view. Their location depends on the <strong>Main dimension side</strong> setting selected on the <strong>General</strong> tab. When the main dimensions are above the part, the skew dimensions are below, and vice versa.</td>
</tr>
<tr>
<td>Skew position</td>
<td>Defines how Tekla Structures dimensions skewed secondary part positions.</td>
</tr>
<tr>
<td></td>
<td><strong>None</strong> creates no dimensions for skewed secondary part positions.</td>
</tr>
<tr>
<td></td>
<td><strong>Angle</strong> creates an angle dimension for the secondary part.</td>
</tr>
<tr>
<td></td>
<td><strong>Dimensions</strong> creates dimensions for the skewed position of the secondary part.</td>
</tr>
<tr>
<td></td>
<td><strong>Both</strong> creates both the angle and the dimensions.</td>
</tr>
<tr>
<td>Centered part</td>
<td>Controls the dimensions of centrally-placed parts. These settings have an effect only if position dimensions are created.</td>
</tr>
<tr>
<td></td>
<td><strong>Internal</strong> dimensions the centered parts overall size.</td>
</tr>
<tr>
<td></td>
<td><strong>Position</strong> dimensions the part to the main part center lines.</td>
</tr>
<tr>
<td></td>
<td><strong>None</strong> creates no centered part dimensions.</td>
</tr>
</tbody>
</table>
### Dimensioning properties - Part dimensions tab (Integrated dimensioning)

Use the options on the **Part dimensioning** tab of the **Dimensioning Properties** dialog box to view and modify part dimensioning settings for single-part, assembly and cast unit drawings.

Note that the contents of the dialog box vary depending on the drawing type, and all the options listed below are not available for all drawing types. This dialog box is displayed if you use **Integrated** dimensioning type in dimensioning.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal</td>
<td>Creates internal dimensions for secondary parts connected to the main part.</td>
</tr>
<tr>
<td></td>
<td><strong>None</strong> creates dimensions for secondary parts.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Option                                      | Necessary creates only the dimensions that are necessary for assembling the parts.  
<p>|                                             | All creates all dimensions for the secondary parts.                         |
| Main part overall dimensions                | Once creates one overall dimension for the main part.                       |
|                                             | All creates overall dimensions for main parts in all views.                 |
|                                             | None creates no overall dimensions for the main part.                       |
|                                             | The Assembly part overall dimension settings have some effect on these options. |
| Assembly part overall dimensions             | Length only creates overall dimensions for an entire assembly or cast unit in the x direction only. |
|                                             | All creates overall dimensions for an assembly or cast unit in all directions. |
|                                             | Off creates no overall dimensions for an assembly or a cast unit.           |
| Main part work points                       | On creates a check dimension between the outermost work points.             |
| Main part shape (Shape dimensions)          | On creates dimensions to show the shape of a main part.                    |
|                                             | By default, Tekla Structures automatically draws shape dimensions on both ends of a beam, even if the ends are symmetrical. |
| Main part radius dimensions (Radius dimensions) | On creates radius dimensions for curved chamfers and round holes in the main part. |
|                                             | This option is available only if you have set Main part shape dimensions to On. |
|                                             | Note that this option does not create radius dimensions for curved beams or polybeams with chamfers. |
| Bevel dimensions                            | On creates linear dimensions of a bevel.                                   |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bevel angle</td>
<td>Creates an angle dimension and defines which side of the bevel to dimension. The choices are None, Angle of cut and Angle of beam.</td>
</tr>
<tr>
<td>Knock off dimensions</td>
<td>On creates check dimensions from the edge of the main part to the work point.</td>
</tr>
<tr>
<td>Preferred dim side</td>
<td>Sets the preferred view (front or side) for part dimensions.</td>
</tr>
<tr>
<td>From the nearest floor level to part</td>
<td>On creates dimensions indicating the distance from the closest floor level to the bottom and/or top of the parts.</td>
</tr>
<tr>
<td>From grid to part center line</td>
<td>On creates dimensions showing the offset of a part from the grid to the part center line.</td>
</tr>
<tr>
<td>From grid to part ends</td>
<td>On creates dimensions showing the offset of a part from the grid to the near or far end of the part.</td>
</tr>
</tbody>
</table>

**See also**

Add automatic view-specific dimensions using dimensioning type Integrated (page 545)

Example: Part dimensioning (page 552)

**Dimensioning properties - Bolt dimensions tab (Integrated dimensioning)**

Use the options on the Bolt dimensions tab of the Dimensioning Properties dialog box to select which bolt dimensions to create and how in single-part, assembly and cast unit drawings.

Note that the contents of the dialog box vary depending on the drawing type, and all the options listed below are not available for all drawing types. This
A dialog box is displayed if you use **Integrated** dimensioning type in dimensioning.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Main part bolt internal dimensions</strong></td>
<td>Creates internal dimensions for bolt groups in the main part.</td>
</tr>
<tr>
<td></td>
<td><strong>None</strong> creates none of the internal bolt dimensions.</td>
</tr>
<tr>
<td></td>
<td><strong>Internal</strong> creates bolt group internal dimensions (distances between bolts).</td>
</tr>
<tr>
<td></td>
<td><strong>All</strong> creates edge distance and bolt group internal dimensions. Edge distance is the dimension from the outermost bolt to the part edge.</td>
</tr>
<tr>
<td><strong>Main part bolt internal dimensions:</strong> Skewed bolt group</td>
<td>Indicates whether the dimensions are parallel to the part or the bolt group.</td>
</tr>
<tr>
<td></td>
<td>The choices are <strong>No dimensions</strong>, <strong>In part direction</strong>, and <strong>In bolt group direction</strong>.</td>
</tr>
<tr>
<td><strong>Secondary part bolt internal dimensions</strong></td>
<td>Creates internal dimensions for bolt groups in the secondary part.</td>
</tr>
<tr>
<td></td>
<td>The choices are <strong>None</strong>, <strong>Necessary</strong>, <strong>Internal</strong>, and <strong>All</strong>.</td>
</tr>
<tr>
<td><strong>Secondary part bolt internal dimensions:</strong> Skewed bolt group</td>
<td>Aligns the bolt dimensions with the secondary part or bolt group.</td>
</tr>
<tr>
<td></td>
<td>The choices are <strong>In part direction</strong>, <strong>No dimensions</strong>, and <strong>In bolt group direction</strong>.</td>
</tr>
<tr>
<td><strong>Distance between extreme bolts:</strong> Extreme bolts**</td>
<td>Creates check dimension between the outermost bolts.</td>
</tr>
<tr>
<td></td>
<td>The choices are <strong>None</strong>, <strong>Main part</strong>, and <strong>Assembly</strong>.</td>
</tr>
<tr>
<td><strong>Distance between extreme bolts:</strong> Extreme bolts to work points</td>
<td>Creates check dimensions from the outermost bolts to the work points.</td>
</tr>
<tr>
<td></td>
<td><strong>Yes</strong> creates the check dimensions.</td>
</tr>
<tr>
<td><strong>Preferred dim side</strong></td>
<td>Sets the preferred view (front or side) for bolt dimensions.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Combine bolt dimensions</td>
<td>Sets the format of the combined bolt group internal dimensions. You can combine bolt group internal dimensions and display them in the format $3\times 60$ or $3\times 60=180$, or have single dimensions.</td>
</tr>
<tr>
<td>Minimum number to combine</td>
<td>Defines the minimum number of dimensions to combine.</td>
</tr>
</tbody>
</table>

See also

Add automatic view-specific dimensions using dimensioning type Integrated (page 545)

Example: Combine bolt group dimensions (page 565)

**Dimensioning properties - Dimension grouping tab (Integrated dimensioning)**

Use the Dimension grouping tab in Dimensioning Properties dialog box to view and modify settings for dimension grouping in single-part, assembly and cast unit drawings.

Note that the contents of the dialog box vary depending on the drawing type, and all the options listed below are not available for all drawing types. This dialog box is displayed if you use Integrated dimensions dimensioning type in dimensioning.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate dimension grouping</td>
<td>Selects the objects for grouping.</td>
</tr>
<tr>
<td>Parts</td>
<td>Groups according to parts.</td>
</tr>
<tr>
<td>Bolts</td>
<td>Groups according to bolts.</td>
</tr>
<tr>
<td>Components</td>
<td>Groups according to components.</td>
</tr>
<tr>
<td>Cuts/Shapes</td>
<td>Groups according to cuts or shapes.</td>
</tr>
<tr>
<td>Automatic tagging</td>
<td>Defines how to display information in a dimension line.</td>
</tr>
<tr>
<td>Display tags</td>
<td>Displays tags.</td>
</tr>
<tr>
<td>Include part count in the tag</td>
<td>Includes part count in the tag.</td>
</tr>
<tr>
<td>Do not display marks for the grouped items</td>
<td>Does not display part marks for grouped items.</td>
</tr>
<tr>
<td>Available elements</td>
<td>Elements available to define identical conditions.</td>
</tr>
<tr>
<td>Add</td>
<td>Adds items to Selected elements list.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes items from <strong>Selected elements</strong> list.</td>
</tr>
<tr>
<td>Move up</td>
<td>Moves the element higher in the list.</td>
</tr>
<tr>
<td>Move down</td>
<td>Moves the element lower in the list.</td>
</tr>
<tr>
<td>Update grouping when model changes</td>
<td><strong>Yes</strong> updates dimension grouping automatically when the model changes.</td>
</tr>
</tbody>
</table>

**See also**

*Add automatic view-specific dimensions using dimensioning type Integrated (page 545)*

*Group identical objects to the same dimension line (page 547)*

**Dimensioning properties - Sub-assemblies tab (Integrated dimensioning)**

Use the options on the **Sub-assembly** tab of the **Assembly - Dimensioning Properties** dialog box to view and modify which dimensions to create and how for sub-assemblies.

Note that the contents of the dialog box vary depending on the drawing type, and all the options listed below are not available for all drawing types. This dialog box is displayed if you use **Integrated dimensions** dimensioning type in dimensioning.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimension parts inside sub-</td>
<td>Defines whether to dimension parts inside sub-assemblies.</td>
</tr>
<tr>
<td>assemblies</td>
<td><strong>Yes</strong> creates internal dimensions for parts inside sub-assemblies.</td>
</tr>
<tr>
<td></td>
<td><strong>No</strong> does not create internal dimensions for parts inside sub-assemblies.</td>
</tr>
<tr>
<td>Measure sub-assembly position from</td>
<td>Defines the position from which the sub-assembly is measured.</td>
</tr>
<tr>
<td></td>
<td><strong>None</strong> does not measure the sub-assembly position.</td>
</tr>
<tr>
<td></td>
<td><strong>Bolt</strong> measures the position of the sub-assembly from the bolts. If bolts</td>
</tr>
<tr>
<td></td>
<td>are not included in the sub-assembly, or if it is not possible to measure the</td>
</tr>
</tbody>
</table>

*Drawing settings reference* 721  *Dimension and dimensioning properties*
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>position from bolts, Tekla Structures measures the sub-assembly position from the reference point. <strong>Extreme points</strong> measures the position of the sub-assembly from the bounding box of the sub-assembly. <strong>Reference point</strong> measures the position of the sub-assembly from the reference point.</td>
<td></td>
</tr>
</tbody>
</table>

**See also**

Add automatic view-specific dimensions using dimensioning type Integrated (page 545)

**Dimensioning properties - Reinforcement dimensions tab (Integrated dimensioning)**

Use the **Reinforcement dimensions** tab in the Dimensioning Properties dialog box to view and modify the setting affecting the creation of reinforcement dimensions and how they are displayed.

This dialog box with this tab is displayed if you use **Integrated dimensions** dimensioning type in dimensioning cast unit drawings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions for reinforcing bar groups</td>
<td>On creates dimensions for reinforcing bar groups. This also activates the other selections on this tab.</td>
</tr>
</tbody>
</table>
| Mark location | Sets the mark type and location.  
- Selecting the first choice in the list creates dimension marks.  
- Selecting one of the other options in the list creates tagged dimension marks. The location of the tag is indicated by the small rectangle in the option. |
<p>| Edit mark contents | Opens the <strong>Dimension mark content</strong> dialog box where you can select what |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close dimension to binding geometry</td>
<td>Yes automatically adds closing dimensions to the edge of the part.</td>
</tr>
</tbody>
</table>

See also

Add automatic view-specific dimensions using dimensioning type Integrated (page 545)

Example: Reinforcement dimension (page 569)

**Dimensioning properties - Grid tab (GA drawings)**

Use the Grid tab in the General - Dimensioning Properties dialog box to view and modify settings for grid and overall dimensions in general arrangement drawings.

To open this dialog box:

- On the Drawings & reports tab, click Drawing properties --> GA drawings and click Dimensioning.
- In an open GA drawing, double-click the drawing background, and click Dimensioning.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid line dimensions</td>
<td>On creates grid dimension lines.</td>
</tr>
<tr>
<td>Overall dimensions</td>
<td>On creates the overall dimensions.</td>
</tr>
<tr>
<td>Dimension positioning: Horizontal</td>
<td>Positions the vertical grid and overall dimension lines to the Left or Right side of the drawing or on Both sides.</td>
</tr>
<tr>
<td>Dimension positioning: Vertical</td>
<td>Positions the horizontal grid and overall dimension lines Above or Below the drawing or Both.</td>
</tr>
</tbody>
</table>

See also

Add automatic dimensions to general arrangement drawings (page 584)

Example: Grid and overall dimensions (page 586)
Dimensioning properties - Parts tab (GA drawings)

Use the Parts tab in the General - Dimensioning Properties dialog box to view and modify settings for part dimensions in general arrangement drawings.

To open this dialog box:

- On the Drawings & reports tab, click Drawing properties --&gt; GA drawings and click Dimensioning.
- In an open GA drawing, double-click the drawing background, and click Dimensioning.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum leader line length: Outside dimensions</td>
<td>Controls how close the dimension lines are positioned to the parts they are dimensioning. Defines that the outside dimension lines take the maximum leader line length from the grid line.</td>
</tr>
<tr>
<td>Maximum leader line length: Inside dimensions</td>
<td>Controls how close the dimension lines are positioned to the parts they are dimensioning. Defines that the inside dimension lines take the maximum leader line length from the part reference point.</td>
</tr>
<tr>
<td>Include parts not entirely in view</td>
<td><strong>On</strong> dimensions the parts partly outside the view. <strong>Off</strong> will not dimension these parts.</td>
</tr>
<tr>
<td>Maximum number of outside dimensions</td>
<td>Specifies the maximum number of dimension lines allowed outside the grid. When you dimension different objects on different dimension lines, using this setting helps you to create cleaner drawings. Once the desired maximum is reached, Tekla Structures creates the dimensions inside the grid.</td>
</tr>
<tr>
<td>Object group dimensioning rules</td>
<td>Specifies different object groups to be dimensioned on different dimension lines.</td>
</tr>
<tr>
<td>Object group</td>
<td>The object group to be dimensioned.</td>
</tr>
<tr>
<td>Positioning</td>
<td><strong>No dimensions</strong> does not create dimensions for the parts. <strong>Inside grid</strong> creates dimensions next to or near the parts being dimensioned. All part dimensions are</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>placed inside the grid when the parts are inside the grid. The dimension will still be outside, even if you have selected <strong>Inside grid</strong> because of where the parts are in the end bay and the end being dimensioned to is next to the outside.</td>
</tr>
<tr>
<td></td>
<td><strong>Outside grid</strong> creates dimensions to parts and positions them outside the grid.</td>
</tr>
<tr>
<td></td>
<td><strong>Either</strong> creates dimensions to parts and positions them either inside or outside the grid depending on the part position and the setting of the option <strong>Maximum number of outside dimensions</strong>.</td>
</tr>
<tr>
<td></td>
<td>You must use the <strong>Either</strong> option if you define the <strong>Maximum number of outside dimensions</strong>, so that Tekla Structures can position dimensions inside the grid when the maximum number of dimensions is reached outside the grid.</td>
</tr>
</tbody>
</table>

**Horizontal position**

<table>
<thead>
<tr>
<th></th>
<th><strong>Left side</strong> positions all dimensions to horizontal parts to the left of the grid.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Right side</strong> positions all dimensions to horizontal parts to the right of the grid.</td>
</tr>
<tr>
<td></td>
<td><strong>Distributed to both sides</strong> positions all dimensions to horizontal parts to the grid nearest the part they are dimensioning.</td>
</tr>
</tbody>
</table>

**Vertical position**

<table>
<thead>
<tr>
<th></th>
<th><strong>Above</strong> positions all dimensions to vertical parts above the grid.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Below</strong> positions all dimensions to vertical parts below the grid.</td>
</tr>
<tr>
<td></td>
<td><strong>Distributed to both sides</strong> positions all dimensions to vertical parts to the grid nearest the part they are dimensioning.</td>
</tr>
</tbody>
</table>

**See also**

*Add automatic dimensions to general arrangement drawings (page 584)*
9.7 Mark properties

You can adjust the mark appearance and contents before creating a drawing and also in an open drawing.

Click the links below to find out more:

- Mark properties - General, Merging and Content tabs (page 726)
- Leader line types (page 730)
- Positioning properties of view label, section and detail marks (page 731)
- Drawing weld mark properties (page 732)
- Model weld mark visibility and appearance properties in drawings (page 734)
- Level mark properties (page 736)
- Mark elements (page 737)

Mark properties - General, Merging and Content tabs

Use the General, Merging and Content tabs in the Mark properties of different types of marks to view and modify the settings affecting the mark content and appearance. For some marks, the corresponding settings are located on the Contents and Appearance tabs.

Note that all the listed settings are not available for all marks.

To open this dialog box:

- On the Drawings & reports tab, click Drawing properties, select the drawing type and go to Mark properties.
- In an open drawing, double-click the drawing background, and go to Mark properties.
- Double-click a mark in an open drawing.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Frame around elements: Type and Color</strong></td>
<td>Defines the element frame type and color for one or several elements</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>element. To select all elements in the list to apply the same modification to all of them, hold down <strong>Shift</strong> and click the last element in the list.</td>
<td></td>
</tr>
<tr>
<td><strong>Add frame</strong></td>
<td>allows you to add frames around elements.</td>
</tr>
<tr>
<td><strong>Font: Color, Height and Font</strong></td>
<td>Defines the font type, color, and height used in element texts in one or several elements. To select all elements in the list to apply the same modification to all of them, hold down <strong>Shift</strong> and click the last element in the list.</td>
</tr>
<tr>
<td>Clicking <strong>Select</strong> gives more font choices.</td>
<td></td>
</tr>
<tr>
<td><strong>Units: Unit and Format</strong></td>
<td>Change the unit and format for the length, height, spacing or diameter element that you have selected from the <strong>Elements in mark</strong> list.</td>
</tr>
<tr>
<td><strong>General or Appearance</strong> tab:**</td>
<td></td>
</tr>
<tr>
<td><strong>Visible</strong></td>
<td><strong>In one view</strong> creates marks in one view only.</td>
</tr>
<tr>
<td></td>
<td><strong>In all views</strong> creates marks in all views.</td>
</tr>
<tr>
<td><strong>In main parts</strong></td>
<td>These options are for bolt marks.</td>
</tr>
<tr>
<td><strong>In secondary parts</strong></td>
<td><strong>Visible</strong> displays bolt marks.</td>
</tr>
<tr>
<td><strong>In sub-assembly main parts</strong></td>
<td><strong>Not visible</strong> does not display bolt marks.</td>
</tr>
<tr>
<td><strong>In sub-assembly secondary parts</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Visibility in view</strong></td>
<td><strong>distributed</strong> distributes the marks in the view. Tekla Structures only creates marks that are not visible in the other views.</td>
</tr>
<tr>
<td></td>
<td><strong>always</strong> always creates marks in the view, irrespective the settings in other views.</td>
</tr>
<tr>
<td></td>
<td><strong>preferred</strong> acts as <strong>distributed</strong>, but the preferred view has a higher priority.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>preferred</strong> to one view only in a drawing. If you set other views to <strong>distributed</strong>, the marks are located</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Option</td>
<td>only in the view that has the setting Visibility in view set to preferred. none creates no marks.</td>
</tr>
<tr>
<td>Parts out of view plane</td>
<td>This option is available only in view level properties.</td>
</tr>
<tr>
<td></td>
<td><strong>Visible</strong> displays marks outside of the view in the drawing. <strong>Not visible</strong> displays no marks outside the view.</td>
</tr>
<tr>
<td>Bolt size limit</td>
<td>This option is for bolt marks. Filters standard-sized bolt marks out of drawings. Tekla Structures does not display bolt marks of the size you enter here. There are several variables that affect the Bolt size limit, see the See also list below.</td>
</tr>
<tr>
<td>Merge marks</td>
<td>This option is for part marks and surface treatment marks. On merges marks.</td>
</tr>
<tr>
<td>Frame around mark: Type and Color</td>
<td>Define the frame to be used around marks, and the color of the frame.</td>
</tr>
<tr>
<td>Leader line: Type, Arrow and Use hidden lines for hidden parts.</td>
<td>Define the leader line type and line arrow type, and select to hide leader lines for hidden parts.</td>
</tr>
<tr>
<td>Place</td>
<td><strong>Placing: free</strong> allows Tekla Structures to search for the first suitable location for the mark.</td>
</tr>
<tr>
<td></td>
<td><strong>Placing: fixed</strong> allows you to place the mark in any location.</td>
</tr>
<tr>
<td></td>
<td>When you use the option fixed, the mark stays where it is even though you update the drawing, whereas with free, Tekla Structures tries to find the optimal place for the annotation object.</td>
</tr>
<tr>
<td></td>
<td><strong>Search margin</strong> is the distance within which Tekla Structures searches for a space to place a mark.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Minimal Distance</td>
<td><em>is the minimum distance of the mark from the part.</em></td>
</tr>
<tr>
<td>Quarter</td>
<td><em>defines the areas Tekla Structures searches for a space to place the mark.</em></td>
</tr>
</tbody>
</table>

Use the **Merging** tab in the **Cast Unit - Reinforcement Mark Properties** dialog box to view and modify the settings affecting the merging of the reinforcement marks in cast unit drawings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>One leader line to group</td>
<td><strong>One leader line to group</strong> creates one leader line for a group of reinforcing bars.</td>
</tr>
<tr>
<td>One leader line per row</td>
<td><strong>One leader line per row</strong> merges the marks and creates one leader line for a row of reinforcing bars.</td>
</tr>
<tr>
<td>Parallel leader lines</td>
<td><strong>Parallel leader lines</strong> merges the marks and creates parallel leader lines.</td>
</tr>
<tr>
<td>Leader lines to one point</td>
<td><strong>Leader lines to one point</strong> merges the marks and draws all leader lines to one point.</td>
</tr>
</tbody>
</table>
| No merge                     | **No merge** does not merge marks. Tekla Structures creates an individual leader line for each mark.  
If you select **No merge**, you still need to define the mark content for the marks that Tekla Structures automatically merges on the **Merging** tab. |
<p>| Preferred merge direction    | <strong>Merge vertically</strong> merges the marks in the vertical direction of the drawing. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Merge horizontally</td>
<td><img src="image.png" alt="Image" /></td>
<td>merges the marks in the horizontal direction of the drawing.</td>
</tr>
</tbody>
</table>

**See also**
- Mark elements (page 737)
- Automatic mark settings (page 600)
- Add automatic marks (page 602)
- Define view labels and view label marks (page 465)
- Modify section properties in drawings (page 167)
- Elements in merged reinforcement marks (page 745)
- Merge reinforcement marks automatically (page 619)
- Add part marks manually in drawings (page 215)

**Leader line types**
You can use leader lines with text, symbols, associative notes and marks to make it clearer to which item it is related to.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Click the links below to find out more</th>
</tr>
</thead>
<tbody>
<tr>
<td>Texts</td>
<td><img src="image.png" alt="Image" /></td>
<td>Add text in drawings (page 233)</td>
</tr>
<tr>
<td>Symbols</td>
<td><img src="image.png" alt="Image" /></td>
<td>Add symbols in drawings (page 351)</td>
</tr>
<tr>
<td>Level marks</td>
<td><img src="image.png" alt="Image" /></td>
<td>Add level marks in drawings (page 217)</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Click the links below to find out more</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Part marks</td>
<td>![Part Mark Icon]</td>
<td>Add automatic marks (page 602) Add part marks manually in drawings (page 215)</td>
</tr>
<tr>
<td>Revision marks</td>
<td>![Revision Mark Icon]</td>
<td>Add revision marks in drawings (page 239)</td>
</tr>
<tr>
<td>Surface treatment marks</td>
<td>![Surface Treatment Mark Icon]</td>
<td>Define automatic surface treatment in drawings (page 665)</td>
</tr>
<tr>
<td>Reinforcement marks</td>
<td>![Reinforcement Mark Icon]</td>
<td>Define automatic reinforcement and reinforcement mesh properties (page 670)</td>
</tr>
<tr>
<td>Associative notes</td>
<td>![Associative Note Icon]</td>
<td>Add associative notes in drawings (page 219)</td>
</tr>
</tbody>
</table>

**Positioning properties of view label, section and detail marks**

Use the **Position** tab in the **Mark Contents** dialog box in view properties to set the positioning options for view labels marks, section marks and detail marks.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show on</td>
<td>For section marks. Defines if the section marks are shown at both ends of the cut line or at the left or right end.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Text position</strong></td>
<td>Defines the position of the mark text in relation to the line or in relation to the symbol or symbol center line.</td>
</tr>
<tr>
<td>Horizontal offset</td>
<td>sets the horizontal offset of the mark text from the line.</td>
</tr>
<tr>
<td>Vertical offset</td>
<td>sets the vertical offset of the mark text from the line.</td>
</tr>
<tr>
<td><strong>Text rotation</strong></td>
<td>For section marks.</td>
</tr>
<tr>
<td></td>
<td>Defines the rotation of the mark text.</td>
</tr>
<tr>
<td><strong>Alignment</strong></td>
<td>For view label marks.</td>
</tr>
<tr>
<td></td>
<td>Defines if the view label mark is aligned to the center, right, or left.</td>
</tr>
</tbody>
</table>

**See also**
Define view labels and view label marks (page 465)
Modify section properties in drawings (page 167)

**Drawing weld mark properties**

In **Weld Mark Properties** dialog box you can view and modify the properties of a weld mark that has been manually added in a drawing.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prefix</td>
<td>a = design throat thickness, s = penetration throat thickness, or z = leg length</td>
</tr>
<tr>
<td>Size</td>
<td>The size of the weld.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of the weld.</td>
</tr>
<tr>
<td></td>
<td>You can customize some of the weld type symbols, see <strong>Customize weld type symbols (page 323)</strong> for more information.</td>
</tr>
<tr>
<td>Angle</td>
<td>The angle of weld preparation, bevels, or groove.</td>
</tr>
<tr>
<td></td>
<td>Tekla Structures displays the angle between the weld type symbol and the fill type contour symbol.</td>
</tr>
<tr>
<td>Contour</td>
<td>The fill type contour of a weld can be:</td>
</tr>
<tr>
<td></td>
<td>• None</td>
</tr>
<tr>
<td></td>
<td>• Flush ----</td>
</tr>
<tr>
<td></td>
<td>• Convex →</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Finish</strong></td>
<td>Tekla Structures displays the finish symbol above the weld type symbol in drawings. The options are:</td>
</tr>
<tr>
<td></td>
<td>• G (Grind)</td>
</tr>
<tr>
<td></td>
<td>• M (Machine)</td>
</tr>
<tr>
<td></td>
<td>• C (Chip)</td>
</tr>
<tr>
<td></td>
<td>• ☒️(Flush finished weld)</td>
</tr>
<tr>
<td></td>
<td>• ☐️(Smooth blended weld face)</td>
</tr>
<tr>
<td><strong>Length</strong></td>
<td>The length of a regular weld depends on the length of the connection between the welded parts. You can set the exact length of a polygon weld by, for example, defining the start and end points of the weld.</td>
</tr>
<tr>
<td><strong>Pitch</strong></td>
<td>The center-to-center spacing of welds for non-continuous welds. Pitch is shown in the weld mark if the value is greater than 0.0.</td>
</tr>
<tr>
<td></td>
<td>To create a non-continuous weld, define the center-to-center spacing and the pitch of the welds. Tekla Structures calculates the distance between the welds as the pitch minus the length of the weld.</td>
</tr>
<tr>
<td></td>
<td>By default, Tekla Structures uses the – character to separate weld length and pitch, for example, 50–100. To change the separator to @, for example, set the advanced option <code>XS_WELD_LENGTH_CC_SEPARATOR_CHAR</code> to @.</td>
</tr>
<tr>
<td><strong>Effective throat</strong></td>
<td>The weld size used in weld strength calculation.</td>
</tr>
<tr>
<td><strong>Root opening</strong></td>
<td>The space between the welded parts.</td>
</tr>
<tr>
<td><strong>Reference text</strong></td>
<td>Additional information to appear in the weld symbol. For example, information about the weld specification or process.</td>
</tr>
<tr>
<td><strong>Edge/Around</strong></td>
<td>Indicates whether only one edge or the entire perimeter of a face should be welded.</td>
</tr>
<tr>
<td></td>
<td>A circle in the weld symbol in drawings indicates the <strong>Around</strong> option has been used.</td>
</tr>
<tr>
<td><strong>Workshop/Site</strong></td>
<td>Indicates where the weld should be made.</td>
</tr>
</tbody>
</table>
### Option | Description
--- | ---
**Stitch weld** | Set this option to **Yes** to create a staggered, intermittent weld. Stitch welds are staggered on both sides of the welded part. Tekla Structures shows the weld type symbols as staggered in weld symbols. If you set this option to **No**, a non-staggered intermittent weld is created. To show the pitch in a weld mark, set **Pitch** to a value greater than 0.0.

**Placing** | **Search margin** is the farthest distance Tekla Structures uses when searching for an empty space for the weld mark. **Minimal distance** is the closest distance Tekla Structures uses to search for an empty space for a weld mark. **Quarter** defines the areas Tekla Structures searches for a space to place the weld marks. **Placing** is the method used to place welds marks:

- **Free** lets Tekla Structures decide the location and direction of the dimension based on the **Direction** settings.
- **Fixed** allows you to place the weld at any point.

---

**See also**

Add manual weld marks in drawings (page 322)

---

### Model weld mark visibility and appearance properties in drawings

You can select which model weld marks are visible in drawings, and define the content that is displayed in weld marks. In assembly drawings, you can define the visibility of welds in sub-assemblies.

Use options in the **Weld mark** panel (or **Welding Mark Properties** dialog box in general arrangement drawings) to set the visibility and contents of model weld marks.

**Single-part and assembly drawings**

1. On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type.
2. Click **View creation**, select the view and the properties that you want to change, and click **View properties**.
3. Click **Weld mark** in the options tree.

**General arrangement drawing**
1. Click **Drawings & reports --> Drawing properties --> GA drawing**.
2. Click **Weld mark**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Weld number</strong></td>
<td><strong>Yes</strong> shows the weld number. Tekla Structures assigns a number to each weld as the weld is created. You can select whether to show or hide the weld number.</td>
</tr>
<tr>
<td><strong>Welds</strong></td>
<td><strong>Not visible</strong> displays no welds in the drawing.</td>
</tr>
<tr>
<td><strong>Welds in sub-assemblies</strong></td>
<td><strong>Site weld visible</strong> displays only site welds in the drawing.</td>
</tr>
<tr>
<td></td>
<td><strong>Workshop weld visible</strong> displays only workshop welds in the drawing.</td>
</tr>
<tr>
<td></td>
<td><strong>Both visible</strong> displays both site welds and workshop welds in the drawing.</td>
</tr>
<tr>
<td><strong>Weld size limit</strong></td>
<td>Enter a weld size to filter welds of that size out of the drawing. This is useful when you only want to show non-typical welds in a drawing.</td>
</tr>
<tr>
<td></td>
<td>To set whether the weld size limit is an exact or minimum value, use the advanced option <strong>XS_WELD_FILTER_TYPE</strong>.</td>
</tr>
<tr>
<td></td>
<td>To filter out a standard weld types, use the advanced option <strong>XS_OMITTED_WELD_TYPE</strong>.</td>
</tr>
<tr>
<td><strong>Above line, Below line and Other</strong></td>
<td>If there is no check mark in the <strong>Visible</strong> column next to the following properties, the properties are not displayed in the weld mark:</td>
</tr>
<tr>
<td></td>
<td><strong>Prefix</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Size</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Type</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Angle</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Contour</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Finish</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Length</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Pitch</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Effective throat</strong></td>
</tr>
</tbody>
</table>

Drawing settings reference 735 Mark properties
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Root opening</td>
<td></td>
</tr>
<tr>
<td>Reference text</td>
<td></td>
</tr>
<tr>
<td>Edge/Around</td>
<td></td>
</tr>
<tr>
<td>Workshop/Site</td>
<td></td>
</tr>
</tbody>
</table>

**Place**

- **Search margin** is the distance within which Tekla Structures searches for a space to place a mark.
- **Quarter** defines the areas Tekla Structures searches for a space for placing the level mark.
- **Minimal Distance** is the minimum distance of the mark from the part.

**Text: Color**

Sets the color of the text.

**Text: Height**

Sets the height of the text.

**Text: Font**

Sets the font of the text. Click **Select** to show more options.

**Line: Type**

Sets the type of the line.

**Line: Color**

Sets the color of the line.

**See also**

- Welds in drawings (page 306)
- Examples: Model welds in drawings (page 310)
- Modify model weld mark visibility and appearance in a drawing (page 316)

**Level mark properties**

Use the options in the **Level mark properties** dialog box to view and modify level mark contents and appearance.

To open the dialog box in an open drawing, go to the **Drawing** tab, and click **Properties --> Level mark**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prefix</td>
<td>Displays text before the mark.</td>
</tr>
<tr>
<td>Prefix for positive level</td>
<td>+ displays a + character in front of the value.</td>
</tr>
<tr>
<td>Visibility of numeric value</td>
<td>Defines if the numeric values are visible or hidden.</td>
</tr>
<tr>
<td>Postfix</td>
<td>Displays text after the mark.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Precision</td>
<td>Defines the precision of the level mark dimension.</td>
</tr>
<tr>
<td>Format</td>
<td>Defines the format of the level mark dimension.</td>
</tr>
<tr>
<td>Use grouping</td>
<td>Defines whether to use different grouping options to represent the level mark dimensions.</td>
</tr>
<tr>
<td>Units</td>
<td>Defines the units used in level mark dimensions. The available values are automatic, mm, cm, m, foot - inch, inch and feet.</td>
</tr>
<tr>
<td>Placing</td>
<td><strong>Search margin</strong> is the farthest distance Tekla Structures uses when searching for an empty space for the level mark.</td>
</tr>
<tr>
<td></td>
<td><strong>Minimal distance</strong> is the closest distance Tekla Structures uses to search for an empty space for a level mark.</td>
</tr>
<tr>
<td></td>
<td><strong>Quarter</strong> defines the areas Tekla Structures searches for a space to place the level marks.</td>
</tr>
<tr>
<td></td>
<td><strong>Placing</strong> is the method used to place level marks:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Free</strong> lets Tekla StructuresTekla Structures decide the location of the level mark.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Fixed</strong> allows you to place the level mark at any point.</td>
</tr>
</tbody>
</table>

**See also**

Add level marks in drawings (page 217)

### 9.8 Mark elements

The elements and options selected on the mark properties **Content** tab define the contents of the marks in drawings.

To add marks to a drawing automatically using the drawing properties, see Add automatic marks (page 602).
To add part marks manually in an open drawing, see Add part marks manually in drawings (page 215).

To add marks manually in reinforcement, see Add reinforcement marks manually in drawings (page 216)

Click the links below to find out more:

- Common elements in marks (page 738)
- Part mark elements (page 739)
- Bolt mark elements (page 741)
- Reinforcement and neighbor reinforcement mark elements (page 742)
- Reinforcement and neighbor reinforcement mesh mark elements (page 744)
- Pour object mark elements (page 746)
- Elements in merged reinforcement marks (page 745)
- Connection mark elements (page 746)
- Surface treatment mark elements (page 747)
- Section and detail mark elements (page 748)
- View, section view and detail view label mark elements (page 748)

Common elements in marks
There are some mark elements that can be used in most of the mark types.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User-defined attributes</td>
<td>Available for building object marks. Adds a user-defined attribute to the mark. You can also use template fields for user-defined attributes. In marks, you cannot use template attributes such as MODEL_TOTAL that refer to the whole model. Marks only check the information from the object in the drawing and not from the whole model. For more information about adding user-defined attributes in marks, see Add attributes in automatic marks (page 624).</td>
</tr>
<tr>
<td>Element</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Text</td>
<td>Opens a dialog box where you can enter text in the mark. The maximum number of characters is 255.</td>
</tr>
<tr>
<td>Symbol</td>
<td>Opens a dialog box where you can change the symbol file in use and select a symbol from the Tekla Structures symbol file to add to the mark.</td>
</tr>
<tr>
<td><code>&lt; &gt;</code></td>
<td>Adds spaces between mark elements.</td>
</tr>
<tr>
<td><code>&lt;--'</code></td>
<td>Adds a line feed between the elements to create multi-row marks. The default space between the lines depends on the text height and can be changed with the advanced option <code>XS_MARK_ELEMENT_SPACE_FACTOR</code>.</td>
</tr>
<tr>
<td><code>&lt;--</code></td>
<td>Adds a backspace between the desired elements to remove the default space between them. The default space between the elements depends on the text height and can be changed with the advanced option <code>XS_MARK_ELEMENT_SPACE_FACTOR</code>.</td>
</tr>
<tr>
<td>Template</td>
<td>Available for building object marks. Adds in the mark a custom graphical template created with Template Editor. Opens a dialog box where you can select the template. For more information about adding templates in marks, see Add templates in marks (page 628).</td>
</tr>
</tbody>
</table>

**Part mark elements**

You can define part mark contents independently for main and secondary parts and for sub-assembly main and secondary parts.

The following table lists all elements specific to part marks and neighbor part marks. Some of the available elements are not listed here, because they are common to many types of marks, and listed separately (page 738).

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assembly position</td>
<td>Adds the prefix and position number of the assembly.</td>
</tr>
<tr>
<td>Element</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Part position</td>
<td>Adds the prefix and position number of the part.</td>
</tr>
<tr>
<td>Profile</td>
<td>Adds the profile name of part, assembly, or cast unit main part.</td>
</tr>
<tr>
<td>Material</td>
<td>Adds the material of part, assembly, or cast unit main part.</td>
</tr>
<tr>
<td>Name</td>
<td>Adds the name of part, assembly, or cast unit main part.</td>
</tr>
<tr>
<td>Class</td>
<td>Adds the class of part, assembly, or cast unit main part.</td>
</tr>
<tr>
<td>Finish</td>
<td>Adds the finish of part, assembly, or cast unit main part.</td>
</tr>
<tr>
<td>Size</td>
<td>Adds the size of the part or the assembly or cast unit main part.</td>
</tr>
<tr>
<td>Length</td>
<td>Adds the length of the part or assembly, or of the cast unit main part.</td>
</tr>
<tr>
<td></td>
<td>You can change the unit and format of the length.</td>
</tr>
<tr>
<td>Camber</td>
<td>Adds the camber of the part or the assembly or cast unit main part (if this user-defined part attribute is set).</td>
</tr>
<tr>
<td>Fittings (NS/FS)</td>
<td>Displays the near side/far side marks in the part mark. (only available in front views).</td>
</tr>
</tbody>
</table>
| Face direction         | Displays main compass direction (North, East, South, West) of the face, where the mark is added. The direction can only be shown if • the face is vertical • the direction is the same for all assemblies with the same assembly position number In other cases, the element produces no text to mark. Furthermore, face direction is not shown for columns in general arrangement drawings, if you have set **Mark always to center of column in GA drawings to Yes** in **File menu --> Settings --> Options --> Orientation marks**.
<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gage of outstanding leg</td>
<td>Adds the hole gage. You can control the format of this option with the advance option XS_GAGE_OF_OUTSTANDING_LEG_STRING.</td>
</tr>
<tr>
<td>Center-to-center distance</td>
<td>Adds center-to-center distance in the mark. You can control the format of this option with the advanced options XS_CENTER_TO_CENTER_DISTANCE_IN_ONE_PART_STRING and XS_CENTER_TO_CENTER_DISTANCE_IN_TWO_PARTS_STRING.</td>
</tr>
</tbody>
</table>

**Bolt mark elements**

You can define bolt mark options independently for site and shop bolts.

Below is a list of the elements specific to bolt marks. Some of the available elements are not listed here, because they are common to many types of marks, and listed separately (page 738).

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bolt length</td>
<td>Adds the length of the bolt. You can change the unit and format of the length.</td>
</tr>
<tr>
<td>Bolt diameter</td>
<td>Adds the bolt diameter. You can change the unit and format of the diameter.</td>
</tr>
<tr>
<td>Hole diameter</td>
<td>Adds the hole diameter. You can change the unit and format of the diameter.</td>
</tr>
<tr>
<td>Material</td>
<td>Adds the bolt material grade.</td>
</tr>
<tr>
<td>Standard</td>
<td>Adds the bolt standard.</td>
</tr>
<tr>
<td>Short name</td>
<td>Adds the bolt's short name. This can be the commercial name of a specific bolt, for example.</td>
</tr>
<tr>
<td>Full name</td>
<td>Adds the complete name of the bolt. This name is visible in the dialog box list.</td>
</tr>
<tr>
<td>Element</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assembly type</td>
<td>Adds the bolt assembly type.</td>
</tr>
<tr>
<td>Number of bolts</td>
<td>Adds the quantity of bolts.</td>
</tr>
<tr>
<td>Slot length (x, y)</td>
<td>Adds the slot length in the x or y direction. You can change the unit and format of the length.</td>
</tr>
<tr>
<td>Slot length</td>
<td>Adds the slot length. You can change the unit and format of the length.</td>
</tr>
<tr>
<td>Slot height</td>
<td>Adds the slot height. You can change the unit and format of the height.</td>
</tr>
<tr>
<td>Size</td>
<td>Adds the hole size. You can change the unit and format of the size.</td>
</tr>
<tr>
<td>Countersunk</td>
<td>Adds countersink in the countersunk bolt marks.</td>
</tr>
<tr>
<td>Gage of outstanding leg</td>
<td>Adds hole gage. You can control the format of this element with the advanced option XS_GAGE_OF_OUTSTANDING_LEG_STRING.</td>
</tr>
<tr>
<td>Center-to-center distance</td>
<td>Adds center-to-center distance. You can control the format of this element with the advanced options XS_CENTER_TO_CENTER_DISTANCE_IN_ONE_PART_STRING and XS_CENTER_TO_CENTER_DISTANCE_IN_TWO_PARTS_STRING.</td>
</tr>
</tbody>
</table>

See also

Define size in bolt marks using advanced options (page 634)

Reinforcement and neighbor reinforcement mark elements
You can define mark contents separately for single reinforcing bars, bar groups, and reinforcement meshes.

Below is a list of the elements you can include in all reinforcement and neighbor reinforcements marks. Some of the available elements are not listed
here, because they are common to many types of marks, and listed separately (page 738).

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Adds the name of the bar or mesh.</td>
</tr>
<tr>
<td>Grade</td>
<td>Adds the material grade of the bar or mesh.</td>
</tr>
<tr>
<td>Diameter</td>
<td>Adds the nominal diameter of the bar.</td>
</tr>
<tr>
<td>Class</td>
<td>Adds the class of the bar or mesh.</td>
</tr>
<tr>
<td>Length</td>
<td>Adds the total length of the bar.</td>
</tr>
<tr>
<td></td>
<td>You can change the unit and format of the length.</td>
</tr>
<tr>
<td>Number</td>
<td>Adds the quantity of the bars.</td>
</tr>
<tr>
<td>Position</td>
<td>Adds the reinforcement position number.</td>
</tr>
<tr>
<td>Shape</td>
<td>Adds the shape of the bar or mesh.</td>
</tr>
<tr>
<td>Weight</td>
<td>Adds the weight of the bar or mesh.</td>
</tr>
<tr>
<td>cc</td>
<td>Adds the center-to-center spacing of the bars. The options are:</td>
</tr>
<tr>
<td></td>
<td>• cc adds the spacing value if spacing does not vary</td>
</tr>
<tr>
<td></td>
<td>• cc min adds the smallest spacing value of the bar group if spacing varies</td>
</tr>
<tr>
<td></td>
<td>• cc max adds the largest spacing value of the bar group if spacing varies</td>
</tr>
<tr>
<td></td>
<td>• cc exact lists all spacing values of the bar group</td>
</tr>
<tr>
<td></td>
<td>• cc target lists all reinforcing bar target spacing values</td>
</tr>
<tr>
<td></td>
<td>You can change the unit and format of the cc options.</td>
</tr>
<tr>
<td>Pull-out picture</td>
<td>Adds a pull-out picture of a bar to the mark.</td>
</tr>
<tr>
<td></td>
<td>For more information about pull-out pictures, see Add pull-out pictures in automatic reinforcement marks (page 637)</td>
</tr>
</tbody>
</table>
Reinforcement and neighbor reinforcement mesh mark elements
You can define mark contents separately for reinforcement meshes.

The following elements are specific to the reinforcement and neighbor reinforcement mesh marks, other elements are the same as for reinforcement marks (page 742). Some of the available elements are not listed here, because they are common to many types of marks, and listed separately (page 738).

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>Adds the nominal diameters of the mesh bars, dimensions of the mesh, and the spacings of the bars in the longitudinal and crossing directions.</td>
</tr>
<tr>
<td>Mesh length</td>
<td>Adds the length of the reinforcement mesh.</td>
</tr>
<tr>
<td>Mesh width</td>
<td>Adds the width of the reinforcement mesh.</td>
</tr>
<tr>
<td>cc</td>
<td>You can define cc individually for the longitudinal and crossing bars in the mesh. Adds the center-to-center spacing of the bars. The options are:</td>
</tr>
<tr>
<td></td>
<td>• cc longitudinal/crossing adds the spacing value if spacing does not vary</td>
</tr>
<tr>
<td></td>
<td>• cc min longitudinal/crossing adds the smallest spacing value of the bar group if spacing varies</td>
</tr>
<tr>
<td></td>
<td>• cc max longitudinal/crossing adds the largest spacing value of the bar group if spacing varies</td>
</tr>
<tr>
<td></td>
<td>• cc exact longitudinal/crossing lists all spacing values of the bar group</td>
</tr>
<tr>
<td></td>
<td>• cc target longitudinal/crossing lists all reinforcing bar target spacing values</td>
</tr>
<tr>
<td>Element</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Diameter longitudinal</td>
<td>Adds the diameter or size of the longitudinal bars.</td>
</tr>
<tr>
<td>Diameter cross</td>
<td>Adds the diameter or size of the crossing bars.</td>
</tr>
</tbody>
</table>

**See also**

*Add automatic marks (page 602)*

**Elements in merged reinforcement marks**

Some extra elements are available for merged reinforcement marks, in addition to basic reinforcement marks.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block prefix</td>
<td>Adds text or a value to the beginning of each repeated block. Opens a dialog box where you can enter the prefix. You can use the following variables as block prefixes: %NUMBER% includes the number of marks merged to the mark. %NUMBER_IN_PLANE% includes the number of marks merged in the plane of the drawing to the mark. %NUMBER_OUT_OF_PLANE% includes the number of marks merged in the depth direction of the drawing to the mark.</td>
</tr>
<tr>
<td>Single mark content</td>
<td>Adds the content of the single reinforcement mark selected on the Content tab to the mark.</td>
</tr>
<tr>
<td>Distance between groups</td>
<td>Adds the center-to-center distances between reinforcing bars or bar groups included in a merged mark.</td>
</tr>
<tr>
<td>Symbol separating blocks in mark</td>
<td>Adds a symbol between the blocks in the merged mark. Opens a dialog box where you can define the symbol. The elements that appear before this element on the mark content list generate a block.</td>
</tr>
</tbody>
</table>
Connection mark elements
In connection marks, you can show the connection code, name, number, and running number, the group they belong to, potential errors, and the related DSTV code.

Below is a list of elements specific to connection marks. Some of the available elements are not listed here, because they are common to many types of marks, and listed separately (page 738).

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>Adds the connection code. This is a user-defined code you give for the connection in the connection dialog box. The code can be either a text string or a number.</td>
</tr>
<tr>
<td>Name</td>
<td>Adds the connection name, for example, Tube_splice.</td>
</tr>
<tr>
<td>DSTV code</td>
<td>Adds the DSTV code.</td>
</tr>
<tr>
<td>Connection number</td>
<td>Adds the number of the connection.</td>
</tr>
<tr>
<td>Running number</td>
<td>Adds the connection running number. All connections are automatically numbered with a running number.</td>
</tr>
<tr>
<td>Group</td>
<td>Adds the connection group.</td>
</tr>
<tr>
<td>Connection error</td>
<td>Adds the connection error. The numbers correspond to the connection symbol colors:</td>
</tr>
<tr>
<td></td>
<td>• 1 = green</td>
</tr>
<tr>
<td></td>
<td>• 2 = yellow</td>
</tr>
<tr>
<td></td>
<td>• 3 = red symbol</td>
</tr>
</tbody>
</table>

See also
Add automatic marks (page 602)
Pour object mark elements
Pour objects have some mark elements of their own, in addition to common mark elements (Text, Symbol, User-defined attribute, Template).

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material</td>
<td>Adds the defined pour material.</td>
</tr>
<tr>
<td>Pour number</td>
<td>Adds the identifier that groups the pours in the same group, for example, to be poured at the same time.</td>
</tr>
<tr>
<td>Pour type</td>
<td>Adds a property of the pour based on the name of a part. For details, see About the pour type property.</td>
</tr>
<tr>
<td>Concrete mixture</td>
<td>Adds the defined concrete mixture.</td>
</tr>
</tbody>
</table>

See also
Common elements in marks (page 738)

Surface treatment mark elements
In surface treatment marks, you can show the name, material, Tekla Structures-specific name, and the code of the surface treatment.

Here is a list of elements specific to surface treatment marks. Some of the available elements are not listed here, because they are common to many types of marks, and listed separately (page 738).

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Adds the name defined in the Name box in the Surface treatment properties dialog box in a model.</td>
</tr>
<tr>
<td>Material</td>
<td>Adds the surface treatment material.</td>
</tr>
<tr>
<td>Class</td>
<td>Adds the class of the surface treatment.</td>
</tr>
<tr>
<td>Code</td>
<td>Adds the code of the surface treatment.</td>
</tr>
<tr>
<td>Surface treatment name</td>
<td>Adds the name selected from the Surface treatment name list in the Surface treatment properties dialog box in a model.</td>
</tr>
</tbody>
</table>

See also
Add automatic marks (page 602)
Section and detail mark elements

In section and detail marks, you can show the name of the section/detail, the name of the current drawing, and the name of the source drawing.

Below is a list of elements specific to section and detail marks. Some of the available elements are not listed here, because they are common to many types of marks, and listed separately (page 738).

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section name/Detail name</td>
<td>Adds the name of the section or the detail (A, B, C, and so on).</td>
</tr>
<tr>
<td>Drawing name</td>
<td>Adds the name of the current drawing.</td>
</tr>
<tr>
<td>Source drawing name</td>
<td>Adds the name of the drawing where the view is.</td>
</tr>
<tr>
<td>Source drawing name when moved</td>
<td>Adds the name of the drawing where the view is. This is shown only if the view is not in the same drawing as the section/detail mark.</td>
</tr>
</tbody>
</table>

See also

Modify section properties in drawings (page 167)
Positioning properties of view label, section and detail marks (page 731)

View, section view and detail view label mark elements

In view labels, you can show the name of the view, section or detail, the view scale, drawing name, and source drawing name.

Below is a list of the elements specific to view, section view and detail view label marks. Some of the available elements are not listed here, because they are common to many types of marks, and listed separately (page 738).

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View name/Section name/Detail name</td>
<td>Adds the name of the view, section or the detail.</td>
</tr>
<tr>
<td>Scale</td>
<td>Adds the scale of the view.</td>
</tr>
<tr>
<td>Drawing name</td>
<td>Adds the name of the current drawing.</td>
</tr>
<tr>
<td>Source drawing name</td>
<td>Adds the name of the drawing where the view has originally been created.</td>
</tr>
</tbody>
</table>
### Source drawing name when moved

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source drawing name when moved</td>
<td>Adds the name of the drawing where the view has originally been created. This is shown only when the view has been moved from its original drawing.</td>
</tr>
</tbody>
</table>

**See also**

*Define view labels and view label marks (page 465)*  
*Positioning properties of view label, section and detail marks (page 731)*

## 9.9 Part and neighbor part properties in drawings

Use the options in **Part** properties or **Neighbor part** properties to check and change the part or neighbor part properties. In **Neighbor part** properties you can also control the visibility and appearance of neighbor part bolts.

To go to part or neighbor part properties:

- On the **Drawings & reports** tab, click **Drawing properties**, select the drawing type and go to **Part/Neighbor part** properties.

- In an open drawing, double-click the drawing view frame, select **View creation**, select a view, click **View properties** and click **Part/Neighbor part**. In GA drawings, just double-click the view frame and click **Part/Neighbor part**.

- In an open drawing, double-click the drawing background, and go to **Part/Neighbor part** properties.

- Double-click a part or neighbor part in an open drawing.

All part properties do not contain all of the settings listed below.

**Content** tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Part representation     | **Outline** shows parts as solid objects.  
**Exact** shows parts as solid objects. This choice also draws the fillet edges and chamfers in the profile cross sections. For some profiles, **Outline** shows them as well.  
**Symbol** draws parts as lines.  
**Symbol with partial profile** shows a partial profile of the part. The length of the partial profile is fixed to 1000 mm. |

Drawing settings reference | Part and neighbor part properties in drawings | 749
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Workshop form</strong></td>
<td>draws round tube profiles as wrap-around templates.</td>
</tr>
<tr>
<td><strong>Bounding box</strong></td>
<td>draws parts as boxes surrounding the actual profiles.</td>
</tr>
<tr>
<td><strong>Base box</strong></td>
<td>shows parts as boxes and uses the $h$ and $b$ values from the profile catalog as box dimensions.</td>
</tr>
<tr>
<td><strong>Symbol offset</strong></td>
<td>Defines the distance of the end points of reference lines and center lines from the end points of the object.</td>
</tr>
<tr>
<td><strong>Inner contours</strong></td>
<td>Shows the inner contours of a tube.</td>
</tr>
<tr>
<td><strong>Hidden lines</strong></td>
<td>If the <strong>Hidden lines</strong> check box is selected, Tekla Structures shows hidden lines in secondary and neighbor parts. If the <strong>Own hidden lines</strong> check box is selected, Tekla Structures shows hidden lines in main parts.</td>
</tr>
<tr>
<td><strong>Center line</strong></td>
<td>Select whether you want to show center lines.</td>
</tr>
<tr>
<td></td>
<td>Select the <strong>Main part &gt; Beam, Plate</strong> or <strong>Polygon</strong> check box to show center lines in main parts.</td>
</tr>
<tr>
<td></td>
<td>Select the <strong>Secondary part &gt; Beam, Plate</strong> or <strong>Polygon</strong> check box to show center lines in secondary parts.</td>
</tr>
<tr>
<td><strong>Reference lines</strong></td>
<td>Select whether you want to show reference lines.</td>
</tr>
<tr>
<td></td>
<td>Select the <strong>Main part &gt; Beam, Plate</strong> or <strong>Polygon</strong> check box to show reference lines in main parts.</td>
</tr>
<tr>
<td></td>
<td>Select the <strong>Secondary part &gt; Beam, Plate</strong> or <strong>Polygon</strong> check box to show reference lines in secondary parts.</td>
</tr>
<tr>
<td><strong>Additional marks</strong></td>
<td>Select the following check boxes to show additional marks in drawings:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Orientation marks</strong> shows orientation marks (page 649).</td>
</tr>
<tr>
<td></td>
<td>• <strong>Connecting side marks</strong> shows connecting side marks (page 650).</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Pop-marks</strong></td>
<td>shows pop-marks defined in NC settings.</td>
</tr>
<tr>
<td><strong>Edge chamfers</strong></td>
<td>shows edge chamfers (page 288).</td>
</tr>
<tr>
<td><strong>Fillet edges</strong></td>
<td>shows fillet edges (page 293).</td>
</tr>
<tr>
<td><strong>Bolt representation</strong> (neighbor parts)</td>
<td>Select bolt representation. The options are <strong>Solid</strong>, <strong>Exact Solid</strong>, <strong>Symbol</strong>, <strong>Symbol 2</strong>, <strong>Symbol 3</strong>, <strong>DIN symbol</strong>, and <strong>User-defined symbol</strong>. DIN symbol corresponds to German standards (DIN). The only DIN symbols you can control are: Select whether to include hole or axis in the symbol.</td>
</tr>
<tr>
<td><strong>Symbol content</strong> (neighbor parts)</td>
<td>Select whether to include hole or axis in the symbol.</td>
</tr>
<tr>
<td><strong>Neighbor parts</strong></td>
<td>None does not show neighbor parts.</td>
</tr>
<tr>
<td><strong>Connected parts</strong></td>
<td>shows all parts connected to the model object.</td>
</tr>
</tbody>
</table>

Drawing settings reference 751 Part and neighbor part properties in drawings
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connecting parts</td>
<td>Shows only the parts the model object is connected to.</td>
</tr>
<tr>
<td>All components</td>
<td>Combines the Connected parts and the Connecting parts options.</td>
</tr>
<tr>
<td>By extreme</td>
<td>Shows all parts within the boundaries of the main and secondary part.</td>
</tr>
<tr>
<td>Main/Secondary parts</td>
<td><strong>Main parts</strong> shows only neighbor parts that make the main part of an assembly or a cast unit.</td>
</tr>
<tr>
<td></td>
<td><strong>Secondary parts</strong> shows only neighbor parts that are secondary parts of an assembly or a cast unit.</td>
</tr>
<tr>
<td></td>
<td><strong>Both</strong> shows both main and secondary parts.</td>
</tr>
<tr>
<td>Skew parts</td>
<td><strong>Yes</strong> shows skew parts as neighbor parts in the drawing, <strong>No</strong> does not.</td>
</tr>
<tr>
<td>Bolts</td>
<td><strong>Yes</strong> shows the bolts in the neighbor parts, <strong>No</strong> does not.</td>
</tr>
</tbody>
</table>

The **Appearance** tab is similar in all of the properties of all kinds of building objects (parts, neighbor parts, bolts, welds, surface treatments, reinforcement, and meshes).

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visible lines</td>
<td>Sets the <strong>Color</strong> and <strong>Type</strong> of the visible lines.</td>
</tr>
<tr>
<td>Hidden lines, Center line</td>
<td>Sets the <strong>Color</strong> and <strong>Type</strong> of the hidden lines.</td>
</tr>
<tr>
<td></td>
<td>Sets the <strong>Color</strong> of the center lines.</td>
</tr>
<tr>
<td>Reference lines</td>
<td>Sets the <strong>Color</strong> and <strong>Type</strong> of the reference lines.</td>
</tr>
<tr>
<td>Text: Color</td>
<td>Sets the <strong>Color</strong> of the text.</td>
</tr>
<tr>
<td>Text: Height</td>
<td>Sets the <strong>Height</strong> of the text.</td>
</tr>
<tr>
<td>Text: Font</td>
<td>Sets the <strong>Font</strong> of the text. Click <strong>Select</strong> to show more options.</td>
</tr>
<tr>
<td>Line: Type</td>
<td>Sets the <strong>Type</strong> of the line.</td>
</tr>
<tr>
<td>Line: Color</td>
<td>Sets the <strong>Color</strong> of the line.</td>
</tr>
<tr>
<td>Bolts: Color</td>
<td>Sets the color of the bolts in neighbor parts.</td>
</tr>
</tbody>
</table>

Drawing settings reference 752 Part and neighbor part properties in drawings
Both parts and neighbor parts have a **Fill** tab. To add a fill for outer part faces, use the **Part faces** area, and to add a fill to cross sections in section views, use the **Sections** area.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Type**  | Defines the fill type. Clicking the button next to the list opens a preview of the hatch patterns (page 656).  
**Automatic** selects the fill type automatically from the hatch pattern schema files.  
**None** uses no fill.                                                                                           |
| **Color** | Defines the color for the fill.  
You can select a predefined color or use **Special** color that is not converted to black in printouts.                                                                                                  |
| **Background** | Defines the background color for the fill.  
Background color selection is disabled for hardware hatches.  
Background color can be set for automatic hatches, but it has effect only if automatic hatch is not defined for the material in the hatch pattern schema file. |
| **Scale** | **Automatic** scales and rotates the fill automatically.  
**Custom** allows you to select scaling and rotation manually.  
**Scaling in direction x** and **Scaling in direction y** define the scales in x and y direction.  
**Keep ratio of x and y** retains the relative proportions in the hatch pattern.  
**Angle** rotates the fill. Angle 0.0 is for horizontal and 90.0 for vertical. |

**See also**
- Define automatic drawing part properties (page 642)
- Define automatic neighbor part properties (page 644)
9.10 Bolt content and appearance properties in drawings

Use the options in bolt properties to check or change the bolt content and appearance.

To go to bolt properties:

- On the Drawings & reports tab, click Drawing properties, select the drawing type and go to Bolt properties.
- In an open drawing, double-click the drawing background, and go to Bolt properties.
- Double-click a bolt in an open drawing.

All bolt properties dialog boxes do not contain all of the settings listed below.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solid/symbol</td>
<td>The options are Solid, Exact Solid, Symbol, Symbol 2, Symbol 3, DIN symbol, and User-defined symbol. DIN symbol corresponds to German standards (DIN). The only DIN symbols you can control are:</td>
</tr>
<tr>
<td></td>
<td>• Symbol 24 for normal workshop bolts</td>
</tr>
<tr>
<td></td>
<td>• Symbol 25 for normal site bolts</td>
</tr>
<tr>
<td></td>
<td>• Symbol 26 for front countersunk site bolts</td>
</tr>
<tr>
<td></td>
<td>• Symbol 27 for back countersunk site bolts</td>
</tr>
<tr>
<td></td>
<td>• Symbol 28 for front countersunk workshop bolts</td>
</tr>
<tr>
<td></td>
<td>• Symbol 29 for back countersunk workshop bolts</td>
</tr>
<tr>
<td></td>
<td>• Symbol 30 for front countersunk holes</td>
</tr>
<tr>
<td></td>
<td>• Symbol 31 for back countersunk holes</td>
</tr>
<tr>
<td></td>
<td>User-defined symbol is a symbol that has been created in Symbol Editor.</td>
</tr>
<tr>
<td>Symbol content</td>
<td>Indicates whether to include the Hole and Axis symbols in the drawing.</td>
</tr>
</tbody>
</table>
## Option Description

**Visibility**  
Control the visibility of bolts in main parts, secondary parts and sub-assemblies separately. **Visible** shows bolt group holes in main parts or secondary parts. **Not visible** hides them. In assembly drawings you can also define whether to show or hide bolt group holes in sub-assemblies.

**Color**  
Change the bolt color.

### See also
- Automatic bolt settings in drawings (page 651)
- Part and neighbor part properties in drawings (page 749)
- Define automatic bolt properties in drawings (page 652)

### 9.11 Surface treatment visibility and content properties in drawings

Use the options in surface treatment properties to check or change the surface treatments drawing properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Visibility</strong></td>
<td><strong>Visible</strong> shows the surface treatment. <strong>Not visible</strong> does not show the</td>
</tr>
<tr>
<td></td>
<td>surface treatment.</td>
</tr>
<tr>
<td><strong>Representation</strong></td>
<td>Defines the appearance of the surface treatment. The available options are</td>
</tr>
<tr>
<td></td>
<td><strong>Outline</strong>, <strong>Exact</strong>, <strong>Workshop form</strong>, <strong>Symbol</strong>, <strong>Bounding box</strong>, and</td>
</tr>
<tr>
<td></td>
<td><strong>Base box</strong>.</td>
</tr>
<tr>
<td><strong>Show pattern</strong></td>
<td>Defines whether the hatch pattern is shown.</td>
</tr>
<tr>
<td><strong>Hidden lines</strong></td>
<td>Defines whether hidden lines in secondary and neighboring parts are shown.</td>
</tr>
<tr>
<td><strong>Own hidden lines</strong></td>
<td>Defines whether hidden lines in main parts are shown.</td>
</tr>
</tbody>
</table>

### See also
- Automatic surface treatment in drawings (page 665)
9.12 Surface treatment hatch pattern properties (surfacing.htc)

You can change the properties of the hatch patterns for each surface treatment type separately.

The properties of the hatch patterns are defined in the surfacing.htc file, located by default in ..\Tekla Structures\<version>\environments \common\system. In addition to this file, the surface treatment code file product_finishes.dat is needed. It is located in the same folder.

If you create your own surface treatment hatch patterns in your company, you can store surfacing.htc and product_finishes.dat in the firm folder defined by the advanced option XS_FIRM.

Note:

**NOTE** When you edit a schema file, you must reopen the model to apply the changes.

The syntax of surfacing.htc file is:

Surfacing Type, Surfacing Code, Hatch name, Scale, [Color], [Automatic Scaling and Rotation]

Example:

1,MF,ANSI31,0.7
1,SMF,ANSI32,0.7
1,WT,ANSI33,0.7
1,HT,ANSI34,0.7
1,LSB,AR-SAND,0.7
2,SM1,CROSS,1.0
2,SM2,CHECKERED,1.0
3,TS3,FBBRICKC,1.0
4,FP,ANSI31,1.0
4,UP,ANSI32,1.0

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Surface treatment type</td>
<td>• 1 = concrete finish</td>
</tr>
<tr>
<td></td>
<td>• 2 = special mix</td>
</tr>
<tr>
<td></td>
<td>• 3 = tile surface</td>
</tr>
<tr>
<td></td>
<td>• 4 = steel finish</td>
</tr>
<tr>
<td>Surface treatment code</td>
<td>This is the abbreviation used in drawings and reports, for example,</td>
</tr>
</tbody>
</table>

Drawing settings reference 756 Surface treatment hatch pattern properties (surfacing.htc)
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MF for Magnesium Float. The product_finishes.dat file contains a full list of surface treatment codes.</td>
<td></td>
</tr>
<tr>
<td>Hatch name</td>
<td>You can check the hatch pattern names and related hatch patterns by going to the Fill tab in Part properties, selecting a hatch pattern from the Type list and clicking the ... button next to the list. The selected hatch pattern is marked with a red frame.</td>
</tr>
<tr>
<td>Scale</td>
<td>Scale is a numeric value that Tekla Structures uses to scale hatches.</td>
</tr>
</tbody>
</table>
| Color (optional) | 0=black (default) 1=white 2=red 3=green 4=blue 5=cyan 6=yellow 7=magenta 120= Special (use this color for gray shade)  

The hatch color defines the line width for the printer. If you do not define a color for a hatch in the surfacing.htc file, Tekla Structures uses the color defined on the Appearance tab in surface treatment properties. The Visible lines color and type is used for the front of the surface treatment, and the Hidden lines for the back. |
| Automatic Scaling and Rotation (optional) | 1=true 0=false (default) |

**See also**

Define automatic surface treatment in drawings (page 665)
## 9.13 Reinforcement/Neighbor reinforcement and mesh properties in drawings

Use the options in the Reinforcement or Neighbor Reinforcement properties to check and modify the reinforcement and mesh visibility, appearance and content.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visibility of all reinforcing bars</td>
<td><strong>Visible</strong> shows the bars or meshes.</td>
</tr>
<tr>
<td>Visibility of all meshes</td>
<td><strong>Not visible</strong> does not show the bars or meshes</td>
</tr>
<tr>
<td>Representation</td>
<td><strong>single line</strong> draws a single line with radiused bends.</td>
</tr>
<tr>
<td></td>
<td><strong>double lines</strong> draws an outline of the bar with radiused bends.</td>
</tr>
<tr>
<td></td>
<td><strong>double lines with filled ends</strong> draws an outline of the bar with radiused</td>
</tr>
<tr>
<td></td>
<td>bends and filled bar ends.</td>
</tr>
<tr>
<td></td>
<td><strong>filled line</strong> draws a solid bar with radiused bends.</td>
</tr>
<tr>
<td></td>
<td><strong>stick</strong> draws a single line without radiused bends.</td>
</tr>
<tr>
<td></td>
<td><strong>outline</strong> shows the shape of the mesh using an outline rectangle or</td>
</tr>
<tr>
<td></td>
<td>polygon, and a diagonal line. Applies only to reinforcement meshes.</td>
</tr>
<tr>
<td>Visibility of reinforcing bars in group</td>
<td><strong>all</strong> shows all bars in a group or mesh.</td>
</tr>
<tr>
<td>Visibility of longitudinal wires</td>
<td><strong>first bar</strong> shows only the first bar in the group or mesh.</td>
</tr>
<tr>
<td>Visibility of crossing bars</td>
<td><strong>last bar</strong> shows only the last bar in the group or mesh.</td>
</tr>
<tr>
<td></td>
<td><strong>first and last bar</strong> shows the first and last bar in the group or mesh.</td>
</tr>
<tr>
<td></td>
<td><strong>bar in the middle of group</strong> shows one bar in the middle of the group or</td>
</tr>
<tr>
<td></td>
<td>mesh.</td>
</tr>
<tr>
<td></td>
<td><strong>two bars in the middle of group</strong> shows two bars in the middle of the</td>
</tr>
<tr>
<td></td>
<td>group or mesh.</td>
</tr>
<tr>
<td></td>
<td><strong>customized</strong> indicates that you have specified the location of the only</td>
</tr>
</tbody>
</table>

---

Drawing settings reference 758 Reinforcement/Neighbor reinforcement and mesh properties in drawings
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>visible reinforcing bar. Applies</td>
<td>visible reinforcing bar. Applies only to bar groups and meshes.</td>
</tr>
<tr>
<td>only to bar groups and meshes.</td>
<td></td>
</tr>
<tr>
<td><strong>Hide lines behind parts</strong></td>
<td>Hides the lines behind the part. This is useful, for example, with lifting anchors where the reinforcing bar is partly outside the part.</td>
</tr>
<tr>
<td><strong>Hide lines behind other rebars</strong></td>
<td>Hides the lines behind other reinforcement bar lines.</td>
</tr>
<tr>
<td><strong>Symbol at straight end</strong></td>
<td>Applies only to reinforcing bars.</td>
</tr>
<tr>
<td><strong>Symbol at hooked end</strong></td>
<td>Applies only to reinforcing bars.</td>
</tr>
<tr>
<td><strong>Mesh symbol</strong></td>
<td>Defines the mesh symbol to be used. The mesh symbol appears in the middle of the diagonal line.</td>
</tr>
<tr>
<td><strong>Symbol 1</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Symbol 2</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Symbol 3</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Mesh symbol size</strong></td>
<td>Defines the size of the mesh symbol.</td>
</tr>
<tr>
<td><strong>Visible lines</strong></td>
<td>Defines the color and type of the visible lines.</td>
</tr>
<tr>
<td><strong>Hidden lines</strong></td>
<td>Defines the color and type of the hidden lines.</td>
</tr>
</tbody>
</table>
**Additional ways of modifying reinforcement**

In addition to the settings in **Reinforcement** properties, you can modify the reinforcement in any of the following ways:

- Increase the size of the bend and end symbols (in drawing units) using the advanced options `XS_REBAR_BEND_MARK_SYMBOL_MIN_SIZE` and `XS_REBAR_END_SYMBOL_MIN_SIZE` in **File menu --> Settings --> Advanced options --> Concrete Detailing**.

- Use the advanced option `XS_REBAR_REVERSE_END_SYMBOLS` in **File menu --> Settings --> Advanced options --> Concrete Detailing** to change the end symbols to a different direction.

- Modify the reinforcing bar bending schedule, rounding of bar dimensions, symbols for meshes, strands, and unbonding, and appearance of reinforcement pull-outs in the **rebar_config.inp** (page 760) file.

**See also**

- Automatic reinforcement and mesh settings in drawings (page 669)
- Part and neighbor part properties in drawings (page 749)

---

### 9.14 Reinforcement settings for drawings (rebar_config.inp)

Tekla Structures uses the settings in the **rebar_config.inp** file in the ..\ProgramData\Tekla Structures\<version>\environments\<environment>\system folder to define the following reinforcement-related issues in drawings:

- Selected area-specific reinforcing bar bending schedule
- Rounding of bar dimensions
- Available symbols for meshes, strands, and unbonding
- Appearance of reinforcement pull-outs

The entries in the **rebar_config.inp** are listed and described below:

<table>
<thead>
<tr>
<th>Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MergeOneFormat</td>
<td>No longer used. Define these properties in the drawing properties.</td>
</tr>
<tr>
<td>MergeTwoOrMoreFormats</td>
<td></td>
</tr>
<tr>
<td>MergeAndFormat</td>
<td></td>
</tr>
<tr>
<td>LeaderLinetype</td>
<td></td>
</tr>
<tr>
<td>DimensionMarkSpacingSep</td>
<td>=&quot;/&quot;</td>
</tr>
<tr>
<td>arator</td>
<td>Affects the separator in reinforcement marks.</td>
</tr>
</tbody>
</table>

Drawing settings reference 760 Reinforcement settings for drawings (rebar_config.inp)
<table>
<thead>
<tr>
<th>Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ExactDimensionMarkSpacingSeparator</td>
<td>=&quot; + &quot;</td>
</tr>
<tr>
<td></td>
<td>Separator between different exact spacing values in reinforcement marks.</td>
</tr>
<tr>
<td>ExactDimensionMarkPcsSeparator</td>
<td>=&quot;*&quot;</td>
</tr>
<tr>
<td></td>
<td>Separator between the number of bars and their exact spacing value in reinforcement mark.</td>
</tr>
<tr>
<td>BendingAngleTolerance</td>
<td>Set a tolerance value for the angle. Angles that differ from the set tolerance value less than the tolerance are recognized and lead to a correct bending shape. Enter the tolerance value as a radians, not as a degree. The default value is 0.001 radians, which is 0.0573 in degrees. This applies to all bending shapes.</td>
</tr>
<tr>
<td>BentRebarTolerance</td>
<td>Set a tolerance value. Depending on the value, slightly curved reinforcing bars get straight shape.</td>
</tr>
<tr>
<td></td>
<td>If reinforcing bar diameter is 20 mm and radius is 200 m then value 20/200000 = 0.0001.</td>
</tr>
<tr>
<td></td>
<td>This variable defines correct curved reinforcing bar in case of long reinforcing bars to get a correct shape for the bar. This option is used in comparing the relation of the reinforcing bar diameter and radius. If the relation is smaller than BentRebarTolerance, the reinforcing bar is of bend_type_1, otherwise it is of bend_type_34.</td>
</tr>
<tr>
<td>Entry</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>PullOutBendingRadiusAsMultiplier</strong></td>
<td>Set to 1 to show the pullout bending radii using multiplier instead of mm.</td>
</tr>
</tbody>
</table>

![Diagram](image)

<table>
<thead>
<tr>
<th>GroupBarMark</th>
<th>No longer in use.</th>
</tr>
</thead>
<tbody>
<tr>
<td>MarkingDimAttributes</td>
<td>No longer in use.</td>
</tr>
<tr>
<td><strong>ScheduleCountry</strong></td>
<td>Defines which bending schedule is used. Affects bending shapes in templates and reports. The available schedules are FIN, SWE, UK, US.</td>
</tr>
<tr>
<td></td>
<td>When you number the model, the bending shape for the bar is given according to this information. For example, in the Default environment, the bending shapes are letters A, B, C, and so on.</td>
</tr>
<tr>
<td><strong>ScheduleDimensionRoundingDirection</strong></td>
<td>Options:</td>
</tr>
<tr>
<td><strong>ScheduleTotalLengthRoundingDirection</strong></td>
<td>- &quot;UP&quot;: rounds bar dimensions up</td>
</tr>
<tr>
<td></td>
<td>- &quot;DOWN&quot;: rounds bar dimensions down</td>
</tr>
<tr>
<td></td>
<td>- &quot;NEAREST&quot;: rounds bar dimensions either up or down</td>
</tr>
<tr>
<td><strong>ScheduleDimensionRoundingAccuracy</strong></td>
<td>Sets the rounding accuracy for bar dimensions. Default is 1 mm. \</td>
</tr>
<tr>
<td></td>
<td>Tekla Structures rounds individual bar dimensions up or down according to the option you select for ScheduleDimensionRoundingDirection.</td>
</tr>
<tr>
<td><strong>ScheduleTotalLengthRoundingAccuracy</strong></td>
<td>Sets the rounding accuracy for the total bar length. Default is 10 mm. \</td>
</tr>
<tr>
<td></td>
<td>Tekla Structures rounds individual bar dimensions up or down according to the option you select for</td>
</tr>
</tbody>
</table>

Drawing settings reference: 762 Reinforcement settings for drawings (rebar_config.inp)
<table>
<thead>
<tr>
<th>Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ScheduleTotalLength</td>
<td>ائيت التراكيب والفتحات وإتجاه التكشيف.</td>
</tr>
<tr>
<td>RoundingDirection</td>
<td>ائيت التراكيب والفتحات وإتجاه التكشيف.</td>
</tr>
<tr>
<td>BentSymbolFile</td>
<td>Points to the symbol file that contains the available reinforcing bar bent symbols. By default, points to the file bent.sym, which in the default environment is located in the folder ...\ProgramData\Tekla Structures &lt;version&gt;\environments\common\symbols.</td>
</tr>
<tr>
<td>MeshSymbolFile</td>
<td>Points to the mesh symbol file that contains the available mesh symbols. Affects the available reinforcement mesh symbols in drawings. By default, points to the mesh.sym file in the ...\Tekla Structures &lt;version&gt;\environments\common\symbols folder.</td>
</tr>
<tr>
<td>StrandSymbolFile</td>
<td>Points to the strand symbol file that contains the available strand symbols. Affects drawings. By default, points to the strand.sym file in the ...\Tekla Structures &lt;version&gt;\environments\common\symbols folder.</td>
</tr>
<tr>
<td>UnbondingSymbolFile</td>
<td>Points to the unbonding symbol file that contains the available unbonding symbols.</td>
</tr>
<tr>
<td>RebarMeshSize</td>
<td>Template for rebar mesh size.</td>
</tr>
<tr>
<td>PullOutDimensionFormat</td>
<td>Defines the format for displaying the dimensions. The format follows the dimension properties format. Options: 0 = ###, 1 = ###[#], 2 = ###.#, 3 = ###[#.#], 4 = ###.##,...</td>
</tr>
</tbody>
</table>

Drawing settings reference 763 Reinforcement settings for drawings (rebar_config.inp)
<table>
<thead>
<tr>
<th>Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PullOutDimensionPrecision</td>
<td>Sets the level of precision. The precision is calculated using the following formula: $1/value = precision$. In metric systems, you may want to use the values 1, 10, and 100, and in imperial systems, the values 2, 4, 8, 16 and 32, for example.</td>
</tr>
<tr>
<td>PullOutDimensionUnit</td>
<td>Defines the units to use. Options: • 0 = auto • 1 = mm • 2 = cm • 3 = m • 4 = inch • 5 = foot and inch</td>
</tr>
<tr>
<td>PullOutColor</td>
<td>Sets the color for the pull-outs in reinforcement marks. Options: • 1 = black • 2 = red • 3 = bright green • 4 = blue • 5 = cyan • 6 = yellow • 7 = magenta</td>
</tr>
<tr>
<td>PullOutVisibleLineType</td>
<td>Sets the line type for reinforcing bar shape in pull-outs. Options: 1 = _____ 2 = ----- 3 = --- 4 = ---- 5 = --------</td>
</tr>
<tr>
<td>Entry</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Sets the representation type. Options:</td>
</tr>
<tr>
<td></td>
<td>• 0 = single</td>
</tr>
<tr>
<td></td>
<td>• 1 = double</td>
</tr>
<tr>
<td></td>
<td>• 2 = filled</td>
</tr>
<tr>
<td></td>
<td>• 3 = stick</td>
</tr>
<tr>
<td>PullOutRepresentation</td>
<td>Sets the color for the angle in pull-outs. Options:</td>
</tr>
<tr>
<td></td>
<td>• 1 = black</td>
</tr>
<tr>
<td></td>
<td>• 2 = red</td>
</tr>
<tr>
<td></td>
<td>• 3 = green</td>
</tr>
<tr>
<td></td>
<td>• 4 = blue</td>
</tr>
<tr>
<td></td>
<td>• 5 = cyan</td>
</tr>
<tr>
<td></td>
<td>• 6 = yellow</td>
</tr>
<tr>
<td></td>
<td>• 7 = magenta</td>
</tr>
<tr>
<td></td>
<td>• 8 = brown</td>
</tr>
<tr>
<td></td>
<td>• 9 = green</td>
</tr>
<tr>
<td></td>
<td>• 10 = dark blue</td>
</tr>
<tr>
<td></td>
<td>• 11 = forest green</td>
</tr>
<tr>
<td></td>
<td>• 12 = orange</td>
</tr>
<tr>
<td></td>
<td>• 13 = gray</td>
</tr>
<tr>
<td></td>
<td><img src="image.png" alt="Diagram" /></td>
</tr>
<tr>
<td>PullOutAngleLineType</td>
<td>Sets the line type for angle lines in pull-outs. Options:</td>
</tr>
<tr>
<td></td>
<td>• 1 = ___</td>
</tr>
<tr>
<td></td>
<td>• 2 = -----</td>
</tr>
<tr>
<td>Entry</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>PullOutLeaderLineMinLength</td>
<td>Sets a minimum length for the small leader lines that point to the dimension text. The default value is 10 mm. To switch leader lines off completely, use a large value.</td>
</tr>
</tbody>
</table>
| PullOutShowDuplicateDims | Defines whether duplicate dimensions are showed multiple times for one bar. Options:  
  - 0 = duplicate dimensions are not shown (default)  
  - 1 = equal and parallel dimensions are shown, but similar hook dimensions are not shown  
  - 2 = equal and parallel dimensions are not shown, but both hook dimensions are shown  
  - 3 = all dimensions are shown  
  - 4 = hook dimensions are not shown  
  - 5 = hook dimensions, or equal and parallel dimensions are not shown |
| PullOutShowUSHookDims | Defines if the US/NA style of dimension will be shown for hooks over 90 degrees. Options:  
  - 0 = shows European hook dimension (= leg length, default)  
  - 1 = shows US hook dimension (= straight length) for hooks >90 degrees  
See the image below for the difference between the US/NA (A) and European (B) hook dimension. |
See also
Hard-coded bending type identifiers in reinforcement shape recognition
Add pull-out pictures in automatic reinforcement marks (page 637)
Define automatic reinforcement and reinforcement mesh properties (page 670)
Reinforcement/Neighbor reinforcement and mesh properties in drawings (page 758)

9.15 Pour object and pour break properties in drawings

Use the options in **Pour Object Properties** and **Pour Break Properties** in general arrangement drawings to control the visibility of the pour objects and pour breaks in drawings.

**Pour object properties**

To open **Pour Object Properties**:

- On the **Drawings & reports** tab, click **Drawing properties --> GA drawing** and then click **Pour object**.
- In an open drawing, double-click the drawing background and click **Pour object**.
- In an open drawing, double-click a pour object.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Content tab - Hidden lines</strong></td>
<td></td>
</tr>
<tr>
<td>Hidden lines on/off</td>
<td>Click <strong>on</strong> to display pour object hidden lines.</td>
</tr>
<tr>
<td>Own hidden lines on/off</td>
<td>Click <strong>on</strong> to display own hidden lines.</td>
</tr>
<tr>
<td><strong>Content tab - Additional marks</strong></td>
<td></td>
</tr>
<tr>
<td>Edge chamfers on/off</td>
<td>Select <strong>on</strong> to display edge chamfers <em>(page 288).</em></td>
</tr>
<tr>
<td>Fillet edges on/off</td>
<td>Select <strong>on</strong> to display fillet edges <em>(page 293).</em></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Appearance tab - Visible lines</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Color</strong></td>
<td>Select the color of the visible pour object lines.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Select the type of the visible pour object lines.</td>
</tr>
<tr>
<td><strong>Appearance tab - Hidden lines</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Color</strong></td>
<td>Select the color of the hidden pour object lines.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Select the type of the hidden pour object lines.</td>
</tr>
<tr>
<td><strong>Fill tab</strong></td>
<td></td>
</tr>
<tr>
<td>To add a fill for outer pour faces, use the <strong>Pour faces</strong> area, and to add a fill for cross sections in section views, use the <strong>Sections</strong> area.</td>
<td></td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Defines the fill type. Clicking the button next to the list opens a preview of the hatch patterns.</td>
</tr>
<tr>
<td></td>
<td><strong>Automatic</strong> selects the fill type automatically from the hatch pattern schema files.</td>
</tr>
<tr>
<td></td>
<td><strong>None</strong> uses no fill.</td>
</tr>
<tr>
<td><strong>Color</strong></td>
<td>Defines the color for the fill.</td>
</tr>
<tr>
<td></td>
<td>You can select a predefined color or use <strong>Special</strong> color that is not converted to black in printouts.</td>
</tr>
<tr>
<td><strong>Background</strong></td>
<td>Defines the background color for the fill.</td>
</tr>
<tr>
<td></td>
<td>Background color selection is disabled for hardware hatches.</td>
</tr>
<tr>
<td></td>
<td>Background color can be set for automatic hatches, but it has effect only if automatic hatch is not defined for the material in the hatch pattern schema file.</td>
</tr>
<tr>
<td><strong>Scale</strong></td>
<td><strong>Automatic</strong> scales and rotates the fill automatically.</td>
</tr>
<tr>
<td></td>
<td><strong>Custom</strong> allows you to select scaling and rotation manually.</td>
</tr>
<tr>
<td></td>
<td><strong>Scaling in direction x</strong> and <strong>Scaling in direction y</strong> define the scales in x and y direction.</td>
</tr>
</tbody>
</table>
Keep ratio of x and y retains the relative proportions in the hatch pattern.

**Angle** rotates the fill. For example, **Angle** 0.0 is for horizontal and **Angle** 90.0 for vertical.

### Pour break properties

To open **Pour Break Properties**:

- On the **Drawings & reports** tab, click **Drawing properties -> GA drawing** and then click **Pour break**.
- In an open drawing, double-click the drawing background and click **Pour break**.
- In an open drawing, double-click a pour break.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Visibility</strong></td>
<td>Defines if the pour breaks are visible (<strong>Visible</strong>) or not (<strong>Not visible</strong>).</td>
</tr>
<tr>
<td><strong>Hidden lines on/off</strong></td>
<td>Click <strong>on</strong> to display pour break hidden lines.</td>
</tr>
</tbody>
</table>

### Content tab - Hidden lines

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Color</strong></td>
<td>Select the color of the visible pour break lines.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Select the type of the visible pour break lines.</td>
</tr>
</tbody>
</table>

### Appearance tab - Hidden lines

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Color</strong></td>
<td>Select the color of the hidden pour break lines.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Select the type of the hidden pour break lines.</td>
</tr>
</tbody>
</table>

### See also

- Pours in drawings (page 329)
- Show pour objects, pour marks and pour breaks in drawings (page 668)
9.16 Placement properties for marks, dimensions, notes, texts and symbols

Use the settings in the Placing dialog boxes for dimensions, marks, notes, texts annotation objects and dimensions to control how the annotation objects are placed in a drawing.

You can set automatic placement properties for dimensions and marks before you create a drawing. In an open drawing, you can modify the placement properties of marks, notes, texts, symbols and dimensions.

To open the Placing properties in an open drawing:

- In an open drawing, on the Drawing tab, click Properties and then click Text, Note, Symbol, Dimension or one of the mark types. After that, click the Place button.

- In an open drawing, double-click a text, mark, symbol, note or dimension. After that, click the Place button.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search margin</td>
<td>Defines the distance within which Tekla Structures searches for a space to place a dimension, mark, weld mark or another annotation object.</td>
</tr>
<tr>
<td>Minimal distance</td>
<td>Defines the minimum distance of the mark, weld mark, dimension or another annotation object from the part.</td>
</tr>
<tr>
<td>Quarter</td>
<td>For marks and manually added annotation objects.</td>
</tr>
<tr>
<td></td>
<td>Defines the areas Tekla Structures searches for a space to place the mark or annotation object.</td>
</tr>
<tr>
<td></td>
<td>Weld placement depends on the welding direction. Welds can only be placed in certain sectors, so the Quarter options are not available. This option is available for manually added welds in the final drawing.</td>
</tr>
<tr>
<td>Placing</td>
<td>free allows Tekla Structures to search for the first suitable location for the mark, dimension, weld or another annotation object. fixed allows you to place the mark, dimension, weld or</td>
</tr>
</tbody>
</table>
### Option

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>another annotation object in any location. When you use the option <strong>fixed</strong>, the annotation object stays where it is even though you update the drawing, whereas with <strong>free</strong>, Tekla Structures tries to find the optimal place for the annotation object.</td>
</tr>
</tbody>
</table>

### Direction

| Available only for manual dimensions. Defines the side on which Tekla Structures places dimensions (relative to the object being dimensioned). This setting affects the Placing - free setting. |

---

**See also**

Object protection and placement settings in drawings (page 453)

---

### 9.17 Model weld properties in drawings

You can select which model welds are visible in drawings and drawing views, and set the weld color and line type.

- To set the automatic welding properties in single-part and assembly drawings: On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type. Click **View creation**, select the view and the properties that you want to change, and click **View properties**. Now click **Weld** in the options tree and adjust the settings as required.

- To set the automatic welding properties in general arrangement drawing: On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type. Click **Weld** and adjust the settings as required.

- To modify the welding properties on drawing level in a general arrangement drawing: Double-click the drawing background and click **Weld**.

- To modify the welding properties on view level: Double-click the drawing view frame and click **Weld** in the **View Properties** dialog box.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WELDS WELDS IN SUB-ASSEMBLIES</td>
<td><strong>Not visible</strong> does not display any welds in the selected view/drawing.</td>
</tr>
<tr>
<td></td>
<td><strong>Site weld visible</strong> displays only site welds in the view/drawing.</td>
</tr>
<tr>
<td></td>
<td><strong>Workshop weld visible</strong> displays only workshop welds in the view/drawing.</td>
</tr>
<tr>
<td></td>
<td><strong>Both visible</strong> displays both site welds and workshop welds in the view/drawing.</td>
</tr>
<tr>
<td>WELD SIZE LIMIT</td>
<td>Enter a weld size limit to filter welds of that size and bigger out of the drawing. This is useful when you only want to show non-typical welds in a drawing. To set whether the weld size is an exact or minimum value, use the advanced option XS_WELD_FILTER_TYPE. To filter out a standard weld type, use the advanced option XS_OMITTED_WELD_TYPE.</td>
</tr>
</tbody>
</table>

**Content: Representation**

<table>
<thead>
<tr>
<th>Representation</th>
<th>Select <strong>Path</strong> or <strong>Outline</strong>. You can also select, whether to show <strong>Hidden lines</strong> or <strong>Own hidden lines</strong>. Weld solids are shown in drawings in the following cases:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Weld solids are shown in drawings for those weld types that have real solid support. Welds that have no real solid support are shown in the model with a hexagonal placeholder, and in drawings weld solids are not shown.</td>
</tr>
<tr>
<td></td>
<td>• Welds that have custom cross-sections are also supported.</td>
</tr>
</tbody>
</table>

**Appearance: Visible lines**

<table>
<thead>
<tr>
<th>Color</th>
<th>Sets the color of the weld lines.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Sets the type of the weld lines.</td>
</tr>
</tbody>
</table>

**Appearance: Hidden lines**

<table>
<thead>
<tr>
<th>Color</th>
<th>Sets the color of the hidden lines.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Sets the type of the hidden lines.</td>
</tr>
</tbody>
</table>

**See also**

Welds in drawings (page 306)
9.18 Drawing sketch object properties

You can draw different kinds of sketch objects (graphical objects) in your drawings (lines, rectangles, polylines, polygons, arcs, circles) and use the sketch objects for highlighting particular spots of interest, for example. Use the properties dialog boxes of different sketch objects to check and change the appearance of the shapes.

To open the properties dialog box of a sketch object, go to the Drawings tab, hold down Shift and click the sketch object command. When you have added a sketch object in a drawing, you can open its properties by double-clicking the object.

The settings you have in the dialog box vary depending on the sketch object type.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Behind model objects</td>
<td>When set to Yes, places the graphical object behind model objects.</td>
</tr>
<tr>
<td>Line: Type</td>
<td>Defines the line type of the object.</td>
</tr>
<tr>
<td>Line: Color</td>
<td>Defines the color of the object lines.</td>
</tr>
</tbody>
</table>
| Line: Bulge or Bulge for all lines. | Values 0 - 1. The bulge factor defines the curvature of the curved segments of objects using the calculation:  
  Arc height = Line length * Bulge factor  
  Changing the bulge factor of a polyline or polygon modifies all the segments of that object. |
<p>| Line: Radius                 | Defines the radius of arcs and circles.                                     |
| Arrow: Position              |                                                                           |</p>
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow: Type</td>
<td><img src="image" alt="Arrow Types" /></td>
</tr>
<tr>
<td>Arrow: Height</td>
<td><img src="image" alt="Arrow Height" /></td>
</tr>
<tr>
<td>Arrow: Length</td>
<td><img src="image" alt="Arrow Length" /></td>
</tr>
<tr>
<td>Fill: Type</td>
<td>Defines the fill type to be used in the object. Clicking <strong>Select</strong> to shows the available hatch types.</td>
</tr>
<tr>
<td>Fill: Color</td>
<td>Defines the color of the fill.</td>
</tr>
<tr>
<td>Fill: Background</td>
<td>Defines the background color of the fill.</td>
</tr>
<tr>
<td>Scaling in direction x</td>
<td>Defines the fill scales in the x direction.</td>
</tr>
<tr>
<td>Scaling in direction y</td>
<td>Defines the fill scales in the y direction.</td>
</tr>
<tr>
<td>Keep ratio of x and y</td>
<td></td>
</tr>
<tr>
<td>Angle</td>
<td>Rotates the fill. Angle 0.0 is for horizontal and 90.0 for vertical.</td>
</tr>
<tr>
<td>Offset</td>
<td>Moves the fill pattern inside the object to in the x and y direction by the specified value.</td>
</tr>
</tbody>
</table>

**See also**

- Automatic hatches in drawings (page 655)
- Draw sketch objects in drawings (page 260)

### 9.19 Drawing grid properties

Use the **Grid** properties to view and modify the grid settings in drawings.

- To set the automatic grid properties in single-part and assembly drawings:
  On the **Drawings & reports** tab, click **Drawing properties** and select the drawing type. Click **View creation**, select the view and the properties that
you want to change, and click View properties. Now click Grid in the options tree and adjust the settings as required.

- To set the automatic grid properties on drawing level in general arrangement drawing: On the Drawings & reports tab, click Drawing properties and select the drawing type. Click Grid, and adjust the settings as required.

- To modify the grid properties on drawing level in a general arrangement drawing: Double-click the drawing background, click Grid and adjust the settings as required.

- To modify the grid properties on view level: Double-click the drawing view frame and click Grid in the View Properties dialog box, and adjust the settings as required.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grids</td>
<td>Visible shows the grids.</td>
</tr>
<tr>
<td></td>
<td>Not visible does not show the grids.</td>
</tr>
<tr>
<td></td>
<td>Visible in all views shows the grids in all drawing views. This option is not</td>
</tr>
<tr>
<td></td>
<td>available for general arrangement drawings.</td>
</tr>
<tr>
<td></td>
<td>Only grid labels visible shows only the grid label and a short section of</td>
</tr>
<tr>
<td></td>
<td>the grid line. The length of the displayed grid line depends on the value</td>
</tr>
<tr>
<td></td>
<td>entered in the Text placing box. In the drawing level, this option is only</td>
</tr>
<tr>
<td></td>
<td>available for general arrangement drawings. On the view and object level</td>
</tr>
<tr>
<td></td>
<td>this option is available for all types of drawings.</td>
</tr>
<tr>
<td>Text placing</td>
<td>Sets the side to show the grid labels and the length of the grid line</td>
</tr>
<tr>
<td></td>
<td>extension (the distance between the end of the grid line and the text).</td>
</tr>
<tr>
<td>Text: Color, Height, Font and Frame</td>
<td>Defines the grid label text color, height, font and frame.</td>
</tr>
</tbody>
</table>

Other ways to adjust grids

Additionally, for example XS_DRAWING_GRID_LABEL_FRAME_FIXED_WIDTH, XS_DRAWING_GRID_LABEL_FRAME_LINE_WIDTH_FACTOR and XS_GRID_TEXT_FONT allow you to adjust the grid labels further.

See also

Automatic grid settings in drawings (page 639)
Define automatic grid properties (page 640)
10 Disclaimer

© 2017 Trimble Solutions Corporation and its licensors. All rights reserved.

This Software Manual has been developed for use with the referenced Software. Use of the Software, and use of this Software Manual are governed by a License Agreement. Among other provisions, the License Agreement sets certain warranties for the Software and this Manual, disclaims other warranties, limits recoverable damages, defines permitted uses of the Software, and determines whether you are an authorized user of the Software. All information set forth in this manual is provided with the warranty set forth in the License Agreement. Please refer to the License Agreement for important obligations and applicable limitations and restrictions on your rights. Trimble does not guarantee that the text is free of technical inaccuracies or typographical errors. Trimble reserves the right to make changes and additions to this manual due to changes in the software or otherwise.

In addition, this Software Manual is protected by copyright law and by international treaties. Unauthorized reproduction, display, modification, or distribution of this Manual, or any portion of it, may result in severe civil and criminal penalties, and will be prosecuted to the full extent permitted by law.

Tekla, Tekla Structures, Tekla BIMsight, BIMsight, Tekla Civil, Tedds, Solve, Fastrak and Orion are either registered trademarks or trademarks of Trimble Solutions Corporation in the European Union, the United States, and/or other countries. More about Trimble Solutions trademarks: http://www.tekla.com/tekla-trademarks. Trimble is a registered trademark or trademark of Trimble Inc. in the European Union, in the United States and/or other countries. More about Trimble trademarks: http://www.trimble.com/trademarks.aspx. Other product and company names mentioned in this Manual are or may be trademarks of their respective owners. By referring to a third-party product or brand, Trimble does not intend to suggest an affiliation with or endorsement by such third party and disclaims any such affiliation or endorsement, except where otherwise expressly stated.

Portions of this software:

D-Cubed 2D DCM © 2010 Siemens Industry Software Limited. All rights reserved.
This product contains proprietary and confidential technology, information and creative works owned by Flexera Software LLC and its licensors, if any. Any use, copying, publication, distribution, display, modification, or transmission of such technology in whole or in part in any form or by any means without the prior express written permission of Flexera Software LLC is strictly prohibited. Except where expressly provided by Flexera Software LLC in writing, possession of this technology shall not be construed to confer any license or rights under any Flexera Software LLC intellectual property rights, whether by estoppel, implication, or otherwise.

To see the third party open source software licenses, go to Tekla Structures, click File menu --> Help --> About Tekla Structures and then click the 3rd party licenses option.

The elements of the software described in this Manual are protected by several patents and possibly pending patent applications in the United States and/or other countries. For more information go to page http://www.tekla.com/tekla-patents.
Index

2
2D .......................................................... 17
2D Library
adding details ........................................ 296
details .................................................. 296
distributing ........................................... 296
DWG files ............................................ 296
exploding ............................................. 296
folders ............................................... 296
images .............................................. 296
inserting details in a drawing ................. 296
limitations ........................................... 296
modifying details .................................. 296
opening .............................................. 296
storing .............................................. 296

3
3D .......................................................... 17
drawing views...................................... 145, 692
isometric drawings .................................. 50
rotation of views .................................. 692
3D drawing views ................................ 152
3D views ............................................ 50

A
A1 .......................................................... 429
A2 .......................................................... 419, 429
A3 .......................................................... 419, 429, 439
printing (old) ...................................... 403
A4 .......................................................... 419, 429, 439
printing (old) ...................................... 402
absolute dimensions ......................... 700
appearance ......................................... 574
orientation ......................................... 574
zero at start point ............................... 574
adding
associative notes .............................. 219
bolt marks ......................................... 215
closing dimensions ............................ 207
connection marks .............................. 215
dimension points ............................... 208
dimension points in anchor bolt plans ... 204
dimension tags ................................. 179
dual dimensions ......................... 183
fold marks ....................................... 394, 414
frames ............................................ 394, 414
hyperlinks ......................................... 237
level marks ....................................... 217
links to DWG/DXF files ...................... 241
links to images ................................. 242
links to other drawings ....................... 238
links to text files .............................. 235
manual dimensions ......................... 171
part marks ......................................... 215
reinforcement marks .......................... 215
revision marks .................................. 239
single-part views in assembly drawings .. 156
surface treatment marks .................. 215
symbols .......................................... 351
symbols in marks .............................. 633
texts ............................................... 233
weld marks ....................................... 322
AddSurfaceSymbols ......................... 358
aligning dimension texts .................... 583
aligning
drawing objects........................................... 248
drawing views...........................................165,496
alternative scales...................................... 450
anchor bolt plans......................................45,51,692
creating................................................... 83
dimensions.............................................. 596
included objects..................................... 85
including assemblies............................... 86
including objects..................................... 84
anchor bolts............................................. 53
angle...................................................... 773
angle dimensions..................................... 83
annotation objects .................................. 700
annotation objects, 143,214,243,322,453,456
associative............................................ 21
independent.......................................... 21
modifying.............................................. 220
appearance............................................. 749
of bolts................................................... 652
of frames............................................... 608
of leader lines........................................ 608
of mark text.......................................... 608
of marks.................................................. 726
of model weld marks in drawings ................ 734
of neighbor parts.................................. 644
of parts............................................... 642
of reference models............................... 364
of surface treatment............................... 665
arcs...................................................... 260,773
dividing.................................................. 275
arranging
drawing objects........................................... 247
drawing views...........................................166
arrows.................................................... 225
customizing............................................ 352
in leader lines....................................... 352
in sketch objects..................................... 773
leader lines............................................ 232
assemblies
including in anchor bolt plans.................. 86
assembly drawings................................. 57
viewing direction of beams and bracings .... 477
creating................................................. 67,86,90,93
dimensioning.......................................... 716
example.................................................. 58
freezing.................................................. 375
including single-part drawings.................. 469
rails..................................................... 60
single-part views.................................... 156
stairs..................................................... 59
viewing direction of columns.................. 477
assembly position.................................... 739
assembly type......................................... 741
associative annotation objects................. 214,322
associative notes.................................... 219
level marks............................................ 217
modifying.............................................. 220
part marks............................................ 215
updating.............................................. 223
associative notes.................................... 21
adding.................................................. 219
in edge chamfers.................................. 291
leader lines.......................................... 232
placing.................................................. 769
associativity.......................................... 17,18
refreshing............................................. 124
associativity symbol
ghost associativity symbol....................... 18
AutoDrawings.......................................... 69
automatic
dimensions............................................. 498,570
marks................................................... 600,602
autoscale.............................................. 450
autosizing............................................ 448,451
autosizing............................................ 448,451
back drawing views................................. 152,692
back views............................................. 463
bar class............................................... 742
bar diameter......................................... 742
bar length............................................. 742
bar marks............................................. 745
bar name.............................................. 742
bar quantity.......................................... 742
bar shape............................................. 742
bar weight............................................. 742
base points.......................................... 232,610
beams
in cast unit drawings.............................. 62
viewing direction in assembly drawings...... 477
bent plates
unfolding................................................ 486
block prefix........................................... 745
bolt diameter........................................... 741
bolt length............................................. 741
bolt marks.............................................. 602
elements.............................................. 634,741
modifying............................................. 220
bolt plans.............................................. 83
bolt standard......................................... 741
bolts
appearance........................................... 652
combining symbols................................. 653
dimensioning......................................... 565
contents............................................... 652
dimensioning......................................... 555,718
examples............................................... 653
in drawings........................................... 651,652
properties............................................. 754
bolt's full name...................................... 741
bolt's short name.................................... 741
bottom drawing views.............................152,692
bottom views......................................... 463
boundaries, see view boundaries
of drawing views.................................. 162
building objects.................................... 17,21,143,283,692
modifying............................................. 283
bulge..................................................... 773
by print area.......................................... 419

C
calculated drawing sizes.......................... 429
calculated sizes...................................... 439
camber.................................................. 739
cast unit definition method
By cast unit ID....................................... 67,86
By cast unit position.............................. 67,86
cast unit drawing
freezing............................................... 375
cast unit drawings.................................. 61
creating............................................... 67,86
creating one by one................................. 87
dimensioning........................................ 716
precast beams........................................ 62
precast column....................................... 62
precast stairs........................................ 63
cc....................................................... 742,744
center lines.......................................... 283
center of gravity
dimensioning........................................... 198
center-to-center distance......................... 555,739,741
chamfer marks
adding............................................... 291
chamfers
in drawings........................................... 278,288,289,290,291
change clouds, see change symbols............ 227
change coulds, see change symbols.............. 226
change symbols...................................... 225
hiding............................................... 226,227
removing........................................... 226,227
changing
drawing revisions................................... 379
check dimensions................................... 550
circles.................................................. 260,773
class..................................................... 739
cloning models...................................... 117
cloning template models........................... 77
cloning templates................................. 104,110
cloning
a drawing to a new sheet......................... 125
checking cloned drawings........................ 123
cloned objects....................................... 123
cloning templates................................. 76,77,116,117
dimensions............................................ 122
drawings............................................. 115,118,120
using cloning templates from other
models................................................ 117
when to clone....................................... 115
closing dimensions................................... 561
adding............................................... 207
closing
drawings............................................... 141
clouds............................................... 225,259
COG, see center of gravity......................... 198
colors
changing pen number (old printing)...421
in drawing hatches................................. 662
in drawings........................................... 243,360,361,363
pen numbers........................................ 420
special colors....................................... 363
columns
in cast unit drawings............................... 62
viewing direction in assembly drawings...... 477
combining
dimension lines.................................... 209
dimensions........................................562,565,709
sketch objects........................................263
compass direction........................................648
complex line types........................................266
complex lines..............................................266
connecting side marks..............................749
connecting side
  showing marks .......................................650
connecting
dimension lines........................................208
connection marks.......................................602
modifying..............................................220
connections
  DSTV code..............................................746
error..................................................746
group..................................................746
marks..................................................746
name..................................................746
number.................................................746
running number......................................746
content..............................................749
contents
  of bolts.................................................652
  of drawing parts......................................642
  of drawings..........................................15
  of marks...............................................737
  of neighbor parts..................................644
  of surface treatment............................665
coordinate systems
  changing...............................................471
  fixed..................................................471
  horizontal brace.....................................471
  local..................................................471
  model...............................................471
  oriented.............................................471
  user coordinate system (UCS)....................177
  vertical brace......................................471
copying
  a drawing to a new sheet.........................125
  drawing views.....................................159
  drawings............................................113
  sketch objects......................................276
  with offset.........................................276
countersunk...........................................741
cover-up line.........................................260
cover-up polygon......................................260
cover-up polyline.....................................260
cover-up rectangle...................................260
cover-up tools........................................280
creating
  anchor bolt plans.................................83
cut lines............................................257
drawings............................................43,67,75,86,92,100,116,126
  empty drawings.....................................82
  empty general arrangement drawings.............66
  fillet...............................................277
general arrangement drawings.....................82
  moment connection symbols.......................355
  revisions...........................................378
  round chamfer in drawing..........................278
  straight chamfer in drawing......................278
curved section views................................149
custom presentations................................327
custom weld symbols.................................323
custom weld type symbols............................323
customizing
drawing grids.........................................335
  line types..........................................681
  Master Drawing catalog..........................101
  master drawings....................................101
  print file names....................................407,408
cut lines
  creating.............................................257
  deleting.............................................258
  managing.............................................257
  updating.............................................258
D
deck plans.............................................48
deformed parts
  undeforming.........................................487
deleting
cut lines.............................................258
drawing revisions....................................379
drawings...............................................381
  moment connection symbols.......................358
  selected part marks..............................224
  selected reinforcement marks....................224
  unnecessary drawing files........................370
detail boundary.......................................169
detail marks..........................................150
  adding..............................................218
detail name.........................................748
elements.............................................748
  modifying............................................169
source drawing name......................................... 748
detail symbols.............................................. 169
detail views.................................................... 145
creating......................................................... 150
marks................................................................ 169
moving to another drawing............................. 160
name................................................................ 748
start letter or number....................................... 152
view label mark elements................................. 748
view labels.......................................................... 150,169
detailed object level settings............................ 23,31,33,36,38,692
details
  adding detail marks.................................... 218
  creating....................................................... 296
  exploding...................................................... 296
  in 2D Library................................................. 296
  inserting...................................................... 296
dg files............................................................. 381
  removing...................................................... 370
dimension format............................................. 703
dimension lines
  combining..................................................... 209
  creating extensions....................................... 573
  linking......................................................... 208
  unlinking.................................................... 208
dimension marks............................................. 203
dragging............................................................ 212
dimension points
  adding.......................................................... 204,207,208
  removing...................................................... 208
dimension rule properties
  applying........................................................ 509
  creating...................................................... 509
dimension tags............................................... 203,706
  automatic tagging......................................... 547
  content......................................................... 179
  contents....................................................... 171
  elements....................................................... 171
  filtering content.......................................... 181
  in dimensions.............................................. 179
  removing default content............................. 179
  rotating....................................................... 179
dimensioning
  integrated................................................... 537
dimensioning tool.......................................... 536,537,539
dimensioning.................................................... 530
  automatic.................................................... 498
defining rules............................................... 506
dimensioning rule properties............................ 518
dimensioning rule properties............................ 518
edge shape..................................................... 539
examples of view-level dimensioning.................. 539
filter for holes and recesses............................ 528,529
filters............................................................. 527,530
integrated...................................................... 535
on view level............................................... 504,506
overall dimensions......................................... 539
precast......................................................... 535,536,539
properties....................................................... 699
view-specific.................................................. 504
dimensions..................................................... 21,123
  absolute.................................................... 574,700
  adding......................................................... 171
  adding dimension tags.................................. 179
  anchor bolt plans......................................... 596
  angle......................................................... 700
  appearance............................................... 203,573,705
  automatic................................................... 570
  automatic tagging........................................ 547
  bolt dimensioning......................................... 555
  bolts......................................................... 718
center of gravity............................................ 198
check dimensions.......................................... 550
cloning......................................................... 122
closing......................................................... 561,709
combining..................................................... 562,565,709
contents....................................................... 171
coordinate system......................................... 177
creating......................................................... 545
creating manually.......................................... 170
creation method.............................................. 692
dimension format.......................................... 703
dimension lines............................................. 185,213
dimension marks............................................ 171,185
dimension points.......................................... 204,208
dimension tags.............................................. 171,185
dimension tags.............................................. 171,185
dual dimensions............................................. 183
elements......................................................... 171
elevations...................................................... 548
enlarging...................................................... 574
exaggerate selected........................................ 202
exaggerating.................................................. 574
examples...................................................... 173,552,555,556,561,562,565,566,567,568,569
extension lines.............................................. 210,700
flipping outside dimensions .......... 205
formats ........................................... 700
forward offset ................................. 566,709
GA drawings ................................. 584
genral arrangement drawings ......... 584,585,723
grid dimensions in GA drawings .... 586
grouping ......................................... 547,700,720
in reinforcement ............................... 185
level ............................................... 700
limiting outside dimensions in GA
drawings .......................................... 590
marks ............................................. 203,212,545,706
maximum leader line length in GA
drawings .......................................... 588
minimizing views ................................ 709
modifying ......................................... 170,203
object groups ................................... 584
object groups in dimensioning ........ 585
part dimensions ............................... 552,723
part dimensions in GA drawings ...... 591
parts in general arrangement drawings ................................................................. 177
parts partly outside the view in GA
drawings .......................................... 589
placing ............................................ 453,459,700,769
plate side marks ............................... 204
plates .............................................. 577
position dimensions ......................... 556,572
position properties ............................ 713
positioning ........................................ 591,723
precision .......................................... 700,703
preferred dim side ......................... 568
prefix of radial dimensions .............. 576
profiles ............................................ 580
properties ......................................... 699,700,716
recognizable distance ...................... 709
recreating ........................................ 184
reinforcement ................................... 185,569,722
reinforcing bar dimension lines ....... 185
reinforcing bar groups ...................... 185
relative ............................................ 700
setting start point ............................ 206
settings ............................................ 545
sloped ............................................. 583
specifying on view level ................... 500
straight ............................................ 700
sub-assemblies ................................... 721
tags ................................................. 569,706
tags, see dimension tags ................. 203
type ................................................... 709
types ............................................... 700
unfolded parts .................................. 571
units ................................................. 700,703
updating format ................................ 625
US absolute ...................................... 700
dim_operation.ail .............................. 548
dim_planes_table.txt ......................... 580
direction marks ............................... 494
direction
view direction marks ...................... 494
distance between groups ................. 745
distances
recognizable ................................... 567
distribution lines ......................... 185
dividing
arcs ............................................... 275
lines ............................................. 275
double dimensioning ................. 183
double dimensions ......................... 183
dragging
associative notes ......................... 232
dimension marks .............................. 212
drawing objects .............................. 254
drawings end of dimension line ........ 213
grid labels in drawings .................... 346
marks ........................................... 232
model weld marks ......................... 320
texts ............................................. 233
weld marks ...................................... 320
drawing files
deleting .......................................... 370
drawing filters ................................. 33,85
drawing fold marks ....................... 429
drawing frames .............................. 429
drawing hatches
colors ............................................. 662
drawing layouts .............................. 20
adding .......................................... 433
adding tables .................................. 433
creating ......................................... 433
examples in pour drawings .............. 333
selecting a new ......................... 446
drawing level properties ................. 33
drawing levels
object level................................................. 31
Drawing List............................................... 127
cloning drawings................................. 118
contents........................................ 128,133
filtering................................................. 133
opening................................................. 128
sorting................................................. 133
status flags........................................... 131
drawing objects......................................... 214
  aligning............................................... 248
  annotation objects................................ 21
  arranging............................................. 247
  associativity........................................ 17
  building objects................................... 21
detailed object level settings............... 31,36
dragging............................................... 254
loading object properties..................... 31
modifying properties................................ 30
moving.................................................. 254
reshaping............................................. 254
resizing............................................... 254
sketch objects......................................... 21
drawing properties
  applying............................................. 40
creating................................................ 504
detailed object level settings............... 31,33,36,38
drawing level......................................... 33
drawing property files.......................... 104
modifying automatic............................. 424
modifying in an open drawing.................. 29
modifying on view level............................ 28
object level............................................ 30
setting before creating drawings........... 27
view level.............................................. 38
drawing property files............................ 107
drawing revisions
  attributes.......................................... 380
drawing sheets........................................ 429
drawing size......................................... 451
calculated sizes..................................... 439
fixed sizes........................................... 438
drawing view filters............................... 36,179,527
drawing view labels
  section views....................................... 167
drawing views......................................... 20,145
  3D.................................................. 692
  3D views........................................... 152
  aligning............................................. 165
arranging............................................ 160,166
assembly drawings.................................. 469
automatic............................................ 461
automatic settings................................ 461
back.................................................... 692
back views............................................ 152
bottom.................................................. 692
bottom views........................................ 152
coordinate system............................... 692
copying............................................... 159
creating.............................................. 147,149,150,152,153,154,155,463
creating automatic............................... 505
deformed parts...................................... 487
detail views.......................................... 150
direction marks...................................... 494,692
detail views.......................................... 150
drawings.............................................. 152
end..................................................... 692
front.................................................... 692
front views.......................................... 152
key plans............................................. 443
linking............................................... 162
modifying............................................. 167
moving.................................................. 164
moving to another drawing..................... 160
neighbor part visibility........................ 479
of entire model view.............................. 153
of reinforcement meshes....................... 156
of selected area in a drawing................ 155
of selected area in model...................... 154
part orientation..................................... 471
projection type...................................... 467
projecting............................................ 166
rotating.............................................. 474
scale................................................... 450,692
section............................................... 692
section view properties.......................... 697
section views........................................ 147,149
settings.............................................. 692
shortening parts.................................... 483
showing openings and recesses.............. 489
single-part views.................................... 156
size..................................................... 450
top...................................................... 692
top views.............................................. 152
unfolding polybeams............................ 486
view boundaries..................................... 162
view label marks.................................... 465
view label symbols................................. 692
viewing direction of beams, bracings and columns..........................................................477
drawings............................................................................................................................126
dimensions..........................................................................................................................498
adding texts..........................................................................................................................233
anchor bolt plans..............................................................51,83
assembly drawing..............................................................57
automatic drawing settings..........................................................424
autoscaling..........................................................................................................................451
autosizing.........................................................................................................................451
before creating..................................................................................................................65
cast unit drawings.............................................................................................................61
changing color.....................................................................................................................361
checking cloned drawings................................................................................................123
checking if parts have drawings.........................................................................................136
cloning................................................................................................................................115,116,118
closing..............................................................................................................................141
colors..................................................................................................................................243,360
contents................................................................................................................................15
creating..................................................................................................................................43,67,75,82,86,92,100,116,126
creating general arrangement drawings..................................................................................66
deleting..................................................................................................................................381
drawing filters..........................................................................................................................33
drawing objects.....................................................................................................................21
drawing size..........................................................................................................................448,450
drawing templates..............................................................................................................126
drawing view scale..............................................................................................................448,449,450
editing..................................................................................................................................143
filters......................................................................................................................................33,38
fold marks................................................................................................................................413
frames....................................................................................................................................413
freezing...................................................................................................................................374
general arrangement drawings............................................................................................45
grid lines..................................................................................................................................334
grids........................................................................................................................................334,639
hiding and showing objects..................................................................................................243
hyperlinks...............................................................................................................................237
in drawings............................................................................................................................20
issuing....................................................................................................................................377
layouts.................................................................................................................................20,429,433,446
links to other drawings........................................................................................................238
locking....................................................................................................................................374
managing..................................................................................................................................372
master drawings....................................................................................................................101
modifying properties............................................................................................................29,30
multidrawings.......................................................................................................................64
multiple drawing sheets of the same part...............................................................................99
object properties....................................................................................................................33,38
old printing............................................................................................................................399
opening...................................................................................................................................136
preview images....................................................................................................................114
printing (old)........................................................................................................................401,404,405,407
printing to multiple sheets (old printing).............................................................................410
properties............................................................................................................................28,31,36,40,424
protection..............................................................................................................................454,456
recreating...............................................................................................................................41
reference models..................................................................................................................364
removing................................................................................................................................105
renaming................................................................................................................................144
revisions..................................................................................................................................378
rule sets...................................................................................................................................92
saved settings..........................................................................................................................86
saving......................................................................................................................................369
screen layout..........................................................................................................................19
searching................................................................................................................................134
selecting..................................................................................................................................135
setting properties before creating drawings.......................................................................27
settings..................................................................................................................................424,684
single-part drawings..............................................................................................................52
snapshots................................................................................................................................137
status flags............................................................................................................................131
status information................................................................................................................131
table layouts..........................................................................................................................440,441
tables.....................................................................................................................................432
text files..................................................................................................................................235
three levels of modifying.......................................................................................................23
titles........................................................................................................................................144
types........................................................................................................................................45
unlocking...............................................................................................................................374
updating..................................................................................................................................23,42,372
user-defined attributes............................................................................................................677,678
view filters...............................................................................................................................38
views.......................................................................................................................................20,461,463
with black background..........................................................................................................360
wizards.....................................................................................................................................92
dual dimensions
adding automatically..............................................................................................................570
adding manually......................................................................................................................183
DWG and DXF files
adding in a drawing table layout..........................................................................................445
in drawings............................................................................................................................241
scaling options........................................241
DWG files
   inserting to drawings................................296
DWG/DXF files........................................21,123,432
DWG
   re-ordering in drawings...........................265

E
edge chamfers........................................219,643,749
   adding chamfer marks..............................291
   in drawings...........................................288,289,290,291
editing
drawings.............................................143
elements
   in bolt marks........................................634,741
   in connection marks..................................746
   in detail view label marks...........................748
   in dimension marks..................................171
   in dimension tags..................................171
   in marks...............................................737,738
   in merged reinforcement marks....................745
   in neighbor reinforcement mesh marks............744
   in part marks...........................................739
   in reinforcement marks..............................742
   in reinforcement mesh marks.......................744
   in section view label marks........................748
   in surface treatment marks..........................747
   in view label marks..................................748
elevation views.....................................145
elevations
   datum point.........................................692
   dimensioning.........................................548
   embeds..................................................53
end views..............................................463,692
   aligning with main view............................496
   view direction marks................................494
enlarged views
   adding dimension points...........................204
enlarging
dimensions............................................574
erction elevation drawings.........................49
erction elevation drawings, see general
   arrangement drawings................................45
exaggerating dimensions............................574
exaggerating
   selected dimensions...............................202
examples
   bolts in drawings..................................653
   cast unit drawings..................................62,63
   cloning drawings.....................................120
   dimensions in drawings............................207,552,555,556,561,562,565,566,567,
   568,569
   edge chamfers in drawings........................291
   hatch patterns........................................664
   manually added dimensions in drawings.............173
   part representation in drawings....................643
   printing (old).........................................402,403,404
   welds in drawings...................................310,324
exploding
   plug-ins...............................................259
   sketch objects.......................................263
extension lines
   of dimensions.......................................210
extrema, see view boundaries.......................147,162

F
face direction.......................................648,739
file names
   in printing...........................................408
   in printing (old)......................................407
fill.........................................................749
fill, see hatches.......................................655
fillet edges..........................................749
fillet
   creating...............................................277
fills.......................................................656
   colors..................................................662
filtering
   dimension tag content..............................181
   drawing filters.......................................33
   Drawing List contents................................133
   using drawing filters in anchor bolt plans............85
   view filters............................................38
filters
   examples in dimensioning........................528,529,530
   excluding stirrups..................................530
   in dimensioning rules..............................527
   in drawings...........................................33
   on view level.........................................38
finding
drawings.................................................127
parts with drawings.............................. 136
finish..................................................... 739
firm folder
for images and symbols............. 359
fittings (NS/FS).............................. 739
fixed..................................................171,322
fixed drawing main view.......... 476
fixed drawing sizes.................. 429
fixed sizes........................................ 438
flags
in drawings.................................. 131
flipping outside dimensions..... 205
fold marks......................................... 413
in printed drawings................. 394,414
folders
in Master Drawing Catalog... 111,112,113
folding printed drawings........ 413
foldmarks........................................ 413
format
dimensions........................................ 625
level attributes......................... 625
forward offset......................... 566,709
foundation plans.......................... 83
frames............................................. 413
around marks......................... 608
in printed drawings................. 394,414
framing plans.................................. 47
free..................................................... 171
freezing
and associativity....................... 376
and cloning................................ 376
assembly drawings..................... 375
cast unit drawings.................... 375
drawings........................................ 374
effect on drawings..................... 376
genral arrangement drawings........ 375
single-part drawings.................. 375
front drawing views..................152,477,692
front views..................................... 463
gage of outstanding leg. ..........555,739,741
general arrangement drawings.... 45
3D views......................................... 50
anchor bolt plans...................... 51
creating using ribbon command... 66
deck plans........................................ 48
defining automatic view properties 464
dimensioning parts to grids........ 177
dimensions................................... 584,585,723
erection elevation drawings ...... 49
foundation plans.......................... 46
framing plans.................................. 47
freezing........................................ 375
isometric drawings.................... 50
plans............................................. 47,48,50
slab plans........................................ 46
tures............................................... 464
genral arrangement drawings
creating........................................ 82
ghost outlines........................... 243
graphical drawing objects......... 123
graphical objects..................... 260,773
re-ordering................................. 265
gird dimensions.......................... 723
in GA drawings........................... 586
gird labels
in drawings.................................. 346,774
gird lines
hiding in drawings....................... 347
in drawings................................ 334
modifying in drawings............... 334
gird UDAs........................................ 335
girds
customizing in drawings............ 335
hiding in drawings....................... 347
in drawings................................. 334,335,639,640
labels in drawings.................. 774
modifying in drawings............... 334
moving grid labels in drawings..... 346
properties in drawings................ 774
user-defined attributes for customizing
drawings........................................ 335
grouped dimensions
tagging........................................ 547
grouping
dimensions.................................... 547,720
identical objects...................... 547
H
handle points in leader lines..................... 256
handles
  in drawing objects............................. 254
hatch patterns
  examples........................................... 664
  insulation.......................................... 664
  schema files...................................... 660
  surface treatment.............................. 756
hatches............................................. 655
  colors............................................... 662
hatches
  neighbor parts.................................. 656
  parts................................................ 656
  schema files..................................... 656
  shapes.............................................. 656
hidden lines....................................... 283
  reference models................................ 364
hidden parts
  listing............................................. 246
  showing frames and leader lines............... 621
hiding
  change symbols................................ 226,227
  drawing objects................................. 243
  grid lines in drawings....................... 347
  grids in drawings.............................. 347
  parts in drawings.............................. 246
  reinforcing bar lines.......................... 671
highlighting
  in drawings...................................... 225
  parts with drawings............................. 136
hole diameter..................................... 741
hole dimensions.................................. 510
hole size.......................................... 741
hyperlinks........................................ 21,123
  adding............................................. 237
  modifying......................................... 243

I
identical objects
  grouping dimensions............................ 547
images
  in drawings....................................... 242
  in templates..................................... 359
  preview images.................................. 114
  re-ordering in drawings....................... 265

K
key plan views..................................... 145
key plans.......................................... 432,443
  adding............................................. 445
  adjusting drawing views....................... 443
knock-off dimensions............................. 550

L
labels
  drawing view labels............................ 465
  section views.................................... 147
landscape
  printing (old).................................... 402
layers
  reinforcing bars............................... 287
layouts............................................. 20,429
  adding key plans............................... 445
  creating......................................... 433
  selecting a new.................................. 446
  table layouts................................... 430
leader lines........................................ 615
  associative notes............................... 232
  base point location............................ 232
  customizing arrows............................. 352
  for reinforcing bar group marks............. 613
  handle points................................... 256

in Master Drawing Catalog....................... 114
independent annotation objects
  DWG and DXF files............................... 241
  hyperlinks....................................... 237
  images............................................. 242
  links............................................... 238
  modifying........................................ 243
  revision marks.................................. 239
  text file.......................................... 235
  texts............................................... 233
insulation
  hatch patterns................................... 664
  Integrated dimensioning......................... 545
  integrated drawings............................ 17
  internal bolt dimensions....................... 555
issuing
  drawings........................................... 377

scaling options................................. 242

789
marks......................................................232
maximum leader line length in GA
drawings.............................................588
modifying.............................................256
part marks............................................609
setting advanced options.......................609
types..................................................613,730
length ...................................................739
lengthening parts.................................483
level attributes......................................625
level dimensions..................................700
level marks...........................................123
adding..................................................217
properties...........................................736
levels
drawing level........................................23
object level..........................................23
three levels of modifying drawings.............23
view level..............................................23
limitations in printing.........................382
limiting outside dimensions in GA drawings
..........................................................590
line extensions......................................573
line thickness.......................................389
line thickness
pen numbers.........................................420
line type...............................................283
line weight..........................................389
line weight
pen numbers.........................................420
line weights (old printing)
changing.............................................421
in printouts.........................................421
line width.............................................389
lines...................................................260,773
customized line types.............................681
dividing...............................................275
extending.............................................273
shortening...........................................273
trimming............................................273
linking
dimension lines....................................208
drawing views......................................162
links....................................................21
hyperlinks..........................................237
modifying............................................243
to DWG/DXF files.................................241
to images.............................................242
to other drawings.................................238
to text files...........................................235
listing hidden parts..............................246
location
of beam marks....................................612
of bracing marks..................................612
of column marks..................................612
of end views.......................................496
of marks.............................................611,646
of section views..................................496
locking
drawings.............................................374
M
macros
adding surface treatment symbols in
drawings..............................................358
main views.........................................145,463
managing
cut lines.............................................257
drawings.............................................372
moment connection symbols...................355
manual dimensions..............................171,173
margins
in table layouts....................................433
mark elements
pours...................................................746
MarkDimensionFormat.dim........................625
marks..................................................21,458,692
view label marks....................................748
adding.................................................602
adding symbols....................................633
adding templates.................................624,628
appearance...........................................726
automatic.............................................600,602
bolt marks..........................................634,741
color....................................................608
common elements................................738
connection marks.................................746
containing templates............................630
contents.............................................737
detail marks.........................................748
detail view label marks..........................748
element unit settings............................622
elements.............................................608,737,739
annotation object properties........................................ 220
building objects.................................................. 283
detail properties.................................................. 169
dimension properties............................................. 203
drawing grid line properties..................................... 334
drawing grid properties........................................... 334
drawing grids.......................................................... 640
Drawing List contents.................................................. 133
drawing view properties.......................................... 167
drawings................................................................. 23
independent annotation objects.............................. 243
leader line shape.................................................. 256
section properties.................................................. 167
symbol properties.................................................. 354
wizard files........................................................... 109
moment connection symbols.................................... 347
creating............................................................... 355
deleting............................................................... 358
managing............................................................. 355
updating.............................................................. 357
moving
drawing views..................................................... 164
drawing views to another drawing........................... 160
end of dimension line............................................. 213
objects in drawings............................................... 254
multidrawings........................................................ 64
creating............................................................... 72
creating empty multidrawings................................. 73
creating of selected parts........................................ 74
of selected drawings............................................... 73
updating.............................................................. 372
multiple drawing sheets of the same part................. 99,100

N
name........................................................................... 739
named size............................................................... 419
names
drawings............................................................... 144
neighbor part marks................................................. 602
neighbor parts........................................................ 641
in drawing views................................................... 479
in drawings............................................................ 644
properties.............................................................. 749
view extension......................................................... 479,692
neighbor reinforcement marks
elements........................................................................ 742,744
north marks................................................................... 649
notes
associative notes................................................... 219
number of bars....................................................... 742
number of bolts ....................................................... 741
numbering.............................................................. 65

O
object groups.................................................................. 102
in dimensioning......................................................... 585,723
in dimensioning GA drawings.................................... 584
object level settings.................................................. 23,692
applying in Master Drawing Catalog........................ 81
objects
associative annotation objects................................ 214
building objects...................................................... 283
cloned objects......................................................... 123
drawing objects....................................................... 21
modifying in drawings............................................. 30
shapes................................................................. 259
offset.......................................................................... 773
forward offset......................................................... 566,709
opening
Drawing List............................................................ 128
drawings................................................................. 127,136
openings and recesses
showing in drawings................................................. 489
showing in views..................................................... 692
orientation marks..................................................... 646
showing................................................................. 649
orientation symbols.................................................. 649
orientation
of parts............................................................... 471,645
of plates................................................................. 478
overall dimensions.................................................. 510
in GA drawings....................................................... 586

P
paper size...................................................................... 404,419
part marks
adding........................................................................ 215
advanced options for setting leader lines
................................................................. 609
compass direction..................................................... 648
containing templates............................................... 630
pours
examples of drawings and reports........333
in drawings..................................329,767
pour break symbol in drawings.........332
pour breaks..................................329
pour objects..................................329
properties in drawings..................767
showing in drawings.......................668
precision......................................703
predefined reinforcement dimensions...185
preferred dim side..........................568
preferred scale................................450
preventing
automatic drawing updates..............42
preview images
creating........................................114
in Master Drawing Catalog...............114,115
print area h*b.................................419
print files......................................408
printer...........................................383
Printer Catalog................................416
Printer Catalog (old printing)........416,417,418
printer drivers...............................416,422
printer instances............................422
Abode postscript printer instances....418
adding...........................................416,417,418
print-to-file instances....................417
setting up......................................416
printers.........................................416,417
printing (old)
xs_use_old_plot_dialog.................401,402,404
A3 on A4........................................404
drawings.........................................402
examples........................................404
printing..........................................408
adding printer instances.................417
Color Table....................................420
customizing file names...................396
hints and tips..................................422
limitations......................................382
line weight....................................420
pen numbers...................................420
plt..................................................383
settings files...................................392
to file............................................406,417
to pdf..............................................383
to plotter.......................................383
product_finishes.dat.....................756
profile..........................................739
profiles
dimensions.......................................580
projection type...............................467
properties files
drawings..........................................504
properties
associative annotation objects........220
automatic drawing properties...........27
bolts..............................................754
drawing properties..........................28,29,424
grids in drawings............................774
marks..............................................726
meshes..........................................758
parts..............................................749
reinforcement..................................758
surface treatment............................755
symbol properties...........................354
protected areas.............................454,456
pull-out pictures.............................742
pull-outs
in reinforcement marks....................637
pullout pictures..............................760

R
radial dimensions
changing the prefix............................... 576
rails................................................................. 60
re-ordering
  sketch objects ........................................... 265
ready for issuing........................................ 376
Rebar group dimensioning application........... 185
rebar marks
deleting....................................................... 224
RebarClassifier........................................... 287
RebarLayeringMarker................................... 287
rebars, see reinforcing bars........................ 185
rebars
  marks..................................................... 216
rebar_config.inp........................................... 760
recognizable distances............................. 567
recreating
dimensions.................................................. 184
drawings.................................................... 41
rectangles.................................................. 260,773
reference dimensions, see check
dimensions................................................... 550
reference lines............................................. 283
reference models......................................... 21
hidden lines............................................... 364
in drawings............................................... 364
own hidden lines........................................ 364
reflected views.............................................. 692
refreshing
  associativity........................................... 124
reinforcement marks.................................... 602
adding pull-outs......................................... 637
deleting...................................................... 224
elements................................................... 742,744,745
leader line base points............................. 610
leader line types......................................... 615
location..................................................... 615
merging...................................................... 232,618,619
modifying................................................... 220
splitting..................................................... 232
reinforcement mesh...................................... 669
creating a drawing view.............................. 156
properties................................................... 758
properties in drawings.................................. 670
reinforcement position................................... 742
reinforcement settings for drawings............... 760
reinforcement
  adding dimensions..................................... 185
closed dimensions........................................ 569
dimension lines........................................... 185
dimension marks.......................................... 185
dimension tags............................................. 185
dimensioning reinforcing bar groups.............. 185
dimensions................................................... 569,722
hiding lines in drawings............................... 671
in drawings................................................ 669,670
marks......................................................... 216
neighbor reinforcement................................ 670
properties................................................. 758
properties in drawings.................................. 670
reinforcing bar layer information................... 287
representation options............................... 672
reinforcing bar group marks
  leader line types........................................ 613
  location................................................... 613
reinforcing bar groups
  dimension lines......................................... 185
dimensioning............................................... 185
distribution lines......................................... 185
reinforcing bars
  adjusting the location............................... 286
dimensioning bar groups............................... 185
dimensioning rebar groups............................ 185
hiding lines in drawings............................... 671
in drawings................................................. 285,286,669,670
layer information......................................... 287
properties................................................... 758
relative dimensions...................................... 700
removing
  change symbols......................................... 226,227
dimension points......................................... 208
dimension tag content.................................. 181
drawings.................................................... 113
unnecessary drawing files............................. 370
renaming
drawings.................................................... 144
reports
  examples for pours..................................... 333
representation options
  for reinforcement...................................... 672
representation
  of parts in drawings................................... 643
resetting
  user coordinate system................................ 369
reshaping
drawing objects........................................... 254
resizing
sample images
creating .................................................. 114
in Master Drawing Catalog.......................... 114,115
saved settings ........................................... 76,77,82,86
in Master Drawing Catalog.......................... 104
modifying .................................................. 107
saving
drawings .................................................. 369
scale ........................................................ 450
scales
in tables .................................................... 441
of drawing views ........................................ 448,449,450
schema files ............................................... .656,660

S

drawing objects .......................................... 254
drawing view boundaries .............................. 162
restriction box, see view boundaries .............. 162
revising drawings ........................................ 378
revising drawings, see revisions ...................... 378
revision marks ............................................. 123
adding ..................................................... 239
arrows ..................................................... 239
deleting ................................................... 239
modifying ............................................... 243
placing .................................................... 239
revision tables ............................................. 432
revisions ..................................................... 378
changing .................................................... 379
creating .................................................... 378
deleting ................................................... 379
rich lines .................................................... 266
rotating plates in drawing .............................. 478
rotating
drawing views ............................................ 166
parts in drawing views .................................. 474
rtf
adding a link ............................................. 235
rule properties
in dimensioning ........................................... 518
rule sets ................................................... 76,79,92,109
creating drawings ........................................ 93
in Master Drawing Catalog ............................ 102
modifying .................................................. 108
rules
dimensioning rules ....................................... 585
in dimensioning .......................................... 506

S

section marks ............................................ 147,493
adding ..................................................... 218
elements .................................................... 748
modifying .................................................. 167
positioning properties .................................. 731
section name ............................................. 748
setting properties ........................................ 491
source drawing name .................................... 748
section view labels ....................................... 147
modifying .................................................. 167
section views ............................................. 145,463,493,692
aligning with main view ................................ 496
creating .................................................... 147,149
cut box ...................................................... 147
cutting line ............................................... 147
label mark elements ..................................... 748
labels ......................................................... 147
modifying .................................................. 167
moving to another drawing ............................. 160
name ........................................................ 748
properties .................................................. 697
setting properties ........................................ 491
titles ........................................................ 748
view direction marks .................................... 494
selecting
drawings .................................................... 135
settings
bolt dimensioning properties ....................... 718
bolt mark elements ....................................... 741
bolt properties ............................................ 754
common elements in marks ......................... 738
connection mark elements .............................. 746
dimension appearance properties ................. 705
dimension format ......................................... 703
dimension grouping properties ...................... 720
dimension mark properties ............................ 706
dimension properties ................................... 699,700,709
dimension tag properties .............................. 706
screen layout
in drawings ............................................... 19
screen shots
preview images .......................................... 114
sample images ........................................... 114
screenshots
preview images .......................................... 114
searching
drawings .................................................... 134
master drawings .......................................... 100
S
section marks ............................................ 147,493
adding ..................................................... 218
elements .................................................... 748
modifying .................................................. 167
positioning properties .................................. 731
section name ............................................. 748
setting properties ........................................ 491
source drawing name .................................... 748
section view labels ....................................... 147
modifying .................................................. 167
section views ............................................. 145,463,493,692
aligning with main view ................................ 496
creating .................................................... 147,149
cut box ...................................................... 147
cutting line ............................................... 147
label mark elements ..................................... 748
labels ......................................................... 147
modifying .................................................. 167
moving to another drawing ............................. 160
name ........................................................ 748
properties .................................................. 697
setting properties ........................................ 491
titles ........................................................ 748
view direction marks .................................... 494
selecting
drawings .................................................... 135
settings
bolt dimensioning properties ....................... 718
bolt mark elements ....................................... 741
bolt properties ............................................ 754
common elements in marks ......................... 738
connection mark elements .............................. 746
dimension appearance properties ................. 705
dimension format ......................................... 703
dimension grouping properties ...................... 720
dimension mark properties ............................ 706
dimension properties ................................... 699,700,709
dimension tag properties .............................. 706

796
key plans................................................ 432
replacing in table layouts..................... 440
revision tables.................................. 432
table layouts................................... 430,441
title blocks............................................ 432
tags.................................................. 457
in dimensions.................................. 569
tags, see dimension tags.................... 171,179,181,185,203
template attributes
  adding in marks..............................624
Template Editor.........................432,446,630,632
templates
  as tables in drawing layouts........... 432
  cloning templates....................... 116
  editing in Template Editor.............446
  in marks...................................628,630,632,738
  modifying tables................. 446
  table layouts.......................................... 430
  template library............................126
text files....................................21,123
  adding in drawings.................. 235
text
  in marks................................. 608
  modifying................................. 243
texts........................................21,123,738
  adding........................................ 233
  dragging........................................ 233
  in drawings.............................. 233
  in marks................................... 738
  placing....................................... 769
  using superscript.......................... 234
thumbnail images
  in Master Drawing Catalog............115
thumbnails........................................ 115
tips
  printing drawings.......................422
title blocks.................................. 432
titles
  in drawings.................................. 144
  section views.................................. 147
toggling between user coordinate systems............................................ 369
top drawing views..........................152,692
top views......................................... 463
TplEd, see Template Editor...............446
transparency
  of tables........................................ 441
trimming
  lines in drawings.......................... 273
types
  dimensions.................................. 700
drawing types.................................. 45
  of leader lines.......................... 730
  of master drawings.................... 76

U
UCS, see user coordinate system........367,369
UCS
  see user coordinate system........367,369
UDA, see user-defined attributes......677
UDAs, see user-defined attributes.....738
undeformed.................................692
undeformed parts.......................... 487
unfolded.................................. 692
unfolding.................................. 571
  bent plates............................. 486
  polybeams.............................. 486
unfreezing drawings..................374,375
general arrangement drawings........375
  units
    in dimension tags...................675
    in drawings.......................... 675
    in reports........................... 675
    in templates....................... 675
  units.................................. 703
  in mark elements..................... 622
unlinking
  dimension lines.......................... 208
unlocking
drawings................................. 374
updating
cut lines..................................... 258
drawings.................................23,42,372
  moment connection symbols...........357
multidrawings.......................... 372
  part marks............................. 223
  weld marks............................. 223
user coordinate system......................367
  creating dimensions............... 177
resetting.................................. 369
setting..................................... 368
toggling between two systems...........369
user interface
drawings................................. 19
user-defined attributes i
  creating........................................ 679
  creating in drawings.......................... 679
  in drawings.................................... 679
user-defined attributes
  adding in marks................................. 624
  grids............................................... 335
  in drawings.................................... 677, 678
  in marks.......................................... 738
V
value fields
  in templates...................................... 630, 632
view boundaries.................................... 147
  resized........................................... 162
view direction marks............................. 494
view extension for neighbor parts................ 479
view extrema, see view boundaries.............. 162
view filters........................................ 31, 38
view label marks
  positioning properties........................ 731
view labels
  mark elements.................................... 748
  marks............................................... 465
  name................................................. 748
view level properties................................ 38
view properties
  defining for general arrangement drawings..... 464
view restriction box, see view boundaries..... 162
view-level dimensioning
  examples............................................ 535
  of shapes, holes and recesses.................. 531
view-level dimensions............................ 500
viewing direction
  beams and bracings in assembly drawings....... 477
  columns in assembly drawings.................... 477
views along grid lines............................. 145
views
  aligning.......................................... 165, 496
  arranging drawing views........................ 166
  cloning dimensions................................ 122
  drawing name..................................... 748
  drawing views..................................... 463
  fixed............................................... 460
frames................................................ 164
free..................................................... 460
in drawings........................................ 145, 461
key plan view....................................... 443
label mark elements................................ 748
linking drawing views............................. 162
moving drawing views.............................. 164
name................................................... 748
rotating drawing views............................ 166
scale................................................... 748
source drawing name................................ 748
visibility............................................. 749
of marks............................................. 604
of model weld marks................................ 734
of reference models................................ 364
of surface treatment.............................. 665

W
weld marks........................................... 310, 732
  adding............................................. 322
  dragging............................................ 320
  examples............................................. 324
  merging............................................. 326
model weld mark visibility in drawings.......... 734
model weld mark appearance........................ 734
modifying............................................. 220
modifying model weld properties.................. 306
  updating............................................ 223
weld numbers
  showing............................................. 734
weld symbols......................................... 306, 666
  customizing......................................... 323
welding properties.................................. 771
welds.................................................... 322
  automatic............................................ 666
  custom symbols..................................... 323
  examples............................................. 310
in drawings........................................ 306, 326, 666, 667
mark properties in drawings........................ 732
model weld mark appearance........................ 734
model weld mark visibility in drawings.......... 734
model weld marks..................................... 316
model weld properties................................ 771
model welds in drawings............................ 310
  modifying............................................ 306, 666
modifying in drawings .......................... 220
modifying model weld objects in drawings .................................. 318
placing ................................................ 453
properties in drawings .......................... 667
solids ................................................ 306
visibility of marks in drawings .......... 316
weld marks ........................................ 320,324
wizard files ......................................... 109
wizards ........................................ 76,80,92
work point ............................................. 550
workshop drawings
assembly drawings .......................... 57
single-part drawings .......................... 52

X

XS_USE_OLD_PLOT_DIALOG .............. 399,405